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Preface

1. General information

1.1. Purpose

This User Guide explains how to manage Talend Studio functions in a normal operational context.

Information presented in this document applies to Talend Studio 5.6.2.

1.2. Audience

This guide is for users and administrators of Talend Studio.

The layout of GUI screens provided in this document may vary slightly from your actual GUI.

1.3. Typographical conventions

This guide uses the following typographical conventions:

• text in bold: window and dialog box buttons and fields, keyboard keys, menus, and menu and
options,

• text in [bold]: window, wizard, and dialog box titles,

• text in courier: system parameters typed in by the user,

• text in italics: file, schema, column, row, and variable names,

•
The  icon indicates an item that provides additional information about an important point. It is
also used to add comments related to a table or a figure,

•
The  icon indicates a message that gives information about the execution requirements or
recommendation type. It is also used to refer to situations or information the end-user needs to be
aware of or pay special attention to.

2. Feedback and Support
Your feedback is valuable. Do not hesitate to give your input, make suggestions or requests regarding
this documentation or product and find support from the Talend team, on Talend's Forum website at:

http://talendforge.org/forum

http://talendforge.org/forum
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Chapter 1. Data Integration: Concepts and
Principles
There is nothing new about the fact that organizations' information systems tend to grow in complexity. The reasons
for this include the "layer stackup trend" (a new solution is deployed although old systems are still maintained) and
the fact that information systems need to be more and more connected to those of vendors, partners and customers.

A third reason is the multiplication of data storage formats (XML files, positional flat files, delimited flat files,
multi-valued files and so on), protocols (FTP, HTTP, SOAP, SCP and so on) and database technologies.

A question arises from these statements: How to manage a proper integration of this data scattered throughout the
company's information systems? Various functions lie behind the data integration principle: business intelligence
or analytics integration (data warehousing) and operational integration (data capture and migration, database
synchronization, inter-application data exchange and so on).

Both ETL for analytics and ETL for operational integration needs are addressed by Talend Studio.
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1.1. Data analytics
While mostly invisible to users of the BI platform, ETL processes retrieve the data from all operational systems
and pre-process it for the analysis and reporting tools.

Talend Studio offers nearly comprehensive connectivity to:

• Packaged applications (ERP, CRM, etc.), databases, mainframes, files, Web Services, and so on to address the
growing disparity of sources.

• Data warehouses, data marts, OLAP applications - for analysis, reporting, dashboarding, scorecarding, and so
on.

• Built-in advanced components for ETL, including string manipulations, Slowly Changing Dimensions,
automatic lookup handling, bulk loads support, and so on.

Most connectors addressing each of the above needs are detailed in Talend Open Studio Components Reference
Guide. For information about their orchestration in Talend Studio, see Designing a Job. For high-level business-
oriented modeling, see Designing a Business Model.

1.2. Operational integration
Operational data integration is often addressed by implementing custom programs or routines, completed on-
demand for a specific need.

Data migration/loading and data synchronization/replication are the most common applications of operational data
integration, and often require:

• Complex mappings and transformations with aggregations, calculations, and so on due to variation in data
structure,

• Conflicts of data to be managed and resolved taking into account record update precedence or "record owner",

• Data synchronization in nearly real time as systems involve low latency.
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Most connectors addressing each of the above needs are detailed in Talend Open Studio Components Reference
Guide. For information about their orchestration in Talend Studio, see Designing a Job. For high-level business-
oriented modeling, see Designing a Business Model. For information about designing a detailed data integration
Job using the output stream feature, see Using the output stream feature.
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Chapter 2. Getting started with Talend Studio
This chapter introduces Talend Studio. It provides basic configuration information required to get started with
Talend Studio.

The chapter guides you through the basic steps in creating local projects. It also describes how to set preferences
and customize the workspace in Talend Studio.
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2.1. Important concepts in Talend Studio
When working with Talend Studio, you will often come across words such as repository, project, workspace, Job,
component and item.

Understanding the concept behind each of these words is crucial to grasping the functionality of Talend Studio.

What is a repository? A repository is the storage location Talend Studio uses to gather data related to all of the
technical items that you use either to describe business models or to design Jobs.

What is a project? Projects are structured collections of technical items and their associated metadata. All of the
Jobs and business models you design are organized in Projects.

You can create as many projects as you need in a repository. For more information about projects, see Working
with projects.

What is a workspace? A workspace is the directory where you store all your project folders. You need to have
one workspace directory per connection (repository connection). Talend Studio enables you to connect to different
workspace directories, if you do not want to use the default one.

For more information about workspaces, see Working with different workspace directories.

What is a Job? A Job is a graphical design, of one or more components connected together, that allows you to set
up and run dataflow management processes. It translates business needs into code, routines and programs. Jobs
address all of the different sources and targets that you need for data integration processes and all other related
processes.

For detailed information about how to design data integration processes in Talend Studio, see Designing a Job.

What is a component? A component is a preconfigured connector used to perform a specific data integration
operation, no matter what data sources you are integrating: databases, applications, flat files, Web services, etc.
A component can minimize the amount of hand-coding required to work on data from multiple, heterogeneous
sources.

Components are grouped in families according to their usage and displayed in the Palette of the Integration of
Talend Studio.

For detailed information about components types and what they can be used for, see Talend Open Studio
Components Reference Guide.

What is an item? An item is the fundamental technical unit in a project. Items are grouped, according to their types,
as: Job Design, Business model, Context, Code, Metadata, etc. One item can include other items. For example,
the business models and the Jobs you design are items, metadata and routines you use inside your Jobs are items
as well.

2.2. Launching Talend Studio
This section guides you through the basics for launching Talend Studio for the first time and opening your first
project in the Studio, and provides information on setting up a project.

2.2.1. How to launch the Studio for the first time

To open Talend Studio for the first time, complete the following:
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1. Uncompress the Talend Studio zip file and, in the folder, double-click the executable file corresponding to
your operating system.

The Studio zip archive contains binaries for several platforms including Mac OS X and Linux/Unix.

2. In the [License] window that appears, read and accept the terms of the end user license agreement to continue.

The startup window appears.

This screen appears only when you launch the Talend Studio for the first time or if all existing projects have been
deleted.

3. Click the Import button to import the selected demo project, or type in a project name in the Create a New
Project field and click the Create button to create a new project, or click the Advanced... button to go to
the Studio login window.

In this procedure, click Advanced... to go to the Studio login widow. For more information about the other
two options, see How to import the demo project and How to create a project respectively.

4. From the Studio login window:

Click... To...

Create... create a new project that will hold all Jobs and Business models designed in the Studio.

For more information, see How to create a project.

Import... import one or more existing projects.
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Click... To...

For more information, see How to import projects.

Demo Project... import the Demo project including numerous samples of ready-to-use Jobs. This Demo
project can help you understand the functionalities of different Talend components.

For more information, see How to import the demo project.

Open open the selected existing project.

For more information, see How to open a project.

Delete... open a dialog box in which you can delete any created or imported project that you do
not need anymore.

For more information, see How to delete a project.

Workspace the path to the current workspace directory that stores the project data. Click Change
to connect to another workspace directory.

As the purpose of this procedure is to create a new project, click Create... to open the [New project] dialog
box.

5. In the dialog box, enter a name for your project and click Finish to close the dialog box. The name of the
new project is displayed in the Project list.

6. To use another workspace directory to store your project data, click the Change button next to the Workspace
field and browse to your preferred workspace directory or create a new one. Upon changing your workspace
directory, you need to restart your Talend Studio by clicking the Restart button on the login window for
your change to take effect.
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For more information on changing the workspace directory, see Working with different workspace directories.

7. Select the project, and click Open.

The Connect to TalendForge page appears, inviting you to connect to the Talend Community so that you can
check, download, install external components and upload your own components to the Talend Community
to share with other Talend users directly in the Exchange view of your Job designer in the Studio.

To learn more about the Talend Community, click the read more link. For more information on using and
sharing community components, see How to download/upload Talend Community components.

If you want to connect to the Talend Community later, click Skip to continue.

8. If you are working behind a proxy, click Proxy setting and fill in the Proxy Host and Proxy Port fields of
the [Network setting] dialog box.

9. By default, the Studio will automatically collect product usage data and send the data periodically to servers
hosted by Talend for product usage analysis and sharing purposes only. If you do not want the Studio to do
so, clear the I want to help to improve Talend by sharing anonymous usage statistics check box.

You can also turn on or off usage data collection in the Usage Data Collector preferences settings. For more
information, see Usage Data Collector preferences (Talend > Usage Data Collector).

10. Fill in the required information, select the I Agree to the TalendForge Terms of Use check box, and click
Create an account to create your account and connect to the Talend Community automatically. If you
already have created an account at http://www.talendforge.org, click the or connect on existing account
link to sign in.

Be assured that any personal information you may provide to Talend will never be transmitted to third parties nor
used for any purpose other than joining and logging in to the Talend Community and being informed of Talend latest
updates.

http://www.talendforge.org
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This page will not appear again when the Studio starts up once you successfully connect to the Talend Community
or if you click Skip too many times. You can show this page again from the [Preferences] dialog box. For more
information, see Exchange preferences (Talend > Exchange).

A progress information bar appears, followed by a welcome window.

11. In the [Additional Talend Packages] wizard, install additional packages such as language packs if needed.
For more information, see the section about installing additional packages in the Talend Installation and
Upgrade Guide.

You can skip this installation step and close the wizard by clicking Cancel.

This wizard appears each time you launch the studio if any additional package is available for installation
unless you select the Do not show this again check box. You can also display this wizard by selecting Help
> Install Additional Packages from the menu bar.

12. From this page you have direct links to Demo projects, user documentation, tutorials, Talend forum, Talend
on-demand training and Talend latest news. Click Start now! to open Talend Studio main window.

The main window opens on a welcome page which has useful tips for beginners on how to get started with
the Studio. Clicking an underlined link brings you to the corresponding tab view or opens the corresponding
dialog box.

For more information on how to open a project, see How to open a project.
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2.2.2. How to set up a project

To open Talend Studio, you must first set up a project.

You can set up a project by:

• creating a new project. For more information, see How to create a project.

• importing one or more projects you already created in other sessions of Talend Studio. For more information,
see How to import projects.

• importing the Demo project. For more information, see How to import the demo project.

2.3. Working with different workspace
directories
Talend Studio makes it possible to create many workspace directories and connect to a workspace different from
the one you are currently working on, if necessary.

This flexibility enables you to store these directories wherever you want and give the same project name to two
or more different projects as long as you store the projects in different directories.
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2.3.1. How to create a new workspace directory

Talend Studio is delivered with a default workspace directory. However, you can create as many new directories
as you want and store your project folders in them according to your preferences.

To create a new workspace directory when launching Talend Studio:

1. On the login window, click the Change button next to the Workspace field.

2. In the [Browse For Folder] dialog box, browse to the parent directory under which you want to create a new
workspace directory, click Make New Folder, and enter the name of your new workspace directory. Then
click OK to validate directory creation and close the dialob box.

3. Back on the login window, click the Restart button to restart your Talend Studio for the change to take effect.
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To create a new workspace directory from the File menu:

1. In the Studio, click File > Switch Workspace and then click Choose....

2. In the dialog box that opens, click Browse and browse to the location where you want to create the new
workspace, or enter your workspace directory path in the Workspace field. If you enter a directory path that
does not exist, the Studio will create it.

3. Click OK to validate your workspace settings and close the dialog box.

4. The Talend Studio start-up window opens. For more information on that window, see Launching Talend
Studio.
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2.3.2. How to connect to a different workspace
directory

In Talend Studio, you can select the workspace directory you want to store your project folders in according to
your preferences.

To change the workspace directory when launching Talend Studio:

1. On the login window, click the Change button next to the Workspace field.

2. In the [Browse For Folder] dialog box, browse to your preferred folder to use as the new workspace directory,
and click OK to validate your directory selection and close the dialog box.
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3. Back on the login window, click the Restart button to restart your Talend Studio for the change to take effect.

To change the workspace directory using the File menu:

1. Click File > Switch Workspace.

2. Select the workspace you want the Studio to switch to.

If the workspace is not listed, import it using the method described in How to create a new workspace
directory.

The Studio restarts.

3. On the re-initiated Project list, select a project and click Open to open the Talend Studio main window.
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All business models or Jobs you design in the current instance of the Studio will be stored in the selected
workspace directory.

Note that if the workspace you choose is already in use, when you launch another instance of Talend Studio with
the same workspace directory chosen for example, an error window opens.

Click OK and define another workspace directory path in the dialog box that opens.

2.4. Working with projects
In Talend Studio, the highest physical structure for storing all different types of data integration Jobs, metadata,
routines, etc. is the "project".

From the login window of the Studio, you can:

• import the Demo project to discover the features of Talend Studio based on samples of different ready-to-use
Jobs. When you import the Demo project, it is automatically installed in the workspace directory of the current
session of the Studio.

For more information, see How to import the demo project.

• create a local project. When connecting to Talend Studio for the first time, there are no default projects listed.
You need to create a project and open it in the Studio to store all the Jobs and business models you create in it.
When creating a new project, a tree folder is automatically created in the workspace directory on your repository
server. This will correspond to the Repository tree view displayed on the main window of the Studio.

For more information, see How to create a project.

• import projects you have already created with previous releases of Talend Studio into your current Talend Studio
workspace directory by clicking Import... .



How to create a project

Talend Open Studio for MDM User Guide 21

For more information, see How to import projects.

• open a project you created or imported in the Studio.

For more information, see How to open a project.

• delete local projects that you already created or imported and that you do not need any longer.

For more information, see How to delete a project.

Once you launch Talend Studio, you can export the resources of one or more of the created projects in the current
instance of the Studio. For more information, see How to export a project.

2.4.1. How to create a project

When you launch the Studio for the first time, there are no default projects listed. You need to create a project that
will hold all data integration Jobs and business models you design in the current instance of the Studio.

To create a project:

1. Launch Talend Studio.

2. Use either of the following two options:

• Enter a project name in the Create A New Project field and click Create to open the [New project] dialog
box with the Project name field filled with the specified name.

• Click Advanced, and then from the login window click Create... to open the [New project] dialog box
with an empty Project name field.
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3. In the Project name field, enter a name for the new project, or change the previously specified project name
if needed. This field is mandatory.

A message shows at the top of the wizard, according to the location of your pointer, to inform you about the
nature of data to be filled in, such as forbidden characters

The read-only "technical name" is used by the application as file name of the actual project file. This name usually
corresponds to the project name, upper-cased and concatenated with underscores if needed.

4. Click Finish. The name of the newly created project is displayed in the Project list in login window of the
Studio.

From version 5.0 onwards, Java is the only language generated.

To open the newly created project in Talend Studio, select it from the Project list and then click Open. A generation
engine initialization window displays. Wait until the initialization is complete.

Later, if you want to switch between projects, on the Studio menu bar, use the combination File > Switch Project.

If you already used Talend Studio and want to import projects from a previous release, see How to import projects.

2.4.2. How to import the demo project

In Talend Studio, you can import the demo project that includes numerous samples of ready to use Jobs. This demo
project can help you understand the functionalities of different Talend components.

At the first launch of Talend Studio, you can create a new project in your repository using the demo project as
a template.

To do that, proceed as follows:

1. Select the demo project that you want to import from the Select A Demo Project list box and click the Import
button. Now you can skip to Step 3.

You can also click Advanced..., and then from the login window click Demo Project....

The dialog box that allows you to select a demo project appears.

The demo projects available in the dialog box may vary depending on the product you are using.
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2. Click the demo project you want to import, and click Finish to close the dialog box.

3. The [Import Demo Project] dialog box appears.

4. Type in a name for the new project, and click Finish to create the project.
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All the samples of the demo project are imported into the newly created project, and the name of the new
project is displayed in the Project list on the login screen.

5. To open the imported demo project in Talend Studio, select it from the Project list and then click Open. A
generation engine initialization window appears. Wait until the initialization is complete.

The Job samples in the open demo project are automatically imported into your workspace directory and
made available in the Repository tree view under the Job Designs folder.

You can use these samples to get started with your own Job design.

You can also import the demo project from the welcome window while starting Talend Studio.

To do that, proceed as follows:

1. Click the Demos link on the welcome window.

2. The dialog box that allows you to select one or more demo projects appears.

The demo projects available in the dialog box may vary depending on the product you are using.
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3. Select the demo project(s) that you want to import from the list and click Finish to close the dialog box.

A confirmation message is displayed, informing you that the demo project has been successfully imported
in the current instance of the Studio.

4. Click Start now! on the welcome window.

The Job samples in the open demo project are automatically imported into your workspace directory and
made available in the Repository tree view under the Job Designs folder.

If needed, you can import the demo project after starting Talend Studio.

To do that, proceed as follows:

1.
From Talend Studio main window, click the  button on the toolbar.

The dialog box that allows you to select one or more demo projects appears.
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2. Select the desired demo project(s), and click Finish to close the dialog box.

A confirmation message is displayed, informing you that the demo project has been successfully imported
in the current instance of the Studio.

The Job samples in the open demo project are automatically imported into your workspace directory and
made available in the Repository tree view under the Job Designs folder.

You can use these samples to get started with your own Job design.

2.4.3. How to import projects

In Talend Studio, you can import projects you already created with previous releases of the Studio.

1. If you are launching Talend Studio for the first time, click Advanced... to open to the login window.

2. From the login window, click Import... to open the [Import] wizard.
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3. Click Import several projects if you intend to import more than one project simultaneously.

4. Click Select root directory or Select archive file depending on the source you want to import from.

5. Click Browse... to select the workspace directory/archive file of the specific project folder. By default,
the workspace in selection is the current release's one. Browse up to reach the previous release workspace
directory or the archive file containing the projects to import.

6. Select the Copy projects into workspace check box to make a copy of the imported project instead of
moving it.

If you want to remove the original project folders from the Talend Studio workspace directory you import from, clear
this check box. But we strongly recommend you to keep it selected for backup purposes.

7. From the Projects list, select the projects to import and click Finish to validate the operation.

In the login window, the names of the imported projects now appear on the Project list.
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You can now select the imported project you want to open in Talend Studio and click Open to launch the Studio.

A generation initialization window might come up when launching the application. Wait until the initialization is complete.

2.4.4. How to open a project

When you launch Talend Studio for the first time, no project names are displayed on the Project list. First you need to
create a project or import a Demo project in order to populate the Project list with the corresponding project names that
you can then open in the Studio.

To open a project in Talend Studio:

On the Studio login screen, select the project from the Project list, and click Open.

A progress bar appears, and the Talend Studio main window opens. A generation engine initialization dialog bow
displays. Wait until the initialization is complete.

When you open a project imported from a previous version of the Studio, an information window pops up to list a short
description of the successful migration tasks. For more information, see Migration tasks.

2.4.5. How to delete a project

1. On the login screen, click Delete...to open the [Select Project] dialog box.
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2. Select the check box(es) of the project(s) you want to delete.

3. Click OK to validate the deletion.

The project list on the login window is refreshed accordingly.

Be careful, this action is irreversible. When you click OK, there is no way to recuperate the deleted project(s).

If you select the Do not delete projects physically check box, you can delete the selected project(s) only from the
project list and still have it/them in the workspace directory of Talend Studio. Thus, you can recuperate the deleted
project(s) any time using the Import existing project(s) as local option on the Project list from the login window.

2.4.6. How to export a project

Talend Studio allows you to export projects created or imported in the current instance of Talend Studio.

1.
On the toolbar of the Studio main window, click  to open the [Export Talend projects in archive file]
dialog box.
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2. Select the check boxes of the projects you want to export. You can select only parts of the project through
the Filter Types... link, if need be (for advanced users).

3. In the To archive file field, type in the name of or browse to the archive file where you want to export the
selected projects.

4. In the Option area, select the compression format and the structure type you prefer.

5. Click Finish to validate the changes.

The archived file that holds the exported projects is created in the defined place.

2.4.7. Migration tasks

Migration tasks are performed to ensure the compatibility of the projects you created with a previous version of
Talend Studio with the current release.

As some changes might become visible to the user, we thought we'd share these update tasks with you through
an information window.

This information window pops up when you launch the project you imported (created) in a previous version of
Talend Studio. It lists and provides a short description of the tasks which were successfully performed so that you
can smoothly roll your projects.
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Some changes that affect the usage of Talend Studio include, for example:

• tDBInput used with a MySQL database becomes a specific tDBMysqlInput component the aspect of which
is automatically changed in the Job where it is used.

• tUniqRow used to be based on the Input schema keys, whereas the current tUniqRow allows the user to select
the column to base the unicity on.

2.5. Setting Talend Studio preferences
You can define various properties for all the perspectives of Talend Studio according to your needs and preferences.

Numerous settings you define can be stored in the Preference and thus become your default values for all new
Jobs you create.

The following sections describe specific settings that you can set as preference.

First, click the Window menu of Talend Studio, then select Preferences.

2.5.1. Java Interpreter path (Talend)

The Java Interpreter path is set default in the Java file of your computer (by default Program Files\Java\jre6\bin
\java.exe).
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To customize your Java Interpreter path:

1. If needed, click the Talend node in the tree view of the [Preferences] dialog box.

2. Enter a path in the Java interpreter field if the default directory does not display the right path.

On the same view, you can also change the preview limit and the path to the temporary files or the OS language.

2.5.2. Designer preferences (Talend > Appearance)

You can set component and Job design preferences to let your settings be permanent in the Studio.

1. From the menu bar, click Window > Preferences to open the [Preferences] dialog box.

2. Expand the Talend > Appearance node.

3. Click Designer to display the corresponding view.

On this view, you can define the way component names and hints will be displayed.
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4. Select the relevant check boxes to customize your use of the Talend Studio design workspace.

2.5.3. How to define the user component folder (Talend
> Components)

You can create and develop your own custom components for use in the Integration perspective of Talend Studio.

For further information about the creation and development of user components, see https://help.talend.com/
display/KB/How+to+create+a+custom+component.

The following procedure applies only to the external components. For the preferences of all the components, see
How to change specific component settings (Talend > Components).

The user component folder is the folder that contains the components you created and/or the ones you downloaded
from TalendForge. To define it, proceed as follows:

1. In the tree view of the [Preferences] dialog box, expand the Talend node and select Components.

https://help.talend.com/display/KB/How+to+create+a+custom+component
https://help.talend.com/display/KB/How+to+create+a+custom+component
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2. Enter the User component folder path or browse to the folder that contains the custom components to be
added to the Palette of the Studio.

In order to be imported to the Palette of the Studio, the custom components have to be in separate folders
located at the root of the component folder you have defined.

3. Click Apply and then OK to validate the preferences and close the dialog box.

The Studio restarts and the external components are added to the Palette.

This configuration is stored in the metadata of the workspace. If the workspace of Talend Studio changes, you
have to reset this configuration again.

2.5.4. How to change specific component settings
(Talend > Components)

You can modify some specific component settings such as the default mapping link display.

The following procedure applies to the external components and to the components included in the Studio. For the
preferences specific to the user components, see How to define the user component folder (Talend > Components).

To modify those specific components settings, proceed as follows:
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1. In the tree view of the [Preferences] dialog box, expand the Talend node and select Components.

2. From the Default mapping links display as list, select the mapping link type you want to use in the tMap.

3. Under tRunJob, select the check box if you do not want the corresponding Job to open upon double clicking
a tRunJob component.

You will still be able to open the corresponding Job by right clicking the tRunJob component and selecting Open
tRunJob Component.

4. Under Component Assist, select the Enable Component Creation Assistant check box if you want to be
able to add a component by typing its name in the design workspace. For more information, see Adding
components to the Job.

5. Click Apply and then OK to validate the set preferences and close the dialog box.

This configuration is stored in the metadata of the workspace. If the workspace of Talend Studio changes, you
have to reset this configuration again.

2.5.5. Documentation preferences (Talend >
Documentation)

You can include the source code on the generated documentation.
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1. From the menu bar, click Window > Preferences to open the [Preferences] dialog box.

2. Expand the Talend node and click Documentation to display the documentation preferences.

3. Customize the documentation preferences according to your needs:

• Select the Source code to HTML generation check box to include the source code in the HTML
documentation that you will generate.

• Select the Use CSS file as a template when export to HTML check box to activate the CSS File field if
you need to use a CSS file to customize the exported HTML files.

For more information on documentation, see How to generate HTML documentation and Documentation tab.

2.5.6. Exchange preferences (Talend > Exchange)

You can set preferences related to your connection with Talend Exchange, which is part of the Talend Community,
in Talend Studio. To do so:

1. From the menu bar, click Window > Preferences to open the [Preferences] dialog box.

2. Expand the Talend node and click Exchange to display the Exchange view.

3. Set the Exchange preferences according to your needs:

• If you are not yet connected to the Talend Community, click Sign In to go to the Connect to TalendForge
page to sign in using your Talend Community credentials or create a Talend Community account and
then sign in.

• If you are already connected to the Talend Community, your account is displayed and the Sign In button
becomes Sign Out. To get disconnected from the Talend Community, click Sign Out.

• By default, while you are connected to the Talend Community, whenever an update to an installed
community extension is available, a dialog box appears to notify you about it. If you often check for
community extension updates and you do not want that dialog box to appear again, clear the Notify me
when updated extensions are available check box.

For more information on connecting to the Talend Community, see Launching Talend Studio. For more
information on using community extensions in the Studio, see How to download/upload Talend Community
components.
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2.5.7. Adding code by default (Talend > Import/Export)

You can add pieces of code by default at the beginning and at the end of the code of your Job.

1. From the menu bar, click Window > Preferences to open the [Preferences] dialog box.

2. Expand the Talend and Import/Export nodes in succession and then click Shell Setting to display the
relevant view.

3. In the Command field, enter your piece/pieces of code before or after %GENERATED_TOS_CALL% to display
it/them before or after the code of your Job.

2.5.8. Language preferences (Talend >
Internationalization)

You can set language preferences in Talend Studio. To do so:

1. From the menu bar, click Window > Preferences to open the [Preferences] dialog box.

2. Expand the Talend node and click Internationalization to display the relevant view.

3. From the Local Language list, select the language you want to use for the graphical interface of Talend
Studio.

4. Click Apply and then OK to validate your change and close the [Preferences] dialog box.
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5. Restart the Studio to display the graphical interface in the selected language.

2.5.9. Performance preferences (Talend >
Performance)

You can set performance preferences according to your use of Talend Studio. To do so, proceed as follows:

1. From the menu bar, click Window > Preferences to open the [Preferences] dialog box.

2. Expand the Talend node and click Performance to display the repository refresh preference.

You can improve your performance when you deactivate automatic refresh.

3. Set the performance preferences according to your use of Talend Studio:

• Select the Deactivate auto detect/update after a modification in the repository check box to deactivate
the automatic detection and update of the repository.

• Select the Check the property fields when generating code check box to activate the audit of the property
fields of the component. When one property filed is not correctly filled in, the component is surrounded
by red on the design workspace.

You can optimize performance if you disable property fields verification of components, for example if you clear
the Check the property fields when generating code check box.

• Select the Generate code when opening the job check box to generate code when you open a Job.

• Select the Check only the last version when updating jobs or joblets check box to only check the latest
version when you update a Job.
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• Select the Propagate add/delete variable changes in repository contexts to propagate variable changes
in the Repository Contexts.

• Select the Activate the timeout for database connection check box to establish database connection time
out. Then set this time out in the Connection timeout (seconds) field.

• Select the Add all user routines to job dependencies, when create new job check box to add all user
routines to Job dependencies upon the creation of new Jobs.

2.5.10. Debug and Job execution preferences (Talend
> Run/Debug)

You can set your preferences for debug and job executions in Talend Studio. To do so:

1. From the menu bar, click Window > Preferences to display the [Preferences] dialog box.

2. Expand the Talend node and click Run/Debug to display the relevant view.

• In the Talend client configuration area, you can define the execution options to be used by default:

Stats port range Specify a range for the ports used for generating statistics, in particular, if the ports defined by
default are used by other applications.

Trace port range Specify a range for the ports used for generating traces, in particular, if the ports defined by default
are used by other applications.

Save before run Select this check box to save your Job automatically before its execution.

Clear before run Select this check box to delete the results of a previous execution before re-executing the Job.

Exec time Select this check box to show Job execution duration.

Statistics Select this check box to show the statistics measurement of data flow during Job execution.

Traces Select this check box to show data processing during job execution.
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Pause time Enter the time you want to set before each data line in the traces table.

• In the Job Run VM arguments list, you can define the parameter of your current JVM according to your needs.
The by-default parameters -Xms256M and -Xmx1024M correspond respectively to the minimal and maximal
memory capacities reserved for your Job executions.

If you want to use some JVM parameters for only a specific Job execution, for example if you want to display
the execution result for this specific Job in Japanese, you need open this Job's Run view and then in the Run
view, configure the advanced execution settings to define the corresponding parameters.

For further information about the advanced execution settings of a specific Job, see How to set advanced execution
settings.

For more information about possible parameters, check the site http://www.oracle.com/technetwork/java/javase/
tech/vmoptions-jsp-140102.html.

2.5.11. Displaying special characters for schema
columns (Talend > Specific settings)

You may need to retrieve a table schema that contains columns written with special characters like Chinese,
Japanese, Korean. In this case, you need to enable Talend Studio to read the special characters. To do so:

1. From the menu bar, click Window > Preferences to open the [Preferences] dialog box.

2. On the tree view of the opened dialog box, expand the Talend node.

3. Click the Specific settings node to display the corresponding view on the right of the dialog box.

4. Select the Allow specific characters (UTF8,...) for columns of schemas check box.

2.5.12. Schema preferences (Talend > Specific
Settings)

You can define the default data length and type of the schema fields of your components.

1. From the menu bar, click Window > Preferences to open the [Preferences] dialog box.

2. Expand the Talend node, and click Specific Settings > Default Type and Length to display the data length
and type of your schema.

http://www.oracle.com/technetwork/java/javase/tech/vmoptions-jsp-140102.html
http://www.oracle.com/technetwork/java/javase/tech/vmoptions-jsp-140102.html
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3. Set the parameters according to your needs:

• In the Default Settings for Fields with Null Values area, fill in the data type and the field length to apply
to the null fields.

• In the Default Settings for All Fields area, fill in the data type and the field length to apply to all fields
of the schema.

• In the Default Length for Data Type area, fill in the field length for each type of data.

2.5.13. Type conversion (Talend > Specific Settings)

You can set the parameters for type conversion in Talend Studio, from Java towards databases and vice versa.

1. From the menu bar, click Window > Preferences to display the [Preferences] dialog box.

2. Expand the Talend and Specific Settings nodes in succession and then click Metadata of Talend Type to
display the relevant view.
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The Metadata Mapping File area lists the XML files that hold the conversion parameters for each database
type used in Talend Studio.

• You can import, export, or delete any of the conversion files by clicking Import, Export or Remove
respectively.

• You can modify any of the conversion files according to your needs by clicking the Edit button to open
the [Edit mapping file] dialog box and then modify the XML code directly in the open dialog box.

2.5.14. SQL Builder preferences (Talend > Specific
Settings)

You can set your preferences for the SQL Builder. To do so:

1. From the menu bar, click Window > Preferences to open the [Preferences] dialog box.

2. Expand the Talend and Specific Settings nodes in succession and then click Sql Builder to display the
relevant view.

3. Customize the SQL Builder preferences according to your needs:

• Select the add quotes, when you generated sql statement check box to precede and follow column and
table names with inverted commas in your SQL queries.

• In the AS400 SQL generation area, select the Standard SQL Statement or System SQL Statement
check boxes to use standard or system SQL statements respectively when you use an AS/400 database.

• Clear the Enable check queries in the database components (disable to avoid warnings for specific
queries) check box to deactivate the verification of queries in all database components.
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2.5.15. Usage Data Collector preferences (Talend >
Usage Data Collector)

By allowing Talend Studio to collect your Studio usage statistics, you help users better understand Talend products
and help Talend better learn how users are using the products, thus enabling Talend to improve product quality
and performance to serve users better.

By default, Talend Studio automatically collects your Studio usage data and sends this data on a regular basis
to servers hosted by Talend. You can view the usage data collection and upload information and customize the
Usage Data Collector preferences according to your needs.

Be assured that only the Studio usage statistics data will be collected and none of your private information will be collected
and transmitted to Talend.

1. From the menu bar, click Window > Preferences to display the [Preferences] dialog box.

2. Expand the Talend node and click Usage Data Collector to display the Usage Data Collector view.

3. Read the message about the Usage Data Collector, and, if you do not want the Usage Data Collector to collect
and upload your Studio usage information, clear the Enable capture check box.

4. To have a preview of the usage data captured by the Usage Data Collector, expand the Usage Data Collector
node and click Preview.
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5. To customize the usage data upload interval and view the date of the last upload, click Uploading under the
Usage Data Collector node.

• By default, if enabled, the Usage Data Collector collects the product usage data and sends it to Talend
servers every 10 days. To change the data upload interval, enter a new integer value (in days) in the Upload
Period field.

• The read-only Last Upload field displays the date and time the usage data was last sent to Talend servers.

2.6. Customizing project settings
Talend Studio enables you to customize the information and settings of the project in progress, including the
Palette, Job settings and Job version management, for example.

To customize project settings:

1.
Click  on the Studio tool bar, or select File > Edit Project Properties from the menu bar.

The [Project Settings] dialog box opens.
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2. In the tree diagram to the left of the dialog box, select the setting you wish to customize and then customize
it, using the options that appear to the right of the box.

From the dialog box you can also export or import the full assemblage of settings that define a particular project:

• To export the settings, click on the Export button. The export will generate an XML file containing all of your
project settings.

• To import settings, click on the Import button and select the XML file containing the parameters of the project
which you want to apply to the current project.

2.6.1. Palette Settings

You can customize the settings of the Palette display so that only the components used in the project are loaded.
This will allow you to launch the Studio more quickly.

To customize the Palette display settings:

1.
On the toolbar of the Studio's main window, click  or click File > Edit Project Properties on the menu
bar to open the [Project Settings] dialog box.
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In the General view of the [Project Settings] dialog box, you can add a project description, if you did not do so
when creating the project.

2. In the tree view of the [Project Settings] dialog box, expand Designer and select Palette Settings. The
settings of the current Palette are displayed in the panel to the right of the dialog box.

3. Select one or several components, or even set(s) of components you want to remove from the current project's
Palette.

4. Use the left arrow button to move the selection onto the panel on the left. This will remove the selected
components from the Palette.

5. To re-display hidden components, select them in the panel on the left and use the right arrow button to restore
them to the Palette.

6. Click Apply to validate your changes and OK to close the dialog box.

To get back to the Palette default settings, click Restore Defaults.

For more information on the Palette, see How to change the Palette layout and settings.

2.6.2. Version management

You can also manage the version of each item in the Repository tree view through General > Version
Management of the [Project Settings] dialog box.

To do so:

1.
On the toolbar of the Studio main window, click  or click File > Edit Project Properties from the menu
bar to open the [Project Settings] dialog box.
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2. In the tree view of the dialog box, expand General and select Version Management to open the
corresponding view.

3. In the Repository tree view, expand the node holding the items you want to manage their versions and then
select the check boxes of these items.

The selected items display in the Items list to the right along with their current version in the Version column
and the new version set in the New Version column.

4. Make changes as required:

• In the Options area, select the Change all items to a fixed version check box to change the version of
the selected items to the same fixed version.

• Click Revert if you want to undo the changes.

• Click Select all dependencies if you want to update all of the items dependent on the selected items at
the same time.

• Click Select all subjobs if you want to update all of the subjobs dependent on the selected items at the
same time.

• To increment each version of the items, select the Update the version of each item check box and change
them manually.
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• Select the Fix tRunjob versions if Latest check box, if you want the father job of current version to keep
using the child Job(s) of current version in the tRunJob to be versioned, regardless of how their versions
will update. For example, a tRunJob will update from the current version 1.0 to 1.1 at both father and
child levels. Once this check box is selected, the father Job 1.0 will continue to use the child Job 1.0 rather
than the latest one as usual, say, version 1.1 when the update is done.

To use this check box, the father Job must be using child Job(s) of the latest version as current version in the tRunjob
to be versioned, by having selected the Latest option from the drop-down version list in the Component view of the
child Job(s). For more information on tRunJob, see Talend Open Studio Components Reference Guide.

5. Click Apply to apply your changes and then OK to close the dialog box.

For more information on version management, see Managing Job versions.

2.6.3. Status management

You can also manage the status of each item in the Repository tree view through General > Status Management
of the [Project Settings] dialog box.

To do so:

1.
On the toolbar of the Studio main window, click  or click File > Edit Project Properties from the menu
bar to open the [Project Settings] dialog box.

2. In the tree view of the dialog box, expand General and select Status Management to open the corresponding
view.
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3. In the Repository tree view, expand the node holding the items you want to manage their status and then
select the check boxes of these items.

The selected items display in the Items list to the right along with their current status in the Status column
and the new status set in the New Status column.

4. In the Options area, select the Change all technical items to a fixed status check box to change the status
of the selected items to the same fixed status.

5. Click Revert if you want to undo the changes.

6. To increment each status of the items, select the Update the version of each item check box and change
them manually.

7. Click Apply to apply your changes and then OK to close the dialog box.

For further information about Job status, see Status settings.

2.6.4. Job Settings

You can automatically use Implicit Context Load and Stats and Logs settings you defined in the [Project
Settings] dialog box of the actual project when you create a new Job.



Stats & Logs

50 Talend Open Studio for MDM User Guide

To do so:

1.
On the toolbar of the Studio main window, click  or click File > Edit Project Properties from the menu
bar to open the [Project Settings] dialog box.

2. In the tree view of the dialog box, click the Job Settings node to open the corresponding view.

3. Select the Use project settings when create a new job check boxes of the Implicit Context Load and Stats
and Logs areas.

4. Click Apply to validate your changes and then OK to close the dialog box.

2.6.5. Stats & Logs

When you execute a Job, you can monitor the execution through the tStatCatcher Statistics option or through
using a log component. This will enable you to store the collected log data in .csv files or in a database.

You can then set up the path to the log file and/or database once for good in the [Project Settings] dialog box so
that the log data get always stored in this location.

To do so:

1.
On the toolbar of the Studio main window, click  or click File > Edit Project Properties from the menu
bar to open the [Project Settings] dialog box.

2. In the tree view of the dialog box, expand the Job Settings node and then click Stats & Logs to display
the corresponding view.
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If you know that the preferences for Stats & Logs will not change depending upon the context of execution, then
simply set permanent preferences. If you want to apply the Stats & Logs settings individually, then it is better to set
these parameters directly onto the Stats & Logs view. For more information about this view, see How to automate
the use of statistics & logs.

3. Select the Use Statistics, Use Logs and Use Volumetrics check boxes where relevant, to select the type of
log information you want to set the path for.

4. Select a format for the storage of the log data: select either the On Files or On Database check box. Or select
the On Console check box to display the data in the console.

The relevant fields are enabled or disabled according to these settings. Fill out the File Name between quotes or
the DB name where relevant according to the type of log information you selected.

You can now store the database connection information in the Repository. Set the Property Type to Repository
and browse to retrieve the relevant connection metadata. The fields get automatically completed.

Alternatively, if you save your connection information in a Context, you can also access them through Ctrl+Space.

2.6.6. Context settings

You can define default context parameters you want to use in your Jobs.

To do so:

1.
On the toolbar of the Studio main window, click  or click File > Edit Project Properties from the menu
bar to open the [Project Settings] dialog box.

2. In the tree view of the dialog box, expand the Job Settings node and then select the Implicit Context Load
check box to display the configuration parameters of the Implicit tContextLoad feature.
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3. Select the From File or From Database check boxes according to the type of file you want to store your
contexts in.

4. For files, fill in the file path in the From File field and the field separator in the Field Separator field.

5. For databases, select the Built-in or Repository mode in the Property Type list and fill in the next fields.

6. Fill in the Table Name and Query Condition fields.

7. Select the type of system message you want to have (warning, error, or info) in case a variable is loaded but
is not in the context or vice versa.

8. Click Apply to validate your changes and then OK to close the dialog box.

2.6.7. Project Settings use

From the [Project Settings] dialog box, you can choose to which Job in the Repository tree view you want to
apply the Implicit Context Load and Stats and Logs settings.

To do so:

1.
On the toolbar of the Studio main window, click  or click File > Edit Project Properties from the menu
bar to open the [Project Settings] dialog box.

2. In the tree view of the dialog box, expand the Job Settings node and then click Use Project Settings to
display the use of Implicit Context Load and Stats and Logs option in the Jobs.
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3. In the Implicit Context Load Settings area, select the check boxes corresponding to the Jobs in which you
want to use the implicit context load option.

4. In the Stats Logs Settings area, select the check boxes corresponding to the Jobs in which you want to use
the stats and logs option.

5. Click Apply to validate your changes and then OK to close the dialog box.

2.6.8. Status settings

In the [Project Settings] dialog box, you can also define the Status.

To do so:

1.
On the toolbar of the Studio main window, click  or click File > Edit Project Properties from the menu
bar to open the [Project Settings] dialog box.

2. In the tree view of the dialog box, click the Status node to define the main properties of your Repository
tree view elements.

The main properties of a repository item gathers information data such as Name, Purpose, Description,
Author, Version and Status of the selected item. Most properties are free text fields, but the Status field
is a drop-down list.
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3. Click the New... button to display a dialog box and populate the Status list with the most relevant values,
according to your needs. Note that the Code cannot be more than 3-character long and the Label is required.

Talend makes a difference between two status types: Technical status and Documentation status.

The Technical status list displays classification codes for elements which are to be running on stations, such
as Jobs, metadata or routines.

The Documentation status list helps classifying the elements of the repository which can be used to
document processes(Business Models or documentation).

4. Once you completed the status setting, click OK to save

The Status list will offer the status levels you defined here when defining the main properties of your Job
designs and business models.

5. In the [Project Settings] dialog box, click Apply to validate your changes and then OK to close the dialog
box.
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2.6.9. Security settings

You can hide or show your passwords on your documentations, metadata, contexts, and so on when they are stored
in the Repository tree view.

To hide your password:

1.
On the toolbar of the Studio main window, click  or click File > Edit Project Properties from the menu
bar to open the [Project Settings] dialog box.

2. In the tree view of the dialog box, click the Security node to open the corresponding view.

3. Select the Hide passwords check box to hide your password.

If you select the Hide passwords check box, your password will be hidden for all your documentations, contexts,
and so on, as well as for your component properties when you select Repository in the Property Type field of the
component Basic settings view, as in the screen capture below. However, if you select Built-in, the password will
not be hidden.

4. In the [Project Settings] dialog box, click Apply to validate your changes and then OK to close the dialog
box.

2.7. Customizing the workspace
When using Talend Studio to design a data integration Job, you can customize the Palette layout and setting
according to your needs. You can as well change the position of any of the panels that exist in the Studio to meet
your requirements.

All the panels, tabs, and views described in this documentation are specific to Talend Studio. Some views listed in the [Show
View] dialog box are Eclipse specific and are not subjects of this documentation. For information on such views, check
Eclipse online documentation at http://www.eclipse.org/documentation/.

2.7.1. How to change the Palette layout and settings

The Palette contains all basic technical components and shapes as well as branches for Job design and business
modeling in the design workspace. These components and shapes as well as branches are grouped in families and
sub-families.

For specific component configuration, check Talend Open Studio Components Reference Guide.

Talend Studio enables you to change the layout and position of your Palette according to your requirements. the
below sections explain all management options you can carry out on the Palette.

http://www.eclipse.org/documentation/
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2.7.1.1. How to show, hide the Palette and change its position

By default, the Palette might be hidden on the right hand side of your design workspace.

If you want the Palette to show permanently, click the left arrow, at the upper right corner of the design workspace,
to make it visible at all times.

You can also move around the Palette outside the design workspace within the Integration perspective. To enable
the standalone Palette view, click the Window menu > Show View... > General > Palette.

If you want to set the Palette apart in a panel, right-click the Palette head bar and select Detached from the
contextual menu. The Palette opens in a separate view that you can move around wherever you like within the
perspective.

2.7.1.2. How to display/hide components families

You can display/hide components families according to your needs in case of visibility problems, for example.
To do so, right-click the Palette and select Display folder to display components families and Hide folder to
display components without their families.

This display/hide option can be very useful when you are in the Favorite view of the Palette. In this view, you usually have
a limited number of components that if you display without their families, you will have them in an alphabetical list and
thus facilitate their usage. for more information about the Palette favorite, see How to set the Palette favorite.

2.7.1.3. How to maintain a component family open

If you often use one or many component families, you can add a pin on their names to stop them from collapsing
when you select components from other families.
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To add a pin, click the pin icon on the top right-hand corner of the family name.

2.7.1.4. How to filter the Palette

You can select the components to be shown or hidden on your Palette. You can also add to the Palette the
components that you developed yourself.

For more information about filtering the Palette, see Palette Settings.

For more information about adding components to the Palette, either from Talend Exchange or from your
own development, see How to download/upload Talend Community components and/or How to define the user
component folder (Talend > Components).

2.7.1.5. How to set the Palette favorite

The Palette offers you search and favorite possibilities that by turn facilitate its usage.

You can add/remove components to/from the Palette favorite view in order to have a quick access to all the
components that you mostly use.

To do so:

1. From the Palette, right-click the component you want to add to Palette favorite and select Add To Favorite.

2.
Do the same for all the components you want to add to the Palette favorite then click the Favorite  button
in the upper right corner of the Palette to display the Palette favorite.
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Only the components added to the favorite are displayed.

To delete a component from the Palette favorite, right-click the component you want to remove from the
favorite and select Remove From Favorite.

To restore the Palette standard view, click the Standard  button in the upper right corner of the Palette.

2.7.1.6. How to change components layout in the Palette

You can change the layout of the component list in the Palette to display them in columns or in lists, as icons
only or as icons with short description.

You can also enlarge the component icons for better readability of the component list.

To do so, right-click any component family in the Palette and select the desired option in the contextual menu or
click Settings to open the [Palette Settings] window and fine-tune the layout.

2.7.1.7. How to add external components to the Palette

Talend Studio enables you to add external components to the Palette of your Studio and use them in your Job
designs.

For more information about the creation and development of user components, refer to the component creation
tutorial on our wiki at http://www.talendforge.org/wiki/doku.php?id=component_creation.

For more information about how to download user components in your Studio, see How to download/upload
Talend Community components.

http://www.talendforge.org/wiki/doku.php?id=component_creation
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2.7.2. How to change panels positions

All panels in the open Studio can be moved around according to your needs.

All you need to do is to click the head border of a panel or to click a tab, hold down the mouse button and drag
the panel to the target destination. Release to change the panel position.

Click the minimize/maximize icons ( / ) to minimize the corresponding panel or maximize it. For more
information on how to display or hide a panel/view, see How to display Job configuration tabs/views.

Click the close icon ( ) to close a tab/view. To reopen a view, click Window > Show View > Talend, then click
the name of the panel you want to add to your current view or see Shortcuts and aliases .

If the Palette does not show or if you want to set it apart in a panel, go to Window > Show view...> General >
Palette. The Palette opens in a separate view that you can move around wherever you like within the perspective.

2.7.3. How to display Job configuration tabs/views

The configuration tabs are located in the lower half of the design workspace of the Integration perspective. Each
tab opens a view that displays detailed information about the selected element in the design workspace.
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The Component, Run Job, and Contexts views gather all information relative to the graphical elements selected
in the design workspace or the actual execution of the open Job.

By default, when you launch Talend Studio for the first time, the Problems tab will not be displayed until the first Job is
created. After that, Problems tab will be displayed in the tab system automatically.

The Modules and Scheduler[deprecated] tabs are located in the same tab system as the Component, Logs and
Run Job tabs. Both views are independent from the active or inactive Jobs open on the design workspace.

Some of the configuration tabs are hidden by default such as the Error Log, Navigator, Job Hierarchy,
Problems, Modules and Scheduler[deprecated] tabs. You can show hidden tabs in this tab system and directly
open the corresponding view if you select Window > Show view and then, in the open dialog box, expand the
corresponding node and select the element you want to display.

For detailed description about these tabs, see Configuration tabs .

2.8. Filtering entries listed in the Repository
tree view
Talend Studio provides the possibility to choose what nodes, Jobs or items you want to list in the Repository
tree view.

You can filter the Repository tree view by job name, Job status, the user who created the Job/items or simply
by selecting/clearing the check box next to the node/ item you want to display/hide in the view. You can also set
several filters simultaneously.

2.8.1. How to filter by Job name

To filter Jobs listed in the Repository tree view by Job name, complete the following:
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1.
In the Studio, click the  icon in the upper right corner of the Repository tree view and select Filter
settings from the contextual menu.

The [Repository Filter] dialog box displays.

2. Select the Filter By Name check box.

The corresponding field becomes available.

3. Follow the rules set below the field when writing the patterns you want to use to filter the Jobs.

In this example, we want to list in the tree view all Jobs that start with tMap or test.

4. In the [Repository Filter] dialog box, click OK to validate your changes and close the dialog box.

Only the Jobs that correspond to the filter you set are displayed in the tree view, those that start with tMap
and test in this example
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You can switch back to the by-default tree view, which lists all nodes, Jobs and items, by simply clicking the icon . This

will cause the green plus sign appended on the icon to turn to a minus red sign ( ).

2.8.2. How to filter by user

To filter entries in the Repository tree view by the user who created the Jobs/items, complete the following:

1.
In the Studio, click the  icon in the upper right corner of the Repository tree view and select Filter
settings from the contextual menu.

The [Repository Filter] dialog box displays.
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2. Clear the All Users check box.

The corresponding fields in the table that follows become available.

This table lists the authentication information of all the users who have logged in to Talend Studio and created
a Job or an item.

3. Clear the check box next to a user if you want to hide all the Jobs/items created by him/her in the Repository
tree view.

4. Click OK to validate your changes and close the dialog box.

All Jobs/items created by the specified user will disappear from the tree view.

You can switch back to the by-default tree view, which lists all nodes, Jobs and items, by simply clicking the icon . This

will cause the green plus sign appended on the icon to turn to a minus red sign ( ).
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2.8.3. How to filter by job status

To filter Jobs in the Repository tree view by the job status, complete the following:

1.
In the Studio, click the  icon in the upper right corner of the Repository tree view and select Filter
settings from the contextual menu.

The [Repository Filter] dialog box displays.

2. In the Filter By Status area, clear the check boxes next to the status type if you want to hide all the Jobs
that have the selected status.

3. Click OK to validate your changes and close the dialog box.

All Jobs that have the specified status will disappear from the tree view.

You can switch back to the by-default tree view, which lists all nodes, Jobs and items, by simply clicking the icon . This

will cause the green plus sign appended on the icon to turn to a minus red sign ( ).

2.8.4. How to choose what repository nodes to display

To filter repository nodes, complete the following:
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1.
In the Integration perspective of the Studio, click the  icon in the upper right corner of the Repository
tree view and select Filter settings from the contextual menu.

The [Repository Filter] dialog box displays.

2. Select the check boxes next to the nodes you want to display in the Repository tree view.
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Consider, for example, that you want to show in the tree view all the Jobs listed under the Job Designs node,
three of the folders listed under the SQL Templates node and one of the metadata items listed under the
Metadata node.

3. Click OK to validate your changes and close the dialog box.

Only the nodes/folders for which you selected the corresponding check boxes are displayed in the tree view.

If you do not want to show all the Jobs listed under the Job Designs node, you can filter the Jobs using the Filter By Name
check box. For more information on filtering Jobs, see How to filter by Job name.
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Chapter 3. Designing a Business Model
The Integration perspective of Talend Studio offers the best tool to formalize business descriptions into building
blocks and their relationships. Talend Studio allows to design systems, connections, processes and requirements
using standardized workflow notation through an intuitive graphical library of shapes and links.

This chapter aims at business managers, decision makers or developers who want to model their flow management
needs at a macro level.
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3.1. What is a Business Model
Talend's Business Models allow data integration project stakeholders to graphically represent their needs
regardless of the technical implementation requirements. Business Models help the IT operation staff understand
these expressed needs and translate them into technical processes (Jobs). They typically include both the systems
and processes already operating in the enterprise, as well as the ones that will be needed in the future.

Designing Business Models is part of the enterprises' best practices that organizations should adopt at a very early
stage of a data integration project in order to ensure its success. Because Business Models usually help detect
and resolve quickly project bottlenecks and weak points, they help limit the budget overspendings and/or reduce
the upfront investment. Then during and after the project implementation, Business Models can be reviewed and
corrected to reflect any required change.

A Business Model is a non technical view of a business workflow need.

Generally, a typical Business Model will include the strategic systems or processes already up and running in your
company as well as new needs. You can symbolize these systems, processes and needs using multiple shapes and
create the connections among them. Likely, all of them can be easily described using repository attributes and
formatting tools.

In the design workspace of the Integration perspective of Talend Studio, you can use multiple tools in order to:

• draw your business needs,

• create and assign numerous repository items to your model objects,

• define the business model properties of your model objects.

3.2. Opening or creating a Business Model
Open Talend Studio following the procedure as detailed in Launching Talend Studio.

In the Repository tree view of the Integration perspective, right-click the Business Models node.

Select Expand/Collapse to display all existing Business Models (if any).

3.2.1. How to open a Business Model
Double-click the name of the Business Model to be opened.
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The selected Business Model opens up on the design workspace.

3.2.2. How to create a Business Model
To create a business model, proceed as follows:

1. Right-click the Business Models node and select Create Business Model.

The creation wizard guides you through the steps to create a new Business Model.

2. Enter the Business Model properties according to the following table:

Field Description

Name the name of the new Business Model. A message comes up if you enter prohibited characters.

Purpose Business Model purpose or any useful information regarding the Business Model use.

Description Business Model description.

Author a read-only field that shows by default the current user login.

Locker a read-only field that shows by default the login of the user who owns the lock on the current Job. This
field is empty when you are creating a Business Model and has data only when you are editing the
properties of an existing Business Model.

Version a read-only field. You can manually increment the version using the M and m buttons.

Status a list to select from the status of the Business Model you are creating.

Path a list to select from the folder in which the Business Model will be created.

3. The Modeler opens up on the empty design workspace.

You can create as many models as you want and open them all.

The Modeler is made of the following panels:

• The Integration perspective's design workspace
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• a Palette of shapes and lines specific to the business modeling

• the Business Model panel showing specific information about all or part of the model.

3.3. Modeling a Business Model
If you have multiple tabs opened on your design workspace, click the relevant tab in order to show the appropriate
model information.

In the Business Model view, you can see information relative to the active model.

Use the Palette to drop the relevant shapes on the design workspace and connect them together with branches and
arrange or improve the model visual aspect by zooming in or out.

This Palette offers graphical representations for objects interacting within a Business Model.

The objects can be of different types, from strategic system to output document or decision step. Each one having
a specific role in your Business Model according to the description, definition and assignment you give to it.

All objects are represented in the Palette as shapes, and can be included in the model.

Note that you must click the business folder to display the library of shapes on the Palette.

3.3.1. Shapes
Select the shape corresponding to the relevant object you want to include in your Business Model. Double-click
it or click the shape in the Palette and drop it in the modeling area.
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Alternatively, for a quick access to the shape library, keep your cursor still on the modeling area for a couple of
seconds to display the quick access toolbar:

For instance, if your business process includes a decision step, select the diamond shape in the Palette to add this
decision step to your model.

When you move the pointer over the quick access toolbar, a tooltip helps you to identify the shapes.

Then a simple click will do to make it show on the modeling area.

The shape is placed in a dotted black frame. Pull the corner dots to resize it as necessary.

Also, a blue-edged input box allows you to add a label to the shape. Give an expressive name in order to be able
to identify at a glance the role of this shape in the model.

Two arrows below the added shape allow you to create connections with other shapes. You can hence quickly
define sequence order or dependencies between shapes.

Related topic: Connecting shapes.

The available shapes include:

Callout Details

Decision The diamond shape generally represents an if condition in the model. Allows to take context-sensitive
actions.

Action The square shape can be used to symbolize actions of any nature, such as transformation, translation
or formatting.

Terminal The rounded corner square can illustrate any type of output terminal.

Data A parallelogram shape symbolize data of any type.

Document Inserts a Document object which can be any type of document and can be used as input or output for
the data processed.

Input Inserts an input object allowing the user to type in or manually provide data to be processed.

List forms a list with the extracted data. The list can be defined to hold a certain nature of data.

Database Inserts a database object which can hold the input or output data to be processed.

Actor This schematic character symbolizes players in the decision-support as well technical processes.

Ellipse Inserts an ellipse shape.

Gear This gearing piece can be used to illustrate pieces of code programmed manually that should be replaced
by a Talend Job for example.

3.3.2. Connecting shapes

When designing your Business Model, you want to implement relations between a source shape and a target shape.
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There are two possible ways to connect shapes in your design workspace:

Either select the relevant Relationship tool in the Palette. Then, in the design workspace, pull a link from one
shape to the other to draw a connection between them.

Or, you can implement both the relationship and the element to be related to or from, in a few clicks.

1. Simply move the mouse pointer over a shape that you already dropped on your design workspace, in order
to display the double connection arrows.

2. Select the relevant arrow to implement the correct directional connection if need be.

3. Drag a link towards an empty area of the design workspace and release to display the connections popup
menu.

4. Select the appropriate connection from the list. You can choose among Create Relationship To, Create
Directional Relationship To or Create Bidirectional Relationship To.

5. Then, select the appropriate element to connect to, among the items listed.

You can create a connection to an existing element of the model. Select Existing Element in the popup menu and
choose the existing element you want to connect to in the displaying list box.
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The connection is automatically created with the selected shape.

The nature of this connection can be defined using Repository elements, and can be formatted and labelled in the
Properties panel, see Business Models.

When creating a connection, an input box allows you to add a label to the connection you have created. Choose
a meaningful name to help you identify the type of relationship you created.

You can also add notes and comments to your model to help you identify elements or connections at a later date.

Related topic: How to comment and arrange a model.

3.3.3. How to comment and arrange a model

The tools of the Palette allow you to customize your model:

Callout Details

Select Select and move the shapes and lines around in the design workspace's modeling area.

Zoom Zoom in to a part of the model. To watch more accurately part of the model. To zoom out, press
Shift and click the modeling area.

Note/Text/Note attachment Allows comments and notes to be added in order to store any useful information regarding the model
or part of it.

3.3.3.1. How to add a note or free text

To add a note, select the Note icon in the Palette, docked to the right of the design workspace.

Alternatively right-click the model or the shape you want to link the note to, and select Add Note. Or select the
Note tool in the quick access toolbar.

A sticky note displays on the modeling area. If the note is linked to a particular shape, a line is automatically
drawn to the shape.
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Type in the text in the input box or, if the latter does not show, type in directly on the sticky note.

If you want to link your notes and specific shapes of your model, click the down arrow next to the Note tool on
the Palette and select Note attachment. Pull the black arrow towards an empty area of the design workspace, and
release. The popup menu offers you to attach a new Note to the selected shape.

You can also select the Add Text feature to type in free text directly in the modeling area. You can access this
feature in the Note drop-down menu of the Palette or via a shortcut located next to the Add Note feature on the
quick access toolbar.

3.3.3.2. How to arrange the model view

You can also rearrange the look and feel of your model via the right-click menu.

Place your cursor in the design area, right-click to display the menu and select Arrange all. The shapes
automatically move around to give the best possible reading of the model.

Alternatively, you can select manually the whole model or part of it.

To do so, right-click any part of the modeling area, and click Select.

You can select:

• All shapes and connectors of the model,

• All shapes used in the design workspace,

• All connectors branching together the shapes.

From this menu you can also zoom in and out to part of the model and change the view of the model.
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3.3.4. Business Models

The information in the Business Models view corresponds to the current selection, if any. This can be the whole
model if you selected all shapes of it or more specifically one of the shapes it is made of. If nothing is selected,
the Business Models tab gives general information about the model.

The Business Models view contains different types of information grouped in the Main, Appearance, Rules &
Grid, and Assignment tabs.

The Main tab displays basic information about the selected item in the design workspace, being a Business Model
or a Job. For more information about the Main tab, see How to display Job configuration tabs/views.

3.3.4.1. Appearance tab

From the Appearance tab you can apply filling or border colors, change the appearance of shapes and lines in
order to customize your Business Model or make it easier to read.

The Business Model view includes the following formats:

• fill the shape with selected color.

• color the shape border

• insert text above the shape

• insert gradient colors to the shape

• insert shadow to the shape

You can also move and manage shapes of your model using the edition tools. Right-click the relevant shape to
access these editing tools.

3.3.4.2. Rulers and Grid tab

To display the Rulers & Grid tab, click  on the Palette, then click any empty area of the design workspace
to deselect any current selection.

Click the Rulers & Grid tab to access the ruler and grid setting view.

In the Display area, select the Show Ruler check box to show the Ruler, the Show Grid check box to show the
Grid, or both heck boxes. Grid in front sends the grid to the front of the model.

In the Measurement area, select the ruling unit among Centimeters, Inches or Pixels.
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In the Grid Line area, click the Color button to set the color of the grid lines and select their style from the Style list.

Select the Snap To Grid check box to bring the shapes into line with the grid or the Snap To Shapes check box
to bring the shapes into line with the shapes already dropped in the Business Model.

You can also click the Restore Defaults button to restore the default settings.

3.3.4.3. Assignment tab

The Assignment tab displays in a tabular form details of the Repository attributes you allocated to a shape or
a connection.

To display any assignment information in the table, select a shape or a connection in the active model, then click
the Assignment tab in the Business Model view.

You can also display the assignment list placing the mouse over the shape you assigned information to.
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You can modify some information or attach a comment. Also, if you update data from the Repository tree view,
assignment information gets automatically updated.

For further information about how to assign elements to a Business Model, see Assigning repository elements to
a Business Model.

3.4. Assigning repository elements to a
Business Model
The Assignment tab in the Business Models view lists the elements from the Repository tree view which have
been assigned to a shape in the Business Model.

You can define or describe a particular object in your Business Model by simply associating it with various types
of information, for example by adding metadata items.

You can set the nature of the metadata to be assigned or processed, thus facilitating the Job design phase.

To assign a metadata item, simply drop it from the Repository tree view to the relevant shape in the design
workspace.

The Assignment table, located underneath the design workspace, gets automatically updated accordingly with the
assigned information of the selected object.

The types of items that you can assign are:

Element Details

Job designs If any Job Designs developed for other projects in the same repository are available, you can reuse
them as metadata in the active Business Model.

Metadata You can assign any descriptive data stored in the repository to any of the objects used in the model.
It can be connection information to a database for example.

Business Models You can use in the active model all other Business Models stored in the repository of the same project.

Documentation You can assign any type of documentation in any format. It can be a technical documentation, some
guidelines in text format or a simple description of your databases.

Routines (Code) If you have developed some routines in a previous project, to automate tasks for example, you can
assign them to your Business Model. Routines are stored in the Code folder of the Repository tree
view.

For more information about the Repository elements, see Designing a Job.
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3.5. Editing a Business Model
Follow the relevant procedure according to your needs:

How to rename a Business Model

1. Right-click the relevant Business Model label on the Repository tree view then select Edit properties to
display the corresponding Main properties information in the [Edit properties] dialog box.

2. Edit the model name in the Name field, then click Finish to close the dialog box. The model label changes
automatically in the Repository tree view and will be reflected on the model tab of the design workspace,
the next time you open the Business Model.

If the Business Model is open, the information in the [Edit properties] dialog box will be read-only so you will not
be able to edit them.

How to copy and paste a Business Model

1. In Repository > Business model, right-click the Business Model name to be copied and select Copy in the
popup menu, or press Ctrl+C.

2. Then right-click where you want to paste your Business Model, and select Paste.

How to move a Business Model

1. To move a Business Model from a location to another in your business models project folder, select a Business
Model in the Repository > Business Models tree.

2. Then simply drop it to the new location.

How to delete a Business Model

1. Right-click the name of the model to be deleted and select Delete in the popup menu.

2. Alternatively, simply select the relevant Business Model, then drop it into the Recycle bin of the Repository
tree view.

3.6. Saving a Business Model
To save a Business Model, click File > Save or press Ctrl+S. The model is saved under the name you gave during
the creation process.

An asterisk displays in front of the Business Model name on the tab to indicate that changes have been made to
the model but not yet saved.

To save a Business Model and increment its version at the same time:

1. click File>Save as....The [Save as] dialog box displays.

2. Next to the Version field, click the M button to increment the major version and the m button to increment
the minor version.

3. Click Finish to validate the modification
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By default, when you open a Business Model, you open its last version. Any previous version of the Business Model is
read-only and thus cannot be modified.

You can access a list of the different versions of a Business Model and perform certain operations. To do that:

1. In the Repository tree view, select the Business Model you want to consult the versions of.

2. Click the Business Models>Version in succession to display the version list of the selected Job.

3. Right-click the Business Model version you want to consult.

4. Do one of the followings:

Select To...

Edit properties edit Business Model properties.

Note: The Business Model should not be open on the design workspace, otherwise it will
be in read-only mode.

Read Business Model consult the Business Model in read-only mode.

You can open and modify the last version of a Business Model from the Version view if you select Edit Business Model
from the drop-down list.
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Chapter 4. Designing a Job
Talend Studio is the tool with the capabilities that treat all of the different sources and targets required in data
integration processes and all other associated operations.

Via Talend Studio, you are able to design data integration Jobs that allow you to put in place up and run dataflow
management processes.

This chapter addresses the needs of programmers or IT managers who are ready to implement the technical aspects
of a Business Model (regardless of whether it was designed in the Business Modeler of the Integration perspective
of Talend Studio).
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4.1. What is a Job design
A Job Design is the runnable layer of a business model. It is a graphical design, of one or more components
connected together, that allows you to set up and run dataflow management processes. A Job Design translates
business needs into code, routines and programs, in other words it technically implements your data flow.

The Jobs you design can address all of the different sources and targets that you need for data integration processes
and any other related process.

When you design a Job in Talend Studio, you can:

• put in place data integration actions using a library of technical components.

• change the default setting of components or create new components or family of components to match your
exact needs.

• set connections and relationships between components in order to define the sequence and the nature of actions.

• access code at any time to edit or document the components in the designed Job.

• create and add items to the repository for reuse and sharing purposes (in other projects or Jobs or with other
users).

In order to be able to execute the Jobs you design in Talend Studio, you need to install an Oracle JVM 1.6 or later (IBM
JVM is not supported). You can download it from http://www.oracle.com/technetwork/java/javase/downloads/index.html.

4.2. Getting started with a basic Job
This section provides a continuous example that will help you create, add components to, configure, and execute a
simple Job. This Job will be named A_Basic_Job and will read a text file and display its content on the Run console.

4.2.1. Creating a Job

Talend Studio enables you to create a Job by dropping different technical components from the Palette onto the
design workspace and then connecting these components together.

To create the example Job described in this section, proceed as follows:

1. In the Repository tree view of the Integration perspective, right-click the Job Designs node and select
Create job from the contextual menu.

http://www.oracle.com/technetwork/java/javase/downloads/index.html
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The [New Job] wizard opens to help you define the main properties of the new Job.

2. Fill the Job properties as shown in the previous screenshot.

The fields correspond to the following properties:

Field Description

Name the name of the new Job.

Note that a message comes up if you enter prohibited characters.

Purpose Job purpose or any useful information regarding the Job use.

Description Job description containing any information that helps you describe what the Job does and how it does it.

Author a read-only field that shows by default the current user login.

Locker a read-only field that shows by default the login of the user who owns the lock on the current Job. This
field is empty when you are creating a Job and has data only when you are editing the properties of
an existing Job.

Version a read-only field. You can manually increment the version using the M and m buttons. For more
information, see Managing Job versions.

Status a list to select from the status of the Job you are creating.

Path a list to select from the folder in which the Job will be created.

3. An empty design workspace opens up showing the name of the Job as a tab label.
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The Job you created is now listed under the Job Designs node in the Repository tree view.

You can open one or more of the created Jobs by simply double-clicking the Job label in the Repository tree view.

Related topics:

• Classify the Jobs you created by creating folders. For more information, see How to use folders.

• Create a data integration Job. For more information, see Theory into practice: Job examples.

• Customize the workspace. For more information, see Customizing the workspace.

4.2.2. Adding components to the Job

Now that the Job is created, components have to be added to the design workspace, a tFileInputDelimited and
a tLogRow in this example.

You can add a component directly on the design workspace by clicking and typing in the full or partial name of
the component or drop components from the Palette or the Medadata node. Only the first two ways are shown in
this example. To know how to drop a component from the Metadata node, see How to use centralized metadata
in a Job.

4.2.2.1. Dropping the first component

The first component of this example will be added from the Palette. This component defines the first task executed
by the Job. In this example, as you first want to read a text file, you will use the tFileInputDelimited component.

For more information regarding components and their functions, see Talend Open Studio Components Reference
Guide.
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To drop a component from the Palette, proceed as follows:

1. In the search field of the Palette of the Studio, enter the beginning of the component name, tfileinputde in
the example. Press Enter to validate your search.

The Palette filters to the only families where the component can be found. If you cannot find the Palette
view in the Studio, see How to show, hide the Palette and change its position.

2. Click a place on the design workspace where you want to drop the component.

Note that you can also drop a note to your Job the same way you drop components. For more information, see
How to add notes to a Job design.

Each newly-added component is shown in a blue box to show that it as an individual Subjob.

4.2.2.2. Adding the second component

The second component of our Job will be added by typing its name directly on the workspace, instead of dropping
it from the Palette or from the Metadata node. You can search a component by its partial or full name.

Prerequisite: Make sure you have selected the Enable Component Creation Assistant check box in the Studio
preferences. For more information, see How to change specific component settings (Talend > Components).
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To add a component directly on the workspace, proceed as follows:

1. Click where you want to add the component on the design workspace, and type a string contained in the
component name in the text field that appears automatically. In our example, start typing tlog.

A list box appears below the text field displaying all the matching components in alphabetical order.

2. Double-click the desired component to add it on the workspace, tLogRow in our example.

4.2.3. Connecting the components together

Now that the components have been added on the workspace, they have to be connected together. Components
connected together form a subjob. Jobs are composed of one or several subjobs carrying out various processes.

To connect the components together, proceed as follows:

1. Right-click the source component, tFileInputDelimited in this example.

2. In the contextual menu that opens, select the type of connection you want to use to link the components,
Row > Main in this example.

3. Click the target component to create the link, tLogRow in this example.

Note that a black crossed circle is displayed if the target component is not compatible with the link.
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According to the nature and the role of the components you want to link together, several types of link are available.
Only the authorized connections are listed in the contextual menu. For more information, see Using connections.

You can also drop components in the middle of a Row link. For more information, see How to drop components
in the middle of a Row link.

4.2.4. Configuring the components

Now that the components are linked, their properties should be defined.

For more advanced details regarding the components properties, see How to define component properties and
Talend Open Studio Components Reference Guide.

Configuring the tFileInputDelimited component

1. Double-click the tFileInputDelimited component to open its Basic settings view.

2. Click the [...] button next to the File Name/Stream field.

3. Browse your system or enter the path to the input file, customers.txt in this example.

4. In the Header field, enter 1.

5. Click the [...] button next to Edit schema.

6. In the Schema Editor that opens, click three times the [+] button to add three columns.

7. Name the three columns id, CustomerName and CustomerAddress respectively and click OK to close the
editor.
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8. In the pop-up that opens, click OK accept the propagation of the changes.

This allows you to copy the schema you created to the next component, tLogRow in this example.

Configuring the tLogRow component

1. Double-click the tLogRow component to open its Basic settings view.

2. In the Mode area, select Table (print values in cells of a table).

By doing so, the contents of the customers.txt file will be printed in a table and therefore more readable.
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4.2.5. Executing the Job

Now that components are configured, the Job can be executed.

To do so, proceed as follows:

1. Press Ctrl+S to save the Job.

2. Go to Run tab, and click on Run to execute the Job.

The file is read row by row and the extracted fields are displayed on the Run log.

4.3. Using connections
In Talend Studio, a Job or a subjob is composed of a group of components logically linked to one another via
connections. You need to use the connections to define how the components in use are coordinated. This section
will describe the types of connections and their related settings.

4.3.1. Connection types

There are various types of connections which define either the data to be processed, the data output, or the Job
logical sequence.

Right-click a component on the design workspace to display a contextual menu that lists all available links for
the selected component.

The sections below describe all available connection types.

4.3.1.1. Row connection

A Row connection handles the actual data. The Row connections can be main, lookup, reject or output according
to the nature of the flow processed.
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Main

This type of row connection is the most commonly used connection. It passes on data flows from one component
to the other, iterating on each row and reading input data according to the component properties setting (schema).

Data transferred through main rows are characterized by a schema definition which describes the data structure
in the input file.

You cannot connect two Input components together using a main Row connection. Only one incoming Row connection is
possible per component. You will not be able to link twice the same target component using a main Row connection. The
second row linking a component will be called Lookup.

To connect two components using a Main connection, right-click the input component and select Row > Main
on the connection list.

Alternatively, you can click the component to highlight it, then right-click it and drag the cursor towards the
destination component. This will automatically create a Row > Main type of connection.

For information on using multiple Row connections, see Multiple Input/Output.

Lookup

This row link connects a sub-flow component to a main flow component (which should be allowed to receive
more than one incoming flow). This connection is used only in the case of multiple input flows.
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A Lookup row can be changed into a main row at any time (and reversely, a main row can be changed to a lookup
row). To do so, right-click the row to be changed, and on the pop-up menu, click Set this connection as Main.

Related topic: Multiple Input/Output.

Filter

This row link connects specifically a tFilterRow component to an output component. This row link gathers the
data matching the filtering criteria. This particular component offers also a Reject link to fetch the non-matching
data flow.

Rejects

This row link connects a processing component to an output component. This row link gathers the data that does
NOT match the filter or are not valid for the expected output. This link allows you to track the data that could not
be processed for any reason (wrong type, undefined null value, etc.). On some components, this link is enabled
when the Die on error option is deactivated. For more information, refer to the relevant component properties
available in Talend Open Studio Components Reference Guide.

ErrorReject

This row link connects a tMap component to an output component. This link is enabled when you clear the Die
on error check box in the tMap editor and it gathers data that could not be processed (wrong type, undefined
null value, unparseable dates, etc.).

Related topic: Handling errors.

Output

This row link connects a tMap component to one or several output components. As the Job output can be multiple,
you get prompted to give a name for each output row created.

The system also remembers deleted output link names (and properties if they were defined). This way, you do not have to
fill in again property data in case you want to reuse them.

Related topic: Multiple Input/Output.

Uniques/Duplicates

These row links connect a tUniqRow to output components.

The Uniques link gathers the rows that are found first in the incoming flow. This flow of unique data is directed
to the relevant output component or else to another processing subjob.

The Duplicates link gathers the possible duplicates of the first encountered rows. This reject flow is directed to
the relevant output component, for analysis for example.
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Multiple Input/Output

Some components help handle data through multiple inputs and/or multiple outputs. These are often processing-
type components such as the tMap.

If this requires a join or some transformation in one flow, you want to use the tMap component, which is dedicated
to this use.

For further information regarding data mapping, see Mapping data flows.

For properties regarding the tMap component as well as use case scenarios, see Talend Open Studio Components
Reference Guide.

4.3.1.2. Iterate connection

The Iterate connection can be used to loop on files contained in a directory, on rows contained in a file or on
DB entries.

A component can be the target of only one Iterate link. The Iterate link is mainly to be connected to the start
component of a flow (in a subjob).

Some components such as the tFileList component are meant to be connected through an iterate link with the next
component. For how to set an Iterate connection, see Iterate connection settings.

The name of the Iterate link is read-only unlike other types of connections.

4.3.1.3. Trigger connections

Trigger connections define the processing sequence, so no data is handled through these connections.

The connection in use will create a dependency between Jobs or subjobs which therefore will be triggered one
after the other according to the trigger nature.

Trigger connections fall into two categories:

• subjob triggers: On Subjob Ok, On Subjob Error and Run if,

• component triggers: On Component Ok, On Component Error and Run if.
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OnSubjobOK (previously Then Run): This link is used to trigger the next subjob on the condition that the main
subjob completed without error. This connection is to be used only from the start component of the Job.

These connections are used to orchestrate the subjobs forming the Job or to easily troubleshoot and handle
unexpected errors.

OnSubjobError: This link is used to trigger the next subjob in case the first (main) subjob do not complete
correctly. This "on error" subjob helps flagging the bottleneck or handle the error if possible.

Related topic: How to define the Start component.

OnComponentOK and OnComponentError are component triggers. They can be used with any source
component on the subjob.

OnComponentOK will only trigger the target component once the execution of the source component is complete
without error. Its main use could be to trigger a notification subjob for example.

OnComponentError will trigger the sub-job or component as soon as an error is encountered in the primary Job.

Run if triggers a subjob or component in case the condition defined is met. For how to set a trigger condition,
see Run if connection settings.

4.3.1.4. Link connection

The Link connection can only be used with ELT components. These links transfer table schema information to
the ELT mapper component in order to be used in specific DB query statements.

Related topics: ELT components in Talend Open Studio Components Reference Guide.

The Link connection therefore does not handle actual data but only the metadata regarding the table to be operated
on.

When right-clicking the ELT component to be connected, select Link > New Output.

Be aware that the name you provide to the link must reflect the actual table name.

In fact, the link name will be used in the SQL statement generated through the ETL Mapper, therefore the same
name should never be used twice.
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4.3.2. How to drop components in the middle of a Row
link

When creating a Job, Talend Studio enables you to insert a component in the middle of a Row > Main, Row >
Reject or Row > Combine connection.

To do so, do the following:

1. In the Integration perspective, drop two combine and two file components from the Palette onto the design
workspace.

2. Connect the component pairs using a Row > Main (or a Row > Reject) connection and a Row > Combine
one.

3. Drop the component you want to insert in the middle of the row. The link gets bold and then a dialog box
displays, prompting you to type in a name for the output link.

4. Type in a name and click OK to close the dialog box.

You may be asked to retrieve the schema of the target component. In that case, click OK to accept or click No to deny.

The component is inserted in the middle of the link, which is now divided in two links.
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4.3.3. How to define connection settings

You can display the properties of a connection by selecting it and clicking the Component view tab, or by right-
clicking the connection and selecting Settings from the contextual menu. This section summarizes connection
property settings.

4.3.3.1. Row connection settings

The Basic settings vertical tab of the Component view of the connection displays the schema of the data flow
handled by the connection. You can change the schema by clicking the Edit schema button. For more information,
see How to set a built-in schema.

The Advanced settings vertical tab lets you monitor the data flow over the connection in a Job without using a
separate tFlowMeter component. The measured information will be interpreted and displayed in a monitoring
tool such Talend Activity Monitoring Console (available with Talend subscription-based products).
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To monitor the data over the connection, perform the following settings in the Advanced settings vertical tab:

1. Select the Monitor this connection check box.

2. From the Mode list, select Absolute to log the actual number of rows passes over the connection, or Relative
to log the ratio (%) of the number of rows passed over this connection against a reference connection. If you
select Relative, you need to select a reference connection from the Connections List list.

3. Click the plus button to add a line in the Thresholds table and define a range of the number of rows to be
logged.

For more information about flow metrics, see the documentation of the tFlowMeterCatcher component in Talend
Open Studio Components Reference Guide.

4.3.3.2. Iterate connection settings

When you configure an Iterate connection, you are actually enabling parallel iterations. For further information,
see How to launch parallel iterations to read data.

4.3.3.3. Trigger connection settings

Run if connection settings

In the Basic settings view of a Run if connection, you can set the condition to the Subjob in Java. Pressing Ctrl
+Space allows you to access all global and context variables.
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4.4. Using contexts and variables
Variables represent values which change throughout the execution of a program. A global variable is a system
variable which can be accessed by any module or function. It retains its value after the function or program using
it has completed execution. A context variable is a variable which is defined by the user for a particular context.

Depending on the circumstances the Job is being used in, you might want to manage it differently for various
execution types, known as contexts (Prod and Test in the example given below). For instance, there might be
various testing stages you want to perform and validate before a Job is ready to go live for production use.

A context is characterized by parameters. These parameters are mostly context-sensitive variables which will be
added to the list of variables for reuse in the component-specific properties on the Component view through the
Ctrl+Space keystrokes.

Talend Studio offers you the possibility to create multiple context data sets. Furthermore you can either create
context data sets on a one-shot basis from the context tab of a Job, or you can centralize the context data sets in
the Contexts node of the Repository tree view in order to reuse them in different Jobs.

4.4.1. How to define context variables for a Job
You can define context variables for a particular Job in two ways:

• Using the Contexts view of the Job. See How to define context variables in the Contexts view.

• Using the F5 key from the Component view of a component. See How to define variables from the Component
view.

4.4.1.1. How to define context variables in the Contexts view

The Contexts view is positioned among the configuration tabs below design workspace.

If you cannot find the Contexts view on the tab system of Talend Studio, go to Window > Show view > Talend, and select
Contexts.

The Contexts tab view shows all of the variables that have been defined for each component in the current Job
and context variables imported into the current Job.
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From this view, you can manage your built-in variables:

• Create and manage built-in contexts.

• Create, edit and delete built-in variables.

• Reorganize the context variables.

• Add built-in context variables to the Repository.

• Import variables from a Repository context source for use in the current Job.

• Edit Repository-stored context variables and update the changes to the Repository.

• Remove imported Repository variables from the current Job.

The following example will demonstrate how to define two contexts named Prod and Test and a set of variables
- host, port, database, username, password, and table_name - under the two contexts for a Job.

Defining contexts

1. Open the Job in the design workspace.

2. Select the Contexts tab view and click the [+] button at the upper right corner of the view.

The [Configure Contexts] dialog box pops up. A context named Default has been created and set as the
default one by the system.
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3. Select the context Default, click the Edit... button and enter Prod in the [Rename Context] dialog box that
opens to rename the context Default to Prod.

Then click OK to close the dialog box.

4. Click the New... button and enter Test in the [Rename Context] dialog box. Then click OK to close the
dialog box.

5. Select the check box preceding the context you want to set as the default context. You can also set the default
context by selecting the context name from the Default context environment list in the Contexts tab view.

If needed, move a context up or down by selecting it and clicking the Up or Down button.

In this example, set Test as the default context and move it up.

6. Click OK to validate your context definition and close the [Configure Contexts] dialog box.

The newly created contexts are shown in the context variables table of the Contexts tab view.
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Defining variables

1. Click the [+] button at the bottom of the Contexts tab view to add a parameter line in the table.

2. Click in the Name field and enter the name of the variable you are creating, host in this example.

3. From the Type list, select the type of the variable corresponding to the component field where it will used,
String for the variable host in this example.

For different variable types, the Value field appear slightly different when you click in it and functions
differently:

Type Value field Default value

String (default type) Editable text field null

Boolean Drop-down list box with two options: true and false

Character, Double, Integer,
Long, Short, Object, BigDecimal

Editable text field

Date Editable text field, with a button to open the [Select Date
& Time] dialog box.

File Editable text field, with a button to open the [Open] dialog
box for file selection.

Directory Editable text field, with a button to open the [Browse for
Folder] dialog box for folder selection.

List of Value Editable text field, with a button to open the [Configure
Values] dialog box for list creation and configuration.

(Empty)
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Type Value field Default value

Password Editable text field; text entered appears encrypted.

It is recommended that you enclose the values of string type variables between double quotation marks to avoid
possible errors during Job execution.

4. Click in Value field and enter the variable value under each context.

5. If needed, select the check box next the variable of interest and enter the prompt message in the corresponding
Prompt field. This allows you to see a prompt for the variable value and to edit it at the execution time.

You can show/hide a Prompt column of the table by clicking the black right/left pointing triangle next to
the relevant context name.

6. Repeat the steps above to define all the variables in this example.

• port, type String,

• database, type String,

• username, type String,

• password, type Password,

• table_name, type String.

All the variables created and their values under different contexts are displayed in the table and are ready for
use in your Job. You can further edit the variables in this view if needed.

You can also add a built-in context variable to the Repository to make it reusable across different Jobs. For
more information, see How to add a built-in context variable to the Repository.

Related topics:

• How to define variables from the Component view

• How to centralize context variables in the Repository

• How to use variables in a Job

• How to run a Job in a selected context

4.4.1.2. How to define variables from the Component view

The quickest way to create a single context variable is to use the F5 key from the Component view:
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1. On the relevant Component view, place your cursor in the field you want to parameterize.

2. Press F5 to display the [New Context Parameter] dialog box:

3. Give a Name to this new variable, fill in the Comment field if needed, and choose the Type.

4. Enter a Prompt to be displayed to confirm the use of this variable in the current Job execution (generally
used for test purpose only), select the Prompt for value check box to display the prompt message and an
editable value field at the execution time.

5. If you filled in a value already in the corresponding properties field, this value is displayed in the Default
value field. Else, type in the default value you want to use for one context.

6. Click Finish to validate.

7. Go to the Contexts view tab. Notice that the context variables tab lists the newly created variables.

The newly created variables are listed in the Contexts view.

The variable name should follow some typing rules and should not contain any forbidden characters, such as space character.

The variable created this way is automatically stored in all existing contexts, but you can subsequently change the
value independently in each context. For more information on how to create or edit a context, see Defining contexts.

Related topics:

• How to define context variables in the Contexts view

• How to centralize context variables in the Repository

• How to use variables in a Job
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• How to run a Job in a selected context

4.4.2. How to centralize context variables in the
Repository

Context variables centrally stored in the Repository can be reused across various Jobs.

You can store context variables in the Repository in different ways:

• Creating a context group using the [Create / Edit a context group] wizard. See How to create a context group
and define context variables in it for details.

• Adding a built-in context variable to an existing or new context group in the Repository. See How to add a
built-in context variable to the Repository for details.

• Saving a context from metadata. See How to create a context from a Metadata  for more information.

4.4.2.1. How to create a context group and define context
variables in it

The following example will demonstrate how to use the [Create / Edit a context group] wizard to create a context
group named TalendDB that contains two contexts named Prod and Test and define a set of variables - host, port,
database, username, password, and table_name - under the two contexts in the Repository.

Create the context group and contexts

1. Right-click the Contexts node in the Repository tree view and select Create context group from the
contextual menu.

A 2-step wizard appears to help you define the various contexts and context parameters.

2. In Step 1 of 2, type in a name for the context group to be created, TalendDB in this example, and add any
general information such as a description if required. The information you provide in the Description field
will appear as a tooltip when you move your mouse over the context group in the Repository.
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3. Click Next to go to Step 2 of 2, which allows you to define the various contexts and variables that you need.

A context named Default has been created and set as the default one by the system.
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4. Click the [+] button at the upper right corner of the wizard to define contexts. The [Configure Contexts]
dialog box pops up.
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5. Select the context Default, click the Edit... button and enter Prod in the [Rename Context] dialog box that
opens to rename the context Default to Prod.

Then click OK to close the dialog box.

6. Click the New... button and enter Test in the [Rename Context] dialog box. Then click OK to close the
dialog box.

7. Select the check box preceding the context you want to set as the default context. You can also set the default
context by selecting the context name from the Default context environment list on the wizard.

If needed, move a context up or down by selecting it and clicking the Up or Down button.

In this example, set Test as the default context and move it up.

8. Click OK to validate your context definition and close the [Configure Contexts] dialog box.

The newly created contexts are shown in the context variables table of the wizard.
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Define context variables

1. Click the [+] button at the bottom of the wizard to add a parameter line in the table.

2. Click in the Name field and enter the name of the variable you are creating, host in this example.

3. From the Type list, select the type of the variable corresponding to the component field where it will used,
String for the variable host in this example.

For different variable types, the Value field appear slightly different when you click in it and functions
differently:

Type Value field Default value

String (default type) Editable text field null

Boolean Drop-down list box with two options: true and false

Character, Double, Integer,
Long, Short, Object, BigDecimal

Editable text field

Date Editable text field, with a button to open the [Select Date
& Time] dialog box.

File Editable text field, with a button to open the [Open] dialog
box for file selection.

Directory Editable text field, with a button to open the [Browse for
Folder] dialog box for folder selection.

List of Value Editable text field, with a button to open the [Configure
Values] dialog box for list creation and configuration.

(Empty)

Password Editable text field; text entered appears encrypted.

It is recommended that you enclose the values of string type variables between double quotation marks to avoid
possible errors during Job execution.

4. Click in Value field and enter the variable value under each context.

5. If needed, select the check box next the variable of interest and enter the prompt message in the corresponding
Prompt field. This allows you to see a prompt for the variable value and to edit it at the execution time.

You can show/hide a Prompt column of the table by clicking the black right/left pointing triangle next to
the relevant context name.
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6. Repeat the steps above to define all the variables in this example.

• port, type String,

• database, type String,

• username, type String,

• password, type Password,

• table_name, type String

All the variables created and their values under different contexts are displayed in the table and are ready for
use in your Job. You can further edit the variables if needed.

Once you created and adapted as many context sets as you want, click Finish to validate. The group of contexts thus
displays under the Contexts node in the Repository tree view. You can further edit the context group, contexts,
and context variables in the wizard by right-clicking the Contexts node and selecting Edit context group from
the contextual menu.

Related topics:

• How to add a built-in context variable to the Repository

• How to create a context from a Metadata

• How to apply context variables to a Job

• How to define context variables for a Job.

• How to use variables in a Job

• How to run a Job in a selected context
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4.4.2.2. How to add a built-in context variable to the Repository

You can save a built-in context variable defined in a Job to a new context group, or an existing context group
provided that the context variable does not already exist in the group.

1. In the Context tab view of a Job, right-click the context variable you want to add to the Repository and select
Add to repository context from the contextual menu to open the [Repository Content] dialog box.

2. In the dialog box, do either of the following:

• to add your context variable to a new context group, select Create new context group and enter a name
for the new context group in the Group Name field, and then click OK.

• to add your context variable to an existing context group, select the context group and click OK.

When adding a built-in context variable to an existing context group, make sure that the variable does not already
exist in the context group.

In this example, add the built-in context variable password to a new context group named DB_login.
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The context variable is added to the Repository context group of your choice, along with the defined built-in
contexts, and it appears as a Repository-stored context variable in the Contexts tab view.

Related topics:

• How to create a context group and define context variables in it

• How to create a context from a Metadata

• How to apply context variables to a Job

• How to define context variables for a Job.

• How to use variables in a Job

• How to run a Job in a selected context

4.4.2.3. How to create a context from a Metadata

When creating or editing a metadata connection (through a File or DB metadata wizard), you have the possibility
to save the connection parameters as context variables in a newly created context group under the Contexts node
of the Repository. To do so, complete your connection details and click the Export as context button in the second
step of the wizard.

For more information about this feature, see Exporting metadata as context and reusing context parameters to
set up a connection.

4.4.3. How to apply context variables to a Job

Once a context group is created and stored in the Repository, there are two ways of applying it to a Job:

• Drop a context group. This way, the group is applied as a whole. See How to drop a context group onto a Job
for details.

•
Use the context icon button . This way, the variables of a context group can be applied separately. See How
to apply context variables to a Job using the context icon button for details.
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4.4.3.1. How to drop a context group onto a Job

To drop a context group onto a Job, proceed as follows:

1. Double-click the Job to which a context group is to be added.

2. Once the Job is opened, drop the context group of your choice either onto the Job workspace or onto the
Contexts view beneath the workspace.

The Contexts view shows all the contexts and variables of the group. You can:

• edit the contexts by clicking the [+] button at the upper right corner of the Contexts view.

• delete the whole group or any variable by selecting the group name or the variable and clicking the [X]
button.

• save any imported context variable as a built-in variable by right-click it and selecting Add to built-in
from the contextual menu.

• double-click any context variable to open the context group in the [Create / Edit a context group] wizard
and update changes to the Repository.

4.4.3.2. How to apply context variables to a Job using the context
icon button

To use the context icon button to apply context variables to a Job, proceed as follows:

1. Double-click the Job to which a context variable is to be added.

2. Once the Job is opened in the workspace, click the Contexts view beneath the workspace to open it.

3. At the bottom of the Contexts view, click the button to open the wizard to select the context variables to
be applied.
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4. In the wizard, select the context variables you need to apply or clear those you do not need to.

The context variables that have been applied are automatically selected and cannot be cleared.

5. Click OK to apply the selected context variables to the Job.

The Contexts view shows the context group and the selected context variables. You can edit the contexts by
clicking the [+] button at the upper right corner of the Contexts view, delete the whole group or any variable
by selecting the group name or the variable and clicking the [X] button, but you cannot edit Repository-stored
variables in this view.

4.4.4. How to use variables in a Job

You can use an existing global variable, a context variable defined in your Job, or a Repository-stored context
variable applied to your Job in any component properties field.

1. In the relevant Component view, place your mouse in the field you want to parameterize and press Ctrl
+Space to display a full list of all the global variables and those context variables defined in or applied to
your Job.

The list grows along with new user-defined variables (context variables).
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2. Double-click the variable of your choice to fill it in the field.

Related topics:

• How to define context variables for a Job

• How to centralize context variables in the Repository

• How to apply context variables to a Job

• How to run a Job in a selected context

4.4.5. How to run a Job in a selected context

You can select the context you want the Job design to be executed in.

Click the Run Job tab, and in the Context area, select the relevant context among the various ones you created.

If you did not create any context, only the Default context shows on the list.

All the context variables you created for the selected context display, along with their respective values, in a table
underneath.

To make a change permanent in a variable value, you need to change it on the Context view if your variable is
of type built-in or in the Context group of the repository.
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Related topics:

• How to define context variables for a Job

• How to centralize context variables in the Repository

• How to apply context variables to a Job

• How to use variables in a Job

4.4.6. StoreSQLQuery

StoreSQLQuery is a user-defined variable and is mainly dedicated to debugging.

StoreSQLQuery is different from other context variables in the fact that its main purpose is to be used as parameter
of the specific global variable called Query. It allows you to dynamically feed the global query variable.

The global variable Query, is available on the proposals list (Ctrl+Space bar) for some DB input components.

For further details on StoreSQLQuery settings, see Talend Open Studio Components Reference Guide, and in
particular the scenarios of the tDBInput component.

4.5. Using parallelization to optimize Job
performance
Parallelization in terms of Talend Jobs means to accomplish technical processes through parallel executions. When
properly designed, a parallelization-enabled technical process can be completed within a shorter time frame.

Talend Studio allows you to implement different types of parallelization depending on ranging circumstances.
These circumstances could be:

1. Parallel executions of multiple Subjobs. For further information, see How to execute multiple Subjobs in parallel

2. Parallel iterations for reading data. For further information, see How to launch parallel iterations to read data

Parallelization is an advanced feature and requires basic knowledge about a Talend Job such as how to design
and execute a Job or a Subjob, how to use components and how to use the different types of connections that link
components or Jobs. If you feel that you need to acquire this kind of knowledge, see Designing a Job.

4.5.1. How to execute multiple Subjobs in parallel

The Multi thread execution feature allows you to run mutliple Subjobs that are active in the workspace in parallel.

As explained in the previous sections, a Job opened in the workspace can contain several Subjobs and you are
able to arrange their execution order using the trigger links such as OnSubjobOK. However, when the Subjobs
do not have any dependencies between them, you might want to launch them at the same time. For example, the
following image presents four Subjobs within a Job and with no dependencies in between.
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The tRunJob component is used in this example to call each Subjob they represent. For further information about
tRunJob, see Talend Open Studio Components Reference Guide.

Then with the Job opened in the workspace, you need simply proceed as follows to run the Subjobs in parallel:

1. Click the Job tab, then the Extra tab to display it.

2. Select the Multi thread execution check box to enable the parallel execution.

When the Use project settings check box is selected, the Multi thread execution check box could be greyed
out and become unavailable . In this situation, clear the Use project settings check box to activate the Multi
thread execution check box.

This feature is optimal when the number of threads (in general a Subjob count one thread) do not exceed the
number of processors of the machine you use for parallel executions. Otherwise, some of the Subjobs have to wait
until any processor is freed up.

4.5.2. How to launch parallel iterations to read data

A parallelization-enabled Iterate connection allows the component that receives threads from the connection to
read those threads in parallel.

You need to proceed as follows to set the parallel iterations:

1. Simply select the Iterate link of your subjob to display the related Basic settings view of the Components
tab.
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2. Select the Enable parallel execution check box and set the number of executions to be carried out in parallel.

When executing your Job, the number of parallel iterations will be distributed onto the available processors.

3. Select the Statistics check box of the Run view to show the real time parallel executions on the design
workspace.

This feature is especially useful when you need to use the Iterate connection to pass context variables to a Subjob.
In that situation, the variables will be read in parallel in the Subjob and thus the processes handled by the Subjob
will be simultaneously run using those variables.

4.6. Handling Jobs: advanced subjects
The sections below give detail information about various advanced configuration situations of a data integration
Job including handling multiple input and output flows, using SQL queries, using external components in the Job,
scheduling a task to run your Job.

4.6.1. How to map data flows

The most common way to handle multiple input and output flows in your Job including transformations and data
re-routing is to use the tMap component.

For more information about the principles of using this component, see Designing a Job.

For examples of Jobs using this component, see tMap in Talend Open Studio Components Reference Guide.

4.6.2. How to create queries using the SQLBuilder

SQLBuilder helps you create your SQL queries and monitor the changes between DB tables and metadata tables.
This editor is available in all DBInput and DBSQLRow components (specific or generic).

You can create a query using the SQLbuilder whether your database table schema is stored in the Repository tree
view or built-in directly in the Job.

Fill in the DB connection details and select the appropriate repository entry if you defined it.
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Remove the default query statement in the Query field of the Basic settings view of the Component panel. Then
click the [...] button to open the [SQL Builder] editor.

The [SQL Builder] editor is made of the following panels:

• Current Schema,

• Database structure,

• Query editor made of editor and designer tabs,

• Query execution view,

• Schema view.

The Database structure shows the tables for which a schema was defined either in the repository database entry
or in your built-in connection.

The schema view, in the bottom right corner of the editor, shows the column description.

4.6.2.1. How to compare database structures

On the Database Structure panel, you can see all tables stored in the DB connection metadata entry in the
Repository tree view, or in case of built-in schema, the tables of the database itself.

The connection to the database, in case of built-in schema or in case of a refreshing operation of a repository schema might
take quite some time.
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Click the refresh icon to display the differences between the DB metadata tables and the actual DB tables.

The Diff icons point out that the table contains differences or gaps. Expand the table node to show the exact column
containing the differences.

The red highlight shows that the content of the column contains differences or that the column is missing from
the actual database table.

The blue highlight shows that the column is missing from the table stored in Repository > Metadata.

4.6.2.2. How to create a query

The [SQL Builder] editor is a multiple-tab editor that allows you to write or graphically design as many queries
as you want.

To create a new query, complete the following:

1. Right-click the table or on the table column and select Generate Select Statement on the pop-up list.

2. Click the empty tab showing by default and type in your SQL query or press Ctrl+Space to access the
autocompletion list. The tooltip bubble shows the whole path to the table or table section you want to search in.
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Alternatively, the graphical query Designer allows you to handle tables easily and have real-time generation
of the corresponding query in the Edit tab.

3. Click the Designer tab to switch from the manual Edit mode to the graphical mode.

You may get a message while switching from one view to the other as some SQL statements cannot be interpreted
graphically.

4. If you selected a table, all columns are selected by default. Clear the check box facing the relevant columns
to exclude them from the selection.

5. Add more tables in a simple right-click. On the Designer view, right-click and select Add tables in the pop-
up list then select the relevant table to be added.

If joins between these tables already exist, these joins are automatically set up graphically in the editor.

You can also create a join between tables very easily. Right-click the first table columns to be linked and
select Equal on the pop-up list, to join it with the relevant field of the second table.
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The SQL statement corresponding to your graphical handlings is also displayed on the viewer part of the
editor or click the Edit tab to switch back to the manual Edit mode.

In the Designer view, you cannot include graphically filter criteria. You need to add these in the Edit view.

6.
Once your query is complete, execute it by clicking the  icon on the toolbar.

The toolbar of the query editor allows you to access quickly usual commands such as: execute, open, save
and clear.

The results of the active query are displayed on the Results view in the lower left corner.

7. If needed, you can select the context mode check box to keep the original query statement and customize
it properly in the Query area of the component. For example, if a context parameter is used in the query

statement, you cannot execute it by clicking the  icon on the toolbar.

8. Click OK. The query statement will be loaded automatically in the Query area of the component.

4.6.2.3. How to store a query in the repository

To be able to retrieve and reuse queries, we recommend you to store them in the repository.

In the [SQL Builder] editor, click the icon on the toolbar to bind the query with the DB connection and schema
in case these are also stored in the repository.

The query can then be accessed from the Database structure view, on the left-hand side of the editor.
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4.6.3. How to download/upload Talend Community
components

Talend Studio enables you to access a list of all community components in Talend Exchange that are compatible
with your current version of Talend Studio. You can then download and install these components to use them later
in the Job designs you carry out in the Studio. From Talend Studio, you can also upload components you have
created to Talend Exchange to share with other community users.

A click on the Exchange link on the toolbar of Talend Studio opens the Exchange tab view on the design
workspace, where you can find lists of:

• components available in Talend Exchange for you to download and install,

• components you downloaded and installed in previous versions of Talend Studio but not installed yet in your
current Studio, and

• components you have created and uploaded to Talend Exchange to share with other Talend Community users.

Note that the approach explained in this section is to be used for the above-mentioned components only.

• Before you can download community components or upload your own components to the community, you need to sign in
to Talend Exchange from your Studio first. If you did not sign in to Talend Exchange when launching the Studio, you
still have a chance to sign in from the Talend Exchange preferences settings page. For more information, see Exchange
preferences (Talend > Exchange).

• The community components available for download are not validated by Talend. This explains why you may encounter
component loading errors sometimes when trying to install certain community components, why an installed community
component may have a different name in the Palette than in the Exchange tab view, and why you may not be able to find
a component in the Palette after it is seemingly installed successfully.

4.6.3.1. How to install community components from Talend
Exchange

To install community components from Talend Exchange to the Palette of your current Talend Studio:

1. Click the Exchange link on the toolbar of Talend Studio to open the Exchange tab view on the design
workspace.
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2. In the Available Extensions view, if needed, enter a full component name or part of it in the text field and
click the fresh button to find quickly the component you are interested in.

3. Click the view/download link for the component of interest to display the component download page.

4. View the information about the component, including component description and review comments from
community users, or write your own review comments and/or rate the component if you want. For more
information on reviewing and rating a community component, see How to review and rate a community
component.

If needed, click the left arrow button to return to the component list page.

5. Click the Install button in the right part of the component download page to start the download and installation
process.

A progress indicator appears to show the completion percentage of the download and installation process.
Upon successful installation of the component, the Downloaded Extensions view opens and displays the
status of the component, which is Installed.
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4.6.3.2. How to reinstall or update community components

From the Exchange tab view, you can reinstall components you already downloaded and installed in your previous
version of Talend Studio or install the updated version of Talend Studio or components in your current Studio.

By default, while you are connected to Talend Exchange, a dialog box appears to notify you whenever an update to an
installed community component is available. If you often check for community component updates and you do not want
that dialog box to appear again, you can turn it off in Talend Exchange preferences settings. For more information, see
Exchange preferences (Talend > Exchange).

To reinstall a community component you already downloaded or update an installed one, do the following:

1. From the Exchange tab view, click Downloaded Extensions to display the list of components you have
already downloaded from Talend Exchange.

In the Downloaded Extensions view, the components you have installed in your previous version of Talend
Studio but not in your current Studio have an Install link in the Install/Update column, and those with
updates available in Talend Exchange have an Update link.

2. Click the Install or Update link for the component of interest to start the installation process.

A progress indicator appears to show the completion percentage of the installation process. Upon successful
installation, the Downloaded Extensions view displays the status of the component, which is Installed.

4.6.3.3. How to review and rate a community component

To review and rate a community component:

1. From the Available Extensions view, click the view/download link for the component you want to review
or rate to open the community component download page.

2. On the component download page, click the write a review link to open the [Review the component] dialog
box.
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3. Fill in the required information, including a title and a review comment, click one of the five stars to rate the
component, and click Submit Review to submit you review to the Talend Exchange server.

Upon validation by the Talend Exchange moderator, your review is published on Talend Exchange and
displayed in the User Review area of the component download page.

4.6.3.4. How to upload a component you created to Talend
Exchange

You can create your own components for use in your Jobs in Talend Studio and upload them to Talend Exchange
to share with other Talend Community users. For information on how to create your own components and deploy
them in Talend Studio, see How to define the user component folder (Talend > Components).

To upload a component you created to Talend Exchange, complete the following:

1. From the Exchange tab view, click My Extensions to open the My Extensions view.

2. Click the Add New Extension link in the upper right part of the view to open the component upload page.
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3. Complete the required information, including the component title, initial version, Studio compatibility
information, and component description, fill in or browse to the path to the source package in the File field,
and click the Upload Extension button.

Upon successful upload, the component is listed in the My Extensions view, where you can update, modify
and delete any component you have uploaded to Talend Exchange.

4.6.3.5. How to manage components you uploaded to Talend
Exchange

From the Exchange tab view, you can manage components you have uploaded to Talend Exchange,
including updating component version, modifying component information, and deleting components from Talend
Exchange.

To update the version of a component, complete the following:

1. From the My Extensions view, click the  icon in the Operation column for the component your want to
update to open the component update page.
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2. Fill in the initial version and Studio compatibility information, fill in or browse to the path to the source
package in the File field, and click the Update Extension button.

Upon successful upload of the updated component, the component is replaced with the new version on Talend
Exchange and the My Extension view displays the component's new version and update date.

To modify the information of a component uploaded to Talend Exchange, complete the following:

1.
From the My Extensions view, click the  icon in the Operation column for the component your want to
modify information for to open the component information editing page.

2. Complete the Studio compatibility information and component description, and click the Modify Extension
button to update the component information to Talend Exchange.
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To delete a component you have uploaded to Talend Exchange, click  icon for the component from the My
Extensions view. The component is then removed from Talend Exchange and is no longer displayed on the
component list in the My Extensions view.

4.6.4. How to launch a Job periodically (feature
deprecated)

This section describes the Job scheduler feature which is deprecated but still available for use.

The Scheduler view in Talend Studio helps you to schedule a task that will launch periodically a Job via a task
scheduling (crontab) program.

Through the Scheduler view, you can generate a crontab file that holds cron-compatible entries (the data required
to launch the Job). These entries will allow you to launch periodically a Job via the crontab program.

This Job launching feature is based on the crontab command, found in Unix and Unix-like operating systems. It
can be also installed on any Windows system.

To access the Scheduler view, click the Scheduler tab in the design workspace.

If the Scheduler tab does not display on the tab system of your design workspace, go to Window > Show View... > Talend,
and then select Scheduler from the list.

This view is empty if you have not scheduled any task to run a Job. Otherwise, it lists the parameters of all the
scheduled tasks.

The procedure below explains how to schedule a task in the Scheduler view to run a specific Job periodically and
then generate the crontab file that will hold all the data required to launch the selected Job. It also points out how
to use the generated file with the crontab command in Unix or a task scheduling program in Windows.

1.
Click the  icon in the upper right corner of the Scheduler view.

The [Open Scheduler] dialog box displays.
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2. From the Project list, select the project that holds the Job you want to launch periodically.

3. Click the three-dot button next to the Job field and select the Job you want to launch periodically.

4. From the Context list, if more than one exists, select the desired context in which to run the Job.

5. Set the time and date details necessary to schedule the task.

The command that will be used to launch the selected Job is generated automatically and attached to the
defined task.

6. Click Add this entry to validate your task and close the dialog box.

The parameters of the scheduled task are listed in the Scheduler view.

7.
Click the  icon in the upper right corner of the Scheduler view to generate a crontab file that will hold
all the data required to start the selected Job.

The [Save as] dialog box displays.

8. Browse to set the path to the crontab file you are generating, enter a name for the crontab file in the File
name field, and then click Save to close the dialog box.

The crontab file corresponding to the selected task is generated and stored locally in the defined path.

9. In Unix, paste the content of the crontab file into the crontab configuration of your Unix system; in Windows,
install a task scheduling program that will use the generated crontab file to launch the selected Job.

You can use the  icon to delete any of the listed tasks and the  icon to edit the parameters of any of the
listed tasks.
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4.6.5. How to use the tPrejob and tPostjob
components

The tPrejob and tPostjob components are designed to make the execution of tasks before and after a given job
easier to manage. These components differ from other components in that they do not actually process data and
they do not have any components properties to be configured. A key feature of these components is that they are
always guaranteed to be executed, even if the main data Job fails. Therefore, they are very useful for setup and
teardown actions for a given Job.

As tPrejob and tPostjob are not meant to take part in any data processing, they cannot be part of a multi-thread execution.
They are meant to help you make your Job design clearer.

To use these tPrejob and tPostjob components, simply drop them onto the design workspace as you would do
with any other components, and then connect tPrejob to a component or subjob that is meant to perform a pre-job
task, and tPostjob to a component or subjob that is meant to perform a post-job task, using Trigger connections.
An orange square on the pre- and post-job parts indicates that they are different types of subjobs.

Tasks that require the use of a tPrejob component include:

• Loading context information required for the subjob execution.

• Opening a database connection.

• Making sure that a file exists.

Tasks that require the use of a tPostjob component include:

• Cleaning up temporary files created during the processing of the main data Job.

• Closing a database connection or a connection to an external service.

• Any task required to be executed, even if the preceding Job or subjobs failed.

For use cases that use the tPrejob and tPostjob components, see Talend Open Studio Components Reference
Guide.

4.6.6. How to use the Use Output Stream feature

The Use Output Stream feature allows you to process the data in byte-arrays using a java.io.outputstream() class
which writes data using binary stream without data buffering. When processing data with a linear format, for
example, when all data is of String format, this feature will help you improve the overall output performance.
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The Use Output Stream feature can be found in the Basic settings view of a number of components such as
tFileOutputDelimited.

To use this feature, select Use Output Stream check box in the Basic settings view of a component that has this
feature. In the Output Stream field that is thus enabled, define your output stream using a command.

Prior to use the output stream feature, you have to open a stream. For a detailed example of the illustration of this prerequisite
and the usage of the Use Output Stream feature, see Using the output stream feature. For an example of Job using this
feature, see the second scenario of tFileOutputDelimited in Talend Open Studio Components Reference Guide.

4.7. Handling Jobs: miscellaneous subjects
The sections below give detail information about various subjects related to the management of a data integration
Job including defining the start component, handling errors, and searching for jobs that use specific components.

4.7.1. How to use folders

You can organize your Jobs into folders.

To create a folder, proceed as follows:

1. In the Repository tree view of the Integration perspective, right-click Job Designs and select Create folder
from the contextual menu.

The [New folder] dialog box displays.
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2. In the Label field, enter a name for the folder and then click Finish to confirm your changes and close the
dialog box.

The created folder is listed under the Job Designs node in the Repository tree view.

If you have already created Jobs that you want to move into this new folder, simply drop them into the folder.

4.7.2. How to define component properties

The properties information for each component forming a Job or a subjob allows to set the actual technical
implementation of the active Job.

Each component is defined by basic and advanced properties shown respectively on the Basic Settings tab and
the Advanced Settings tab of the Component view of the selected component in the design workspace. The
Component view gathers also other collateral information related to the component in use, including View and
Documentation tabs.

For more an example of a basic Job design, see Getting started with a basic Job.

4.7.2.1. Basic Settings tab

The Basic Settings tab is part of the Component view, which is located on the lower part of the designing editor
of the Integration perspective of Talend Studio.

Each component has specific basic settings according to its function requirements within the Job. For a detailed
description of each component properties and use, see Talend Open Studio Components Reference Guide.

Some components require code to be input or functions to be set. Make sure you use Java code in properties.

For File and Database components, you can centralize properties in metadata files located in the Metadata
directory of the Repository tree view. This means that on the Basic Settings tab you can set properties on the
spot, using the Built-In Property Type or use the properties you stored in the Metadata Manager using the
Repository Property Type. The latter option helps you save time.

Select Repository as Property Type and choose the metadata file holding the relevant information. Related topic:
Managing Metadata.

Alternatively, you can drop the Metadata item from the Repository tree view directly to the component already
dropped on the design workspace, for its properties to be filled in automatically.
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If you selected the Built-in mode and set manually the properties of a component, you can also save those
properties as metadata in the Repository. To do so:

1. Click the floppy disk icon. The metadata creation wizard corresponding to the component opens.

2. Follow the steps in the wizard. For more information about the creation of metadata items, see Managing
Metadata.

3. The metadata displays under the Metadata node of the Repository.

For all components that handle a data flow (most components), you can define a Talend schema in order to
describe and possibly select the data to be processed. Like the Properties data, this schema is either Built-in or
stored remotely in the Repository in a metadata file that you created. A detailed description of the Schema setting
is provided in the next sections.

How to set a built-in schema

A schema created as Built-in is meant for a single use in a Job, hence cannot be reused in another Job.

Select Built-in in the Property Type list of the Basic settings view, and click the Edit Schema button to create
your built-in schema by adding columns and describing their content, according to the input file definition.

In all output properties, you also have to define the schema of the output. To retrieve the schema defined in the
input schema, click the Sync columns tab in the Basic settings view.

When creating a database table, you are recommended to specify the Length field for all columns of type String, Integer or
Long and specify the Precision field for all columns of type Double, Float or BigDecimal in the schema of the component
used. Otherwise, unexpected errors may occur.

Some extra information is required. For more information about Date pattern for example, check out: http://docs.oracle.com/
javase/6/docs/api/index.html.

How to set a repository schema

If you often use certain database connections or specific files when creating your data integration Jobs, you can
avoid defining the same properties over and over again by creating metadata files and storing them in the Metadata
node in the Repository tree view of the Integration perspective.

http://docs.oracle.com/javase/6/docs/api/index.html
http://docs.oracle.com/javase/6/docs/api/index.html


How to define component properties

Talend Open Studio for MDM User Guide 133

To recall a metadata file into your current Job, select Repository in the Schema list and then select the relevant
metadata file. Or, drop the metadata item from the Repository tree view directly to the component already dropped
on the design workspace. Then click Edit Schema to check that the data is appropriate.

You can edit a repository schema used in a Job from the Basic settings view. However, note that the schema hence
becomes Built-in in the current Job.

You can also use a repository schema partially. For more information, see How to use a repository schema
partially.

You cannot change the schema stored in the repository from this window. To edit the schema stored remotely, right-click it
under the Metadata node and select the corresponding edit option (Edit connection or Edit file) from the contextual menu.

Related topics: Managing Metadata.

How to use a repository schema partially

When using a repository schema, if you do not want to use all the predefined columns, you can select particular
columns without changing the schema into a built-in one:

The following describes how to use a repository schema partially for a database input component. The procedure
may vary slightly according to the component you are using.

1. Click the [...] button next to Edit schema on the Basic settings tab. The [Edit parameter using repository]
dialog box appears. By default, the option View schema is selected.
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2. Click OK. The [Schema] dialog box pops up, which displays all columns in the schema. The Used Column
check box before each column name indicates whether the column is used.

3. Select the columns you want to use.

4. Click OK. A message box appears, which prompts you to do a guess query.

The guess query operation is needed only for the database metadata.
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5. Click OK to close the message box. The [Propagate] dialog box appears. Click Yes to propagate the changes
and close the dialog box.

6. On the Basic settings tab, click Guess Query. The selected column names are displayed in the Query area
as expected.

For more information about how to set a repository schema, see How to set a repository schema.

How to set a field dynamically (Ctrl+Space bar)

On any field of your Job/component Properties view, you can use the Ctrl+Space bar to access the global and
context variable list and set the relevant field value dynamically.

1. Place the cursor on any field of the Component view.

2. Press Ctrl+Space bar to access the proposal list.

3. Select on the list the relevant parameters you need. Appended to the variable list, a information panel provides
details about the selected parameter.
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This can be any parameter including: error messages, number of lines processed, or else... The list varies
according to the component in selection or the context you are working in.

Related topic: Using contexts and variables.

4.7.2.2. Advanced settings tab

Some components, especially File and Databases components, provides numerous advanced use possibilities.

The content of the Advanced settings tab changes according to the selected component.

Generally you will find on this tab the parameters that are not required for a basic or usual use of the component
but may be required for a use out of the standard scope.

How to measure data flows

You can also find in the Advanced settings view the option tStatCatcher Statistics that allows you, if selected,
to display logs and statistics about the current Job without using dedicated components. For more information
regarding the stats & log features, see How to automate the use of statistics & logs.
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4.7.2.3. Dynamic settings tab

The Basic settings and Advanced settings tabs of all components display various check boxes and drop-down
lists for component parameters. Usually, available values for these types of parameters can only be edited when
designing your Job.

The Dynamic settings tab, on the Component view, allows you to customize these parameters into code or
variable.

This feature allows you, for example, to define these parameters as variables and thus let them become context-
dependent, whereas they are not meant to be by default.

Another benefit of this feature is that you can now change the context setting at execution time. This makes full
sense when you intend to export your Job in order to deploy it onto a Job execution server for example.

To customize these types of parameters, as context variables for example, follow the following steps:

1. Select the relevant component basic settings or advanced settings view that contains the parameter you want
to define as a variable.

2. Click the Dynamic settings tab.

3. Click the plus button to display a new parameter line in the table.

4. Click the Name of the parameter displaying to show the list of available parameters. For example: Print
operations

5. Then click in the facing Code column cell and set the code to be used. For example: context.verbose if you
create the corresponding context variable, called verbose.

As code, you can input a context variable or a piece of Java code.

The corresponding lists or check boxes thus become unavailable and are highlighted in yellow in the Basic
settings or Advanced settings tab.
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If you want to set a parameter as context variable, make sure you create the corresponding variable in the Contexts view.

For more information regarding the context variable definition, see How to define context variables in the Contexts view.

For use cases showing how to define a dynamic parameter, see the scenario of tMysqlInput about reading data
from MySQL databases through context-based dynamic connections and the scenario of tContextLoad in Talend
Open Studio Components Reference Guide.

4.7.2.4. View tab

The View tab of the Component view allows you to change the default display format of components on the
design workspace.

Field Description

Label format Free text label showing on the design workspace. Variables can be set to retrieve and display
values from other fields. The field tooltip usually shows the corresponding variable where the
field value is stored.

Hint format Hidden tooltip, showing only when you mouse over the component.

Connection format Indicates the type of connection accepted by the component.

You can graphically highlight both Label and Hint text with HTML formatting tags:

• Bold: <b> YourLabelOrHint </b>

• Italic: <i> YourLabelOrHint </i>

• Return carriage: YourLabelOrHint <br> ContdOnNextLine

• Color: <Font color= ‘#RGBcolor'> YourLabelOrHint </Font>

To change your preferences of this View panel, click Window>Preferences>Talend>Designer.

4.7.2.5. Documentation tab

Feel free to add any useful comment or chunk of text or documentation to your component.
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In the Documentation tab, you can add your text in the Comment field. Then, select the Show Information
check box and an information icon display next to the corresponding component in the design workspace.

You can show the Documentation in your hint tooltip using the associated variable _COMMENT_, so that when
you place your mouse on this icon, the text written in the Comment field displays in a tooltip box.

For advanced use of Documentations, you can use the Documentation view in order to store and reuse any type
of documentation.

4.7.3. How to share a database connection

If you have various Jobs using the same database connection, you can factorize the connection by using the Use
or register a shared DB Connection option so that the connection can be shared between parent and child Jobs.

This option has been added to all database connection components in order to reduce the number of connections
to open and close.

The Use or register a shared DB Connection option of all database connection components is incompatible with the Use
dynamic job and Use an independent process to run subjob options of the tRunJob component. Using a shared database
connection together with a tRunJob component with either of these two options enabled will cause your Job to fail.

Assume that you have two related Jobs (a parent Job and a child Job) that both need to connect to your remote
MySQL database. To use a shared database connection in the two Jobs, to the following:

1. Add a tMysqlConnection (assuming that you work with a MySQL database) to both the parent and the child
Job, if they are not using a database connection component.

2. Connect each tMysqlConnection to the relevant component in your Jobs using a Trigger > On Subjob Ok
link.
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3. In the Basic settings view of the tMysqlConnection component that will run first, fill in the database
connection details if the database connection is not centrally stored in the Repository.

4. Select the Use or register a shared DB Connection check box, and give a name to the connection in the
Shared DB Connection Name field.

You are now able to re-use the connection in your child Job.

5. In the Basic settings view of the other tMysqlConnection component, which is in the other Job, simply
select Use or register a shared DB Connection check box, and fill the Shared DB Connection Name field
with the same name as in the parent Job.

Among the different Jobs sharing the same database connection, you need to define the database connection details
only in the first Job that needs to open the database connection.

For a complete use case, see the scenario of the tMysqlConnection component showing how to share a database
connection between different Jobs in Talend Open Studio Components Reference Guide.

For more information about how to use the Connection components, see Talend Open Studio Components
Reference Guide.

4.7.4. How to define the Start component

The Start component is the trigger of a Job. There can be several Start components per Job design if there are
several flows running in parallel. But for one flow and its connected subflows, only one component can be the
Start component.

Drop a component to the design workspace, all possible start components take a distinctive bright green
background color. Notice that most of the components, can be Start components.

Only components which do not make sense to trigger a flow, will not be proposed as Start components, such as
the tMap component for example.
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To distinguish which component is to be the Start component of your Job, identify the main flow and the secondary
flows of your Job.

• The main flow should be the one connecting a component to the next component using a Row type link. The
Start component is then automatically set on the first component of the main flow (icon with green background).

• The secondary flows are also connected using a Row-type link which is then called Lookup row on the design
workspace to distinguish it from the main flow. This Lookup flow is used to enrich the main flow with more data.

Be aware that you can change the Start component hence the main flow by changing a main Row into a Lookup
Row, simply through a right-click the row to be changed.

Related topics:

• Connecting the components together

• Activating/Deactivating a component or a subjob

4.7.5. How to handle error icons on components or
Jobs

When the properties of a component are not properly defined and contain one or several errors that can prevent
the Job code to compile properly, error icons will automatically show next to the component icon on the design
workspace and the Job name in the Repository tree view.

4.7.5.1. Warnings and error icons on components

When a component is not properly defined or if the link to the next component does not exist yet, a red checked
circle or a warning sign is docked at the component icon.

Mouse over the component, to display the tooltip messages or warnings along with the label. This context-sensitive
help informs you about any missing data or component status.
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When the tooltip messages of a component indicate that a module is required, you must install this module for this component
using the Module view. This view is hidden by default. For further information about how to install external modules using
this view, see the Talend Installation and Upgrade Guide.

4.7.5.2. Error icons on Jobs

When the component settings contain one or several errors that can prevent the Job code to compile properly, an
icon will automatically show next to the Job name in the Repository tree view.

The error icon displays as well on the tab next to the Job name when you open the Job on the design workspace.

The compilation or code generation does only take place when carrying out one of the following operations:

• opening a Job,

• clicking on the Code Viewer tab,

• executing a Job (clicking on Run Job),

• saving the Job.

Hence, the red error icon will only show then.

When you execute the Job, a warning dialog box opens to list the source and description of any error in the current
Job.
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Click Cancel to stop your Job execution or click Continue to continue it.

For information on errors on components, see Warnings and error icons on components.

4.7.6. How to add notes to a Job design

In the Palette, click the Misc family and then drop the Note element to the design workspace to add a text comment
to a particular component or to the whole Job.

You can change the note format. To do so, select the note you want to format and click the Basic setting tab of
the Component view.

Select the Opacity check box to display the background color. By default, this box is selected when you drop a
note on the design workspace. If you clear this box, the background becomes transparent.

You can select options from the Fonts and Colors list to change the font style, size, color, and so on as well as
the background and border color of your note.

You can select the Adjust horizontal and Adjust vertical boxes to define the vertical and horizontal alignment
of the text of your note.
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The content of the Text field is the text displayed on your note.

4.7.7. How to display the code or the outline of your
Job

This panel is located below the Repository tree view. It displays detailed information about the open Job or
Business Model in the design workspace.

The Information panel is composed of two tabs, Outline and Code Viewer, which provide information regarding
the displayed diagram (either Job or Business Model).

4.7.7.1. Outline

The Outline tab offers a quick view of the business model or the open Job on the design workspace and also a
tree view of all used elements in the Job or Business Model.As the design workspace, like any other window area,
can be resized to suit your needs, the Outline view provides a convenient way for you to check out where on your
design workspace you are located.

This graphical representation of the diagram highlights in a blue rectangle the diagram part showing in the design
workspace.

Click the blue-highlighted view and hold down the mouse button. Then, move the rectangle over the Job.

The view in the design workspace moves accordingly.
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The Outline view can also be displaying a folder tree view of components in use in the current diagram. Expand
the node of a component, to show the list of variables available for this component.

To switch from the graphical outline view to the tree view, click either icon docked at the top right of the panel.

4.7.7.2. Code viewer

The Code viewer tab provides lines of code generated for the selected component, behind the active Job design
view, as well the run menu including Start, Body and End elements.

This view only concerns the Job design code, as no code is generated from Business Models.

Using a graphical colored code view, the tab shows the code of the component selected in the design workspace.
This is a partial view of the primary Code tab docked at the bottom of the design workspace, which shows the
code generated for the whole Job.

4.7.8. How to manage the subjob display
A subjob is graphically defined by a blue square gathering all connected components that belong to this subjob.
Each individual component can be considered as a subjob when they are not yet connected to one another.

This blue highlight helps you easily distinguish one subjob from another.

A Job can be made of one single subjob. An orange square shows the prejob and postjob parts which are different types
of subjobs.

For more information about prejob and postjob, see How to use the tPrejob and tPostjob components.

4.7.8.1. How to format subjobs

You can modify the subjob color and its title color. To do so, select your subjob and click the Component view.

In the Basic setting view, select the Show subjob title check box if you want to add a title to your subjob, then
fill in a title.

To modify the title color and the subjob color:
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1. In the Basic settings view, click the Title color/Subjob color button to display the [Colors] dialog box.

2. Set your colors as desired. By default, the title color is blue and the subjob color is transparent blue.

4.7.8.2. How to collapse the subjobs

If your Job is made of numerous subjobs, you can collapse them to improve the readability of the whole Job. The
minus ([-]) and plus ([+]) signs on the top right-hand corner of the subjob allow you to collapse and restore the
complete subjob.

Click the minus sign ([-]) to collapse the subjob. When reduced, only the first component of the subjob is displayed.

Click the plus sign ([+]) to restore your subjob.

4.7.8.3. How to remove the subjob background color

If you do not want your subjobs to be highlighted, you can remove the background color on all or specific subjobs.

To remove the background color of all your subjobs, click the Toggle Subjobs icon on the toolbar of Talend Studio.

To remove the background color of a specific subjob, right-click the subjob and select the Hide subjob option
on the pop-up menu.
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4.7.9. How to define options on the Job view

On the Job view located on the bottom part of the design workspace, you can define Job's optional functions. This
view is made of two tabs: Stats & Logs tab and Extra tab.

The Stats & Logs tab allows you to automate the use of Stats & Logs features and the Context loading feature.
For more information, see How to automate the use of statistics & logs.

The Extra tab lists various options you can set to automate some features such as the context parameters use, in
the Implicit Context Loading area. For more information, see How to use the features in the Extra tab.

4.7.9.1. How to automate the use of statistics & logs

If you have a great need of log, statistics and other measurement of your data flows, you are facing the
issue of having too many log-related components loading your Job Designs. You can automate the use of
tFlowMeterCatcher, tStatCatcher, tLogCatcher component functionalities without using the components in
your Job via the Stats & Logs tab.

For more information regarding the Log component, see Talend Open Studio Components Reference Guide.

The Stats & Logs panel is located on the Job tab underneath the design workspace and prevents your Jobs Designs
to be overloaded by components.

This setting supersedes the log-related components with a general log configuration.

To set the Stats & Logs properties:

1. Click the Job tab.

2. Select the Stats & Logs panel to display the configuration view.
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3. Set the relevant details depending on the output you prefer (console, file or database).

4. Select the relevant Catch check box according to your needs.

You can save the settings into your Project Settings by clicking the  button. This way, you can

access such settings via File > Edit project settings > Job settings > Stats & Logs or via the  button on the toolbar.

When you use Stats & Logs functions in your Job, you can apply them to all its subjobs.

To do so, click the Apply to subjobs button in the Stats & Logs panel of the Job view and the selected stats &
logs functions of the main Job will be selected for all of its subjobs.

4.7.9.2. How to use the features in the Extra tab

The Extra tab offers some optional function parameters.

• Select the Multithread execution check box to allow two Job executions to start at the same time.

• Set the Implicit tContextLoad option parameters to avoid using the tContextLoad component on your Job
and automate the use of context parameters.

Choose between File and Database as source of your context parameters and set manually the file or database
access.

Set notifications (error/warning/info) for unexpected behaviors linked to context parameter setting.

• When you fill in Implicit tContextLoad manually, you can store these parameters in your project by clicking
the Save to project settings button, and thus reuse these parameters for other components in different Jobs.

• Select the Use Project Settings check box to recuperate the context parameters you have already defined in
the Project Settings view.

The Implicit tContextLoad option becomes available and all fields are filled in automatically.

For more information about context parameters, see Context settings.

• Click Reload from project settings to update the context parameters list with the latest context parameters
from the project settings.

4.7.10. How to find components in Jobs

You should open one Job at least in the Studio to display the Palette to the right of the design workspace and thus start
the search.

From the Palette, you can search for all the Jobs that use the selected component. To do so:



How to find components in Jobs

Talend Open Studio for MDM User Guide 149

1. In the Palette, right-click the component you want to look for and select Find Component in Jobs.

A progress indicator displays to show the percentage of the search operation that has been completed then
the [Find a Job] dialog box displays listing all the Jobs that use the selected component.

2. From the list of Jobs, click the desired Job and then click OK to open it on the design workspace.
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4.7.11. How to set default values in the schema of an
component

You can set default values in the schema of certain components to replace null values retrieved from the data
source.

At present, only tFileInputDelimited, tFileInputExcel, and tFixedFlowInput support default values in the schema.

In the following example, the company and city fields of some records of the source CSV file are left blank, as
shown below. The input component reads data from the source file and completes the missing information using
the default values set in the schema, Talend and Paris respectively.

id;firstName;lastName;company;city;phone
1;Michael;Jackson;IBM;Roma;2323
2;Elisa;Black;Microsoft;London;4499
3;Michael;Dujardin;;;8872
4;Marie;Dolvina;;;6655
5;Jean;Perfide;;;3344
6;Emilie;Taldor;Oracle;Madrid;2266
7;Anne-Laure;Paldufier;Apple;;4422

To set default values:

1. Double-click the input component tFileInputDelimited to show its Basic settings view.

In this example, the metadata for the input component is stored in the Repository. For information about
metadata creation in the Repository, see Managing Metadata.

2. Click the [...] button next to Edit schema, and select the Change to built-in property option from the pop-
up dialog box to open the schema editor.

3. Enter Talend between quotation marks in the Default field for the company column, enter Paris between
quotation marks in the Default field for the city column, and click OK to close the schema editor.
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4. Configure the output component tLogRow to display the execution result the way you want, and then run
the Job.

In the output data flow, the missing information is completed according to the set default values.
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Chapter 5. Managing Jobs
This chapter describes the management procedures you can carry out on the Jobs you design in Talend Studio or
you can carry out on any of the items included in a project, for example routines or metadata.

These management procedures include importing and exporting Jobs and items between different projects or
machines, scheduling Job execution, etc.
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5.1. Activating/Deactivating a component or a
subjob
You can activate or deactivate a subjob directly connected to the selected component. You can also activate or
deactivate a single component as well as all the subjobs linked to a Start component. The Start component is the
trigger of the Job. It has a green background. For more information about Start components, see How to define
the Start component.

When a component or a subjob is deactivated, you are not able to create or modify links from or to it. Moreover,
at runtime, no code is generated for the deactivated component or subjob.

5.1.1. Activate or deactivate a component

To activate or deactivate a component, proceed as follows:

1. Right-click the component you want to activate or deactivate, the tFixedFlowInput component for example.

2. Select the option corresponding to the action you want to perform:

• Activate tFixedFlowInput_1 if you want to activate it.

• Deactivate tFixedFlowInput_1 if you want to deactivate it.

5.1.2. Activate or deactivate a subjob

To activate or deactivate a subjob, proceed as follows:
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1. Right-click any component composing the subjob.

2. Select the option corresponding to the action you want to perform:

• Activate current Subjob if you want to activate it.

• Deactivate current Subjob if you want to deactivate it.

5.1.3. Activate or deactivate all linked subjobs

To activate or deactivate all linked subjobs, proceed as follows:

1. Right-click the Start component.

2. Select the option corresponding to the action you want to perform:

• Activate all linked Subjobs if you want to activate them.

• Deactivate all linked Subjobs if you want to deactivate them.

5.2. Importing/exporting items and building
Jobs
Talend Studio enables you to import/export your Jobs or items in your Jobs from/to various projects or various
versions of the Studio. It enables you as well to build Jobs and thus deploy and execute those created in the Studio
on any server.

5.2.1. How to import items

You can import items from previous versions of Talend Studio or from a different project of your current version.

The items you can possibly import are multiple:

• Business Models

• Jobs Designs

• Routines

• Documentation

• Metadata

To import items, right-click any entry such as Job Designs or Business Models in the Repository tree view and

select Import Items from the contextual menu or directly click the  icon on the toolbar to open the [Import
items] dialog box and then select an import option.
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To import items stored in a local directory, do the following:

1. Click the Select root directory option in the [Import items] dialog box.

2. Click Browse to browse down to the relevant project folder within the workspace directory. It should
correspond to the project name you picked up.
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3. If you only want to import very specific items such as some Job Designs, you can select the specific folder,
such as Process where all the Job Designs for the project are stored. If you only have Business Models to
import, select the specific folder: BusinessProcess, and click OK.

But if your project gathers various types of items (Business Models, Jobs Designs, Metadata, Routines...),
we recommend you to select the project folder to import all items in one go, and click OK.

4. If needed, select the overwrite existing items check box to overwrite existing items with those having the
same names to be imported. This will refresh the Items List.

5. From the Items List which displays all valid items that can be imported, select the items that you want to
import by selecting the corresponding check boxes.

6. Click Finish to validate the import.

To import items from an archive file (including source files and scripts), do the following:

1. Click the Select archive file option in the [Import items] dialog box.

2. Browse to the desired archive file and click Open.

3. If needed, select the overwrite existing items check box to overwrite existing items with those having the
same names to be imported. This will refresh the Items List.

4. From the Items List which displays all valid items that can be imported, select the items that you want to
import by selecting the corresponding check boxes.

5. Click Finish to validate the import.
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To import items from Talend Exchange, do the following:

1. Click the Select archive file option in the [Import items] dialog box. Then, click BrowseTalendExchange
to open the [Select an item from Talend Exchange] dialog box.

2. Select the desired category from the Category list, and select the desired version from the
TOS_VERSION_FILTER list.

A progress bar appears to indicate that the extensions are being downloaded. At last, the extensions for the
selected category and version will be shown in the dialog box.

3. Select the extension that you want to import from the list.

Click Finish to close the dialog box.

4. If needed, select the overwrite existing items check box to overwrite existing items with those having the
same names to be imported. This will refresh the Items List.

5. From the Items List which displays all valid items that can be imported, select the items that you want to
import by selecting the corresponding check boxes.

6. Click Finish to validate the import.

If there are several versions of the same items, they will all be imported into the Project you are running, unless you already
have identical items.
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5.2.2. How to build Jobs

The Build Job feature allows you to deploy and execute a Job on any server, independent of Talend Studio.

The build Job feature adds all of the files required to execute the Job to an archive, including the .bat and .sh along
with any context-parameter files or other related files.

By default, when a Job is built, all the required jars are included in the .bat or .sh command. For a complex Job that
involves many Jars, the number of characters in the batch command may exceed the limitation of command length
on certain operating systems. To avoid failure of running the batch command due to this limitation, before building
your Job, go to Window > Preferences, select Talend > Import/Export, and then select the Add classpath jar
in exported jobs check box to wrap the Jars in a classpath.jar file added to the built Job.

To build Jobs, complete the following:

1. In the Repository tree view, right-click the Job you want to build, and select Build Job to open the [Build
Job] dialog box.

You can show/hide a tree view of all created Jobs in Talend Studio directly from the [Build Job] dialog box by clicking

the  and the  buttons respectively. The Jobs you earlier selected in the Studio tree view display with selected
check boxes. This accessibility helps to modify the selected items to be exported directly from the dialog box without
having to close it and go back to the Repository tree view in Talend Studio to do that.

2. In the To archive file field, browse to the directory where you want to save your built Job.

3. From the Select the Job version area, select the version number of the Job you want to build if you have
created more than one version of the Job.

4. Select the Build Type from the list between Standalone Job, Axis Webservice (WAR), Axis Webservice
(Zip), JBoss ESB, Petals ESB and OSGI Bundle For ESB.

If the data service Job includes the tRESTClient or tESBConsumer component, and none of the Service
Registry, Service Locator or Service Activity Monitor is enabled in the component, the data service Job can
be built as OSGI Bundle For ESB or Standalone Job. With the Service Registry, Service Locator or Service
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Activity Monitor enabled, the data service Job including the tRESTClient or tESBConsumer component
can only be built as OSGI Bundle For ESB.

5. Select the Extract the zip file check box if you want the archive file to be automatically extracted in the
target directory.

6. In the Options area, select the file type(s) you want to add to the archive file. The check boxes corresponding
to the file types necessary for the execution of the Job are selected by default. You can clear these check
boxes depending on what you want to build.

Option Description

Shell launcher Select this check box to export the .bat and/or .sh files necessary to launch the built Job.

• All: exports the .bat and .sh files.

• Unix exports the .sh file.

• Windows exports the .bat file.

Context scripts Select this check box to export ALL context parameters files and not just those you select
in the corresponding list.

To export only one context, select the context that fits your needs from the
Context scripts list, including the .bat or .sh files holding the appropriate context
parameters. Then you can, if you wish, edit the .bat and .sh files to manually modify
the context type.

Apply to children Select this check box if you want to apply the context selected from the list to all child Jobs.

Java sources Select this check box to export the .java file holding Java classes generated by the Job when
designing it.

Items / Source files Select this check box to export the sources used by the Job during its execution including the
.item and .properties files, Java and Talend sources.

If you select the Items or Source files check box, you can reuse the built Job in
a Talend Studio installed on another machine. These source files are only used in
Talend Studio.

7. Click the Override parameters' values button, if necessary.

In the window which opens you can update, add or remove context parameters and values of the Job context
you selected in the list.

8. Click Finish to validate your changes, complete the build operation and close the dialog box.

A zipped file for the Jobs is created in the defined place.

If the Job to be built calls a user routine that contains one or more extra Java classes in parallel with the public class named
the same as the user routine, the extra class or classes will not be included in the exported file. To export such classes, you
need to include them within the class with the routine name as inner classes. For more information about user routines, see
Managing user routines. For more information about classes and inner classes, see relevant Java manuals.

5.2.2.1. How to build Jobs as standalone Job

In the case of a Plain Old Java Object export, if you want to reuse the Job in Talend Studio installed on another
machine, make sure you selected the Items check box. These source files (.item and .properties) are only needed
within Talend Studio.

Select a context from the list when offered. Then once you click the Override parameters' values button below
the Context scripts check box, the opened window will list all of the parameters of the selected context. In this
window, you can configure the selected context as needs.

All contexts parameter files are exported along in addition to the one selected in the list.
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After being exported, the context selection information is stored in the .bat or .sh file and the context settings are stored
in the context .properties file.

5.2.2.2. How to build Jobs as Webservice

In the [Build Job] dialog box, you can change the build type in order to build the Job selection as Webservice
archive.

Select the type of archive you want to use in your Web application.

Archive type Description

WAR The options are read-only. Indeed, the WAR archive generated includes all
configuration files necessary for the execution or deployment from the Web
application.

ZIP All options are available. In the case the files of your Web application config are all
set, you have the possibility to only set the Context parameters if relevant and export
only the Classes into the archive.

Once the archive is produced, place the WAR or the relevant Class from the ZIP (or unzipped files) into the
relevant location, of your Web application server.

The URL to be used to deploy the Job, typically reads as follow:

http://localhost:8080/Webappname/services/JobName?method=runJob&args=null

where the parameters stand as follow:

URL parameters Description

http://localhost:8080/ Type in the Webapp host and port.

/Webappname/ Type in the actual name of your web application.

/services/ Type in "services" as the standard call term for web services.

/JobName Type in the exact name of the Job you want to execute.

?method=runJob&args=null The method is RunJob to execute the Job.

The call return from the Web application is 0 when there is no error and different from 0 in case of error. For a
real-life example of creating and building a Job as a Webservice and calling the built Job from a browser, see An
example of building a Job as a Web service.

The tBufferOutput component was especially designed for this type of deployment. For more information
regarding this component, see Talend Open Studio Components Reference Guide.

5.2.2.3. An example of building a Job as a Web service

This scenario describes first a simple Job that creates a .txt file and writes in it the current date along with first
and last names. Secondly, it shows how to build this Job as a Webservice. And finally, it calls the Job built as
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a Webservice from a browser. The built Job as a Webservice will simply return the "return code" given by the
operating system.

Creating the Job:

1. Drop the following components from the Palette onto the design workspace: tFixedFlowInput and
tFileOutputDelimited.

2. Connect tFixedFlowInput to tFileOutputDelimited using a Row > Main link.

3. In the design workspace, select tFixedFlowInput, and click the Component tab to define the basic settings
for tFixedFlowInput.

4. Set the Schema to Built-In and click the [...] button next to Edit Schema to describe the data structure you
want to create from internal variables. In this scenario, the schema is made of three columns, now, firstname,
and lastname.

5. Click the [+] button to add the three parameter lines and define your variables, and then click OK to close
the dialog box and accept propagating the changes when prompted by the system.

The three defined columns display in the Values table of the Basic settings view of tFixedFlowInput.

6. In the Value cell of each of the three defined columns, press Ctrl+Space to access the
global variable list, and select TalendDate.getCurrentDate(), talendDatagenerator.getFirstName, and
talendDataGenerator.getLastName for the now, firstname, and lastname columns respectively.

7. In the Number of rows field, enter the number of lines to be generated.
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8. In the design workspace, select tFileOutputDelimited, click the Component tab for tFileOutputDelimited,
and browse to the output file to set its path in the File name field. Define other properties as needed.

If you press F6 to execute the Job, three rows holding the current date and first and last names will be written
to the set output file.

Building the Job as a Webservice:

1. In the Repository tree view, right-click the above created Job and select Build Job. The [Build Job] dialog
box appears.
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2. Click the Browse... button to select a directory to archive your Job in.

3. In the Job Version area, select the version of the Job you want to build as a web service.

4. In the Build type area, select the build type you want to use in your Web application (WAR in this example)
and click Finish. The [Build Job] dialog box disappears.

5. Copy the War folder and paste it in the Tomcat webapp directory.

Calling the Job from a browser:

1. Type the following URL into your browser: http://localhost:8080//export_job/services/

export_job2?method=runJob where "export_job" is the name of the webapp directory deployed in Tomcat
and "export_job2" is the name of the Job.

2. Click Enter to execute the Job from your browser.
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The return code from the Web application is 0 when there is no error and 1 if an error occurs.

For a real-life example of creating and building a Job as a Webservices using the tBufferOutput component,
see the tBufferOutput component in Talend Open Studio Components Reference Guide.

5.2.2.4. How to build Jobs as JBoss ESB

Talend Studio provides the possibility to build Talend Jobs as services into JBoss ESB (Enterprise Service Bus)
in order to execute these Jobs on the messaging engine (the bus).

In order to be able to build a Job to be deployed on a JBoss ESB server, make sure that the jar specific to JBoss ESB is
installed in the Java library and that it displays in the Modules view of Talend Studio . For more information about the
Modules view, see the Talend Installation and Upgrade Guide.

In the [Build Job] dialog box, you can change the build type in order to build the selected Job as an ESB archive.
You can then deploy this built Job on a JBoss ESB server.

To build a Job on ESB:

1. In the Job Version area, select the version of the Job you want to execute on a JBoss ESB server.

2. From the Select the build type list in the Build type area, select JBoss ESB (Deprecated).

3. In the Options area, select the file type you want to add to the archive. When the Context scripts list displays
more than one context, select the one you need, and select the Apply to children check box if you want to
apply the context selected from the list to all child Jobs.

4. To export the sources used by the Job during its execution including the files .item, .properties and Java
sources of Jobs and routines, select the Source files check box.

If you select the Source files check box, you can reuse the exported Job in a Talend Studio installed on another
machine. These source files are only used in Talend Studio.

5. In the ESB Export type list, select between JBoss MQ or JBoss Messaging.

6. In the Service Name field, type in the name of the service on which you will deploy your Job.

7. In the Category field, type in the category of the service on which the Job will be deployed.

8. In the Message Queue Name field, type in the name of the queue that is used to deploy the Job.
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9. Click the Browse... button next to the To archive file field and browse to set the path to the archive file in
which you want to export the Job. Then click Finish.

The dialog box closes. A progress indicator displays to show the progress percentage of the build operation.
The Job is built in the selected archive.

When you copy the ESB archive in the deployment directory and launch the server, the Job is automatically
deployed and will be ready to be executed on the ESB server.

5.2.2.5. How to build Jobs as Petals ESB

Talend Studio provides the possibility to build Talend Jobs as services into Petals ESB (Enterprise Service Bus)
in order to execute these Jobs on the messaging engine (the bus).

Integrating Talend with Petals ESB

Talend provides a smooth approach to build services on Petals ESB and thus facilitates:

• application integration on the bus: This will enable the integration of systems and applications across the
enterprise.

• service interactions: The ESB provides connectivity between services. It allows services with varying interfaces
to communicate.

The Java Business Integration (JBI) is the approach used to implement a service-oriented architecture (SOA) and
export Talend Jobs on Petals ESB.

Petals ESB is complemented with Binding Components (BC) and Talend Service Engine (SE) in order to provide:
first the access methods necessary for different types of services including FileTransfer, WebService, MOM, and
second the engine to deploy the service. For more information about interaction between Petals and Talend Jobs,
check http://doc.petalslink.com/display/petalscomponents/A+Simple+Talend+Job.

Then, with the integration of Talend and Petals ESB, you can execute the Jobs designed in Talend Studio on
Petals ESB. For more information, see Building Jobs to Petals ESB. Several mechanisms are provided to pass
information and data to a Job and to retrieve information and data from a Job.

Using Talend Studio and Petals ESB, you can execute a Job which has no specific interaction with Petals. You can:

• export a context as a parameter into the service's WSDL,

• pass attachment files to a Job,

• pass native parameters and options to a Job,

• get the Job's execution result.

Building Jobs to Petals ESB

From the [Build Job] dialog box, you can build a selected Job as a Petals ESB archive. You can then execute the
exported Job on the bus (the messaging engine).

To build a Job as a Petals ESB archive, complete the following:

1. In the Repository tree view, right-click the Job you want to build and then select Build Job from the
contextual menu.

http://doc.petalslink.com/display/petalscomponents/A+Simple+Talend+Job
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The [Build Job] dialog box appears.

2. In the To archive file field, browse to set the path to the archive file in which you want to build the Job.

3. From the Select the Job version list, select the Job version you want to build.

4. From the Select the build type list in the Build type area, select Petals ESB (Deprecated).

The three following options in the Options area are selected by default: Singleton job and Source file. You
can select any of the other options as needed.

The table below explains the export options:

Option Description

Singleton job Exports the Job as singleton: A singleton Job can have only one instance running at a time on a
given Talend Service Engine in Petals ESB.

Generate the end-point Generates the end-point at deployment time. If this option is not selected, the end-point name is
the Job name with the suffix Endpoint.

Validate Petals messages Validates all the messages / requests against the WSDL.



How to build Jobs

168 Talend Open Studio for MDM User Guide

Option Description

Selecting this option reduces system performance (disk access).

Source files Embeds the source files in the generated service-unit.

Jobs contexts A list from which to select the context that will be used by default by the Job.

5. Click OK to validate your choice and close the [Context Export] dialog box.

6. In the [Build Job] dialog box, click Finish.

The dialog box closes. A progress indicator displays to show the progress percentage of the build operation.
The Job is built in the selected archive.

The Talend Job is now built as a service into Petals ESB and can be executed inside the bus.

5.2.2.6. How to build a Job as an OSGI Bundle For ESB

In the [Build Job] dialog box, you can change the build type in order to build the Job selection as an OSGI Bundle
in order to deploy your Job in Talend ESB Container.

1. In the Job Version area, select the version number of the Job you want to build if you have created more
than one version of the Job.

2. In the Build type area, select OSGI Bundle For ESB to build your Job as an OSGI Bundle.
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The extension of your build automatically change to .jar as it is what Talend ESB Container is expecting.

3. Click the Browse... button to specify the folder in which building your Job.

4. Click Finish to build it.

5.2.3. How to export items

You can export multiple items from the repository onto a directory or an archive file. Hence you have the possibility
to export metadata information such as DB connection or Documentation along with your Job or your Business
Model, for example.

To do so:

1. In the Repository tree view, select the items you want to export.

2. To select several items at a time, press the Ctrl key and select the relevant items.

If you want to export a database table metadata entry, make sure you select the whole DB connection, and not only
the relevant table as this will prevent the export process to complete correctly.

3. Right-click while maintaining the Ctrl key down and select Export items on the pop-up menu:
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You can select additional items on the tree for exportation if required.

4. Click Browse to browse to where you want to store the exported items. Alternatively, define the archive file
where to compress the files for all selected items.

If you have several versions of the same item, they will all be exported.

Select the Export Dependencies check box if you want to set and export routine dependencies along with Jobs you
are exporting. By default, all of the user routines are selected. For further information about routines, see What are
routines.

5. Click Finish to close the dialog box and export the items.

5.2.4. How to change context parameters in Jobs

As explained in How to build Jobs, you can edit the context parameters:

If you want to change the context selection, simply edit the .bat/.sh file and change the following setting: --
context=Prod to the relevant context.

If you want to change individual parameters in the context selection, edit the .bat/.sh file and add the following
setting according to your need:

Operation Setting

To change value1 for parameter key1 --context_param key1=value1
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Operation Setting

To change value1 and value2 for respective
parameters key1 and key2

--context_param key1=value1 --context_param key2=value2

To change a value containing space characters
such as in a file path

--context_param key1="path to file"

5.3. Managing repository items
Talend Studio enables you to edit the items centralized in the repository and to update the Jobs that use these
items accordingly.

5.3.1. How to handle updates in repository items

You can update the metadata, context parameters that are centralized in the Repository tree view any time in order
to update the database connection or the context group details, for example.

When you modify any of the parameters of an entry in the Repository tree view, all Jobs using this repository entry
will be impacted by the modification. This is why the system will prompt you to propagate these modifications
to all the Jobs that use the repository entry.

The following sections explain how to modify the parameters of a repository entry and how to propagate the
modifications to all or some of the Jobs that use the entry in question.

5.3.1.1. How to modify a repository item

To update the parameters of a repository item, complete the following:

1. Expand the Metadata, or Contexts node in the Repository tree view and browse to the relevant entry that
you need to update.

2. Right-click this entry and select the corresponding edit option in the contextual menu.

A respective wizard displays where you can edit each of the definition steps for the entry parameters.

When updating the entry parameters, you need to propagate the changes throughout numerous Jobs or all
your Jobs that use this entry.

A prompt message pops up automatically at the end of your update/modification process when you click the
Finish button in the wizard.

3. Click Yes to close the message and implement the changes throughout all Jobs impacted by these changes.
For more information about the first way of propagating all your changes, see How to update impacted Jobs
automatically.
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Click No if you want to close the message without propagating the changes. This will allow you to propagate
your changes on the impacted Jobs manually on one by one basis. For more information on another way of
propagating changes, see How to update impacted Jobs manually.

5.3.1.2. How to update impacted Jobs automatically

After you update the parameters of any item already centralized in the Repository tree view and used in different
Jobs, a message will prompt you to propagate the modifications you did to all Jobs that use these parameters.

To update impacted Jobs, complete the following:

1. In the [Modification] dialog box, click Yes to let the system scan your Repository tree view for the Jobs
that get impacted by the changes you just made. This aims to automatically propagate the update throughout
all your Jobs (open or not) in one click.

The [Update Detection] dialog box displays to list all Jobs impacted by the parameters that are modified.

You can open the [Update Detection] dialog box any time if you right-click the item centralized in the Repository
tree view and select Manage Dependencies from the contextual menu. For more information, see How to update
impacted Jobs manually.

2. If needed, clear the check boxes that correspond to the Jobs you do not wish to update. You can update them
any time later through the Detect Dependencies menu. For more information, see How to update impacted
Jobs manually.

3. Click OK to close the dialog box and update all selected Jobs.

5.3.1.3. How to update impacted Jobs manually

Before propagating changes in the parameters of an item centralized in the tree view throughout the Jobs using
this entry, you might want to view all Jobs that are impacted by the changes. To do that, complete the following:
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1. In the Repository tree view, expand the node holding the entry you want to check what Jobs use it.

2. Right-click the entry and select Detect Dependencies.

A progress bar indicates the process of checking for all Jobs that use the modified metadata or context
parameter. Then a dialog box displays to list all Jobs that use the modified item.

3. Select the check boxes corresponding to the Jobs you want to update with the modified metadata or context
parameter and clear those corresponding to the Jobs you do not want to update.

4. Click OK to validate and close the dialog box.

The Jobs that you choose not to update will be switched back to Built-in, as the link to the Repository cannot be maintained.
It will thus keep their setting as it was before the change.

5.4. Searching a Job in the repository
If you want to open a specific Job in the Repository tree view of the current Integration perspective of Talend

Studio and you can not find it for one reason or another, you can simply click  on the quick access toolbar.

To find a Job in the Repository tree view, complete the following:

1.
On Talend Studio toolbar, click  to open the [Find a Job] dialog box that lists automatically all the Jobs
you created in the current Studio.
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2. Enter the Job name or part of the Job name in the upper field.

When you start typing your text in the field, the Job list is updated automatically to display only the Job(s)
which name(s) match(es) the letters you typed in.

3. Select the desired Job from the list and click Link Repository to automatically browse to the selected Job
in the Repository tree view.

4. If needed, click Cancel to close the dialog box and then right-click the selected Job in the Repository tree
view to perform any of the available operations in the contextual menu.
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Otherwise, click OK to close the dialog box and open the selected Job on the design workspace.

5.5. Managing Job versions
When you create a Job in Talend Studio, by default its version is 0.1, where 0 stands for the major version and
1 for the minor version.

You can create as many versions of the same Job as you want. To do that:

1. Close your Job if it is open on the design workspace. Otherwise, its properties will be read-only and thus
you cannot modify them.

2. In the Repository tree view, right-click your Job and select Edit properties from the drop-down list to open
the [Edit properties] dialog box.

3. Next to the Version field, click the M button to increment the major version and the m button to increment
the minor version.

4. Click Finish to validate the modification.

By default, when you open a Job, you open its last version.

Any previous version of the Job is read-only and thus cannot be modified.

To change the version of your Job, you can also:

1. Close your Job if it is open on the design workspace. Otherwise, its properties will be read-only and thus
you cannot modify them.

2. In the Repository tree view, right-click your Job and select Open another version from the drop-down list.

3. In the dialog box, select the Create new version and open it check box and click the M button to increment
the major version and the m button to increment the minor version.

4. Click Finish to validate the modification and open this new version of your Job.

You can also save your currently active Job and increment its version at the same time, by clicking File > Save
As... and setting a new version in the [Save As] dialog box.

If you give your Job a new name, this option does not overwrite your current Job, but it saves your Job as a new one with
the same version of the current Job or with a new version if you specify one.

You can access a list of the different versions of a Job and perform certain operations. To do that:

1. In the Repository tree view, select the Job you want to consult the versions of.

2. On the configuration tabs panel, click the Job tab and then click Version to display the version list of the
selected Job.

3. Right-click the Job version you want to consult.

4. Do one of the followings:

Select To...

Edit Job open the last version of the Job.
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Select To...

This option is available only when you select the last version of the Job.

Read job consult the Job in read-only mode.

Open Job Hierarchy consult the hierarchy of the Job.

Edit properties edit Job properties.

Note: The Job should not be open on the design workspace, otherwise it will be in
read-only mode.

This option is available only when you select the last version of the Job.

Run job execute the Job.

Generate Doc As HTML generate details documentation about the Job.

You can also manage the version of several Jobs and/or metadata at the same time, as well as Jobs and their
dependencies and/or child Jobs from the Project Settings. For more information, see Version management.

5.6. Documenting a Job
Talend Studio enables you to generate documentation that gives general information about your projects, Jobs or
joblets. You can automate the generation of such documentation and edit any of the generated documents.

5.6.1. How to generate HTML documentation

Talend Studio allows you to generate detailed documentation in HTML of the Job(s) you select in the Repository
tree view of your Studio in the Integration perspective. This auto-documentation offers the following:

• The properties of the project where the selected Jobs have been created,

• The properties and settings of the selected Jobs along with preview pictures of each of the Jobs,

• The list of all the components used in each of the selected Jobs and component parameters.

To generate an HTML document for a Job, complete the following:

1. In the Repository tree view, right-click a Job entry or select several items to produce multiple
documentations.

2. Select Generate Doc as HTML on the contextual menu.
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3. Browse to the location where the generated documentation archive should be stored.

4. In the same field, type in a name for the archive gathering all generated documents.

5. Select the Use CSS file as a template to export check box to activate the CSS File field if you need to
use a CSS file.

6. In the CSS File field, browse to, or enter the path to the CSS file to be used.

7. Click Finish to validate the generation operation.

The archive file is generated in the defined path. It contains all required files along with the Html output file. You
can open the HTML file in your favorite browser.

5.6.2. How to update the documentation on the spot

You can choose to manually update your documentation on the spot.

To update a single document, right-click the relevant documentation entry and select Update documentation.

5.7. Handling Job execution
You can execute a Job in several ways. This mainly depends on the purpose of your Job execution and on your
user level.

This section describes:

• How to run a Job in normal mode

• How to run a Job in Java Debug mode
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• How to run a Job in Traces Debug mode

• How to set advanced execution settings

• How to deploy a Job on SpagoBI server

5.7.1. How to run a Job in normal mode

Make sure you saved your Job before running it in order for all properties to be taken into account.

To run your Job in a normal mode, do the following:

1. Click the Run view to access it.

2. Click the Basic Run tab to access the normal execution mode.

3. In the Context area to the right of the view, select in the list the proper context for the Job to be executed
in. You can also check the variable values.

If you have not defined any particular execution context, the context parameter table is empty and the context is
the default one. Related topic: Using contexts and variables.

1. Click Run to start the execution.

2. On the same view, the console displays the progress of the execution. The log includes any error message
as well as start and end messages. It also shows the Job output in case of a tLogRow component is used
in the Job design.

3. To define the lines of the execution progress to be displayed in the console, select the Line limit check box
and type in a value in the field.

4. Select the Wrap check box to wrap the text to fit the console width. This check box is selected by default.
When it is cleared, a horizontal scrollbar appears, allowing you to view the end of the lines.

Before running again a Job, you might want to remove the execution statistics and traces from the designing
workspace. To do so, click the Clear button.

If for any reason, you want to stop the Job in progress, simply click the Kill button. You will need to click the
Run button again, to start again the Job.

Talend Studio offers various informative features displayed during execution, such as statistics and traces,
facilitating the Job monitoring and debugging work. For more information, see the following sections.
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5.7.2. How to run a Job in Java Debug mode

To follow step by step the execution of a Job to identify possible bugs, you can run it in Debug mode.

To access the Debug mode:

1. Click the Run view to access it.

2. Click the Debug Run tab to access the debug execution modes.

Before running your Job in Debug mode, add breakpoints to the major steps of your Job flow.

This will allow you to get the Job to automatically stop at each breakpoint. This way, components and their
respective variables can be verified individually and debugged if required.

To add breakpoints to a component, right-click it on the design workspace, and select Add breakpoint on the
contextual menu.

A pause icon displays next to the component where the break is added.

To switch to debug mode, click the Java Debug button on the Debug Run tab of the Run panel. Talend Studio's
main window gets reorganized for debugging.

You can then run the Job step by step and check each breakpoint component for the expected behavior and variable
values.

To switch back to Talend Studio designer mode, click Window, then Perspective and select Integration.

5.7.3. How to run a Job in Traces Debug mode

The traces feature allows you to monitor data processing when running a Job in the Integration perspective of
Talend Studio.

It provides a row by row view of the component behavior and displays the dynamic result next to the Row link
on the design workspace.

This feature allows you to monitor all the components of a Job, without switching to the debug mode, hence
without requiring advanced Java knowledge.

The Traces function displays the content of processed rows in a table.



How to run a Job in Traces Debug mode

180 Talend Open Studio for MDM User Guide

Exception is made for external components which cannot offer this feature if their design does not include it.

You can activate or deactivate Traces or decide what processed columns to display in the traces table that displays
on the design workspace when launching the current Job.

To activate the Traces mode in a Job:

1. Click the Run view.

2. Click the Debug Run tab to access the debug and traces execution modes.

3. Click the down arrow of the Java Debug button and select the Traces Debug option. An icon displays under
every flow of your Job to indicate that process monitoring is activated.

4. Click the Traces Debug to execute the Job in Traces mode.

To deactivate the Traces on one of the flows in your Job:

1. Right-click the Traces icon under the relevant flow.

2. Select Disable Traces from the list. A red minus sign replaces the green plus sign on the icon to indicate that
the Traces mode has been deactivated for this flow.

To choose which columns of the processed data to display in the traces table, do the following:

1. Right-click the Traces icon for the relevant flow, then select Setup Traces from the list. The [Setup Traces]
dialog box appears.

2. In the dialog box, clear the check boxes corresponding to the columns you do not want to display in the
Traces table.
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3. Click OK to close the dialog box.

Monitoring data processing starts when you execute the Job and stops at the end of the execution.

To remove the displayed monitoring information, click the Clear button in the Debug Run tab.

5.7.4. How to set advanced execution settings

Several advanced execution settings are available to make the execution of the Jobs handier:

• Statistics, this feature displays processing performance rate. For more information, see How to display Statistics.

• Exec time, this feature displays the execution time in the console at the end of the execution. For more
information, see How to display the execution time and other options.

• Save Job before execution, this feature allows to automatically save the Job before its execution.

• Clear before run, this feature clears all the results of a previous execution before re-executing the Job.

• JVM Setting, this feature allows you to define the parameters of your JVM according to your needs, for example
the parameters used to display special characters.

5.7.4.1. How to display Statistics

The Statistics feature displays each component performance rate, under the flow links on the design workspace.

It shows the number of rows processed and the processing time in row per second, allowing you to spot straight
away any bottleneck in the data processing flow.

For trigger links like OnComponentOK, OnComponentError, OnSubjobOK, OnSubjobError and If, the
Statistics option displays the state of this trigger during the execution time of your Job: Ok or Error and True
or False.

Exception is made for external components which cannot offer this feature if their design does not include it.

In the Run view, click the Advanced settings tab and select the Statistics check box to activate the Stats feature
and clear the box to disable it.

The calculation only starts when the Job execution is launched, and stops at the end of it.
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Click the Clear button from the Basic or Debug Run views to remove the calculated stats displayed. Select the
Clear before Run check box to reset the Stats feature before each execution.

The statistics thread slows down Job execution as the Job must send these stats data to the design workspace in order to
be displayed.

You can also save your Job before the execution starts. Select the relevant option check box.

5.7.4.2. How to display the execution time and other options

To display the Job total execution time after Job execution, select in the Advanced settings tab of the Run view
the Exec time check box before running the Job.

This way you can test your Job before going to production.

You can also clear the design workspace before each Job execution by selecting the check box Clear before Run.

You can also save your Job before the execution starts. Select the relevant option check box.

5.7.4.3. How to display special characters in the console

Talend Studio can display special characters in the console. To enable the display of Chinese, Japanese or Korean
characters, for example, proceed as follows before executing the Job:

1. Select the Advanced settings tab.

2. In the JVM settings area of the tab view, select the Use specific JVM arguments check box to activate
the Argument table.

3. Next to the Argument table, click the New... button to pop up the [Set the VM argument] dialog box.

4. In the dialog box, type in -Dfile.encoding=UTF-8.

5. Click OK to close the dialog box.

This argument can be applied for all of your Job executions in Talend Studio. For further information about
how to apply this JVM argument for all of the Job executions, see Debug and Job execution preferences
(Talend > Run/Debug).
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5.7.5. How to deploy a Job on SpagoBI server

From Talend Studio interface, you can deploy your Jobs easily on a SpagoBI server in order to execute them from
your SpagoBI administrator.

5.7.5.1. How to create a SpagoBI server entry

Beforehand, you need to set up your single or multiple SpagoBI server details in Talend Studio.

1. On the menu bar, click Window > Preferences to open the [Preferences] dialog box.

2. Expand the Talend > Import/Export nodes in succession and select SpagoBI Server to display the relevant
view.

3. Select the Enable/Disable Deploy on SpagoBI check box to activate the deployment operation.

4. Click New to open the [Create new SpagoBi server] dialog box and add a new server to the list.

5. Enter your SpagoBI server details, as described below:

Field Description

Engine Name Internal engine name used in Talend Studio. This name is not used in the generated code.
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Field Description

Short description Free text to describe the server entry you are recording.

Host IP address or host name of the machine running the SpagoBI server.

Login User name required to log on to the SpagoBI server.

Password Password for SpagoBI server logon authentication.

6. Click OK to validate the details of the new server entry and close the dialog box.

The newly created entry is added to the table of available servers. You can add as many SpagoBI entries
as you need.

7. Click Apply and then OK to close the [Preferences] dialog box.

5.7.5.2. How to edit or remove a SpagoBI server entry

Select the relevant entry in the table, click the Remove button next to the table to first delete the outdated entry.

Then if required, simply create a new entry including the updated details.

5.7.5.3. How to deploy your Jobs on a SpagoBI server

Follow the steps below to deploy your Job(s) onto a SpagoBI server.
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1. In the Repository tree view, expand Job Designs and right-click the Job to deploy.

2. In the drop-down list, select Deploy on SpagoBI.

3. As for any Job export, select a Name for the Job archive that will be created and fill it in the To archive
file field.

4. Select the relevant SpagoBI server on the drop-down list.

5. The Label, Name and Description fields come from the Job main properties.

6. Select the relevant context in the list.

7. Click OK once you have completed the setting operation.

The Jobs are now deployed onto the relevant SpagoBI server. Open your SpagoBI administrator to execute your
Jobs.
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Chapter 6. Mapping data flows
The most common way to handle multiple input and output flows including transformations and data re-routing
is to use dedicated mapping components.

This chapter explains the theory behind how those mapping components can be used, by taking as example the
typical ones which you can refer to for the use of the other mapping components. For further information or
scenarios and use cases about the mapping components, see Talend Open Studio Components Reference Guide.
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6.1. Map editor interfaces
Mapping components are advanced components which require more detailed explanation than other Talend Open
Studio Components. The Map Editor is an "all-in-one" tool allowing you to define all parameters needed to
map, transform and route your data flows via a convenient graphical interface.

You can minimize and restore the Map Editor and all tables in the Map Editor using the window icons.

This figure presents the interface of tMap. Those of the other mapping components differ slightly in appearance.
For example, in addition to the Schema editor and the Expression editor tabs on the lower part of this interface,
tXMLMap has a third tab called Tree schema editor. For further information about tXMLMap, see tXMLMap
operation.

The Map Editor is made of several panels:

• The Input panel is the top left panel on the editor. It offers a graphical representation of all (main and lookup)
incoming data flows. The data are gathered in various columns of input tables. Note that the table name reflects
the main or lookup row from the Job design on the design workspace.

• The Variable panel is the central panel in the Map Editor. It allows the centralization of redundant information
through the mapping to variable and allows you to carry out transformations.

• The Search panel is above the Variable panel. It allow you to search in the editor for columns or expressions
that contain the text you enter in the Find field.
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• The Output panel is the top right panel on the editor. It allows mapping data and fields from Input tables and
Variables to the appropriate Output rows.

• Both bottom panels are the Input and Output schemas description. The Schema editor tab offers a schema view
of all columns of input and output tables in selection in their respective panel.

• Expression editor is the edition tool for all expression keys of Input/Output data, variable expressions or
filtering conditions.

The name of input/output tables in the Map Editor reflects the name of the incoming and outgoing flows (row
connections).

The following sections present separately different mapping components of which each is able to map flows of
a specific nature.

If you are using a Talend Studio with Big Data, then components that map Big Data flows become available.
For information about those components, see the related chapter of the your Talend Open Studio for Big Data
Getting Started Guide.

6.2. tMap operation
tMap allows the following types of operations:

• data multiplexing and demultiplexing,

• data transformation on any type of fields,

• fields concatenation and interchange,

• field filtering using constraints,

• data rejecting.

As all these operations of transformation and/or routing are carried out by tMap, this component cannot be a start
or end component in the Job design.

tMap uses incoming connections to pre-fill input schemas with data in the Map Editor. Therefore, you cannot
create new input schemas directly in the Map Editor. Instead, you need to implement as many Row connections
incoming to tMap component as required, in order to create as many input schemas as needed.
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The same way, create as many output row connections as required. However, you can fill in the output with content
directly in the Map Editor through a convenient graphical editor.

Note that there can be only one Main incoming rows. All other incoming rows are of Lookup type. Related topic:
Row connection.

Lookup rows are incoming connections from secondary (or reference) flows of data. These reference data might
depend directly or indirectly on the primary flow. This dependency relationship is translated with a graphical
mapping and the creation of an expression key.

The Map Editor requires the connections to be implemented in your Job in order to be able to define the input
and output flows in the Map Editor. You also need to create the actual mapping in your Job in order to display
the Map Editor in the Preview area of the Basic settings view of the tMap component.

To open the Map Editor in a new window, double-click the tMap icon in the design workspace or click the three-
dot button next to the Map Editor in the Basic settings view of the tMap component.

The following sections give the information necessary to use the tMap component in any of your Job designs.

6.2.1. Setting the input flow in the Map Editor

The order of the Input tables is essential. The top table reflects the Main flow connection, and for this reason, is
given priority for reading and processing through the tMap component.

For this priority reason, you are not allowed to move up or down the Main flow table. This ensures that no Join
can be lost.
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Although you can use the up and down arrows to interchange Lookup tables order, be aware that the Joins between
two lookup tables may then be lost.

Related topic: How to use Explicit Join.
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6.2.1.1. How to fill in Input tables with a schema

To fill in the input tables, you need to define either the schemas of the input components connected to the tMap
component on your design workspace, or the input schemas within the Map Editor.

For more information about setting a component schema, see How to define component properties.

For more information about setting an input schema in the Map Editor, see Setting schemas in the Map Editor.

Main and Lookup table content

The order of the Input tables is essential.

The Main Row connection determines the Main flow table content. This input flow is reflected in the first table
of the Map Editor's Input panel.

The Lookup connections' content fills in all other (secondary or subordinate) tables which displays below the
Main flow table. If you have not define the schema of an input component yet, the input table displays as empty
in the Input area.

The key is also retrieved from the schema defined in the Input component. This Key corresponds to the key defined
in the input schema where relevant. It has to be distinguished from the hash key that is internally used in the Map
Editor, which displays in a different color.

Variables

You can use global or context variables or reuse the variable defined in the Variables area. Press Ctrl+Space bar
to access the list of variables. This list gathers together global, context and mapping variables.

The list of variables changes according to the context and grows along new variable creation. Only valid mappable
variables in the context show on the list.

Docked at the Variable list, a metadata tip box display to provide information about the selected column.

Related topic: Mapping variables

6.2.1.2. How to use Explicit Join

In fact, Joins let you select data from a table depending upon the data from another table. In the Map Editor
context, the data of a Main table and of a Lookup table can be bound together on expression keys. In this case,
the order of table does fully make sense.
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Simply drop column names from one table to a subordinate one, to create a Join relationship between the two
tables. This way, you can retrieve and process data from multiple inputs.

The join displays graphically as a purple link and creates automatically a key that will be used as a hash key to
speed up the match search.

You can create direct joins between the main table and lookup tables. But you can also create indirect joins from
the main table to a lookup table, via another lookup table. This requires a direct join between one of the Lookup
table to the Main one.

You cannot create a Join from a subordinate table towards a superior table in the Input area.

The Expression key field which is filled in with the dragged and dropped data is editable in the input schema,
whereas the column name can only be changed from the Schema editor panel.

You can either insert the dragged data into a new entry or replace the existing entries or else concatenate all
selected data into one cell.

For further information about possible types of drag and drops, see Mapping the Output setting .

If you have a big number of input tables, you can use the minimize/maximize icon to reduce or restore the table size in the
Input area. The Join binding two tables remains visible even though the table is minimized.
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Creating a Join automatically assigns a hash key onto the joined field name. The key symbol displays in violet on
the input table itself and is removed when the Join between the two tables is removed.

Related topics:

• Setting schemas in the Map Editor

• How to use Inner Join

Along with the explicit Join you can select whether you want to filter down to a unique match or if you allow
several matches to be taken into account. In this last case, you can choose to consider only the first or the last
match or all of them.

To define the match model for an explicit Join:

1. Click the tMap settings button at the top of the table to which the Join links to display the table properties.

2. Click in the Value field corresponding to Match Model and then click the three-dot button that appears to
open the [Options] dialog box.

3. In the [Options] dialog box, double-click the wanted match model, or select it and click OK to validate the
setting and close the dialog box.

Unique Match

This is the default selection when you implement an explicit Join. This means that only the last match from the
Lookup flow will be taken into account and passed on to the output.

The other matches will be then ignored.

First Match

This selection implies that several matches can be expected in the lookup. The First Match selection means that
in the lookup only the first encountered match will be taken into account and passed onto the main output flow.

The other matches will then be ignored.
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All Matches

This selection implies that several matches can be expected in the lookup flow. In this case, all matches are taken
into account and passed on to the main output flow.

6.2.1.3. How to use Inner Join

The Inner join is a particular type of Join that distinguishes itself by the way the rejection is performed.

This option avoids that null values are passed on to the main output flow. It allows also to pass on the rejected
data to a specific table called Inner Join Reject table.

If the data searched cannot be retrieved through the explicit Join or the filter Join, in other words, the Inner Join
cannot be established for any reason, then the requested data will be rejected to the Output table defined as Inner
Join Reject table if any.

Simply drop column names from one table to a subordinate one, to create a Join relationship between the two
tables. The Join is displayed graphically as a purple link and creates automatically a key that will be used as a
hash key to speed up the match search.

To define the type of an explicit Join:

1. Click the tMap settings button at the top of the table to which the Join links to display the table properties.

2. Click in the Value field corresponding to Join Model and then click the three-dot button that appears to open
the [Options] dialog box.

3. In the [Options] dialog box, double-click the wanted Join type, or select it and click OK to validate the
setting and close the dialog box.
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An Inner Join table should always be coupled to an Inner Join Reject table. For how to define an output table as an Inner
Join Reject table, see Lookup Inner Join rejection.

You can also use the filter button to decrease the number of rows to be searched and improve the performance
(in Java).

Related topics:

• Lookup Inner Join rejection

• How to filter an input flow

6.2.1.4. How to use the All Rows option

By default, without a Join set up, in each input table of the input area of the Map Editor, the All rows match
model option is selected. This All rows option means that all the rows are loaded from the Lookup flow and
searched against the Main flow.

The output corresponds to the Cartesian product of both table (or more tables if need be).

If you create an explicit or an inner Join between two tables, the All rows option is no longer available. You then have to
select Unique match, First match or All matches. For more information, see How to use Explicit Join and How to use
Inner Join.

6.2.1.5. How to filter an input flow

Click the Filter button next to the tMap settings button to add a Filter field.

In the Filter field, type in the condition to be applied. This allows to reduce the number of rows parsed against
the main flow, enhancing the performance on long and heterogeneous flows.

You can use the Auto-completion tool via the Ctrl+Space bar keystrokes in order to reuse schema columns in
the condition statement.

6.2.1.6. How to remove input entries from table

To remove input entries, click the red cross sign on the Schema Editor of the selected table. Press Ctrl or Shift
and click fields for multiple selection to be removed.

If you remove Input entries from the Map Editor schema, this removal also occurs in your component schema definition.
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6.2.2. Mapping variables

The Var table (variable table) regroups all mapping variables which are used numerous times in various places.

You can also use the Expression field of the Var table to carry out any transformation you want to, using Java
Code.

Variables help you save processing time and avoid you to retype many times the same data.

There are various possibilities to create variables:

• Type in freely your variables in Java. Enter the strings between quotes or concatenate functions using the
relevant operator.

• Add new lines using the plus sign and remove lines using the red cross sign. And press Ctrl+Space to retrieve
existing global and context variables.

• Drop one or more Input entries to the Var table.

Select an entry on the Input area or press Shift key to select multiple entries of one Input table.

Press Ctrl to select either non-appended entries in the same input table or entries from various tables. When
selecting entries in the second table, notice that the first selection displays in grey. Hold the Ctrl key down to drag
all entries together. A tooltip shows you how many entries are in selection.

Then various types of drag-and-drops are possible depending on the action you want to carry out.

To... You need to...

Insert all selected entries as separated variables. Simply drag & drop to the Var table. Arrows show you where the new Var
entry can be inserted. Each Input is inserted in a separate cell.

Concatenate all selected input entries together with an
existing Var entry.

Drag & drop onto the Var entry which gets highlighted. All entries gets
concatenated into one cell. Add the required operators using Java operations
signs. The dot concatenates string variables.

Overwrite a Var entry with selected concatenated
Input entries.

Drag & drop onto the relevant Var entry which gets highlighted then press
Ctrl and release. All selected entries are concatenated and overwrite the
highlighted Var.

Concatenate selected input entries with highlighted
Var entries and create new Var lines if needed

Drag & drop onto an existing Var then press Shift when browsing over the
chosen Var entries. First entries get concatenated with the highlighted Var
entries. And if necessary new lines get created to hold remaining entries.

6.2.2.1. How to access global or context variables

Press Ctrl+Space to access the global and context variable list.
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Appended to the variable list, a metadata list provides information about the selected column.

6.2.2.2. How to remove variables

To remove a selected Var entry, click the red cross sign. This removes the whole line as well as the link.

Press Ctrl or Shift and click fields for multiple selection then click the red cross sign.

6.2.3. Using the expression editor

All expressions (Input, Var or Output) and constraint statements can be viewed and edited from the expression
editor. This editor provides visual comfort to write any function or transformation in a handy dedicated view.

6.2.3.1. How to access the expression editor

You can write the expressions necessary for the data transformation directly in the Expression editor view located
in the lower half of the expression editor, or you can open the [Expression Builder] dialog box where you can
write the data transformation expressions.

To open the Expression editor view, complete the following:

1. Double-click the tMap component in your job design to open the Map Editor.

2. In the lower half of the editor, click the Expression editor tab to open the corresponding view.

To edit an expression, select it in the Input panel and then click the Expression editor tab and modify the expression
as required.

3. Enter the Java code according to your needs. The corresponding expression in the output panel is
synchronized.

Refer to the Java documentation for more information regarding functions and operations.

To open the [Expression Builder] dialog box, click the three-dot button next to the expression you want to open
in the Var or Output panel of the Map Editor.
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The [Expression Builder] dialog box opens on the selected expression.

For a use case showing the usage of the expression editor, see the following section.

6.2.3.2. How to write code using the Expression Builder

Some Jobs require pieces of code to be written in order to provide components with parameters. In the Component
view of some components, an Expression Builder interface can help you write these pieces of code (in Java).

The following example shows the use of Expression Builder in a tMap component.
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Two input flows are connected to the tMap component.

• From the DB input, comes a list of names made of a first name and a last name separated by a space char.

• From the File input, comes a list of US states, in lower case.

In the tMap, use the expression builder to: First, replace the blank char separating the first and last names with an
underscore char, and second, change the states from lower case to upper case.

1. In the tMap, set the relevant inner join to set the reference mapping. For more information regarding tMap,
see tMap operation and Map editor interfaces.

2. From the main (row1) input, drop the Names column to the output area, and the State column from the lookup
(row2) input towards the same output area.

3. Then click in the first Expression field (row1.Name) to display the three-dot button.

The [Expression Builder] dialog box opens up.

4. In the Category area, select the relevant action you want to perform. In this example, select StringHandling
and select the EREPLACE function.

5. In the Expression area, paste row1.Name in place of the text expression, in order to get:
StringHandling.EREPLACE(row1.Name," ","_"). This expression will replace the separating space char
with an underscore char in the char string given.

6. Now check that the output is correct, by typing in the relevant Value field of the Test area, a dummy value,
e.g: Chuck Norris and clicking Test!. The correct change should be carried out, for example, Chuck_Norris.
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7. Click OK to validate the changes, and then proceed with the same operation for the second column (State).

8. In the tMap output, select the row2.State Expression and click the [...] button to open the Expression builder
again.

This time, the StringHandling function to be used is UPCASE. The complete expression says:
StringHandling.UPCASE(row2.State).

9. Once again, check that the expression syntax is correct using a dummy Value in the Test area, for example
indiana. The Test! result should display INDIANA for this example. Then, click OK to validate the changes.

Both expressions are now displayed in the tMap Expression field.

These changes will be carried out along the flow processing. The output of this example is as shown below.
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6.2.4. Mapping the Output setting

On the design workspace, the creation of a Row connection from the tMap component to the output components
adds Output schema tables in the Map Editor.

You can also add an Output schema in your Map Editor, using the plus sign from the tool bar of the Output area.

You have as well the possibility to create a join between your output tables. The join on the tables enables you
to process several flows separately and unite them in a single output. For more information about the output join
tables feature, see Talend Open Studio Components Reference Guide.

The join table retrieves the schema of the source table.

When you click the [+] button to add an output schema or to make a join between your output tables, a dialog
box opens. You have then two options.

Select... To...

New output Add an independent table.

Create join table from Create a join between output tables. In order to do so, select in the drop down
list the table from which you want to create the join. In the Named field, type
in the name of the table to be created.

Unlike the Input area, the order of output schema tables does not make such a difference, as there is no
subordination relationship between outputs (of Join type).

Once all connections, hence output schema tables, are created, you can select and organize the output data via
drag & drops.

You can drop one or several entries from the Input area straight to the relevant output table.

Press Ctrl or Shift, and click entries to carry out multiple selection.

Or you can drag expressions from the Var area and drop them to fill in the output schemas with the appropriate
reusable data.

Note that if you make any change to the Input column in the Schema Editor, a dialog prompts you to decide to
propagate the changes throughout all Input/Variable/Output table entries, where concerned.

Action Result

Drag & Drop onto existing expressions. Concatenates the selected expression with the existing expressions.

Drag & Drop to insertion line. Inserts one or several new entries at start or end of table or between two
existing lines.

Drag & Drop + Ctrl. Replaces highlighted expression with selected expression.

Drag & Drop + Shift. Adds the selected fields to all highlighted expressions. Inserts new lines if
needed.
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Action Result

Drag & Drop + Ctrl + Shift. Replaces all highlighted expressions with selected fields. Inserts new lines if
needed.

You can add filters and rejections to customize your outputs.

6.2.4.1. Creating complex expressions

If you have complex expressions to create, or advanced changes to be carried out on the output flow, then the
Expression Builder interface can help in this task.

Click the Expression field of your input or output table to display the [...] button. Then click this three-dot button
to open the Expression Builder.

For more information regarding the Expression Builder, see How to write code using the Expression Builder.

6.2.4.2. Filters

Filters allow you to make a selection among the input fields, and send only the selected fields to various outputs.

Click the [+] button at the top of the table to add a filter line.

You can enter freely your filter statements using Java operators and functions.

Drop expressions from the Input area or from the Var area to the Filter row entry of the relevant Output table.

An orange link is then created. Add the required Java operator to finalize your filter formula.

You can create various filters on different lines. The AND operator is the logical conjunction of all stated filters.

6.2.4.3. Output rejection

Reject options define the nature of an output table.

It groups data which do not satisfy one or more filters defined in the standard output tables. Note that as standard
output tables, are meant all non-reject tables.

This way, data rejected from other output tables, are gathered in one or more dedicated tables, allowing you to
spot any error or unpredicted case.
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The Reject principle concatenates all non Reject tables filters and defines them as an ELSE statement.

To define an output table as the Else part of the regular tables:

1. Click the tMap settings button at the top of the output table to display the table properties.

2. Click in the Value field corresponding to Catch output reject and then click the [...] button that appears to
display the [Options] dialog box.

3. In the [Options] dialog box, double-click true, or select it and click OK to validate the setting and close
the dialog box.

You can define several Reject tables, to offer multiple refined outputs. To differentiate various Reject outputs,
add filter lines, by clicking on the plus arrow button.

Once a table is defined as Reject, the verification process will be first enforced on regular tables before taking in
consideration possible constraints of the Reject tables.

Note that data are not exclusively processed to one output. Although a data satisfied one constraint, hence is routed
to the corresponding output, this data still gets checked against the other constraints and can be routed to other
outputs.

6.2.4.4. Lookup Inner Join rejection

The Inner Join is a Lookup Join. The Inner Join Reject table is a particular type of Rejection output. It gathers
rejected data from the main row table after an Inner Join could not be established.

To define an Output flow as container for rejected Inner Join data, create a new output component on your Job
that you connect to the Map Editor. Then in the Map Editor, follow the steps below:

1. Click the tMap settings button at the top of the output table to display the table properties.

2. Click in the Value field corresponding to Catch lookup inner join reject and then click the [...] button that
appears to display the [Options] dialog box.

3. In the [Options] dialog box, double-click true, or select it and click OK to validate the setting and close
the dialog box.
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6.2.4.5. Removing Output entries

To remove Output entries, click the cross sign on the Schema Editor of the selected table.

6.2.4.6. Handling errors

The Die on error option prevents error to be processed. To do so, it stops the Job execution as soon as an error is
encountered. The tMap component provides this option to prevent processing erroneous data. The Die on error
option is activated by default in tMap.

Deactivating the Die on error option will allow you to skip the rows on error and complete the process for error-
free rows on one hand, and to retrieve the rows on error and manage them if needed.

To deactivate the Die on error option:

1. Double-click the tMap component on the design workspace to open the Map Editor.

2. Click the Property Settings button at the top of the input area to display the [Property Settings] dialog box.

3. In [Property Settings] dialog box, clear the Die on error check box and click OK.
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A new table called ErrorReject appears in the output area of the Map Editor. This output table automatically
comprises two columns: errorMessage and errorStackTrace, retrieving the message and stack trace of the error
encountered during the Job execution. Errors can be unparseable dates, null pointer exceptions, conversion issues,
etc.

You can also drag and drop columns from the input tables to this error reject output table. Those erroneous data
can be retrieved with the corresponding error messages and thus be corrected afterward.

Once the error reject table is set, its corresponding flow can be sent to an output component.
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To do so, on the design workspace, right-click the tMap component, select Row > ErrorReject in the menu, and
click the corresponding output component, here tLogRow.

When you execute the Job, errors are retrieved by the ErrorReject flow.

The result contains the error message, its stack trace, and the two columns, id and date, dragged and dropped to
the ErrorReject table, separated by a pipe "|".

6.2.5. Setting schemas in the Map Editor

In the Map Editor, you can define the type of a table schema as Built-In so that you can modify the data structure
in the Schema editor panel, or Repository and retrieve the data structure from the Repository. By default, the
schema type is set to Built-In for all tables.

6.2.5.1. Retrieving the schema structure from the Repository

To retrieve the schema structure of the selected table from the Repository:
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1. Click the tMap Settings button at the top of the table to display the table properties.

2. Click in the Value field of Schema Type, and then click the three-dot button that appears to open the
[Options] dialog box.

3. In the [Options] dialog box, double-click Repository, or select it and click OK, to close the dialog box and
display the Schema Id property beneath Schema Type.

If you close the Map Editor now without specifying a Repository schema item, the schema type changes back to
Built-In.

4. Click in the Value field of Schema Id, and then click the [...] button that appears to display the [Repository
Content] dialog box.

5. In the [Repository Content] dialog box, select your schema as you define a centrally stored schema for any
component, and then click OK.

The Value field of Schema Id is filled with the schema you just selected, and everything in the Schema
editor panel for this table becomes read-only.
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Changing the schema type of the subordinate table across a Join from Built-In to Repository causes the Join to get lost.

Changes to the schema of a table made in the Map Editor are automatically synchronized to the schema of the
corresponding component connected with the tMap component.

6.2.5.2. Using the Schema Editor

The Schema Editor details all fields of the selected table. With the schema type of the table set to Built-In, you
can modify the schema of the table.

Use the tool bar below the schema table, to add, move or remove columns from the schema.

You can also load a schema from the repository or export it into a file.
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Metadata Description

Column Column name as defined on the Map Editor schemas and on the Input or Output component
schemas.

Key The Key shows if the expression key data should be used to retrieve data through the Join link. If
unchecked, the Join relation is disabled.

Type Type of data: String, Integer, Date, etc.

This column should always be defined in a Java version.

Length -1 shows that no length value has been defined in the schema.

Precision Defines the number of digits to the right of the decimal point.

Nullable Clear this check box if the field value should not be null.

Default Shows any default value that may be defined for this field.

Comment Free text field. Enter any useful comment.

Input metadata and output metadata are independent from each other. You can, for instance, change the label of a column
on the output side without the column label of the input schema being changed.

However, any change made to the metadata are immediately reflected in the corresponding schema on the tMap
relevant (Input or Output) area, but also on the schema defined for the component itself on the design workspace.

A Red colored background shows that an invalid character has been entered. Most special characters are prohibited
in order for the Job to be able to interpret and use the text entered in the code. Authorized characters include lower-
case, upper-case, figures except as start character.

6.2.6. Solving memory limitation issues in tMap use

When handling large data sources, including for example, numerous columns, large number of lines or of column
types, your system might encounter memory shortage issues that prevent your Job, to complete properly, in
particular when using a tMap component for your transformation.

A feature has been added (in Java only for the time being) to the tMap component, in order to reduce the memory
in use for lookup loading. In fact, rather than storing the temporary data in the system memory and thus possibly
reaching the memory limitation, the Store temp data option allows you to choose to store the temporary data
onto a directory of your disk instead.

This feature comes as an option to be selected in the Lookup table of the input data in the Map Editor.

To enable the Store temp data option:

1. Double-click the tMap component in your Job to launch the Map Editor.

2. In input area, click the Lookup table describing the temporary data you want to be loaded onto the disk rather
than in the memory.

3. Click the tMap settings button to display the table properties.

4. Click in the Value field corresponding to Store temp data, and then click the [...] button to display the
[Options] dialog box.

5. In the [Options] dialog box, double-click true, or select it and click OK, to enable the option and close the
dialog box.
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For this option to be fully activated, you also need to specify the directory on the disk, where the data will be stored,
and the buffer size, namely the number of rows of data each temporary file will contain. You can set the temporary
storage directory and the buffer size either in the Map Editor or in the tMap component property settings.

To set the temporary storage directory and the buffer size in the Map Editor:

1. Click the Property Settings button at the top of the input area to display the [Property Settings] dialog box.

2. In [Property Settings] dialog box, fill the Temp data directory path field with the full path to the directory
where the temporary data should be stored.

3. In the Max buffer size (nr of rows) field, specify the maximum number of rows each temporary file can
contain. The default value is 2,000,000.

4. Click OK to validate the settings and close the [Property Settings] dialog box.

To set the temporary storage directory in the tMap component property settings without opening the Map Editor:

1. Click the tMap component to select it on the design workspace, and then select the Component tab to show
the Basic settings view.
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2. In the Store on disk area, fill the Temp data directory path field with the full path to the directory where
the temporary data should be stored.

Alternatively, you can use a context variable through the Ctrl+Space bar if you have set the variable in a
Context group in the repository. For more information about contexts, see Using contexts and variables.

At the end of the subjob, the temporary files are cleared.

This way, you will limit the use of allocated memory per reference data to be written onto temporary files stored
on the disk.

As writing the main flow onto the disk requires the data to be sorted, note that the order of the output rows cannot be
guaranteed.

On the Advanced settings view, you can also set a buffer size if needed. Simply fill out the field Max buffer size
(nb of rows) in order for the data stored on the disk to be split into as many files as needed.

6.2.7. Handling Lookups
In order to adapt to the multiple processing types as well as to address performance issues, the tMap component
supports different lookup loading modes.

• Load once: Default setting. Select this option to load the entire lookup flow before processing the main flow.
This is the preferred option if you have a great number of data from your main flow that needs to be requested
in your lookup, or if your reference (or lookup) data comes from a file that can be easily loaded.

• Reload at each row: At each row, the lookup gets loaded again. This is mainly interesting in Jobs where the
lookup volume is large, while the main flow is pretty small. Note that this option allows you to use dynamic
variable settings such as where clause, to change/update the lookup flow on the fly as it gets loaded, before
the main flow join is processed. This option could be considered as the counter-part of the Store temp data
option that is available for file lookups.

• Reload at each row (cache): Expressions (in the Lookup table) are assessed and looked up in the cache first.
The results of joins that have already been solved, are stored in the cache, in order to avoid loading the same
results twice. This option optimizes the processing time and helps improve processing performance of the tMap
component.

Note that for the time being, you cannot use Reload at each row (cache) and Store temp data at the same time.

To set the loading mode of a lookup flow:

1. Click the tMap settings button at the top of the lookup table to display the table properties.

2. Click in the Value field corresponding to Lookup Model, and then click the [...] button to display the
[Options] dialog box.



Handling Lookups

Talend Open Studio for MDM User Guide 213

3. In the [Options] dialog box, double-click the wanted loading mode, or select it and then click OK, to validate
the setting and close the dialog box.

For use cases using these options, see the tMap section of Talend Open Studio Components Reference Guide.

When your lookup is a database table, the best practise is to open the connection to the database in the beginning of your
job design in order to optimize performance.

6.2.7.1. Reloading data at each row

As explained above, the Reload at each row option is used to read all the records of a lookup flow for each record
of the main flow. In general, this approach increases the time of Job execution, however, it becomes recommended
if the main flow and lookup flow meet the following conditions:

1. The main flow has much less rows than the lookup flow (for example, with a ratio of 1000 or more).

2. The lookup input is a database component, such as tMysqlInput.

The advantage of this approach, with both conditions satisfied, is that it helps deal with the fact that the amount
of lookup data increases over time, since you can run queries against the data from the main flow in the database
component in order to select only that lookup data which is assumed to be relevant for each record in the main
flow, such as in the following example which uses lookup data from a MySQL database.
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The schemas of the main flow, the lookup flow and the output flow read as follows:

You can select from the MySQL database only the data that matches the values of the id column of the main flow.
To do this, proceed as follows:

1. Double-click tSetGlobalVar to open its Component view.

2. Click the [+] button to add one row and name the Key to id and the Value to row1.id.

3. Double-click tMysqlInput to open its Component view.
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4. In the Query field, enter the query to select the data that matches the id column of the main flow. In this
example, this query reads:

Select * from person where id="+(Integer)globalMap.get("id")

For further information about the components used in this example, see Talend Open Studio Components Reference
Guide.

6.3. tXMLMap operation
Before starting this section, we recommend reading the previous tMap sections for the basic knowledge of a Talend mapping
component.

tXMLMap is fine-tuned to leverage the Document data type for processing XML data, a case of transformation
that often mixes hierarchical data (XML) and flat data together. This Document type carries a complete user-
specific XML flow. In using tXMLMap, you are able to add as many input or output flows as required into a
visual map editor to perform, on these flows, the operations as follows:

• data multiplexing and demultiplexing,

• data transformation on any type of fields, particularly on the Document type,

• data matching via different models, for example, the Unique match mode (related topic: How to use Explicit
Join),

• Automated XML tree construction on both of the input and the output sides,

• inner join and left outer join (related topic: How to use Inner Join)

• lookup between data sources whatever they are flat or XML data using models like Load once (related topic:
Handling Lookups),

• fields concatenation and interchange,
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• field filtering using constraints,

• data rejecting.

Like tMap, a map editor is required to configure these operations. To open this map editor, you can double-click
the tXMLMap icon in the design workspace, or alternatively, click the three-dot button next to the Map Editor
in the Basic settings view of the tXMLMap component.

tXMLMap and tMap use the common approaches to accomplish most of these operations. Therefore, the
following sections explain only the particular operations to which tXMLMap is dedicated for processing the
hierarchical XML data.

The operations focusing on hierarchical data are:

• using the Document type to create the XML tree;

• managing the output XML data;

• editing the XML tree schema.

The following sections present more relevant details.

Different from tMap, tXMLMap does not provide the Store temp data option for storing temporary data onto the directory
of your disk. For further information about this option of tMap, see Solving memory limitation issues in tMap use.

6.3.1. Using the document type to create the XML tree

The Document data type fits perfectly the conception of defining XML structure as easily as possible. When
you need the XML tree structure to map the input or output flow or both, use this type. Then you can import the
XML tree structure from various XML sources and edit the tree directly in the mapping editor, thus saving the
manual efforts.

6.3.1.1. How to set up the Document type

The Document data type is one of the data types provided by Talend. This Document type is set up when you
edit the schema for the corresponding data in the Schema editor. For further information about the schema editor,
see Using the Schema Editor.

The following figure presents an example in which the input flow, Customer, is set up as the Document type. To
replicate it, in the Map editor, you can simply click the [+] button to add one row on the input side of the Schema
editor, rename it and select Document from the drop-down list of the given data types.
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In practice for most cases, tXMLMap retrieves the schema of its preceding or succeeding components, for
example, from a tFileInputXML component or in the ESB use case, from a tESBProviderRequest component.
This avoids many manual efforts to set up the Document type for the XML flow to be processed. However, to
continue to modify the XML structure as the content of a Document row, you need still to use the given Map editor.

Be aware that a Document flow carries a user-defined XML tree and is no more than one single field of a schema, which,
same as the other schemas, may contain different data types between each field. For further information about how to set
a schema, see Basic Settings tab.

Once the Document type is set up for a row of data, in the corresponding data flow table in the map editor, a basic
XML tree structure is created automatically to reflect the details of this structure. This basic structure represents
the minimum element required by a valid XML tree in using tXMLMap:

• The root element: it is the minimum element required by an XML tree to be processed and when needs be, the
foundation to develop a sophisticated XML tree.

• The loop element: it determines the element over which the iteration takes place to read the hierarchical data of
an XML tree. By default, the root element is set as loop element.

This figure gives an example with the input flow, Customer. Based on this generated XML root tagged as root by
default, you can develop the XML tree structure of interest.

To do this, you need to:

1. Import the custom XML tree structure from one of the following types of sources:

• XML or XSD files (related topic: How to import the XML tree structure from XML and XSD files)

When you import an XSD file, you will create the XML structure this XSD file describes.

• file XML connections created and stored in the Repository of your Studio (related topic: How to import
the XML tree structure from the Repository).

If needs be, you can develop the XML tree of interest manually using the options provided on the contextual menu.

2. Reset the loop element for the XML tree you are creating, if needs be. You can set as many loops as you need
to. At this step, you may have to consider the following situations:

• If you have to create several XML trees, you need to define the loop element for each of them.

• If you import the XML tree from the Repository, the loop element will have been set depending on the
set of the source structure. But you can still reset the loop element.

For further details, see How to set or reset a loop element for an imported XML structure

If needed, you can continue to modify the imported XML tree using the options provided in the contextual menu.
The following table presents the operations you can perform through the available options.

Options Operations

Create Sub-element and Create Attribute Add elements or attributes to develop an XML tree. Related topic: How to
add a sub-element or an attribute to an XML tree structure
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Options Operations

Set a namespace Add and manage given namespaces on the imported XML tree. Related
topic: How to manage a namespace

Delete Delete an element or an attribute. Related topic: How to delete an element
or an attribute from the XML tree structure

Rename Rename an element or an attribute.

As loop element Set or reset an element as loop element. Multiple loop elements and optional
loop element are supported.

As optional loop This option is not available unless to the loop element you have defined.

When the corresponding element exists in the source file, an optional loop
element works the same way as a normal loop element; otherwise, it resets
automatically its parent element as loop element or in absence of parent
element in the source file, it takes the element of the higher level until the
root element. But in the real-world practice, with such differences between
the XML tree and the source file structure, we recommend adapting the
XML tree to the source file for better performance.

As group element On the XML tree of the output side, set an element as group element. Related
topic: How to group the output data

As aggregate element On the XML tree of the output side, set an element as aggregate element.
Related topic: How to aggregate the output data

Add Choice Set the Choice element. Then all of its child elements developed underneath
will be contained in this declaration. This Choice element originates from
one of the XSD concepts. It enables tXMLMap to perform the function of
the XSD Choice element to read or write a Document flow.

When tXMLMap processes a choice element, the elements contained in
its declaration will not be outputted unless their mapping expressions are
appropriately defined.

The tXMLMap component declares automatically any Choice
element set in the XSD file it imports.

Set as Substitution Set the Substitution element to specify the element substitutable for a given
head element defined in the corresponding XSD. The Substitution element
enables tXMLMap to perform the function of the XSD Substitution
element to read or write a Document flow

When tXMLMap processes a substitution element, the elements contained
in its declaration will not be outputted unless their mapping expressions are
appropriately defined.

The tXMLMap component declares automatically any
Substitution element set in the XSD file it imports.

The following sections present more details about the process of creating the XML tree.

6.3.1.2. How to import the XML tree structure from XML and XSD
files

To import the XML tree structure from an XML file, proceed as follows:

1. In the input flow table of interest, right-click the column name to open the contextual menu. In this example,
it is Customer.
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2. From this menu, select Import From File.

3. In the pop-up dialog box, browse to the XML file you need to use to provide the XML tree structure of
interest and double-click the file.

To import the XML tree structure from an XSD file, proceed as follows:

1. In the input flow table of interest, right-click the column name to open the contextual menu. In this example,
it is Customer.

2. From this menu, select Import From File.

3. In the pop-up dialog box, browse to the XSD file you need to use to provide the XML tree structure of interest
and double-click the file.

4. In the dialog box that appears, select an element from the Root list as the root of your XML tree, and click
OK. Then the XML tree described by the XSD file imported is established.

The root of the imported XML tree is adaptable:

• When importing either an input or an output XML tree structure from an XSD file, you can choose an element as
the root of your XML tree.

• Once an XML structure is imported, the root tag is renamed automatically with the name of the XML source. To
change this root name manually, you need use the tree schema editor. For further information about this editor, see
Editing the XML tree schema.

Then, you need to define the loop element in this XML tree structure. For further information about how to define
a loop element, see How to set or reset a loop element for an imported XML structure.

6.3.1.3. How to import the XML tree structure from the Repository

To do this, proceed as follows:

1. In any input flow table, right click the column name to open the contextual menu. In this example, it is
Customer.
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2. From this menu, select Import From Repository.

3. In the pop-up repository content list, select the XML connection or the MDM connection of interest to import
the corresponding XML tree structure.

This figure presents an example of this Repository-stored XML connection.

To import an XML tree structure from the Repository, the corresponding XML connection should have been created.
For further information about how to create a file XML connection in the Repository, see Centralizing XML file
metadata.

4. Click OK to validate this selection.

The XML tree structure is created and a loop is defined automatically as this loop was already defined during the
creation of the current Repository-stored XML connection.

6.3.1.4. How to set or reset a loop element for an imported XML
structure

You need to set at least one loop element for each XML tree if it does not have any. If it does, you may have to
reset the existing loop element when needs be.

Whatever you need to set or reset a loop element, proceed as follows:

1. In the created XML tree structure, right-click the element you need to define as loop. For example, you need
to define the Customer element as loop in the following figure.

2. From the pop-up contextual menu, select As loop element to define the selected element as loop.
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Once done, this selected element is marked with the text: loop:true.

If you close the Map Editor without having set the required loop element for a given XML tree, its root element will be
set automatically as loop element.

6.3.1.5. How to add a sub-element or an attribute to an XML tree
structure

In the XML tree structure view, you are able to manually add a sub-element or an attribute to the root or to any
of the existing elements when needs be.

To do either of these operations, proceed as follows:

1. In the XML tree you need to edit, right-click the element to which you need to add a sub-element or an
attribute underneath and select Create Sub-Element or Create Attribute according to your purpose.

2. In the pop-up [Create New Element] wizard, type in the name you need to use for the added sub-element
or attribute.
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3. Click OK to validate this creation. The new sub-element or attribute displays in the XML tree structure you
are editing.

6.3.1.6. How to delete an element or an attribute from the XML
tree structure

From an established XML tree, you may need to delete an element or an attribute. To do this, proceed as follows:

1. In the XML tree you need to edit, right-click the element or the attribute you need to delete.

2. In the pop-up contextual menu, select Delete.

Then the selected element or attribute is deleted, including all of the sub-elements or the attributes attached
to it underneath.

6.3.1.7. How to manage a namespace

When necessary, you are able to set and edit namespace for each of the element in the a created XML tree of the
input or the output data flow.

Defining a namespace

To do this, proceed as follows:

1. In the XML tree of the input or the output data flow you need to edit, right click the element for which you
need to declare a namespace. For example, in a Customer XML tree of the output flow, you need to set a
namespace for the root.
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2. In the pop-up contextual menu, select Set a namespace. Then the [Namespace dialog] wizard displays.

3. In this wizard, type in the URI you need to use.

4. If you need to set a prefix for this namespace you are editing, select the Prefix check box in this wizard and
type in the prefix you need. In this example, we select it and type in xhtml.

5. Click OK to validate this declaration.
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Modifying the default value of a namespace

To do this, proceed as follows:

1. In the XML tree that the namespace you need to edit belongs to, right-click this namespace to open the
contextual menu.

2. In this menu, select Set A Fixed Prefix to open the corresponding wizard.

3. Type in the new default value you need in this wizard.

4. Click OK to validate this modification.

Deleting a namespace

To do this, proceed as follows:

1. In the XML tree that the namespace you need to edit belongs to, right-click this namespace to open the
contextual menu.

2. In this menu, click Delete to validate this deletion

6.3.1.8. How to group the output data

The tXMLMap component uses a group element to group the output data according to a given grouping condition.
This allows you to wrap elements matching the same condition with this group element.

To set a group element, two restrictions must be respected:

1. the root node cannot be set as group element;

2. the group element must be the parent of the loop element.

The option of setting group element is not visible until you have set the loop element; this option is also invisible if an
element is not allowed to be set as group element.

Once the group element is set, all of its sub-elements except the loop one are used as conditions to group the
output data.

You have to carefully design the XML tree view for the optimized usage of a given group element. For further
information about how to use a group element, see tXMLMap in Talend Open Studio Components Reference
Guide.

tXMLMap provides group element and aggregate element to classify data in the XML tree structure. When handling a row
of XML data flow, the behavioral difference between them is:

• The group element processes the data always within one single flow.

• The aggregate element splits this flow into separate and complete XML flows.
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Setting a group element

To set a group element, proceed as follows:

1. In the XML tree view on the output side of the Map editor, right-click the element you need to set as group
element.

2. From the opened contextual menu, select As group element.

Then this element of selection becomes the group element. The following figure presents an example of an
XML tree with the group element.

Revoking a defined group element

To revoke a defined group element, proceed as follows:

1. In the XML tree view on the output side of the Map editor, right-click the element you have defined as
group element.

2. From the opened contextual menu, select Remove group element.

Then the defined group element is revoked.

6.3.1.9. How to aggregate the output data

With tXMLMap, you can define as many aggregate elements as required in the output XML tree to class the
XML data accordingly. Then this component outputs these classes, each as one complete XML flow.

1. To define an element as aggregate element, simply right-click this element of interest in the XML tree view
on the output side of the Map editor and from the contextual menu, select As aggregate element.

Then this element becomes the aggregate element. Texts in red are added to it, reading aggregate : true. The
following figure presents an example.
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2. To revoke the definition of the aggregate element, simply right-click the defined aggregate element and from
the contextual menu, select Remove aggregate element.

To define an element as aggregate element, ensure that this element has no child element and the All in one feature is being
disabled. The As aggregate element option is not available in the contextual menu until both of the conditions are respected.
For further information about the All in one feature, see How to output elements into one document.

For an example about how to use the aggregate element with tXMLMap, see Talend Open Studio Components
Reference Guide.

tXMLMap provides group element and aggregate element to classify data in the XML tree structure. When handling one
row of data ( one complete XML flow), the behavioral difference between them is:

• The group element processes the data always within one single flow.

• The aggregate element splits this flow into separate and complete XML flows.

6.3.2. Defining the output mode

To define the output mode of the document-type data, you are defining whether to put all of the XML elements into
one single XML flow and when empty element exist, whether to output them. By doing this, you do not change
the structure of the XML tree you have created.

6.3.2.1. How to output elements into one document

Unless you are using the aggregate element which always classifies the output elements and splits an output XML
flow, you are able to determine whether an XML flow is output as one single flow or as separate flows, using the
All in one feature in the tXMLMap editor.

To do this, on the output side of the Map editor, proceed as follows:

1. Click the pincer icon to open the map setting panel. The following figure presents an example.
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2. Click the All in one field and from the drop-down list, select true or false to decide whether the output XML
flow should be one single flow.

• If you select true, the XML data is output all in one single flow. In this example, the single flow reads
as follows:

The structure of this flow reads:
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• If you select false, the XML data is output in separate flows, each loop being one flow, neither grouped
nor aggregated. In this example, these flows read as follows:
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Each flow contains one complete XML structure. To take the first flow as example, its structure reads:

The All in one feature is disabled if you are using the aggregate element. For further information about the aggregate element,
see How to aggregate the output data

6.3.2.2. How to manage empty element in Map editor

It may be necessary to create and output empty elements during the process of transforming data into XML flow,
such as, when tXMLMap works along with tWriteXMLField that creates empty elements or when there is no
input column associated with certain XML node in the output XML data flow.

By contrast, in some scenarios, you do not need to output the empty element while you have to keep them in the
output XML tree for some reasons.

tXMLMap allows you to set the boolean for the creation of empty element. To do this, on the output side of the
Map editor, perform the following operations:

1. Click the pincer icon to open the map setting panel.
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2. In the panel, click the Create empty element field and from the drop-down list, select true or false to decide
whether to output the empty element.

• If you select true, the empty element is created in the output XML flow and output, for example,
<customer><LabelState/></customer>.

• If you select false, the empty element is not output.

6.3.2.3. How to define the sequence of multiple input loops

If a loop element, or the flat data flow, receives mappings from more than one loop element of the input flow, you
need to define the sequence of the input loops. The first loop element of this sequence will be the primary loop,
so the transformation process related to this sequence will first loop over this element such that the data outputted
will be sorted with regard to its element values.

For example, in this figure, the types element is the primary loop and the outputted data will be sorted by the
values of this element.
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In this case in which one output loop element receives several input loop elements, a [...] button appears next to
this receiving loop element or for the flat data, appears on the head of the table representing the flat data flow.
To define the loop sequence, do the following:

1. Click this [...] button to open the sequence arrangement window as presented by the figure used earlier in
this section.

2. Use the up or down flash button to arrange this sequence.

6.3.3. Editing the XML tree schema

In addition to the Schema editor and the Expression editor views that tMap is also equipped with, a Tree schema
editor view is provided in the map editor of tXMLMap for you to edit the XML tree schema of an input or output
data flow.

To access this schema editor, click the Tree schema editor tab on the lower part of the map editor.
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The left half of this view is used to edit the tree schema of the input flow and the right half to edit the tree schema
of the output flow.

The following table presents further information about this schema editor.

Metadata Description

XPath Use it to display the absolute paths pointing to each element or attribute in a XML tree and edit the
name of the corresponding element or attribute.

Key Select the corresponding check box if the expression key data should be used to retrieve data
through the Join link. If unchecked, the Join relation is disabled.

Type Type of data: String, Integer, Document, etc.

This column should always be defined in a Java version.

Nullable Select this check box if the field value could be null.

Pattern Define the pattern for the Date data type.

Input metadata and output metadata are independent from each other. You can, for instance, change the label of a column
on the output side without the column label of the input schema being changed.

However, any change made to the metadata are immediately reflected in the corresponding schema on the
tXMLMap relevant (Input or Output) area, but also on the schema defined for the component itself on the design
workspace.

For detailed use cases about the multiple operations that you can perform using tXMLMap, see Talend Open
Studio Components Reference Guide.
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Chapter 7. Managing Metadata
Metadata in Talend Studio is definitional data that provides information about or documentation of other data
managed within Talend Studio.

This chapter provides procedures to create and manage various metadata items in the Repository that can be used
in all your Job designs. For how to use a Repository metadata item, see How to use centralized metadata in a
Job and How to set a repository schema.
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7.1. Objectives
The Metadata folder in the Repository tree view stores reusable information on files, databases, and/or systems
that you need to create your Jobs.

Various corresponding wizards help you store these pieces of information that can be used later to set the
connection parameters of the relevant input or output components and the data description called "schemas" in a
centralized manner in Talend Studio.

The procedures of different wizards slightly differ depending on the type of connection chosen.

Click Metadata in the Repository tree view to expand the folder tree. Each of the connection nodes will gather
the various connections and schemas you have set up.

From Talend Studio, you can set up the following, amongst others:

• a DB connection,

• a JDBC schema,

• a SAS connection,

• a file schema,

• an LDAP schema,

• a Salesforce schema,

• a generic schema,

• a MDM connection,
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• a WSDL schema,

• a FTP connection,

The following sections explain in detail how to set up different connections and schemas.

7.2. Centralizing database metadata
If you often need to connect to database tables of any kind, then you may want to centralize the connection
information details in the Metadata folder in the Repository tree view.

This setup procedure is made of two separate but closely related major tasks:

1. Set up a database connection,

2. Retrieve the table schemas.

The sections below describe how to complete the tasks in detail.

Prerequisites: Talend Studio requires specific third-party Java libraries or database drivers (.jar files) to be
installed in order to connect to sources or targets. Due to license restrictions, Talend may not be able to ship
certain required libraries or drivers; in that situation, the connection wizard to be presented in the following
sections displays related information to help you identify and install the libraries or drivers in question. For more
information, see Talend Installation and Upgrade Guide.

7.2.1. Setting up a database connection

To create a database connection from scratch, expand Metadata in the Repository tree view, right-click Db
Connections and select Create connection from the contextual menu to open the database connection setup
wizard.

To centralize database connection parameters you have defined in a Job, click the  icon in the Basic settings
view of the relevant database component with its Property Type set to Built-in to open the database connection
setup wizard.

To modify an existing database connection, right-click the connection item from the Repository tree view, and
select Edit connection to open the connection setup wizard.

Then define the general properties and parameters of the connection in the wizard.

7.2.1.1. Defining general properties

1. In the connection setup wizard, give your connection a name in the Name field. This name will appear as the
database connection name under the Metadata node of the Repository tree view.
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2. Fill in the optional Purpose and Description fields as required. The information you fill in the Description
field will appear as a tooltip when you move your mouse pointer over the connection.

3. If needed, set the connection version and status in the Version and Status fields respectively. You can also
manage the version and status of a repository item in the [Project Settings] dialog box. For more information,
see Version management and Status management respectively.

4. If needed, click the Select button next to the Path field to select a folder under the Db connections node
to hold your newly created database connection. Note that you cannot select a folder if you are editing an
existing database connection, but you can drag and drop a connection to a new folder whenever you want.

5. Click Next when completed. The second step requires you to fill in or edit database connection data.

7.2.1.2. Defining connection parameters

1. Select the type of the database to which you want to connect and fill in the connection details. The fields you
need to fill vary depending on the database type you select.
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When you are creating the database connection of some databases like AS/400, HSQDB, Informix, MsSQL, MySQL,
Oracle, Sybase, or Teradata, you can specify additional connection properties through the Additional parameters
field in the Database Settings area.

If you need to connect to Hive, we recommend using one of the Talend solutions with Big Data.

If you are creating an MSSQL connection, in order to be able to retrieve all table schemas in the database, be sure to:

- enter dbo in the Schema field if you are connecting to MSSQL 2000,

- remove dbo from the Schema field if you are connecting to MSSQL 2005/2008.

2. Click Check to check your connection.

If the connection fails, a message box is displayed to indicate this failure and from that message box. From
that message box, click the Details button to read further information.

If a missing library or driver (.jar file) has provoked this failure, you can read that from the Details panel
and then install the specified library or driver.
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The Studio provides multiple approaches to automate the installation. For further information, see the chapter
describing how to install external modules of the Talend Installation and Upgrade Guide.

3. If needed, fill in the database properties information. That is all for the first operation on database connection
setup. Click Finish to close the connection setup wizard.

The newly created database connection is now available in the Repository tree view and it displays several
folders including Queries (for SQL queries you save) and Table schemas that will gather all schemas linked
to this database connection upon table schema retrieval.

Now you can drag and drop the database connection onto the design workspace as a database component to
reuse the defined database connection details in your Job.

7.2.2. Retrieving table schemas

To retrieve table schemas from the database connection you have just set up, right-click the connection item from
the Repository tree view, and select Retrieve schema from the contextual menu.

An error message will appear if there are no tables to retrieve from the selected database or if you do not have the correct
rights to access this database.

A new wizard opens up where you can filter and show different objects (tables, views and synonyms) in your
database connection, select tables of interest, and define table schemas.

For the time being, synonyms option works for Oracle, IBM DB2 and MSSQL only.
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7.2.2.1. Filtering database objects

In the Select Filter Conditions area, you can filter the database objects using either of the two options: Set the
Name Filter or Use the Sql Filter to filter tables based on objects names or using SQL queries respectively.

To filter database tables based on their names, do the following:

1. In the Select Filter Conditions area, select the Use the Name Filter option.

2. In the Select Types area, select the check box(es) of the database object(s) you want to filter or display.

Available options can vary according to the selected database.

3. In the Set the Name Filter area, click Edit... to open the [Edit Filter Name] dialog box.

4. Enter the filter you want to use in the dialog box. For example, if you want to recuperate the database objects
which names start with "A", enter the filter "A%", or if you want to recuperate all database objects which
names end with "type", enter "%type" as your filter.

5. Click OK to close the dialog box.

6. Click Next to open a new view on the wizard that lists the filtered database objects.

To filter database objects using an SQL query, do the following:

1. In the Select Filter Conditions area, select the Use Sql Filter option.

2. In the Set the Sql Filter field, enter the SQL query you want to use to filter database objects.
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3. Click Next to open a new view that lists the filtered database objects.

7.2.2.2. Selecting tables and defining table schemas

Once you have the filtered list of the database objects (tables, views and synonyms), do the following to load the
schemas of the desired objects onto your Repository:

1. Select one or more database objects on the list and click Next to open a new view on the wizard where you
can see the schemas of the selected object.

If no schema is visible on the list, click the Check connection button below the list to verify the database connection
status.



Retrieving table schemas

Talend Open Studio for MDM User Guide 241

2. Modify the schemas if needed.

Make sure the data type in the Type column is correctly defined.

For more information regarding data types, including date pattern, check out http://docs.oracle.com/javase/6/docs/api/
index.html.

If your source database table contains any default value that is a function or an expression rather than a string, be
sure to remove the single quotation marks, if any, enclosing the default value in the end schema to avoid unexpected
results when creating database tables using this schema.

For more information, see https://help.talend.com/display/KB/Verifying+default+values+in+a+retrieved+schema.

By default, the schema displayed on the Schema panel is based on the first table selected in the list of schemas
loaded (left panel). You can change the name of the schema and according to your needs. You can also
customize the schema structure in the schema panel.

The tool bar allows you to add, remove or move columns in your schema. In addition, you can load an XML
schema from a file or export the current schema as XML.

To retrieve a schema based on one of the loaded table schemas, select the DB table schema name in the drop-
down list and click Retrieve schema. Note that the retrieved schema then overwrites any current schema
and does not retain any custom edits.

When done, click Finish to complete the database schema creation. All the retrieved schemas are displayed
in the Table schemas sub-folder under the relevant database connection node.

http://docs.oracle.com/javase/6/docs/api/index.html
http://docs.oracle.com/javase/6/docs/api/index.html
https://help.talend.com/display/KB/Verifying+default+values+in+a+retrieved+schema
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Now you can drag and drop any table schema of the database connection from the Repository tree view onto
the design workspace as a new database component or onto an existing component to reuse the metadata. For
more information, see How to use centralized metadata in a Job and How to set a repository schema.

7.3. Centralizing JDBC metadata
To centralize DB table based metadata into a JDBC connection under the Metadata node of the Repository tree
view, the procedure is made of two separate but closely related tasks:

1. Set up a JDBC connection,

2. Retrieve the table schemas.

The sections below describe how to complete the tasks in detail.

7.3.1. Setting up a JDBC connection

1. To create a JDBC connection from scratch, expand Metadata in the Repository tree view, right-click Db
Connections and select Create connection from the contextual menu to open the database connection setup
wizard.

To centralize database connection parameters you have defined in a Job into a JDBC connection, click the

 icon in the Basic settings view of the relevant database component with its Property Type set to Built-
in to open the database connection setup wizard.

To modify an existing JDBC connection, right-click the connection item from the Repository tree view, and
select Edit connection to open the connection setup wizard.

2. Fill in the schema generic information, such as the connection Name and Description, and then click Next
to proceed to define the connection details.

For further information, see the section on defining general properties in Setting up a database connection.

3. Select General JDBC from the DB Type list.
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4. Fill in the connection details as follows:

• Fill in the JDBC URL used to access the database server.

• In the Driver jar field, select the jar driver validating your connection to the database.

• In the Class name field, fill in the main class of the driver allowing to communicate with the database.

• Fill in your User name and Password.

• Fill the Mapping File field with the mapping allowing the database Type to match the Java type of data
on the schema by clicking the [...] button to open a dialog box and selecting the mapping file from the
Mapping list area according to the type of database you are connecting to.

The mapping files are XML files that you can manage via Window > Preferences > Talend > Specific Settings
> Metadata of TalendType. For more information, see Type conversion (Talend > Specific Settings).
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5. Click Check to check your connection.

6. Fill in, if needed, the database properties information. Click Finish to close the connection setup wizard.

The newly created JDBC connection is now available in the Repository tree view and it displays several
folders including Queries (for the SQL queries you save) and Table schemas that will gather all schemas
linked to this DB connection upon schema retrieval.

7.3.2.  Retrieving table schemas

1. To retrieve table schemas from the database connection you have just set up, right-click the connection item
from the Repository tree view and select Retrieve schema from the contextual menu.

A new wizard opens up where you can filter and show different objects (tables, views and synonyms) in your
database connection, select tables of interest, and define table schemas.

2. Define a filter to filter databases objects according to your need. For details, see Filtering database objects.

Click Next to open a view that lists your filtered database objects. The list offers all the databases with all
their tables present on the database connection that meet you filter conditions.

If no database is visible on the list, click Check connection to verify the database connection.

3. Select one or more tables on the list to load them onto your repository file system. Your repository schemas
will be based on these tables.

4. Click Next. On the next window, four setting panels help you define the schemas to create. Modify the
schemas if needed.

In Java, make sure the data type is correctly defined. For more information regarding data types, including date pattern,
check out http://docs.oracle.com/javase/6/docs/api/index.html.

http://docs.oracle.com/javase/6/docs/api/index.html
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If your source database table contains any default value that is a function or an expression rather than a string, be
sure to remove the single quotation marks, if any, enclosing the default value in the end schema to avoid unexpected
results when creating database tables using this schema.

For more information, see https://help.talend.com/display/KB/Verifying+default+values+in+a+retrieved+schema.

By default, the schema displayed on the Schema panel is based on the first table selected in the list of schemas
loaded (left panel). You can change the name of the schema and according to your needs, you can also
customize the schema structure in the schema panel.

The tool bar allows you to add, remove or move columns in your schema. In addition, you can load an XML
schema from a file or export the current schema as XML.

To retrieve a schema based on one of the loaded table schemas, select the database table schema name in
the drop-down list and click Retrieve schema. Note that the retrieved schema then overwrites any current
schema and does not retain any custom edits.

When done, click Finish to complete the database schema creation. All the retrieved schemas are displayed
in the Table schemas sub-folder under the relevant database connection node.

Now you can drag and drop any table schema of the database connection from the Repository tree view onto
the design workspace as a new database component or onto an existing component to reuse the metadata. For
more information, see How to use centralized metadata in a Job and How to set a repository schema.

7.4. Centralizing SAS metadata
If you often need to connect to a remote SAS system, you can centralize the connection information in the
Repository.

To centralize the metadata information of a SAS connection in the Repository, you need to complete two major
tasks:

1. Set up a SAS connection,

2. Retrieve the database schemas.

Prerequisites:

• Talend Studio requires specific third-party Java libraries or database drivers (.jar files) to be installed in order
to connect to sources or targets. Due to license restrictions, Talend may not be able to ship certain required
libraries or drivers; in that situation, the connection wizard to be presented in the following sections displays
related information to help you identify and install the libraries or drivers in question. For more information,
see Talend Installation and Upgrade Guide.

• Before carrying on the procedure below to configure your SAS connection, make sure that you retrieve your
metadata from the SAS server and export it in XML format.

7.4.1. Setting up a SAS connection

1. In the Repository tree view of Talend Studio, right-click DB Connections under the Metadata node and
select Create connection from the contextual menu to open the [Database Connection] wizard.

2. Fill in the general properties of the connection, such as Name and Description and click Next to open a new
view on the wizard to define the connection details.

https://help.talend.com/display/KB/Verifying+default+values+in+a+retrieved+schema
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For further information, see the section on defining general properties in Setting up a database connection.

3. In the DB Type field of the [Database Connection] wizard, select SAS and fill in the fields that follow with
SAS connection information.

4. If needed, click the Check tab to verify if your connection is successful.

5. If needed, define the properties of the database in the corresponding fields in the Database Properties area.

6. Click Finish to validate your changes and close the wizard.

The newly set connection to the defined database displays under the DB Connections folder in the Repository
tree view. This connection has several sub-folders among which Table schemas will group all schemas
relative to this connection after schema retrieval.
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7.4.2. Retrieving table schemas
1. Right-click the SAS connection you created and then select Retrieve Schema from the contextual menu.

A new wizard opens up where you can filter and show different objects (tables, views) in your database
connection, select tables of interest, and define table schemas.

2. Filter databases objects according to your need, select one or more tables of interest, and modify the table
schemas if needed. For details, see Retrieving table schemas.

When done, you can drag and drop any table schema of the SAS connection from the Repository tree view
onto the design workspace as a new component or onto an existing component to reuse the metadata. For
more information, see How to use centralized metadata in a Job and How to set a repository schema.

7.5. Centralizing File Delimited metadata
If you often need to read data from and/or write data to delimited files, you may want to centralize their
metadata in the Repository for easy reuse. File Delimited metadata can be used to define the properties of
tFileInputDelimited, tFileOutputDelimited, and t*OutputBulk components.

The file schema creation is very similar for all types of file connections: Delimited, Positional, Regex, XML, or Ldif.

Unlike the database connection wizard, the [New Delimited File] wizard gathers both file connection and schema
definitions in a four-step procedure.

To create a File Delimited connection from scratch, expand Metadata in the Repository tree view, right-click
File Delimited and select Create file delimited from the contextual menu to open the file metadata setup wizard.

To centralize a file connection and its schema you have defined in a Job, click the  icon in the Basic settings
view of the relevant component with its Property Type set to Built-in to open the file metadata setup wizard.

Then define the general properties and file schema in the wizard.

Defining the general properties

1. In the file metadata setup wizard, fill in the Name field, which is mandatory, and the Purpose and Description
fields if you choose to do so. The information you provide in the Description field will appear as a tooltip
when you move your mouse pointer over the file connection.
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2. If needed, set the version and status in the Version and Status fields respectively. You can also manage
the version and status of a repository item in the [Project Settings] dialog box. For more information, see
Version management and Status management respectively.

3. If needed, click the Select button next to the Path field to select a folder under the File delimited node to
hold your newly created file connection. Note that you cannot select a folder if you are editing an existing
connection, but you can drag and drop it to a new folder whenever you want.

4. Click Next when completed with the general properties.

Defining the file path and format

1. Click the Browse... button to search for the file on the local host or a LAN host.
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2. Select the OS Format the file was created in. This information is used to prefill subsequent step fields. If the
list doesn't include the appropriate format, ignore it.

3. The File viewer gives an instant picture of the file loaded. Check the file consistency, the presence of header
and more generally the file structure.

4. Click Next to proceed to the next step.

Defining the file parsing parameters

On this view, you can refine the various settings of your file so that the file schema can be properly retrieved.
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1. Set the Encoding type,and the Field and Row separators in the File Settings area.

2. Depending on your file type (csv or delimited), set the Escape and Enclosure characters to be used.
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3. If the file preview shows a header message, exclude the header from the parsing. Set the number of header
rows to be skipped. Also, if you know that the file contains footer information, set the number of footer lines
to be ignored.

4. The Limit of Rows allows you to restrict the extend of the file being parsed. If needed, select the Limit check
box and set or select the desired number of rows.

5. In the File Preview panel, view the new settings impact.

6. Check the Set heading row as column names box to transform the first parsed row as labels for schema
columns. Note that the number of header rows to be skipped is then incremented by 1.

7. Click Refresh on the preview panel for the settings to take effect and view the result on the viewer.

8. Click Next to proceed to the final step to check and customize the generated file schema.

Checking and customizing the file schema

The last step shows the Delimited File schema generated. You can customize the schema using the toolbar
underneath the table.
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1. If the Delimited file which the schema is based on has been changed, use the Guess button to generate again
the schema. Note that if you customized the schema, the Guess feature does not retain these changes.

2. Click Finish. The new schema is displayed under the relevant File Delimited connection node in the
Repository tree view.

Now you can drag and drop the file connection or any schema of it from the Repository tree view onto the design
workspace as a new component or onto an existing component to reuse the metadata. For further information
about how to use the centralized metadata in a Job, see How to use centralized metadata in a Joband How to set
a repository schema.

To modify an existing file connection, right-click it from the Repository tree view, and select Edit file delimited
to open the file metadata setup wizard.

To add a new schema to an existing file connection, right-click the connection from the Repository tree view and
select Retrieve Schema from the contextual menu.

To edit an existing file schema, right-click the schema from the Repository tree view and select Edit Schema
from the contextual menu.

7.6. Centralizing File Positional metadata
If you often need to read data from and/or write data to certain positional files, you may want to centralize
their metadata in the Repository for easy reuse. File Positional metadata can be used to define the properties of
tFileInputPositional, tFileOutputPositional, and tFileInputMSPositional components.
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Like the [New Delimited File] wizard, the [New Positional File] wizard gathers both file connection and schema
definitions in a four-step procedure.

The file schema creation is very similar for all types of file connections: Delimited, Positional, Regex, XML, or Ldif.

To create a File Positional connection from scratch, expand Metadata in the Repository tree view, right-click
File positional and select Create file positional from the contextual menu to open the file metadata setup wizard.

To centralize a file connection and its schema you have defined in a Job, click the  icon in the Basic settings
view of the relevant component with its Property Type set to Built-in to open the file metadata setup wizard.

Then define the general properties and file schema in the wizard.

Defining the general properties

1. In the file metadata setup wizard, fill in the Name field, which is mandatory, and the Purpose and Description
fields if you choose to do so. The information you provide in the Description field will appear as a tooltip
when you move your mouse pointer over the file connection.

2. If needed, set the version and status in the Version and Status fields respectively. You can also manage
the version and status of a Repository item in the [Project Settings] dialog box. For more information, see
Version management and Status management respectively.

3. If needed, click the Select button next to the Path field to select a folder under the File positional node to
hold your newly created file connection. Note that you cannot select a folder if you are editing an existing
connection, but you can drag and drop it to a new folder whenever you want.
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4. Click Next when completed with the general properties.

Defining the file path, format and marker positions

1. Click the Browse... button to search for the file on the local host or a LAN host.

2. Select the Encoding type and the OS Format the file was created in. This information is used to prefill
subsequent step fields. If the list doesn't include the appropriate format, ignore the OS format.

The file is loaded and the File Viewer area shows a file preview and allows you to place your position markers.

3. Click the file preview and set the markers against the ruler to define the file column properties. The orange
arrow helps you refine the position.
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The Field Separator and Marker Position fields are automatically filled with a series of figures separated
by commas.

The figures in the Field Separator are the number of characters between the separators, which represent
the lengths of the columns of the loaded file. The asterisk symbol means all remaining characters on the
row, starting from the preceding marker position. You can change the figures to specify the column lengths
precisely.

The Marker Position field shows the exact position of each marker on the ruler, in units of characters. You
can change the figures to specify the positions precisely.

To move a marker, press its arrow and drag it to the new position. To remove a marker, press its arrow and

drag it towards the ruler until a  icon appears.

4. Click Next to continue.

Defining the file parsing parameters

On this view, you define the file parsing parameters so that the file schema can be properly retrieved.

At this stage, the preview shows the file columns upon the markers' positions.
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1. Set the Field and Row separators in the File Settings area.

• If needed, change the figures in the Field Separator field to specify the column lengths precisely.

• If the row separator of your file is not the standard EOL (end of line), select Custom String from the Row
Separator list and specify the character string in the Corresponding Character field.

2. If your file has any header rows to be excluded from the data content, select the Header check box in the
Rows To Skip area and define the number of rows to be ignored in the corresponding field. Also, if you know
that the file contains footer information, select the Footer check box and set the number of rows to be ignored.

3. The Limit of Rows area allows you to restrict the extend of the file being parsed. If needed, select the Limit
check box and set or select the desired number of rows.

4. If the file contains column labels, select the Set heading row as column names check box to transform the
first parsed row to labels for schema columns. Note that the number of header rows to be skipped is then
incremented by 1.

5. Click Refresh Preview on the Preview panel for the settings to take effect and view the result on the viewer.

6. Click Next to proceed to the next view to check and customize the generated file schema.

Checking and customizing the file schema

Step 4 shows the end schema generated. Note that any character which could be misinterpreted by the program is
replaced by neutral characters. Underscores replace asterisks, for example.



Centralizing File Positional metadata

Talend Open Studio for MDM User Guide 257

1. Rename the schema (by default, metadata) and edit the schema columns as needed.

2. To generate the Positional File schema again, click the Guess button. Note that, however, any edits to the
schema might be lost after "guessing" the file-based schema.

3. When done, click Finish to close the wizard.

The new schema is displayed under the relevant File positional connection node in the Repository tree view. You
can drop the defined metadata from the Repository onto the design workspace as a new component or onto an
existing component to reuse the metadata. For further information about how to use the centralized metadata in a
Job, see How to use centralized metadata in a Joband How to set a repository schema.

To modify an existing file connection, right-click it from the Repository tree view, and select Edit file positional
to open the file metadata setup wizard.

To add a new schema to an existing file connection, right-click the connection from the Repository tree view and
select Retrieve Schema from the contextual menu.

To edit an existing file schema, right-click the schema from the Repository tree view and select Edit Schema
from the contextual menu.
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7.7. Centralizing File Regex metadata
Regex file schemas are used for files made of regular expressions, such as log files. If you often need to connect
to a regex file, you may want to centralize its connection and schema information in the Repository for easy reuse.

Like the [New Delimited File] wizard, the [New RegEx File] wizard gathers both file connection and schema
definitions in a four-step procedure.

This procedure requires some advanced knowledge on regular expression syntax.

To create a File Regex connection from scratch, expand the Metadata node in the Repository tree view, right-
click File Regex and select Create file regex from the contextual menu to open the file metadata setup wizard.

To centralize a file connection and its schema you have defined in a Job, click the  icon in the Basic settings
view of the relevant component with its Property Type set to Built-in to open the file metadata setup wizard.

Then define the general properties and file schema in the wizard.

Defining the general properties

1. In the file metadata setup wizard, fill in the Name field, which is mandatory, and the Purpose and Description
fields if you choose to do so. The information you provide in the Description field will appear as a tooltip
when you move your mouse pointer over the file connection.

2. If needed, set the version and status in the Version and Status fields respectively. You can also manage
the version and status of a repository item in the [Project Settings] dialog box. For more information, see
Version management and Status management respectively.
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3. If needed, click the Select button next to the Path field to select a folder under the File regex node to hold your
newly created file connection. Note that you cannot select a folder if you are editing an existing connection,
but you can drag and drop it to a new folder whenever you want.

4. Click Next when completed with the general properties.

Defining the file path and format

1. Click the Browse... button to search for the file on the local host or a LAN host.

2. Select the Encoding type and the OS Format the file was created in. This information is used to prefill
subsequent step fields. If the list doesn't include the appropriate format, ignore the OS format.

The file viewer gives an instant picture of the loaded file.

3. Click Next to define the schema structure.

Defining the file parsing parameters

On this view, you define the file parsing parameters so that the file schema can be properly retrieved.

1. Set the Field and Row separators in the File Settings area.

• If needed, change the figures in the Field Separator field to specify the column lengths precisely.

• If the row separator of your file is not the standard EOL, select Custom String from the Row Separator
list and specify the character string in the Corresponding Character field.

2. In the Regular Expression settings panel, enter the regular expression to be used to delimit the file.
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Make sure to include the Regex code in single or double quotes accordingly.

3. If your file has any header rows to be excluded from the data content, select the Header check box in the
Rows To Skip area and define the number of rows to be ignored in the corresponding field. Also, if you know
that the file contains footer information, select the Footer check box and set the number of rows to be ignored.

4. The Limit of Rows allows you to restrict the extend of the file being parsed. If needed, select the Limit check
box and set or select the desired number of rows.

5. If the file contains column labels, select the Set heading row as column names check box to transform the
first parsed row to labels for schema columns. Note that the number of header rows to be skipped is then
incremented by 1.

6. Then click Refresh preview to take the changes into account. The button changes to Stop until the preview
is refreshed.

7. Click Next to proceed to the next view where you can check and customize the generated Regex File schema.

Checking and customizing the file schema

1. Rename the schema (by default, metadata) and edit the schema columns as needed.

2. To retrieve or update the Regex File schema, click Guess. Note however that any edits to the schema might
be lost after guessing the file based schema.

3. When done, click Finish to close the wizard.

The new schema is displayed under the relevant File regex node in the Repository tree view. You can drop
the defined metadata from the Repository onto the design workspace as a new component or onto an existing
component to reuse the metadata. For further information about how to use the centralized metadata in a Job, see
How to use centralized metadata in a Job and How to set a repository schema.

To modify an existing file connection, right-click it from the Repository tree view, and select Edit file regex to
open the file metadata setup wizard.

To add a new schema to an existing file connection, right-click the connection from the Repository tree view and
select Retrieve Schema from the contextual menu.

To edit an existing file schema, right-click the schema from the Repository tree view and select Edit Schema
from the contextual menu.
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7.8. Centralizing XML file metadata
If you often need to connect to an XML file, you may want to use the [New Xml File] wizard to centralize your
connection to the file and the schema retrieved from it in your Repository for easy reuse.

Depending on the option you select, the wizard helps you create either an input or an output file connection. In a
Job, the tFileInputXML and tExtractXMLField components use the input connection created to read XML files,
whereas tAdvancedFileOutputXML uses the output schema created to either write an XML file, or to update
an existing XML file.

For further information about reading an XML file, see Setting up XML metadata for an input file.

For further information about writing an XML file, see Setting up XML metadata for an output file.

To create an XML file connection from scratch, expand the Metadata node in the Repository tree view, right-
click File XML and select Create file XML from the contextual menu to open the file metadata setup wizard.

To centralize a file connection and its schema you have defined in a Job, click the  icon in the Basic settings
view of the relevant component with its Property Type set to Built-in to open the file metadata setup wizard.

Then define the general properties and file schema in the wizard.

7.8.1. Setting up XML metadata for an input file

This section describes how to define a file connection and upload an XML schema for an input file. To define and
upload an output file, see Setting up XML metadata for an output file.

Defining the general properties

In this step, the general metadata properties such as the Name, Purpose and Description are set.

1. In the file metadata setup wizard, fill in the Name field, which is mandatory, and the Purpose and Description
fields if you choose to do so. The information you provide in the Description field will appear as a tooltip
when you move your mouse pointer over the file connection.

When you enter the general properties of the metadata to be created, you need to define the type of connection as
either input or output. It is therefore advisable to enter information that will help you distinguish between your input
and output schemas.
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2. If needed, set the version and status in the Version and Status fields respectively. You can also manage
the version and status of a Repository item in the [Project Settings] dialog box. For more information, see
Version management and Status management respectively.

3. If needed, click the Select button next to the Path field to select a folder under the File XML node to hold your
newly created file connection. Note that you cannot select a folder if you are editing an existing connection,
but you can drag and drop it to a new folder whenever you want.

4. Click Next to select the type of metadata.

Setting the type of metadata (input)

In this step, the type of metadata is set as either input or output. For this procedure, the metadata of interest is input.

1. In the dialog box, select Input XML.
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2. Click Next to upload the input file.

Uploading an XML file

This procedure describes how to upload an XML file to obtain the XML tree structure. To upload an XML Schema
Definition (XSD) file, see Uploading an XSD file.

The example input XML file used to demonstrate this step contains some contact information, and the structure
is like the following:

<contactInfo>
  <contact>
    <id>1</id>
    <firstName>Michael</firstName>
    <lastName>Jackson</lastName>
    <company>Talend</company>
    <city>Paris</city>
    <phone>2323</phone>
  </contact>
  <contact>
    <id>2</id>
    <firstName>Elisa</firstName>
    <lastName>Black</lastName>
    <company>Talend</company>
    <city>Paris</city>
    <phone>4499</phone>
  </contact>
  ...
</contactInfo>

To upload an XML file, do the following:

1. Click Browse... and browse your directory to the XML file to be uploaded. Alternatively, enter the access
path to the file.

The Schema Viewer area displays a preview of the XML structure. You can expand and visualize every
level of the file's XML tree structure.
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2. Enter the Encoding type in the corresponding field if the system does not detect it automatically.

3. In the Limit field, enter the number of columns on which the XPath query is to be executed, or 0 if you want
to run it against all of the columns.

4. Click Next to define the schema parameters.

Uploading an XSD file

This procedure describes how to upload an XSD file to obtain the XML tree structure. To upload an XML file,
see Uploading an XML file.

An XSD file is used to define the schema of XML files. The structure and element data types of the example XML
file above can be described using the following XSD, which is used as the example XSD input in this section.

<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" elementFormDefault="qualified">
  <xs:element name="contactInfo">
    <xs:complexType>
      <xs:sequence>
        <xs:element maxOccurs="unbounded" ref="contact"/>
      </xs:sequence>
    </xs:complexType>
  </xs:element>
  <xs:element name="contact">
    <xs:complexType>
      <xs:sequence>
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        <xs:element ref="id"/>
        <xs:element ref="firstName"/>
        <xs:element ref="lastName"/>
        <xs:element ref="company"/>
        <xs:element ref="city"/>
        <xs:element ref="phone"/>
      </xs:sequence>
    </xs:complexType>
  </xs:element>
  <xs:element name="id" type="xs:integer"/>
  <xs:element name="firstName" type="xs:NCName"/>
  <xs:element name="lastName" type="xs:NCName"/>
  <xs:element name="company" type="xs:NCName"/>
  <xs:element name="city" type="xs:NCName"/>
  <xs:element name="phone" type="xs:integer"/>
</xs:schema>

For more information on XML Schema, see http://www.w3.org/XML/Schema.

When loading an XSD file,

• the data will be saved in the Repository, and therefore the metadata will not be affected by the deletion or displacement
of the file.

• you can choose an element as the root of your XML tree.

To load an XSD file, do the following:

1. Click Browse... and browse your directory to the XSD file to be uploaded. Alternatively, enter the access
path to the file.

2. In the dialog box the appears, select an element from the Root list as the root of your XML tree, and click OK.

The Schema Viewer area displays a preview of the XML structure. You can expand and visualize every
level of the file's XML tree structure.

http://www.w3.org/XML/Schema
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3. Enter the Encoding type in the corresponding field if the system does not detect it automatically.

4. In the Limit field, enter the number of columns on which the XPath query is to be executed, or 0 if you want
to run it against all of the columns.

5. Click Next to define the schema parameters.

Defining the schema

In this step the schema parameters are set.
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The schema definition window is composed of four views:

View Description

Source Schema Tree view of the XML file.

Target Schema Extraction and iteration information.

Preview Preview of the target schema, together with the input data of the selected
columns displayed in the defined order.

The preview functionality is not available if you loaded an XSD
file.

File Viewer Preview of the brute data.

First define an Xpath loop and the maximum number of times the loop can run. To do so:
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1. Populate the XPath loop expression field with the absolute XPath expression for the node to be iterated
upon. There are two ways to do this, either:

• enter the absolute XPath expression for the node to be iterated upon (Enter the full expression or press
Ctrl+Space to use the autocompletion list),

or

• drop a node from the tree view under Source schema onto the Absolute XPath expression field.

An orange arrow links the node to the corresponding expression.

The Xpath loop expression field is mandatory.

2. In the Loop limit field, specify the maximum number of times the selected node can be iterated.

3. Define the fields to be extracted dragging the node(s) of interest from the Source Schema tree into the
Relative or absolute XPath expression fields.

You can select several nodes to drop on the table by pressing Ctrl or Shift and clicking the nodes of interest. The
arrow linking an individual node selected on the Source Schema to the Fields to extract table are blue in colour.
The other ones are gray.

4. If needed, you can add as many columns to be extracted as necessary, delete columns or change the column
order using the toolbar:

•
Add or delete a column using the  and  buttons.
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•
Change the order of the columns using the  and  buttons.

5. In the Column name fields, enter labels for the columns to be displayed in the schema Preview area.

6. Click Refresh Preview to display a preview of the target schema. The fields are consequently displayed in
the schema according to the defined order.

The preview functionality is not available if you loaded an XSD file.

7. Click Next to check and edit the end schema.

Finalizing the end schema

The schema generated displays the columns selected from the XML file and allows you to further define the
schema.
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1. If needed, rename the metadata in the Name field (metadata, by default), add a Comment, and make further
modifications, for example:

• Redefine the columns by editing the relevant fields.

• Add or delete a column using the  and  buttons.

• Change the order of the columns using the  and  buttons.

2. If the XML file which the schema is based on has been changed, click the Guess button to generate the
schema again. Note that if you have customized the schema, the Guess feature does not retain these changes.

3. Click Finish. The new file connection, along with it schema, appears under the File XML node in the
Repository tree view.

Now you can drag and drop the file connection or any schema of it from the Repository tree view onto the design
workspace as a new tFileInputXML or tExtractXMLField component or onto an existing component to reuse
the metadata. For further information about how to use the centralized metadata in a Job, see How to use centralized
metadata in a Joband How to set a repository schema.
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To modify an existing file connection, right-click it from the Repository tree view, and select Edit file xml to
open the file metadata setup wizard.

To add a new schema to an existing file connection, right-click the connection from the Repository tree view and
select Retrieve Schema from the contextual menu.

To edit an existing file schema, right-click the schema from the Repository tree view and select Edit Schema
from the contextual menu.

7.8.2. Setting up XML metadata for an output file

This section describes how to define a file connection and upload an XML schema for an output file. To define
and upload an XML schema for an input file, see Setting up XML metadata for an input file.

Defining the general properties

In this step, the general metadata properties such as the Name, Purpose and Description are set.

1. In the file metadata setup wizard, fill in the Name field, which is mandatory, and the Purpose and Description
fields if you choose to do so. The information you provide in the Description field will appear as a tooltip
when you move your mouse pointer over the file connection.

When you enter the general properties of the metadata to be created, you need to define the type of connection as
either input or output. It is therefore advisable to enter information that will help you distinguish between your input
and output schemas.
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2. If needed, set the version and status in the Version and Status fields respectively. You can also manage
the version and status of a repository item in the [Project Settings] dialog box. For more information, see
Version management and Status management respectively.

3. If needed, click the Select button next to the Path field to select a folder under the File XML node to hold your
newly created file connection. Note that you cannot select a folder if you are editing an existing connection,
but you can drag and drop it to a new folder whenever you want.

4. Click Next to select the type of metadata.

Setting the type of metadata (output)

In this step, the type of metadata is set as either input or output. For this procedure, the metadata of interest is output.

1. From the dialog box, select Output XML.

2. Click Next to define the output file, either from an XML or XSD file or from scratch.

Defining the output file structure using an existing XML file

In this step, you will choose whether to create your file manually or from an existing XML or XSD file. If
you choose the Create manually option you will have to configure your schema, source and target columns
yourself at step 4 in the wizard. The file will be created in a Job using a an XML output component such as
tAdvancedFileOutputXML.

In this procedure, we will create the output file structure by loading an existing XML. To create the output XML
structure from an XSD file, see Defining the output file structure using an XSD file.

To create the output XML structure from an XML file, do the following:

1. Select the Create from a file option.

2. Click the Browse... button next to the XML or XSD File field, browse to the access path to the XML file
the structure of which is to be applied to the output file, and double-click the file.

The File Viewer area displays a preview of the XML structure, and the File Content area displays a maximum
of the first 50 rows of the file.
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3. Enter the Encoding type in the corresponding field if the system does not detect it automatically.

4. In the Limit field, enter the number of columns on which the XPath query is to be executed, or enter 0 if
you want it to be run against all of the columns.

5. In the Output File field, in the Output File Path zone, browse to or enter the path to the output file. If the
file does not exist as yet, it will be created during the execution of a Job using a tAdvancedFileOutputXML
component. If the file already exists, it will be overwritten.

6. Click Next to define the schema.
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Defining the output file structure using an XSD file

This procedure describes how to define the output XML file structure from an XSD file. To define the XML
structure from an XML file, see Defining the output file structure using an existing XML file.

When loading an XSD file,

• the data will be saved in the Repository, and therefore the metadata will not be affected by the deletion or displacement
of the file.

• you can choose an element as the root of your XML tree.

To create the output XML structure from an XSD file, do the following:

1. Select the Create from a file option.

2. Click the Browse... button next to the XML or XSD File field, browse to the access path to the XSD file the
structure of which is to be applied to the output file, and double-click the file.

3. In the dialog box the appears, select an element from the Root list as the root of your XML tree, and click OK.

The File Viewer area displays a preview of the XML structure, and the File Content area displays a maximum
of the first 50 rows of the file.
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4. Enter the Encoding type in the corresponding field if the system does not detect it automatically.

5. In the Limit field, enter the number of columns on which the XPath query is to be executed, or enter 0 if
you want it to be run against all of the columns.

6. In the Output File field, in the Output File Path zone, browse to or enter the path to the output file. If the
file does not exist as yet, it will be created during the execution of a Job using a tAdvancedFileOutputXML
component. If the file already exists, it will be overwritten.

7. Click Next to define the schema.

Defining the schema

Upon completion of the previous operations, the columns in the Linker Source area are automatically mapped to
the corresponding ones in the Linker Target area, as indicated by blue arrow links.
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In this step, you need to define the output schema. The following table describes how:

To... Perform the following...

Create a schema from scratch or
edit the source schema columns
to pass to the output schema

In the Linker Source area, click the Schema Management button to open the schema editor.

Define a loop element In the Linker Target area, right-click the element of interest and select Set As Loop Element
from the contextual menu.

It is a mandatory operation to define an element to run a loop on.

Define a group element In the Linker Target area, right-click the element of interest and select Set As Group Element
from the contextual menu.

You can set a parent element of the loop element as a group element on the condition
that the parent element is not the root of the XML tree.

Create a child element for an
element

In the Linker Target area,

• Right-click the element of interest and select Add Sub-element from the contextual menu, enter
a name for the sub-element in the dialog box that appears, and click OK, or

• Select the element of interest, click the  button at the bottom, select Create as sub-element

in the dialog box that appears, and click OK. Then, enter a name for the sub-element in the next
dialog box and click OK.

Create an attribute for an element In the Linker Target area,
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To... Perform the following...

• Right-click the element of interest and select Add Attribute from the contextual menu, enter a
name for the attribute in the dialog box that appears, and click OK, or

• Select the element of interest, click the  button at the bottom, select Create as attribute

in the dialog box that appears, and click OK. Then, enter a name for the attribute in the next
dialog box and click OK.

Create a name space for an
element

In the Linker Target area,

• Right-click the element of interest and select Add Name Space from the contextual menu, enter
a name for the name space in the dialog box that appears, and click OK, or

• Select the element of interest, click the  button at the bottom, select Create as name space

in the dialog box that appears, and click OK. Then, enter a name for the name space in the next
dialog box and click OK.

Delete one or more elements/
attributes/name spaces

In the Linker Target area,

• Right-click the element(s)/attribute(s)/name space(s) of interest and select Delete from the
contextual menu, or

•
Select the element(s)/attribute(s)/name space(s) of interest and click the  button at the
bottom, or

• Select the element(s)/attribute(s)/name space(s) of interest and press the Delete key.

Deleting an element will also delete its children, if any.

Adjust the order of one or more
elements

In the Linker Target area, select the element(s) of interest and click the  and  buttons.

Set a static value for an element/
attribute/name space

In the Linker Target area, right-click the element/attribute/name space of interest and select Set
A Fix Value from the contextual menu.

• The value you set will replace any value retrieved for the corresponding column from
the incoming data flow in your Job.

• You can set a static value for a child element of the loop element only, on the condition
that the element does not have its own children and does not have a source-target
mapping on it.

Create a source-target mapping Select the column of interest in the Linker Source area, drop it onto the node of interest in the
Linker Target area, and select Create as sub-element of target node, Create as attribute of
target node, or Add linker to target node according to your need in the dialog box that appears,
and click OK.

If you choose an option that is not permitted for the target node, you will see a warning message
and your operation will fail.

Remove a source-target mapping In the Linker Target area, right-click the node of interest and select Disconnect Linker from the
contextual menu.

Create an XML tree from another
XML or XSD file

Right-click any schema item in the Linker Target area and select Import XML Tree from
the contextual menu to load another XML or XSD file. Then, you need to create source-target
mappings manually and define the output schema all again.

You can select and drop several fields at a time, using the Ctrl + Shift technique to make multiple selections, therefore
making mapping faster. You can also make multiple selections for right-click operations.

1. In the Linker Target area, right-click the element you want to run a loop on and select Set As Loop Element
from the contextual menu.
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2. Define other output file properties as needed, and then click Next to view and customize the end schema.

Finalizing the end schema

Step 5 of the wizard displays the end schema generated and allows you to further define the schema.
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1. If needed, rename the metadata in the Name field (metadata, by default), add a Comment, and make further
modifications, for example:

• Redefine the columns by editing the relevant fields.

• Add or delete a column using the  and  buttons.

• Change the order of the columns using the  and  buttons.

2. If the XML file which the schema is based on has been changed, click the Guess button to generate the
schema again. Note that if you have customized the schema, the Guess feature does not retain these changes.

3. Click Finish. The new file connection, along with its schema, is displayed under the relevant File XML
metadata node in the Repository tree view.

Now you can drag and drop the file connection or any schema of it from the Repository tree view onto the design
workspace as a new tAdvancedFileOutputXML component or onto an existing component to reuse the metadata.

To modify an existing file connection, right-click it from the Repository tree view, and select Edit file xml to
open the file metadata setup wizard.

To add a new schema to an existing file connection, right-click the connection from the Repository tree view and
select Retrieve Schema from the contextual menu.

To edit an existing file schema, right-click the schema from the Repository tree view and select Edit Schema
from the contextual menu.
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7.9. Centralizing File Excel metadata
If you often need to read data from and/or write data to a certain Excel spreadsheet file, you may want to centralize
the connection to the file, along with its data structure, in the Repository for easy reuse. This will save you much
effort because you will not have to define the metadata details manually in the relevant components each time
you use the file.

You can centralize an Excel file connection either from an existing Excel file, or from Excel file property settings
defined in a Job.

To centralize a File Excel connection and its schema from an Excel file, expand Metadata in the Repository
tree view, right-click File Excel and select Create file Excel from the contextual menu to open the file metadata
setup wizard.

To centralize a file connection and its schema you have already defined in a Job, click the  icon in the Basic
settings view of the relevant component, with its Property Type set to Built-in, to open the file metadata setup
wizard.

Then complete these tasks step by step following the wizard:

• Define the general information that will identify the file connection. See Defining the general properties.

• Load the file of interest. See Loading the file.

• Parse the file to retrieve the file schema. See Parsing the file.

• Finalize the file schema. See Finalizing the end schema.

Defining the general properties

1. In the file metadata setup wizard, fill in the Name field, which is mandatory, and the Purpose and Description
fields if needed. The information you provide in the Description field will appear as a tooltip when you move
your mouse pointer over the file connection.
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2. If needed, set the version and status in the Version and Status fields respectively. You can also manage
the version and status of a repository item in the [Project Settings] dialog box. For more information, see
Version management and Status management respectively.

3. If needed, click the Select button next to the Path field to select a folder under the File Excel node to hold
your newly created file connection.

4. Click Next to proceed with file settings.

Loading the file

1. Click the Browse... button to browse to the file and fill out the File field.

Skip this step if you are saving an Excel file connection defined in a component because the file path is
already filled in the File field.
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2. If the uploaded file is an Excel 2007 file, make sure that the Read excel2007 file format(xlsx) check box
is selected.

3. By default, user mode is selected. If the uploaded xlsx file is extremely large, select Less memory consumed
for large excel(Event mode) from the Generation mode list to prevent out-of-memory errors.

4. In the File viewer and sheets setting area, view the file content and the select the sheet or sheets of interest.

• From the Please select sheet drop-down list, select the sheet you want to view. The preview table displays
the content of the selected sheet.

By default the file preview table displays the first sheet of the file.

• From the Set sheets parameters list, select the check box next to the sheet or sheets you want to upload.

If you select more than one sheet, the result schema will be the combination of the structures of all the
selected sheets.

5. Click Next to continue.
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Parsing the file

In this step of the wizard, you can define the various settings of your file so that the file schema can be properly
retrieved.

1. Specify the encoding, advanced separator for numbers, and the rows that should be skipped as they are header
or footer, according to your Excel file.

2. If needed, fill the First column and Last column fields with integers to set precisely the columns to be read
in the file. For example, if you want to skip the first column as it may not contain proper data to be processed,
fill the First column field with 2 to set the second column of the file as the first column of the schema.

To retrieve the schema of an Excel file you do not need to parse all the rows of the file, especially when you
have uploaded a large file. To limit the number of rows to parse, select the Limit check box in the Limit Of
Rows area and set or select the desired number of rows.

3. If your Excel file has a header row, select the Set heading row as column names check box to take into
account the heading names. Click Refresh to view the result of all the previous changes in the preview table.

4. Then click Next to continue.
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Finalizing the end schema

The last step of the wizard shows the end schema generated and allows you to customize the schema according
to your needs.

Note that any character which could be misinterpreted by the program is replaced by neutral characters. For
example, asterisks are replaced with underscores.

1. If needed, rename the schema (by default, metadata) and leave a comment.

Customize the schema if needed: add, remove or move schema columns, export the schema to an XML file,
or replace the schema by importing an schema definition XML file using the tool bar.

2. If the Excel file which the schema is based on has been changed, click the Guess button to generate the
schema again. Note that if you have customized the schema, the Guess feature does not retain these changes.

3. Click Finish. The new schema is displayed under the relevant File Excel connection node in the Repository
tree view.
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Now you can drag and drop the file connection or the schema of it from the Repository tree view onto the design
workspace as a new component or onto an existing component to reuse the metadata. For further information
about how to use the centralized metadata in a Job, see How to use centralized metadata in a Joband How to set
a repository schema.

To modify an existing file connection, right-click it from the Repository tree view, and select Edit file Excel to
open the file metadata setup wizard.

To add a new schema to an existing file connection, right-click the connection from the Repository tree view and
select Retrieve Schema from the contextual menu.

To edit an existing file schema, right-click the schema from the Repository tree view and select Edit Schema
from the contextual menu.

7.10. Centralzing File LDIF metadata
LDIF files are directory files described by attributes. If you often need to read certain LDIF files, you may want
to centralize the connections to these LDIF-type files and their attribute descriptions in the Repository for easy
reuse. This way you will not have to define the metadata details manually in the relevant components each time
you use the files.

You can centralize an LDIF file connection either from an existing LDIF file, or from the LDIF file property
settings defined in a Job.

To centralize an LDIF connection and its schema from an LDIF file, expand Metadata in the Repository tree view,
right-click File ldif and select Create file ldif from the contextual menu to open the file metadata setup wizard.

To centralize a file connection and its schema you have already defined in a Job, click the  icon in the Basic
settings view of the relevant component, with its Property Type set to Built-in, to open the file metadata setup
wizard.

Then complete these steps following the wizard:

Make sure that you have installed the required third-party module as described in the Talend Installation and Upgrade
Guide.

1. Fill in the general information in the relevant fields to identify the LDIF file metadata, including Name,
Purpose and Description.

The Name field is required, and the information you provide in the Description field will appear as a tooltip
when you move your mouse pointer over the file connection.
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2. If needed, set the version and status in the Version and Status fields respectively. You can also manage
the version and status of a repository item in the [Project Settings] dialog box. For more information, see
Version management and Status management respectively.

3. If needed, click the Select button next to the Path field to select a folder under the File ldif node to hold
your newly created file connection.

Click Next to proceed with file settings.

4. Click the Browse... button to browse to the file and fill out the File field.

Skip this step if you are saving an LDIF file connection defined in a component because the file path is
already filled in the File field.



Centralzing File LDIF metadata

Talend Open Studio for MDM User Guide 287

5. Check the first 50 rows of the file in the File Viewer area and click Next to continue.

6. From the list of attributes of the loaded file, select the attributes you want to include the file schema, and
click Refresh Preview to preview the selected attributes.

Then click Next to proceed with schema finalization.
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7. If needed, customize the generated schema:

• Rename the schema (by default, metadata) and leave a comment.

• Add, remove or move schema columns, export the schema to an XML file, or replace the schema by
importing an schema definition XML file using the tool bar.
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8. If the LDIF file on which the schema is based has been changed, click the Guess button to generate the
schema again. Note that if you have customized the schema, the Guess feature does not retain these changes.

9. Click Finish. The new schema is displayed under the relevant Ldif file connection node in the Repository
tree view.

Now you can drag and drop the file connection or the schema of it from the Repository tree view onto the design
workspace as a new component or onto an existing component to reuse the metadata. For further information
about how to use the centralized metadata in a Job, see How to use centralized metadata in a Joband How to set
a repository schema.

To modify an existing file connection, right-click it from the Repository tree view, and select Edit file ldif to
open the file metadata setup wizard.

To add a new schema to an existing file connection, right-click the connection from the Repository tree view and
select Retrieve Schema from the contextual menu.

To edit an existing file schema, right-click the schema from the Repository tree view and select Edit Schema
from the contextual menu.
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7.11. Centralizing JSON file metadata
If you often need to use a JSON file, you may want to use the [New Json File] wizard to centralize the file
connection, XPath query statements, and data structure in the Repository for easy reuse.

Depending on the option you select, the wizard helps you create either an input or an output file connections. In a
Job, the tFileInputJSON and tExtractJSONFields components use the input schema created to read JSON files/
fields, whereas tWriteJSONField uses the output schema created to write a JSON field, which can be saved in
a file by tFileOutputJSON or extracted by tExtractJSONFields.

For information about setting up input JSON file metadata, see Setting up JSON metadata for an input file.

For information about setting up output JSON metadata, see Setting up JSON metadata for an output file.

In the Repository view, expand the Metadata node, right click File JSON, and select Create JSON Schema
from the contextual menu to open the [New Json File] wizard.

7.11.1. Setting up JSON metadata for an input file

This section describes how to define a file connection and upload a JSON schema for an input file. To define an
output JSON file connection and schema, see Setting up JSON metadata for an output file.

Defining the general properties

1. In the wizard, fill in the general information in the relevant fields to identify the JSON file metadata, including
Name, Purpose and Description.

The Name field is required, and the information you provide in the Description field will appear as a tooltip
when you move your mouse pointer over the file connection.

In this step, it is advisable to enter information that will help you distinguish between your input and output connections,
which will be defined in the next step.
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2. If needed, set the version and status in the Version and Status fields respectively.

You can also manage the version and status of a repository item in the [Project Settings] dialog box. For
more information, see Version management and Status management respectively.

3. If needed, click the Select button next to the Path field to select a folder under the File Json node to hold
your newly created file connection.

4. Click Next to select the type of metadata.

Setting the type of metadata and loading the input file

1. In the dialog box, select Input Json and click Next to proceed to the next step of the wizard to load the
input file.
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2. Click Browse... and browse your directory to the JSON file to be uploaded. Alternatively, enter the full path
to the file or the URL that links to the JSON file.

The Schema Viewer area displays a preview of the JSON structure. You can expand and visualize every
level of the file's JSON tree structure.
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3. Enter the Encoding type in the corresponding field if the system does not detect it automatically.

4. In the Limit field, enter the number of columns on which the XPath query is to be executed, or 0 if you want
to run it against all of the columns.

5. Click Next to define the schema parameters.

Defining the schema

In this step you will set the schema parameters.
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The schema definition window is composed of four views:

View Description

Source Schema Tree view of the JSON file.

Target Schema Extraction and iteration information.

Preview Preview of the target schema, together with the input data of the selected
columns displayed in the defined order.

File Viewer Preview of the JSON file's data.

1. Populate the XPath loop expression field with the absolute XPath expression for the node to be iterated
upon. There are two ways to do this, either:
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• enter the absolute XPath expression for the node to be iterated upon (enter the full expression or press Ctrl
+Space to use the autocompletion list),

or

• drag the loop element node from the tree view under Source schema into the Absolute XPath expression
field of the Xpath loop expression table.

An orange arrow links the node to the corresponding expression.

The Xpath loop expression definition is mandatory.

2. In the Loop limit field, specify the maximum number of times the selected node can be iterated.

3. Define the fields to be extracted by dragging the nodes from the Source Schema tree into the Relative or
absolute XPath expression fields of the Fields to extract table.

You can select several nodes to drop onto the table by pressing Ctrl or Shift and clicking the nodes of interest.

4. If needed, you can add as many columns to be extracted as necessary, delete columns or change the column
order using the toolbar:

•
Add or delete a column using the  and  buttons.

•
Change the order of the columns using the  and  buttons.
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5. If you want your file schema to have different column names than those retrieved from the input file, enter
new names in the corresponding Column name fields.

6. Click Refresh Preview to preview the target schema. The fields are consequently displayed in the schema
according to the defined order.

7. Click Next to finalize the schema.

Finalizing the schema

The last step of the wizard shows the end schema generated and allows you to customize the schema according
to your needs.
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1. If needed, rename the schema (by default, metadata) and leave a comment.

Customize the schema if needed: add, remove or move schema columns, export the schema to an XML file,
or replace the schema by importing an schema definition XML file using the tool bar.

2. If the JSON file which the schema is based on has been changed, click the Guess button to generate the
schema again. Note that if you have customized the schema, the Guess feature does not retain these changes.

3. Click Finish. The new file connection, along with its schema, is displayed under the relevant File Json
metadata node in the Repository tree view.

Now you can drag and drop the file connection or the schema of it from the Repository tree view onto the design
workspace as a new tFileInputJSON or tExtractJSONFields component or onto an existing component to reuse
the metadata. For further information about how to use the centralized metadata in a Job, see How to use centralized
metadata in a Joband How to set a repository schema.

To modify an existing file connection, right-click it from the Repository tree view, and select Edit JSON to open
the file metadata setup wizard.

To add a new schema to an existing file connection, right-click the connection from the Repository tree view and
select Retrieve Schema from the contextual menu.
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To edit an existing file schema, right-click the schema from the Repository tree view and select Edit Schema
from the contextual menu.

7.11.2. Setting up JSON metadata for an output file

This section describes how to define JSON metadata for an output file. To define JSON metadata for an input file,
see Setting up JSON metadata for an input file.

Defining general properties

1. In the wizard, fill in the general information in the relevant fields to identify the JSON file metadata, including
Name, Purpose and Description.

The Name field is required, and the information you provide in the Description field will appear as a tooltip
when you move your mouse pointer over the file connection.

In this step, it is advisable to enter information that will help you distinguish between your input and output connections,
which will be defined in the next step.

2. If needed, set the version and status in the Version and Status fields respectively.

You can also manage the version and status of a repository item in the [Project Settings] dialog box. For
more information, see Version management and Status management respectively.

3. If needed, click the Select button next to the Path field to select a folder under the File Json node to hold
your newly created file connection.
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4. Click Next to set the type of metadata.

Setting the type of metadata and loading the template JSON file

In this step, the type of schema is set as either input or output. For this procedure, the schema of interest is output.

1. From the dialog box, select Output JSON click Next to proceed to the next step of the wizard.

2. Choose whether to create the output metadata manually or from an existing JSON file as a template.

If you choose the Create manually option you will have to configure the schema and link the source and
target columns yourself. The output JSON file/field is created via a Job using a JSON output component such
as tWriteJSONField.

In this example, we will create the output metadata by loading an existing JSON file. Therefore, select the
Create from a file option.

3. Click the Browse... button next to the JSON File field, browse to the access path to the JSON file the structure
of which is to be applied to the output JSON file/field, and double-click the file. Alternatively, enter the full
path to the file or the URL which links to the template JSON file.

The File Viewer area displays a preview of the JSON structure, and the File Content area displays a
maximum of the first 50 rows of the file.
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4. Enter the Encoding type in the corresponding field if the system does not detect it automatically.

5. In the Limit field, enter the number of columns on which the XPath query is to be executed, or enter 0 if
you want it to be run against all of the columns.

6. Optionally, specify an output file path.

7. Click Next to define the schema.

Defining the schema

Upon completion of the previous operations, the columns in the Linker Source area are automatically mapped to
the corresponding ones in the Linker Target area, as indicated by blue arrow links..
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In this step, you need to define the output schema. The following table describes how:

To... Perform the following...

Define a loop element In the Linker Target area, right-click the element of interest and select Set As Loop Element
from the contextual menu.

It is a mandatory operation to define an element to run a loop on.

Define a group element In the Linker Target area, right-click the element of interest and select Set As Group Element
from the contextual menu.

You can set a parent element of the loop element as a group element on the condition
that the parent element is not the root of the JSON tree.

Create a child element for an
element

In the Linker Target area,

• Right-click the element of interest and select Add Sub-element from the contextual menu, enter
a name for the sub-element in the dialog box that appears, and click OK, or
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To... Perform the following...

• Select the element of interest, click the  button at the bottom, select Create as sub-element

in the dialog box that appears, and click OK. Then, enter a name for the sub-element in the next
dialog box and click OK.

Create an attribute for an element In the Linker Target area,

• Right-click the element of interest and select Add Attribute from the contextual menu, enter a
name for the attribute in the dialog box that appears, and click OK, or

• Select the element of interest, click the  button at the bottom, select Create as attribute

in the dialog box that appears, and click OK. Then, enter a name for the attribute in the next
dialog box and click OK.

Create a name space for an
element

In the Linker Target area,

• Right-click the element of interest and select Add Name Space from the contextual menu, enter
a name for the name space in the dialog box that appears, and click OK, or

• Select the element of interest, click the  button at the bottom, select Create as name space

in the dialog box that appears, and click OK. Then, enter a name for the name space in the next
dialog box and click OK.

Delete one or more elements/
attributes/name spaces

In the Linker Target area,

• Right-click the element(s)/attribute(s)/name space(s) of interest and select Delete from the
contextual menu, or

•
Select the element(s)/attribute(s)/name space(s) of interest and click the  button at the
bottom, or

• Select the element(s)/attribute(s)/name space(s) of interest and press the Delete key.

Deleting an element will also delete its children, if any.

Adjust the order of one or more
elements

In the Linker Target area, select the element(s) of interest and click the  and  buttons.

Set a static value for an element/
attribute/name space

In the Linker Target area, right-click the element/attribute/name space of interest and select Set
A Fix Value from the contextual menu.

• The value you set will replace any value retrieved for the corresponding column from
the incoming data flow in your Job.

• You can set a static value for a child element of the loop element only, on the condition
that the element does not have its own children and does not have a source-target
mapping on it.

Create a source-target mapping Select the column of interest in the Linker Source area, drop it onto the node of interest in the
Linker Target area, and select Create as sub-element of target node, Create as attribute of
target node, or Add linker to target node according to your need in the dialog box that appears,
and click OK.

If you choose an option that is not permitted for the target node, you will see a warning message
and your operation will fail.

Remove a source-target mapping In the Linker Target area, right-click the node of interest and select Disconnect Linker from the
contextual menu.

Create a JSON tree from another
JSON file

Right-click any schema item in the Linker Target area and select Import JSON Tree from
the contextual menu to load another JSON file. Then, you need to create source-target mappings
manually and define the output schema all again.

You can select and drop several fields at a time, using the Ctrl + Shift technique to make multiple selections, therefore
making mapping faster. You can also make multiple selections for right-click operations.

1. In the Linker Target area, right-click the element you want to set as the loop element and select Set As
Loop Element from the contextual menu.
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In this example, define a loop to run on the details element.

2. Customize the mappings if needed.

3. Click Next to finalize the schema.

Finalizing the end schema

The last step of the wizard shows the end schema generated and allows you to customize the schema according
to your needs.
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1. If needed, rename the schema (by default, metadata) and leave a comment.

Customize the schema if needed: add, remove or move schema columns, export the schema to an XML file,
or replace the schema by importing an schema definition XML file using the tool bar.

2. If the JSON file which the schema is based on has been changed, click the Guess button to generate the
schema again. Note that if you have customized the schema, the Guess feature does not retain these changes.

3. Click Finish. The new file connection, along with its schema, is displayed under the relevant File Json
metadata node in the Repository tree view.

Now you can drag and drop the file connection or the schema of it from the Repository tree view onto the design
workspace as a new tWriteJSONField component or onto an existing component to reuse the metadata. For
further information about how to use the centralized metadata in a Job, see How to use centralized metadata in
a Joband How to set a repository schema.

To modify an existing file connection, right-click it from the Repository tree view, and select Edit JSON to open
the file metadata setup wizard.

To add a new schema to an existing file connection, right-click the connection from the Repository tree view and
select Retrieve Schema from the contextual menu.

To edit an existing file schema, right-click the schema from the Repository tree view and select Edit Schema
from the contextual menu.



Centralizing LDAP connection metadata

Talend Open Studio for MDM User Guide 305

7.12. Centralizing LDAP connection metadata
If you often need to access an LDAP directory, you want to centralize your LDAP server connection in the
Repository tree view for easy reuse.

You can create an LDAP connection either from an accessible LDAP directory, or by saving the LDAP settings
defined in a Job.

To create an LDAP connection from an accessible LDAP directory, expand the Metadata node in the Repository
tree view, right-click the LDAP tree node, and select Create LDAP schema from the contextual menu to open
the [Create new LDAP schema] wizard.

To centralize an LDAP connection and its schema you have already defined in a Job, click the  icon in the
Basic settings view of the relevant component, with its Property Type set to Built-In, to open the [Create new
LDAP schema] wizard.

Unlike the DB connection wizard, the LDAP wizard gathers both LDAP server connection and schema definition
in a five-step procedure.

Defining the general properties

1. Fill in the general information in the relevant fields to identify the LDAP connection to be created, including
Name, Purpose and Description.

The Name field is required, and the information you provide in the Description field will appear as a tooltip
when you move your mouse pointer over the LDAP connection.

2. If needed, set the version and status in the Version and Status fields respectively. You can also manage
the version and status of a Repository item in the [Project Settings] dialog box. For more information, see
Version management and Status management respectively.

3. If needed, click the Select button next to the Path field to select a folder under the LDAP node to hold your
newly created LDAP connection.

4. Click Next to define your LDAP server connection details.

Defining the server connection

1. Fill the connection details.

Field Description

Host LDAP Server host name or IP address

Port Listening port to the LDAP directory

Encryption method LDAP : no encryption is used
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Field Description

LDAPS: secured LDAP

TLS: certificate is used

2. Then check your connection using Check Network Parameter to verify the connection and activate the
Next button.

3. Click Next to continue.

Configuring LDAP access parameters

1. In this view, set the authentication and data access mode.

Field Description

Authentication method Simple authentication: requires Authentication Parameters field to be filled in

Anonymous authentication: does not require authentication parameters

Authentication Parameters Bind DN or User: login as expected by the LDAP authentication method

Bind password: expected password

Save password: remembers the login details.

Get Base DN from Root DSE / Base DN Path to user's authorized tree leaf
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Field Description

Fetch Base DNs button retrieves the DN automatically from Root.

Alias Dereferencing Never allows to improve search performance if you are sure that no aliases is to
be dereferenced. By default, Always is to be used. Always: Always dereference
aliases

Never: Never dereferences aliases.

Searching:Dereferences aliases only after name resolution.

Finding: Dereferences aliases only during name resolution

Referral Handling Redirection of user request:

Ignore: does not handle request redirections

Follow:does handle request redirections

Limit Limited number of records to be read

2. Click Check authentication to verify your access rights.

3. Click Fetch Base DNs to retrieve the DN and click the Next button to continue.

4. If any third-party libraries required for setting up an LDAP connection are found missing, an external module
installation wizard appears. Install the required libraries as guided by the wizard. For more information on
installing third-party modules, see the Talend Installation and Upgrade Guide.

Defining the schema

1. Select the attributes to be included in the schema structure.

Add a filter if you want selected data only.
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2. Click Refresh Preview to display the selected column and a sample of the data.

3. Then click Next to continue.

Finalizing the end schema

The last step shows the LDAP schema generated and allows you to further customize the end schema.
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1. If needed, rename the metadata in the Name field (metadata, by default), add a Comment, and make further
modifications, for example:

• Redefine the columns by editing the relevant fields.

• Add or delete a column using the  and  buttons.

• Change the order of the columns using the  and  buttons.

2. If the LDAP directory which the schema is based on has changed, use the Guess button to generate again the
schema. Note that if you customized the schema, your changes will not be retained after the Guess operation.

3. Click Finish. The new schema is displayed under the relevant LDAP connection node in the Repository
tree view.

Now you can drag and drop the file connection or any schema of it from the Repository tree view onto the design
workspace as a new component or onto an existing component to reuse the metadata.

To modify an existing file connection, right-click it from the Repository tree view, and select Edit LDAP schema
to open the file metadata setup wizard.

To add a new schema to an existing file connection, right-click the connection from the Repository tree view and
select Retrieve Schema from the contextual menu.
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To edit an existing file schema, right-click the schema from the Repository tree view and select Edit Schema
from the contextual menu.

7.13. Centralizing Salesforce metadata
If you often need to connect to a Salesforce system, you may want to centralize your Salesforce connection in the
Repository by completing the following major tasks:

• Set up a Salesforce connection,

• Retrieve Salesforce modules.

Prerequisites:

Talend Studio requires specific third-party Java libraries or database drivers (.jar files) to be installed in order
to connect to sources or targets. Due to license restrictions, Talend may not be able to ship certain required
libraries or drivers; in that situation, the connection wizard to be presented in the following sections displays
related information to help you identify and install the libraries or drivers in question. For more information, see
Talend Installation and Upgrade Guide.

7.13.1. Setting up a Salesforce connection

Defining general properties

1. In the Repository tree view, right-click the Salesforce tree node, and select Create Salesforce Connection
from the pop-up menu.

2. Fill in the schema general information, such as Name and Description. Then click Next to open a new view
on the wizard to define the connection details.

For further information, see the section on defining general properties in Setting up a database connection.

Connecting to a Salesforce system - Basic login mode

Two login modes are available for accessing the Salesforce website: Basic and OAuth. This procedure describes
how to connect to a Salesforce system in Basic login mode. For how to connect to a Salesforce system in OAuth
login mode, see Connecting to a Salesforce system - OAuth login mode.

1. Select Basic from the Login Type list.

2. Enter the Salesforce system address in the Web service URL field.

3. Enter your user name in the User name field and your password followed by your security token in the
Password field to connect to your Salesforce account through the salesforce web service.



Setting up a Salesforce connection

Talend Open Studio for MDM User Guide 311

4. If you are working behind a Socks or HTTP proxy, select the Enable Socks proxy or Enable Http proxy
check box and provide your proxy parameters.

5. Click Check login to verify that you can connect without issue.

6. Click Finish to validate the connection settings and close the wizard.

Connecting to a Salesforce system - OAuth login mode

This procedure describes how to connect to a Salesforce system in OAuth login mode. For how to connect to a
Salesforce system in Basic login mode, see Connecting to a Salesforce system - Basic login mode.
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1. Select OAuth2 from the Login Type list.

2. Enter your OAuth authentication details in the  Consumer key and Consumer Secret fields.

3. Enter your callback host details in the Callback Host  and Callback Port fields.

4. If you are working behind a Socks or HTTP proxy, select the Enable Socks proxy or Enable Http proxy
check box and provide your proxy parameters.

5. Click Check login to verify that you can connect without issue.

The Salesforce login page appears.
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6. Enter your Salesforce user name/Password and click Log in to Salesforce for authorization.

7. When the authorization success message is shown on the page, click the OK button on the lower right corner
for confirmation.

8. When the connection check success message appears, Click the OK button for confirmation.

9. Click Finish to validate the connection settings and close the wizard.

For a use case that illustrates the OAuth2 login mode, refer to the tSalesforceConnection section in Talend Open
Studio Components Reference Guide.
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7.13.2. Retrieving Salesforce modules and schemas

The next step retrieves Salesforce modules and their schema based on the connection you set up in the previous
procedure.

1. In the Repository tree view, expand the Connection node, right-click the connection you set up in Step 2,
and select Retrieve Salesforce Modules from the pop-up menu.

2. In the Select Schema to create area, you can narrow down the selection by filtering schemas displayed. Type
in the first letters of the modules you want to retrieve in Name Filter field.

3. Select the check boxes for the modules of interest and click Finish to retrieve the modules and their schemas.
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The newly created Salesforce connection is displayed under the Salesforce node in the Repository tree view,
along with its modules retrieved and their schemas.

You can now drop any Salesforce module from the Repository onto the design workspace. A dialog box
opens in which you can choose to use the centralized module as a tSalesforceInput, a tSalesforceOutput, or
a tSalesforceConnection component in your Job. You can also drop the module onto an existing component to
reuse the metadata.

For more information about dropping component metadata in the design workspace, see How to use centralized
metadata in a Job.

To modify an existing Salesforce connection, right-click it from the Repository tree view, and select Edit
Salesforce Connection to open the file metadata setup wizard.
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To add new modules to an existing Salesforce connection, right-click the connection from the Repository tree
view and select Retrieve Salesforce Modules from the contextual menu.

To edit an existing Salesforce schema of a module, right-click the schema from the Repository tree view and
select Edit Schema from the contextual menu.

7.14. Setting up a generic schema
Talend Studio allows you to create a generic schema to use in your Jobs if none of the specific metadata wizards
matches your need or if you do not have any source file to take the schema from.

You can create a generic schema:

• from scratch. For details, see Setting up a generic schema from scratch,

• from a schema definition XML file. For details, see Setting up a generic schema from an XML file, and

• from the schema defined in a component. For details, see Saving a component schema as a generic schema.

To use a generic schema on a component, use either of the following methods:

• Select Repository from the Schema drop-down list in the component Basic settings view.

Click the [...] button to open the [Repository Content] dialog box, select the generic schema under the Generic
schemas node and click OK.

• Select the metadata node of the generic schema from the Repository tree view and drop it onto the component.

7.14.1. Setting up a generic schema from scratch

To create a generic schema from scratch, proceed as follows:

1. Right-click Generic schemas under the Metadata node in the Repository tree view, and select Create
generic schema.

2. In the schema creation wizard that appears, fill in the generic schema properties such as schema Name and
Description. The Status field is a customized field. For more information about how to define the field, see
Status settings.

Click Next to continue.
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3. Give a name to the schema or use the default one (metadata) and add a comment if needed. Customize the
schema structure in the Schema panel according to your needs.

The tool bar allows you to add, remove or move columns in your schema. You can also export the current
schema as an XML file, or import a schema from an XML file, which must be an export of schema from the
Studio, to replace the current schema.
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4. Click Finish to complete the generic schema creation. The created schema is displayed under the relevant
Generic schemas node.

7.14.2. Setting up a generic schema from an XML file
The source XML file from which you can create a generic schema must be an export of schema from the Studio or an XML
with the same XML tree structure, not any other kind of XML.

To create a generic schema from a source XML file, proceed as follows:

1. Right-click Generic schemas in the Repository tree view, and select Create generic schema from xml.
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2. In the dialog box that appears, choose the source XML file from which the schema is taken and click Open.

3. In the schema creation wizard that appears, define the schema Name or use the default one (metadata) and
give a Comment if any.

The schema structure from the source file is displayed in the Schema panel. You can customize the columns
in the schema as needed.

The tool bar allows you to add, remove or move columns in your schema. You can also export the current
schema as an XML file, or import a schema from an XML file, which must be an export of schema from the
Studio, to replace the current schema.

4. Click Finish to complete the generic schema creation. The created schema is displayed under the relevant
Generic schemas node.
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7.14.3. Saving a component schema as a generic
schema

You can create a generic schema by saving the schema defined in a component. To do so, follow the steps below:

1. Open the Basic settings view of the component that has the schema you want to create a generic schema
from, and click the [...] button next to Edit schema to open the [Schema] dialog box.

2. Click the floppy disc icon to open the [Select folder] dialog box.

3. Select a folder if needed, and click OK to close the dialog box and open the [Save as generic schema]
creation wizard.
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4. Fill in the Name field (required) and the other fields if needed, and click Finish to save the schema. Then
close the [Schema] dialog box opened from the component Basic settings view.

The schema is saved in the selected folder under the Generic schemas node in the Repository tree view.

7.15. Centralizing MDM metadata
Talend Studio enables you to centralized the details of one or more MDM connections under the Metadata folder
in the Repository tree view. You can then use any of these established connections to connect to the MDM server.

For more information on working with Talend MDM, consult the MDM Part of this guide, which starts with  Master
Data Management: Concepts and Principles.

You can also set up an MDM connection the same way by clicking the  icon in the Basic settings view of the
tMDMInput and tMDMOutput components. For more information, see the Talend MDM component chapter in Talend
Open Studio Components Reference Guide.

According to the option you select, the wizard helps you create an input XML, an output XML or a receive XML
schema. Later, in a Talend Job, the tMDMInput component uses the defined input schema to read master data
stored in XML documents, tMDMOutput uses the defined output schema to either write master data in an XML
document on the MDM server, or to update existing XML documents and finally the tMDMReceive component
uses the defined XML schema to receive an MDM record in XML from MDM triggers and processes.
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7.15.1. Setting up the connection

To establish an MDM connection, complete the following:

1. In the Repository tree view, expand Metadata and right-click Talend MDM.

2. Select Create MDM on the contextual menu.

The connection wizard displays.

3. Fill in the connection properties such as Name, Purpose and Description. The Status field is a customized
field that can be defined. For more information, see Status settings.

4. Click Next to proceed to the next step.
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5. Fill in the connection details including the authentication information to the MDM server and then click
Check to check the connection you have created.

A dialog box displays to confirm if your connection is successful.

6. Click OK to close the confirm dialog box and then Next to proceed to the next step.

7. From the Version list, select the master data version on the MDM server to which you want to connect.

8. From the Data-Model list, select the data model against which the master data is validated.

9. From the Data-Container list, select the data container that holds the master data you want to access.

10. Click Finish to validate your changes and close the dialog box.



Defining MDM schema

324 Talend Open Studio for MDM User Guide

The newly created connection is listed under Talend MDM under the Metadata folder in the Repository
tree view.

You need now to retrieve the XML schema of the business entities linked to this MDM connection.

7.15.2. Defining MDM schema

7.15.2.1. Defining Input MDM schema

This section describes how to define and download an input MDM XML schema. To define and download an
output MDM XML schema, see Defining output MDM schema.

To set the values to be fetched from one or more entities linked to a specific MDM connection, complete the
following:

1. In the Repository tree view, expand Metadata and right-click the MDM connection for which you want to
retrieve the entity values.

2. Select Retrieve Entity from the contextual menu.

A dialog box displays.
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3. Select the Input MDM option in order to download an input XML schema and then click Next to proceed
to the following step.

4. From the Entities field, select the business entity (XML schema) from which you want to retrieve values.

The name displays automatically in the Name field.

You are free to enter any text in this field, although you would likely put the name of the entity from which you are
retrieving the schema.

5. Click Next to proceed to the next step.
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The schema of the entity you selected automatically display in the Source Schema panel.

Here, you can set the parameters to be taken into account for the XML schema definition.

The schema dialog box is divided into four different panels as the following:

Panel Description

Source Schema Tree view of the uploaded entity.

Target schema Extraction and iteration information.

Preview Target schema preview.

File viewer Raw data viewer.

6. In the Xpath loop expression area, enter the absolute XPath expression leading to the XML structure node
on which to apply the iteration. Or, drop the node from the source schema to the target schema Xpath field.
This link is orange in color.

The Xpath loop expression field is compulsory.

7. If required, define a Loop limit to restrict the iteration to a number of nodes.
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In the capture above, we use Features as the element to loop on because it is repeated within the Product
entity as follows:

<Product>
    <Id>1</Id>
    <Name>Cup</Name>
    <Description/>
    <Features>
         <Feature>Color red</Feature>
         <Feature>Size maxi</Feature
    <Features>
    ...
</Product>
<Product>
    <Id>2</Id>
    <Name>Cup</Name>
    <Description/>
    <Features>
         <Feature>Color blue</Feature>
         <Feature>Thermos</Feature>
    <Features>
    ...
</Product>

By doing so, the tMDMInput component that uses this MDM connection will create a new row for every
item with different feature.

8. To define the fields to extract, drop the relevant node from the source schema to the Relative or absolute
XPath expression field.
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Use the [+] button to add rows to the table and select as many fields to extract as necessary. Press the Ctrl or the Shift
keys for multiple selection of grouped or separate nodes and drop them to the table.

9. If required, enter a name to each of the retrieved columns in the Column name field.

You can prioritize the order of the fields to extract by selecting the field and using the up and down arrows. The link
of the selected field is blue, and all other links are grey.

10. Click Finish to validate your modifications and close the dialog box.

The newly created schema is listed under the corresponding MDM connection in the Repository tree view.

To modify the created schema, complete the following:

1. In the Repository tree view, expand Metadata and Talend MDM and then browse to the schema you want
to modify.

2. Right-click the schema name and select Edit Entity from the contextual menu.

A dialog box displays.



Defining MDM schema

Talend Open Studio for MDM User Guide 329

3. Modify the schema as needed.

You can change the name of the schema according to your needs, you can also customize the schema structure
in the schema panel. The tool bar allows you to add, remove or move columns in your schema.

4. Click Finish to close the dialog box.

The MDM input connection (tMDMInput) is now ready to be dropped in any of your Jobs.

7.15.2.2. Defining output MDM schema

This section describes how to define and download an output MDM XML schema. To define and download an
input MDM XML schema, see Setting up the connection.

To set the values to be written in one or more entities linked to a specific MDM connection, complete the following:

1. In the Repository tree view, expand Metadata and right-click the MDM connection for which you want to
write the entity values.

2. Select Retrieve Entity from the contextual menu.

A dialog box displays.
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3. Select the Output MDM option in order to define an output XML schema and then click Next to proceed
to the following step.

4. From the Entities field, select the business entity (XML schema) in which you want to write values.

The name displays automatically in the Name field.

You are free to enter any text in this field, although you would likely put the name of the entity from which you are
retrieving the schema.

5. Click Next to proceed to the next step.
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Identical schema of the entity you selected is automatically created in the Linker Target panel, and columns are
automatically mapped from the source to the target panels. The wizard automatically defines the item Id as the looping
element. You can always select to loop on another element.

Here, you can set the parameters to be taken into account for the XML schema definition.

6. Click Schema Management to display a dialog box.

7. Do necessary modifications to define the XML schema you want to write in the selected entity.

Your Linker Source schema must corresponds to the Linker Target schema, that is to say define the
elements in which you want to write values.
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8. Click OK to close the dialog box.

The defined schema displays under Schema list.

9. In the Linker Target panel, right-click the element you want to define as a loop element and select Set as
loop element. This will restrict the iteration to one or more nodes.

By doing so, the tMDMOutput component that uses this MDM connection will create a new row for every
item with different feature.

You can prioritize the order of the fields to write by selecting the field and using the up and down arrows.

10. Click Finish to validate your modifications and close the dialog box.

The newly created schema is listed under the corresponding MDM connection in the Repository tree view.

To modify the created schema, complete the following:
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1. In the Repository tree view, expand Metadata and Talend MDM and then browse to the schema you want
to modify.

2. Right-click the schema name and select Edit Entity from the contextual menu.

A dialog box displays.

3. Modify the schema as needed.

You can change the name of the schema according to your needs, you can also customize the schema structure
in the schema panel. The tool bar allows you to add, remove or move columns in your schema.

4. Click Finish to close the dialog box.

The MDM output connection (tMDMOutput) is now ready to be dropped in any of your Jobs.

7.15.2.3. Defining Receive MDM schema

This section describes how to define a receive MDM XML schema based on the MDM connection.

To set the XML schema you want to receive in accordance with a specific MDM connection, complete the
following:

1. In the Repository tree view, expand Metadata and right-click the MDM connection for which you want to
retrieve the entity values.

2. Select Retrieve Entity from the contextual menu.

A dialog box displays.
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3. Select the Receive MDM option in order to define a receive XML schema and then click Next to proceed
to the following step.

4. From the Entities field, select the business entity (XML schema) according to which you want to receive
the XML schema.

The name displays automatically in the Name field.

You can enter any text in this field, although you would likely put the name of the entity according to which you want
to receive the XML schema.

5. Click Next to proceed to the next step.
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The schema of the entity you selected display in the Source Schema panel.

Here, you can set the parameters to be taken into account for the XML schema definition.

The schema dialog box is divided into four different panels as the following:

Panel Description

Source Schema Tree view of the uploaded entity.

Target schema Extraction and iteration information.

Preview Target schema preview.

File viewer Raw data viewer.

6. In the Xpath loop expression area, enter the absolute XPath expression leading to the XML structure node
on which to apply the iteration. Or, drop the node from the source schema to the target schema Xpath field.
This link is orange in color.

The Xpath loop expression field is compulsory.

7. If required, define a Loop limit to restrict the iteration to one or more nodes.
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In the above capture, we use Features as the element to loop on because it is repeated within the Product
entity as the following:

<Product>
    <Id>1</Id>
    <Name>Cup</Name>
    <Description/>
    <Features>
         <Feature>Color red</Feature>
         <Feature>Size maxi</Feature
    <Features>
    ...
</Product>
<Product>
    <Id>2</Id>
    <Name>Cup</Name>
    <Description/>
    <Features>
         <Feature>Color blue</Feature>
         <Feature>Thermos</Feature>
    <Features>
    ...
</Product>

By doing so, the tMDMReceive component that uses this MDM connection will create a new row for every
item with different feature.

8. To define the fields to receive, drop the relevant node from the source schema to the Relative or absolute
XPath expression field.
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Use the plus sign to add rows to the table and select as many fields to extract as necessary. Press the Ctrl or the Shift
keys for multiple selection of grouped or separate nodes and drop them to the table.

9. If required, enter a name to each of the received columns in the Column name field.

You can prioritize the order of the fields you want to receive by selecting the field and using the up and down arrows.
The link of the selected field is blue, and all other links are grey.

10. Click Finish to validate your modifications and close the dialog box.

The newly created schema is listed under the corresponding MDM connection in the Repository tree view.

To modify the created schema, complete the following:

1. In the Repository tree view, expand Metadata and Talend MDM and then browse to the schema you want
to modify.

2. Right-click the schema name and select Edit Entity from the contextual menu.

A dialog box displays.
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3. Modify the schema as needed.

You can change the name of the schema according to your needs, you can also customize the schema structure
in the schema panel. The tool bar allows you to add, remove or move columns in your schema.

4. Click Finish to close the dialog box.

The MDM receive connection (tMDMReceive) is now ready to be dropped in any of your Jobs.

7.16. Centralizing Web Service metadata
If you often need to visit a Web Service from your Talend Studio you can save your Web Service connections
in the Repository.

The [Web Service] schema wizard enables you to create either a simple schema (Simple WSDL) or an advanced
schema (Advanced WebService), according to your needs.

In step 1, you must enter the schema metadata before choosing whether to create a simple or an advanced schema in step 2.
It is therefore important to enter metadata information which will help you to differentiate between your different schema
types in the future.

To create a simple schema, see Setting up a simple schema.

To create an advanced schema, see Setting up an advanced schema.

7.16.1. Setting up a simple schema

This section describes how to define a simple Web Service schema (Simple WSDL). For information about how
to define an Advanced Web Service schema, see Setting up an advanced schema.
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Defining general properties

1. In the Repository, expand the Metadata node.

2. Right-click Web Service and select Create WSDL schema from the context menu list.

3. Enter the generic schema information such as its Name and Description.

4. Click Next to select the schema type in step 2.

Selecting the type of schema (Simple)

In this step, you need to indicate whether you want to create a simple or an advanced schema. In this example,
a simple schema is created.

1. In the dialog box, select the Simple WSDL option.
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2. Click Next to continue.

Specifying the URI and method

This step involves the definition of the URI and other parameters required to obtain the desired values.
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In the Web Service Parameter zone:

1. Enter the URI which will transmit the desired values, in the WSDL field, http://www.webservicex.net/
country.asmx?wsdl in this example.

2. If necessary, select the Need authentication? check box and then enter your authentication information in
the User and Password fields.

3. If you use an http proxy, select the Use http proxy check box and enter the information required in the host,
Port, user and password fields.

4. Enter the Method name in the corresponding field, GetCountryByCountryCode in this example.

5. In the Value table, Add or Remove values as desired, using the corresponding buttons.

6. Click Refresh Preview to check that the parameters have been entered correctly.
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In the Preview tab, the values to be transmitted by the Web Service method are displayed, based the
parameters entered.

Finalizing the end schema

You can modify the schema name (metadata, by default) and modify the schema itself using the tool bar.

1.
Add or delete columns using the  and  buttons.
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2.
Modify the order of the columns using the  and  buttons.

3. Click Finish.

The new schema is added to the Repository under the Web Service node. You can now drop it onto the
design workspace as a tWebServiceInput component in your Job.

7.16.2. Setting up an advanced schema

This section describes how to define an Advanced WebService schema. For information about how to define a
Simple WSDL schema, see Setting up a simple schema.

Defining general properties

1. In the Repository view, expand the metadata node.

2. Right-click Web Service and select Create WSDL schema from the context menu list.

3. Enter the generic schema information, such as its Name and Description.
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4. Click Next to select the schema type in step 2.

Selecting the type of schema (Advanced)

In this step, you must indicate whether you want to create a Simple or an Advanced schema. In this example,
an Advanced schema is created.

1. In the dialog box, select the Advanced WebService option.
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2. Click Next to defineprecise Web Service parameters.

Defining the port name and operation

1. Type in the URI of the Web Service WSDL file manually by typing in the WSDL field, or click the Browse...
button to browse your directory if your WSDL is stored locally.

2. Click the Refresh button to retrieve the list of port names and operations available.
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3. Select the port name to be used, in the Port Name zone, countrySoap12 in this example.

4. Select the operation to be carried out in the Operation zone.

In this example, select GetCountryByCountryCode(parameters):string to retrieve the country name for a
given country code.

Next, you need to define the input and output schemas and schema-parameter mappings in the Input mapping
and Output mapping tabs.

Defining the input schemas and mappings

To define the input schema and mappings, do the following:

1. Click the Input mapping tab to define the input schema and set the parameters required to execute the
operation.

2. In the table to the right, select the parameters row and click the [+] button to open the [ParameterTree]
dialog box.
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3. Selectthe parameter you want to use and click OK to close the dialog box.

A new row appears showing the parameter you added, CountryCode in this example.

4. In the table to the left, click the Schema Management button to open the [Schema] dialog box.

5. Define the input schema.

In this example, the schema has only one column: CountryCode.

6. Click OK to validate this addition and close the dialog box.

7. Create mappings between schema columns and parameters.

In this example, drop the CountryCode column from the left table onto the parameters.CountryCode row
to the right.
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A red line shows that the column is mapped.

If available, use the Auto Map button situated to the top of the tab, to carry out the mapping automatically.

Defining the output schemas and mappings

To define the output schema and mappings, proceed as follows:

1. Click the Output mapping tab to define the output schema and set its parameters.

2. In the table to the left, select the parameter row and click the [+] button to add a parameter.

The [ParameterTree] dialog box opens.
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3. Select the parameter and click OK to close the dialog box.

A new row appears showing the parameter you added, GetCountryByCountryCodeResult in this example.

4. In the table to the right, click [...] to open the [Schema] dialog box.

5. Define the output schema.

In this example, the schema has only one column: Result.

6. Click OK to validate your addition and close the dialog box.

7. Create output parameter-schema mappings.

In this example, drop the parameters.GetCountryByCountyCodeResult row from the table to the left onto the
Result column to the right.
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8. Click Next to finalize the schema.

Depending on the type of the output, you can choose to normalize or denormalize the results by clicking the Normalize
and Denormalize buttons.

Finalizing the end schema

In this step the wizard displays the output schema generated.
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You can customize the metadata by changing or adding information in the Name and Comment fields and make
further modifications using the toolbar, for example:

1.
Add or delete columns using the  and  buttons.

2.
Change the column order by clicking the  and  arrows.

3. Click Finish to finalize your advanced schema.

The new schema is added to the Repository under the corresponding Web Service node. You can now drop
it onto the design workspace as a tWebService component in your Job.

7.17. Centralizing an FTP connection
If you need to connect to an FTP server regularly, you can centralize the connection information under the
Metadata node in the Repository view.

Defining the general properties

To create a connection to an FTP server, follow the steps below:
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1. Expand the Metadata node in the Repository tree view.

2. Right-click FTP and select Create FTP from the context menu.

The connection wizard opens:

3. Enter the generic schema information such as its Name and Description.

The status field is a customized field which can be defined in the [Preferences] dialog box (Window > Preferences).
For further information about setting preferences, see Setting Talend Studio preferences.

4. When you have finished, click Next to enter the FTP server connection information.

Connecting to an FTP server

In this step we shall define the connection information and parameters.

1. Enter your Username and Password in the corresponding fields.
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2. In the Host field, enter the name of your FTP server host.

3. Enter the Port number in the corresponding field.

4. Select the Encoding type from the list.

5. From the Connection Model list, select the connection model you want to use:

• Select Passive if you want the FTP server to choose the port connection to be used for data transfer.

• Select Active if you want to choose the port yourself.

6. In the Parameter area, select a setting for FTP server usage. For standard usage, there is no need to select
an option.

• Select the SFTP Support check box to use the SSH security protocol to protect server communications.

An Authentication method appears. Select Public key or Password according to what you use.

• Select the FTPs Support check box to protect server communication with the SSL security protocol.

• Select the Use Socks Proxy check box if you want to use this option, then enter the proxy information (the
host name, port number, username and password).

7. Click Finish to close the wizard.

All of the connections created appear under the FTP server connection node, in the Repository view.

You can drop the connection metadata from the Repository onto the design workspace. A dialog box opens in
which you can choose the component to be used in your Job.

For further information about how to drop metadata onto the workspace, see How to use centralized metadata
in a Job.
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7.18. Exporting metadata as context and
reusing context parameters to set up a
connection
For every metadata connection (either File or Database, etc.), you can export the connection details as to a new
context group in the Repository for reuse in other connections or across different Jobs, or reuse variables of an
existing context group to set up your metadata connection.

7.18.1. How to export connection details as context
variables

To export connection details as context variables in a new context group in the Repository, follow the steps below:

1. On the last step or second last step of creating or editing a metadata connection in the wizard, click Export
as context.
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2. In the [Create / Reuse a context group] wizard that opens, select Create a new repository context and
click Next.
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3. Type in a name for the context group to be created, and add any general information such as a description
if required.

The name of the Metadata entry is proposed by the wizard as the context group name, and the information
you provide in the Description field will appear as a tooltip when you move your mouse over the context
group in the Repository.
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4. Click Next to create and view the context group, or click Finish to complete context creation and return to
the connection wizard directly.

In this example, click Next.

5. Check the context group generation result.

To edit the context variables, go to the Contexts node of the Repository, right-click the newly created context
group, and select Edit context group to open the [Create / Edit a context group] wizard after the connection
wizard is closed.

To edit the default context, or add new contexts, click the [+] button at the upper right corner of the wizard.

To add a new context variable, click the [+] button at the bottom of the wizard.

For more information on handling contexts and variables, see Using contexts and variables.
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6. Click Finish to complete context creation and return to the connection wizard.
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The relevant connection details fields in the wizard are set with the context variables.

To unset the connection details, click the Revert Context button.

7.18.2. How to use variables of an existing context
group to set up a connection

To use variables of an existing context group centrally stored in the Repository to set up a connection, follow
the steps below:

1. On the last step or second last step of creating or editing a metadata connection in the wizard, click Export
as context.
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2. In the [Create / Reuse a context group] wizard that opens, select Reuse an existing repository context
and click Next.
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3. Select a context group from the list and click Next.
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4. For each variable, select the corresponding field of the connection details, and then click Next to view and
edit the context variables, or click Finish to show the connection setup result directly.

In this example, click Next.

5. Edit the contexts and/or context variables if needed. If you make any changes, your centralized context group
will be updated automatically.

For more information on handling contexts and variables, see Using contexts and variables.

6. Click Finish to validate context reuse and return to the connection wizard.
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The relevant connection details fields in the wizard are set with the context variables.

To unset the connection details, click the Revert Context button.
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7.19. How to use centralized metadata in a
Job
For recurrent use of files and database connections in various Jobs, we recommend you to store the connection and
schema metadata in the Repository tree view under the Metadata node. Different folders under the Metadata
node will group the established connections including those to databases, files and systems.

Different wizards will help you centralize connection and schema metadata in the Repository tree view. For more
information about the [Metadata Manager] wizards, see Managing Metadata.

Once the relevant metadata is stored under the Metadata node, you will be able to drop the corresponding
components directly onto the design workspace.

1. In the Repository tree view of the Integration perspective, expand Metadata and the folder holding the
connection you want to use in your Job.

2. Drop the relevant connection or schema onto the design workspace.

A dialog box prompts you to select the component you want to use among those offered.
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3. Select the component and then click OK. The selected component displays on the design workspace.

Alternatively, according to the type of component (Input or Output) you want to use, perform one of the following
operations:

• Output: Press Ctrl on your keyboard while you are dropping the component onto the design workspace to
directly include it in the active Job.

• Input: Press Alt on your keyboard while you drop the component onto the design workspace to directly include
it in the active Job.

If you double-click the component, the Component view shows the selected connection details as well as the
selected schema information.

If you select the connection without selecting a schema, then the properties will be filled with the first encountered schema.
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Chapter 8. Managing routines
This chapter defines the routines, along with user scenarios, and explains how to create your own routines or how
to customize the system routines. The chapter also gives an overview of the main routines and use cases of them.
To have an overview of the most commonly used routines and other use cases, see System routines.
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8.1. What are routines
Routines are fairly complex Java functions, generally used to factorize code. They therefore optimize data
processing and improve Job capacities.

You can also use the Repository tree view to store frequently used parts of code or extract parts of existing
company functions, by calling them via the routines. This factorization makes it easier to resolve any problems
which may arise and allows you to update the code used in multiple Jobs quickly and easily.

On top of this, certain system routines adopt the most common Java methods, using the Talend syntax. This allows
you to escalate Java errors in the studio directly, thereby facilitating the identification and resolution of problems
which may arise as your integration processes evolve with Talend.

There are two types of routines:

• System routines: a number of system routines are provided. They are classed according to the type of data which
they process: numerical, string, date...

• User routines: these are routines which you have created or adapted from existing routines.

You do not need any knowledge of the Java language to create and use Talend routines.

All of the routines are stored under Code > Routines in the Repository tree view.

For further information concerning the system routines, see Accessing the System Routines.

For further information about how to create user routines, see How to create user routines.

You can also set up routine dependencies on Jobs. To do so, simply right click a Job on the Repository tree view and select
Set up routine dependencies. In the dialog box which opens, all routines are set by default. You can use the tool bar to
remove routines if required.

8.2. Accessing the System Routines
To access the system routines, click Code > Routines > system. The routines or functions are classed according
to their usage.

The system folder and its content are read only.
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Each class or category in the system folder contains several routines or functions. Double-click the class that you
want to open.

All of the routines or functions within a class are composed of some descriptive text, followed by the corresponding
Java code. In the Routines view, you can use the scrollbar to browse the different routines. Or alternatively:

1. Press Ctrl+O in the routines view.

A dialog box displays a list of the different routines in the category.

2. Click the routine of interest.

The view jumps to the section comprising the routine's descriptive text and corresponding code.

The syntax of routine call statements is case sensitive.

8.3. Customizing the system routines
If the system routines are not adapted to your specific needs, you can customize them by copying and pasting the
content in a user routine, then modify the content accordingly.

To customize a system routine:

1. First of all, create a user routine by following the steps outlined in How to create user routines. The routine
opens in the workspace, where you shall find a basic example of a routine.

2. Then, under Code > Routines > system, select the class of routines which contains the routine(s) you want
to customize.

3. Double-click the class which contains the relevant routine to open it in the workspace.

4. Use the Outline panel on the bottom left of the studio to locate the routine from which you want to copy
all or part of the content.
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5. In the workspace, select all or part of the code and copy it using Ctrl+C.

6. Click the tab to access your user routine and paste the code by pressing Ctrl+V.

7. Modify the code as required and press Ctrl+S to save it.

We advise you to use the descriptive text (in blue) to detail the input and output parameters. This will make your
routines easier to maintain and reuse.

8.4. Managing user routines
Talend Studio allows you to create user routines, to modify them or to modify system routines, in order to fill
your specific needs.

8.4.1. How to create user routines

You can create your own routines according to your particular factorization needs. Like the system routines, the
user routines are stored in the Repository tree view under Code > Routines. You can add folders to help organize
your routines and call them easily in any of your Jobs.

To create a new user routine, complete the following:

1. In the Repository tree view, expand Code to display the Routines folder.
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2. Right-click Routines and select Create routine.

3. The [New routine] dialog box opens. Enter the information required to create the routine, ie., its name,
description...

4. Click Finish to proceed to the next step.

The newly created routine appears in the Repository tree view, directly below the Routines node. The routine
editor opens to reveal a model routine which contains a simple example, by default, comprising descriptive
text in blue, followed by the corresponding code.

We advise you to add a very detailed description of the routine. The description should generally include the input and
output parameters you would expect to use in the routine, as well as the results returned along with an example. This
information tends to be useful for collaborative work and the maintenance of the routines.

The following example of code is provided by default:

public static void helloExample(String message) {
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        if (message == null) {
            message = "World"; //$NON-NLS-1$
        }
        System.out.println("Hello " + message + " !");

5. Modify or replace the model with your own code and press Ctrl+S to save the routine. Otherwise, the routine
is saved automatically when you close it.

You can copy all or part of a system routine or class and use it in a user routine by using the Ctrl+C and Ctrl+V commands,
then adapt the code according to your needs. For further information about how to customize routines, see Customizing the
system routines.

8.4.2. How to edit user routines

You can modify the user routines whenever you like.

The system folder and all of the routines held within are read only.

To edit your user routines:

1. Right click the routine you want to edit and select Edit Routine.

2. The routine opens in the workspace, where you can modify it.

3. Once you have adapted the routine to suit your needs, press Ctrl+S to save it.

If you want to reuse a system routine for your own specific needs, see Customizing the system routines.

8.4.3. How to edit user routine libraries

You can edit the library of any of the user routines by importing external .jar files for the selected routine. These
external library files will be listed, like modules, in the Modules view in your current Studio. For more information
on the Modules view, see the Talend Installation and Upgrade Guide.

The .jar file of the imported library will be also listed in the library file of your current Studio.

To edit a user routine library, complete the following:

1. In the Repository tree view, expand Code > Routines.

2. Right-click the user routine you want to edit its library and then select Edit Routine Library.

The [Import External Library] dialog box displays.
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3. Click New to open a new dialog box where you can import the external library.

You can delete any of the already imported routine files if you select the file in the Library File list and click the
Remove button.

4. Enter the name of the library file in the Input a library's name field followed by the file format (.jar), or

5. Select the Browse a library file option and click browse to set the file path in the corresponding field.

6. If required, enter a description in the Description field and then click OK to confirm your changes.

The imported library file is listed in the Library File list in the [Import External Library] dialog box.

7. Click Finish to close the dialog box.

The library file is imported into the library folder of your current Studio and also listed in the Module view
of the same Studio.

For more information about the Modules view, see the Talend Installation and Upgrade Guide.
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8.5. Calling a routine from a Job
Pre-requisite: You must have at least one Job created, in order to run a routine. For further information regarding
how to create a Job, see Creating a Job.

You can call any of your user and system routines from your Job components in order to run them at the same
time as your Job.

To access all the routines saved in the Routines folder in the Repository tree view, press Ctrl+Space in any of
the fields in the Basic settings view of any of the Talend components used in your Job and select the one you
want to run.

Alternatively, you can call any of these routines by indicating the relevant class name and the name of the routine,
followed by the expected settings, in any of the Basic settings fields in the following way:

<ClassName>.<RoutineName>

8.6. Use case: Creating a file for the current
date
This scenario describes how to use a routine. The Job uses just one component, which calls a system routine.

1. In the Palette, click File > Management, then drop a tFileTouch component onto the workspace. This
component allows you to create an empty file.

2. Double-click the component to open its Basic settings view in the Component tab.

3. In the FileName field, enter the path to access your file, or click [...] and browse the directory to locate the file.
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4. Close the double inverted commas around your file extension as follows: "D:/Input/customer".txt.

5. Add the plus symbol (+) between the closing inverted commas and the file extension.

6. Press Ctrl+Space to open a list of all of the routines, and in the auto-completion list which appears, select
TalendDate.getDate to use the Talend routine which allows you to obtain the current date.

7. Modify the format of the date provided by default, if required.

8. Enter the plus symbol (+) next to the getDate variable to complete the routine call, and place double inverted
commas around the file extension.

If you are working on windows, the ":" between the hours and minutes and between the minutes and seconds must
be removed.

9. Press F6 to run the Job.

The tFileTouch component creates an empty file with the days date, retrieved upon execution of the GetDate
routine called.
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Chapter 9. Using SQL templates
SQL templates are groups of pre-defined query arguments that run in the ELT mode. This chapter explains the
ELT mode, defines the SQL templates and provides user scenarios to explain how to use the SQL templates or
how to create your own ones.
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9.1. What is ELT
Extract, Load and Transform (ELT) is a data manipulation process in database usage, especially in data
warehousing. Different from the traditional ETL (Extract, Transform, Load) mode, in ELT, data is extracted,
loaded into the database and then is transformed where it sits in the database, prior to use. This data is migrated in
bulk according to the data set and the transformation process occurs after the data has been loaded into the targeted
DBMS in its raw format. This way, less stress is placed on the network and larger throughput is gained.

However, the ELT mode is certainly not optimal for all situations, for example,

• As SQL is less powerful than Java, the scope of available data transformations is limited.

• ELT requires users that have high proficiency in SQL tuning and DBMS tuning.

• Using ELT with Talend Studio, you cannot pass or reject one single row of data as you can do in ETL. For more
information about row rejection, see Row connection.

Based on the advantages and disadvantages of ELT, the SQL templates are designed as the ELT facilitation
requires.

9.2. Introducing Talend SQL templates
SQL is a standardized query language used to access and manage information in databases. Its scope includes data
query and update, schema creation and modification, and data access control. Talend Studio provides a range of
SQL templates to simplify the most common tasks. It also comprises a SQL editor which allows you to customize
or design your own SQL templates to meet less common requirements.

These SQL templates are used with the components from the Talend ELT component family including
tSQLTemplate, tSQLTemplateFilterColumns, tSQLTemplateCommit, tSQLTemplateFilterRows,
tSQLTemplateRollback, tSQLTemplateAggregate and tSQLTemplateMerge. These components execute the
selected SQL statements. Using the UNION, EXCEPT and INTERSECT operators, you can modify data directly
on the DBMS without using the system memory.

Moreover, with the help of these SQL templates, you can optimize the efficiency of your database management
system by storing and retrieving your data according to the structural requirements.

Talend Studio provides the following types of SQL templates under the SQL templates node in the Repository
tree view:

• System SQL templates: They are classified according to the type of database for which they are tailored.

• User-defined SQL templates: these are templates which you have created or adapted from existing templates.

More detailed information about the SQL templates is presented in the below sections.

For further information concerning the components from the ELT component family, see Talend Open Studio
Components Reference Guide.

As most of the SQL templates are tailored for specific databases, if you change database in your system, it is inevitable to
switch to or develop new templates for the new database.

9.3. Managing Talend SQL templates
Talend Studio enables you via the SQL Templates folder in the Repository tree view to use system or user-
defined SQL templates in the Jobs you create in the Studio using the ELT components.

The below sections show you how to manage these two types of SQL templates.
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9.3.1. Types of system SQL templates

This section gives detail information related to the different types of the pre-defined SQL templates.

Even though the statements of each group of templates vary from database to database, according to the operations
they are intended to accomplish, they are also grouped on the basis of their types in each folder.

The below table provides these types and their related information.

Name Function Associated components Required component
parameters

Aggregate Realizes aggregation (sum,
average, count, etc.) over a
set of data.

tSQLTemplateAggregate Database name

Source table name

Target table name

Commit Sends a Commit instruction
to RDBMS

tSQLTemplate  tSQLTemplateAggregate
tSQLTemplateCommit
tSQLTemplateFilterColumns
tSQLTemplateFilterRows
tSQLTemplateMerge
tSQLTemplateRollback

Null

Rollback Sends a Rollback instruction
to RDBMS.

tSQLTemplate  tSQLTemplateAggregate
tSQLTemplateCommit
tSQLTemplateFilterColumns
tSQLTemplateFilterRows
tSQLTemplateMerge
tSQLTemplateRollback

Null

DropSourceTable Removes a source table. tSQLTemplate  tSQLTemplateAggregate
tSQLTemplateFilterColumns
tSQLTemplateFilterRows

Table name (when use
tSQLTemplate)

Source table name

DropTargetTable Removes a target table tSQLTemplateAggregate
tSQLTemplateFilterColumns
tSQLTemplateFilterRows

Target table name

FilterColumns Selects and extracts a set of
data from given columns in
RDBMS.

tSQLTemplateAggregate
tSQLTemplateFilterColumns
tSQLTemplateFilterRows

Target table name (and schema)

Source table name (and
schema)

FilterRow Selects and extracts a set
of data from given rows in
RDBMS.

tSQLTemplateAggregate
tSQLTemplateFilterColumns
tSQLTemplateFilterRows

Target table name (and schema)

Source table name (and
schema)

Conditions

MergeInsert Inserts records from the
source table to the target
table.

tSQLTemplateMerge
tSQLTemplateCommit

Target table name (and schema)

Source table name (and
schema)

Conditions

MergeUpdate Updates the target table with
records from the source table.

tSQLTemplateMerge
tSQLTemplateCommit

Target table name (and schema)

Source table name (and
schema)

Conditions

9.3.2. How to access a system SQL template

To access a system SQL template, expand the SQL Templates node in the Repository tree view.
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Each folder contains system sub-folders containing pre-defined SQL statements, as well as a UserDefined folder
in which you can store SQL statements that you have created or customized.

Each system folder contains several types of SQL templates, each designed to accomplish a dedicated task.

Apart from the Generic folder, the SQL templates are grouped into different folders according to the type of
database for which they are to be used. The templates in the Generic folder are standard, for use in any database.
You can use these as a basis from which you can develop more specific SQL templates than those defined in
Talend Studio.

The system folders and their content are read only.

From the Repository tree view, proceed as follows to open an SQL template:

1. In the Repository tree view, expand SQL Templates and browse to the template you want to open.

2. Double click the class that you want to open, for example, aggregate in the Generic folder.

The aggregate template view displays in the workspace.
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You can read the predefined aggregate statements in the template view. The parameters, such as
TABLE_NAME_TARGET, operation, are to be defined when you design related Jobs. Then the parameters can be
easily set in the associated components, as mentioned in the previous section.

Everytime you click or open an SQL template, its corresponding property view displays at the bottom of the studio.
Click the aggregate template, for example, to view its properties as presented below:

For further information regarding the different types of SQL templates, see Types of system SQL templates

For further information about how to use the SQL templates with the associated components, see in Talend Open
Studio Components Reference Guide.

9.3.3. How to create user-defined SQL templates

As the transformation you need to accomplish in ELT may exceed the scope of what the given SQL templates can
achieve, Talend Studio allows you to develop your own SQL templates according to some writing rules. These
SQL templates are stored in the User-defined folders grouped according to the database type in which they will
be used.
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For more information on the SQL template writing rules, see SQL template writing rules.

To create a user-defined SQL template:

1. In the Repository tree view, expand SQL Templates and then the category you want to create the SQL
template in.

2. Right-click UserDefined and select Create SQL Template to open the [SQL Templates] wizard.

3. Enter the information required to create the template and click Finish to close the wizard.

The name of the newly created template appears under UserDefined in the Repository tree view. Also, an
SQL template editor opens on the design workspace, where you can enter the code for the newly created
template.

For further information about how to create a user-defined SQL template and how to use it in a Job, see
tMysqlTableList in Talend Open Studio Components Reference Guide.
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9.3.4. A use case of system SQL templates

As there are many common, standardized SQL statements, Talend Studio allows you to benefit from various
system SQL templates.

This section presents you with a use case that takes you through the steps of using MySQL system templates in
a Job that:

• opens a connection to a Mysql database.

• collects data grouped by specific value(s) from a database table and writes aggregated data in a target database
table.

• deletes the source table where the aggregated data comes from.

• reads the target database table and lists the Job execution result.

To connect to the database and aggregate the database table columns:

Configuring a connection to a MySQL database

1. Drop the following components from the Palette onto the design workspace: tMysqlConnection,
tSQLTemplateAggregate, tSQLTemplateCommit, and tMysqlInput, tLogRow.

2. Right-click tMysqlconnection and from the contextual menu, select Trigger > OnComponentOk to connect
tMysqlConnection to tSQLTemplateAggregate.

3. Connect tSQLTemplateAggregate, tSQLTemplateCommit and tMysqlInput using OnComponentOk
links.

4. Connect tMysqlInput to tLogRow using an Main > Row link.

5. In the design workspace, select tMysqlConnection and click the Component tab to define the component
basic settings.

6. In the Basic settings view, set the database connection details manually.
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7. In the design workspace, select tSQLTemplateCommit and click the Component tab to define its basic
settings.

8. On the Database type list, select the relevant database type, and from the Component list, select the relevant
database connection component if more than one connection is used.

Grouping data, writing aggregated data and dropping the source table

1. In the design workspace, select tSQLTemplateAggregate and click the Component tab to define its basic
settings.

2. On the Database type list, select the relevant database type, and from the Component list, select the relevant
database connection component if more than one connection is used.

3. Enter the names for the database, source table, and target table in the corresponding fields and click the [...]
button next to Edit schema to define the data structure in the source and target tables.

The source table schema consists of three columns: First_Name, Last_Name and Country. The target table
schema consists of two columns: country and total. In this example, we want to group citizens by their
nationalities and count citizen number in each country. To do that, we define the Operations and Group
by parameters accordingly.
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4. In the Operations table, click the plus button to add one or more lines and then click in the Output column
line to select the output column that will hold the counted data.

5. Click in the Function line and select the operation to be carried on.

6. In the Group by table, click the plus button to add one or more lines and then click in the Output column
line to select the output column that will hold the aggregated data.

7. Click the SQL template tab to open the corresponding view.

8. Click the plus button twice under the SQL template list table to add two SQL templates.

9. Click on the first SQL template row and select the MySQLAggregate template from the drop-down list. This
template generates codes to aggregate data according to the configuration in the Basic settings view.

10. Do the same to select the MySQLDropSourceTable template for the second SQL template row. This template
generates codes to delete the source table where the data to be aggregated comes from.

To add new SQL templates to an ELT component for execution, you can simply drop the templates of your choice
either onto the component in the design workspace, or onto the component's SQL template list table.

The templates set up in the SQL template list table have priority over the parameters set in the Basic settings view
and are executed in a top-down order. So in this use case, if you select MySQLDropSourceTable from the list, the
source table will be deleted prior to aggregation, meaning that nothing will be aggregated.

Reading the target database and listing the Job execution result

1. In the design workspace, select tMysqlInput, and click the Component tab to define its basic settings.
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2. Select the Use an existing connection check box to use the database connection that you have defined on
the tMysqlConnection component.

3. To define the schema, select Repository and then click the three-dot button to choose the database table
whose schema is used. In this example, the target table holding the aggregated data is selected.

4. In the Table Name field, type in the name of the table you want to query. In this example, the table is the
one holding the aggregated data.

5. In the Query area, enter the query statement to select the columns to be displayed.

6. Save your Job and press F6 to execute it.

The source table is deleted.

A two-column table citizencount is created in the database. It groups citizens according to their nationalities
and gives their total count in each country.
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Chapter 10. Data Profiling: Concepts and
Principles
This chapter introduces data profiling as the process of examining the data available in different data sources such
as databases and files.
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10.1. Why profiling data
Data profiling is the process of examining the data available in different data sources and collecting statistics and
information about this data. Data profiling helps to assess the quality level of the data according to defined set
goals.

If data is of a poor quality, or managed in structures that cannot be integrated to meet the needs of the enterprise,
business processes and decision-making suffer.

Compared to manual analysis techniques, data profiling technology improves the enterprise ability to meet the
challenge of managing data quality and to address the data quality challenges faced during data migrations and
data integrations.

10.2.  About Talend Data Quality
The following sections introduce Talend Data Quality and list its key features.

10.2.1.  What is Talend Data Quality
This data profiling tool allows you to identify potential problems before beginning data-intensive projects such
as data integration.

The data profiler centralizes several elements including a:

• data profiler; for more information about the data profiler, see Main window of Talend Studio .

• data explorer; for more information about the data explorer, see Main window of the data explorer

• pattern manager; for more information about the pattern manager, see Patterns and indicators.

• metadata manager; for more information about the metadata manager, see Metadata repository.

10.2.2. Core features
This section describes basic features of Talend data profiling solution.

10.2.2.1. Metadata repository

Using Talend data quality, you can connect to data sources to analyze their structure (catalogs, schemas and
tables), and stores the description of their metadata in its metadata repository. You can then use this metadata to
set up metrics and indicators.

For more information, see Before you begin profiling data.

10.2.2.2. Patterns and indicators

Patterns are sets of strings against which you can define the content, structure and quality of high complex data. The
Profiling perspective of the studio lists two types of patterns: regular expressions, which are predefined regular
patterns, and SQL patterns which are the patterns you add using LIKE clauses.
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For more information about patterns, see Patterns.

Indicators are the results achieved through the implementation of different patterns. They can represent the results
of data matching and different other data-related operations. The Profiling perspective of the studio lists two types
of indicators: system indicators, a list of predefined indicators, and user-defined indicators, a list of those defined
by the user.

For more information about indicators, see Indicators.
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Chapter 11. Getting started with Talend Data
Quality
This chapter introduces Talend Data Quality and guides you through the basics for launching the studio .

This chapter explains the typical sequence of profiling data using the studio and many other important
miscellaneous subjects.
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11.1. Working principles of data quality
From the Profiling perspective of the studio, you can examine the data available in different data sources and
collect statistics and information about this data.

A typical sequence of profiling data using the studio involves the following steps:

1. Connecting to a data source including databases and delimited files or excel files in order to be able to access
the tables and columns on which you want to define and execute analyses. For more information, see Before
you begin profiling data.

2. Defining any of the available data quality analyses including database content analysis, column analysis, table
analysis, redundancy analysis, correlation analysis, etc. These analyses will carry out data profiling processes
that will define the content, structure and quality of highly complex data structures. The analysis results will
be displayed graphically next to each of the analysis editors, or in more detail in the Analysis Results view.

While you can use all analyses types to profile data in databases, you can only use Column Analysis and Column
Set Analysis to profile data in a delimited or excel file.

11.2.  Launching the studio
You can get the studio archive file from the Talend web site. Please check Talend Installation and Upgrade Guide
for detail information about installing the studio and the installation requirements.

To open your studio for the first time, do the following:

1. Unzip the Talend Studio zip file and, in the folder, double-click the executable file corresponding to your
operating system.

The studio zip archive contains binaries for several platforms including Mac OS X and Linux/Unix.

2. In the [License]  window that is displayed, read and accept the terms of the license agreement.

A registration window is displayed.

3. If required, follow the instructions provided to join Talend community or click Register later to open a
welcome window.

The welcome window gives you access to user documentation and Talend forum.

4. Use the wizard that is displayed to install additional packages such as third-party libraries.

Talend Studio requires specific third-party Java libraries or database drivers (.jar files) to be installed to
connect to sources and targets. Those libraries or drivers, known as external modules, can be required by
some connection wizards. Due to license restrictions, Talend may not be able to ship certain external modules
within the studio.

For more information about identifying and installing external modules, see Talend Installation and Upgrade
Guide.

For more information about the Module view, see Displaying the Module view.

You can skip this installation step and close the wizard by clicking Cancel.

This wizard appears each time you launch the studio if any additional package is available for installation
unless you select the Do not show this again check box. You can also display this wizard by selecting Help
> Install Additional Packages from the menu bar.

5. Click Start now to open the studio.
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The studio starts on a cheat sheet view that is open in the Profiling perspective.

From this window, you can have access to perspectives of several applications integrated within the studio.

For more information about working with perspectives, see Multi-perspective approach.

You can use the cheat sheet procedures to start a profiling task, this will open the DQ Repository tree view in the
studio. Or you can open the DQ Repository tree view by clicking its icon in the top left corner and start profiling
your data directly from the tree view.

For more information about creating new analyses, see Working principles of data quality.

For more information about importing analyses and data quality items created in other studios, see Importing data
profiling items  and Upgrading project items from older versions.

11.3. Important features and configuration
options
This section details some important information about analysis editors, the error log view and the help context
embedded in your studio.

11.3.1. Defining the maximum memory size threshold
From the studio, you can control memory usage when using the Java engine to run two types of analyses: column
analysis and the analysis of a set of columns.
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Why would you like to set a memory limit when running such analyses? If you use column analysis or column
set analysis to profile very big sets of data or data with many problems, you may run out of memory and end up
with a Java heap error. By defining the maximum memory size threshold for these analyses, the Studio will stop
the analysis execution when the memory limit size is reached and provide you with the analysis results that were
measured on the data before the analysis execution was terminated by the memory limit size.

To define the maximum memory size threshold, do the following:

1. On the menu bar, select Window > Preferences to display the [Preferences] window.

2. Either:

• expand Talend > Profiling and select Analysis tuning, or,

• start typing analysis tuning in the dynamic filter field.

The Analysis tuning view is displayed.

3. In the Memory area, select the Enable analysis thread memory control check box.

4. Move the slider to the right to define the memory limit at which the analysis execution will be stopped.

The execution of any column analysis or column set analysis will be stopped if it exceeds the allocated memory
size. The analysis results given in the Studio will cover the data analyzed before the interruption of the analysis
execution.

11.3.2. Setting preferences of analysis editors and
analysis results

You can decide once for all what sections to fold by default when you open any of the connection or analysis
editors. It also offers the possibility to set up the display of all analysis results and whether to show or hide the
graphical results in the different analysis editors.

To set the display parameters for all editors, do the following:

1. On the menu bar, select Window > Preferences to display the [Preferences] window.
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2. Expand Talend > Profiling and select Editor.

3. In the Folding area, select the check box(es) corresponding to the display mode you want to set for the
different sections in all the editors.

4. In the Analysis results folding area, select the check boxes corresponding to the display mode you want to
set for the statistic results in the Analysis Results view of the analysis editor.

5. In the Graphics area, select the Hide graphics in analysis results page option if you do not want to show
the graphical results of the executed analyses in the analysis editor. This will optimize system performance
when you have so many graphics to generate.

6. In the Analyzed Items Per Page field, set the number for the analyzed items you want to group on each page.

7. In the Business Rules Per Page field, set the number for the business rules you want to group in each page.

You can always click the Restore Defaults tab on the [Preferences] window to bring back the default values.

8. Click Apply and then OK to validate the changes and close the [Preferences] window.

While carrying on different analyses, all corresponding editors will open with the display mode you set in the
[Preferences] window.

11.3.3. Displaying and hiding the help content
Your studio provides you with cheat sheets that you can use as a quick reference that guides you through all
common tasks in data profiling.
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You can also have access to a help panel that is attached to all wizards used in the studio to create the different
types of analyses or to set thresholds on indicators.

11.3.3.1. Cheat sheets

When you open the studio for the first time, the cheat sheets view opens by default in theProfiling perspective.

If you close the cheat sheets view in the Profiling perspective of the studio, it will be always closed anytime you
switch back to this perspective until you open it manually.

To display the cheat sheets, do one of the following:

1. Either:

• press the Alt+Shift+Q and then H shortcut keys, or,

• select Window > Show View from the menu bar.

The [Show View] dialog box opens.

2. Expand the Help folder and then select Cheat Sheets.

3. Click OK to close the dialog box.

Or,

1. Select Help > Cheat Sheets from the menu bar. The [Cheat Sheet Selection] dialog box opens.

You can also press the Alt+H shortcut keys to open the Help menu and then select Cheat Sheets.

2. Expand the Talend-Cheat Sheets folder, select the cheat sheet you want to open in the studio and then click
OK .

The selected cheat sheet opens in the studio main window. Use the local toolbar icons to manage the display
of the cheat sheets.



Displaying and hiding the help content

Talend Open Studio for MDM User Guide 401

11.3.3.2. Help panel

A help panel is attached to the wizards used in the studio to create and manage profiling items. This help panel
opens by default in all wizards.

To hide the help panel in any of the wizards used in the studio, do the following:
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1. Select Window > Preferences > Talend > Profiling > Web Browser.

The [Web Browser] view opens.

2. Select the Block browser help check box and then click OK.

From now on, all wizards in the studio display without the help panel.

11.3.4. Displaying the Module view

Talend Studio provides you with a Module view. This view shows if a module is necessary and required for
creating a connection to a database. Checking the Module view helps you to verify what modules you have or
should have to run smoothly your profiling analyses.

To display the Module view in the studio:

1. Select Window > Show View from the menu bar.

The [Show View] dialog box opens.
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2. Start typing Module in the filter field.

3. Select Modules from the list and then click OK.

The Module view opens in the studio.

4. From the toolbar of the Module view, select:

Icon To...

browse your local system to the module you want to install

open a list of all required external modules that are not integrated in the studio.

For further information, see Talend Installation and Upgrade Guide.

11.3.5. Displaying the error log view and managing log
files

The studio provides you with very comprehensive log files that maintain diagnostic information and record any
errors that are encountered in the data profiling process. The error log view is the first place to look when a problem
occurs while profiling data, since it will often contain details of what went wrong and how to fix it.

To display the error log view in the Studio, do one of the following:

1. Either:

• press the Alt+Shift+Q and then L shortcut keys, or,

• select Window > Show View from the menu bar.
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The [Show View] dialog box opens.

2. Expand the General folder and select Error Log.

3. Click OK to close the dialog box.

The Error Log view opens in the studio.

The filter field at the top of the view enables you to do dynamic filtering, for example as you type your text in the
field, the list will show only the logs that match the filter.

You can use icons on the view toolbar to carry out different management options including exporting and
importing the error log files.

Each error log in the list is preceded by an icon that indicates the severity of the log:  for errors,  for
warnings and  for information.

4. Double-click any of the error log files to open the [Event Detail] dialog box.
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5. If required, click the  icon in the [Event Detail] dialog box to copy the event detail to the Clipboard and
then paste it anywhere you like.

11.3.6. Opening new editors

It is possible to open new analysis or SQL editors in the Profiling and Data Explorer perspectives respectively.
You can either open a duplicate of the already open editor with the same analysis parameters or SQL query, or
you can open a completely new empty editor.

Prerequisite(s): An analysis editor or an SQL query editor is open in the Profiling perspective of the studio.

To be able to use Data Explorer in the studio, you must install certain SQL explorer libraries that are required for
data quality. If you do not install these libraries, the Data Explorer perspective will be missing from the studio
and many features will not be available.

For further information about identifying and installing external modules, see Talend Installation and Upgrade
Guide.

To open a duplicate of the already open editor, do the following:

1. In the open analysis or SQL editor, right-click the editor title tab.

In the analysis editor:
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In the SQL editor:

2. From the contextual menu, select New Editor.

A new analysis or SQL editor opens on the same analysis metadata and parameters or on the same SQL query.
The new editor will be an exact duplicate of the initial one.

To open an empty new analysis editor, do the following:

1. In the DQ Repository tree view, expand the Data Profiling folder.

2. Right-click the Analysis folder and select New Analysis.

To open an empty new SQL editor from the Data Explorer perspective, do the following:
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1. In the Connections view of the Data Explorer perspective, right-click any connection in the list.

A contextual menu is displayed.

2. Select New SQL Editor.

A new SQL empty editor opens in the Data Explorer perspective.

To open an empty SQL editor from the Profiling perspective of  the studio, see the procedure outlined in Creating
and storing SQL queries.

11.4.  Icons appended on analyses names in
the DQ Repository
When you create any analysis type from the studio, a corresponding analysis item is listed under the Analyses
folder in the DQ Repository tree view.

The number of the analyses created in the studio will be indicated next to this Analyses folder in the DQ Repository tree
view.

This analysis list will give you an idea about any problems in one or more of your analyses before even opening
the analysis.

If an analysis fails to run, a small red-cross icon will be appended on it. If an analysis runs correctly but has violated
thresholds, a warning icon is appended on such analysis.
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11.5. Multi-perspective approach
Talend Studio offers a comprehensive set of tools and functions for all its key capabilities including data and
application integration, data profiling and master data management. These tools are all accessible from different
perspectives within the studio.

11.5.1. Switching between different perspectives

There are different ways to switch between different perspectives in the studio. They are as follows:

To switch between perspectives using quick access icons, do the following:

• Click the quick access icon in the top left corner of the studio to switch between the Profiling and Data
Explorer perspective.

Alternatively, you may switch between perspectives using the menu bar:

1. On the menu bar, click Window > Perspective.

2. Select from the list:

Item to...

Profiling open the data profiler perspective where you can examine data available in different data sources.

Data Explorer open the data explorer perspective where you can browse and query analyzed data.

Other... open a dialog box from which you can select to open different perspectives that extend the studio
functionalities.

It is also possible, using the Window - Show view... combination, to show views from other perspectives in the
open perspective.

11.5.2.  Saving the configuration of a perspective

You can save the configuration of your current perspective in order to list it as a new perspective in the perspective
dialog box.

To save the configuration of the current perspective, do the following:

1. On the menu bar, click Window > Save Perspective As....
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2. In the Name field, enter a name.

3. Click OK .

The current perspective is saved as a new perspective under the new name.

You can open this perspective any time by selecting it from the [Open Perspective] dialog box. For further
information, see Switching between different perspectives.



Talend Open Studio for MDM User Guide



Talend Open Studio for MDM User Guide

Chapter 12. Before you begin profiling data
The Profiling perspective of Talend Studio enables you to profile data in different data sources including databases
and in files.

This chapter explains how to set up different connections to your data sources. It describes as well how to manage
such metadata connections.
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12.1. Creating connections to data sources
The Profiling perspective of the studio enables you to create connections to databases and delimited or excel files
in order to profile data in these data sources.

12.1.1. Connecting to a database

Before proceeding to analyze data in a specific database, you must first set up the connection to this database.
From the Profiling perspective of the studio, you can create a connection on the DataBase Management System
(DBMS) and show database content.

For further information about what databases are supported for profiling data, see What databases are supported
from the Profiling perspective and the section about supported databases in Talend Installation and Upgrade
Guide.

Connections to different databases are reflected by different tree levels and different icons in the DQ Repository
tree view because the logical and physical structure of data differs from one relational database to another. The
highest level structure "Catalog" followed by "Schema" and finally by "Table" is not applicable to all database
types. For further information, see Catalogs and schemas in database systems.

12.1.1.1. How to create a connection

Prerequisite(s): You have selected the Profiling perspective of the studio.

To create a database connection, do the following:

1. In the DQ Repository tree view, expand Metadata, right-click DB Connections and select Create DB
Connection.

The [Database Connection] wizard opens.
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2. In the Name field, enter a name for this new database connection.

Do not use spaces in the connection name.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

3. If required, set other connection metadata (purpose, description and author name) in the corresponding fields
and click Next to proceed to the next step.
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4. In the DB Type field and from the drop-down list, select the type of database to which you want to connect.
For example, MySQL. A warning message will pop up to remind you of the incompatibility if the database
type you have selected cannot be used in the Profiling perspective.

If you select to connect to a database that is not supported in the studio (using the ODBC or JDBC methods), it
is recommended to use the Java engine to execute the column analyses created on the selected database. For more
information on column analyses, see Defining the columns to be analyzed and setting indicators, and for more
information on the Java engine, see Using the Java or the SQL engine.

5. In the DB Version field, select the version of the database to which you are creating the connection.

6. Enter your login, password, server and port information in their corresponding fields.

If needed, click the  button to show all connection fields without having to scroll down in the wizard.

7. In the Database field, enter the database name you are connecting to. If you need to connect to all of the
catalogs within one connection, if the database allows you to, leave this field empty.

8. Click the Check button to verify if your connection is successful.
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If you have not already installed the database driver (.jar file) necessary to use the database, you will have a
wizard prompting you to install the relative third-party module, click Download and Install and then close
the wizard.

For further information about identifying and installing external modules, see Talend Installation and
Upgrade Guide or click the How to install a driver link in the wizard.

For further information about the Module view, see Displaying the Module view.

9. If needed, export your connection as a context and centralize it under the Context node in the Integration
perspective of your Studio. This enables you to reuse this context in the data quality analyses that use the
current connection. You can also create different context parameters for the same connection and later choose
to execute an analysis on one specific context. For further information, see Using context variables to connect
to data sources.

10. Click Finish to close the [Database Connection] wizard.

A folder for the created database connection is displayed under DB Connection in the DQ Repository tree
view  and under the Metadata  node in the Integration perspective. The connection editor opens with the
defined metadata in the studio.

Once you create the connection, you can open in the studio a preview of the data in a specific database table.
For further information, see Previewing data in the SQL editor.

From the connection editor, you can:

• Click Connection information to show the connection parameters for the relevant database.

• Click the Check button to check the status of your current connection.
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• Click the Edit... button to open the connection wizard and modify any of the connection information.

For information on how to set up a connection to a file, see Connecting to a file.

12.1.1.2. How to create a connection from a catalog or a schema

You can create a connection on a database catalog or schema directly from a database connection.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database

1. In the DQ Repository tree view, expand Metadata > DB Connections and browse to the catalog or schema
on which you want to create the connection.

2. Right-click a catalog or schema and select Create a new connection.

A confirmation message is displayed.

3. Click OK.

A new connection named after the selected connection and catalog is created under DB Connections.



Connecting to a database

Talend Open Studio for MDM User Guide 417

12.1.1.3. How to create a connection to a custom database

The database connection wizard in the studio lists the databases to which you can create a connection and do
profiling and integration processes.

Currently, fewer databases in the list are supported for profiling data. For further information, see What databases
are supported from the Profiling perspective and the section about supported databases in Talend Installation and
Upgrade Guide.

You can still use the studio to connect to a custom "unsupported" database. To do this, you need to choose
General JDBC as the database type in the connection wizard and then fill in the connection parameters. For
further information, see Centralizing JDBC metadata.

After creating the connection to a custom database, you can profile and monitor data in this database by using
different analyses and indicators, as you do with supported databases. But you may need to change, in the Indicator
Settings editor, the SQL query template for some indicators, such as the regex indicator where each database has
a different function to call. For further information, see How to edit a system indicator and How to edit a user-
defined indicator.

If you have a problem profiling a custom database even though you use a JDBC connection, the reason could be that some
JDBC functions are not implemented by the JDBC driver library. Please raise an issue or ask support via Talend Forum
Website at:

http://talendforge.org/forum.

12.1.1.4. What databases are supported from the Profiling
perspective

You can set a connection to a database either from the Profiling perspective or from the Integration perspective.
The database connection you create are listed under the Metadata node in both perspectives. You can then use
this connection in your data quality analyses and data integration Jobs.

However, fewer databases are supported for profiling data than those supported for integrating data, this is why
the database list in the connection wizard is much longer in the Integration perspective. Also, in the Profiling
perspective, the connections created on unsupported databases are labeled as Unsupported.

For further information about what databases are supported for profiling data, see the section about supported
databases in Talend Installation and Upgrade Guide.

12.1.1.5. What you need to know about some databases

Teradata:

If you select to connect to the Teradata database, please select the Yes option next to USE SQL Mode to enable
the studio to use the SQL queries to retrieve metadata. The JDBC driver is not recommended with this database
because of possible bad performance.

http://talendforge.org/forum
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In the Teradata database, the regular expression function is installed by default only starting from version 14. If
you want to use regular expressions with older versions of this database, you must install a User Defined Function
in Teradata and add the indicator definition for Teradata in the studio. For further information, check the article
How to configure regular expressions on Teradata.

Netezza:

The Netezza database does not support regular expressions. If you want to use regular expressions with this
database, you must:

• Install the SQL Extensions Toolkit package on a Netezza system. Use the regex_like function provided
in this toolkit in the SQL template as documented in http://pic.dhe.ibm.com/infocenter/ntz/v7r0m3/topic/
com.ibm.nz.sqltk.doc/r_sqlext_regexp_like.html.

• Add the indicator definition for Netezza in the Pattern Matching folder in the studio under Libraries >
Indicators > System Indicators.

https://help.talend.com/pages/viewpage.action?pageId=190513345
http://pic.dhe.ibm.com/infocenter/ntz/v7r0m3/topic/com.ibm.nz.sqltk.doc/r_sqlext_regexp_like.html
http://pic.dhe.ibm.com/infocenter/ntz/v7r0m3/topic/com.ibm.nz.sqltk.doc/r_sqlext_regexp_like.html
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The query template you need to define for Netezza is as the following: SELECT COUNT(CASE WHEN

REGEXP_LIKE(<%=COLUMN_NAMES%>,<%=PATTERN_EXPR%>) THEN 1 END), COUNT FROM <%=TABLE_NAME%>

<%=WHERE_CLAUSE%>. For a detail procedure about how to add an indicator definition for a specific database,
see How to define a query template for a specific database.

Hive:

If you select to connect to the Hive database, you will be able to create and execute different analyses as with
the other database types.

In the connection wizard, you must select from the Distribution list the platform that hosts Hive. You must also
set the Hive version and model. For further information, see Managing Metadata and http://hadoop.apache.org/.

http://hadoop.apache.org/
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-If you decide to change the user name in an embedded mode of a Hive connection, you must restart the studio
before being able to successfully run the profiling analyses that use the connection. For more information about
the use of user credentials with Hive see the article How user credentials work in Hive embedded mode in studio.

-If the Hadoop distribution to be used is Hortonworks Data Platform V1.2 or Hortonworks Data Platform V1.3,
you must set proper memory allocations for the map and reduce computations to be performed by the Hadoop
system. In the second step in the connection wizard:

1. Scroll down to the Hadoop Properties table and click the [+] button to add two lines.

2. Enter the parameters names as mapred.job.map.memory.mb and mapred.job.reduce.memory.mb.

3. Set their values to the by-default value 1000.

This value is normally appropriate for running the computations.

-If the Hadoop distribution to be used is Hortonworks Data Platform V2.0 (YARN), you must set the following
parameter in the Hadoop Properties table:

• The parameter is

yarn.application.classpath

• The value is

/etc/hadoop/conf,/usr/lib/hadoop/,/usr/lib/hadoop/lib/,/usr/lib/hadoop-hdfs/,/usr/
lib/hadoop-hdfs/lib/,/usr/lib/hadoop-yarn/,/usr/lib/hadoop-yarn/lib/,/usr/lib/hadoop-
mapreduce/,/usr/lib/hadoop-mapreduce/lib/

Note that one analysis type and few indicators and functions are still not supported for Hive, see the table below
for more detail:

Unsupported indicators Unsupported functions Unsupported analyses

with SQL engine:

-Soundex Low Frequency Table.

-Pattern(Low) Frequency Table.

-Upper Quartile and Lower
Quartile.

-Median.

- All Date Frequency indicators.

-the View rows contextual menu for column
analyses with unique, duplicate and all textual
indicators.

For further information on the View rows menu, see
Viewing and exporting analyzed data.

-the View match rows contextual menu for column
analyses with unique, duplicate and all textual
indicators.

For further information on View match rows, see
Comparing identical columns in different tables.

-all contextual menus on the analysis results of
functional dependency analysis.

For further information on this analysis, see
Detecting anomalies in the table columns: column
functional dependency analysis.

-the only analysis that is not supported for
Hive is Time Correlation Analysis as the
Date data type does not exist in Hive. For
further information on this analysis type,
see Time correlation analyses.

https://help.talend.com/pages/viewpage.action?pageId=190513363
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12.1.1.6. Catalogs and schemas in database systems

The structure of a database defines how objects are organized in the database. Different data storage structures
are used to store objects in databases. For example, the highest-level structure (such as "Catalog" followed by
"Schema" and finally by "Table") is not applicable to all database types.

The table below describes the structure of some databases in terms of catalog and schemas:

Database name Version Catalog Schema

Oracle no yes

MySQL yes no

SQLServer 2000/2005/2008 yes yes

DB2 no yes

DB2 ZOS no yes

Sybase yes yes

Informix yes yes

PointBase no yes

PostgreSQL yes yes

AS/400 V5R4 yes yes

Ingres no yes

Teradata no yes

Netezza yes yes

SQLite no no

12.1.2. Connecting to a file

Before proceeding to analyze data in a delimited file or an excel file, you must first set up the connection to such
a file.

12.1.2.1. How to connect to a delimited file

Before being able to profile data in a delimited file, you must first set up the connection to this file.

Prerequisite(s): You have selected the Profiling perspective in the studio.

To create a connection to a delimited file, do the following:

1. Expand the Metadata folder.
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2. Right-click FileDelimited connections and then select Create File Delimited Connection to open the [New
Delimited File] wizard.

3. Follow the steps defined in the wizard to create a connection to a delimited file.

You can then create a column analysis and drop the columns to analyze from the delimited file metadata in
the DQ Repository tree view to the open analysis editor. For further information, see Analyzing columns
in a delimited file.

For information on how to set up a connection to a database, see Connecting to a database.

You can create a file delimited connection either from the Profiling or the Integration perspectives. Once created,
this connection is always listed in both perspectives.

You can export your connection as a context and centralize it under the Context node in the Integration
perspective of your Studio. This enables you to reuse this context in the data quality analyses that use the current
connection. You can also create different context parameters for the same connection and later choose to execute
an analysis on one specific context. For further information, see Using context variables to connect to data sources.

12.1.2.2. How to connect to an Excel file

Before being able to profile data in an excel file, you must create your Data Source, and then set up the connection
to this Data Source.

To create the Data Source, do the following:

1. On the task bar of your desktop, click the Start button and then select Control Panel to open the
corresponding page.

2. Double-click Tools and Administrator to open the corresponding page.

3. Double-click Data sources (ODBC).
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A dialog box opens.

4. In the User DSN view, click Add... to open a dialog box where you can select the ODBC driver, Microsoft
Excel in this example, for the data source (database) to which you want to connect.

5. Click Finish to proceed to the step where you can define the Data Source.
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6. In the Data Source Name field, enter a name for the Data Source, and then click the Select Workbook... tab
to proceed to the step where you link this Data Source to the excel file you want to profile.

7. In the open dialog box, browse to the excel file to which you want to link your Data Source.

To be able to set an ODBC connection to the Data Source without problems, make sure that the excel files you want
to profile are put in a folder, that is to say they are not located on the root directory of your system.

8. Select the excel file and then click OK to close the open dialog boxes. The Data Source you create is listed
in the User Data Sources list.

9. Click OK to close the dialog box.

You can then create a column analysis and drop the columns to analyze from the excel file metadata in the DQ
Repository tree view to the open analysis editor. For further information, see Analyzing columns in an excel file.

For information on how to set up a connection to a database, see Connecting to a database.

12.2.  Managing connections to data sources
Several management options are available for each of the connections created in the studio.

12.2.1.  Managing database connections

Many management options are available for database connections including editing and duplicating the connection
or adding a task to it.

The sections below explain in detail these management options.

12.2.1.1. How to open or edit a database connection

You can edit the connection to a specific database and change the connection metadata and the connection
information.
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Prerequisite(s): A database connection is created in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To edit an existing database connection, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connection.

2. Either:

• Double-click the database connection you want to open, or,

• Right-click the database connection and select Open in the contextual menu.

The connection editor for the selected database connection is displayed.
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3. Modify the connection metadata in the Connection Metadata view, as required.

4. Click the Edit... button in the Connection information view to open the [Database Connection] wizard.
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5. Go through the steps in the wizard and modify the database connection settings as required.

6. Click Finish to validate the modifications.

A dialog box opens prompting you to reload the updated database connection.

7. Select the reload option if you want to reload the new database structure for the updated database connection.

If you select the don't reload option, you will still be able to execute the analyses using the connection even after
you update it.

If the database connection is used by profiling analyses in the Studio, another dialog box is displayed to list
all the analyses that use the database connection. It alerts you that if you reload the database new structure,
all the analyses using the connection will become unusable although they will be always listed in the DQ
Repository tree view.
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8. Click OK to accept reloading the database structure or Cancel to cancel the operation and close the dialog
box.

A number of confirmation messages are displayed one after the other.

9. Click OK to close the messages and reload the structure of the new connection.

12.2.1.2. How to filter a database connection

After setting a specific database connection in the studio, you may not want to view all databases in the DQ
Repository tree view of your Studio.

You can filter your database connections to list the databases that match the filter you set. This option is very
helpful when the number of databases in a specific connection is very big.

Prerequisite(s): A database connection is already created in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To filter a database connection, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connection.
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2. Right-click the database connection you want to filter and select Package Filter to open the corresponding
dialog box.

3. In the Package Filter field, enter the complete name of the database you want to view and then click Finish
to close the dialog box.

Only the database that matches the filter you set is listed under the database connection in the DQ Repository
tree view.
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To cancel the filter, do the following:

1. In the [Package Filter] dialog box, delete the text from the Package Filter field.

2. Click Finish  to close the dialog box.

All databases are listed under the selected database connection in the DQ Repository tree view.

12.2.1.3. How to duplicate a database connection

To avoid creating a DB connection from scratch, you can duplicate an existing one in the DB Connections list
and work around its metadata to have a new connection.

Prerequisite(s): A database connection is created in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To duplicate a connection to a specific database, do the following:

1. In the DQ Repository tree view, expand Metadata DB Connections.

2. Right-click the connection you want to duplicate and select Duplicate from the contextual menu.
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The duplicated database connection shows under the connection list in the DQ Repository tree view as a copy of
the original connection. You can now open the duplicated connection and modify its metadata as needed.

12.2.1.4. How to add a task to a database connection or any of its
elements

You can add a task to a database connection to use it as a reminder to modify the connection or to flag a problem
that needs to be solved later, for example. You can also add a task to a catalog, a table or a column in the connection.

Prerequisite(s): A database connection is created in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To add a task to a database connection, do the following:

1. Expand Metadata and DB connections.

2. Right-click the connection to which you want to add a task, and then select Add task... from the contextual
menu.

The [Properties] dialog box opens showing the metadata of the selected connection.
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3. In the Description field, enter a short description for the task you want to attach to the selected connection.

4. On the Priority list, select the priority level and then click OK to close the dialog box.

The created task is added to the Tasks list.

You can follow the same steps in the above procedure to add a task to a catalog, a table or a column in the connection. For
further information, see Adding a task to a column in a database connection.

For more information on how to access the task list, see Displaying the task list.

12.2.1.5. How to filter tables/views in a database connection

You can filter the tables/views to list under any database connection.

This option is very helpful when the number of tables in the database to which the studio is connecting is very
big. If so, a message is displayed prompting you to set a table filter on the database connection in order to list only
defined tables in the DQ Repository tree view.

Prerequisite(s): A database connection is already created in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To filter table/views in a database connection, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Expand the database connection in which you want to filter tables/views and right-click the desired catalog/
schema.
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3. Select Table/View Filter from the list to display the corresponding dialog box.

4. Set a table and a view filter in the corresponding fields and click Finish to close the dialog box.

Only tables/views that match the filter you set are listed in the DQ Repository tree view.

12.2.1.6. How to delete or restore a database connection

You can move a database connection to the studio recycle bin whether it is used by analyses or not. You can also
restore the deleted database connection.

Prerequisite(s): A database connection is created in the studio. For further information, see Connecting to a
database.
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To delete a database connection from the Metadata node, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Right-click a database connection and select Delete in the contextual menu.

The database connection is moved to the Recycle Bin.

You can still run the analyses that use the connection in the recycle bin. However, an alert message will be
displayed next to the connection name in the analysis editor.

To delete the connection from the Recycle Bin, do the following:

1. Right-click the database connection in the Recycle Bin and choose Delete from the contextual menu.

A confirm deletion dialog box is displayed.

2. Click OK.

If the connection is not used by any analysis, it is deleted from the studio.

If the connection is used by one or more analyses in the studio, a dialog box is displayed to list such analyses.
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3. Either:

• Click OK to close the dialog box without deleting the database connection from the recycle bin.

• Select the Force to delete all the dependencies check box and then click OK to delete the database
connection from the Recycle Bin and to delete all the dependent analyses from the Data Profiling node.

You can also delete permanently the database connection by emptying the recycle bin. To empty the Recycle Bin,
do the following:

1. Right-click the Recycle Bin and select Empty recycle bin.

If the connection is not used by any analysis in the current Studio, a confirmation dialog box is displayed.

2. Click Yes to empty the recycle bin.

If the connection is used by one or more analyses in the studio, a dialog box is displayed to list these analyses.
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3. Click OK to close the dialog box without removing the connection from the recycle bin.

To restore a database connection from the Recycle Bin, do the following:

• In the Recycle Bin, right-click the connection and select Restore.

The database connection is moved back to the Metadata node.

12.2.2.  Managing file connections

Few management options are available for file connections including editing or deleting the connection, adding
a task to it, or importing and exporting the connection.

You can edit the connection to a specific file and change the connection metadata and the connection information.

Prerequisite(s): A file connection is created in the Profiling perspective of the studio. For further information,
see Connecting to a file.

To edit an existing file connection, do the following:

1. In the DQ Repository tree view, expand Metadata > Filedelimited Connection.

2. Double-click the file connection you want to open.

The connection editor for the selected connection is displayed.

3. Modify the connection metadata as required and click Next.

4. Go through the steps in the wizard and modify the file connection settings as required.

5. Click Finish to validate the modifications.

Other management procedures for file connection are the same as those for databases.

For further information on how to add a task to a file connection, see How to add a task to a database connection
or any of its elements.

For further information on how to delete or restore a file connection, see How to delete or restore a database
connection.

For further information on how to import or export a file connection, see Importing data profiling items .
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Chapter 13. Profiling database content
This chapter provides the information you need to analyze database content to have an overview of the number of
tables in the database, rows per table and indexes and primary keys.
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13.1. Analyzing databases
You can analyze the content of a database to have an overview of the number of tables in the database, rows per
table and indexes and primary keys.

You can also analyze one specific catalog or schema in a database, if a catalog or schema is used in the physical
structure of the database.

13.1.1. Creating a database content analysis

From the Profiling perspective of the studio, you can create an analysis of the content of a given database.

Prerequisite(s): At least, one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To create a database content analysis, you must first define the relevant analysis and then select the database
connection you want to analyze.

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. Expand the Connection Analysis node, click Database Structure Overview and then click the Next button.

4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".
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These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

5. Set the analysis metadata (purpose, description and author name) in the corresponding fields and click Next.

Selecting the database connection you want to analyze

1. Expand DB Connections and select a database connection to analyze, if more than one exists.

2. Click Next to proceed to the next step.

3. Set filters on tables and/or views in their corresponding fields according to your needs using the SQL
language.

By default, the analysis will include all tables and views in the database.

4. Click Finish to close the [Create New Analysis] wizard.

A folder for the newly created analysis is listed under the Analyses folder in the DQ Repository tree view,
and the connection editor opens with the defined metadata.
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The display of the connection editor depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

5. Click Analysis Parameters and:

• In the Number of connections per analysis field, set the number of concurrent connections allowed per
analysis to the selected database connection.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

• Check/modify filters on table and/or views, if any.

• Select the Reload databases check box if you want to reload all databases in your connection on the server
when you run the overview analysis.

When you try to reload a database, a message will prompt you for confirmation as any change in the
database structure may affect existing analyses.

6. In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.
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The table in this view lists all context environments and their values you define in the Contexts view in the
analysis editor. For further information, see Using context variables in analyses.

7. Click Analysis Summary to show all the parameters of the current analysis along with the current analysis
execution status.

8. Click the save icon on top of the editor and then press F6 to execute the current analysis. A message opens
to confirm that the operation is in progress.

Analysis results are stored in the Statistical information view.

9. Click Statistical information to show analytical information about the content of the relevant database.

From the Statistical information view, you can:

• Click a catalog or a schema in the Statistical information view to list all tables included in it along with a
summary of their content: number of rows, keys and user-defined indexes.

The selected catalog or schema is highlighted in blue. Catalogs or schemas highlighted in red indicate potential
problems in data.

• Right-click a catalog or a schema and select Overview analysis to analyze the content of the selected item.

• Right-click a table or a view and select Table analysis to create a table analysis on the selected item.

• Click any column header in the analytical table to sort alphabetically the data listed in catalogs or schemas. You
can also sort alphabetically all columns in the result table doing the same.
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13.1.2.  Creating a database content analysis in
shortcut procedure

You can create an analysis of the content of a given database directly from the DB Connection folder in the DQ
Repository tree view.

Prerequisite(s): At least, one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To create a database content analysis, do the following:

1. Right-click the database for which you want to create content analysis.

2. From the contextual menu, select Overview analysis .

This way, you do not have to specify in the new analysis wizard either the type of analysis you want to carry
out or the DB connection to analyze. Otherwise, all other procedural steps are exactly the same as in Creating
a database content analysis.

13.1.3. Creating a catalog analysis

You can analyze one specific catalog in a database, if this entity is used in the physical structure of the database.
The result of the analysis gives analytical information about the content of this catalog, for example number of
rows, number of tables, number of rows per table and so on.
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Prerequisite(s): At least one database connection has been created to connect to a database that uses the "catalog"
entity.

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.

3. Expand the Catalog Analysis node and then click Catalog Structure Overview.

4. Click the Next button.
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You can directly go to this step in the analysis creation wizard if you right-click the catalog to analyze in Metadata>DB
Connections and select Overview analysis.

5. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

6. Set the analysis metadata (purpose, description and author name) in the corresponding fields and click Next.
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Selecting the catalog you want to analyze

1. Expand DB Connections and the database that include catalog entities in its physical structure and select
a catalog to analyze.

2. Click Next.

3. Set filters on tables and/or views in their corresponding fields according to your needs using the SQL
language.

By default, the analysis will include all tables and views in the catalog.

4. Click Finish to close the [Create New Analysis] wizard.



Creating a catalog analysis

Talend Open Studio for MDM User Guide 447

A folder for the newly created analysis is listed under Analysis in the DQ Repository tree view, and the
analysis editor opens with the defined metadata.

The display of the analysis editor depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

5. Click Analysis Parameters and:

• In the Number of connections per analysis field, set the number of concurrent connections allowed per
analysis to the selected database connection.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

• Check/modify filters on table and/or views, if any.

6. In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

The table in this view lists all context environments and their values you define in the Contexts view in the
analysis editor. For further information, see Using context variables in analyses.

7. Click the save icon on top of the editor and then press F6 to execute the current analysis.

A message opens to confirm that the operation is in progress.

Analysis results are stored in the Statistical information view.

8. Click Statistical information to show analytical information about the content of the relevant catalog.
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From the Statistical information view, you can:

• Click the catalog in the analytical table to open a result list that details all tables included in the selected catalog
with a summary of their content.

The selected catalog is highlighted in blue. Catalogs highlighted in red indicate potential problems in data.

• Right-click a table or a view and select Table analysis to create a table analysis on the selected item.

• Click any column header in the analytical table to sort the listed data alphabetically.

13.1.4. Creating a schema analysis

You can use the Profiling perspective of the studio to analyze one specific schema in a database, if this entity
is used in the physical structure of the database. The result of the analysis gives analytical information about the
content of this schema, for example number of rows, number of tables, number of rows per table and so on.

Prerequisite(s): At least one database connection has been created to connect to a database that uses the "schema"
entity, for example the DB2 database. For further information, see Connecting to a database.

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.
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The [Create New Analysis] wizard opens.

3. Expand the Schema Analysis node and then click Schema Structure Overview.

4. Click the Next button to proceed to the next step.
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You can directly get to this step in the analysis creation wizard if you right-click the schema to analyze in Metadata
>DB connections and select Overview analysis.

5. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

6. If required, set the analysis metadata (purpose, description and author name) in the corresponding fields and
click Next to proceed to the next step.
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Selecting the schema you want to analyze

1. Expand in succession DB Connections and the database that include schema entities in its physical structure
and select a schema to analyze.

2. Click Next.

3. Set filters on tables and/or views in their corresponding fields according to your needs using the SQL
language.

By default, the analysis will include all tables and views in the catalog.

4. Click Finish to close the [Create New Analysis] wizard.

A folder for the newly created analysis is listed under Analysis in the DQ Repository tree view, and the
analysis editor opens with the defined metadata.
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The display of the analysis editor depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

5. Click Analysis Parameters and:

• In the Number of connections per analysis field, set the number of concurrent connections allowed per
analysis to the selected database connection.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

• Check/modify filters on table and/or views, if any.

6. In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

The table in this view lists all context environments and their values you define in the Contexts view in the
analysis editor. For further information, see Using context variables in analyses.

7. Click the save icon on top of the editor and then press F6 to execute the current analysis.

A message opens to confirm that the operation is in progress.

Analysis results are stored in the Statistical informations area.
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8. Click Statistical informations to show analytical information about the content of the relevant catalog.

From the Statistical information view, you can:

• Click the schema in the analytical table to open a result list that details all tables included in the selected schema
with a summary of their content.

The selected schema is highlighted in blue. Schemas highlighted in red indicate potential problems in data.

• Right-click a table or a view and select Table analysis to create a table analysis on the selected item.

• Click any column header in the analytical table to sort the listed data alphabetically.

13.2. Previewing data in the SQL editor
After you create a connection to a database, you can open a view in the studio to see actual data in the database.

Prerequisite(s): At least one database connection has been created in the Profiling perspective of the studio. For
further information, see Connecting to a database.

To display a preview of actual data of a given database table, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Browse to a table in a given database connection, right-click it and select Preview.
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The SQL editor opens in the studio listing the data in the selected table.

3. If required, do any modifications in the query and save it.

The query is listed under the Libraries > Source Files folder in the DQ Repository  tree view.

13.3.  Displaying keys and indexes of
database tables
After analyzing the content of a database as outlined in Creating a database content analysis, you can display
the details of the key and user-defined index of a given table. This information could be very interesting for the
database administrator.

Prerequisite(s): At least one database content analysis has been created and executed in the studio. For further
information, see Creating a database content analysis.

To display the details of the key and user-defined index of a given table in the analyzed database, do the following:

1. In the Statistical information view, click a catalog or a schema.

All the tables included in the selected catalog or schema are listed along with a summary of their content:
number of rows, keys and user-defined indexes.
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2. In the table list, right-click the table key and select View keys.

You can not display the key details of tables in a Hive connection.

The Database Structure and the Database Detail views display the structure of the analyzed database and
information about the primary key of the selected table.
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If one or both views do not show, select Window > Show View > Database Structure or Window > Show
View > Database Detail.

3. In the table list, right-click the table index and select View indexes.

You can not display the index details of tables in a Hive connection.

The Database Structure and the Database Detail  views display the structure of the analyzed database and
information about the user-defined index of the selected table.

4. If required, click any of the tabs in the Database Detail view to display the relevant metadata about the
selected table.

13.4. Tracking data changes in source
databases
When the data in a source database is changed or updated, it is necessary that the relevant connection structure in
the studio follows that change or update as well. Otherwise, errors may occur when trying to analyze a column
that has been modified/deleted in a database.

From the studio, you can compare the connection structure displayed in the DQ Repository tree view with the
database structures itself to locate possible differences. Then you can synchronize the connection structure in the
tree view with the actual database structure.

Comparing  and synchronizing  a database connection with a database structure may take long time. Do not do it unless
you are sure that incoherency does exist.
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13.4.1. Comparing tree-view metadata structures with
database structures

You can quickly and accurately compare the metadata lists displayed in the DQ Repository tree view with the
database structures on which you create the connection to indicate any incoherences.

The studio takes a connection structure in the DQ Repository tree view and compares it to the database trying to
locate all structure differences and display these differences in the Compare view.

You can then, if necessary, synchronize the connection structure in the tree view with the database structure. For
more information, see Synchronizing the connection structure with the database structure.

You can perform the structure comparison at the following three different levels:

• DB connection: to compare the catalog and schema lists,

• Tables: to compare the list of tables,

• Column: to compare the list of columns.

13.4.1.1. How to compare catalog and schema lists

Prerequisite(s): A database connection has been already created in the Profiling perspective of the studio.

To compare the catalog and schema lists, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Right-click the DB connection for which you want to compare the metadata structure with the database
structure and select Database Compare.
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A message opens to confirm that the operation is in progress.

3. If required, click the Cancel button on the message to stop the operation.

A compare view opens displaying the differences between your connection structure and the actual database
structure.
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In the compare view, colors are used as the following:

Color Indication

green highlights any deleted item.

blue highlights any updated item.

red highlights any added item.

If you select an item in the top half of the view, the color markers in the bottom half of the view become
thicker to highlight the selected item. If you select any database from the Distant Structure list in the bottom
half of the view, the corresponding description will be highlighted in the top half of the view.

4. If required, right-click a specific catalog in this view to display a contextual menu where you can select
Compare the list of tables or Compare the list of views. This will display respectively the table list or the
view list of the selected catalog. For further information about comparing table lists, see How to compare
table lists

If you select a specific catalog in this list and press the T or V keys on your keyboard, you can display respectively the
table or view lists of the selected catalog.
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13.4.1.2. How to compare table lists

Prerequisite(s): A DB connection has already been created in the Profiling perspective of the studio.

To compare a table list, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Browse through the entities in your database connection to reach the Table folder you want to compare with
that of the database.

3. Right-click the Tables folder and select Table Compare.

A message opens to confirm that the operation is in progress.

You can click the Cancel button on the confirmation message to stop the operation.

The Compare view opens displaying any differences between the table lists in the tree view and the actual
database.

In the compare view, colors are used as the following:
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Color Indication

green highlights any deleted item.

blue highlights any updated item.

red highlights any added item.

If you select an item in the top half of the view, the color markers in the bottom half of the view become
thicker to highlight the selected item. If you select any database from the Distant Structure list in the bottom
half of the view, the corresponding description will be highlighted in the top half of the view.

4. If required, right-click a specific table in the Compare view to display a contextual menu. Select Compare
the list of columns to display the columns list of the selected table. For further information, see How to
compare column lists

If you select a specific table in the Compare list and press the C key on your keyboard, you can display the column list
of the selected table.

13.4.1.3. How to compare column lists

Prerequisite(s): A database connection has been created in the Profiling perspective of the studio.

To compare a column list, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Browse through the entities in your database connection to reach the Columns folder you want to compare
with that of the database.

3. Right-click the Columns folder and select Column Compare.

A progress information pop-up opens to confirm that the operation is in progress.

You can click the Cancel button on the confirmation message to stop the operation.
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The Compare view opens displaying any differences between the column list in the tree view and the
database.

In the compare view, colors are used as the following:

Color Indication

green highlights any deleted item.

blue highlights any updated item.

red highlights any added item.

If you select an item in the top half of the view, the color markers in the bottom half of the view become
thicker to highlight the selected item. If you select any database from the Distant Structure list in the bottom
half of the view, the corresponding description will be highlighted in the top half of the view.

13.4.2. Synchronizing the connection structure with
the database structure

You can synchronize the connection structure displayed in the DQ Repository tree view with the database
structures to eliminate any incoherences. You can perform synchronization at the following three different levels:

• DB connection: to refresh the catalog and schema lists,

• Tables: to refresh the list of tables,

• Column: to refresh the list of columns.
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13.4.2.1. How to synchronize and reload catalog and schema lists

You can compare and match the catalog and schema lists in the DQ Repository tree view with those in the
database.

However, if you have a large number of catalogs and schemas in the database, you must first set the correct value
for the EMF (Eclipse Modeling Framework) compare function, the function that provides comparison and merge
facility for any kind of EMF model, before you try to perform the reload function. Otherwise, some of the reloaded
items will be lost.

Prerequisite(s): A database connection has been created in the Profiling perspective of the studio.

To synchronize the catalog and schema lists when there are less than 50 objects in the database, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Right-click the database connection you want to synchronize with the database and select Reload database
list.

A message will prompt you for confirmation as any change in the database structure may affect the analyses
listed in the Studio.

3. Click OK to close the confirmation message, or Cancel to stop the operation.

The selected database connection is updated with the new catalogs and schemas, if any.

To synchronize the catalog and schema lists when there are more than 50 objects in the database, do the following:

1. In the menu bar, select Window > Preferences to display the [Preferences] window.
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2. Select EMF Compare to open the EMF Compare view.

The EMF compare function provides comparison and merge facility for any kind of EMF model.

3. In the Search Windows field, set the search parameter to a value greater than twice the number of the objects
to reload (catalogs, tables, or columns).

The default value 100 works only when the objects in the database do not exceed 50 in number.

4. Follow the steps listed in the first procedure in this section to reload the database structure in the DQ
Repository tree view.

13.4.2.2. How to synchronize and reload table lists

You can compare and match the table lists in the DQ Repository tree view with those in the database.

However, if you have a large number of tables in the database, you must first set the correct value for the EMF
(Eclipse Modeling Framework) compare function before you try to perform the reload operation. Otherwise, some
of the reloaded items will be lost.

For further information, see How to synchronize and reload catalog and schema lists.

Prerequisite(s): A database connection has already been created in the Profiling perspective of the studio.

To synchronize and reload a table list, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections  .

2. Browse through the entities in your database connection to reach the Table folder you want to synchronize
with the database.

3. Right-click the Tables folder and select Reload table list.
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A message will prompt you for confirmation as any change in the database structure may affect existing
analyses.

4. Click OK to close the confirmation message, or Cancel to stop the operation.

The selected table list is updated with the new tables in the database, if any.

13.4.2.3. How to synchronize and reload column lists

You can compare and match the column lists in the DQ Repository tree view with those in the database.

However, if you have a large number of columns in the database, you must first set the correct value for the EMF
(Eclipse Modeling Framework) compare function before you try to perform the reload operation. Otherwise, some
of the reloaded items will be lost.

For further information, see How to synchronize and reload catalog and schema lists.

Prerequisite(s): A database connection has been created in the Profiling perspective of the studio.

To synchronize and reload a column list, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Browse through the entities in your database connection to reach the Columns folder you want to synchronize
with the database.

3. Right-click the Columns folder and select Reload column list.
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A message will prompt you for confirmation as any change in the database structure may affect existing
analyses.

4. Click OK to close the confirmation message, or Cancel to stop the operation.

The selected column list is updated with the new column in the database, if any.
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Chapter 14. Column analyses
This chapter describes the process of using the studio to examine single columns in databases and in delimited
or excel files. It provides detailed information about how to use patterns, indicators and indicator options when
analyzing such data.
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14.1. Steps to analyze a column
From the studio, you can examine and collect statistics and information about the data available in database
columns and in delimited or excel files.

The sequence of profiling data in one or multiple columns involves the following steps:

1. Connecting to the data source. For further information, see Before you begin profiling data.

2. Defining one or more columns on which to carry out data profiling processes that will define the content,
structure and quality of the data included in the column(s).

3. Settings predefined system indicators or indicators defined by the user on the column(s) that need to be
analyzed or monitored. These indicators will represent the results achieved through the implementation of
different patterns.

4. Adding to the column analyses the patterns against which you can define the content, structure and quality
of the data.

For further information, see How to add a regular expression or an SQL pattern to a column analysis.

The Analyzing columns in a database explains the procedures to analyze the content of one or multiple columns
in a database.

The Analyzing data in a file explains the procedures to analyze columns in delimited or excel files.

14.2. Data mining types
When you create a column analysis in the studio, you can see a Datamining Type box next to each of the columns
you want to analyze. The selected type in the box represents the data mining type of the associated column.

These data mining types help the studio to choose the appropriate metrics for the associated column since not all
indicators (or metrics) can be computed on all data types.

Available data mining types are: Nominal, Interval, Unstructured Text and Other. The sections below describe
these data mining types.
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14.2.1. Nominal

Nominal data is categorical data which values/observations can be assigned a code in the form of a number where
the numbers are simply labels. You can count, but not order or measure nominal data.

In the studio, the mining type of textual data is set to nominal. For example, a column called WEATHER with the
values: sun, cloud and rain is nominal.

And a column called POSTAL_CODE that has the values 52200 and 75014 is nominal as well in spite of
the numerical values. Such data is of nominal type because it identifies a postal code in France. Computing
mathematical quantities such as the average on such data is non sense. In such a case, you should set the data
mining type of the column to Nominal, because there is currently no way in the studio to automatically guess the
correct type of data.

The same is true for primary or foreign-key data. Keys are most of the time represented by numerical data, but
their data mining type is Nominal.

14.2.2. Interval

This data mining type is used for numerical data and time data. Averages can be computed on this kind of data.
In databases, sometimes numerical quantities are stored in textual fields.

In the studio, it is possible to declare the data mining type of a textual column (e.g. a column of type VARCHAR)
as Interval. In that case, the data should be treated as numerical data and summary statistics should be available.

14.2.3. Unstructured text

This is a new data mining type introduced by the studio. This data mining type is dedicated to handle unstructured
textual data.

For example, the data mining type of a column called COMMENT that contains commentary text can not be
Nominal, since the text in it is unstructured. Still, we could be interested in seeing the duplicate values of such a
column and here comes the need for such a new data mining type.

14.2.4. Other

This is another new data mining type introduced in the studio. This type designs the data that the studio does not
know how to handle yet.

14.3. Analyzing columns in a database
You can analyze the content of one or multiple columns and execute the created analyses using the Java or the
SQL engine. This type of analysis provides statistics about the values within each column.

When you use the Java engine to run a column analysis, you can view the analyzed data according to parameters
you set yourself. For more information, see Using the Java or the SQL engine.

When you use the Java engine to run a column analysis on big sets or on data with many problems, it is advisable to define
a maximum memory size threshold to execute the analysis as you may end up with a Java heap error. For more information,
see Defining the maximum memory size threshold.
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You can also analyze a set of columns. This type of analysis provides statistics on the values across all the data
set (full records). For more information, see Analyzing tables in databases.

The sequence of analyzing a column involves the following steps:

1. Defining the column(s) to be analyzed.

For more information, see How to define the columns to be analyzed.

2. Settings predefined system indicators or indicators defined by the user for the column(s).

For more information, see How to set indicators for the column(s) to be analyzed. For more information on
indicator types and indicator management, see Indicators.

3. Adding the patterns against which to define the content, structure and quality of the data.

For more information, see Using regular expressions and SQL patterns in a column analysis. For more
information on pattern types and management, see Patterns.

The following sections provide a detailed description on each of the preceding steps.

14.3.1. Defining the columns to be analyzed and
setting indicators

14.3.1.1. How to define the columns to be analyzed

The first step in analyzing the content of one or multiple columns is to define the column(s) to be analyzed. The
analysis results provides statistics about the values within each column.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To analyze one or more columns, do the following:

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analysis folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. Expand the Column Analysis node and then click Column Analysis.

4. Click the Next button.
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5. In the Name field, enter a name for the current column analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

6. Set column analysis metadata (purpose, description and author name) in the corresponding fields and click
Next to proceed to the next step.

Selecting the column you want to analyze

1. Expand DB connections and in the desired database, browse to the columns you want to analyze, select them
and then click Finish to close the wizard.

When profiling a DB2 database, if double quotes exist in the column names of a table, the double quotation marks
cannot be retrieved when retrieving the column. Therefore, it is recommended not to use double quotes in column
names in a DB2 database table.

A file for the newly created column analysis is listed under the Analysis node in the DQ Repository tree
view, and the analysis editor opens with the defined analysis metadata.
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The display of the analysis editor depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

2. Click the Analyzed Columns tab to open the corresponding view.

You can drag the columns to be analyzed directly from the DQ Repository  tree view to the Analyzed
Columns list in the analysis editor.

3. Click the Select columns to analyze link to open a dialog box and select the columns you want to analyze.
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You can filter the table or column lists by typing letters or complete words in the Table filter  or Column
filter fields respectively. The lists will show only the tables/columns that correspond to the text you type in.

If one of the columns you want to analyze is a primary or a foreign key, its data mining type will automatically become
Nominal when you list it in the Analyzed Columns view. For more information on data mining types, see Data
mining types.

4. If required, change your database connection by selecting another connection from the Connection box. This
box lists all the connections created in the Studio with the corresponding database names.

If the columns listed in the Analyzed Columns view do not exist in the new database connection you want
to set, you will receive a warning message that enables you to continue or cancel the operation.

If you select to connect to a database that is not supported in the studio (using the ODBC or JDBC methods), it
is recommended to use the Java engine to execute the column analyses created on the selected database. For more
information on the java engine, see Using the Java or the SQL engine.

5. Click OK and then save the column analysis.

You can right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view to locate it in the database connection in the DQ Repository tree view.

When you select to analyze Date columns, it may happen that the analyzed data is more precise than what is stored
in the studio. Whatever the data source is, when analyzing Date columns, the date information is stored in the
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studio as regular date/time of format YYYY-MM-DD hh:mm:ss (for example, 2013-04-19 15:50:30) even when the
data is 2013-04-19 15:50:30.343454 in the source file.

14.3.1.2. How to set indicators for the column(s) to be analyzed

The second step after defining the column(s) to be analyzed is to set either system or user-defined indicators for
each of the defined columns.

How to set system indicators

Prerequisite(s): A column analysis is open in the analysis editor in the Profiling perspective of the studio. For
more information, see How to define the columns to be analyzed.

To set system indicators for the column(s) to be analyzed, do the following:

1. In the analysis editor, click Analyzed Columns to open the analyzed columns view.

You can right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view to locate the selected column under the corresponding connection in the tree view.

2. Click Select indicators for each column to open the [Indicator Selection] dialog box.
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In this dialog box, you can change column positions by dropping them with the cursor.

If you are analyzing very large number of columns, place the cursor in the top/bottom right corner of the
[Indicator Selection] dialog box to access the columns to the very right. Similarly, place the cursor in the
top/bottom left corner of the [Indicator Selection] dialog box to access the columns to the very left.

3. Click in the cells to set indicator parameters for the analyzed column(s) as needed and then click OK.

Indicators are accordingly attached to the analyzed columns in the Analyzed Columns view.

-It is not very useful to use Pattern Frequency Statistics on a column of a Date type in databases when executing
the analysis with the SQL engine. No data quality issues are returned by this indicator as all dates will be displayed
using one single format. For further information, check the article Why do we get 99-AAA-99 when profiling Date
columns in Oracle.

-If you attach the Date Pattern Frequency Table to a date column in your analysis, you can generate a date regular
expression from the analysis results. For more information, see How to generate a regular expression from the Date
Pattern Frequency Table.

4. Click the save icon on the toolbar of the analysis editor.

How to set options for system indicators

Prerequisite(s): A column analysis is open in the analysis editor in the Profiling perspective of the studio. For
more information, see How to define the columns to be analyzed.

https://help.talend.com/pages/viewpage.action?pageId=190513204
https://help.talend.com/pages/viewpage.action?pageId=190513204
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For more information about setting indicators, see How to set system indicators.

To set options for system indicators, do the following:

1. In the analysis editor, click Analyzed Columns to open the analyzed columns view.

2.
Click the option icon  next to the defined indicator to open the dialog box where you can set options for
the given indicator.

For example, if you want to flag if there are null values in the column you analyze, you can set 0 in the Upper
threshold field for the Null Count indicator.

Indicators settings dialog boxes differ according to the parameters specific for each indicator. For more
information about different indicator parameters, see Indicator parameters.

3. Set the parameters for the given indicator.

4. Click Finish to close the dialog box.

5. Click the save icon on the toolbar of the analysis editor.

How to set user-defined indicators

Prerequisite(s):

• A column analysis is open in the analysis editor in the Profiling perspective of the studio. For more information,
see How to define the columns to be analyzed.

• A user-defined indicator is created in the Profiling perspective of the studio. For more information, see How
to create SQL user-defined indicators.

To set user-defined indicators for the column(s) to be analyzed, do the following:

1. In the analysis editor, click Analyzed Columns to open the analyzed columns view.
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2. Either:

1.
In the Analyzed Columns view, click the  icon next to the column name to which you want to
define a user-defined indicator.

The [UDI selector] dialog box opens.
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2. Select the user-defined indicators you want to use on the column and then click OK to close the dialog
box.

Or:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. From the User Defined Indicator folder, drop the user-defined indicator(s) against which you want to
analyze the column content to the column name(s) in the Analyzed Columns view.

The user-defined indicator is listed under the column name

3. Click the save icon on the toolbar of the analysis editor.

14.3.2. Finalizing the column analysis before execution

After defining the column(s) to be analyzed and setting indicators, you may want to filter the data that you want
to analyze and decide what engine to use to execute the column analysis.

Prerequisite(s):

• The column analysis is open in the analysis editor in the Profiling perspective of the studio . For more
information, see How to define the columns to be analyzed.

• You have set system or predefined indicators for the column analysis. For more information, see How to set
indicators for the column(s) to be analyzed.

To finalize the column analysis defined in the above sections, do the following:

1. In the Data Filter view, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.

2. In the Analysis Parameters View:
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• In the Number of connections per analysis field, set the number of concurrent connections allowed per
analysis to the selected database connection.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

• From the Execution engine list, select the engine, Java or SQL, you want to use to execute the analysis.

If you select the Java engine:

-select the Allow drill down check box to be able to drill down, in the Analysis Results view, the results
of all indicators except Row Count.

-in the Max number of rows kept per indicator field, set the number of the data rows you want to drill
down.

For further information about these engines, see Using the Java or the SQL engine.

For further information about analysis results, see How to access analysis results and analyzed data.

3. If you have defined context variables in the Contexts view in the analysis editor:

• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.

• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

4. Save the analysis and press F6 to execute it.

A group of graphics is displayed in the Graphics panel to the right of the analysis editor, each corresponding
to the group of the indicators set for each analyzed column.

When you use the SQL engine, the analysis runs multiple indicators in parallel and results are refreshed in
the charts while the analysis is still in progress.

Below are the graphics representing the Frequency Statistics and Simple Statistics for the email column
analyzed in the above procedure.
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Below are the graphics representing the order of magnitude and the Benford's law frequency statistics for the
total_sales column analyzed in the above procedure.
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For further information about the Benford's law frequency statistics usually used as an indicator of accounting
and expenses fraud in lists or tables, see Benford's law frequency indicator.

For information on how to access a detailed view of the results of the analysis, see How to access the detailed
view of the analysis results.

If you execute this analysis using the Java engine and then select the Allow drill down check box in the Analysis
parameters view, you can store locally the analyzed data and thus access it in the Analysis Results > Data view.
You can use the Max number of rows kept per indicator field to decide the number of the data rows you want
to make accessible.

When you select the Java engine, the system will look for Java regular expressions first, if none is found, it looks
for SQL regular expressions.

If you select to connect to a database that is not supported in the studio (using the ODBC or JDBC methods), it is
recommended to use the Java engine to execute the column analyses created on the selected database. For more information
on the java engine, see Using the Java or the SQL engine.

If you execute this analysis using the SQL engine, you can view the executed query for each of the attached
indicators if you right-click an indicator and then select the View executed query option from the list. However,
when you use the Java engine, SQL queries will not be accessible and thus clicking this option will open a warning
message.
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For more information on the Java and the SQL engines, see Using the Java or the SQL engine.

14.3.3. Using the Java or the SQL engine

After setting the analysis parameters in the analysis editor, you can use either the Java or the SQL engine to execute
your analysis.

The choice of the engine can sometimes slightly change analysis results, for example when you select the summary
statistics indicators to profile a DB2 database. This is because indicators are computed differently depending on
the database type, and also because Talend uses special functions when working with Java.

SQL engine:

If you use the SQL engine to execute a column analysis:

• an SQL query is generated for each indicator used in the column analysis, the analysis runs multiple indicators
in parallel and results are refreshed in the charts while the analysis is still in progress,

• data monitoring and processing is carried on the DBMS,

• only statistical results are retrieved locally.

By using this engine, you guarantee system better performance. You can also access valid/invalid data in the data
explorer, for more information, see Viewing and exporting analyzed data.

Java engine:

If you use the Java engine to execute a column analysis:

• only one query is generated for all indicators used in the column analysis,

• all monitored data is retrieved locally to be analyzed,

• you can set the parameters to decide whether to access the analyzed data and how many data rows to show per
indicator. This will help to avoid memory limitation issues since it is impossible to store all analyzed data.
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When you execute the column analysis with the Java engine, you do not need different query templates specific
for each database. However, system performance is significantly reduced in comparison with the SQL engine.
Executing the analysis with the Java engine uses disk space as all data is retrieved and stored locally. If
you want to free up some space, you may delete the data stored in the main studio directory, at Talend-
Studio>workspace>project_name>Work_MapDB.

To set the parameters to access analyzed data when using the Java engine, do the following:

1. In the Analysis Parameter view of the column analysis editor, select Java from the Execution engine list.

2. Select the Allow drill down check box to store locally the data that will be analyzed by the current analysis.

This check box is usually selected by default.

3. In the Max number of rows kept per indicator field enter the number of the data rows you want to make
accessible.

This field is set to 50 by default.

You can now run your analysis and then have access to the analyzed data according to the set parameters. For
more information, see Viewing and exporting analyzed data.

14.3.4. Accessing the detailed view of the database
column analysis

Prerequisite(s): You have selected the Profiling perspective in the studio. A column analysis is defined and
executed.

To access a more detailed view of the analysis results of the procedures outlined in Defining the columns to be
analyzed and setting indicators and Finalizing the column analysis before execution, do the following:

1. Click the Analysis Results tab at the bottom of the analysis editor to open the corresponding view.

2. Click the Analysis Result  tab in the view and then the name of the analyzed column for which you want
to open the detailed results.

The display of the Analysis Results view depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

The detailed analysis results view shows the generated graphics for the analyzed columns accompanied with
tables that detail the statistic results.

Below are the tables that accompany the Frequency and Simple Statistics graphics in the Analysis Results
view for the analyzed email column.
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In the Simple Statistics table, if an indicator value is displayed in red, this means that a threshold has been set
on the indicator in the column analysis editor and that this threshold has been violated. For further information
about data thresholds, see How to set options for system indicators.

Below are the tables and the graphics representing the order of magnitude and the Benford's law frequency
statistics in the Analysis Results view for the analyzed total_sales column.
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For further information about the Benford's law frequency statistics usually used as an indicator of accounting
and expenses fraud in lists or tables, see Benford's law frequency indicator.

3. Right-click any data row in the result tables and select View rows to access a view of the analyzed data.

For more information, see Viewing and exporting analyzed data.

14.3.5. Viewing and exporting analyzed data

After running your analysis using the SQL or the Java engine and from the Analysis Results view of the analysis
editor, you can right-click any of the rows in the statistic result tables and access a view of the actual data.

After running your analysis using the Java engine, you can use the analysis results to access a view of the actual
data.

After running your analysis using the SQL engine, you can use the analysis results to open the Data Explorer
perspective and access a view of the actual data.
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Prerequisite(s):You have selected the Profiling perspective in the studio. A column analysis has been created
and executed.

To view and export the analyzed data, do the following:

1. At the bottom of the analysis editor, click the Analysis Results tab to open a detailed view of the analysis
results.

2. Right-click a data row in the statistic results of the analyzed columns and select an option as the following:

Option Operation

View rows open a view on a list of all data rows in the analyzed column.

For the Duplicate Count indicator, the View rows option will list all the rows
that are duplicated. So if the duplicate count is 12 for example, this option will
list 24 rows.

View values open a view on a list of the actual data values of the analyzed column.

Options other than the above listed ones are available when using regular expressions and SQL patterns in a column analysis.
For further information, see Using regular expressions and SQL patterns in a column analysis and How to view the data
analyzed against patterns.

When using the SQL engine, the view opens in the Data Explorer perspective listing the rows or the values of
the analyzed data according to the limits set in the data explorer.

If the Data Explorer perspective is missing from the studio, you must install certain SQL explorer libraries that
are required for data quality to work correctly, otherwise you may get an error message.

For further information about identifying and installing external modules, see Talend Installation and Upgrade
Guide.
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This explorer view will give also some basic information about the analysis itself. Such information is of great
help when working with multiple analysis at the same time.

The data explorer does not support connections which has empty user name, such as Single sign-on of MS SQL Server.
If you analyze data using such connection and you try to view data rows and values in the Data Explorer perspective, a
warning message prompt you to set your connection credentials to the SQL Server.

When using the Java engine, the view opens in the studio listing the number of the analyzed data rows you set in
the Analysis parameters view of the analysis editor. For more information, see Using the Java or the SQL engine.

From this view, you can export the analyzed data into a csv file. To do that:

1.
Click the  icon in the upper left corner of the view.

A dialog box opens.
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2. Click the Choose... button and browse to where you want to store the csv file and give it a name.

3. Click OK to close the dialog box.

A csv file is created in the specified place holding all the analyzed data rows listed in the view.

14.3.6. Using regular expressions and SQL patterns in
a column analysis

You can use regular expressions or SQL patterns in column analyses. These expressions and patterns will help
you define the content, structure and quality of the data included in the analyzed columns.

For more information on regular expressions and SQL patterns, see Patterns and indicators and Table analyses.

14.3.6.1. How to add a regular expression or an SQL pattern to a
column analysis

You can add to any column analysis one or more regular expressions or SQL patterns against which you can match
the content of the column to be analyzed.

If the database you are using does not support regular expressions or if the query template is not defined in the studio, you
need first to declare the user defined function and define the query template before being able to add any of the specified
patterns to the column analysis. For more information, see Managing User-Defined Functions in databases.
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Prerequisite(s): You have selected the Profiling perspective in the studio. A column analysis is open in the
analysis editor.

To add a regular expression or an SQL pattern to a column analysis, do the following:

1. Follow the steps outlined in How to define the columns to be analyzed to create a column analysis.

2. In the open analysis editor, click Analyze Columns to open the analyzed columns view.

You can right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view to locate the selected column under the corresponding connection in the tree view.

3.
Click the  icon next to the column name to which you want to add a regular expression or an SQL pattern,
the email column in this example.

The [Pattern Selector] dialog box opens.
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4. Expand Patterns and browse to the regular expression or/and the SQL patterns you want to add to the column
analysis.

5. Select the check box(es) of the expression(s) or pattern(s) you want to add to the selected column.

6. Click OK to proceed to the next step.

The added regular expression(s) or SQL pattern(s) are displayed under the analyzed column in the Analyzed
Column list.

You can add a regular expression or an SQL pattern to a column simply by a drag and drop operation from the DQ
Repository tree view onto the analyzed column.

7. Click the save icon on the toolbar of the analysis editor and then press F6 to execute the column analysis.

A group of graphics is displayed in the Graphics panel to the right of the analysis editor. These graphics
show the results of the column analysis including those for pattern matching.

14.3.6.2. How to edit a pattern in the column analysis

Prerequisite(s): You have selected the Profiling perspective in the studio. A column analysis is open in the
analysis editor.

To edit a pattern added to an analyzed column:

1. Click Analyze Columns to open the analyzed columns view.

2. Right-click the pattern you want to edit and select Edit pattern from the contextual menu.
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The pattern editor opens showing the selected pattern metadata.
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3. In the pattern editor, click Pattern Definition to edit the pattern definition, or change the selected database,
or add other patterns specific to available databases using the [+] button.

4. On the toolbar, click the save icon to save your changes.

If the regular pattern is simple enough to be used in all databases, select Default in the list.

When you edit a pattern through the analysis editor, you modify the pattern listed in the DQ Repository tree view. Make
sure that your modifications are suitable for all other analyses that may be using the pattern modified.

14.3.6.3. How to view the data analyzed against patterns

When you add one or more patterns to an analyzed column, you check all existing data in the column against the
specified pattern(s). After the execution of the column analysis, using the java or the SQL engine you can access
a list of all the valid/invalid data in the analyzed column.

When you use the Java engine to run the analysis, the view of the actual data will open in the studio. While if you use the
SQL engine to execute the analysis, the view of the actual data will open in the Data Explorer perspective.

Prerequisite(s): You have selected the Profiling perspective in the studio. A column analysis that uses patterns
has been created and executed.

To be able to use Data Explorer in the studio, you must install certain SQL explorer libraries that are required for
data quality. If you do not install these libraries, the Data Explorer perspective will be missing from the studio
and many features will not be available.

For further information about identifying and installing external modules, see Talend Installation and Upgrade
Guide.

To view the actual data in the column analyzed against a specific pattern, do the following:

1. Follow the steps outlined in How to define the columns to be analyzed and How to add a regular expression
or an SQL pattern to a column analysis to create a column analysis that uses a pattern.

2. Execute the column analysis.

3. In the analysis editor, click the Analysis Results tab at the bottom of the editor to open the corresponding
view.

The display of the Analysis Results view depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.
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4. Click Pattern Matching under the name of the analyzed column.

The generated graphic for the pattern matching is displayed accompanied with a table that details the matching
results.

5. Right-click the pattern line in the Pattern Matching table and select:

Option To...

View valid/invalid values open a view of all valid/invalid values measured against the pattern used on the selected
column

View valid/invalid rows open a view of all valid/invalid rows measured against the pattern used on the selected
column

When using the SQL engine, the view opens in the Data Explorer perspective listing valid/invalid rows or values
of the analyzed data according to the limits set in the data explorer.
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This explorer view will also give some basic information about the analysis itself. Such information is of great
help when working with multiple analysis at the same time.

The data explorer does not support connections which has empty user name, such as Single sign-on of MS SQL Server.
If you analyze data using such connection and you try to view data rows and values in the Data Explorer perspective, a
warning message prompt you to set your connection credentials to the SQL Server.

When using the Java engine, the view opens in the Profiling perspective of the studio listing the number of valid/
invalid data according to the row limit you set in the Analysis parameters view of the analysis editor. For more
information, see Using the Java or the SQL engine.

You can save the executed query and list it under the Libraries > Source Files folders in the DQ Repository tree view if
you click the save icon on the SQL editor toolbar. For more information, see Saving the queries executed on indicators.

For more information about the data explorer Graphical User Interface, see Main window of the data explorer.

14.3.7. Saving the queries executed on indicators

From the studio and in the Data Explorer perspective, you can view the queries executed on different indicators
used in an analysis. From the data explorer, you will be able to save the query and list it under the Libraries >
Source Files folders in the DQ Repository tree view.

Prerequisite(s): You have selected the Profiling perspective in the studio. At least one analysis with indicators
has been created.

To save any of the queries executed on an indicator set in a column analysis, do the following:

1. In the column analysis editor, right-click any of the used indicators to open a contextual menu.
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2. Select View executed query to open the data explorer on the query executed on the selected indicator.

If the Data Explorer perspective is missing from the studio, you must install certain SQL explorer libraries
that are required for data quality to work correctly, otherwise you may get an error message.

For further information about identifying and installing external modules, see Talend Installation and
Upgrade Guide.

The data explorer does not support connections which has empty user name, such as Single sign-on of MS SQL Server.
If you analyze data using such connection and you try to view the executed queries in the Data Explorer perspective,
a warning message prompt you to set your connection credentials to the SQL Server.

3. Click the save icon on the editor toolbar to open the [Select folder] dialog box
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4. Select the Source Files folder or any sub-folder under it and enter in the Name field a name for the open query.

Make sure that the name you give to the open query is always followed by .sql. Otherwise, you will not be able to
save the query.

5. Click OK to close the dialog box.

The selected query is saved under the selected folder in the DQ Repository tree view.

14.3.8. Creating analyses from table or column names

In the studio, you can use simplified ways to create one or multiple column analyses. All what you need to do is
to start from the table name or the column name under the relevant DB Connection folder in the DQ Repository
tree view.

However, the options you have to create column analyses if you start from the table name are different from those
you have if you start from the column name.

To create a column analysis directly from the relevant table name in the DB Connection, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Browse to the table that holds the column(s) you want to analyze and right-click it.

3. From the contextual menu, select:

Item To...
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Match analysis open the match analysis editor where you can define match rules and select the columns
on which you want to use the match rules.

For more information see Analyzing duplicates.

Table analysis analyze the selected table using SQL business rules.

For more information on the Simple Statistics indicators, see Simple statistics.

Column analysis analyze all the columns included in the selected table using the Simple Statistics
indicators.

For more information on the Simple Statistics indicators, see Simple statistics.

Pattern frequency analysis analyze all the columns included in the selected table using the Pattern Frequency
Statistics along with the Row Count and the Null Count indicators.

For more information on the Pattern Frequency Statistics, see Pattern frequency statistics.

The above steps replace the procedures outlined in Defining the columns to be analyzed and setting indicators.
Then you proceed following the steps outlined in Finalizing the column analysis before execution.

To create a column analysis directly from the column name in the DB Connection, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Browse to the column(s) you want to analyze and right-click it/them.

3. From the contextual menu, select:

Item To...

Analyze create an analysis for the selected column

you must later set the indicators you want to use to analyze the selected column.

For more information on setting indicators, see How to set indicators for the column(s) to
be analyzed. For more information on accomplishing the column analysis, see Finalizing
the column analysis before execution.

Nominal value analysis analyze minimal correlations between nominal columns in the same table and gives the
result in a chart.

For more information, see Nominal correlation analyses.

Simple analysis analyze the selected column using the Simple Statistics indicators.

For more information on the Simple Statistics indicators, see Simple statistics.

Pattern frequency analysis analyze the selected column using the Pattern Frequency Statistics along with the Row
Count and the Null Count indicators.

For more information on the Pattern Frequency Statistics, see Pattern frequency statistics.

Analyze column set perform an analysis on the content of a set of columns. This analysis focuses on a column
set (full records) and not on separate columns as it is the case with the column analysis.

For more information, see Creating a simple table analysis: the analysis of a set of
columns.

Analyze correlation perform column correlation analyses between nominal and interval columns or nominal
and date columns in database tables.

For more information, see Numerical correlation analyses.

Analyze matches open the match analysis editor where you can define match rules and select the columns
on which you want to use the match rules.

For more information see Analyzing duplicates.

The above steps replace one of or both of the procedures outlined in Defining the columns to be analyzed and
setting indicators. Now, you proceed following the same steps outlined in Finalizing the column analysis before
execution.
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14.4. Analyzing data in a file
You can create a column analysis on a delimited file and execute the created analyses using the Java engine.

From the studio, you can also analyze a set of columns, for more information, see Analyzing tables in delimited
files.

14.4.1. Analyzing columns in a delimited file

The sequence of profiling data in a delimited file involves the following steps:

1. defining the columns to be analyzed.

For more information, see How to define the columns to be analyzed.

2. settings predefined system indicators for the defined columns.

For more information, see How to set indicators for the column(s) to be analyzed. For more information on
indicator types and indicator management, see Indicators.

3. setting patterns for the defined columns. For more information, see Patterns.

You can also use Java user-defined indicators when analyzing columns in a delimited file on the condition that a Java user-
defined indicator is already created. For further information, see How to define Java user-defined indicators.

The following sections provide a detail description on each of the preceding steps.

14.4.1.1. How to define the columns to be analyzed

The first step in analyzing the content of a delimited file is to define the columns to be analyzed.

Prerequisite(s): At least one connection to a delimited file is set in the Profiling perspective of the studio. For
further information, see How to connect to a delimited file.

Defining the analysis

1. In the DQ Repository tree view, expand the Data Profiling folder.

2. Right-click the Analysis folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. Expand the Column Analysis folder and click Column Analysis.

4. Click the Next button to proceed to the next step.
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You can directly get to this step in the analysis creation wizard if you right-click the column to analyze in Metadata
> FileDelimited and select Column Analysis > Analyze. For further information, see Creating analyses from table
or column names.

5. In the Name field, enter a name for the current column analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

6. If required, set the analysis metadata (purpose, description and author name) in the corresponding fields and
click Next to proceed to the next step.

Selecting the columns in the delimited file

1. Expand FileDelimited and then browse to the columns you want to analyze.

2. Select these columns and then click Finish to close the wizard.

A file for the newly created analysis is displayed under the Analyses node in the DQ Repository tree view,
and the analysis editor opens with the defined analysis metadata.
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The display of the connection editor depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

3. Click Analyzed Columns to display the Analyzed Columns view.

You can also drop the columns to analyze directly from the DQ Repository tree view to the analysis editor.

The Connection field shows the selected connection and the columns you want to analyze are already listed
in the column list.

4. If required, click the Select columns to analyze link to open a dialog box where you can modify your column
selection.

In this example, you want to analyze the id, first_name and age columns from the selected connection.

5. If required, use the delete, move up or move down buttons to manage the analyzed columns.

6. Click the save icon on the toolbar of the analysis editor.
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You can right-click any of the listed columns in the Analyzed Columns table and select Show in DQ
Repository view to locate the selected column under the corresponding delimited file connection in the tree
view.

When you select to analyze Date columns, it may happen that the analyzed data is more precise than what is stored
in the studio. Whatever the datasource is, when analyzing Date columns, the date information is stored in the
studio as regular date/time of format YYYY-MM-DD hh:mm:ss (for example, 2013-04-19 15:50:30) even when the
data is 2013-04-19 15:50:30.343454 in the source file.

14.4.1.2. How to set system indicators for the columns to be
analyzed

The second step after defining the columns to be analyzed is to set statistics indicators for each of the defined
columns.

You can also use Java user-defined indicators when analyzing columns in a delimited file on the condition that a Java user-
defined indicator is already created. For further information, see How to define Java user-defined indicators.

Prerequisite(s): An analysis of a delimited file is open in the analysis editor in the Profiling perspective of the
studio. For more information, see How to define the columns to be analyzed.

To set system indicators for the column(s) to be analyzed, do the following:

1. Follow the procedure outlined in How to define the columns to be analyzed.

2. In the analysis editor, click Analyzed Columns to open the analyzed columns view.

3. Click Select indicators for each column to open the [Indicator Selection] dialog box.
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In this dialog box, you can change column positions by dropping them with the cursor.

4. If you are analyzing very large number of columns, place the cursor in the top/bottom right corner of the
[Indicator Selection] dialog box to access the columns to the very right.

Similarly, place the cursor in the top/bottom left corner of the [Indicator Selection] dialog box to access
the columns to the very left.

5. Click in the cells to set indicator parameters for the columns to be analyzed and then click OK to proceed
to the next step.

In this example, you want to set the Simple Statistics indicators on all columns, the Text Statistics indicators
on the first_name column and the Soundex Frequency Table on the first_name column as well.

You can set the text statistics indicators on a column only if its data mining type is set to nominal. Otherwise, these
indicators will be grayed out in the [Indicator Selection] dialog box.

The selected indicators are attached to the analyzed columns in the Analyzed Columns view.
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6. Click the save icon on the toolbar of the analysis editor.

14.4.1.3. How to set options for system indicators

Prerequisite(s): An analysis of a delimited file is open in the analysis editor in the Profiling perspective of the
studio. For more information, see How to define the columns to be analyzed, How to set indicators for the column(s)
to be analyzed.

To set options for system indicators used on the columns to be analyzed, do the following:

1. Follow the procedures outlined in How to define the columns to be analyzed and How to set indicators for
the column(s) to be analyzed.

2. In the analysis editor, click Analyzed Columns to open the analyzed columns view.

3.
In the Analyzed Columns list, click the option icon  next to the indicator to open the dialog box where
you can set options for the given indicator.

Indicators settings dialog boxes differ according to the parameters specific for each indicator. For more information
about different indicator parameters, see Indicator parameters.

4. Set the parameters for the given indicator.

5. Click Finish to close the dialog box.

6. Click the save icon on the toolbar of the analysis editor.
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14.4.1.4. How to set regular expressions and finalize the analysis

You can add one or more regular expressions to one or more of the analyzed columns.

Prerequisite(s): An analysis of a delimited file is open in the analysis editor in the Profiling perspective of the
studio. For more information, see How to define the columns to be analyzed, How to set indicators for the column(s)
to be analyzed and How to set options for system indicators.

To set regular expressions to the analyzed columns, do the following:

1. Define the regular expression you want to add to the analyzed column. For further information on creating
regular expressions, see How to create a new regular expression or SQL pattern.

In this example, the regular expression checks for all words that start with uppercase.

2. Add the regular expression to the analyzed column in the open analysis editor, the first_name column in
this example. For further information, see How to add a regular expression or an SQL pattern to a column
analysis.
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3. Click the save icon on the toolbar of the analysis editor and then press F6 to execute the analysis.

If the format of the file you are using has problems, you will have an error message to indicate which row causes
the problem.

The Graphics panel to the right of the analysis editor displays a group of graphic(s), each corresponding to
one of the analyzed columns.

4. If you analyze more than one column, navigate through the different pages in the Graphics panel using the
toolbar on the upper-right corner in order to view the different graphics associated with all analyzed columns.

Below is a sample of the graphical results of one of the analyzed columns: first_name.

In order to view detail results of the analyzed columns, see How to access the detailed view of the analysis results.

14.4.1.5. How to access the detailed view of the file analysis

Prerequisite(s): An analysis of a delimited file is defined and executed in the Profiling perspective of the studio.
For more information, see Analyzing columns in a delimited file.
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To access a more detailed view of the analysis results, do the following:

1. Click the Analysis Results tab at the bottom of the analysis editor to open the corresponding view.

2. Click Analysis Result and then the name of the analyzed column for which you want to display the detailed
results.

The display of the Analysis Results view depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

The detailed analysis results view shows the generated graphics for the analyzed columns accompanied with tables
that detail the statistic results.

Below are the tables that accompany the statistics graphics in the Analysis Results view for the analyzed
first_name column in the procedure outlined in Analyzing columns in a delimited file.
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14.4.1.6. How to view and export the analyzed data in a file

After running your file analysis using the Java engine and from the Analysis Results view of the analysis editor,
you can right-click any of the rows in the statistic result tables and access a view of the actual data.

Prerequisite(s): A file analysis has been created and executed.

To view and export the analyzed data, do the following:

1. At the bottom of the analysis editor, click the Analysis Results tab to open a detailed view of the analysis
results.

2. Right-click a data row in the statistic results of any of the analyzed columns and select an option as the
following:

Option Operation

View rows open a view on a list of all data rows in the analyzed column.

For the Duplicate Count indicator, the View rows option will list all the rows
that are duplicated. So if the duplicate count is 12 for example, this option will
list 24 rows.

View values open a view on a list of the actual data values of the analyzed column.

For Pattern Matching results, select an option as the following:

Option Operation

View valid/invalid rows open a view on a list of all valid/invalid rows measured against a pattern.
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Option Operation

View valid/invalid values open a view on a list of all valid/invalid values measured against a pattern.

From this view, you can export the analyzed data into a csv file. To do that:

1.
Click the  icon in the top left corner of the view.

A dialog box opens.

2. Click the Choose... button and browse to where you want to store the csv file and give it a name.

3. Click OK to close the dialog box.

A csv file is created in the specified place holding all the analyzed data rows listed in the view.

14.4.1.7. How to analyze delimited data in shortcut procedures

You can profile data in a delimited file using a simplified way. All what you need to do is to start from the column
name under Metadata > FileDelimited folders in the DQ Repository tree view.

For further information, see Creating analyses from table or column names.

14.4.2. Analyzing columns in an excel file
You can analyze data in an excel file and execute the created analyses using the Java engine.
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Profiling excel files is done via ODBC for the time being. In later releases, you will be able to analyze excel files directly
as you do with delimited files.

Prerequisite(s): At least one connection to an excel file is set in the Profiling perspective of the studio. For further
information, see How to connect to an Excel file.

To set up an ODBC connection to a Data Source, do the following:

1. In the DQ Repository tree view, expand Metadata, and then right-click DB connections.

The connection wizard is displayed.

2. In the Name field, enter a name for the connection.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

3. If required, fill in a purpose and a description for the connection, and then click Next to proceed to the next
step.
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4. From the DB Type list, select Generic ODBC.

5. In the DataSource field, enter the exact name of the Data Source you created in the previous procedure.

6. Click the Check button to display a confirmation message about the status of the connection.

7. If your connection is successful, click OK to close the message, and then click Finish to close the wizard.

8. The connection is listed under DB connections in the DQ Repository tree view and the connection editor
opens in the Studio.
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If you have difficulty retrieving the columns from the excel file, give the worksheet in the excel file the same name of
the table. To do that, select the whole table in the excel file and then press Ctrl + F3 and modify the name.

You can now create a column analysis in the Profiling perspective of the studio to profile the columns in the
excel file.

The procedures to analyze columns in an excel file are exactly the same as those for analyzing columns in a
delimited file. For further information on analyzing columns in an excel files, see Analyzing columns in a delimited
file and How to access the detailed view of the analysis results.

Make sure to select the Java engine in the Analysis Parameter view in the analysis editor before executing the analysis of
the excel columns, otherwise you will have an error message when running the analysis.
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Chapter 15. Table analyses
This chapter provides all the information you need to perform table analyses on databases and delimited files.

It describes how to set up SQL business rules based on WHERE clauses and add them as indicators to database
table analyses.
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15.1. Steps to analyze a table
You can examine the data available in single tables of a database and collect information and statistics about this
data.

The sequence of profiling data in one or multiple tables may involve the following steps:

1. Defining one or more tables on which to carry out data profiling processes that will define the content,
structure and quality of the data included in the table(s).

2. Creating SQL business rules based on WHERE clauses and add them as indicators to table analyses.

3. Creating column functional dependencies analyses to detect anomalies in the column dependencies of the
defined table(s) through defining columns as either "determinant" or "dependent".

Check Analyzing tables in databases for information about the different options to analyze a table.

15.2. Analyzing tables in databases
Table analyses can range from simple table analyses to table analyses that uses SQL business rules or table analyses
that detect anomalies in the table columns.

Using the studio, you can better explore the quality of data in a database table through either:

• Creating a simple table analysis through analyzing all columns in the table using patterns. For more information,
see Creating a simple table analysis: the analysis of a set of columns.

• Adding data quality rules as indicators to table analysis. For more information, see Creating a table analysis
with SQL business rules.

• Detecting anomalies in column dependencies. For more information, see Detecting anomalies in the table
columns: column functional dependency analysis.

The sections below explain in detail all types of analysis that can be executed against tables.

15.2.1. Creating a simple table analysis: the analysis of
a set of columns

You can analyze the content of a set of columns. This set can represent only some of the columns in the defined
table or the table as a whole.

The analysis of a set of columns focuses on a column set (full records) and not on separate columns as it is the case
with the column analysis. The statistics presented in the analysis results (row count, distinct count, unique count
and duplicate count) are measured against the values across all the data set and thus do not analyze the values
separately within each column.

With the Java engine, you may also apply patterns on each column and the result of the analysis will give the
number of records matching all the selected patterns together. For further information, see How to add patterns
to the analyzed columns.

When you use the Java engine to run a column set analysis on big sets or on data with many problems, it is advisable to define
a maximum memory size threshold to execute the analysis as you may end up with a Java heap error. For more information,
see Defining the maximum memory size threshold.
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15.2.1.1. How to create an analysis of a set of columns using
patterns

This type of analysis provides simple statistics on the full records of the analyzed column set and not on the values
within each column separately. For more information about simple statistic indicators, see Simple statistics.

With this analysis, you can use patterns to validate the full records against all patterns and have a single-bar result
chart that shows the number of the rows that match "all" the patterns..

How to define the set of columns to be analyzed

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To define the set of columns to analyzed, do the following:

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. Expand the Table Analysis node and then click Column Set Analysis.

4. Click the Next button.
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5. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

6. Set column analysis metadata (purpose, description and author name) in the corresponding fields and then
click Next.
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Selecting the set of columns you want to analyze

1. Expand DB connections.

2. In the desired database, browse to the columns you want to analyze, select them and then click Finish to
close this [New analysis] wizard.

A folder for the newly created analysis is listed under Analysis in the DQ Repository tree view, and the
analysis editor opens with the defined analysis metadata.

The display of the analysis editor depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

3. In the Analyzed Columns view, click the Select columns to analyze link to open a dialog box where you
can modify your table or column selection.
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If you select to connect to a database that is not supported in the studio (using the ODBC or JDBC methods), it
is recommended to use the Java engine to execute the column analyses created on the selected database. For more
information on the Java engine, see Using the Java or the SQL engine.

4. Either:

• expand the DB Connections folder and browse through the catalog/schemas to reach the table holding the
columns you want to analyze, or,

• filter the table or column lists by typing the desired text in the Table filter  or Column filter fields
respectively. The lists will show only the tables/columns that correspond to the text you type in.

As this analysis retrieves as many rows as the number of distinct rows in order to compute the statistics, it is advised
to avoid selecting a primary key column.

In this example, you want to analyze a set of six columns in the customer table: account number
(account_num), education (education), email (email), first name (fname), second name (Iname) and gender
(gender). you want to identify the number of rows, the number of distinct and unique values and the number
of duplicates.

5. Click the table name to list all its columns in the right-hand panel of the [Column Selection] dialog box.

6. In the column list, select the check boxes of the column(s) you want to analyze and click OK.

The selected columns is displayed in the Analyzed Column view of the analysis editor.
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7. If required, select to connect to a different database by selecting a different connection from the Connection
box. This box lists all the connections created in the Studio with the corresponding database names.

If the columns listed in the Analyzed Columns view do not exist in the new database connection you want
to set, you will receive a warning message that enables you to continue or cancel the operation.

8. If required, right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view. The selected column is automatically located under the corresponding connection in the
tree view.

9. Use the delete, move up or move down buttons to manage the analyzed columns when necessary.

How to add patterns to the analyzed columns

You can add patterns to one or more of the analyzed columns to validate the full record (all columns) against all
the patterns, and not to validate each column against a specific pattern as it is the case with the column analysis.
The results chart is a single bar chart for the totality of the used patterns. This chart shows the number of the rows
that match "all" the patterns.

Before being able to use a specific pattern with a set of columns analysis, you must manually set the pattern definition
for Java in the pattern settings, if it does not already exist. Otherwise, a warning message opens prompting you to set the
definition of the Java regular expression.

Prerequisite(s): An analysis of a set of columns is open in the analysis editor in the Profiling perspective of the
studio. For more information, see How to define the set of columns to be analyzed.

To add patterns to the analysis of a set of columns, do the following:

1.
Click the  icon next to each of the columns you want to validate against a specific pattern.

The [Pattern Selector] dialog box is displayed.
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You can add only regular expressions to the analyzed columns.

You can drop the regular expression directly from the Patterns folder in the DQ Repository tree view directly to the
column name in the column analysis editor.

If no Java expression exists for the pattern you want to add, a warning message opens prompting you to add the
pattern definition for Java. Click Yes to open the pattern editor and add the Java regular expression, then proceed
to add the pattern to the analyzed columns.

In this example, you want to add a corresponding pattern to each of the analyzed columns to validate data in
these columns against the selected patterns. The result chart will show the percentage of the matching/non-
matching values, the values that respect the totality of the used patterns.

2. In the [Pattern Selector] dialog box, browse to the regular expression you want to add to the selected column.

3. Select the check box(es) of the expression(s) you want to add to the selected column.

4. Click OK.

The added regular expression(s) are displayed under the analyzed column(s) in the Analyzed Columns list,
and the All Match indicator is displayed in the Indicators list in the Indicators view.
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How to finalize and execute the analysis of a set of columns

What is left before executing this set of columns analysis is to define indicators, data filter and analysis parameters.

Prerequisite(s): A column set analysis has already been defined in the Profiling perspective of the studio. For
further information, see How to define the set of columns to be analyzed and How to add patterns to the analyzed
columns.

1. Click Indicators in the analysis editor to open the corresponding view.
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The indicators representing the simple statistics are by-default attached to this type of analysis. For further
information about the indicators for simple statistics, see section Simple statistics.

2.
Click the option icon  to open a dialog box where you can set options for each indicator according to
your needs.

For more information about indicators management, see Indicators.

3. In the Data Filter view, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.

4. In the Analysis Parameters view:

• In the Number of connections per analysis field, set the number of concurrent connections allowed per
analysis to the selected database connection.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

• From the Execution engine list, select the engine, Java or SQL, you want to use to execute the analysis.

-If you select the Java engine, the Store data check box is selected by default and cannot be unselected.
Once the analysis is executed, the profiling results are always available locally to drill down through the
Analysis Results > Data view. For further information, see How to access analysis results and analyzed
data and How to filter data against patterns.
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Executing the analysis with the Java engine uses disk space as all data is retrieved and stored locally. If
you want to free up some space, you may delete the data stored in the main studio directory, at Talend-
Studio>workspace>project_name>Work_MapDB.

-If you select the SQL engine, you can use the Store data check box to decide whether to store locally
the analyzed data and access it in the Analysis Results > Data view. For further information, see How to
access analysis results and analyzed data.

If the data you are analyzing is very big, it is advisable to leave the Store data check box unselected in order not
to store the results at the end of the analysis computation.

5. If you have defined context variables in the Contexts view in the analysis editor:

• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.

• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

6. Save the analysis and press F6 to execute it.

The graphical result of the set of columns analysis is displayed in the Graphics  panel to the right of the
analysis editor.

This graphical result provides the simple statistics on the full records of the analyzed column set and not on
the values within each column separately.

When you use patterns to match the content of the set of columns, another graphic is displayed to illustrates
the match and non-match results against the totality of the used patterns.
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How to access analysis results and analyzed data

Prerequisite(s): An analysis of a set of columns is open in the analysis editor in the Profiling perspective of the
studio. For more information, see How to define the set of columns to be analyzed and How to add patterns to
the analyzed columns.

To access a more detailed view of the analysis results:

1. Click the Analysis Results tab at the bottom of the analysis editor.

The corresponding view is displayed. Here you can read the analysis results in tables and graphics.
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2. In the Simple Statistics table, right-click an indicator result and select View Rows or View Values.

• If you run the analysis with the Java engine, a list of the analyzed data is opened in the Profiling perspective.

• If you run the analysis with the SQL engine, a list of the analyzed data is opened in the Data Explorer
perspective.

3. In the Data view, click Filter Data to filter the valid/invalid data according to the used patterns.

You can filter data only when you run the analysis with the Java engine. For further information, see How
to filter data against patterns.

How to filter data against patterns

After analyzing a set of columns against a group of patterns and having the results of the rows that match or do
not match "all" the patterns, you can filter the valid/invalid data according to the used patterns.
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Prerequisite(s): An analysis of a set of columns is open in the analysis editor in the Profiling perspective of the
studio. You have used the Java engine to execute the analysis.

For more information, see How to define the set of columns to be analyzed and How to add patterns to the analyzed
columns.

To filter data resulted from the analysis of a set of columns, do the following:

1. In the analysis editor, click the Analysis Results tab at the bottom of the editor to open the detailed result view.

2. Click Data to open the corresponding view.

A table lists the actual analyzed data in the analyzed columns.

3. Click Filter Data on top of the table.

A dialog box is displayed listing all the patterns used in the column set analysis.

4. Select the check box(es) of the pattern(s) according to which you want to filter data.

5. Select a display option as the following:

Select To...

All data show all analyzed data.
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matches show only the data that matches the selected pattern.

non-matches show the data that does not match the selected pattern(s).

6. Click Finish to close the dialog box.

In this example, data is filtered against the Email Address pattern, and only the data that does not match is
displayed.

All email addresses that do not match the selected pattern appear in red. Any data row that has a missing
value appear with a red background.

15.2.1.2. How to create a column analysis from a simple table
analysis

You can create a column analysis on one or more columns defined in a simple table analysis (column set analysis).

Prerequisite(s): A simple table analysis is defined in the analysis editor in the Profiling perspective of the studio.

To create a column analysis on one or more columns defined in a simple table analysis, do the following:

1. Open the simple table analysis.

2. In the Analyzed Columns view, right-click the column(s) you want to create a column analysis on.
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3. Select Column analysis from the contextual menu.

The [New Analysis] wizard opens.

4. In the Name field, enter a name for the new column analysis and then click Next to proceed to the next step.

The analysis editor opens with the defined metadata and a folder for the newly created analysis is listed under
the Analyses folder in the DQ Repository tree view.

5. Follow the steps outlined in Analyzing columns in a database to continue creating the column analysis.

15.2.2. Creating a table analysis with SQL business
rules

You can set up SQL business rules based on WHERE clauses and add them as indicators to table analyses. You
can as well define expected thresholds on the SQL business rule indicator's value. The range defined is used for
measuring the quality of the data in the selected table.

It is also possible to create an analysis with SQL business rules on views in a database. The procedure is exactly the same
as that for tables. For more information, see How to create a table analysis with an SQL business rule with a join condition.

When you use the Java engine to run a column set analysis on big sets or on data with many problems, it is advisable to define
a maximum memory size threshold to execute the analysis as you may end up with a Java heap error. For more information,
see Defining the maximum memory size threshold.
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15.2.2.1. How to create an SQL business rule

SQL business rules can be simple rules with WHERE clauses. They can also have join conditions in them to
combine common values between columns in database tables and give a result data set.

For an example of a table analysis with a simple business rule, see How to create a table analysis with a simple
SQL business rule. For an example of a table analysis with a business rule that has a join condition, see How to
create a table analysis with an SQL business rule with a join condition.

Creating the business rule

1. In the DQ Repository tree view, expand Libraries > Rules.

2. Right-click SQL.

3. From the contextual menu, select New Business Rule to open the [New Business Rule] wizard.
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Consider as an example that you want to create a business rule to match the age of all customers listed in the
age column of a defined table. You want to filter all the age records to identify those that fulfill the specified
criterion.

4. In the Name field, enter a name for this new SQL business rule.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

5. Set other metadata (purpose, description and author name) in the corresponding fields and then click Next.

6. In the Where clause field, enter the WHERE clause to be used in the analysis.

In this example, the WHERE clause is used to match the records where customer age is greater than 18.

7. Click Finish to close the [New Business Rule] wizard.

A sub-folder for this new SQL business rule is displayed under the Rules folder in the DQ Repository tree
view. The SQL business rule editor opens with the defined metadata.
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In the SQL business rule editor, you can modify the WHERE clause or add a new one directly in the Data quality
rule view.

8. If required, set a value in the Criticality Level field.

This will act as an indicator to measure the importance of the SQL business rule.

Creating a join condition

This step is not obligatory. You can decide to create a business rule without a join condition and use it with only
the WHERE clause in the table analysis.

For an example of a table analysis with a simple business rule, see How to create a table analysis with a simple
SQL business rule. For an example of a table analysis with a business rule that has a join condition, see How to
create a table analysis with an SQL business rule with a join condition.

1. In the SQL business rule editor, click Join Condition to open the corresponding view.

2. Click the [+] button to add a row in the Join Condition table.
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3. Expand the Metadata folder in the DQ Repository tree view, and then browse to the columns in the tables
on which you want to create the join condition.

This join condition will define the relationship between a table A and a table B using a comparison operator
on a specific column in both tables. In this example, the join condition will compare the "name" value in the
Person and Person_Ref tables that have a common column called name.

You must be careful when defining the join clause. In order to get an easy to understand result, it is advisable to make
sure that the joined tables do not have duplicate values. For further information, see How to create a table analysis
with an SQL business rule with a join condition.

4. Drop the columns from the DQ Repository tree view to the Join Condition table.

A dialog box is displayed prompting you to select where to place the column: in TableA or in TableB.

5. Select a comparison condition operator between the two columns in the tables and save your modifications.

In the analysis editor, you can now drop this newly created SQL business rule onto a table that has an "age"
column. When you run the analysis, the join to the second column is done automatically.

The table to which to add the business rule must contain at least one of the columns used in the SQL business rule.

For more information about using SQL business rules as indicators on a table analysis, see Creating a table analysis
with SQL business rules.

15.2.2.2. How to edit an SQL business rule

To edit an SQL business rule, do the following:

1. In the DQ Repository tree view, expand Libraries > Rules > SQL.

2. Right-click the SQL business rule you want to open and select Open from the contextual menu.

The SQL business rule editor opens displaying the rule metadata.
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3. Modify the business rule metadata or the WHERE clause as required.

4. Click the save icon on top of the editor to save your modifications.

The SQL business rule is modified as defined.

15.2.2.3. How to create a table analysis with a simple SQL
business rule

You can create analyses on either tables or views in a database using SQL business rules. The procedure for
creating such analysis is the same for a table or a view.

Prerequisite(s):

• At least one SQL business rule has been created in the Profiling perspective of the studio. For further
information about creating SQL business rules, see How to create an SQL business rule

• At least one database connection is set in the Profiling perspective of the studio. For further information, see
Connecting to a database.
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In this example, you want to add the SQL business rule created in How to create an SQL business rule to a
top_custom table that contains an age column. This SQL business rule will match the customer ages to define
those who are older than 18.

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.

3. Expand the Table Analysis node and then select Business Rule Analysis.

4. Click the Next button to proceed to the next step.
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5. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

6. Set the analysis metadata (purpose, description and author name) in the corresponding fields and then click
Next.
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Selecting the table you want to analyze

1. Expand DB Connections, browse to the table to be analyzed and select it.

2. Click Finish to close the [Create New Analysis] wizard.

You can directly select the data quality rule you want to add to the current analysis by clicking the Next button in the
[New Analysis] wizard or you can do that at later stage in the Analyzed Tables view as shown in the following steps.

A folder for the newly created table analysis is listed under the Analyses folder in the DQ Repository tree
view, and the analysis editor opens with the defined metadata.
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3. Click the Analyzed Tables tab to open the Analyzed Tables view.

4. If required, click Select tables to analyze to open the [Table Selection] dialog box and modify the selection
and/or select new table(s).

5. Expand DB Connections and browse to the table(s) you want to analyze.
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You can filter the table or column lists by typing the desired text in the Table filter  or Column filter fields
respectively. The lists will show only the tables/columns that correspond to the text you type in.

6. Select the check box next to the table name and click OK.

The selected table(s) is listed in the Analyzed Tables view.

You can connect to a different database by selecting another connection from the Connection box. This box lists
all the connections created in the Studio with the corresponding database names. If the tables listed in the Analyzed
Tables view do not exist in the new database connection you want to set, you will receive a warning message that
enables you to continue or cancel the operation.

If you right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view, the selected column is automatically located under the corresponding connection in the
tree view.

Selecting the business rule

1.
Click the  icon next to the table name where you want to add the SQL business rule.

The [Business Rule Selector] dialog box is displayed.

2. Expand the Rules folder and select the check box(es) of the predefined SQL business rule(s) you want to
use on the corresponding table(s).

3. Click OK.
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The selected business rule is listed below the table name in the Analyzed Tables view.

You can also drag the business rule directly from the DQ Repository tree view to the table in the analysis editor.

4. If required, right-click the business rule and select View executed query.

The SQL editor opens in the Studio to display the query.

5. Click Data Filter in the analysis editor to open the view where you can set a filter on the data of the analyzed
table(s).

6. Save the table analysis and press F6 to execute it.

An information pop-up opens to confirm that the operation is in progress. The table analysis results are
displayed in the Graphics panel to the right.

7. Click Analysis Results at the bottom of the analysis editor to switch to the detail result view.
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All age records in the selected table are evaluated against the defined SQL business rule. The analysis results
has two bar charts: the first is a row count indicator that shows the number of rows in the analyzed table, and
the second is a match and non-match indicator that indicates in red the age records from the "analyzed result
set" that do not match the criteria (age below 18).

8. Right-click the business rule results in the second table, or right-click the result bar in the chart itself and
select:

Option To...

View valid rows access a list in the SQL editor of all valid rows measured against the pattern used on the
selected table

View invalid rows access a list in the SQL editor of all invalid rows measured against the pattern used on
the selected table

Analyze duplicates generates a ready-to-use analysis that analyzes duplicates in the table, if any, and give the
row and duplicate counts. For further information, see How to generate an analysis on
the join results to analyze duplicates.

For further information about the Analysis Results view, see How to access the detailed view of the analysis
results.

You can carry out a table analysis in a direct and more simplified way. For further information, see How to
create a table analysis with an SQL business rule in a shortcut procedure.

15.2.2.4. How to create a table analysis with an SQL business rule
with a join condition

In some cases, you may need to analyze database tables or views using an SQL business rule that has a join clause
that combines records from two tables in a database. This join clause will compare common values between two
columns and give a result data set. Then the data in this set will be analyzed against the business rule.
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Depending on the analyzed data and the join clause itself, several different results of the join are possible, for
example #match + #no match > #row count,  #match + #no match < #row count or #match + #no match = #row
count.

The example below explains in detail the case where the data set in the join result is bigger than the row count
(#match + #no match > #row count) which indicates duplicates in the processed data.

Prerequisite(s):

• At least one SQL business rule has been created in the Profiling perspective of the studio. For further
information about creating SQL business rules, see How to create an SQL business rule

• At least one database connection is set in the Profiling perspective of the studio. For further information, see
Connecting to a database.

In this example, you want to add the SQL business rule created in How to create an SQL business rule to a Person
table that contains the age and name columns. This SQL business rule will match the customer ages to define
those who are older than 18. The business rule also has a join condition that compares the "name" value between
the Person table and another table called Person_Ref through analyzing a common column called name.

Below is a capture of both tables:

Below is a capture of the result of the join condition between these two tables:

The result set may give duplicate rows as it is the case here. Thus the results of the analysis may become a bit
harder to understand. The analysis here will not analyze the rows of the table that match the business rule but
it will run on the result set given by the business rule. For detail explanation of the analysis results, see How to
access the detailed view of the analysis results.

1. Define the table analysis and select the table you want to analyze as outlined in How to create a table analysis
with a simple SQL business rule.

The selected table is listed in the Analyzed Tables view.
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2.
Add the business rule with the join condition to the selected table through clicking the icon next to the
table name.

This business rule has a join condition that compares the "name" value between two different tables through
analyzing a common column. For further information about SQL business rules, see How to create an SQL
business rule.

3. Save the table analysis and press F6 to execute it.

An information pop-up opens to confirm that the operation is in progress. The table analysis results are
displayed in the Graphics panel to the right.
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All age records in the selected table are evaluated against the defined SQL business rule. The analysis results
has two bar charts: the first is a row count indicator that shows the number of rows in the analyzed table, and
the second is a match and non-match indicator that indicates in red the age records from the "analyzed result
set" that do not match the criteria (age below 18).

To better understand the Business Rule Statistics bar chart in the analysis results, do the following:

1. In the analysis editor, right-click the business rule and select View executed query.
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The SQL editor opens in the Studio.

2. Modify the query in the top part of the editor to read as the following: SELECT * FROM

`person_joins`.`PERSON`  PERSON  JOIN  `person_joins`.`PERSON_REF`  PERSON_REF  ON

(PERSON.`name`=PERSON_REF.`name`).

This will list the result data set of the join condition in the editor.

3.
In the top left corner of the editor, click the  icon to execute the query.
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The query result, that is the analyzed result set, is listed in the bottom part of the editor.

4. Click the Analysis Results tab at the bottom of the analysis editor to open a detail view of the analysis results.

The analyzed result set may contain more or fewer rows than the analyzed table. In this example, the number
of match and non-match records (5 + 2 = 7) exceeds the number of analyzed records (6) because the join of
the two tables generates more rows than expected.

Here 5 rows (71.43%) match the business rule and 2 rows do not match. Because the join generates duplicate
rows, this result does not mean that 5 rows of the analyzed table match the business rule. It only means that 5
rows among the 7 rows of the result set match the business rule. Actually, some rows of the analyzed tables
may not be even analyzed against the business rule. This happens when the join excludes these rows. For this
reason, it is advised to check for duplicates on the columns used in the join of the business rule in order to
make sure that the join does not remove or add rows in the analyzed result set.  Otherwise the interpretation
of the result is more complex.

For further information on the result detail view, see How to access the detailed view of the analysis results.

In the Analysis Results view, if the number of match and non-match records exceeds the number of analyzed records,
you can generate a ready-to-use analysis that will analyze the duplicates in the selected table. For further information,
see How to access the detailed view of the analysis results.
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15.2.2.5. How to access the detailed view of the analysis results

Prerequisite(s): A table analysis with an SQL business rule, that may have a join condition, is defined and executed
in the Profiling perspective of the studio. For further information, see How to create a table analysis with an SQL
business rule with a join condition.

To access a more detailed view of a table analysis that uses an SQL business rule, do the following:

1. Click the Analysis Results tab at the bottom of the analysis editor to open the corresponding view.

The display of the Analysis Results view depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

The detailed analysis results view shows the two bar charts that indicate the number of the analyzed rows in
the selected table and the percentage of the rows that match and non-match the SQL business rule. The bar
charts are also accompanied with the tables that detail the statistic results.

If a join condition is used in the SQL business rule, the number of the rows of the join (#match + # no match) can
be different from the number of the analyzed rows (row count). For further information, see How to create a table
analysis with an SQL business rule with a join condition.

2. Right-click the Row Count row in the first table and select View rows.

The SQL editor opens in the Studio to display a list of the analyzed rows.
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3. Right-click the business rule results in the second table, or right-click the result bar in the chart itself and
select:

Option To...

View valid rows access a list in the SQL editor of all valid rows measured against the pattern used on the
selected table

View invalid rows access a list in the SQL editor of all invalid rows measured against the pattern used on
the selected table

Analyze duplicates generates a ready-to-use analysis that analyzes duplicates in the table and give the row
and duplicate counts. For further information, see How to generate an analysis on the join
results to analyze duplicates.

Below is the list of the invalid rows in the analyzed table.

4. In the SQL editor, click the save icon on the toolbar to save the executed query on the SQL business rule and
list it under the Libraries > Source Files folder in the DQ Repository tree view.

For further information, see Saving the queries executed on indicators.
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15.2.2.6. How to generate an analysis on the join results to
analyze duplicates

In some cases, when you analyze database tables using an SQL business rule that has a join clause, the join results
show that there are more rows in the joint than in the analyzed table. This is because the columns in the analyzed
table has some duplicate records, for an example see How to create a table analysis with an SQL business rule
with a join condition.

You can generate a ready-to-use analysis to analyze these duplicate records. The results of this analysis help you
to better understand why there are more records in the join results than in the table.

Prerequisite(s): A table analysis with an SQL business rule, that has a join condition, is defined and executed in
the Profiling perspective of the studio. The join results must show that there are duplicates in the table. For further
information, see How to create a table analysis with an SQL business rule with a join condition.

To generate an analysis that analyzes the duplicate records in a table, do the following:

1. After creating and executing an analysis on a table that has duplicate records as outlined in How to create a
table analysis with an SQL business rule with a join condition, click the Analysis Results tab at the bottom
of the analysis editor.

2. Right-click the join results in the second table and select Analyze duplicates.

The [Column Selection] dialog box opens with the analyzed tables selected by default.

3. Modify the selection in the dialog box if needed and then click OK.
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Two column analyses are generated and listed under the Analyses folder in the DQ Repository tree view
and the analysis editor opens in the Studio on the settings of the generated analysis.

4. Press F6 to execute the analysis.



Creating a table analysis with SQL business rules

Talend Open Studio for MDM User Guide 553

The analysis results show two bars, one representing the row count of the data records in the analyzed column
and the other representing the duplicate count.

5. Click Analysis Results at the bottom of the analysis editor to access the detail result view.

6. Right-click the row count or duplicate count results in the table, or right-click the result bar in the chart itself
and select:

Option To...

View rows open a view on a list of all data rows or duplicate rows in the analyzed column.

View values open a view on a list of the duplicate data values of the analyzed column.

15.2.2.7. How to create a table analysis with an SQL business rule
in a shortcut procedure

You can use a simplified way to create a table analysis with a predefined business rule. All what you need to do
is to start from the table name under the relevant DB Connection folder.

Prerequisite(s):

• At least one SQL business rule is created in the Profiling perspective of the studio.

• At least one database connection is set in the Profiling perspective of the studio.

For more information about creating SQL business rules, see How to create an SQL business rule.

To create a table analysis with an SQL business rule in a shortcut procedure, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections, and then browse to the table you
want to analyze.

2. Right-click the table name and select Table analysis from the list.

The [New Table Analysis] wizard is displayed.
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3. Enter the metadata for the new analysis in the corresponding fields and then click Next to proceed to the
next step.

4. Expand Rules > SQL and then select the check box(es) of the predefined SQL business rule(s) you want to
use on the corresponding table(s).

5. Click OK to proceed to the next step.
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The table name along with the selected business rule are listed in the Analyzed Tables view.

6. If required, click Data Filter in the analysis editor to open the view where you can set a filter on the data
of the analyzed table(s).

7. Save the table analysis and press F6 to execute it.

An information pop-up opens to confirm that the operation is in progress. The table analysis results are
displayed in the Graphics panel to the right.

15.2.3. Detecting anomalies in the table columns:
column functional dependency analysis

This type of analysis helps you to detect anomalies in column dependencies through defining columns as either
"determinant" or "dependent" and then analyzing values in dependant columns against those in determinant
columns.

This type of analysis detects to what extent a value in a determinant column functionally determines another value
in a dependant column.

This can help you identify problems in your data, such as values that are not valid. For example, if you analyze
the dependency between a column that contains United States Zip Codes and a column that contains states in the
United States, the same Zip Code should always have the same state. Running the functional dependency analysis
on these two columns will show if there are any violations of this dependency.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. Expand the Table Analysis node and select Functional Dependency.

4. Click the Next button to proceed to the next step.
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5. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

6. Set the analysis metadata (purpose, description and author name) in the corresponding fields, and then click
Next.
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Selecting the columns as either "determinant" or "dependent"

1. Expand DB connections, and then browse to the columns you want to analyze, select them and then click
Finish to close the [New Analysis] wizard.

A folder for the newly created functional dependency analysis is listed under Analysis in the DQ Repository
tree view, and the analysis editor opens with the defined metadata.

The display of the analysis editor depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

2. In the Analyzed Column Set view, click Determinant columns: Select columns from set A to open the
[Column Selection] dialog box.

Here you can select the first set of columns against which you want to analyze the values in the dependant
columns. You can also drag the columns directly from the DQ Repository tree view to the left column panel.

In this example, you want to evaluate the records present in the city column and those present in the
state_province column against each other to see if state names match to the listed city names and vice versa.
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3. In the [Column Selection] dialog box, expand DB Connections and browse to the column(s) you want to
define as determinant columns.

You can filter the table or column lists by typing the desired text in the Table filter or Column filter fields
respectively. The lists will show only the tables/columns that correspond to the text you type in.

4. Select the check box(es) next to the column(s) you want to analyze and click OK to proceed to the next step.

The selected column(s) are displayed in the Left Columns panel of the Analyzed Columns Set view. In this
example, we select the city column as the determinant column.

5. Do the same to select the dependant column(s) or drag it/them from the DQ Repository tree view to the
Right Columns panel. In this example, we select the state_province column as the dependent column. This
relation will show if the state names match to the listed city names.

If you right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view, the selected column is automatically located under the corresponding connection in the
tree view.

6. Click the Reverse columns tab to automatically reverse the defined columns and thus evaluate the reverse
relation, what city names match to the listed state names.
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You can select to connect to a different database by selecting another connection from the Connection box. This
box lists all the connections created in the Studio with the corresponding database names. If the columns listed in the
Analyzed Columns Set view do not exist in the new database connection you want to set, you will receive a warning
message that enables you to continue or cancel the operation.

Finalizing and executing the functional dependency analysis

1. In the Data Filter view, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.

2. In the Analysis Parameter view and in the Number of connections per analysis field, set the number of
concurrent connections allowed per analysis to the selected database, if required.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

3. If you have defined context variables in the Contexts view in the analysis editor:

• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.

• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

4. Save the analysis and press F6 to execute it.

A progress information pop-up opens to confirm that the operation is in progress. The results of column
functional dependency analysis are displayed in the Analysis Results view.

This functional dependency analysis evaluated the records present in the city column and those present in the
state_province column against each other to see if the city names match to the listed state names and vice
versa. The returned results, in the %Match column, indicate the functional dependency strength for each
determinant column. The records that do not match are indicated in red.

The #Match column in the result table lists the numbers of the distinct determinant values in each of the
analyzed columns. The #row column in the analysis results lists the actual relations between the determinant
attribute and the dependant attribute. In this example, #Match in the first row of the result table represents the
number of distinct cities, and #row represents the number of distinct pairs (city, state_province). Since these
two numbers are not equal, then the functional dependency relationship here is only partial and the ratio of
the numbers (%Match) measures the actual dependency strength. When these numbers are equal, you have
a "strict" functional dependency relationship, that is to say each city appears only once with each state.

The presence of null values in either of the two analyzed columns will lessen the "dependency strength". The system
does not ignore null values, but rather calculates them as values that violates the functional dependency.
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5. In the Analysis Results view, right-click any of the dependency lines and select:

Option To...

View valid/invalid rows access a list in the SQL editor of all valid/invalid rows measured according to the
functional dependencies analysis

View valid/invalid values access a list in the SQL editor of all valid/invalid values measured according to the
functional dependencies analysis

View detailed valid/detailed
invalid values

access a detailed list in the SQL editor of all valid/invalid values measured according to
the functional dependencies analysis

From the SQL editor, you can save the executed query and list it under the Libraries > Source Files folders
in the DQ Repository tree view if you click the save icon on the editor toolbar. For more information, see
Saving the queries executed on indicators.

15.2.4. Creating a column analysis from a simple table
analysis

You can create a column analysis on one or more columns defined in a simple table analysis (column set analysis).

Prerequisite(s):A simple table analysis is defined in the analysis editor in the Profiling perspective of the studio.

To create a column analysis on one or more columns defined in a simple table analysis, do the following:

1. Open the simple table analysis.

2. In the Analyzed Columns view, right-click the column(s) you want to create a column analysis on.



Analyzing tables in delimited files

562 Talend Open Studio for MDM User Guide

3. Select Column analysis from the contextual menu.

The [New Analysis] wizard opens.

4. In the Name field, enter a name for the new column analysis and then click Finish to proceed to the next step.

The analysis editor opens with the defined metadata and a folder for the newly created analysis is listed under
the Analyses folder in the DQ Repository tree view.

5. Follow the steps outlined in Analyzing columns in a database to continue creating the column analysis.

15.3. Analyzing tables in delimited files
You can analyze the content of a set of columns in a delimited file. This set can represent only some of the columns
in the defined table or the table as a whole.

You can then execute the created analysis using the Java engine.
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15.3.1.  Creating a column set analysis on a delimited
file using patterns

This type of analysis provide simple statistics on the number of records falling in certain categories, including the
number of rows, the number of null values, the number of distinct and unique values, the number of duplicates,
or the number of blank fields. For more information about these indicators, see Simple statistics.

It is also possible to add patterns to this type of analysis and have a single-bar result chart that shows the number
of the rows that match "all" the patterns.

15.3.1.1. How to define the set of columns to be analyzed in a
delimited file

Prerequisite(s): At least one connection to a delimited file is set in the studio. For further information, see
Connecting to a database.

When carrying out this type of analysis, the set of columns to be analyzed must not include a primary key column.

To define the set of columns to analyzed, do the following:

1. In the DQ Repository tree view, expand the Data Profiling folder.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. Expand the Table Analysis folder and click Column Set Analysis.

4. Click the Next button to proceed to the next step.
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5. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

6. If required, set column analysis metadata (purpose, description and author name) in the corresponding fields
and click Next to proceed to the next step.
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7. Expand the FileDelimited connection and browse to the set of columns you want to analyze.

8. Select the columns to be analyzed, and then click Finish to close this [New analysis] wizard.

The analysis editor opens with the defined analysis metadata, and a folder for the newly created analysis is
displayed under Analysis in the DQ Repository tree view.
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The display of the analysis editor depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

9. If required, select another connection from the Connection box in the Analyzed Columns view. This box
lists all the connections created in the Studio with the corresponding database names.

By default, the delimited file connection you have selected in the previous step is displayed in the Connection
box.

10. If required, click the Select columns to analyze link to open a dialog box where you can modify your column
selection.
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You can filter the table or column lists by typing the desired text in the Table filter  or Column filter fields
respectively. The lists will show only the tables/columns that correspond to the text you type in.

11. In the column list, select the check boxes of the column(s) you want to analyze and click OK to proceed
to the next step.

In this example, you want to analyze a set of six columns in the delimited file: account number (account_num),
education (education), email (email), first name (fname), second name (Iname) and gender (gender). You
want to identify the number of rows, the number of distinct and unique values and the number of duplicates.

12. Use the delete, move up or move down buttons to manage the analyzed columns.

If you right-click any of the listed columns in the Analyzed Columns view and select Show in DQ Repository
view, the selected column will be automatically located under the corresponding connection in the tree view.
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15.3.1.2. How to add patterns to the analyzed columns in the
delimited file

Now, you can add patterns to one or more of the analyzed columns to validate the full record (all columns) against
all the patterns, and not to validate each column against a specific pattern as it is the case with the column analysis.
The results chart is a single bar chart for the totality of the used patterns. This chart shows the number of the rows
that match "all" the patterns.

Before being able to use a specific pattern with a set of columns analysis, you must manually set in the patterns settings
the pattern definition for Java, if it does not already exist. Otherwise, a warning message will display prompting you to set
the definition of the Java regular expression.

Prerequisite(s): An analysis of a set of columns is open in the analysis editor in the studio. For more information,
see How to define the set of columns to be analyzed.

To add patterns to the analysis of a set of columns, do the following:

1.
Click the  icon next to each of the columns you want to validate against a specific pattern.

The [Pattern Selector] dialog box is displayed.

You can add only regular expressions to the analyzed columns.

You can drop the regular expression directly from the Patterns folder in the DQ Repository tree view directly to the
column name in the column analysis editor.

If no Java expression exists for the pattern you want to add, a warning message will display prompting you to add the
pattern definition for Java. Click Yes to open the pattern editor and add the Java regular expression, then proceed
to add the pattern to the analyzed columns.

In this example, you want to add a corresponding pattern to each of the analyzed columns to validate data in
these columns against the selected patterns. The result chart will show the percentage of the matching/non-
matching values, the values that respect the totality of the used patterns.

2. In the [Pattern Selector] dialog box, expand Patterns and browse to the regular expression you want to add
to the selected column.
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3. Select the check box(es) of the expression(s) you want to add to the selected column.

4. Click OK to proceed to the next step.

The added regular expression(s) display(s) under the analyzed column(s) in the Analyzed Columns view
and the All Match indicator is displayed in the Indicators list in the Indicators view.

15.3.1.3. How to finalize and execute the column set analysis on a
delimited file

What is left before executing this set of columns analysis is to define indicators, data filter and analysis parameters.

Prerequisite(s):A column set analysis is defined in the Profiling perspective of the studio. For further information,
see How to define the set of columns to be analyzed in a delimited file and How to add patterns to the analyzed
columns in the delimited file.

1. Click Indicators in the analysis editor to open the corresponding view.
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The indicators representing the simple statistics are by-default attached to this type of analysis. For further information
about the indicators for simple statistics, see section Simple statistics.

2.
If required, click the option icon  to open a dialog box where you can set options for each indicator. For
more information about indicators management, see Indicators.

3. If required, click Data Filter in the analysis editor to display its view and filter data through SQL "WHERE"
clauses.

4. In the Analysis Parameters view, select the Allow drill down check box to store locally the data that will
be analyzed by the current analysis.

5. In the Max number of rows kept per indicator field enter the number of the data rows you want to make
accessible.

The Allow drill down check box is selected by default, and the maximum analyzed data rows to be shown per indicator
is set to 50.

6. Click the save icon on top of the analysis editor and then press F6 to execute the analysis.

The Graphics panel to the right of the analysis editor displays the graphical result corresponding to the
Simple Statistics indicators used to analyze the defined set of columns.
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When you use patterns to match the content of the columns to be analyzed, another graphic is displayed to
illustrates the match results against the totality of the used patterns.

15.3.1.4. How to access the detailed result view for the delimited
file analysis

The procedure to access the detailed results for the delimited file analysis is the same as that for the database
analysis. For further information, see How to access analysis results and analyzed data.
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15.3.1.5. How to filter analysis data against patterns

The procedure to filter the data of the analysis of a delimited file is the same as that for the database analysis. For
further information, see How to filter data against patterns.

15.3.2.  Creating a column analysis from the analysis
of a set of columns

You can create a column analysis on one or more columns defined in the set of columns analysis.

Prerequisite(s): A simple table analysis is defined in the analysis editor in the Profiling perspective of the studio.

To create a column analysis on one or more columns defined in the set of columns analysis, do the following:

1. Open the set of columns analysis.

2. In the Analyzed Columns view, right-click the column(s) you want to create a column analysis on.

3. Select Column analysis from the contextual menu. The [New Analysis] wizard opens.

4. In the Name field, enter a name for the new column analysis and then click Next to proceed to the next step.

The analysis editor opens with the defined metadata and a folder for the newly created analysis is displayed
under the Analyses folder in the DQ Repository tree view.

5. Follow the steps outlined in Analyzing columns in a delimited file to continue creating the column analysis
on a delimited file.
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15.4. Analyzing duplicates
You can use the match analysis editor in the Profiling perspective of the studio to compare columns in a data flow
and create groups of similar records using the VSR or the T-Swoosh algorithm.

This editor provides you with a simple way to create match rules, test them on a set of columns and see the results
directly in the editor..

You can also use the Profiling perspective to define match rules in a match rule editor and save them in the studio
repository. For further information, see Creating a match rule.

15.4.1. Creating a match analysis

The match analysis enables you to compare a set of columns and create groups of similar records using blocking
and matching keys and/or survivorship rules.

This analysis enables you to create match rules and test them on data to assess the number of duplicates . Currently,
you can test match rules only on columns in the same table.

Prerequisite(s): You have selected the Profiling perspective of the studio. At least one database or file connection
is defined under the Metadata node. For further information, see Connecting to a database.

The sequence of setting up a match analysis involves the following steps:

1. Connecting to a data source.

2. Defining the columns you want to search for similar records using match processes.

3. Defining blocking keys to reduce the number of pairs that need to be compared.

4. Defining match keys, the match methods according to which similar records are grouped together.

5. Exporting the match rules from the match analysis editor and centralize them in the studio repository.

15.4.1.1. How to define a match analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analysis folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. Start typing match in the filter field, select Match Analysis and then click Next.

4. Set the analysis name and metadata and then click Next.
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Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

5. Expand DB connections or FileDelimited connections depending on if the columns you want to match are
in a database or a delimited file.

6. Browse to the columns you want to match, select them and then click Finish.

The columns you select should be in the same table. Currently, the match analysis does not work on columns
in different tables.

The match analysis editor opens listing the selected columns.
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You can directly open the match analysis editor on the columns you want to compare if you right-click the
column(s) under the Metadata node and select Analyze matches.

7. In the Limit field, set the number for the data records you want to use as a data sample. data is displayed
in the Data table.

8. If required, click any column name in the table to sort the sample data in an ascending or descending order.

9. in the analysis match editor, select:

Option To...

locate the selected table under the Metadata node in the tree view.

New Connection create a connection to a database or to a file from inside the match analysis editor where
you can expand this new connection and select the columns on which to do the match.

For further information about how to create a connection to data sources, see Connecting
to a database and How to connect to a delimited file.

Select Data update the selection of the columns listed in the table.

If you change the data set for an analysis, the charts that display the match results of the
sample data will be cleared automatically. You must click Chart to compute the match
results for the new data set you have defined.

Refresh Data refresh the view of the columns listed in the table.
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Select Blocking Key define the column(s) from the input flow according to which you want to partition the
processed data in blocks.

For more information, see How to define a match rule.

Select Matching Key define the match rules and the column(s) from the input flow on which you want to apply
the match algorithm.

For more information, see How to define a match rule.

Store on disk store processed data blocks on the disk to maximize system performance.

Max buffer size: Type in the size of physical memory you want to allocate to processed
data.

Temporary data directory path: Set the path to the directory where the temporary file
should be stored.

The Data table has some additional columns which show the results of matching data. The indication of these
columns are as the following:

Column Description

GID represents the group identifier.

GRP_SIZE counts the number of records in the group, computed only on the master record.

MASTER identifies, by true or false, if the record used in the matching comparisons is a master
record. There is only one master record per group.

Each input record will be compared to the master record, if they match, the input record will
be in the group.

SCORE measures the distance between the input record and the master record according to the
matching algorithm used.

GRP_QUALITY only the master record has a quality score which is the minimal value in the group.

ATTRIBUTE_SCORE lists the match score and the names of the columns used as key attributes in the applied rules.

15.4.1.2. How to define a match rule

You can define match rules from the match analysis editor by defining:

• blocking keys, the column(s) from the input flow according to which you want to partition the processed data
in blocks,

• matching keys and survivorship rules, the match algorithms you want to apply on columns from the input flow.

Defining a blocking key

Defining a blocking key is not mandatory but strongly advisable. Using a blocking key to partition data in blocks
reduces the number of records that need to be examined as comparisons are restricted to record pairs within each
block. Using blocking column(s) is very useful when you are processing a big data set.

1. In the Data section, click the Select Blocking Key tab and then click the name of the column(s) you want
to use to partition the processed data in blocks.

Blocking keys that have the exact name of the selected columns are listed in the Blocking Key table.
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You can define more than one column in the table, but only one blocking key will be generated and listed
in the BLOCK_KEY column in the Data table.

For example, if you use an algorithm on the country and lnamecolumns to process records that have the same
first character, data records that have the same first letter in the country and last names are grouped together
in the same block. Comparison is restricted to record within each block.

To remove a column from the Blocking key table, right-click it and select Delete or click on its name in
the Data table.

2. Select an algorithm for the blocking key, and set the other parameters in the Blocking Key table as needed.

In this example, only one blocking key is used. The first character of each word in the country column is
retrieved and listed in the BLOCK_KEY column.

3. Click Chart to compute the generated key, group the sample records in the Data table and display the results
in a chart.

This chart allows you to visualize the statistics regarding the number of blocks and to adapt the blocking
parameters according to the results you want to get.

Defining a matching key with the VSR algorithm

1. In the Record linkage algorithm section, select Simple VSR Matcher if it is not selected by default.

2. In the Data section, click the Select Matching Key tab and then click the name of the column(s) on which
you want to apply the match algorithm.

Matching keys that have the exact names of the selected input columns are listed in the Matching Key table.
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To remove a column from this table, right-click it and select Delete or click on its name in the Data table.

3. Select the match algorithms you want to use from the Matching Function column and the null operator from
the Handle Null column.

In this example two match keys are defined, you want to use the Levenshtein and Jaro-Winkler match
methods on first names and last names respectively and get the duplicate records.

If you want to use an external user-defined matching algorithm, select Custom and use the Custom Matcher
column to load the Jar file of the user-defined algorithm.

Defining a matching key with the T-Swoosh algorithm

• Make sure first to select the column(s) on which to apply the match algorithm either from the Data section
by using the Select Matching Key tab, or directly from the Matching Key table.

To create a match key using the T-Swoosh algorithm:

1. In the Record linkage algorithm section, select T-Swoosh. The Simple VSR Matcher is for use with Talend
Data Quality only.

2. In the Match and Survivor section, you define the criteria to use when matching data records. Click the [+]
button to add a new rule, and then set the following criteria.

• Match Key Name: Enter the name of your choice for the match key.

• Matching Function: Select the type of matching you want to perform from the drop-down list. Select
Custom if you want to use an external user-defined matching algorithm.
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• Custom Matcher: This item is only used with the Custom matching function. Browse and select the Jar
file of the user-defined algorithm.

• Threshold: Specify the match score (between 0 and 1) above which two values should be considered a
match.

• Confidence Weight: Set a numerical weight (between 1 and 10) to the column you want to use as a match
key. This value is used to give greater or lesser importance to certain columns when performing the match.

• Handle Null: Specify how to deal with data records which contain null values.

• nullMatchNull: If both records contain null values, consider this a match.

• nullMatch None: If one record contains a null, do not consider this a match.

• nullMatch All: If one record contains a null, consider this a match.

• Survivorship Function: Select how two similar records will be merged from the drop-down list.

• Concatenate: It adds the content of the first record and the content of the second record together - for
example, Bill and William will be merged into BillWilliam. In the Parameter field, you can specify a
separator to be used to separate values.

• Prefer True (for booleans): It always set booleans to True in the merged record, unless all booleans
in the source records are False.

• Prefer False (for booleans): It always sets booleans to False in the merged record, unless all booleans
in the source records are True.

• Most common: It validates the most frequently-occurring field value in each duplicates group.

• Most recent or Most ancient: The former validates the earliest date value and the latter the latest date
value in each duplicates group. The relevant reference column must be of the Date type.

• Longest or Shortest: The former validates the longest field value and the latter the shortest field value
in each duplicates group.

• Largest or Smallest: The former validates the largest numerical value and the latter the smallest
numerical value in a duplicates group.

• Most trusted source: It takes the data coming from the source which has been defined as being most
trustworthy. The most trusted data source is set in the Parameter field.

• Parameter: For the Most trusted source survivorship function, this item is used to set the name of the data
source you want to use as a base for the master record. For the Concatenate survivorship function, this
item is used to specify a separator you want to use for concatenating data.

3. In the Match threshold field, enter the match probability threshold.

Two data records match when the probability is above this value.

In the Confident match threshold field, set a numerical value between the current Match threshold and 1.

4. In the Default Survivorship Rules section, you define how to survive matches for certain data types:
Boolean, Data, Number and String. If you do not specify the behavior for any or all data types, the default
behavior is applied.

• Click the [+] button to add a new row for each data type.

• In the Data Type column, select the relevant data type from the drop-down list.
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• In the Survivorship Function column, select how two similar records will be merged from the drop-down
list. Note that, depending on the data type, only certain choices may be relevant.

• Parameter: For the Most trusted source survivorship function, this item is used to set the name of the data
source you want to use as a base for the master record. For the Concatenate survivorship function, this
item is used to specify a separator you want to use for concatenating data.

5. Save your changes.

Editing the rule and displaying the sample results

1. To define a second match rule, click the [+] button on the top right corner of the table and follow the above
steps.

When you define multiple conditions in the match rule editor, an OR match operation is conducted on the
analyzed data. Records are evaluated against the first rule and the records that match are not evaluated against
the second rule and so on.

2.
Click the  button at the top right corner of the Matching Key or Match and Survivor section and replace
the default name of the rule with a name of your choice.

If you define more than one rule in the match analysis, you can use the up and down arrows in the dialog box
to change the rule order and thus decide what rule to execute first.

3. Click OK.

The rules are named and ordered accordingly in the section.

4. In the Match threshold field, enter the match probability threshold.

Two data records match when the probability is above this value.

In the Confident match threshold field, set a numerical value between the current Match threshold and 1.

If the GRP-QUALITY calculated by the match analysis is equal to or greater than the Confident match
threshold, you can be confident about the quality of the group.

5. Click Chart to compute the groups according to the blocking key and match rule you defined in the editor
and display the results of the sample data in a chart.

This chart shows a global picture about the duplicates in the analyzed data. The Hide groups less than
parameter is set to 2 by default. This parameter enables you to decide what groups to show in the chart, you
usually want to hide groups of small group size.
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For example, the chart in the above image indicates that out of the 1000 sample records you examined and
after excluding items that are unique, by having the Hide groups less than parameter set to 2:

• 20 groups have 2 items each. In each group, the 2 items are duplicates of each other.

• one group has 3 duplicate items, another group has 4 duplicate items and a third group has 6 duplicate items.

Also, the Data table indicates the match details of items in each group and colors the groups in accordance
with their colors in the match chart.

15.4.1.3. How to show the match results

To collect duplicates from the input flow according to the match types you define, Levenshtein and Jaro-Winkler
in this example, do the following:

1. If you are processing large data sets, select the Store on disk check box in the Analysis parameter view and:

• In the Max buffer size field, type in the size of physical memory you want to allocate to processed data.

• In the Temporary data directory path field, set the path to the directory where you want to store the
temporary file.

2. Save the settings in the match analysis editor and press F6.

The analysis is executed. The match rule and blocking key are computed against the whole data set and the
Analysis Results view is open in the editor.

In this view, the charts give a global picture about the duplicates in the analyzed data. In the first tables, you
can read statistics about the count of processed records, distinct records with only one occurrence, duplicate
records and suspect records that did not match the rule. In the second table, you can read statistics about the
number of groups and the number of records in each group.
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15.4.1.4. How to import or export match rules

You can import match rules from the studio repository and use them in the match editor to test them on your data.
You can also export match rules from the match editor and save them in the studio repository.

You can import match rules stored in the studio repository into the match editor and test them on your data. You
can also export match rules from the editor and store them in the studio repository.

Importing match rules from the repository

1. In the match editor, click the  icon on top of the editor.

2. In the [Match Rule Selector] wizard, select the match rule you want to import into the match analysis editor
and use on the analyzed data.

-A warning message displays in the wizard if the match rule you want to import is defined on columns that do not
exist in the analyzed data. Ignore the message as you can define input columns later in the match analysis editor.

3. Select the Overwrite current Match Rule in the analysis check box if you want to replace the rule in the
editor with the rule you import, otherwise, leave the box unselected.

4. Click OK.

The match rule is imported and the matching and blocking keys and /or survivorship rules are listed in the
Matching Key and Blocking Key tables respectively.
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5. Click in the Input column and select from the list the column on which you want to apply the imported
blocking and matching keys.

If you have in the analyzed data a column that match the input column in the imported keys, it will be
automatically defined in the Input column, you do not need to define it yourself.

When you analyze data with multiple conditions, the match results will list data records that meet any of the
defined rules. When you execute the match analysis, an OR match operation is conducted on data and data
records are evaluated against the first rule and the records that match are not evaluated against the other rules.

Exporting match rules to the repository

1. In the match editor, click the  icon on top of the editor.
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2. In the open wizard, enter a name for the rule and set other metadata, if needed.

3. Click Finish.

The rule editor opens on the rule settings and the rule is saved and listed under Libraries > Rules > Match
in the DQ Repository tree view.

15.4.2. Creating a match rule
In data quality, match rules are used to compare a set of columns and create groups of similar records using
blocking and matching keys and/or survivorship functions.

From the Profiling perspective of the studio, you can create match rules with the VSR or the T-Swoosh algorithm
and save them in the studio repository. Once centralized in the repository, you can import them in the match
analysis editor and test them on your data to group duplicate records. For further information about the match
analysis, see Creating a match analysis.

The two algorithms produce different match results because of two reasons:

• first, the master record is simply selected to be the first input record with the VSR algorithm. Therefore, the list
of match groups may depend on the order of the input records,

• second, the output records do not change with the VSR algorithm, whereas the T-Swoosh algorithm creates
new records.

15.4.2.1. How to define the rule

Prerequisite(s): You have selected the Profiling perspective of the studio.
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1. In the DQ Repository tree view, expand Libraries > Rules.

2. Right-click Match and select New Match Rule.

3. In the [New Match Rule] wizard, enter a name and set other metadata, if required.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

Consider as an example that you want to create a rule to match customer full names.

4. Click Finish.

A match rule editor opens in the studio and the new match rule is listed under Libraries > Rule > Match
in the DQ Repository tree view.

In the Record Linkage algorithm view, the Simple VSR Matcher algorithm is selected by default.

15.4.2.2. Rules with the VSR algorithm

The VSR algorithm takes a set of records as input and groups similar encountered duplicates together according
to defined match rules. It compares pairs of records and assigns them to groups. The first processed record of each
group is the master record of the group. The VSR algorithm compares each record with the master of each group
and uses the computed distances, from master records, to decide to what group the record should go.
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In the match analysis, the matching results of the VSR algorithm may vary depending on the order of the input
records. If possible, put the records in which you have more confidence first in the input flow, to have better
algorithm accuracy.

Defining a blocking key

Defining a blocking key is not mandatory but advisable. Using a blocking key partitions data in blocks and thus
reduces the number of records to be examined, as comparisons are restricted to record pairs within each block.
Using blocking key(s) is very useful when you are processing big data set.

1. In the rule editor and in the Generation of Blocking Key section, click the [+] button to add a row to the table.

2. Set the parameters of the blocking key as the following:

• Blocking Key Name: Enter a name for the column you want to use to reduce the number of record pairs
that need to be compared.

• Pre-algorithm: Select from the drop-down list an algorithm and set its value where necessary.

Defining a pre-algorithm is not mandatory. This algorithm is used to clean or standardize data before
processing it with the match algorithm and thus improve the results of data matching.

• Algorithm: Select from the drop-down list the match algorithm you want to use and set its value where
necessary.

• Post-algorithm: Select from the drop-down list an algorithm and set its value where necessary

Defining a post-algorithm is not mandatory. This algorithm is used to clean or standardize data after
processing it with the match algorithm and thus improve the outcome of data matching.

3. If required, follow the same steps to add as many blocking keys as needed.

When you import a rule with many blocking keys into the match analysis editor, only one blocking key will
be generated and listed in the BLOCK_KEY column in the Data table.

Defining a matching key

1. In the rule editor and in the Matching Key table, click the [+] button to add a row to the table.

2. Set the parameters of the matching key as the following:

• Match Key Name: Enter the name of your choice for the match key.

• Matching Function: Select the type of matching you want to perform from the drop-down list. Select
Custom if you want to use an external user-defined matching algorithm.

In this example two match keys are defined, you want to use the Levenshtein and Jaro-Winkler match
methods on first names and last names respectively and get the duplicate records.

• Custom Matcher: This item is only used with the Custom matching function. Browse and select the Jar
file of the user-defined algorithm.

• Confidence Weight: Set a numerical weight (between 1 and 10) to the column you want to use as a match
key. This value is used to give greater or lesser importance to certain columns when performing the match.

• Handle Null: Specify how to deal with data records which contain null values.

3. In the Match threshold field, enter the match probability threshold. Two data records match when the
probability is above this value.

In the Confident match threshold field, set a numerical value between the current Match threshold and 1.
Above this threshold, you can be confident about the quality of the group.
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4. To define a second match rule, click the [+] button on the top right corner of the table and follow the above
steps.

When you define multiple conditions in the match rule editor, an OR match operation is conducted on the
analyzed data. Records are evaluated against the first rule and the records that match are not evaluated against
the second rule.

5.
If required, click the  button at the top right corner of the table and replace the default names of the rules
with names of your choice.
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You can also use the up and down arrows in the dialog box to change the rule order and thus decide what
rule to execute first.

6. Click OK.

The rules are named and ordered accordingly in the Matching Key table.

7. Save the match rule settings.

The match rule is saved and centralized under Libraries > Rule > Match in the DQ Repository tree view.

You can import and test the rule on your data in the match analysis editor. For further information, see How to
import or export match rules.

15.4.2.3. Rules with the T-Swoosh algorithm

You can use the T-Swoosh algorithm to find duplicates and to define how two similar records are merged to create
a master record, using a survivorship function. These new merged records are used to finds new duplicates. The
difference with the VSR algorithm is that the master record is in general a new record that does not exist in the
list of input records.

1. In the Record linkage algorithm section, select T-Swoosh. The Simple VSR Matcher is for use with Talend
Data Quality only.

2. In the Match and Survivor section, you define the criteria to use when matching data records. Click the [+]
button to add a new rule, and then set the following criteria.

• Match Key Name: Enter the name of your choice for the match key.

• Matching Function: Select the type of matching you want to perform from the drop-down list. Select
Custom if you want to use an external user-defined matching algorithm.

• Custom Matcher: This item is only used with the Custom matching function. Browse and select the Jar
file of the user-defined algorithm.

• Threshold: Specify the match score (between 0 and 1) above which two values should be considered a
match.

• Confidence Weight: Set a numerical weight (between 1 and 10) to the column you want to use as a match
key. This value is used to give greater or lesser importance to certain columns when performing the match.
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• Handle Null: Specify how to deal with data records which contain null values.

• nullMatchNull: If both records contain null values, consider this a match.

• nullMatch None: If one record contains a null, do not consider this a match.

• nullMatch All: If one record contains a null, consider this a match.

• Survivorship Function: Select how two similar records will be merged from the drop-down list.

• Concatenate: It adds the content of the first record and the content of the second record together - for
example, Bill and William will be merged into BillWilliam. In the Parameter field, you can specify a
separator to be used to separate values.

• Prefer True (for booleans): It always set booleans to True in the merged record, unless all booleans
in the source records are False.

• Prefer False (for booleans): It always sets booleans to False in the merged record, unless all booleans
in the source records are True.

• Most common: It validates the most frequently-occurring field value in each duplicates group.

• Most recent or Most ancient: The former validates the earliest date value and the latter the latest date
value in each duplicates group. The relevant reference column must be of the Date type.

• Longest or Shortest: The former validates the longest field value and the latter the shortest field value
in each duplicates group.

• Largest or Smallest: The former validates the largest numerical value and the latter the smallest
numerical value in a duplicates group.

• Most trusted source: It takes the data coming from the source which has been defined as being most
trustworthy. The most trusted data source is set in the Parameter field.

• Parameter: For the Most trusted source survivorship function, this item is used to set the name of the data
source you want to use as a base for the master record. For the Concatenate survivorship function, this
item is used to specify a separator you want to use for concatenating data.

3. In the Match threshold field, enter the match probability threshold.

Two data records match when the probability is above this value.

In the Confident match threshold field, set a numerical value between the current Match threshold and 1.

4. In the Default Survivorship Rules section, you define how to survive matches for certain data types:
Boolean, Data, Number and String. If you do not specify the behavior for any or all data types, the default
behavior is applied.

• Click the [+] button to add a new row for each data type.

• In the Data Type column, select the relevant data type from the drop-down list.

• In the Survivorship Function column, select how two similar records will be merged from the drop-down
list. Note that, depending on the data type, only certain choices may be relevant.

• Parameter: For the Most trusted source survivorship function, this item is used to set the name of the data
source you want to use as a base for the master record. For the Concatenate survivorship function, this
item is used to specify a separator you want to use for concatenating data.

5. Save your changes.
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Chapter 16. Redundancy analyses
This chapter provides all the information you need to perform redundancy analysis that can compare table content
or identify overlapping values between two sets of columns.
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16.1. What are redundancy analyses
Redundancy analyses are column comparison analyses that better explore the relationships between tables through:

• Comparing identical columns in different tables,

• Matching foreign keys in one table to primary keys in the other table and vice versa.

The sections below provide detailed information about these two types of redundancy analyses.

The number of the analyses created in the Profiling perspective of the studio is indicated next to the Analyses folder in
the DQ Repository tree view.

16.2. Comparing identical columns in
different tables
From your studio, you can create an analysis that compares two identical sets of columns in two different tables.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. Expand the Redundancy Analysis node and then select Column Content Comparison.

4. Click Next.
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5. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

6. Set the analysis metadata (purpose, description and author name) in the corresponding fields and then click
Next.

Selecting the identical columns you want to compare

1. Expand DB connections and in the desired database, browse to the columns you want to analyze, select them
and then click Finish to close the wizard.

A file for the newly created analysis is listed under the Analysis folder in the DQ Repository tree view. The
analysis editor opens with the defined analysis metadata.
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The display of the analysis editor depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

2. Click Analyzed Column Sets to open the view where you can set the columns or modify your selection.

In this example, you want to compare identical columns in the account and account_back tables.

3. From the Connection box, select the database connection relevant to the database to which you want to
connect.

This box lists all the connections created in the Studio with the corresponding database names.

4. Click Select columns for the A set to open the [Column Selection] dialog box.
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5. Expand DB Connections and then browse through the catalogs/schemas to reach the table holding the
columns you want to analyze.

You can filter the table or column lists by typing the desired text in the Table filter  or Column filter fields
respectively. The lists will show only the tables/columns that correspond to the text you type in.

6. Click the table name to list all its columns in the right-hand panel of the [Column Selection] dialog box.

7. In the list to the right, select the check boxes of the column(s) you want to analyze and click OK to proceed
to the next step.

You can drag the columns to be analyzed directly from the DQ Repository tree view to the editor.

If you right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view, the selected column will be automatically located under the corresponding connection in
the tree view.

8. Click Select Columns from the B set and follow the same steps to select the second set of columns or drag
it to the right column panel.

9. Select the Compute only number of A rows not in B check box if you want to match the data from the A
set against the data from the B set and not vice versa.

Finalizing and executing the analysis

1. In the Data Filter view, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.

2. In the Analysis Parameter view and in the Number of connections per analysis field, set the number of
concurrent connections allowed per analysis to the selected database, if required.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.
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3. If you have defined context variables in the Contexts view in the analysis editor:

• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.

• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

4. Save the analysis and press F6 to execute it.

A confirmation message is displayed.

5. Click OK if you want to continue the operation.

The Analysis Results  view opens showing the analysis results.

In this example, 72.73% of the data present in the columns in the account table could be matched with the
same data in the columns in the account_back table.

Through this view, you can also access the actual analyzed data via the Data Explorer.

To access the analyzed data rows, right-click any of the lines in the table and select:

Option To...

View match rows access a list of all rows that could be matched in the two identical column sets

View not match rows access a list of all rows that could not be matched in the two identical column sets

View rows access a list of all rows in the two identical column sets

The data explorer does not support connections which has empty user name, such as Single sign-on of MS SQL Server. If
you analyze data using such connection and you try to view data rows in the Data Explorer perspective, a warning message
prompt you to set your connection credentials to the SQL Server.

The figure below illustrates the data explorer list of all rows that could be matched in the two sets, eight in this
example.
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From the SQL editor, you can save the executed query and list it under the Libraries > Source Files folders in
the DQ Repository tree view if you click the save icon on the editor toolbar. For more information, see Saving
the queries executed on indicators.

The figure below illustrates the data explorer list of all rows that could not be matched in the two sets, three in
this example.

For more information about the data explorer Graphical User Interface, see Main window of the data explorer.

16.3. Matching primary and foreign keys
You can create an analysis that matches foreign keys in one table to primary keys in the other table and vice versa.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To match primary and foreign keys in tables, do the following:

Defining the analysis

1. In the DQ Repository tree view, expand the Data Profiling folder.
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2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.

3. Expand the Redundancy Analysis folder and select Column Content Comparison.

4. Click Next.
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5. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

6. Set the analysis metadata (purpose, description and author name) in the corresponding fields and then click
Finish.

A file for the newly created analysis is displayed under the Analysis folder in the DQ Repository tree view.
The analysis editor opens with the defined analysis metadata.
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Selecting the primary and foreign keys

1. Click Analyzed Column Sets to display the corresponding view.

In this example, you want to match the foreign keys in the customer_id column of the sales_fact_1998 table
with the primary keys in the customer_id column of the customer table, and vice versa. This will explore the
relationship between the two tables to show us for example if every customer has an order in the year 1998.

2. From the Connection box, select the database connection relevant to the database to which you want to
connect. This box lists all the connections created in the Studio with the corresponding database names.

3. Click Select columns for the A set to open the [Column Selection] dialog box.

If you want to check the validity of the foreign keys, select the column holding the foreign keys for the A set and the
column holding the primary keys for the B set.
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4. Expand the DB Connections folder and browse through the catalogs/schemas to reach the table holding the
column you want to match. In this example, the column to be analyzed is customer_id that holds the foreign
keys.

You can filter the table or column lists by typing the desired text in the Table filter  or Column filter fields
respectively. The lists will show only the tables/columns that correspond to the text you type in.

5. Click the table name to display all its columns in the right-hand panel of the [Column Selection] dialog box.

6. In the list to the right, select the check box of the column holding the foreign keys and then click OK to
proceed to the next step.

You can drag the columns to be analyzed directly from the DQ Repository tree view to the editor.

If you right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view, the selected column will be automatically located under the corresponding connection in
the tree view.

7. Click Select Columns from the B set and follow the same steps to select the column holding the primary
keys or drag it from the DQ Repository to the right column panel.

If you select the Compute only number of rows not in B check box, you will look for any missing primary keys
in the column in the B set.

8. Click Data Filter in the analysis editor to display the view where you can set a filter on each of the analyzed
columns.

9. Click the save icon on top of the editor, and then press F6 to execute this key-matching analysis. A
confirmation message is displayed.

10. Read the confirmation message and click OK if you want to continue the operation.

The Analysis Resultsview opens to display the analysis results.

The execution of this type of analysis may takes some time. Wait till the Analysis Results view opens automatically
showing the analysis results.
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In this example, every foreign key in the sales_fact_1998 table is identified with a primary key in the customer
table. However, 98.22% of the primary keys in the customer table could not be identified with foreign keys
in the sales_fact_1998 table. These primary keys are for the customers who did not order anything in 1998.

Through this view, you can also access the actual analyzed data via the data explorer.

To access the analyzed data rows, right-click any of the lines in the table and select:

Option To...

View match rows access a list of all rows that could be matched in the two identical column sets

View not match rows access a list of all rows that could not be matched in the two identical column sets

View rows access a list of all rows in the two identical column sets

The data explorer does not support connections which has empty user name, such as Single sign-on of MS SQL Server. If
you analyze data using such connection and you try to view data rows in the Data Explorer perspective, a warning message
prompt you to set your connection credentials to the SQL Server.

The figure below illustrates the data explorer list of all analyzed rows in the two columns.

From the SQL editor, you can save the executed query and list it under the Libraries > Source Files folders in the DQ
Repository tree view if you click the save icon on the editor toolbar. For more information, see Saving the queries executed
on indicators.

For more information about the data explorer Graphical User Interface, see Main window of the data explorer.
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Chapter 17. Correlation analyses
This chapter provides all the information you need to perform column correlation analyses between nominal
and interval columns or nominal and date columns in database tables. A column correlation analysis can also
investigate minimal correlations between nominal columns in the same table.

Column correlation analyses are usually used to explore relationships and correlations in data. They are not used
to provide statistics about the quality of data.
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17.1. What are column correlation analyses
Your studio provides the possibility to explore relationships and correlations between two or more columns so
that these relationships and correlations give a new interpretation of the data through describing how data values
are correlated at different positions.

Column correlation analyses are possible only on database columns for the time being. You can not use these analyses on
file connections.

It is very important to make the distinction between column correlation analyses and all other types of data quality
analyses. Column correlation analyses are usually used to explore relationships and correlations in data and not
to provide statistics about the quality of data.

Several types of column correlation analysis are possible. For more information, see Creating a numerical
correlation analysis, Creating a time correlation analysis and Creating a nominal correlation analysis.

For more information about the use of data mining types in the studio, see Data mining types.

17.2. Numerical correlation analyses
This type of analysis analyzes correlation between nominal and interval columns and gives the result in a kind
of a bubble chart.

A bubble chart is created for each selected numeric column. In a bubble chart, each bubble represents a distinct
record of the nominal column. For example, a nominal column called outlook with 3 distinct nominal instances:
sunny (11 records), rainy (16 records) and overcast (4 records) will generate a bubble chart with 3 bubbles.

The second column in this example is the temperature column where temperature is in degrees Celsius. The
analysis in this example will show the correlation between the outlook and the temperature columns and will give
the result in a bubble chart. The vertical axis represents the average of the numeric column and the horizontal
axis represents the number of records of each nominal instance. The average temperature would be 23.273 for the
"sunny" instances, 7.5 for the "rainy" instances and 18.5 for the "overcast" instances.

The two things to pay attention to in such a chart is the position of the bubble and its size.

Usually, outlier bubbles must be further investigated. The more the bubble is near the left axis, the less confident
we are in the average of the numeric column. For example, the overcast nominal instance here has only 4 records,
hence the bubble is near the left axis. We cannot be confident in the average with only 4 records. When looking
for data quality issues, these bubbles could indicate problematic values.

The bubbles near the top of the chart and those near the bottom of the chart may suggest data quality issues too.
A too high or too low temperature in average could indicate a bad measure of the temperature.

The size of the bubble represents the number of null numeric values. The more there are null values in the interval
column, the bigger will be the bubble.
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When several nominal columns are selected, the order of the columns plays a crucial role in this analysis. A series
of bubbles (with one color) is displayed for the average temperature and the weather. Another series of bubbles is
displayed for the average temperature and each record of any other nominal column.

17.2.1. Creating a numerical correlation analysis

In the example below, you want to create a numerical correlation analysis to compute the age average of the
personnel of different enterprises located in different states. Three database columns are used for the analysis:
STATE, AGE and COMPANY.

The numerical correlation analysis is possible only on database columns for the time being. You can not use this analysis
on file connections.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.

3. Start typing numerical in the filter field, select Numerical Correlation Analysis and then click Next.
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4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

5. Set the analysis metadata (purpose, description and author name) in the corresponding fields and then click
Finish.

A folder for the newly created analysis is listed under Analysis in the DQ Repository tree view, and the
analysis editor opens on the analysis metadata.

Selecting the columns you want to analyze and setting analysis parameters

1. In the analysis editor and from the Connection list, select the database connection on which to run the
analysis.
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The numerical correlation analysis is possible only on database columns for the time being. You can change
your database connection by selecting another connection from the Connection list. If the analyzed columns
do not exist in the new database connection you want to set, you receive a warning message that enables you
to continue or cancel the operation.

2. Click Select columns to analyze to open the [Column Selection] dialog box.
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3. Browse the catalogs/schemas in your database connection to the column(s) you want to analyze.

You can filter the table or column lists by typing the desired text in the Table filter  or Column filter fields
respectively. The lists will show only the tables/columns that correspond to the text you type in.

4. Click the table name to list all its columns in the right-hand panel of the [Column Selection] dialog box.

5. In the column list, select the check boxes of the column(s) you want to analyze and click OK.

In this example, you want to compute the age average of the personnel of different enterprises located in
different states. Then the columns to be analyzed are AGE, COMPANY and STATE.

The selected columns are displayed in the Analyzed Column  view of the analysis editor.
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You can drag the columns to be analyzed directly from the corresponding database connection in the DQ
Repository tree view into the Analyzed Columns area.

If you right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view, the selected column will be automatically located under the corresponding connection in
the tree view.

6.
In the Indicators view, click  to open a dialog box where you can set thresholds for each indicator.

The indicators representing the simple statistics are by-default attached to this type of analysis.

7. In the Data Filter view, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.

8. In the Analysis Parameter view and in the Number of connections per analysis field, set the number of
concurrent connections allowed per analysis to the selected database connection, if required.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

9. If you have defined context variables in the Contexts view in the analysis editor:
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• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.

• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

10. Save the analysis and press F6 to execute it.

The graphical result is displayed in the Graphics panel to the right of the editor.

The data plotted in the bubble chart have different colors. The legend shows which color refers to which data.

From the generated graphic, you can:

• place the pointer on any of the bubbles to see the correlated data values at that position,

• right-click any of the bubbles and select:

Option To...

Show in full screen open the generated graphic in a full screen

View rows access a list of all analyzed rows in the selected position

The below figure illustrates an example of the SQL editor listing the correlated data values at the selected position.
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From the SQL editor, you can save the executed query and list it under the Libraries > Source Files folders in
the DQ Repository tree view if you click the save icon on the editor toolbar. For more information, see Saving
the queries executed on indicators.

For more information on the bubble chart, see Accessing the detailed view of the analysis results.

17.2.2. Accessing the detailed view of the analysis
results

Prerequisite(s): A numerical correlation analysis is defined and executed in the Profiling perspective of the
studio.

To access a more detailed view of the analysis results of the procedure outlined in Creating a numerical correlation
analysis, do the following:

1. Click the Analysis Results tab at the bottom of the analysis editor to open the corresponding view.

2. Click on Analysis Result to see more detail of the analysis results in the three different views: Graphics,
Simple Statistics and Data.

3. Click Graphics, Simple Statistics or Data to show the generated graphic, the number of the analyzed records
or the actual analyzed data respectively.

In the Graphics view, the data plotted in the bubble chart have different colors with the legend pointing out which
color refers to which data.
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The more the bubble is near the left axis the less confident we are in the average of the numeric column. For the
selected bubble in the above example, the company name is missing and there are only two data records, hence
the bubble is near the left axis. We cannot be confident about age average with only two records. When looking
for data quality issues, these bubbles could indicate problematic values.

The bubbles near the top of the chart and those near the bottom of the chart may suggest data quality issues too,
too big or too small age average in the above example.

From the generated graphic, you can:

• clear the check box of the value(s) you want to hide in the bubble chart,

• place the pointer on any of the bubbles to see the correlated data values at that position,

• right-click any of the bubbles and select:

Option To...

Show in full screen open the generated graphic in a full screen

View rows access a list of all analyzed rows in the selected column

The Simple Statistics view shows the number of the analyzed records falling in certain categories, including the
number of rows, the number of distinct and unique values and the number of duplicates.
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The Data view displays the actual analyzed data.

You can sort the data listed in the result table by simply clicking any column header in the table.

17.3. Time correlation analyses
This type of analysis analyzes correlation between nominal and date columns and gives the result in a gantt chart
that illustrates the start and finish dates of each value of the nominal column.

17.3.1. Creating a time correlation analysis

In the example below, you want to create time correlation analysis to compute the minimal and maximal birth
dates for each listed country in the selected nominal column. Two columns are used for the analysis: birthdate
and country.

The time correlation analysis is possible only on database columns for the time being. You can not use this analysis on
file connections.



Creating a time correlation analysis

618 Talend Open Studio for MDM User Guide

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

Defining the analysis

1. In the DQ Repository tree view, expand the Data Profiling folder.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.

3. Start typing time in the filter field, select Time Correlation Analysis and click Next.
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4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

5. Set the analysis metadata (purpose, description and author name) in the corresponding fields and then click
Finish.

A folder for the newly created analysis is listed under Analysis in the DQ Repository tree view, and the
analysis editor opens on the analysis metadata.

Selecting the columns you want to analyze and setting analysis parameters

1. In the analysis editor and from the Connection list, select the database connection on which to run the
analysis.
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The time correlation analysis is possible only on database columns for the time being. You can change your
database connection by selecting another connection from the Connection list. If the analyzed columns do
not exist in the new database connection you want to set, you receive a warning message that enables you
to continue or cancel the operation.

2. Click Select columns to analyze to open the [Column Selection] dialog box and select the columns, or drag
them directly from the DQ Repository tree view into the Analyzed Columns view.

If you right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view, the selected column will be automatically located under the corresponding connection in
the tree view.

3.
If required, click  in the Indicators view to open a dialog box where you can set thresholds for each
indicator.

The indicators representing the simple statistics are by-default attached to this type of analysis.

4. In the Data Filter view, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.
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5. In the Analysis Parameterview and in the Number of connections per analysis field, set the number of
concurrent connections allowed per analysis to the selected database connection, if required.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

6. If you have defined context variables in the analysis editor:

• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.

• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

7. Click the save icon on top of the editor and press F6 to execute the column comparison analysis.

The graphical result is displayed in the Graphics panel to the right.

This gantt chart displays a range showing the minimal and maximal birth dates for each country listed in the
selected nominal column. It also highlights the range bars that contain null values for birth dates.

For example, in the above chart, the minimal birth date for Mexico is 1910 and the maximal is 2000. And of
all the data records where the country is Mexico, 41 records have null value as birth date.

From the generated graphic, you can:

• place the pointer on any of the range bars to display the correlated data values at that position,

• put the pointer on a specific birth date and drag it to another birth date to change the chart and show the minimal
and maximal birth dates related only to your selection.

• right-click any of the range bars and select:

Option To...

Show in full screen open the generated graphic in a full screen
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View rows access a list of all analyzed rows in the selected nominal column

The below figure illustrates an example of the SQL editor listing the correlated data values at the selected range bar.

From the SQL editor, you can save the executed query and list it under the Libraries > Source Files folders in the DQ
Repository tree view if you click the save icon on the editor toolbar. For more information, see Saving the queries executed
on indicators.

For more information on the gantt chart, see  Accessing the detailed view of the analysis results.

17.3.2.  Accessing the detailed view of the analysis
results

Prerequisite(s): A time correlation analysis is defined and executed is the Profiling perspective of the studio.

To access a more detailed view of the analysis results of the procedure outlined in Creating a time correlation
analysis, do the following:

1. Click the Analysis Results tab at the bottom of the analysis editor to open the corresponding view.

2. Click on Analysis Result to display the analysis more detailed results in the three different views: Graphics,
Simple Statistics and Data.

3. Click Graphics, Simple Statistics or Data to show the generated graphic, the number of the analyzed records
or the actual analyzed data respectively.

In the Graphics view, you can clear the check box of the value(s) you want to hide in the chart.
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You can also select a specific birth date range to show if you put the pointer at the start nominal value you want
to show and drag it to the end nominal value you want to show.

From the generated graphic, you can:

• clear the check box of the value(s) you want to hide in the chart,

• place the pointer on any of the range bars to display the correlated data values at that position,

• right-click any of the bars and select:

Option To...

Show in full screen open the generated graphic in a full screen

View rows access a list of all analyzed rows in the selected column

The Simple Statistics view shows the number of the analyzed records falling in certain categories, including the
number of rows, the number of distinct and unique values and the number of duplicates.

The Data view displays the actual analyzed data.
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You can sort the data listed in the result table by simply clicking any column header in the table.

17.4. Nominal correlation analyses
This type of analysis analyzes minimal correlations between nominal columns in the same table and gives the
result in a chart.

In the chart, each column will be represented by a node that has a given color. The correlations between the
nominal values are represented by lines. The thicker the line is, the weaker the association is. Thicker lines can
identify problems or correlations that need special attention. However, you can always inverse edge weight, that
is give larger edge thickness to higher correlation, by selecting the Inverse Edge Weight check box below the
nominal correlation chart.

The correlations in the chart are always pairwise correlations: show associations between pairs of columns.

17.4.1. Creating a nominal correlation analysis

In the example below, you want to create nominal correlation analysis to compute the minimal and maximal birth
dates for each listed country in the selected nominal column. Two columns are used for the analysis: birthdate
and country.

The nominal correlation analysis is possible only on database columns for the time being. You can not use this analysis
on file connections.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

Defining the analysis

1. In the DQ Repository tree view, expand the Data Profiling folder.

2. Right-click the Analyses folder and select New Analysis.
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The [Create New Analysis] wizard opens.

3. Start typing nominal in the filter field, select Nominal Correlation Analysis and then click Next.

4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.
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5. Set the analysis metadata (purpose, description and author name) in the corresponding fields and then click
Finish.

A folder for the newly created analysis is listed under Analysis in the DQ Repository tree view, and the
analysis editor opens on the analysis metadata.

Selecting the columns you want to analyze

1. In the analysis editor and from the Connection list, select the database connection on which to run the
analysis.

The nominal correlation analysis is possible only on database columns for the time being. You can change
your database connection by selecting another connection from the Connection list. If the analyzed columns
do not exist in the new database connection you want to set, you receive a warning message that enables you
to continue or cancel the operation.

2. Click Select columns to analyze to open the [Column Selection] dialog box and select the columns you
want to analyze, or drag them directly from the DQ Repository tree view.

Please notice that if you select too many columns, the analysis result chart will be very difficult to read.
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You can right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository viewto locate the selected column under the corresponding connection in the tree view.

3.
If required, click  in the Indicators view to open a dialog box where you can set thresholds for each
indicator.

The indicators representing the simple statistics are by-default attached to this type of analysis.

4. In the Data Filter view, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.

5. In the Analysis Parameter view and in the Number of connections per analysis field, set the number of
concurrent connections allowed per analysis to the selected database connection, if required.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

6. If you have defined context variables in the analysis editor:

• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.

• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

7. Save the analysis and press F6 to execute it.

The graphical result is displayed in the Graphics panel to the right of the editor.

In the above chart, each value in the country and marital-status columns is represented by a node that has a
given color. Nominal correlation analysis is carried out to see the relationship between the number of married
or single people and the country they live in. Correlations are represented by lines.
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To have a better view of the graphical result of the nominal correlation analysis, right-click the graphic in
the Graphics panel and select Show in full screen. For more information on the chart, see  Accessing the
detailed view of the analysis results.

17.4.2.  Accessing the detailed view of the analysis
results

Prerequisite(s): A nominal correlation analysis is defined and executed in the Profiling perspective of the studio.

To access a more detailed view of the analysis results of the procedure outlined in Creating a nominal correlation
analysis, do the following:

1. Click the Analysis Results tab at the bottom of the analysis editor to open the corresponding view.

2. Click on Analysis Result to display the analysis more detailed results in three different views: Graphics,
Simple Statistics and Data.

3. Click Graphics, Simple Statistics or Data to show the generated graphic, the number of the analyzed records
or the actual data respectively.

The Graphics view shows the generated graphic for the analyzed columns.
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In the above chart, each value in the country and marital-status columns is represented by a node that has a given
color. Nominal correlation analysis is carried out to see the relationship between the number of married or single
people and the country they live in. Correlations are represented by lines, the thicker the line is, the higher the
association is - if the Inverse Edge Weight check box is selected.

The buttons below the chart help you manage the chart display. The following table describes these buttons and
their usage:

Button Description

Filter Edge Weight Move the slider to the right to (filter out edges with small weight) visualize the more important
edges.

plus and minus Click the [+] or [-] buttons to respectively zoom in and zoom out the chart size.

Reset Click to put the chart back to its initial state.

Inverse Edge Weight By default, the thicker the line is, the weaker the correlation is.

Select this check box to inverse the current edge weight, that is give larger edge thickness to higher
correlation.

Picking Select this check box to be able to pick any node and drag it to anywhere in the chart.

Save Layout Click this button to save the chart layout.

Restore Layout Click this button to restore the chart to its previously saved layout.

The Simple Statistics view shows the number of the analyzed records falling in certain categories, including the
number of rows, the number of distinct and unique values and the number of duplicates.

The Data view displays the actual analyzed data.
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You can sort the data listed in the result table by simply clicking any column header in the table.
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Chapter 18. Extended functionality: patterns
and indicators
This chapter provides detailed information about how to use regular expressions and SQL patterns to analyze and
monitor data in columns. It also explains how to use system and user-defined indicators when analyzing columns.
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18.1. Patterns
Patterns are sets of strings against which you can match the content of the columns to be analyzed.

18.1.1. Pattern types

Two types of patterns are listed under the Patterns folder in the DQ Repository tree view: regular expressions
and SQL patterns.

Regular expressions (regex) are predefined patterns that you can use to search and manipulate text in the databases
to which you connect. You can also create your own regular expressions and use them to analyze columns.

SQL patterns are a kind of personalized patterns that are used in SQL queries. These patterns usually
contain the percent sign (%). For more information on SQL wildcards, see http://www.w3schools.com/SQL/
sql_wildcards.asp.

You can use any of the above two pattern types either with column analyses or with the analyses of a set of columns
(simple table analyses). These pattern-based analyses illustrate the frequencies of various data patterns found in
the values of the analyzed columns. For more information, see Analyzing columns in a databaseand How to create
an analysis of a set of columns using patterns.

From the studio, you can generate graphs to represent the results of analyses using patterns. You can also view
tables in the Analysis Results view that write in words the generated graphs. From those graphs and analysis
results you can easily determine the percentage of invalid values based on the listed patterns. For more information,
see Tab panel of the analysis editors.

Management processes for SQL patterns and regular expressions, including those for Java, are the same. For more
information, see Managing regular expressions and SQL patterns.

Some databases do not support regular expressions. To work with such databases, some configuration is necessary before
being able to use regular expressions. For more information, see Managing User-Defined Functions in databases.

18.1.2. Managing User-Defined Functions in databases

The regular expression function is built in several databases, but many other databases do not support it. The
databases that natively support regular expressions include: MySQL, PostgreSQL, Oracle 10g, and Ingres while
Microsoft SQL server and Netezza do not, for example.

A different case is when the regular expression function is built in the database but the query template of the
regular expression indicator is not defined.

From Profiling perspective of the studio, you can:

• extend the functionality of certain database servers to support the regular expression function. For more
information, see How to declare a User-Defined Function in a specific database.

• define the query template for a database that supports the regular expression function. For more information,
see How to define a query template for a specific database.

For information about using regular expressions with Teradata, check the article How to configure regular
expressions on Teradata.

For information about using regular expressions with Netezza, see What you need to know about some databases.

http://www.w3schools.com/SQL/sql_wildcards.asp
http://www.w3schools.com/SQL/sql_wildcards.asp
https://help.talend.com/pages/viewpage.action?pageId=190513345
https://help.talend.com/pages/viewpage.action?pageId=190513345
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18.1.2.1. How to declare a User-Defined Function in a specific
database

The regular expression function is not built into all different database environments. If you want to use the studio to
analyze columns against regular expressions in databases that do not natively support regular expressions, you can:

Either:

1. Install the relevant regular expressions libraries on the database. For an example of creating a regular
expression function on a database, see  Regular expressions on SQL Server.

2. Create a query template for the database in the studio. For more information, see How to define a query
template for a specific database.

Or:

• Execute the column analysis using the Java engine. In this case, the system will use the Java regular
expressions to analyze the specified column(s) and not SQL regular expressions. For more information on
the Java engine, see Using the Java or the SQL engine.

18.1.2.2. How to define a query template for a specific database

A query template defines the query logic required to analyze columns against regular expressions. The steps to
define a query template in the studio include the following:

• Create a query template for a specific database,

• Set the database-specific regular expression if this expression is not simple enough to be used with all databases.

The below example shows how to define a query template specific for the Microsoft SQL Server database.  Regular
expressions on SQL Server gives a detailed example on how to create a user-defined regular expression function
on an SQL server.

To define a query template for a specific database, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Expand System Indicators > Pattern Matching.
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3. Double-click Regular Expression Matching, or right-click it and select Open from the contextual menu.

The corresponding view is displayed to show the indicator metadata and its definition.

You need now to add to the list of databases the database for which you want to define a query template. This
query template will compute the regular expression matching.

4. Click the [+] button at the bottom of the Indicator Definition view to add a field for the new template.

5. In the new field, click the arrow and select the database for which you want to define the template. In this
example, select Ingres.

6. Copy the indicator definition of any of the other databases.

7. Click the Edit... button next to the new field.

The [Edit expression] dialog box is displayed.
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8. Paste the indicator definition (template) in the Expression box and then modify the text after WHEN in order
to adapt the template to the selected database. In this example, replace the text after WHEN with WHEN REGEX.

9. Click OK. The new template is displayed in the field.

10. Click the save icon on top of the editor to save your changes.

You have finalized creating the query template specific for the Ingres database. You can now start analyzing the
columns in this database against regular expressions.

If the regular expression you want to use to analyze data on this server is simple enough to be used with all
databases, you can start your column analyses immediately. If not, you must edit the definition of the regular
expression to work with this specific database, Ingres in this example.

If an analysis with a user-defined indicator runs successfully at least one time and later the indicator definition
template for the database is deleted, the analysis does not fail. It keeps running successfully because it uses the
previously generated SQL query.

For more information on how to set the database-specific regular expression definition, see How to edit a regular
expression or an SQL pattern and How to duplicate a regular expression or an SQL pattern.

18.1.2.3. How to edit a query template

You can edit the query template you create for a specific database.

To edit a query template for a specific database, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Expand System Indicator > Pattern Matching.
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3. Double-click Regular Expression Matching, or right-click it and select Open from the contextual menu.

The corresponding view is displayed to show the indicator metadata and its definition.

4.
Click the  button next to the database for which you want to edit the query template.

The [Edit expression] dialog box is displayed.
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5. In the Expression  area, edit the regular expression template as required and then click OK to close the dialog
box and proceed to the next step.

The regular expression template is modified accordingly.

18.1.2.4. How to delete a query template

You can delete the query template you create for a specific database.

To delete a query template for a specific database, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Expand System Indicators > Pattern Matching.

3. Double-click Regular Expression Matching, or right-click it and select Open from the contextual menu.
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The corresponding view is displayed to show the indicator metadata and its definition.

4.
Click the  button next to the database for which you want to delete the query template.

The selected query template is deleted from the list in the Indicator definition view.

18.1.3. Adding regular expressions and SQL patterns
to column analyses

You can use regular expressions and SQL patterns in column analyses in order to check all existing data in
the analyzed columns against these expressions and patterns. For more information, see How to add a regular
expression or an SQL pattern to a column analysis.

You can also edit the regular expression or SQL pattern parameters after attaching it to a column analysis. For
more information, see How to edit a pattern in the column analysis.

After the execution of the column analysis that uses a specific expression or pattern, you can:

• access a list of all valid/invalid data in the analyzed column. For more information, see How to view the data
analyzed against patterns.

18.1.4. Managing regular expressions and SQL
patterns

The management procedures of regular expressions and SQL patterns include operations like creating, testing,
duplicating, importing and exporting.

The sections below explain in detail each of the management option for regular expressions and SQL patterns.
Management processes for both types of patterns are exactly the same.
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18.1.4.1. How to create a new regular expression or SQL pattern

You can create new regular expressions or SQL patterns, including those for Java to be used in column analyses.

Management processes for regular expressions and SQL patterns are the same. The procedure below with all the included
screen captures reflect the steps to create a regular expression. You can follow the same steps to create an SQL pattern.

To create a new pattern, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns, and then right-click Regex.

2. From the contextual menu, select New Regex Pattern to open the corresponding wizard.
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When you open the wizard, a help panel automatically opens with the wizard. This help panel guides you
through the steps of creating new regular patterns.

3. In the Name field, enter a name for this new regular expression.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

4. If required, set other metadata (purpose, description and author name) in the corresponding fields and click
Next.

5. In the Regular expression field, enter the definition of the regular expression to be created. The regular
expression must be surrounded by single quotes.

For the PostgreSQL database, regular expressions are not compatible among the database different versions.

If you want to use the regular expression with PostgreSQL version 9.1 or greater, you must either:

• in the PostgreSQL database configuration, set the standard_conforming_strings parameter to off and write
double backslashes in the definition, or

• in the Regular expression field in the wizard, use a single backslash in the expression definition.

For further information about PostgreSQL regular expressions, select Window > Show View, expand Help and then
select Bookmarks.

6. From the Language Selection list, select the language (a specific database or Java).

7. Click Finish to close the dialog box.

A subfolder for this new regular expression is listed under the Regex folder in the DQ Repository tree view,
and the pattern editor opens with the defined metadata and the defined regular expression.
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8. In the Pattern Definition view, click the [+] button and add as many regular expressions as necessary in
the new pattern.

You can define the regular expressions specific to any of the available databases or specific to Java.

If the regular expression is simple enough to be used in all databases, select Default from the list.

Subfolders labeled with the specified database types or Java are listed below the name of the new pattern
under the Patterns folder in the DQ Repository tree view.
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9. Save the new pattern.

Once the pattern is created, you can drop it directly onto a database column in the open analysis editor.

10. If required, click the pattern name to display its detail in the Detail View in the Studio.

In the pattern editor, you can click Test next to the regular expression to test the regular pattern definition. For more
information, see How to test a regular expression in the Pattern Test View. Also, from the [Pattern Test View], you
can create a new pattern based on the regular expression you are testing. For further information, see How to create
a new pattern from the Pattern Test View .

18.1.4.2. How to test a regular expression in the Pattern Test View

It is possible to test character sequences against a predefined or newly created regular expression.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio.

To test a character sequence against a regular expression, do the following:

1. Follow the steps outlined in How to create a new regular expression or SQL pattern to create a new regular
expression.

2. In the open pattern editor, click Pattern Definition to open the relevant view.
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3. Click the Test button next to the definition against which you want to test a character sequence to proceed
to the next step.

The test view is displayed in the Studio showing the selected regular expression.

4. In the Test Area, enter the character sequence you want to check against the regular expression

5. From the DB Connection list, select the database in which you want to use the regular expression.

If you select to test a regular expression in Java, the Java option will be selected by default and the DB Connections
option and list will be unavailable in the test view.

6. Click Test.

An icon is displayed in the upper left corner of the view to indicate if the character sequence matches or does
not match the selected pattern definition.

7. If required, modify the regular expression according to your needs and then click Save to save your
modifications.

The pattern definition is modified accordingly in the pattern editor.

You can create/modify patterns directly from the Pattern Test View via the Create Pattern button. For further information,
see How to create a new pattern from the Pattern Test View

18.1.4.3. How to create a new pattern from the Pattern Test View

You can create your own customized patterns from the [Pattern Test View]. The advantage of creating a pattern
from this view is that you can create your customized pattern based on an already tested regular expression. All
you need to do is to customize the expression definition according to your needs before saving the new pattern.

To create a new pattern based on a predefined or a newly created regular expression, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns > Regex and double-click the pattern you
want to use to create your customized pattern.

The pattern editor opens in the studio.
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2. Click Test next to the definition you want to use as a base to create the new pattern.

The [Pattern Test View] is opened on the definition of the selected regular expression.

3. If required, test the regular expression through entering text in the Test Area. For further information, see
How to test a regular expression in the Pattern Test View.

4. Click Create Pattern to open the [New Regex pattern] wizard.
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5. In the Name field, enter a name for this new regular expression.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

6. If required, set other metadata (purpose, description and author name) in the corresponding fields and click
Next to proceed to the next step.

The definition of the initial regular expression is already listed in the Regular expression field.

7. Customize the syntax of the initial regular expression according to your needs. The regular expression
definition must be surrounded by single quotes.

For the PostgreSQL database, regular expressions are not compatible among the database different versions.
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If you want to use the regular expression with PostgreSQL version 9.1 or greater, you must either:

• in the PostgreSQL database configuration, set the standard_conforming_strings parameter to off and write
double backslashes in the definition, or

• in the Regular expression field in the wizard, use a single backslash in the expression definition.

For further information about PostgreSQL regular expressions, select Window > Show View, expand Help and then
select Bookmarks.

8. From the Language Selection list, select the database in which you want to use the new regular expression.

9. Click Finish to close the wizard.

A subfolder for the new pattern is listed under the Regex folder in the same file of the initial regular pattern.
The pattern editor opens on the pattern metadata and pattern definition.

18.1.4.4. How to generate a regular expression from the Date
Pattern Frequency Table

You can generate a regular pattern from the results of an analysis that uses the Date Pattern Frequency Table
indicator on a date column.

Prerequisite(s): In the Profiling perspective of the studio, a column analysis is created on a date column using
the Date Pattern Frequency Table indicator.

To be able to use the Date Pattern Frequency Table indicator on date columns, you must set the execution engine to Java
in the Analysis Parameter view of the column analysis editor. For more information on execution engines, see Using the
Java or the SQL engine.

For more information on how to create a column analysis, see Analyzing columns in a database.

To generate a regular expression from the results of a column analysis, do the following:

1. In the DQ Repository tree view, right-click the column analysis that uses the date indicator on a date column.

2. Select Open from the contextual menu to open the corresponding analysis editor.
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3. Press F6 to execute the analysis and display the analysis results in the Graphics panel to the right of the
Studio.

4. At the bottom of the editor, click the Analysis Results tab to display a more detailed result view.

In this example, 100.00% of the date values follow the pattern yyyy MM dd and 39.41% follow the pattern
yyyy dd MM.

5. Right-click the date value for which you want to generate a regular expression and select Generate Regex
Pattern from the contextual menu.

The [New Regex Pattern] dialog box is displayed.
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6. Click Next.

The date regular expression is already defined in the corresponding field.

7. Click Finish to proceed to the next step.

The pattern editor opens with the defined metadata and the generated pattern definition.
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The new regular expression is listed under Pattern > Regex in the DQ Repository tree view. You can drag
it onto any date column in the analysis editor.

8. If required, click the Test button to test a character sequence against this date regular expression as outlined
in How to test a regular expression in the Pattern Test View.

18.1.4.5. How to edit a regular expression or an SQL pattern

You can open the editor of any regular expression or SQL pattern to check its settings and/or edit its definition
in order to:

• adapt it to a specific database type, or

• adapt it to a specific use.

To open/edit a regular expression or an SQL pattern, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns.

2. Browse through the regular expression or SQL pattern lists to reach the expression or pattern you want to
open/edit.

3. Right-click its name and select Open from the contextual menu.

The pattern editor opens displaying the regular expression or SQL pattern settings.
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4. Modify the pattern metadata, if required, and then click Pattern Definition to display the relevant view. In
this view, you can: edit pattern definition, change the selected database and add other patterns specific to
available databases through the [+] button.

For the PostgreSQL database, regular expressions are not compatible among the database different versions.

If you want to use the regular expression with PostgreSQL version 9.1 or greater, you must either:

• in the PostgreSQL database configuration, set the standard_conforming_strings parameter to off and write
double backslashes in the definition, or

• in the Regular expression field in the wizard, use a single backslash in the expression definition.

For further information about PostgreSQL regular expressions, select Window > Show View, expand Help and then
select Bookmarks.

5. If the regular expression or SQL pattern is simple enough to be used in all databases, select Default in the list.

6. Click the save icon on top of the editor to save your changes.

You can test regular expressions before start using them against data in the specified database. For more information, see
How to test a regular expression in the Pattern Test View.

When you edit a regular expression or an SQL pattern, make sure that your modifications are suitable for all the analyses
that may be using this regular expression or SQL pattern.

18.1.4.6. How to export regular expressions or SQL patterns

You can export regular expressions or SQL patterns from your current version of the studio to Talend Exchange
where they are saved as .xmi files. Other users can then import these patterns from the exchange server into their
studios and use them in their analyses.

You can also export regular expressions and SQL patterns and store them locally in a csv file. For more information
about the content lay out of the csv file, seeHow to import regular expressions or SQL patterns .
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Management processes for regular expressions and SQL patterns are the same. The procedure below with all the included
screen captures reflect the steps to export regular expressions. You can follow the same steps to export SQL patterns.

How to export regular expressions or SQL patterns to Talend Exchange

You can export regular expressions or SQL patterns from your current version of studio to Talend Exchange
where you can share them with other users. The exported patterns are saved as .xmi files on the exchange server.

Patterns will be exported with the exact path they have in the initial repository. When users import them from
Talend Exchange into the repository of their studios, these patterns will be imported under the same folder or
subfolders they had in the initial repository.

The below procedure uses regular expressions as an example. You can follow the same steps to export SQL
patterns.

To export regular expressions to Talend Exchange, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns.

2. Right-click Regex and select Export for Talend Exchange.

The [Export for Talend Exchange] wizard is displayed.

3. Browse to the folder where to save the regular expressions.

4. Click Select All to select all the regular expressions in the list or select the check boxes of the regular
expressions you want to export to the specified folder.

Select the Show only selected elements check box to list only the patterns you want to export.
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5. Click Finish.

The .xmi file of each selected pattern is saved as a zip file in the defined folder.

6. Upload the zip files to Talend Exchange at http://www.talendforge.org/exchange. Please create an account
on the Talend Exchange server if you do not have one already.

To export a single regular expression family to Talend Exchange, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns, and then browse to the regular expression
you want to export.

2. Right-click it and then select Export for Talend Exchange from the contextual menu.

The [Export for Talend Exchange] wizard opens.

http://www.talendforge.org/exchange


Managing regular expressions and SQL patterns

Talend Open Studio for MDM User Guide 653

3. Click Select All to select all the regular expressions in the list, or select the check boxes of the regular
expressions or SQL patterns you want to export to the folder.

4. Click Finish to close the wizard.

The .xmi file of each selected pattern is saved as a zip file in the defined folder.

5. Upload the zip files to Talend Exchange at http://www.talendforge.org/exchange. Please create an account
on the Talend Exchange server if you do not have one already.

Patterns are uploaded to Talend Exchange as .xmi files.

When users import these .xmi files from Talend Exchange into the repository of their studios, the patterns are
imported under the same family subfolder, and thus have the path they had in the initial repository.

How to export regular expressions or SQL patterns to a csv file

To export regular expressions to a csv file, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns, and then right-click Regex.

2. From the contextual menu, select Export Patterns.

The [Export Patterns] wizard opens.

http://www.talendforge.org/exchange
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3. Browse to the csv file where to save the regular expressions.

4. Click Select All to select all listed regular expressions or select the check boxes of the regular expressions
you want to export to the csv file.

5. Click Finish to close the wizard.

All exported regular expressions are saved in the defined csv file.

When users try to import these regular expressions from the csv file into the repository of their studios,
the regular expressions will be imported under the Regex folder, and thus have the same path in the new
repository.

To export a single regular expression family to a csv file, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns, and then browse to the regular expression
family you want to export.
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2. From the contextual menu, select Export Patterns.

The [Export Patterns] wizard opens.

3. Click Select All to select all the check boxes of the regular expressions or select the check boxes of the regular
expressions you want to export to the csv file.
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4. Click Finish to close the wizard.

All exported regular expressions are saved in the defined csv file.

When users try to import these regular expressions from the csv file into the repository of their studios, the regular
expressions will be imported under the same subfolder, and thus have in the new repository the same path they
had in the initial repository.

18.1.4.7. How to import regular expressions or SQL patterns

You can import regular expressions or SQL patterns from Talend Exchange into your studio and use them on
analyses. This way you can share all the patterns created by other users and stored on the exchange server.

You can also import the regular expressions or SQL patterns stored locally in a csv file. The csv file must have
specific columns including the ones listed in the table below. The csv file may contain only a few of them.

Column name Description

Label the label of the pattern (must not be empty)

Purpose the purpose of the pattern (can be empty)

Description the description of the pattern (can be empty)

Author the author of the regular expression (can be empty)

Relative Path the relative path to the root folder (can be empty)

All_ DB_Regexp the regular expression applicable to all databases (can be empty)

<database name>_Regexp the regular expression applicable to this specific databases (can be empty)

How to import regular expressions or SQL patterns from Talend Exchange

You can import the .xmi files of regular expressions or SQL patterns from Talend Exchange into the repository
of your current studio and use them to analyze columns.

You can import only versions that are compatible with the version of your current studio.

Prerequisite(s): Your network is up and running.

The below procedure uses SQL patterns as an example. You can follow the same steps to import regular
expressions.

To import SQL patterns from Talend Exchange, do the following:

1. In the DQ Repository tree view, expand Libraries > Exchange.

If you have connection problems, you will not have access to any of the items under the Exchange node. A
pop-up will prompt you to check your internet connection.

2. Under Exchange, expand SQL and right-click the name of the pattern you want to import.
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3. Select Import in DQ Repository.

The [Import From Talend Exchange] wizard opens.

You will have access only to versions that are compatible with the version of your current studio.

4. Select the Overwrite existing items check box if some error and warning messages are listed in the Error
and Warning area.

This means that a pattern with the same name already exists in the current studio. The imported pattern will
replace the one in the studio.

5. Click Finish.
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A progress information bar is displayed. The pattern is listed under the Patterns > SQL folder in the DQ
Repository tree view.

The patterns you import in your studio will be imported with the structure they had in the initial repository.
They will be imported under the same folder or subfolder they had initially.

How to import regular expressions or SQL patterns from a csv file

Prerequisite(s): The csv file is stored locally.

To import regular expressions from a csv file, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns.

2. Right-click Regex and select Import patterns.

The [Import Patterns] wizard opens.

3. Browse to the csv file holding the regular expressions.

4. In the Duplicate patterns handling area, select:

Option To...

skip existing patterns import only the regular expressions that do not exist in the corresponding lists in the DQ
Repository tree view. A warning message is displayed if the imported patterns already
exist under the Patterns folder.

rename new patterns with suffix identify each of the imported regular expressions with a suffix. All regular expression
will be imported even if they already exist under the Patterns folder.

5. Click Finish.

A confirmation message is displayed.
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6. Click OK.

All imported regular expressions are listed under the Regex folder in the DQ Repository tree view.

The regular expressions are imported under the same folders or subfolders they had in the initial repository.

A warning icon  next to the name of the imported regular expression or SQL pattern in the tree view identifies that it is
not correct. You must open the expression or the pattern and try to figure out what is wrong. Usually, problems come from
missing quotes. Check your regular expressions and SQL patterns and ensure that they are encapsulated in single quotes.

18.1.4.8. How to duplicate a regular expression or an SQL pattern

To avoid creating a regular expression or an SQL pattern from scratch, you can duplicate an existing one and work
around its metadata and definition to have a new regular expression or SQL pattern to be used in data profiling
analyses.

To duplicate a regular expression or an SQL pattern, do the following:

1. In the DQ Repository tree view, expand Libraries > patterns.

2. Browse through the regular expression/SQL pattern lists to reach the expression/pattern you want to duplicate.

3. Right-click its name and select Duplicate... from the contextual menu.

The duplicated regular expression/SQL pattern is displayed under the Regex/SQL folder in the DQ
Repository tree view.

You can now double-click the duplicated pattern to modify its metadata and/or definition as needed.

For the PostgreSQL database, regular expressions are not compatible among the database different versions.

If you want to use the regular expression with PostgreSQL version 9.1 or greater, you must either:

• in the PostgreSQL database configuration, set the standard_conforming_strings parameter to off and write double
backslashes in the definition, or

• in the Regular expression field in the wizard, use a single backslash in the expression definition.

For further information about PostgreSQL regular expressions, select Window > Show View, expand Help and then select
Bookmarks.

You can test new regular expressions before start using them against data in the specified database. For more
information, see How to test a regular expression in the Pattern Test View.

18.1.4.9. How to delete a regular expression or an SQL pattern

You can delete regular expressions or SQL patterns directly from the Analyzed Columns view or from the DQ
Repository tree view.

How to delete a regular expression or an SQL pattern from the analyzed
column

A column analysis is open in the analysis editor.

To delete a regular expression or an SQL pattern from the analyzed column, do the following:
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1. Click Analyze Columns to display the analyzed columns view.

2. Right-click the regular expression/SQL pattern you want to delete and select Remove Elements from the
contextual menu.

The selected regular expression/SQL pattern disappears from the Analyzed Column list.

How to delete and restore a regular expression or an SQL pattern

To delete a regular expression or an SQL pattern from the DQ Repository tree view, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns.

2. Browse to the regular expression or SQL pattern you want to remove from the list.

3. Right-click the expression or pattern and select Delete from the contextual menu.

The regular expression or SQL pattern is moved to the Recycle Bin.
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To delete it from the Recycle Bin, do the following:

1. Right-click it in the Recycle Bin and choose Delete from the contextual menu.

If it is not used by any analysis in the current Studio, a [Delete forever] dialog box is displayed.

2. Click Yes to confirm the operation and close the dialog box.

If it is used by one or more analyses in the current Studio, a dialog box is displayed to list all the analyses
that use the pattern.

3. Either:

• Click OK to close the dialog box without deleting the pattern from the recycle bin.

• Select the Force to delete all the dependencies check box and then click OK to delete the pattern from
the recycle bin and to delete all the dependent analyses from the Data Profiling node.

You can also delete the pattern permanently by emptying the recycle bin. To empty the Recycle Bin, do the
following:

1. Right-click the Recycle Bin and select Empty recycle bin.

If the pattern is not used by any analysis in the current Studio, a confirmation dialog box is displayed.

2. Click Yes to empty the recycle bin.

If the pattern is used by one or more analyses in the current Studio, a dialog box is displayed to list all the
analyses that use the pattern.

3. Click OK to close the dialog box without removing the pattern from the recycle bin.

To restore a pattern from the Recycle Bin, do the following:
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• In the Recycle Bin, right-click the pattern and select Restore.

The pattern is moved back to the Libraries node.

18.2. Indicators
Indicators can be the results achieved through the implementation of different patterns that are used to define the
content, structure and quality of your data.

Indicators represent as well the results of highly complex analyses related not only to data-matching, but also to
different other data-related operations.

18.2.1. Indicator types

Two types of indicators are listed under the Indicators folder in the DQ Repository tree view: system indicators
and user-defined indicators.

User-defined indicators, as their name indicates, are indicators created by the user. You can use them through a
simple drag-and-drop operation from the User Defined Indicators folder in the tree view. User-defined indicators
are used only with column analyses. For more information on how to set user-defined indicators for columns, see
How to set user-defined indicators.

System indicators are predefined indicators grouped under different categories in the System Indicators folder in
the DQ Repository tree view. Each category of the system indicators is used with a corresponding analysis type.

You can not create a system indicator or drag it directly from the DQ Repository tree view to an analysis. However,
you can open and modify the parameters of a system indicator to adapt it to a specific database for example. For
further information, see How to edit a system indicator

Several management options including editing, duplicating, importing and exporting are possible for both types
of indicators. For more information, see Managing user-defined indicators and Managing system indicators.

The below sections describe the system indicators used on column analyses. These system indicators can range
from simple or advanced statistics to text strings analysis, including summary data and statistical distributions
of records.

You can see under the System Indicators folder in the DQ Repository tree view system indicators other than the indicators
in the below sections. Those different system indicators are used on the other analysis types, for example redundancy,
correlation and overview analyses.

18.2.1.1. Simple statistics

They provide simple statistics on the number of records falling in certain categories including the number of rows,
the number of null values, the number of distinct and unique values, the number of duplicates, or the number of
blank fields.

• Blank Count: counts the number of blank rows. A "blank" is a non null textual data that contains only white
space. Note that Oracle does not distinguish between the empty string and the null value.

• Default Value Count: counts the number of default values.



Indicator types

Talend Open Studio for MDM User Guide 663

• Distinct Count: counts the number of distinct values of your column.

• Duplicate Count: counts the number of values appearing more than once. You have the relation: Duplicate count
+ Unique count = Distinct count. For example, a,a,a,a,b,b,c,d,e => 9 values, 5 distinct values, 3 unique values,
2 duplicate values.

• Null Count: counts the number of null rows.

• Row Count: counts the number of rows.

• Unique Count: counts the number of distinct values with only one occurrence. It is necessarily less or equal
to Distinct counts.

18.2.1.2. Text statistics

You can use the text statistics indicators to analyze columns only if their data mining type is set to nominal in the
analysis editor. Otherwise, these statistics will be grayed out in the [Indicator Selection] dialog box. For further
information on the available data mining types, see Data mining types.

Text statistics analyze the characteristics of textual fields in the columns, including minimum, maximum and
average length.

• Minimal Length: computes the minimal length of a text field.

• Maximal Length: computes the maximal length of a text field.

• Average Length: computes the average length of a field.

Other text indicators are available to count each of the above indicators with null values, with blank values or
with null and blank values.

Null values will be counted as data of 0 length, that is to say the minimal length of null values is 0. This means
that the Minimal Length With Null and the Maximal Length With Null will compute the minimal/maximal
length of a text field including null values.

Blank values will be counted as data of 0 length, that is to say the minimal length of blank values is 0. This means
that the Minimal Length With Blank and the Maximal Length With Blank will compute the minimal/maximal
length of a text field including blank values.

The same will be applied for all average indicators.

The below table gives an example of computing the length of few textual fields in a column using all different
types of text statistic indicators.

Data Current length With blank values With null values With blank
and null values

Brayan 6 6 6 6

Ava 3 3 3 3

" " 1 0 1 0

"" 0 0 0 0

Null — — 0 0

Minimal, Maximal and Average lengths

Minimal length 0 0 0 0

Maximal length 6 6 6 6

Average length 9/4 = 2.25 8/4 = 2 9/5 = 1.8 8/5 = 1.6
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18.2.1.3. Summary statistics

They perform statistical analyses on numeric data, including the computation of location measures such as the
median and the average, the computation of statistical dispersions such as the inter quartile range and the range.

• Mean: computes the average of the records.

• Median: computes the value separating the higher half of a sample, a population, or a probability distribution
from the lower half.

• Inter quartile range: computes the difference between the third and first quartiles.

• Range: computes the difference between the highest and lowest records.

When using the summary statistics indicators to profile a DB2 database, analysis results could be slightly different
between Java and SQL engines. This is because indicators are computed differently depending on the database
type, and also Talend uses special functions when working with Java.

18.2.1.4. Advanced statistics

They determine the most probable and the most frequent values and builds frequency tables. The main advanced
statistics include the following values:

• Mode: computes the most probable value. For numerical data or continuous data, you can set bins in the
parameters of this indicator. It is different from the "average" and the "median". It is good for addressing
categorical attributes.

• Frequency table: computes the number of most frequent values for each distinct record.

• All other frequency table indicators are available to aggregate date and numerical data (with respect to "date",
"week", "month", "quarter", "year" and "bin").

• Low frequency table: computes the number of less frequent records for each distinct record.

• All other low frequency table indicators are available to aggregate date and numerical data (with respect to
"date", "week", "month", "quarter", "year" and "bin"), where "bin" is the aggregation of numerical data by
intervals.

18.2.1.5. Pattern frequency statistics

Indicators in this group determine the most and less frequent patterns.

• Pattern frequency table: computes the number of most frequent records for each distinct pattern.

• Pattern low frequency table: computes the number of less frequent records for each distinct pattern.

• Date pattern frequency table: retrieves the date patterns from date or text columns. It works only with the Java
engine.

It is not very useful to use Pattern Frequency Statistics on a column of a Date type in databases when executing the
analysis with the SQL engine. No data quality issues are returned by this indicator as all dates will be displayed
using one single format. For further information, check the article Why do we get 99-AAA-99 when profiling
Date columns in Oracle.

https://help.talend.com/pages/viewpage.action?pageId=190513204
https://help.talend.com/pages/viewpage.action?pageId=190513204
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18.2.1.6. Soundex frequency statistics

Indicators in this group use the Soundex algorithm built in the DBMS.

They index records by sounds. This way, records with the same pronunciation (only English pronunciation) are
encoded to the same representation so that they can be matched despite minor differences in spelling.

• Soundex frequency table: computes the number of most frequent distinct records relative to the total number
of records having the same pronunciation.

• Soundex low frequency table: computes the number of less frequent distinct records relative to the total number
of records having the same pronunciation.

Due to some limitation in Teradata soundex implementation, you may not be able to drill down the results of profiling
Teradata with this indicator. For further information, check the article An error when profiling Teradata using the Soundex
Fequency Statistics indicator .

18.2.1.7. Phone number statistics

Indicators in this group count phone numbers. They return the count for each phone number format. They validate
the phone formats using the org.talend.libraries.google.libphonumber library.

• Valid phone number count: computes the valid phone numbers.

• Possible phone number count: computes the supposed valid phone numbers.

• Valid region code number count: computes phone numbers with valid region code.

• Invalid region code count. computes phone numbers with invalid region code.

• Well formed national phone number count: computes well formatted national phone numbers.

• Well formed international phone number count: computes the international phone numbers that respect the
international phone format (phone numbers that start with the country code) .

• Well formed E164 phone number count: computes the international phone numbers that respect the international
phone format ( maximum of fifteen digits written with a + prefix.

• Format Frequency Pie: shows the results of the phone number count in a pie chart divided into sectors.

18.2.1.8. Benford's law frequency indicator

The Benford Law Frequency indicator (first-digit law) is based on examining the actual frequency of the digits
1 through 9 in numerical data. It is usually used as an indicator of accounting and expenses fraud in lists or tables.

Benford's law states that in lists and tables the digit 1 tends to occur as a leading digit about 30% of the time.
Larger digits occur as the leading digits with lower frequency, for example the digit 2 about 17%, the digit 3
about 12% and so on. Valid, unaltered data will follow this expected frequency. A simple comparison of first-
digit frequency distribution from the data you analyze with the expected distribution according to Benford's law
ought to show up any anomalous results.

For example, let's assume an employee has committed fraud by creating and sending payments to a fictitious
vendor. Since the amounts of these fictitious payments are made up rather than occurring naturally, the leading
digit distribution of all fictitious and valid transactions (mixed together) will no longer follow Benford's law.

https://help.talend.com/pages/viewpage.action?pageId=190513397
https://help.talend.com/pages/viewpage.action?pageId=190513397
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Furthermore, assume many of these fraudulent payments have 2 as the leading digit, such as 29, 232 or 2,187. By
using the Benford Law indicator to analyze such data, you should see the amounts that have the leading digit 2
occur more frequently than the usual occurrence pattern of 17%.

When using the Benford Law Frequency indicator, it is advised to:

• make sure that the numerical data you analyze do not start with 0 as Benford's law expects the leading digit to range only
from 1 to 9. This can be verified by using the number > Integer values pattern on the column you analyze.

• check the order of magnitude of the data either by selecting the min and max value indicators or by using the Order of
Magnitude indicator you can import from Talend Exchange. This is because Benford's law tends to be most accurate
when values are distributed across multiple orders of magnitude. For further information about importing indicators from
Talend Exchange, see How to import user-defined indicators from Talend Exchange.

In the result chart of the Benford Law Frequency indicator, digits 1 through 9 are represented by bars and the
height of the bar is the percentage of the first-digit frequency distribution of the analyzed data. The dots represent
the expected first-digit frequency distribution according to Benford's law.

Below is an example of the results of an analysis after using the Benford Law Frequency indicator and the Order
of Magnitude user-defined indicator on a total_sales column.

The first chart shows that the analyzed data varies over 6 orders of magnitude, that is there are 6 digits between
the minimal value and maximal value of the numerical column.

The second chart shows that the actual distribution of the data (height of bars) does not follow the Benford's law
(dot values). The differences are very big between the frequency distribution of the sales figures and the expected
distribution according to Benford's law. For example, the usual occurrence pattern for sales figures that start with
1 is 30% and those figures in the analyzed data represent only 11%. Some fraud could be suspected here, sales
figures may have been modified by someone or some data may be missing.

Below is another example of the result chart of a column analysis after using the Benford Law Frequency
indicator.
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The red bar labeled as invalid means that this percentage of the analyzed data does not start with a digit. And the 0
bar represents the percentage of data that starts with 0. Both cases are not expected when analyzing columns using
the Benford Law Frequency indicator and this is why they are represented in red.

For further information about analyzing columns, see Analyzing columns in a database.

18.2.2. Managing system indicators

System indicators are predefined but editable indicators that you can use on analyses. For more information on
the system indicators available in the studio, see Indicator types.

18.2.2.1. How to edit a system indicator

Although system indicators are predefined indicators, you can open their editors to check or to edit their settings
and their definitions in order to adapt them to a specific database version or to a specific need, for example.
However, you can not edit the name of the system indicator.

To edit a system indicator, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators, and then browse through the indicator lists
to reach the indicator you want to modify.

2. Right-click the indicator name and select Open from the contextual menu.
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The indicator editor opens displaying the selected indicator parameters.

3. Modify the indicator metadata.

You can edit any metadata field of the system indicator except the indicator name which is not editable..

4. Click Indicator Definition.

In this view, you can edit the indicator definition, change the selected database and add other indicators
specific to available databases using the [+] button at the bottom of the editor.

5. Click the save icon on top of the editor to save your changes.

If the indicator is simple enough to be used in all databases, select Default in the database list.

When you edit an indicator, you modify the indicator listed in the DQ Repository tree view. Make sure that your modifications
are suitable for all analyses that may be using the modified indicator.
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18.2.2.2. How to set system indicators and indicator options to
column analyses

You can define system indicators and indicator parameters for columns of database tables that need to be analyzed
or monitored. For more information, see How to set indicators for the column(s) to be analyzed and How to set
options for system indicators.

18.2.2.3. How to export or import system indicators

You can export system indicators to folders or archive files and import them again in the studio on the condition
that the export and import operations are done in compatible versions of the Studio. For further information, see
Exporting data profiling items and Importing data profiling items .

18.2.2.4. How to duplicate a system indicator

To avoid creating a system indicator from scratch, you can duplicate an existing one in the indicator list. once the
copy is created, you can work around its metadata to have a new indicator and use it in data profiling analyses.

To duplicate a system indicator, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Browse through the indicator lists to reach the indicator you want to duplicate, right-click its name and select
Duplicate... from the contextual menu.

The duplicated indicator is displayed under the System folder in the DQ Repository tree view.

You can now open the duplicated indicator to modify its metadata and definition as needed. For more information
on editing system indicators, see How to edit a system indicator.

18.2.3. Managing user-defined indicators
User-defined indicators, as their name indicates, are indicators created by the user himself/herself. You can use
these indicators to analyzed columns through a simple drag-and-drop operation from the DQ Repository tree view
to the columns listed in the editor.

The management options available for user-defined indicators include: create, export and import, edit and
duplicate.
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18.2.3.1. How to create SQL user-defined indicators

You can create your own personalized indicators from the studio.

Management processes for user-defined indicators are the same as those for system indicators.

Defining the indicator

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Right-click User Defined Indicators.

3. Select New Indicator from the contextual menu.

The [New Indicator] wizard is displayed.
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4. In the Name field, enter a name for the indicator you want to create.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

If required, set other metadata (purpose, description and author name) in the corresponding fields and click
Finish.

The indicator editor opens displaying the metadata of the user-defined indicator.

Setting the indicator definition and category

1. Click Indicator Category and select from the list a category for the indicator.

The selected category determines the columns expected in the result set of the analysis that uses the user-
defined indicator.

The table below explains available categories.

Indicator category Description Expected query results

User Defined Match Evaluates the number of data matching a
condition.

The result set should have one row and
two columns. The first column contains the
number of values that match and the second
column the total count.

User Defined Frequency Evaluates the frequency of records using
user-defined indicators for each distinct
record.

The result set should have 0 or more rows
and two columns. The first column contains
a value and the second the frequency (count)
of this value.
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User Defined Real Value Evaluates real function of data. The result set should have one row and one
column that contain a real value.

User Defined Count (by-default
category)

Analyzes the quantity of records and returns
a row count.

The result set should have one row and one
column that contain the row count.

2. Click Indicator Definition and then click the [+] button.

3. From the Database list, select a database on which to use the indicator.

If the indicator is simple enough to be used in all databases, select Default in the database list.

4. Enter the database version in the Version field.

5. Define the SQL statement for the indicator you want to create:

• Click the Edit... button next to the SQL Template field.

The [Edit Expression] dialog box opens.

• In the Indicator Definition view, enter the SQL expression(s) you want to use in matching and analyzing
data. You can drop templates from the templates list to complete the expression.

For example, set the expression to measure the maximal length of the values in a column as shown in the
above capture.

This view may have several input fields, one for each column expected by indicator category. For example,
if you select the User Defined Count category, you will have only a Where Expression field; while if
you select the User Defined Match category, you will have two fields: Matching Expression and Where
Expression.

The SQL expressions are automatically transformed into a complete SQL template in the Full SQL
Template view.
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Also, the SQL expressions are automatically transformed into templates to view rows/values. Different
tabs are available in the dialog box depending on what indicator category is selected.

If you edit the SQL expression(s) in the Indicator Definition view, the templates will be updated
accordingly in the other tabs.

• Use the Reset button to revert all templates according to the content of the Indicator Definition tab.

• Click OK.

The dialog box is closed and the SQL template is displayed in the indicator editor.

• Use the [+] button and follow the same steps to add as many indicator definitions as needed.

You do not need to define any parameters in the Indicator Parameters view when the user-defined indicator
contains only SQL templates. These parameters are used only when indicators have Java implementation. For further
information, see How to define Java user-defined indicators.

6. Click the save icon on top of the editor.

The indicator is listed under the User Defined Indicators folder in the DQ Repository tree view. You can
use this indicator to analyzed columns through a simple drag-and-drop operation from the DQ Repository
tree view to the columns listed in the editor.

If an analysis with a user-defined indicator runs successfully at least one time and later the indicator definition
template for the database is deleted, the analysis does not fail. It keeps running successfully because it uses
the previously generated SQL query.

18.2.3.2. How to define Java user-defined indicators

You can create your own personalized Java indicators from the studio. Management processes for Java user-
defined indicators are the same as those for system indicators.

You can also import a ready-to-use Java user-defined indicator from the Exchange folder in the DQ Repository tree view.
This Java user-defined indicator connects to the mail server and checks if the email exists. For further information on
importing indicators from Talend Exchange, see How to import user-defined indicators from Talend Exchange.

The two sections below detail the procedures to create Java user-defined indicators.
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How to create Java user-defined indicators

Defining the indicator

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Right-click User Defined Indicators.

3. Select New Indicator from the contextual menu.

The [New Indicator] wizard is displayed.

4. In the Name field, enter a name for the Java indicator you want to create.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "‘", """, "«", "»", "<", ">".
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These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

5. If required, set other metadata (purpose, description and author name) in the corresponding fields and click
Finish.

The indicator editor opens displaying the metadata of the user-defined indicator.

Setting the indicator definition and category

1. Click Indicator Category and select from the list a category for the Java indicator.

The selected category determines the columns expected in the result set of the analysis that uses this indicator.

The table below explains available categories.

Indicator category Description Expected query results

User Defined Match Evaluates the number of data matching a
condition.

The result set should have one row and
two columns. The first column contains the
number of values that match and the second
column the total count.

User Defined Frequency Evaluates the frequency of records using
user-defined indicators for each distinct
record.

The result set should have 0 or more rows
and two columns. The first column contains
a value and the second the frequency (count)
of this value.

User Defined Real Value Evaluates real functions of data. The result set should have one row and one
column that contain a real value.

User Defined Count (by-default
category)

Analyzes the quantity of records and returns
a row count.

The result set should have one row and one
column that contain the row count.
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2. Click Indicator Definition and then click the [+] button.

3. From the Database list, select Java.

4. Enter the Java class in the Java Class field.

Make sure that the class name includes the package path, if this string parameter is not correctly specified, an error
message will display when you try to save the Java user-defined indicator.

5. Select the Java archive holding the Java class:

• Click the Edit... button.

The [UDI Selector] dialog box opens.

• In the Select libraries view, select the check box of the archive holding the Java class.

• Click OK.

The dialog box is closed and the Java archive is displayed in the indicator editor.

You can add or delete Java archives from the Manage Libraries view of this dialog box.

For more information on creating a Java archive, see How to create a Java archive for the user-defined
indicator.

6. Click Indicator Parameters to open the view where you can define parameters to retrieve parameter values
while coding the Java indicator.
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You can retrieve parameter values with a code similar to this one that retrieves the parameter of EMAIL_PARAM:

// Check prerequisite
        IndicatorParameters param = this.getParameters();
        if (param == null) {
            log.error("No parameter set in the user defined indicator " +
 this.getName()); //$NON-NLS-1$
            return false;
        }
        Domain indicatorValidDomain = param.getIndicatorValidDomain();
        if (indicatorValidDomain == null) {
            log.error("No parameter set in the user defined indicator " +
 this.getName()); //$NON-NLS-1$
            return false;
        }

        // else retrieve email from parameter
        EList<JavaUDIIndicatorParameter> javaUDIIndicatorParameter =
 indicatorValidDomain.getJavaUDIIndicatorParameter();
        for (JavaUDIIndicatorParameter p : javaUDIIndicatorParameter) {
            if (EMAIL_PARAM.equalsIgnoreCase(p.getKey())) {

For a more detailed sample of the use of parameters in a Java user-defined
indicator, visit  http://talendforge.org/svn/top/trunk/test.myudi/src/main/java/org/talend/dataquality/
indicator/userdefine/email/EMailValidationIndicator.java.

7. Click the [+] button at the bottom of the table and define in the new line the parameter key and value.

You can edit these default parameters or even add new parameters any time you use the indicator in a column
analysis. To do this, click the indicator option icon in the analysis editor to open a dialog box where you can
edit the default parameters according to your needs or add new parameters.

8. Click the save icon on top of the editor.

The indicator is listed under the User Defined Indicators folder in the DQ Repository tree view. You can
use this indicator to analyzed columns through a simple drag-and-drop operation from the DQ Repository
tree view to the columns listed in the editor.

How to create a Java archive for the user-defined indicator

Before creating a Java archive for the user defined indicator, you must define, in Eclipse, the target platform
against which the workspace plug-ins will be compiled and tested.

To define the target platform, do the following:

1. In Eclipse, select Preferences to display the [Preferences] window.

http://talendforge.org/svn/top/trunk/test.myudi/src/main/java/org/talend/dataquality/indicator/userdefine/email/EMailValidationIndicator.java
http://talendforge.org/svn/top/trunk/test.myudi/src/main/java/org/talend/dataquality/indicator/userdefine/email/EMailValidationIndicator.java
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2. Expand Plug-in Development and select Target Platform then click Add... to open a view where you can
create the target definition.
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3. Select the Nothing: Start with an empty target definition option and then click Next to proceed to the
next step.

4. In the Name field, enter a name for the new target definition and then click the Add... button to proceed
to the next step.
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5. Select Installation from the Add Content list and then click Next to proceed to the next step.

6. Use the Browse... button to set the path of the installation directory and then click Next  to proceed to the
next step.

The new target definition is displayed in the location list.
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7. Click Finish to close the dialog box.

To create a Java archive for the user defined indicator, do the following:

1. In Eclipse, check out the project from svn at http://talendforge.org/svn/top/branches/branch-4_0/test.myudi.

In this Java project, you can find four Java classes that correspond to the four indicator categories listed in
the Indicator Category view in the indicator editor.

Each one of these Java classes extends the UserDefIndicatorImpl indicator. The figure below illustrates
an example using the MyAvgLength Java class.

http://talendforge.org/svn/top/branches/branch-4_0/test.myudi
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2. Modify the code of the methods that follow each @Override according to your needs.

3. If required, use the following methods in your code to retrieve the indicator parameters:

4. use Indicator.getParameter() which returns an IndicatorParameters object.

5. call IndicatorParameters.getIndicatorValidDomain() which returns a Domain object.

6. call Domain.getJavaUDIIndicatorParameter() which returns a list of JavaUDIIndicatorParameter
that stores each key/value pair that defines the parameter.

7. Save your modifications.

8. Using Eclipse, export this new Java archive.

The Java archive is now ready to be attached to any Java indicator you want to create in from Profiling perspective
of the studio.

18.2.3.3. How to export user-defined indicators

You can export user-defined indicators to archive files or to Talend Exchange to be shared with other users.
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How to export user-defined indicators to an archive file

You can export user-defined indicators and store them locally in an archive file using the Export Item option on
the studio toolbar. For further information on how to export indicators, see Exporting data profiling items.

How to export user-defined indicators to Talend Exchange

You can export user-defined indicators from your current studio to Talend Exchange where you can share them
with other users.

The exported indicators are saved as .xmi files on the exchange server.

Prerequisite(s):At least one user-defined indicator is created in the Profiling perspective of the studio.

To export user-defined indicators to Talend Exchange, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Right-click the User Defined Indicator folder and select Export for Talend Exchange.

The [Export for Talend Exchange] wizard is displayed.

3. Browse to the folder where to save indicators.

4. Select the check boxes of the indicators you want to export to the specified folder.

Select the Show only selected elements check box to list only the indicators you want to export.

5. Click Finish.
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The .xmi file of each selected indicator is saved as a zip file in the defined folder.

6. Upload the zip files to Talend Exchange at http://www.talendforge.org/exchange. Please create an account
on the Talend Exchange server if you do not have one already.

18.2.3.4. How to import user-defined indicators

You can import user-defined indicators from a local archive file or from Talend Exchange into your studio and
use them on your column analyses.

How to import user-defined indicators from an archive file

Using the Import Item option on the studio toolbar, you can import user-defined indicators stored locally in
an archive file and use them on your column analyses. For further information on how to import indicators, see
Importing data profiling items .

A warning icon  next to the name of the imported indicator in the tree view identifies that it is not correct. You
must open the indicator and try to figure out what is wrong.

How to import user-defined indicators from a csv file (deprecated feature)

This section describes a deprecated feature that is still available for use to provide backward compatibility.

You can import indicators stored locally in a csv file to use them on your column analyses.

Prerequisite(s): You have selected the Profiling perspective of the studio. The csv file is stored locally.

To import user-defined indicators from a csv file, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Right-click User Defined Indicators and select Import Indicators.

The [Import Indicators] wizard opens.

http://www.talendforge.org/exchange
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3. Browse to the csv file holding the user-defined indicators.

4. In the Duplicate Indicators handling area, select:

Option To...

skip existing indicators import only the indicators that do not exist in the corresponding lists in the DQ Repository
tree view. A warning message is displayed if the imported indicators already exist under
the Indicators folder.

rename new indicators with suffix identify each of the imported indicators with a suffix. All indicators will be imported even
if they already exist under the Indicators folder.

5. Click Finish.

All imported indicators are listed under the User Defined Indicators folder in the DQ Repository tree view.

A warning icon  next to the name of the imported user-defined indicator in the tree view identifies that it is not correct.
You must open the indicator and try to figure out what is wrong.

How to import user-defined indicators from Talend Exchange

You can import the .xmi files of user-defined indicators created by other users and stored on the Talend Exchange
server into your current studio and use them on your column analyses.

You can import only versions that are compatible with the version of your current studio.
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The indicators you can import from Talend Exchange include for example:

• Order of Magnitude: It computes the number of digits between the minimal value and maximal value of a
numerical column.

• Email validation via mail server: This Java user-defined indicator connects to a mail server and checks if the
email exists.

Prerequisite(s): You have selected the Profiling perspective of the studio. Your network is up and running.

The below procedure shows how to import the Email validation via mail server indicator from the exchange server
into the studio:

1. In the DQ Repository tree view, expand Libraries > Exchange.

If you have connection problems, you will not have access to any of the items under the Exchange node. A
pop-up will prompt you to check your internet connection.

2. Under Exchange, expand indicator and right-click the name of the indicator you want to import, a Java user-
defined indicator in this example.

3. Select Import in DQ Repository.

The [Import From Talend Exchange] wizard opens.
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You will have access only to versions that are compatible with the version of your current studio.

4. Select the Overwrite existing items check box if some error and warning messages are listed in the Error
and Warning area.

This means that an indicator with the same name already exists in the current studio. The imported indicator
will replace the one in the studio.

5. Click Finish.

The user-defined indicator is imported from Talend Exchange and listed under the User Defined Indicators
folder in the DQ Repository tree view.

Before being able to use this indicator on column analyses to check emails by sending an SMTP request to the
mail server, you must define the indicator parameters as the following:

1. Double-click the indicator to open the indicator editor.
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This Java user-defined indicator has three parameters set by default:

• a buffer size that gives the number of invalid email addresses stored in memory before they are saved in
a file.

• a file path to the list of invalid email addresses.

• the email of the sender.

2. Modify the values of the BUFFER SIZE and INVALID DATA FILE according to your needs.

3. In the Parameters Value column, set the value for the EMAIL parameter, that is the address of the sender
on the SMTP server.

4. Save the indicator.

If you have an error message when running a column analysis with this indicator, please check your email server
configuration.
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You can also use the studio to create an SQL user-defined indicator or a Java user-defined indicator from scratch.
For further information, see How to create SQL user-defined indicators and How to define Java user-defined
indicators respectively.

18.2.3.5. How to edit a user-defined indicator

You can open the editor of any system or user-defined indicator to check its settings and/or edit its definition and
metadata in order to adapt it to a specific database type or need, if required.

Prerequisite(s):At least one user-defined indicator is created in the Profiling perspective of the studio.

To edit the definition of a user-defined indicator, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators, and then browse through the indicator lists
to reach the indicator you want to modify the definition of.

2. Right-click the indicator name and select Open from the contextual menu.

The indicator editor opens displaying the selected indicator settings.

3. Modify the indicator metadata, if required.

4. Click Indicator Category to open the view and select an indicator category from the list.

The table below describes the different categories.

Indicator category Description

User Defined Match (by-default
category)

Uses user-defined indicators to evaluate the number of the data records that match a
regular expression or an SQL pattern. The analysis results show the record matching count
and the record total count.



Managing user-defined indicators

690 Talend Open Studio for MDM User Guide

User Defined Frequency Uses user-defined indicators for each distinct data record to evaluate the record frequency
that match a regular expression or an SQL pattern. The analysis results show the distinct
count giving a label and a label-related count.

User Defined Real Value Uses user-defined indicators which return real value to evaluate any real function of the
data.

User Defined Count Uses user-defined indicators that return a row count.

5. Click Indicator Definition to open the view. Set the indicator definition for one or more databases using
the [+] button.

If the indicator is simple enough to be used in all databases, select Default in the list.

6. Click Indicator Parameter and modify the indicator parameters as needed.

7. To add new default parameters, click the [+] button at the bottom of the table, click in the lines and define
the parameter keys and values.

8. Click the save icon on top of the editor to save your changes.

When you edit an indicator, make sure that your modifications are suitable for all analyses that may be using the modified
indicator.

18.2.3.6. How to duplicate a user-defined indicator

To avoid creating an indicator from scratch, you can duplicate an existing one in the indicator list. Once the copy
is created, you can work around its metadata to have a new indicator and use it in data profiling analyses.

Prerequisite(s): At least one user-defined indicator has been defined in the Profiling perspective of the studio.

To duplicate a user defined indicator, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Browse through the user-defined indicator lists to reach the indicator you want to duplicate, right-click its
name and select Duplicate... from the contextual menu.
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The duplicated indicator is displayed under the User Defined Indicators folder in the DQ Repository tree view.

You can now open the duplicated indicator to modify its metadata and definition as needed. for more information
on editing user-defined indicators, see How to edit a user-defined indicator.

18.2.3.7. How to delete or restore a user-defined indicator

In the studio, you can delete a user-defined indicator definitely or restore it from the Recycle Bin. For details,
refer to How to delete a regular expression or an SQL pattern.

18.2.4. Indicator parameters

This section describes indicator parameters displayed in the different [Indicators Settings] dialog boxes.

Bins Designer

Possible value Description

Minimal value Beginning of the first bin.

Maximal value End of the last bin.

Number of bins Number of bins.

Blank Options

Possible value Description

Aggregate nulls with blanks When selected, null data is counted as zero length text field. This means that null
data is treated as an empty string. When not selected, null data is treated as any other
text data.

Aggregate blanks When selected, blank texts (e.g. " ") are all grouped together and considered as an
empty string. When not selected, blank texts are treated as any other text data.

In Oracle, empty strings and null strings are the same objects. Therefore,
you must select or clear both check boxes in order to get consistent results.
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Data Thresholds

Possible value Description

Lower threshold Data smaller than this value should not exist.

Upper threshold Data greater than this value should not exist.

Frequency Table Parameters

Possible value Description

Number of results shown Number of displayed results.

Indicator Thresholds

Possible value Description

Lower threshold Lower threshold of matching indicator values.

Upper threshold Higher threshold of matching indicator values.

Lower threshold(%) Lower threshold of matching indicator values in percentage relative to the total row
count.

Upper threshold(%) Higher threshold of matching indicator values in percentage relative to the total row
count.

Expected value Only for the Mode indicator in the Advanced Statistics. Most probable value that
should exist in the selected column.

Java Options

Possible value Description

Characters to replace List of the characters to be replaced.

Replacement characters List of the characters that will take the place of the replaced characters.

Each character of the first field will be replaced by the character at
the same position from the second field. For example, with the values
"abc0123ABC,;.:" in the first field and "aaa9999AAApppp" in the second
field any "a", "b" or "c" will be replaced by "a" and any "0", "1", "2" or "3"
will be replaced by "9".

Phone number

Possible value Description

Country Country ISO2 code of the phone number.

Text Parameters

Possible value Description

Ignore case When selected, comparison of text data is not case sensitive.

Text Length

Possible value Description

Count nulls When selected, null data is counted as zero length text field.

Count blanks When selected, blank texts (e.g. " ") are counted as zero length text fields.
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Chapter 19. Other important management
procedures
This chapter provides the information you need to carry out some basic procedures including setting preferences
of analysis editors and analysis results, creating SQL queries, setting data parser rules, importing/exporting data
quality items and upgrading projects from older versions.
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19.1. Creating and storing SQL queries
From the studio, you can query and browse a selected database using the SQL Editor and then to store these SQL
queries under the Source Files folder in the DQ Repository tree view. You can then open the SQL Editor on any
of these stored queries to rename, edit or execute the query.

To create an SQL query, do the following:

1. In the DQ Repository tree view, expand Libraries.

2. Right-click Source Files and select Create SQL File from the contextual menu. The [Create SQL File]
dialog box is displayed.

3. In the Name field, enter a name for the SQL query you want to create and then click Finish to proceed to
the next step.

The SQL Editor opens on the new SQL query.

If the Connections view is not open, use the combination Window > Show View > Data Explorer > Connections
to open it.

4. Enter your SQL statement in the SQL Editor.
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5. From the Choose Connection list, select the database you want to run the query on.

6. On the SQL Editor toolbar, click  to execute the query on the defined base table(s).

Data rows are retrieved from the defined base table(s) and displayed in the editor.

A file for the new SQL query is listed under Source Files in the DQ Repository tree view.

7. Right-click an SQL file and from the contextual menu select:

Option To...

Open open the selected Query file

Duplicate create a copy of the selected Query file
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Rename SQL File open a dialog box where you can edit the name of the query file

Open in Data Explorer open in the data explorer the SQL editor on the selected query file

Delete delete the query file

The deleted item will go to the Recycle Bin in the DQ Repository tree view.
You can restore or delete such item via a right-click on the item. You can also
empty the recycle bin via a right-click on it.

When you open a query file in the SQL Editor, make sure to select the database connection from the Choose Connection
list before executing the query. Otherwise the run icon on the editor toolbar will be unavailable.

When you create or modify a query in a query file in the SQL Editor and try to close the editor, you will be prompted to
save the modifications. The modifications will not be taken into account unless you click the save icon on the editor toolbar.

19.2. Using context variables to connect to
data sources
You can define context variables from the Profiling perspective to connect to data sources and decide to run an
analysis with a specific context.

The Profiling perspective of the studio allows you to define multiple context parameters for any of the database or
file connections you define in the Metadata node in the DQ Repository tree view. Then you can select a specific
context parameters with which you want to execute one or more of the analyses that use the database or the file
connection. For example, there might be various testing stages you want to perform and validate before an analysis
is ready to go for production use.

While setting the connection information for a database or a file as outlined in Connecting to a database or in
Connecting to a file respectively, you can export the connection as a context and centralize it under the Context
node in the Integration perspective of your Studio. You can reuse this context in the data quality analyses that use
the current connection. You can also create different context parameters for the same connection and later choose
to execute an analysis on one specific context.

For detailed information on centralizing contexts and variables to be used in data integration Jobs or data quality
analyses, see Managing Metadata.

19.2.1. Exporting a connection as a context
Prerequisite(s): A database connection or a file connection has been created as outlined in Connecting to a
database or in Connecting to a file respectively

To export a database or a file connection as a context, do the following:

1. In the DQ Repository tree view, expand Metadata.

2. Double-click:

Item To...

a database connection open it in the connection editor, and then click Edit... in the Connection information
panel to open the connection wizard.

a file connection open the connection wizard.

3. • In the [Database Connection ] wizard, do any modifications in the connection information, if necessary
and click Next.

Make sure that the database name, the schema name or the catalog name is defined in the wizard. This
enables you to retrieve the correct database structure when you switch between different contexts. For
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further information about switching between contexts, see Switching between different contexts of the same
connection.

• In the file connection wizard, do any modifications in the connection information, if necessary, and click
Next.
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4. Click Export as context.

The [Create/Reuse a context group] wizard is displayed.
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5. Select to create a new context and save it in the repository, or to use a context group that is already centralized
in the repository, and click Next.

6. If you select to create a new context, set the context metadata and then click Next > Finish.

The variables and values of the selected database or file connection are automatically defined in the wizard
and the new context is named as Default.

7. Click the [+] button at the top right corner of the wizard and modify the context name as required. Click OK.

8. Click Finish to close the [Create/Reuse a context group] wizard.

In the [Database Connection] wizard, all connection settings are set as context and are read-only.
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In the file connection wizard, all connection settings are set as context and are read-only.
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If you want to edit the context group, you must switch to the Integration perspective where you can open
the context group to edit it.

9. Click Finish to close the wizard.

You can always click Revert Context at the bottom of the connection wizard to switch the current database
or file connection back to its initial state.

A message is displayed prompting you to propagate the change in the connection type to all the Jobs and
analyses that use the connection, if any.

10. Click Yes to confirm the operation and close the message and the dialog box.

The database or file connection is exported as a context and listed as a context item under the Contexts node
in the Integration perspective of your Studio.
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19.2.2. Creating multiple contexts for the same
connection

You can create several contexts for the same database or file connection and select specific context parameters
with which you want to execute an analysis on the database or the file connection. For example, there might be
various testing stages you want to perform and validate before an analysis is ready to go for production use.

Prerequisite(s): You have selected the Profiling perspective in the studio.

To create multiple contexts for the same database or file connection, do the following:

1. Follow the procedures outlined in Exporting a connection as a context.

2. In the last step in the [Create/Reuse a context group] wizard, click the Configure Contexts... icon.

3. In the [Configure Contexts] dialog box, click New....
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4. Enter a name for the new context, and then click OK to close the dialog box.

The defined context for the current connection are listed in dialog box.

5. If required, click New... again and proceed as above to create as many contexts as needed.

6. Click OK to close the dialog box and then Finish to close the [Create/Reuse a context group] wizard.

In the [Database Connection] wizard, all connection settings are set as context and are read-only.
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In the file connection wizard, all connection settings are set as context and are read-only.
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7. Click Finish to close the wizard.

The [Choose context] dialog box is displayed.

8. If required, change the context for the current database or file connection, and then click OK to close the
dialog box.

A message is displayed prompting you to propagate the modifications to all the Jobs and analyses that use
the connection, if any.

9. Click Yes to confirm the operation and close the message and the dialog box.

The selected connection is exported as a context and listed as a context item under the Contexts node in the
Integration perspective of your Studio.
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For detailed information on centralizing the contexts and variables to be used in data integration Jobs or data
quality analyses, see Managing Metadata.

19.2.3. Switching between different contexts of the
same connection

When you create more than one context for the same database or file connection, the menu Switch context will
be accessible from the connection. This menu enables you to select the context on which you want to execute
the current analysis.

Prerequisite(s):Multiple contexts has been defined for a connection in the Profiling perspective of the studio.
For further information, see Creating multiple contexts for the same connection.

To switch between different contexts of the same database or file connection, do the following:

1. In the DQ Repository tree view, expand Metadata > DB connections or Metadata > FileDelimited
connections.
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2. Right-click the connection exported as a context and select from the contextual menu Switch context. The
[Choose context] dialog box is displayed.

3. Select from the list the context you want to set for the current connection, and then click OK to close the
dialog box.

A confirmation message is displayed prompting you to refresh the connection editor.

4. Click OK to close the message.

The context has been changed accordingly for the current selection.

For detailed information on centralizing the contexts and variables to be used in data integration Jobs or data
quality analyses, see Managing Metadata.
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19.3. Using context variables in analyses
You can use context variables in the analysis editor to filter the data on which to run the analysis, or to decide the
number of concurrent connections to the database allowed by the analysis.

The Profiling perspective of the studio allows you to define multiple contexts for profiling analyses and select
specific context values with which to execute an analysis. You can define context parameters in the analysis editor
to:

• filter data using contexts variables with WHERE clauses and decide the data or tables/columns on which to
run the analysis,

• decide the number of concurrent connections allowed by the analysis.

You usually set this number according to the database available resources, that is the number of concurrent
connections each database can support.

You can use context variables only when you profile databases. Context variables can not be used when profiling files.

For detailed information on contexts and their management, see Managing Metadata.

19.3.1. Creating one or multiple contexts for the same
analysis

You can create one or several contexts for a database analysis and select specific context values with which to
execute the analysis. Defining context variables in analysis will enable you to run the analysis on different data
using the same connection.

Prerequisite(s): You have already created a database analysis in the Profiling perspective of the studio.

To define one or more contexts for an analysis, do the following:

1. Double-click the database analysis to open the analysis editor.

2. In the Contexts view, click the [+] button at the top right corner to open the [Configure Contexts] dialog box.

The Default context is listed by default.
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If the Contexts view does not show in the analysis editor by default, select Window > Show View > Profiling
> Contexts.

3. Click Edit to rename the default context and then click OK in both dialog boxes.

The context environment is named accordingly in the table in the Contexts view.

4. Click the [+] button at the bottom of the view to add lines in the table and define the name and values of
the context variables.

5. To add a new context, click the [+] button at the top right corner in the view and then click New... in the
[Configure Contexts] dialog box.

6. Enter a name for the new context, and then click OK.

The legacy of the context selected as default in the context list is copied to the new context which is created
and listed in the dialog box and in the Contexts view.

7. Click in the context table and modify the values of the new context as needed.

8. Repeat the above three steps to add as many context environments as needed.

You can also click  at the bottom of the view to import any of the contexts created and centralized in
the studio repository and use it with the current analysis.
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For detailed information on contexts and their management, see Managing Metadata.

19.3.2. Selecting the context with which to run the
analysis

Prerequisite(s): You have selected the Profiling perspective in the studio. At least one context has been created
in the analysis editor.

1. Double-click the analysis to open the analysis editor.

2. In the Data Filter view and in the Where box, either:

• enter the name of the context variable you want to use to run the analysis using context. followed by
the variable name, or

• press Ctrl + space to open the list of context variables from which you can select a variable of your choice.

This list will be empty until you define context variables in the Contexts view in the analysis editor.

You can use only one context variable to run the analysis. Multiple variables are not supported.

For further information about defining context variables, see Creating one or multiple contexts for the same
analysis.

3. In the Analysis Parameters view and in the Number of connection per analysis field, either:

• enter the name of the context variable you want to use to run the analysis using context. followed by
the variable name, or

• press Ctrl + space to open the list of context variables.

This list will be empty until you define context variables in the Contexts view in the analysis editor.

For further information about defining context variables, see Creating one or multiple contexts for the same
analysis.

4. In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.
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The variables of the selected context will show in the table.

All context environments you create in the Contexts view in the analysis editor or you import from the studio
repository will be accessible from this list.

For further information about contexts and their variables, see How to define context variables in the Contexts
view and How to centralize context variables in the Repository.

19.4. Importing data profiling items
You can import data profiling items including analyses, database connections, patterns and indicators, etc. into
you current studio from various projects or different versions of the studio.

You can not import an item without all its dependencies. When you try to import an analysis for example, all its
dependencies such as a metadata connection and the patterns and indicators used in this analysis will be selected
by default and imported with the analysis.

You can not import into your current studio data profiling items created in versions older than 4.0.0. To use such items in
your current studio, you must carry out an upgrade operation. For further information, see Upgrading project items from
older versions.

Prerequisite(s): You have access to the root directory of another studio version in which data profiling items
have been created.

To import one or more data profiling items, do the following:

1. In the Profiling perspective, either:

• Right-click anywhere in the DQ Repository tree view and select Import Items.

•
Click the  icon on the toolbar and select Import Items.

The [Import Item] wizard is displayed.
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2. Select the root directory or the archive file option according to whether the data profiling items you want to
import are in the workspace file within the studio directory or are already exported into a zip file.

• If you select the root directory option, click Browse and set the path to the project folder containing the
items to be imported within the workspace file of the studio directory.

All items and their dependencies that do not exist in your current Studio are selected by default in the
dialog box.

• If you select the archive file option, click Browse and set the path to the archive file that holds the data
profiling items you want to import.

All items and their dependencies that do not exist in your current studio are selected by default in the
dialog box.
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3. Select the Overwrite existing items check box if some error and warning messages are listed in the Error
and Warning area.

This means that items with the same names already exist in the current studio.

The imported items will replace the existing ones.

When you import system indicators that are modified in a studio version, they will not overwrite the indicators
in the current studio. All modifications from older versions will be integrated with the system indicators in
the current studio.

If there is a large number of catalogs, schemas or tables in the database connections you import, make sure to set
the correct value for the EMF (Eclipse Modeling Framework) compare function in your current studio in order not
to have problems when reloading the database structure. For further information, see How to synchronize and reload
catalog and schema lists.

4. Select or clear the check boxes of the data profiling items you want or do not want to import according to
your needs.

All dependencies for the selected item are selected by default. When you clear the check box of an item, the
check boxes of the dependencies of this item are automatically cleared as well. Also, an error message will
display on top of the dialog box if you clear the check box of any of the dependencies of the selected item.

5. Click Finish to validate the operation.

The imported items display under the corresponding folders in the DQ Repository tree view.

You can also import local project folders from the login window of your studio. For further information, see
Launching the studio.

6. Do the following to have every item working correctly:

• Run the analyses that have Java as their execution engine. This will compute and store locally the results
of the indicators used in the analyses.

You can not open a list of the indicator results in the Analysis Results view in the current studio without
running the analyses first as data is not imported with them from the old studio.

• Install missing third-party Java libraries or database drivers.

When you import database connections for the first time, warning red icons may be docked on the
connection names. This is because Talend Studio requires specific third-party Java libraries or database
drivers (.jar files) to be installed to connect to sources and targets. Those libraries or drivers, known as
external modules, can be required by some connection wizards. Due to license restrictions, Talend may
not be able to ship certain external modules within the studio.

For more information about identifying and installing external modules, see Talend Installation and
Upgrade Guide.

• Set the path for the drivers of the SQL Servers (2005 or 2008).
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If you import SQL Servers (2005 or 2008) connections into your current studio, a warning red icon is
docked on the connection names in the DB connections folder. This indicates that the driver path for these
connections is empty. You must open the connection wizard and redefine the connection manually to set
the path to a JDBC driver you can download from the Microsoft download center.

For further information on editing a database connection, see How to open or edit a database connection.

You can also set the path to a JDBC driver for a group of database connections simultaneously in order
not to define them one by one. For further information, see Migrating a group of connections.

19.5. Exporting data profiling items
You can export data profiling items including analyses, database connections, patterns and indicators, etc. from
the current instance of the studio to the root directory of another studio or to archive files.

Prerequisite(s): At least, one data profiling item has been created in the studio.

To export data profiling items, do the following:

1. • Right-click anywhere in the DQ Repository tree view and select Export Items.

•
Click the  icon on the toolbar and select Export Items.

The [Export Item] wizard is displayed.



Exporting data profiling items

Talend Open Studio for MDM User Guide 715

2. Select the root directory or archive file option and then click Browse... and browse to the directory/archive
where you want to export the data profiling items.

3. Select the check boxes of the data profiling items you want to export or use the Select All or Deselect All tabs.

When you select an analysis check box, all analysis dependencies including the metadata connection and any patterns
or indicators used in this analysis are selected by default. Otherwise, if you have an error message on top of the dialog
box that indicates any missing dependencies, click the Include dependencies tab to automatically select the check
boxes of all items necessary to the selected data profiling analysis.

4. If required, select the Browse check box to have in the export list only the selected data profiling items.

5. Click Finish to validate the operation.

A progress bar is displayed to indicate the progress of the export operation and the data profiling items are
exported in the defined place.
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19.6. Migrating a group of connections
You can import database connections from various projects or various versions of the Studio.

Some of the migrated JDBC connections may have a warning icon docked on their names in the DB connections
folder in the DQ Repository tree view. This indicates that the driver path for these connections is empty after
migration.

Setting the driver path manually for each of the connections could be tedious especially if you have imported big
number. The studio enables you to set the driver path once for all. You may download such a driver from the
Microsoft download center, for example.

Prerequisite(s): You have already migrated your database connections from an older version of the studio as
outlined in Importing data profiling items .

To migrate a group of connections simultaneously, do the following:

1. In the menu bar, select Window > Preferences to display the [Preferences] window.

2. In the search field, type jdbc and then select JDBC Driver Setting to open the corresponding view.

3. Set the JDBC parameters in the corresponding fields, and then click Apply to connections....

A dialog box is displayed to list all the JDBC connections that do not have the required JDBC driver after
migration.

4. Select the check boxes of the connections for which you want to apply the driver settings and then click OK.

A confirmation message is displayed.

5. Click OK to close the confirmation message.

6. In the [Preferences] window, click OK.
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A confirmation message is displayed.

7. Click OK to close the message and the [Preferences] window.

19.7. Upgrading project items from older
versions

The below procedure concerns only the migration of data profiling items from versions older than 4.0.0. To migrate your
data profiling items from version 4.0.0 onward, you simply need to import them into your current Studio . For further
information, see Importing data profiling items .

To migrate data profiling items (analyses, database connections, patterns and indicators, etc.) created in versions
older than 4.0.0, do the following:

1. From the folder of the old version studio, copy the workspace file and paste it in the folder of your current
Studio. Accept to replace the current workspace file with the old file.

2. Launch the Studio connecting to this workspace.

The upgrade operation is completed once the Studio is completely launched, and you should have access to all
your data profiling items.

Regarding system indicators during migration, please pay attention to the following:

• When you upgrade the repository items to version 4.2 from a prior version, the migration process overwrites any changes
you made to the system indicators.

• When you upgrade the repository items from version 4.2 to version 5.0 onward, you do not lose any changes you made
to the system indicators, the changes are merged.
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Chapter 20. Managing analyses
This chapter provides the information you need to perform basic management procedures for all analysis created
in the Profiling perspective of Talend Studio.
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20.1. Procedures for all types of analyses
The procedures below provide detailed information on basic management options for all types of the analyses
listed under the Analyses folder in the DQ Repository tree view.

From the contextual menu of the selected analysis, you can open, execute, duplicate or delete this analysis. You
can also add a task to the selected analysis.

20.1.1. Opening an analysis

Prerequisite(s): At least one analysis has been created in the Profiling perspective of the studio.

To open an analysis, do the following:

1. In the DQ Repository tree view, expand Data Profiling > Analyses.

2. Either:

• double-click the analysis you want to open, or,

• right-click the analysis you want to open and select Open from the contextual menu.

The corresponding analysis editor is displayed.

3. If required, click Refresh the graphics to the right of the editor to display the results of the analysis.

4. If required, click the Analysis results button at the bottom of the editor to open a more detailed view of the
analysis results.

20.1.2. Executing an analysis without opening the
analysis editor

Prerequisite(s): At least one analysis has been created in the Profiling perspective of the studio.

To execute an analysis without opening the analysis editor, do the following:

1. In the DQ Repository tree view, expand Data Profiling > Analyses.

2. Right-click the analysis you want to execute and select Run from the contextual menu.

A message is displayed on the status bar showing execution progress and the analysis is executed without
opening the analysis editor in the studio.

You can execute many analyses simultaneously if you select them, right-click the selection and click Run.

20.1.3. Duplicating an analysis

To avoid creating an analysis from scratch, you can duplicate an existing one in the Analyses folder and work
around its metadata to have a new analysis.
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Prerequisite(s): At least one analysis has been created in the Profiling perspective of the studio.

To duplicate an analysis, do the following:

1. In the DQ Repository tree view, expand Data profiling > Analyses.

2. Right-click the analysis you want to duplicate and select Duplicate... from the contextual menu.

The duplicated analysis shows in the analysis list in the DQ Repository tree view. You can now open the
duplicated analysis and modify its metadata as needed.

20.1.4. Adding a task to an analysis

You can add a task to an analysis to indicate a problem that needs to be solved later, for example.

For more information, see Managing tasks.

20.1.5. Deleting or restoring an analysis

Prerequisite(s):At least one analysis has been created in the Profiling perspective of the studio.

To delete an analysis, do the following:

1. In the DQ Repository tree view, expand Data Profiling > Analyses.

2. Right-click the analysis you want to delete and select Delete from the contextual menu.

The analysis is moved to the Recycle Bin.

You can also delete the analysis permanently by emptying the recycle bin. To empty the Recycle Bin, do the
following:

1. Right-click the Recycle Bin and select Empty recycle bin.

A confirmation dialog box is displayed.

2. Click Yes to empty the recycle bin.

To restore an analysis from the Recycle Bin, do the following:

• In the Recycle Bin, right-click the analysis and select Restore.

The analysis is moved back to the Data profiling node.

20.2. Managing tasks
In the studio, it is possible to add tasks to different items, display the task list and delete any completed task from
the task list.

You can add tasks to different items either:



Adding a task to a column in a database connection

722 Talend Open Studio for MDM User Guide

• in the DQ Repository tree view on connections, catalogs, schemas, tables, columns and created analyses,

• or, on columns, or patterns and indicators set on columns directly in the current analysis editor.

For example, you can add a general task to any item in a database connection via the Metadata node in the DQ
Repository tree view. You can add a more specific task to the same item defined in the context of an analysis
through the Analyses node. And finally, you can add a task to a column in an analysis context (also to a pattern
or an indicator set on this column) directly in the current analysis editor.

The procedure to add a task to any of these items is exactly the same. Adding tasks to such items will list these
tasks in the Tasks list accessible through the Window > Show view... combination. Later, you can open the editor
corresponding to the relevant item by double-clicking the appropriate task in the Tasks list.

20.2.1. Adding a task to a column in a database
connection

Prerequisite(s): At least, one database connection has been created in the Profiling perspective of the studio. For
further information, see Connecting to a database.

To add a task to a column in a database connection, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Navigate to the column you want to add a task to, account_id in this example.

3. Right-click the account_id and select Add task... from the contextual menu.
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The [Properties] dialog box opens showing the metadata of the selected column.

4. In the Description field, enter a short description for the task you want to carry on the selected item.

5. In the Priority list, select the priority level and then click OK to close the dialog box.

The created task is added to the Tasks list. For more information on how to access the task list, see Displaying
the task list.

From the task list, you can:

• double-click a task to open the editor where this task has been set.

• select the task check box once the task is completed in order to be able to delete it.

• filter the task view according to your needs using the options in a menu accessible through the drop-down arrow
on the top-right corner of the Tasks view. For further information about filtering the task list, see Filtering
the task list.

20.2.2. Adding a task to an item in a specific analysis

The below procedure gives an example of adding a task to a column in an analysis. You can follow the same steps
to add tasks to other elements in the created analyses.

Prerequisite(s): The analysis has been created in the Profiling perspective of the studio.
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To add a task to an item in an analysis, do the following:

1. In the DQ Repository tree view, expand Analyses.

2. Expand an analysis and navigate to the item you want to add a task to, the account_id column in this example.

3. Right-click account_id and select Add task... from the contextual menu.

4. Follow the steps outlined in Adding a task to a column in a database connection to add a task to account_id
in the selected analysis.

For more information on how to access the task list, see Displaying the task list.

20.2.3. Adding a task to an indicator in a column
analysis

In the open analysis editor, you can add a task to the indicators set on columns. This task can be used, for example,
as a reminder to modify the indicator or to flag a problem that needs to be solved later.

Prerequisite(s):

• A column analysis is open in the analysis editor in the Profiling perspective of the studio.

• At least one indicator is set for the columns to be analyzed.

To add a task to an indicator, do the following:

1. In the open analysis editor, click Analyzed columns to open the relevant view.

2. In the Analyzed Columns list, right-click the indicator name and select Add task... from the contextual menu.
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The [Properties] dialog box opens showing the metadata of the selected indicator.

3. In the Description field, enter a short description for the task you want to attach to the selected indicator.

4. On the Priority list, select the priority level and then click OK to close the dialog box. The created task is
added to the Tasks list.

For more information on how to access the task list, see Displaying the task list.

20.2.4. Displaying the task list

Adding tasks to items will list these tasks in the Tasks list.
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Prerequisite(s): At least, one task is added to an item in Profiling perspective of the studio.

To access the Tasks list, do the following:

1. On the menu bar of Talend Studio, select Window > Show view... .

The [Show View] dialog box is displayed.

2. Start typing task in the filter field and then select Tasks from the list.

3. Click OK.

The Tasks view opens in the Profiling perspective of the studio listing the added task(s).

4. If required, double-click any task in the Tasks list to open the editor corresponding to the item to which the
task is attached.

You can create different filters for the content of the task list. For further information, see Filtering the task list.

20.2.5. Filtering the task list

In the Profiling perspective of the studio, the Tasks view lists all the tasks you create in the studio.

You can create filters to decide what to list in the task view.

Prerequisite(s): At least, one task is added to an item in Profiling perspective of the studio.
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To filter tasks in the Tasks view, do the following:

1. Follow the steps outlined in Displaying the task list to open the task list.

The Tasks view is displayed.

2. Click the drop-down arrow in the top right corner of the view, and then select Configure contents....

The [Configure contents...] dialog box is displayed showing the by-default configuration.

3. Click New to open a dialog box and then enter a name for the new filter.

4. Click OK to close the dialog box
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The new filter is listed in the Configurations list.

5. Set the different options for the new filter as the following:

• From the Scope list, select a filter scope option, and then click Select... to open a dialog box where you
can select a working set for your filter.

• Select whether you want to display completed or not completed tasks or both of them.

• Select to display tasks according to their priority or according to the text they have.

• Finally, select the check boxes of the task types you want to list.

6. Click OK to confirm your changes and close the dialog box.

The task list shows only the tasks that confirm to the new filter options.



Deleting a completed task

Talend Open Studio for MDM User Guide 729

20.2.6. Deleting a completed task

When a task goal is met, you can delete this task from the Tasks list after labeling it as completed.

Prerequisite(s): At least one task is added to an item in the Profiling perspective of the studio.

To delete a completed task, do the following:

1. Follow the steps outlined in Displaying the task list to access the Tasks list.

2. Select the check boxes next to each of the tasks and right-click anywhere in the list.

3. From the contextual menu, select Delete Completed Tasks. A confirmation message is displayed to validate
the operation.

4. Click OK to close the confirmation message.

All tasks marked as completed are deleted from the Tasks list.
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Chapter 21.  Master Data Management:
Concepts and Principles
This chapter introduces Master Data Management as the means to manage shared data in an enterprise.

It also describes how the MDM, Integration and Profiling perspectives of Talend Studio are integrated together
to provide the first complete Master Data Management solution that combines data profiling, data integration and
master data functionalities on a single platform.
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21.1.  Introducing Master Data Management
Most large enterprises have a heterogeneous application portfolio, with fragments of often inaccurate, incomplete
and inconsistent data residing in various application silos. Companies wanting a consistent view of their customer
base often struggle to reconcile data across numerous operational systems. These issues cause intelligent decision
making to be difficult. The heart of these problems lies in the handling of shared data.

Master Data Management (MDM) is a comprehensive method of enabling an enterprise to link all of its critical data
to one "master file" that provides a common point of interest. Examples of master data include customer, product,
asset, location, employee, organizational unit. Data that is not shared between functions within an organization
is not master data.

MDM has emerged as a means to more efficiently manage shared data, eliminate redundancy, and create the
elusive "single version of the truth". Unlike most Enterprise Resource Planning (ERP) systems which are often
monolithic, expensive and rigid, MDM is able to offer both consistency and agility, therefore providing a major
competitive advantage and return on investment (ROI).

As businesses strive to dramatically reduce costs, meet compliance reporting mandates, deliver increased sales,
and provide superior service to customers and suppliers, analysts have declared MDM as a solution which will
significantly contribute to these business priorities.

21.2.  General concepts
According to Wikipedia (http://en.wikipedia.org/wiki/Master_data_management), in computing, Master Data
Management comprises a set of processes and tools that consistently defines and manages the non-transactional
data entities of an organization. Its objective is to provide processes for collecting, aggregating, matching,
consolidating, quality-assuring, persisting and distributing such data throughout an organization to ensure
consistency and control in the ongoing maintenance and application use of this information.

21.2.1.  Master data

Master data is data describing a physical or virtual object and its properties. Master data is usually described with
nouns.

Typical master data can be:

• Physical: products, material, assets, customers, locations etc.

• Virtual: cost centers, planned buildings etc.

21.2.2.  Transactional data

Transaction data is data describing an event (the change as a result of a transaction) and is usually described with
verbs. Transaction data always has a time dimension, a numerical value and refers to one or more objects.

Typical transactions are:

• Financial: orders, invoices, payments, etc.

http://en.wikipedia.org/wiki/Master_data_management
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• Work: plans, activity records, etc.

• Logistics: deliveries, storage records, travel records, etc.

21.3.  Master Data Management by Talend
Talend MDM is a model-driven, non intrusive solution easily adaptable to specific business needs and quick to
implement. It has been specifically developed to address the challenges of creating and managing master data for
all types of organizations where data is hosted under various formats in various systems and can be extremely
volatile.

Talend MDM groups all master data of the company in a central hub. This standardized repository provides,
through using Data Models, the prerequisites against which data and updates are validated.

Talend Studio presents a single platform that bundles data integration, data profiling and mastering and governing
data in the same Studio.

21.3.1.  Overview of Talend MDM

Talend MDM has all the core features a user needs for an MDM application: advanced modeling, model-driven
dynamic web interface, full-text search, event triggering, etc.

Talend MDM is a model-driven, non intrusive solution easily adaptable to specific business needs and it is quick
to implement. It provides a complete set of features for mastering, governing and integrating data throughout the
enterprise.

Talend MDM groups all master data of the company in a central hub. This standardized repository provides, via
the use of Data Models, the prerequisites against which data and updates are validated.

The chart below illustrates the main building blocks of Talend MDM.

The list below describes the main building blocks of Talend MDM:
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• Talend Studio - where administrators can set up and operate a centralized master data repository. They can build
data models that employ the necessary business and data rules to create a single master copy of the master data.
This master data will be propagated back to target and source systems.

• MDM Hub - where the master data is stored.

• MDM Repository - where a working copy of the data is stored before deployment to the MDM Server. The
MDM Repository can be stored locally, on the same machine as the MDM Studio, or remotely, based on an
SVN server.

• The web-based interface - where business users and data stewards can search, display or edit master data handled
by the MDM Studio.

The building blocks you have available for use may change depending on which edition of MDM you have.

For further information about how Talend MDM fits in with the other products in the Talend suite, see the Talend
Installation and Upgrade Guide.

21.3.2.  User interfaces for data governance and data
stewardship

Talend Studio provides the processing layers that ensure the right people have the right tools to centrally model and
manipulate master data. This key capability comprises the relevant features involved in master data governance
and stewardship.

Data governance is the process of defining the rules that master data has to follow. Data stewardship is the process
of making sure that the data follows those rules. This means that it is necessary to have both a governance function,
to demonstrate that the right controls are in place, and a stewardship function, to ensure that the controls are
enforced.

In Talend MDM, the governance and stewardship processes are available through two different user interfaces.
The first is an administration tool called Talend Studio. The second is a web-based interface called Talend MDM
Web User Interface.

Users of Talend Studio can set the governance rules. For more information about available administration tasks,
see  Setting data governance rules,  and Advanced subjects.

Users of Talend MDM Web User Interface can carry out any manual interventions necessary to make sure that
the master data is clean, consistent, and accurate. For more information, see Talend MDM Web User Interface
User Guide.

21.3.3. A comprehensive set of tools

The MDM solution offered by Talend consists of a comprehensive set of tools and functions, many of which are
accessible from a single interface called Talend Studio.

Inside Talend Studio you will find:

• Data integration features, available from the Integration perspective, that ensure that master data can be
integrated from a wide range of sources. The result is an innovative and powerful data integration solution
with hundreds of ELT/ETL connectors enabling interaction with multiple sources and the synchronization
of enterprise systems. From the Integration perspective, users can design different Jobs using a dedicated
component group that allows bulk loading of data. Moreover, MDM's event management and Talend Jobs are
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tightly coupled so that users can call a Job from within Talend Studio to validate, correct or propagate data in
the MDM Hub.

• Data profiling features, available from the Profiling perspective, that enable the profiling of the source data
before loading it into the MDM Hub, to help guarantee high standards of master data quality in your company.
From the Profiling perspective, users can profile data from various sources before loading it into the MDM Hub.

• Master data management features, available from the MDM perspective, that enable you to build data models
employing the necessary business and data rules to create one single master copy of the data which will be
propagated back to the source and target systems.

Talend Studio bundles Data Integration, Data Profiling and Master Data Management capabilities in a single tool
to enable the management of the complete data life cycle: from data integration to quality assurance, through to
the identification of master data and its governance.

For more information about accessing different perspectives, see Multi-perspective approach.

For detailed information about integration and data quality components, see the Talend Open Studio Components
Reference Guide.

21.4.  Example of a functional workflow
through Talend MDM
The below schema illustrates how data is handled in Talend MDM.

• A business user creates or modifies a master data record from Talend MDM Web User Interface,

• A Trigger that matches the conditions set on the data validated against a data model kicks in to initialize a
service. Various services can be initialized including Processes (callprocess) such as data validation or a human
validation process, an enrichment process, a data integration process, etc.

• A Process may use one or more plug-ins. Each plug-in performs certain tasks on master data. The most important
plug-ins used by a given Process are calljob and xslt.
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Chapter 22.  Getting started with Talend
Studio
This chapter introduces Talend Studio. It provides a short description of the Graphical User Interface (GUI) and
gives definitions of basic terms.

This chapter guides you through the basics for launching Talend Studio and emphasizes the use of multiple
perspectives, those of data integration, data quality and Master Data Management, in the same Studio.
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22.1. Important terms in Talend Studio
When working with Talend Studio and in order to understand its functional mechanism, it is important to
understand some basic vocabulary.

The following table defines some of the most essential terminology.

Term Description

Annotation Gives a description about the metadata that the administrator "attached" to an Entity in the data model.

Consumer Consumes data FROM the MDM Hub. A consumer may also be a provider.

Data Container Holds data of one or several business entities. Data containers are typically used to separate master data
domains.

Data governance The process of defining the rules that data has to follow within an organization.

Data Model Defines the attributes, user access rights and relationships of entities mastered by the MDM Hub. The
data model is the central component of Talend MDM. A data model maps to a single entity that can be
explicitly defined. Any concept can be defined by a data model.

Data stewardship The process of validating master data against the rules (data models) that are set in the Studio.

Domain A collection of data models that define a particular concept. For instance, the customer domain may be
defined by the organization, account, contact and opportunity data models. A product domain may be
defined by a product, product family and price list. Ultimately, the domain is the collection of all entities
(data models) that relate to a concept. Talend MDM can model any and many domains within a single
hub. It is a generic multi-domain MDM solution.

Entity Describes the actual data, its nature, its structure and its relationships. A data model can have multiple
entities.

Event Manager A service of the MDM Hub responsible for routing events thrown by the MDM Hub to trigger, evaluate
their conditions, execute Processes, and trace active / completed / failed actions for monitoring purpose.

MDM Hub Defines a complete Talend MDM implementation. It consists of components for Integration, Quality,
Master Data Model, an XML DB interface and operational database, Web Services, MDM Web Interface.
The MDM Hub is configured to meet different business needs.

Process A Process is executed when the condition specified by the corresponding Trigger is verified. A Process
may have several "steps", each step performs a specific task such as: update a record in the hub, run a
Talend Job, etc.

Provider Feeds data IN to the MDM Hub.

Record An instance of data defined by a data model in the MDM Hub. Two records may be compared and
considered similar or a close match, in which case the records may be linked and one may or may not
survive.

Talend Studio The administration user interface built from Eclipse. It allows the administrator of the system to manage
and maintain the MDM Hub and all associated Data Integration Jobs through a single console.

Triggers Condition for a Process to be executed, based on events thrown by the MDM Hub. Example of a Trigger
condition: Agency created and Agency/Revenue > 100. An event may cause more than one Trigger
conditions to be true, which will result in several Processes to be executed. Triggers are used to specify
when specific Processes such as notifications, duplicate checking, records enrichment, propagation to
back end systems, etc. should be executed.

Version (deprecated) Partition of the MDM Hub where part, or all, objects may be modified separately. The MDM Hub has at
least one Version shared by all users, which is considered as the "main" Version. Users typically create
additional Versions for sandboxing modifications before they are made available in the main Version.
This may also be used to isolate a derived Version of the MDM Hub for a specific group of users. A
Version can have its own copy of models, entities, views, etc., or it may share objects with other Versions
- for instance it may have a specific Version of the Product entity but still share the same model and
views of the main Version.

View A complete or a subset view of a record. A complete view shows all elements or columns in an entity,
while a subset view shows some of the elements or columns in an entity. A View may restrict access to
attributes of a record depending on who or what is asking for the data.
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22.2. Launching Talend Studio and
connecting to the MDM server
Talend Studio is the administration and parameter setting tool for the MDM platform. It is the Graphical User
Interface for administrators and it is run as an Eclipse plug-in.

Prerequisite(s): Make sure to install JBoss and the MDM server before launching Talend Studio. For further
information on the installation procedure using the .jar file, see Talend Installation and Upgrade Guide. For further
information on the installation procedure using the .exe file, see Talend Installation and Upgrade Guide.

22.2.1. Launching Talend Studio
To launch Talend Studio for the first time, do the following:

1. Launch the MDM server: in the JBoss folder, double-click run.bat if you are on Windows or run.sh if you
are on Linux.

Talend MDM server is a J2EE application, it comprises numerous J2EE artifacts. Allow several minutes for JBoss
to deploy the MDM server when it starts up.

If you set a PATH environment variable to specify where executable programs such as  run.bat  files are located, make
sure that this variable DOES NOT end with a backslash, otherwise the execution of the server will fail.

2. Unzip the Studio zip folder and open it.

3. Double-click the executable file that corresponds to your platform, for example TMDMCE-win32-x86.exe on
Windows or TMDMCE-linux-gtk-x86 on Linux 32 bits Intel, etc.

4. In the [License] window that appears, read and accept the terms of the license agreement to proceed to the
next step.

The startup window opens.

This screen appears only when you launch the Talend Studio for the first time or if all existing projects have been
deleted.

For more detailed information about launching the Studio, see Launching Talend Studio.

5. Click the Import button to import the selected demo project, or type in a project name in the Create A New
Project field and click the Create button to create a new project, or click the Advanced... button to go to
the Studio login window.

In this procedure, click Advanced... to go to the Studio login widow.
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6. From the login window:

Click... To...

Create... create a project where you can store all the Jobs and Business Models you create in the
Studio.

Import... import any project you have.

Demo Project... import the Demo project that includes various MDM objects and numerous samples of
ready to use Jobs. This Demo project can help you understand the MDM functionalities.

For more information about how to import a demo project, see How to import the demo
project.

Open open the selected project.

Delete... open a dialog box where you can delete any of the listed projects that you already created
or imported and that you do not need any more.

As the purpose of this procedure is to create a new project, click Create... to open the [New project] dialog
box.

7. In the [New project] dialog box, enter a name for the project, and then click Finish to close the dialog box.

The name of the new project displays in the Project field.
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8. Select the project, and click Open.

The Connect to TalendForge page appears, inviting you to connect to the Talend Community so that you
can check, download, and install external components, and upload your own components to the Talend
Community to share with other Talend users directly in the Exchange view of your Job designer in the Studio.

To learn more about the Talend Community, click the read more link. For more information on using and
sharing community components, see How to download/upload Talend Community components.

9. If you want to connect to the Talend Community later, click Skip to continue.

10. If you are working behind a proxy, click Proxy setting and fill in the Proxy Host and Proxy Port fields of
the [Network setting] dialog box.

11. By default, the Studio will automatically collect product usage data and send the data periodically to servers
hosted by Talend for product usage analysis ans sharing purposes only. If you do not want the Studio to do
so, clear the I want to help to improve Talend by sharing anonymous usage statistics check box.

You can also turn on or off usage data collection in the Usage Data Collector preferences settings. For more
information, see Usage Data Collector preferences (Talend > Usage Data Collector).

12. Fill in the required information, select the I Agree to the TalendForge Terms of Use check box, and click
Create Account to create your account and connect to the Talend Community automatically. If you already
have created an account at http://www.talendforge.org, click the or connect on existing account link to sign
in.

Be assured that any personal information you may provide to Talend will never be transmitted to third parties nor
used for any purpose other than joining and logging in to the Talend Community and being informed of Talend latest
updates.

http://www.talendforge.org
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This page will not appear again at Studio startup once you successfully connect to the Talend Community or if you
click Skip too many times. You can show this page again from the Exchange preferences settings page. For more
information on Exchange preferences, see Exchange preferences (Talend > Exchange).

A progress information bar appears, and then an [Additional Talend Packages] wizard and a welcome page
is displayed.

13. From the welcome page you have direct links to user documentation, tutorials, Talend forum, Talend on-
demand training and Talend latest news. Click Start now to close the welcome page and open the main
window of Talend Studio.

Talend Studio main window opens on the MDM perspective. For further information, see Multi-perspective
approach and Switching between different perspectives.

22.2.2. Connecting to the MDM server

Before you begin working with the MDM perspective of the Talend Studio, you need to create a connection to
at least one MDM server.

To create a connection to an MDM server, do the following:

1.
In the Studio main window, in the Server Explorer panel, click the  button to specify a new MDM server
location.

The [Add Server Location] dialog box appears.

You can have more than one active connection to the MDM server using different authentication information
(deprecated).

2. In the Name field, enter a name or description for the MDM server to which you want to connect.

You can then choose this alias to refer to the server from different points within the Studio. This simplifies
deployment of MDM related integration and quality jobs.

3. In the Server field, type in the address of the MDM server to which you want to connect.
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The server address is structured as follows:

-http://[server address]:[server port]/talend/TalendPort

4. Enter admin as the user name and talend as the password.

5. Click OK to close the dialog box and create the connection to the MDM server.

When developing an MDM solution, you can have more than one MDM server environment. Talend Studio allows
you to define multiple MDM server locations.

You can repeat the above procedure to create connections to as many MDM servers as needed. Then, in the Server
Explorer panel, you can choose which server to interact with from the list of servers displayed.

Talend Studio also allows you to disable one particular MDM server so that it will not appear in the dialog box
where you need to select an MDM server to access physically.

To disable an MDM server, in the Server Explorer panel, right-click the connection to the MDM server, and
then click Disable.

To enable an MDM server which has already been disabled, in the Server Explorer panel, right-click the
connection to the disabled MDM server, and then click Enable.

22.2.3. Viewing the log of activity on the MDM server

The server.log file, which is stored in the jboss/server/default/log directory, contains a log of activity on the MDM
server, including warnings and functional errors which may be useful for debugging potential issues that could
arise. Users who do not have direct access to the filesystem on the remote server on which MDM server is installed
can still view the contents of the log file directly from within Talend Studio or in a browser, provided they have
been assigned the administration role.

To view the server.log file in Talend Studio, do the following:

1. In the studio main window, in the Server Explorer panel, right-click the connection to the server where
MDM server is installed, and then click View Server Log.

A Console opens displaying the most recent contents of the server.log file.
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This view is updated automatically when the contents of the server.log file change, and you can manage
these updates using the buttons in the toolbar, for instance to pause the update, clear the console, or reload
its content.

2.
To download a copy of the complete log file to your local machine, click the download button , specify
the download location in the [Download server log] dialog box that opens, and then click OK.

To view the server.log file in a browser, do the following:

1. In your browser, enter the following address: http://<host>:<port>/datamanager/logviewer/
logviewer.html (for instance, http://localhost:8180/datamanager/logviewer/logviewer.html).

2. Enter the user name and password of an account with administrator rights.

The MDM Log Viewer opens.

In the browser window, you can perform any of the following actions:

• Click the Reload button to reload the contents of the log file.

• Click the Clear button to clear the display.

• Click the Download button to download a copy of the log file to your local machine.

• Click the Pause button to temporarily prevent the display of the log file from updating in your browser.

You can also edit the parameters Fetch Period (which is the time in milliseconds between each refresh of
the log displayed) and Max lines (the maximum number of lines displayed), then click Set Params to apply
your changes.
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22.3. Working with the MDM Repository
The MDM Repository enables you to work with your objects, including data models, jobs, processes, and stored
procedures, in a repository that is separate from the MDM Server database.

The MDM Repository can be stored locally or it can be stored on a remote server. If the repository is stored on a
remote server, it can be shared among many users, and in this case the locking of objects is managed by Subversion.

When you make changes to the objects in the MDM Repository, you must deploy these objects to the MDM Server
for your changes to be taken into account at runtime. For more information on setting a connection to an MDM
Server, see Connecting to the MDM server.

22.3.1. Displaying the MDM Repository view

To display the MDM Repository view, click Window > Show View to open the [Show View] dialog box, and
then select Talend > MDM Repository.
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22.3.2. Deploying objects to the MDM Server

You must always deploy your objects to the MDM Server for any changes you make to be taken into account
at runtime.

You have a choice of how you deploy objects to the MDM Server.

•
You can click the Update Server button  in the repository icon bar to deploy some or all of the objects that
have changed in the MDM Repository since your last deployment.

In the specific case of Jobs, only those Jobs that have previously been deployed using the Deploy to... option are proposed
for update.

• You can manually select which objects you want to deploy from the MDM Repository tree view, either by
specifying the destination server explicitly or by choosing to deploy to the last server used.

• You can edit the Preferences so that, when you save an object, it is automatically deployed to the last server used.

The steps involved in each of these different deployment methods are described in more detail in the following
procedures. For further information on deploying Jobs, see How to deploy Jobs from the MDM perspective

To deploy objects that have changed in the MDM Repository since your last deployment, do the following:

1.
In the MDM Repository tree view, click the Update Server button  in the repository icon bar.

2. In the window that opens, select the server where you want to deploy the object or objects from the drop-
down list, select the object or objects to deploy, and then click OK to perform the deployment.

To manually select the objects you want to deploy to the MDM Server, do the following:

1. In the MDM Repository tree view, right-click the object you want to deploy, and then click one of the
following deployment options:

• Deploy To... to select the MDM Server where you want to deploy the object from the list of available
servers

• Deploy To Last Server to reuse the server you used for the most recent deployment action

• Update Server to open the server update dialog box, as described in the previous procedure.

The deployment options available may vary depending on the type of object you want to deploy, and if you are
deploying the object for the first time or if it has already been deployed to a server.
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If you want to deploy multiple objects at the same time, press and hold down the Ctrl key while you click each of
the objects you want to deploy.

2. If appropriate, select the server where you want to deploy the objects in the [Select server location definition]
window.

3. In the [Deploy to Talend MDM] window, specify the Settings for the deployment:

1. Export type: Choose between Distributed (War) or Hosted (Zip).

Deploy the Job as a Zip file if you want it to be preloaded and run directly in the MDM Server, which
reduces latency. Deploy the Job as a War file if you want to embed it in a web service, for instance as a
way of deploying the Jobs across different servers for the purposes of load balancing.

2. Leave the Context scripts check box selected.

4. Click Finish to deploy your objects.

To automatically deploy objects to the MDM Server on saving, do the following:

1. Click Windows > Preferences.

The [Preferences] window opens.

2. Expand Talend, and then click MDM.

3. Select the Automatically deploy items onto last server when saving check box, and then click OK to
enable this option.

If this option is enabled, whenever you save any changes you make to an object, the object is automatically
deployed to the MDM Server.

If the objects you want to deploy are being handled and deployed by another user, one or more conflicts will
occur. You can set up a strategy to reconcile the conflict(s). For more information, see Setting up a reconciliation
strategy for deployment conflicts.
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You can also undeploy one or more deployed objects from the MDM server. For more information, see
Undeploying one or more objects from the MDM Server.

22.3.2.1. Setting up a reconciliation strategy for deployment
conflicts

Sometimes, several users may handle objects simultaneously. In this case, conflicts could easily occur when one of
the users wants to deploy objects to the MDM server. You can set up a reconciliation strategy for the deployment
conflict(s).

This feature is only available to users who install MDM servers with relational databases.

The following reconciliation strategies for deployment conflicts are available:

• Default (Skip same, overwrite difference, and deploy not exists): the same objects are skipped, the objects
which are different from those on the studio side will be overwritten, and the objects which do not exist will
be created.

• Overwrite All: all relevant objects will be overwritten.

• Skip Difference (Skip same and different object): both the same objects and the objects which are different
from the those on the studio side will be skipped.

To set up the reconciliation strategy for deployment conflicts in the dialog box that warns about deployment
conflict(s), proceed as follows:

1. In case of one or more deployment conflict(s), the following dialog box appears:

2. Select the desired reconciliation strategy according to your need.

3. Select the Remember my choice, don't show this dialog again check box to make the reconciliation strategy
remain unchanged upon validation.

If you want to show this dialog box once again so that you can set up a new reconciliation strategy, select the
Show the conflict dialog when more than one object has conflict check box in the [Preferences] dialog
box. For more information, see Setting up a reconciliation strategy in Preferences.

4. If needed, click the Show Conflicts button to learn about the conflict details.
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The Operation column allows you to select the reconciliation action to be taken for each conflict.

Besides, you can set up the operation in batch mode by clicking the buttons on the right side of the dialog box.

If you want to overwrite all relevant objects, click Overwrite All. If you want to skip the same objects, click
Skip Same. If you want to skip the objects which are different from those on the studio side, click Skip
Difference.

If needed, select the Only Show Conflict and Modified Objects check box to view only the objects which
are modified and involved in the conflicts.

If needed, select the Show Local And Server Timestamp check box to view the timestamp differences.

Click OK to close the dialog box.

5. Click OK to validate your changes.

Alternatively, you can set up the reconciliation strategy for deployment conflicts in the [Preferences] dialog box.

To do that, proceed as follows:

1. From the menu bar, click Window > Preferences to open the [Preferences] dialog box.

2. Expand the Talend > MDM node and click Consistency.
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3. By default, the Show the conflict dialog when more than one object has conflict check box is selected. It
means that the dialog box that warns about deployment conflict(s) will appear even if only one deployment
conflict occurs.

4. Select the appropriate reconciliation strategy option according to your needs.

5. Click OK to validate your changes.

22.3.3. Undeploying one or more objects from the
MDM Server

After objects are deployed, you are allowed to undeploy them so as to remove their information directly from
the MDM Server.

You can undeploy only one object at a time or undeploy multiple objects together in one go.

To undeploy one or more objects, do the following:

1. In the MDM Repository tree view, right-click the deployed object or objects that you want to undeploy, and
click Undeploy From....
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2. In the [Select a server location definition] dialog box that appears, select the server from which you want
to remove the object information and click OK.

3. Finally, a dialog box shows that the system objects are undeployed successfully. Click OK to close the dialog
box.
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In the MDM Repository tree view, the information showing that one or more objects are deployed on the
server will disappear as the objects are no longer deployed on the server.

For more information about how to deploy objects to the MDM Server, see Deploying objects to the MDM Server.

22.3.4. Importing server objects from the MDM Server

You can import system objects, including data models, jobs, processes, and stored procedures, from the MDM
Server database to the MDM Repository.

To import system objects from the MDM server, do the following:

1. In the MDM Repository tree view, right-click any object, and then click Import Server Objects from
MDM Server.

The [Import Server Objects from MDM Server] window opens.

2. Click the [...] button, select the server from which you want to import the objects in the [Select a server
location definition] window that opens, and then click OK.

The window is populated with a list of all available system objects.
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3. Select the objects you want to import.

4. If needed, you can expand the object node to check the comparison result between objects on the studio side
and those on the server.

You can click the Skip Same button to skip the objects which are the same as those on the studio side.

5. Click Finish to import the selected objects to your MDM Repository.

22.4. Main window and navigation principles
The MDM perspective of Talend Studio is a user interface for designing and administrating Talend MDM.

In the main window, all data objects in the MDM Repository are listed in a tree view on the left hand side of
the window.

Below is an example of a Talend Studio main window open on the MDM perspective.
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From the tree view:

• Double-click any of the MDM objects to open an editor on the right hand side of the main window. Here, you
can view the object metadata or set the object parameters.

• Right-click any of the MDM objects or any item under an MDM object to display a contextual menu with
multiple options.

22.5. Multi-perspective approach
Talend Studio offers a comprehensive set of tools and functions for all its key capabilities including data
integration, data profiling and master data management. These tools are ALL accessible in different perspectives
from one single platform.

22.5.1. Switching between different perspectives

There are different ways to switch between the Integration, Profiling or MDM perspectives.

The options are as follows:

• In the upper right corner of the Talend Studio main window, click the  icon and then select Other... to display
the [Open Perspective] dialog box.
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• Select the perspective you want to access, Integration for example, and then click OK to close the dialog box.
The Integration perspective of your studio displays.

It is also possible, using the Window - Show view... combination, to show views from other perspectives in the
open perspective.
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Alternatively, you may also switch between different perspectives by doing the following:

• On the menu bar, click Window > Perspective to display a list from which you can select the perspective to
open.

Finally, you can also switch between available perspectives by simply clicking the corresponding icon on the
upper right corner of the main window.

For more information on how to manage the display of these icons, see Managing quick access icons for different
perspectives.
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22.5.2. Managing quick access icons for different
perspectives

Every time you open a perspective in Talend Studio, a corresponding icon is docked on the upper right corner
of the main window.

To manage the display of these quick access icons, do the following:

1. Right-click the icon of the open perspective to display a contextual menu.

2. Select the needed management option from the menu.

The quick access icon or the corresponding perspective is changed accordingly.

The table below lists all available management options and their indications.

Option Description

Customize Opens a dialog box where you can

-customize shortcuts in the current perspective

-add command groups to the current perspective

Save As... Changes the text that displays next to the icon as a title for the current perspective

Reset Returns the current perspective to its default state

Close Closes the current perspective

Dock on Places the icons of the open perspectives:

Top right: in the upper right corner of the Studio

Top left: in the upper left corner of the Studio

Left: to the left of the Studio

Show text Displays/hides text next to the icon
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Chapter 23.  Setting data governance rules
This chapter provides the information you need to define the rules master data has to follow. These rules include
how to partition data; what validity models are required for data; who can read, create, update, and delete data and
what services to be taken on data, to name a few.
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23.1.  MDM working principles
From Talend Studio, you can define the rules that master data has to follow.

A typical sequence of setting governance rules in Talend Studio involves the following steps:

1. Create a data model containing one or multiple business entities. A business entity can be a supplier, a country,
a customer, etc. For more information, see Setting up a data model.

2. Define a data container in the MDM Hub where the master data is to be persist. For more information, see
Creating a data container.

3. Design one or more Processes that perform transformations, data validation and other tasks. Processes usually
call a sequence of available plug-ins to project data from the source system to a defined data container (MDM
Hub). During projection, the data is transformed, cross-referenced if needed and validated against the entity
model. For more information on Processes, see How to create a Process from scratch.

4. Design one or more Triggers, rules for transforming data, that enable the event-based Processes to be
undertaken on specific data records. For more information, see Creating a Trigger.

After projection, the MDM Hub holds valid data (model compliant data) that a data steward or a business user
can query and/or extract via Talend MDM Web User Interface. For more information, see the Talend MDM Web
User Interface User Guide.

Before a given business user is able to extract and query valid master data via the web-based User Interface, you
need to create one or more Views in Talend Studio that specify:

• which records of an entity a business user has the right to search,

• which records of an entity a business user has the right to view,

• optionally which conditions should the content meet to be delivered as the result of a search (content filters).

For more information on Views, see Creating a View.

23.2. Data Models
Data models are the central component of Talend MDM. They only define the master entities you want to manage
while master data records themselves are stored in data containers.

For further information about data containers, see Data Containers.

Data models contain entities which are master data objects (or business entities) such as a Person, a Product, an
Organization, etc. Each entity is defined by its attributes which are the entity characteristics, for example, for the
Person entity, the attributes could be name, date of birth, address, etc.

When creating a data model from Talend Studio, you compartmentalize records and data to create the most efficient
data model possible. In addition, you can define the attributes,user access rights and relationships of entities
mastered by the MDM Hub.

Authorized users can create, import/export, edit, copy/paste and delete data models.

The following sections detail the procedural steps to carry out each of the above management options.

23.2.1. Setting up a data model
If you have the appropriate user authorization, you can create one or multiple data models for any domain and
store them in the MDM Hub.
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Once created, an authorized user of Talend MDM Web User Interface can validate hub data against these data
models. For more information, see the Talend MDM Web User Interface User Guide.

A few steps are necessary to complete the creation of a data model:

1. Create business entities in the model.

2. Adding attributes in each of the created business entities.

3. Set annotations to entities or attributes regarding display issues, foreign key, etc.

You can also define reusable types for any data model. These reusable types are sets of attributes that can be used in
one or more entities of the data model. Using reusable types is a way of factoring the data model and managing the
impact of changes since any modification on a reusable type will have an impact on every entity that uses this type.

Once the data model is created, you can easily create Views over one or multiple business entities held in this data
model. Creating a View on a business entity allows a business user inside Talend MDM Web User Interface to
visualize specific records in this entity according to the defined criteria.

Once the data model is created, you can right-click any of the entities held in this data model and automatically generate
a default View for the selected entity.

For more information, see Views.

Once the creation of the data model is complete, you may need to design one or more Processes and create a View
to define search parameters on business entities and data records in the created data model.

For more information on Processes and Triggers, see Processes and Triggers respectively.

For more information on Views, see Views.

23.2.1.1. How to create a data model

Prerequisite(s): You have already connected to the MDM server from Talend Studio.

To create a new data model, proceed as follows:

1. In the MDM Repository tree view, right-click Data Models and select New from the contextual menu.

A dialog box appears.

2. Enter a name for the new model. Make sure that the name contains valid characters and does not already exist.

3. By default, the Create the corresponding Data Container at the same time check box is selected, so that
the corresponding data container with the same name will be created.

If needed, you can clear this check box and create the corresponding data container with the same name later.
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A data container and its corresponding data model must have the same name.

4. Click OK to validate your changes and close the dialog box. The newly created data model and its
corresponding data container will appear in the MDM Repository tree view.

5. Click the data model, and an editor appears in the Studio workspace where you can set up the parameters
for the new data model.

You can define your business entities, attributes, annotations, etc. in the upper part of the editor; while the lower
part will display the properties of any of the elements you select in the editor.

The editor also enables you to switch to the XML schema design and XML schema source through clicking the
Schema Design and Schema Source tabs respectively.

You can create the data model directly in the schema source, XML document, if you click the Schema Source tab at the
bottom of the editor.

23.2.1.2. How to create business entities in the data model

Prerequisite(s): You have already created a data model. For further information, see How to create a data model.
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To create business entities in the model:

1. Right-click in the Data Model Entities panel and select New Entity to open the [New Entity] dialog box.

2. In the Name field, enter a name for the new entity.

3. Select the Complex type option if you want to define a complete structure, such as an address. The steps
that follow differ according to the selected type.

You cannot create two complex types where one is a base type and the other is a type that derives from the base type,
and then create entities based on these types.

Instead, you should first define a higher level entity which implements its own complex type (for example, Media) to
define all common elements for the entity. Next, define another complex-type element (for example, MediaSpecifics)
which can extend Media and then be extended in turn. In this example, MediaSpecifics could be extended with Books
to add elements that are specfic to books and Audio to add elements that are specific to audio media.

At this point you can create a Browse_item_Media#Books View that filters (where clause) on @xsi:type -
equals - Books and a Browse_item_Media#Audio View that filters on @xsi:type - equals - Audio. The standard
Browse_item_Media View would return all media.

For more information on creating Views, see Views.

4. Select the Simple type option if you want to define a single element type such as a phone number, an email,
etc. The steps that follow differ according to the selected type.

You can still change the entity type after you create it if you right-click the entity in the Data Model Entities panel
and select Change to a Complex Type or Change to a Simple Type.
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5. If you select Complex type, select the group type among:

-All: to list the elements in any sequence,

-Sequence: to list the elements according to the defined sequence,

-Choice: to have a choice on the elements.

6. Enter a name for the complex type in the corresponding field, if you want to create a reusable type of this
entity.

Reusable types are sets of attributes that can be used in one or more entities.

The complex type list gives you access to all complex types you create in your data model. When defining a new
entity, you can select from this list the complex type from which you want to inherit elements in the new business
entity. Each complex type you define can serve as the basis for another complex type. For further information, see
Data model inheritance and polymorphism.

7. Click OK to validate your changes and close the dialog box.

The created business entity is listed in the Data Model Entities panel with a by-default record, which takes
its name from the entity name with the suffix Id, and the complex type, if any, displays in the Data Model
Types panel.

Each time you create a new business entity, a default Primary Key record, which takes its name from the entity name
with the suffix Id, and a Unique Key record which has the same name as the Entity are automatically created. For
example, if you create a new business entity and name it Agency, the Primary Key record AgencyId will be created
automatically.

A Primary Key can be an integer but a Foreign Key must always be a string. The server surrounds Foreign Keys with
square brackets to support compound keys.

8. Repeat the above steps to create as many business entities as you need in your data model.

All business entities you create are listed in the Data Model Entities panel.

To finish defining the business entities in your data model, you must create attributes in these business entities.
These attributes represent the characteristics of each of the business entities. For further information, see How to
add attributes to the business entity.

Displaying user data differently based on locale

You can also set up the elements you create so that the Talend MDM Web User Interface displays the data for a
record differently depending on the user's locale.

Prerequisite(s): You have already created business entities in the data model. For further information, see How
to create business entities in the data model.
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1. Right-click the element, and then click Change to a Simple Type in the contextual menu.

The [Make Simple Type] dialog box opens.

2. Select the Custom radio button and set the Type as MULTI_LINGUAL by selecting this option in the drop-
down list, and then click OK.

Users of Talend MDM Web User Interface will now be able to create localized instances of the data for this field.
For further information, see the Talend MDM Web User Interface User Guide.

23.2.1.3. How to add attributes to the business entity

Prerequisite(s): You have already created business entities in the data model. For further information, see How
to create business entities in the data model.

To add attributes to the business entity, do the following:

1. Expand the business entity you created and the group type in succession and right-click subelement then
select Edit Element from the contextual menu.

A dialog box displays.

2. Change the name to Id and set the minimum and maximum occurrences to 1 and then click OK to close
the dialog box.

3. Right-click Id, select Add Element (after) from the contextual menu, and then select Add string Element.

A dialog box displays.

4. Enter a name and a minimum and maximum number of occurrences for the new attribute in the corresponding
fields.

Talend Studio supports the definition of multi-occurrence attributes. You can set the Maximum Occurrence value to
a specific number or leave it blank, which means the maximum number of occurrences is not bounded: in this case,
the cardinality will be [1..many] or [0..many].

5. Click OK to validate your changes and close the dialog box.

6. Follow the same steps to create as many attributes as needed in the business entity.
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All attributes you create are listed under the business entity in the Data Model Entities panel, and all complex
types are listed in the Data Model Types panel.

The data model editor includes a Properties view that displays all the properties of the selected entity/attribute in the
data model. You can use this detail view to edit dynamically any of the entity or attribute listed in the data model. For
further information, see How to use the Properties view in the data model editor.

7. If required, right-click any of the listed element and select Edit element to open a dialog box where you can
change the parameters for the selected element.

You can switch to the XML schema design or XML schema source through clicking the Schema Design and
Schema Source tabs respectively.

Below is an example of an XML schema design:
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The XML schema design presents the data model in a graphical format. This format shows related entities in a
graphical format and also implements an XSD editor.

1. Double-click any of the items in the Types panel in the XML schema design.

A graphical format of the selected data model type displays.
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2.
Click the  icon in the upper left corner of the editor to go back to the XML schema index view.

Because Talend MDM uses XSD as the language to support data modeling and to make it easier to import existing
XML schemas, you can use any of the XSD capabilities in any of the XML schema views. Some management
options are accessible from the XML schema design or XML schema source if you right-click any of the entities/
attributes listed in the view, or if you right-click in the view itself.

You can also select any of the elements or types in the XML schema design to display its properties in the
Properties view. Then you can modify any of the listed properties in the view and reflect the modification directly
in the XML schema design.

Below is an example of an XML schema source:

You can carry out any modifications on the business entities or attributes directly in the XML schema source. This enables
you to take advantage of such features as code-assist and syntax highlighting.

After defining business entities and attributes in your data model, you must set annotations to these entities or
attributes regarding display issues, foreign keys, etc. The following sections explain this in detail.
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23.2.1.4. How to set up annotations to business entities

Prerequisite(s): You have already created business entities and attributes in the data model. For further
information, see How to create business entities in the data model and How to add attributes to the business entity.

The data model editor makes it very easy to add specific annotations to any business entity in the data model.

Through annotations, you can define display issues related to language specific labels, foreign and primary keys,
multilingual description etc.

The below table describes the annotations you can add to business entities.

Option Description

Add Key To add a unique or a simple key to the selected entity.

Set the Labels To have labels in different languages for any business entity in the data model.

You can automatically generate the labels for new entities in any of the listed languages. To
generate a label automatically, select a language from the Language list in the upper right corner
of the data model editor and then click the plus button.

Set the Descriptions To have multilingual descriptions for different business entities in the data model.

Set Lookup Fields To look up fields in the source system through a Process attached to a specific view in order to enrich
data on the fly. For example, when an interaction is done on a business entity that is not persisted or not
totally persisted in the MDM Hub. For further information, see Running the view result through a Process
(registry style lookup)

Set the Primary Key
Infos

To display specific data related to the business entity when accessing any data record in the business entity
through Talend MDM Web User Interface.

When you add any of the above annotation to a business entity, an Annotations node is added to the business
entity in the Data Model Entities panel. This node lists all the annotations added to the business entity.

As an example of how to set up an annotation to a business entity, the below procedure gives detail information
about how to add the Set the Primary Key Infos annotation.

1. Right-click the business entity to which you want to add the annotation.

2. In the contextual menu, select the annotation you want to apply to the selected business entity, Set the
Primary Key Infos in this example.
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A dialog box corresponding to the annotation option you have selected displays.

3.
Click  and select from the list the primary key information you want to display in Talend MDM Web User
Interface when a user access any of the records of the selected business entity. In this example, you want
each agency record to be headed with the agency name.

4.
Click the  button in the upper right corner to add the selected xpath to the xpaths list and then click OK
to validate your changes and close the dialog box.

The set annotation displays under the selected business entity.
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5. Click the save icon on the toolbar or press Ctrl + S on your keyboard to save your modifications.

When a business user access the data model holding this entity through Talend MDM Web User Interface and
browse for any of the data records in this entity, the detailed view of the data record will have the agency name
as its heading as defined in the above procedure.

23.2.1.5. How to set up annotations to attributes

Prerequisite(s): You have already created business entities and attributes in the data model. For further
information, see How to create business entities in the data model and How to add attributes to the business entity.

The data model editor makes it very easy to add specific annotations to any attribute within the business entity.

Through annotations, you candefine display issues related to language specific labels, foreign and primary keys,
multilingual description etc.

The below table describes the annotations you can add to attributes within business entities.

Option Description

Set the Descriptions To have multilingual descriptions for different attributes in business entities.

Set the Labels To have labels in different languages for any attribute within a business entity in the data model.

You can automatically generate the labels for new attributes in any of the listed languages. To
generate a label automatically, select a language from the Language list in the upper right corner
of the data model editor and then click the plus button.

Set the Foreign Key To link one attribute to another attribute or to a business entity. For further information, see How to add
a foreign key: linking entities together.

A Primary Key can be an integer but a Foreign key must always be a string. The server surrounds
Foreign Keys with square brackets to support compound keys.

Set the Foreign Key
Filter

To filter foreign keys by values extracted from the current record through using the standard xpath predicate
of the relevant element. For further information, see How to add a foreign key filter.

Set the Foreign Key
Infos

To display the data related to the foreign key.

Set the Facet Message To set multilingual facet error messages.

Set the display format To decide the format according to which you want to display/insert, in a specific language, dates or numbers
in master data records in Talend MDM Web User Interface.

To define the date/number format, you must use a syntax that is based on the java.util.Formatter
class. For further information on this class, see http://download.oracle.com/javase/6/docs/api/java/util/
Formatter.html.

http://download.oracle.com/javase/6/docs/api/java/util/Formatter.html
http://download.oracle.com/javase/6/docs/api/java/util/Formatter.html
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Option Description

For an example on how to set the display format, see How to set the display format of dates and numbers.

When you add any of the above annotation to an attribute in a business entity, an Annotations node is added to
the attribute in the Data Model Entities panel. This node lists all the annotations added to the selected attribute.

To set up an annotation to any of the attributes you create in a business entity, do the following:

1. In the Data Model Entities panel, right-click the attribute to which you want to add the annotation.

2. In the contextual menu, select the annotation you want to apply to the selected attribute.
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A dialog box corresponding to the annotation option you have selected is displayed.

For example, if you select Set the Labels to have labels in different languages for a selected attribute, the
following dialog box pops up.

3. From the list to the left, select a language and then enter a label in the field to the right.

4.
Click the  icon in the upper right corner to add the defined label to the Language/Label list and then
click OK to validate your changes and close the dialog box.

The set annotation is displayed under the selected attribute.

5. Click the save icon on the toolbar or press Ctrl + S on your keyboard to save your modifications.

You can automatically generate the labels for new attributes in any of the listed languages. To generate a label automatically,
select a language from the Language list in the upper right corner of the data model editor and then click the plus button.

23.2.1.6. How to add business rules

Talend Studio enables you to enrich data models by adding simple business rules.
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How to add simple rules

In any business entity, you can set rules against which you validate the entity attributes (minimum and maximum
length, list of values, etc.).

Prerequisite(s): You have already created a data model and the business entities and attributes in the data model.
For further information, see How to create a data model, How to create business entities in the data model and
How to add attributes to the business entity.

Consider as an example that your data model holds the following entities: Agency, Agent and Region. You have
an attribute called Rating in the Agency entity. This attribute will be used as a reference to the agency rating (list
of values) in a workflow process.

To add a simple rule to a business entity, do the following:

1. In the data model editor, right-click the Rating attribute and select Change to a Simple Type.

A dialog box displays.

2. Select the Custom option and then enter RatingType in the Type field.

3. Click OK to validate your changes and close the dialog box.

The RatingType simple rule displays under the selected attribute in the data model editor and a reusable type
of the same simple rule is created in the Data Model Types list.
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4. Right-click the simple rule in the Data Model Types panel and select Edit Enumeration.

A dialog box displays.

5. In the New Item field, enter the first agency rating value and then click the plus button to clear the text field
and add the value to the list.

6. Repeat the operation to add as many values as needed and then click OK to close the dialog box.

The added values display under the simple rule in the data model editor.

23.2.1.7. How to add a foreign key: linking entities together

Talend Studio enables you to set relationship between different entities using Foreign Keys.
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Prerequisite(s): You have already created data models, business entities and attributes in the data model. For
further information, see How to create a data model, How to create business entities in the data model and How
to add attributes to the business entity.

Consider as an example that your data model hold the following entities: Agency, Agent and Region. You want
to link the two entities Agency and Region together in order to represent that an Agency belongs to a Region.
Consequently, Agency will have a new attribute that points to a Region.

To set a foreign key, do the following:

1. Add a new Region attribute to the Agency entity as outlined in How to add attributes to the business entity

2. Right-click Region and select Set the Foreign Key from the list.

[Set the Foreign Key] dialog box displays.

3. Click the three-dot button to open the [Select Xpath] dialog box.

4. Browse to the Region primary key Id and then click Add in the bottom of the dialog box to proceed to the
next step.



Setting up a data model

Talend Open Studio for MDM User Guide 781

The Xpath to the foreign key displays in the [Set the Foreign Key] dialog box.

5. If you want to render the Foreign Key in the main tab, select the Render Foreign Key in the main tab?
check box. By default, Talend Web UI renders the Foreign Key in a separate tab.

6. Click OK to close the dialog box.

The foreign key is set to Region/Id under the Annotations node of the Region attribute in the data model
editor.

Entities which are linked by a foreign key are identified by a key icon with a green arrow . To jump
directly to the related entity, right-click the entity in the data model editor and click Jump to Foreign Key
Entity.

23.2.1.8. How to add a foreign key filter

One of the most useful annotations that you can set up on any of the attributes (elements) of the business entities
in a data model is the foreign key filter.

Through this annotation, you can filter foreign keys by:

• values extracted from the current record through using the standard xpath predicate of the relevant attribute,

• complex expressions: literal and functions,

• current record values and complex expressions.

Note that if the filter is not an xpath but a value, it needs to be enclosed in quotes (").

Custom filters for foreign keys are not supported when you use a SQL database to store your data records.

Prerequisite(s): You have already created data models, business entities and attributes in the data model. For
further information, see How to create a data model, How to create business entities in the data model and How
to add attributes to the business entity.

Consider as an example that your data records hold the following entities: Agency, Agent and Region. The Agency
and Region entities hold the Country attribute. In Talend MDM Web User Interface, you want to filter the foreign
key values by the Country attribute.

To set a foreign key filter, do the following:

1. Right-click the attribute to which you want to add the annotation, Agency > Region in this example.
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2. In the contextual menu, select Set the Foreign Key Filter.

A dialog box displays.

3.
Click the  icon to add a line to the table where you can define the foreign key filter.

4. Click in the XPath column and then click the three-dot button to open a dialog box where you can select the
XPath on which to set the foreign key filter.
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5. Select Region > Country and then click Add in the dialog box.

The XPath is set to Region/Coutry.

6. Click in the Operator column and select an operator from the list, Contains in this example.

7. Click in the Value column and then click the three-dot button to open a dialog box where you can select the
value on which to set the foreign key filter.

8. Select Agency > Country and then click Add in the dialog box.

The foreign key filter value is set to Agency/Coutry.

9. In this example, you want to filter foreign keys based on the Country attribute:
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Click OK to close the dialog box.

The defined foreign key filter displays under the Annotation node of the Region element.

10. Click the save icon on the toolbar or press Ctrl + S on your keyboard to save your modifications.

Now in any agency record in Talend MDM Web User Interface, every time a user clicks on the foreign key icon
next to the Region field, the list will only include the foreign keys based on the Country attribute.

23.2.1.9. How to set the display format of dates and numbers

Talend Studio enables you to decide the format according to which you want to display/insert dates or numbers in
different languages in master data records in Talend MDM Web User Interface.

You must use a syntax based on the java.util.Formatter class to define the display of dates and numbers in a specific language.
For further information about this class, see  http://download.oracle.com/javase/6/docs/api/java/util/Formatter.html .

http://download.oracle.com/javase/6/docs/api/java/util/Formatter.html
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Prerequisite(s): You have already created data models, business entities and attributes in the data model. For
further information, see How to create a data model, How to create business entities in the data model and How
to add attributes to the business entity.

Consider as an example that your data model holds the Agent entity and that you have created an attribute in this
entity, StartDate, to display the start date of the agent.

To set the display format of dates in the English and French languages, do the following:

1. In the data model editor, expand the Agent entity and browse to the StartDate attribute.

2. Right-click StartDate and select Set the display format.

A dialog box displays.

3. From the language list, select the language for which you want to define the date format.

4. In the field to the right, enter the syntax for the date format according to the java.util.Formatter class.

In this example, enter %tc for the English language and %1$td/%1$tm/%1$ty for the French language.

5. Click the plus button to add each of the two lines to the list below the fields, and then click OK to close
the dialog box.

The two annotations display below the selected attribute.
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When a business user accesses the Agent record through Talend MDM Web User Interface, the start date will
display as the following in English Mon Jul 12 00:00:00 CST 2010:

And as the following in French 07/12/10:
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You can follow the same procedure to set the display format of numbers. For example, assume that the actual
value in the database is 2.5 (XSD standard); if you define the format in English as the following %-10.4f, the
result in the web application will be 2.5000. And if you define the format in French as the following %-10.4f,
the result in the web application will be 2,5000.

Java automatically substitutes the local-specific decimal separator.

23.2.1.10. How to use the Properties view in the data model editor

The data model editor has a Properties view that details all the properties of the currently selected element (entity
or attribute) in the editor. The properties in the view are arranged in different categories in order to represent the
element linguistic presentation, validation rules, etc.

From this view, you can easily edit any of these properties and see the change in the data model on the fly.

Prerequisite(s): You have already created a data model, with the corresponding business entities and attributes.
For further information, see How to create a data model, How to create business entities in the data model and
How to add attributes to the business entity.

To edit an element in a data model from the Properties view, do the following:

1. Open the data model that holds the elements you want to modify.

2. In the data model editor, select an element (entity or attribute) to display its main properties in the view.
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3. Click, any of the tabs in the view to display the corresponding properties and modify them according to your
needs.

All your modifications will reflect in the data model editor on the fly.

23.2.2. Data model inheritance and polymorphism

Talend MDM introduces a true object-oriented data model that allows you to use inheritance and polymorphic
characteristics when defining your data models. This object-oriented approach enables you to define inheritance
hierarchies (inheritance trees) in the data models you create in Talend Studio. For further information on setting
up a data model, see Data Models.

Inheritance allows you to extend an existing type to add or override specific elements while inheriting the
attributes from the main entity. This summarizes the two main concepts included in inheritance: generalization
and specialization. Generalization (or abstraction) is the process of sharing attributes from the main type and
inheriting them automatically in other subtypes (inheritance types). In contrast to generalization, specialization
means creating new subtypes from an existing main type by adding attributes specific to each subtype.

Polymorphism allows you to set the type of an element to an abstract generic type and the concrete type is
determined at runtime. For instance you can have an address established and define it at runtime as a US or
European address.
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Inheritance and polymorphism are supported for both attributes and entities. The sections below gives examples
for both cases.

23.2.2.1. How to use inheritance and polymorphism with
attributes

Consider as an example that your data model could contain a Person entity. This business entity has several
attributes including Address. This attribute has one main reusable type, AddressType. Talend Studio enables you
to create inheritance reusable types that return a collection of new elements while inheriting the attributes from
the AddressType in order to return one address format specific to Europe and another specific to the USA. So in
this example, the Europe and US address types both extend the generic address type.

Prerequisite(s): You have already created the data model and business entities in the data model. For further
information, see How to create a data model and How to create business entities in the data model respectively.

To create inheritance and polymorphism for attributes, do the following:

1. Expand the business entity you created and the group type in succession and right-click the default Primary
Key record then select Edit Element from the contextual menu.

A dialog box pops up.

2. Change the name to Id  and then click OK to close the dialog box.

3. Right-click Id, select Add Element (after) from the contextual menu, and then select Add string Element.

Add Firstname, Lastname, DOB, PostalCode, Resolution and Address as attributes of the Person entity as
outlined in How to add attributes to the business entity.

Your data model should look like the one shown below.
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4. Right-click Address and select from the list Change to a complex type.

A dialog box displays.

The complex type enables you to define a complete structure, as you need for an address, and not only a
single element.

5. Enter a name for the complex type and then select the Sequence option in order to list the address elements
in the defined order.

Click OK to validate your changes and close the dialog box.

The complex type is listed under the Address attribute and also in the Data Model Types panel.

6. You now need to create the elements in your address:

Expand AddressType and rename the by-default subelement to Line1.

7. Right-click Line1 , select Add Element (after) from the contextual menu, and then select Add string
Element. Add two other elements to the address: Line2 and City.
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The elements in the address types are now created below the Address attribute and also in the Data Model
Types panel.

Now you need to create the inheritance type(s) for the US and EU addresses. The EUAddressType extends
the main AddressType by adding a postal code and a country, whereas theUSAddressType extends the main
AddressType by adding a zip code and a state.

8. Right-click in the Data Model Types panel and select Create a Complex Type.

A dialog box pops up.
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9. Enter a name for this inheritance type, EUAddressType in this example.

From the complex type list, select the main type from which you want to inherit existing elements,
AddressType in this example.

10. Click OK to validate your changes and close the dialog box.

The inheritance type is created in the Data Model Types panel with a by-default subelement element.

This inheritance type derives the three elements in the main AddressType. You can now add elements specific
to this type in order to have a complete address format for Europe.

11. Change subelement to PostalCode and then add a Country element.

Follow the same steps in the Data Model Types panel to create another inheritance type that you call
USAddressType that inherits the main AddressType. Add a ZipCode element and a State element in order to
complete the address format for the USA.
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12. Save your data model.

You have achieved inheritance here at the attribute level by extending an existing type (AddressType) to add
specific elements to complete the US and EU addresses while inheriting the attributes from the main address type.

Polymorphism is also achieved when, at runtime, the actual address instance of a person can be an EUAddressType
or a USAddressType. When business users browse master data records through Talend MDM Web User Interface,
the concrete address type for the open record (person) is automatically selected. Business users will also have in
an open record a list for the Address attribute. From this list they can choose any of the complex address types
you defined in Talend Studio.
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By default, the list displays the code of the types, but Talend Studio also lets you define labels for the complex
types so that they can have labels in different languages and become more understandable as displayed in the list.

You can define labels either in the Data Model Types panel or in the source XML schema of the data model.

You can set the order in which you want to display the extended types within the raw XML schema editor by adding the
annotation manually. Doing so via the graphical user interface is not currently supported.

To define labels for complex types in the Data Model Types panel, proceed as follows:

1. Open the data model where you have defined the complex types.

2. Right-click the complex type for which you want to set labels and then select Set the labels.
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3. The [Set the Labels] dialog box pops up.

From the list to the left, select a language and then enter a label corresponding to the selected language in
the field to the right.

4. Click the [+] button in the upper right corner to add the defined label to the Language/Label list.

5. Click OK to validate your changes and close the dialog box.

The labels will be displayed under the Annotations node of the complex type.
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When business users browse master data records in the updated data model through Talend MDM Web User
Interface, the list for the Address attribute shows the complex type labels you defined in the annotations.

To define labels for the complex types in the source XML schema of the data model, proceed as follows:

1. Open the data model where you have defined the complex types.

2. Click Schema Source at the bottom of the editor to open the source XML schema of the data model.
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3. Browse to the schema corresponding to the extended complex type to which you want to add a label and
which you want to display in a certain order for the business user.

4. Inside the root element of the complex type, use the X_Label_<ISO> annotation to add a label for the extended
type and the X_Order_Value annotation to define the order of the extended type, as follows:

...
<xsd:complexType name="EUAddressType">
 <xsd:annotation>
  <xsd:appinfo source="X_Label_EN">EU address format</xsd:appinfo>
    <xsd:appinfo source="X_Label_FR">format d'adresse UE</xsd:appinfo>
    <xsd:appinfo source="X_Order_Value">2</xsd:appinfo>
 </xsd:annotation>
  <xsd:complexContent>
    <xsd:extension base="AddressType">
      <xsd:sequence maxOccurs="1" minOccurs="1">
        <xsd:element maxOccurs="1" minOccurs="1" name="PostalCode"
 type="xsd:string"/>
        <xsd:element maxOccurs="1" minOccurs="1" name="Country" type="xsd:string"/>
      </xsd:sequence>
    </xsd:extension>
 </xsd:complexContent>
</xsd:complexType>
<xsd:complexType name="USAddressType">
<xsd:annotation>
   <xsd:appinfo source="X_Label_EN">US address format</xsd:appinfo>
   <xsd:appinfo source="X_Label_FR">format d'adresse US</xsd:appinfo>
   <xsd:appinfo source="X_Order_Value">1</xsd:appinfo>
</xsd:annotation>
<xsd:complexContent>
  <xsd:extension base="AddressType">
    <xsd:sequence maxOccurs="1" minOccurs="1">
    <xsd:element maxOccurs="1" minOccurs="1" name="ZipCode"   type="xsd:string"/>
    <xsd:element maxOccurs="1" minOccurs="1" name="State" type="xsd:string"/>
   </xsd:sequence>
  </xsd:extension>
 </xsd:complexContent>
</xsd:complexType>
...

In the above schema, you want to name the EUAddressType as EU address format and you want it to be the
second in the list of extended types. You want also to name the USAddressType as US address format and
you want it to be the first in the list of extended types.
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5. Save your modifications in the model editor.

When business users browse master data records in the updated data model through Talend MDM Web User
Interface, the list for the Address attribute shows the complex type labels you defined in the annotations and the
extended types are displayed in the order you defined as well.

23.2.2.2. How to use inheritance and polymorphism with entities

Consider as an example that your data model could contain the following entities: Company, Individual, Party and
Product. With Talend Studio, you can define inheritance types where Individual and Company both extend Party.
Party becomes a polymorphic element that holds individuals and companies.

You can also define in the Product entity a foreign key in the supplier attribute that points at the Party entity.
So, this foreign key can also point at Individual or Company since both extend Party, so it acts as a polymorphic
foreign key.

Prerequisite(s): You have already created your data model. For further information, see How to create a data
model.

To create inheritance and polymorphism for entities, proceed as follows:

1. In your data model, create the business entities Company, Individual and Party selecting the Complex type
and Sequence options. Create a Product business entity selecting the Complex type and All options. For
further information, see How to create business entities in the data model.

2. Expand Party and its group type, right-click subelement then select Edit Element from the contextual menu.

A dialog box displays.
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3. Change the name to code and set the minimum and maximum occurrences to 1 and then click OK to close
the dialog box.

4. Expand Company and its group type, and then change subelement to name. You will only need a name for
the company.

5. Double-click Companytype to open the [Complex Type Properties] dialog box.

6. From the complex type list, select PartyType and then click OK to close the dialog box.

This will add the PartyType as a group type below Company. Here, you have defined inheritance between
the Company and Party entities where Company extends Party.

7. Do the same to define inheritance between the Individual and Party entities where Individual extends Party.
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8. Define two attributes in the group type of the Individual entity: firstName and lastName. You will need these
two elements for an individual.

Your data model should look like the one shown below:

The Company and Individual entities extend the Party entity using the PartType group. All complex types
are also listed in the Data Model Types panel.

Now, you can create a polymorphic foreign key which, by pointing to the Party entity, can also point to the
Individual or Company entities, since both extend Party.

9. Create a supplier attribute in the Product entity.

Right-click supplier and select Set the Foreign Key from the list.

A dialog box displays.
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10. Click the three-dot button and browse to set an Xpath to the entity to which you want the foreign key to point.

11. Click Add and then OK to close the dialog boxes.

The foreign key path is listed below the supplier attribute.

You have achieved inheritance here at the entities level by adding the Party group type to the Company and
Individual entities.

Polymorphism is also achieved when, at runtime, the actual Party element can be expanded into Individual or
Company when a business user tries to create a data record through Talend MDM Web User Interface. Business
users will also have access to a foreign key list that displays Individualtype and CompanyType  when they click

the  icon. From this list they can choose any of the extended types you defined in Talend Studio.
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By default, the extended types list displays the code of the types, but Talend Studio also lets you define labels for
the extended types in order to display these labels in the Select a type list. You can also decide the order in which
you want to display these types. To do so, proceed as follows:

1. Open the data model where you have defined the complex types.

2. Click Schema Source at the bottom of the editor to open the source XML schema of the data model.

3. Browse to the schema corresponding to the extended complex type to which you want to add a label and
which you want to display in a certain order for the business user.
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4. Inside the root element of the complex type, use the X_Label_<ISO> annotation to add a label for the extended
type and the X_Order_Value annotation to define the order of the extended type, as follows:

...
<xsd:complexType name="IndividualType">
 <xsd:annotation>
  <xsd:appinfo source="X_Label_EN">individual supplier</xsd:appinfo>
    <xsd:appinfo source="X_Label_FR">fournisseur individuel</xsd:appinfo>
    <xsd:appinfo source="X_Order_Value">3</xsd:appinfo>
 </xsd:annotation>
  <xsd:complexContent>
...

In the above schema, you want to name the IndividualType as individual supplier and you want it to be the
third in the list of extended types.

5. Save your modifications in the model editor.

When business users browse master data records in the updated data model through Talend MDM Web User

Interface, the  icon gives them access to the extended type list that shows the labels you defined in the
annotation elements in the defined order.

23.2.3. Managing data models

An authorized user can also import/export, copy/paste and delete created data models from Talend Studio.

It is also possible to import and share MDM complete projects or only a data model or part of the data model from the
community web page, Talend Exchange. For further information, see Projects/objects on Talend Exchange.

23.2.3.1. How to export data models

From Talend Studio you can export one or multiple data models in order to exchange them between:

• two different MDM servers or repositories,

• two different Versions (deprecated) from the same/different MDM servers or repositories, for example.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one data model
exists.
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To export one or multiple data models:

1. In the MDM Repository tree view, right-click the Data Model node and select Export Items from the
contextual menu.

The [Export Repository items] dialog box appears and the Data Model check box is selected by default.

If you want to export all data objects in the repository and not only data models, click the Select All button to select
the check boxes of all data objects in the list.

2. To export the selected data models in a folder, select the Select root directory option and click the three-
dot button next to the option.

A dialog box appears.

3. Browse to where you want to save the data model and click OK to close the dialog box.

The path to the target folder is set in the field next to the selected option.

4. In the [Export items] dialog box, click Finish to validate your changes and close the dialog box.

A folder holding all data models in the current MDM Repository is created in the specified path. An XML
file that lists all exported elements is also created.
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5. To export the selected data models in a zip file, select the Select archive file option in the [Export Items]
dialog box and then click the three-dot button next to the option.

A dialog box appears.

6. Browse to where you want to save the data model archive file.

7. In the File Name field, enter a name for the archive file and then click Open to close the dialog box.

The path to the target archive file is set in the field next to the selected option.

8. In the [Export items] dialog box, click Finish to validate your changes and close the dialog box.

An archive file holding all data models in the current MDM Repository is created in the specified path. An
XML file that lists all exported elements is also created.

If you want to export only one data model of all those in the MDM Repository, expand Data Model in the [Export items]
dialog box and then select the check box next to the name of the data model you want to export and proceed as usual.

23.2.3.2. How to import data models

From Talend Studio you can import data models into the current MDM Repository that have been created in other
MDM Repositories or in different Versions (deprecated) of the current MDM Repository.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. You have exported one or
multiple data models from other MDM repositories.

To import one or multiple data models into the current MDM Repository:

1. In the MDM Repository tree view, right-click the Data Model node and select Import items from the
contextual menu.

The [Import Objects] dialog box displays.
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2. Select the root directory or archive file option according to whether the data models you want to import are
saved in a folder/archive file and then click the three-dot button next to the option.

A dialog box appears.

3. Browse to the folder/archive file holding the data models and click OK/Open to close the dialog box.

4. In the [Import Objects] dialog box, click Finish to validate your changes and close the dialog box.

All data models in the folder/archive file are exported and listed under the Data Model node in the current
Talend Studio.

If you want to import only one data model of all those saved in the folder/archive file, expand Data Model in the [Import
Objects] dialog box and then select the check box next to the name of the data model you want to import and proceed as usual.

23.2.3.3. How to edit a data model

You can open a data model you have already created to check its settings and/or edit any of the defined elements
(entities, attributes, annotations or reusable types) in order, for example, to adapt the data model to the specific
needs of an enterprise.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one data model
exists.

To edit a data model from the data model editor, do the following:
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1. In the MDM Repository tree view, expand the Data Model node.

2. Right-click the data model you want to edit and select Edit properties from the contextual menu.

The corresponding editor opens on the selected data model.

3. Double-click an element in the data model editor to open the corresponding dialog box.

4. Modify the element as needed and then click OK to close the dialog box.

5. Click the save icon on the toolbar or press Ctrl + S on your keyboard to save your changes.

The selected element is modified accordingly.

If you try to update a data model that has been modified by somebody else after you have retrieved it from the database, a
warning message displays to warn you that saving your modifications will overwrite the other user's changes.

You can also edit any element in the data model from the Properties view in the data model editor. For further
information, see How to use the Properties view in the data model editor.

23.2.3.4. How to copy/paste a data model

To avoid creating a data model from scratch, you can copy an existing one in the MDM Repository tree view
and modify its metadata to have a new data model.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one data model
exists.

To copy/paste a data model, do the following:

1. In the MDM Repository tree view, expand the Data Model node.

2. Right-click the data model you want to duplicate and select Copy from the contextual menu.

3. Right-click the Data Model node and select Paste from the contextual menu.

A dialog box displays prompting you to enter a name for the new data model.

4. Enter a name for the new data model and click OK to validate the changes and close the dialog box.

The new data model is listed under the Data Model node in the MDM Repository tree view.

23.2.3.5. How to duplicate a data model

To avoid creating a data model from scratch, you can duplicate an existing one in the MDM Repository tree view
and modify its metadata to have a new data model.
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Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one data model
exists.

To duplicate a data model, do the following:

1. In the MDM Repository tree view, expand the Data Model node.

2. Right-click the data model you want to duplicate and select Duplicate from the contextual menu.

A dialog box displays prompting you to enter a name for the new data model

3. Enter a name for the new data model and click OK to validate the changes and close the dialog box.

The new data model is listed under the Data Model node in the MDM Repository tree view.

You can also duplicate the data object if you drop it onto its parent node in the MDM Repository tree view.

23.2.3.6. How to delete a data model, a business entity or an
attribute

You can delete any of the data models, business entities or attributes you create through a simple right-click on
the selected item.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one data model,
business entity or attribute exists.

To delete a data model:

1. In the MDM Repository tree view, expand the Data Model node.

2. Right-click the data model you want to delete and select Delete from the contextual menu.

A confirmation dialog box displays prompting you to confirm the deletion operation or to cancel it.

3. Click OK to close the dialog box and delete the selected data model from the MDM Repository tree view.
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To delete a business entity or an attribute in a data model:

1. In the MDM Repository tree view, expand the Data Model node and double-click the data model from
which you want to delete a business entity or an attribute.

The corresponding editor opens on the selected data model.

2. Right-click the business entity or the attribute in the business entity you want to delete and select the delete
option relevant to your selection.

The selected business entity or attribute is deleted from the data model editor.

23.2.3.7. How to enable foreign key integrity checking

You can enable foreign key integrity checking to manage whether users are allowed to delete a record that is linked
to another record through a foreign key. By default, this is not allowed.

To enable foreign key integrity checking:

1. In the MDM Repository tree view, expand the Data Model node and double-click the data model for which
you want to enable foreign key integrity checking.

The corresponding editor opens with the selected data model displayed.

2. Select the entity containing the foreign key for which you want to enable integrity checking.

3. In the Properties view, click the Relationship tab.
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4. Under the Foreign Key section:

• Select the Enforce FK integrity check box to enable foreign key integrity checking, that is, to raise an error
whenever a user tries to delete a record if the record is linked to any other records through this foreign key.

• Select the Allow FK integrity override check box to allow users to force the delete of a record even if it
is linked to another record through this foreign key.

These two options can be combined in the following ways.

Enforce FK integrity enabled Enforce FK integrity disabled

Allow FK integrity override enabled Delete allowed, with user prompted for
override

Delete allowed

Allow FK integrity override disabled Delete forbidden Delete allowed

In the case of conflicts, the least tolerant rule is always applied.

If a user is prevented from deleting a record, details are provided in <jboss-dir>/server/default/log/server.log.

Handling circular dependencies

If you are using a SQL database to store your data records, you may encounter an error during initialization because
a circular dependency is detected. This means that, for example, EntityA references EntityB, EntityB references
EntityC, and EntityC references EntityA.

To fix the data model in such a case, simply turn off Foreign Key integrity checking for the relation, as described
in How to enable foreign key integrity checking.

23.2.3.8. How to check the validity of a Data Model

Whenever you make changes to your Data Model, Talend Studio can perform a series of checks to ensure that
the Data Model is valid. By default, these checks are performed when you save your Data Model and when you
deploy your Data Model, and can also be launched manually.

After checking the validity of a data model, Talend Studio also provides the impact analysis result if the data
model changes impact the database schema. For more information, see How to deal with the impact of data model
changes.

Items in the Data Model that are validated include:

• Entities (other than Reusable Types):

• Lookup fields

• Primary keys

• Primary key information

• Inheritance

• Fields (may occur in Entities or Reusable Types):

• Foreign keys
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• Foreign key information

The validation check reports both errors (issues which mean your Data Model is not valid) and warnings (issues
which do not affect the validity of your Data Model, but which may not provide the result you expect). This report
is shown in the MDM Problem View of the console.

How to launch a validation check manually

To launch a validation check manually, without saving any changes you may have made to your Data Model,
do the following:

1. In the MDM Repository tree view, expand Data Model, right-click the Data Model on which you want to
perform a validation check, and then click Validate.

2. In the [Validation Result Dialog] that opens, click the Details >> button for more information on any errors
or warnings that may be found.

How to identify the source of validation issues

When the Data Model validation check reports issues with your Data Model, it also helps you identify where these
issues occur so you can fix them.

To identify the source of validation issues, do the following.

1. In the MDM Problem View of the console, double-click the error or warning.

The Data Model opens on the Schema Source tab.

2. Click the red error marker in the right-hand scrollbar to jump directly to the point where the error or warning
has been identified, and perform any changes necessary to make the Data Model valid.

Note that you can also customize how the MDM Problem View displays errors and warnings in the console by

clicking the View Menu button , for instance to group them by type (error or warning).

How to configure the validation check

By default, the validation check is performed when you launch it manually, when you save any changes to your
Data Model, or when you deploy the Data Model to the server. You can configure this behavior in the preferences
for the Data Model validation check.

To configure the preferences for the Data Model validation check, do the following.

1. Click Window > Preferences.
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2. In the [Preferences] window that opens, expand Talend > MDM and then click Data Model Validation.

3. In the [Data Model Validation] preferences, select the situations in which you want a validation check to
be performed on your Data Model.

• User initiated validation: Users can launch a check manually.

• Validation on save: A check is performed when the user saves any changes to the Data Model.

• Validation on deploy: A check is performed when the user deploys the Data Model to the server.

If you choose to perform a validation when the user deploys the Data Model to the server, you can also specify
what happens if issues are found.

23.2.3.9. How to deal with the impact of data model changes

When designing a data model, you can make as many changes as required to the data model before you deploy
the modified data model to the MDM server to check if the changes make sense.

When you deploy the data model, Talend Studio will perform a series of checks to ensure the validity of the data
model. For more information, see How to check the validity of a Data Model.

After the validity checking of a data model, if the changes you made to the data model impact the database schema,
for example, adding new elements to one entity in the data model, Talend Studio provides the impact analysis
result when you deploy the modified data model to the MDM server which helps you to decide whether to cancel
the operation or continue the deployment.

The impact analysis result shows the relevant data model, the description of the changes made to the data model,
the level of each change and the operation to be performed.
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In this dialog box, you can view the data model changes and select the appropriate operation according to your
need.

Item Description

DataModel/Change It shows the relevant data model and the changes made to the data model.

Level There are three levels of data model changes:

• Low: The change will lead to the modification of the database schema, but it is perfectly OK.

• Medium: The change will be reflected in the database schema, but the existing data may cause
it to fail.

• High: The change cannot be reflected without recreating part of the database schema that
corresponds to the data model changes, and will result in a loss of data.

Operation Three options are available:

• Recreate table: recreate the table to reflect the changes made to the data model. This option
is available only if the change level is Medium or High.

• Apply changes: apply the changes to the data model. By default, this option is selected.

• Cancel deployment: cancel the deployment of the modified data model.

Click OK to validate your changes and close the dialog box.
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23.3. Data Containers
Talend Studio allows you to persist master data in one or several containers within a single MDM Hub. Data
containers are then "partitioned" to help you organize the master data, typically by domains.

A data container in the MDM Hub can hold data from multiple entities. An entity in a data container is not visible
from another data container.

You can create, import/export, edit, copy/paste, duplicate and delete data containers.

The following sections detail the procedural steps to carry out each of the above management options.

23.3.1. Creating a data container

From Talend Studio you can create one or several data containers in the MDM Hub in which you can manage data
records directly or you can load data using the tMDMInput and tMDMOutput components.

For more information about how to manage data records in a data container, see Managing records in a data
container.

For more information on the MDM components, see Talend Open Studio Components Reference Guide.

Later, a business user can write/edit data in the created container using Talend MDM Web User Interface. For
more information, see Talend MDM Web User Interface User Guide.

Prerequisite(s): You have already connected to the MDM server from Talend Studio.

To create a data container, do the following:

1. In the MDM Repository tree view, right-click Data Container and select New from the contextual menu.

The [New Data Container] dialog box appears.

2. Enter a name for the new data container. Make sure the name contains valid characters and does not already
exist.

3. Click OK to close the dialog box.

The newly created data container is listed under the Data Container node in the MDM Repository tree view.

In order to populate the data container with your data, you can use the Integration perspective in the Studio to design a Job
using Talend MDM components. For further information on the MDM components, see Talend Open Studio Components
Reference Guide. For an MDM Demo example, see http://talendforge.org/wiki/doku.php?id=mdmce:demo.

http://talendforge.org/wiki/doku.php?id=mdmce:demo
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23.3.2. Managing records in a data container

From Talend Studio, you are allowed to add, edit or delete data records directly in a data container.

23.3.2.1. How to create a new record in a data container

In a data container, you can create as many new data records as needed for one or more entities.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. A data container exists and
is defined with at least one entity.

To create a new data record from a data container, do the following:

1. In the MDM Repository tree view, expand the Data Container node.

2. Double-click the data container in which you want to create a new data record.

3. A dialog box opens, asking you to select an appropriate MDM server.

Once you have made your choice, click OK to close the dialog box.

4. Right-click the lower part of the data container browser, and then click New Record.

5. An [XML Editor/Viewer] dialog box opens, allowing you to add a new data record with an XML editor.

After the editing is done, you can click the Tree tab to check the data record in a tree view.
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6. If needed, select the Fire a change event (update report) and triggers check box so that the newly created
record will be written into the UpdateReport and eligible Triggers will be executed directly.

After selecting the Fire a change event (update report) and triggers check box, if required, select the
Enable verification by before processes check box to enable the verification of the newly created record
by the Before Saving processes. For more information about Process types, see Process types.

7. Select an appropriate data model from the Data Model list.

8. Click Save to validate your changes.

The newly added data record will be displayed in the lower part of the data container browser.

23.3.2.2. How to edit a record in a data container

In a data container, you can edit an existing data record according to your need.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. A data container exists and
is populated with some data records.

To edit an existing data record in a data container, do the following:

1. Follow the steps outlined in How to browse a data container to search for the data records of interest.

2. Right-click the data record you want to edit, and then click Edit Record.
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3. An [XML Editor/Viewer] dialog box opens, allowing you to modify the data record according to your need.
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4. If needed, select the Fire a change event (update report) and triggers check box so that the modified record
will be written into the UpdateReport and eligible Triggers will be executed directly.

After selecting the Fire a change event (update report) and triggers check box, if required, select the
Enable verification by before processes check box to enable the verification of the modified record by the
Before Saving processes. For more information about Process types, see Process types.

5. Click Save to validate your changes.

23.3.2.3. How to delete a record in a data container

In a data container, you can choose to delete a data record permanently or only remove it from the data record list.

You can delete only one record at a time or delete multiple records together in one go.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. A data container exists and
is populated with some data records.

To delete a record permanently, do the following:

1. Follow the steps outlined in How to browse a data container to search for the data records of interest.

2. Right-click the record you want to delete permanently, and then click Physically delete the selected record.

3. A dialog box pops up, asking you to confirm the deletion.

If needed, select the Fire Delete Event check box so that a delete event will be generated and written into
UpdateReport. Next, in the Source Name field, define a name for the source which generates the delete
event. You can also select the Invoke before deleting process check box to enable the verification of the
delete event by a Before Deleting process.
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4. Click OK to validate your changes and confirm the deletion.

The data record will be removed from the list of data records and be deleted permanently.

To remove a data record from the data record list, do the following:

1. Right-click the record you want to remove from the data record list, and then click Logically delete the
selected record.

2. A dialog box pops up, asking you to confirm the deletion.

In the Set Part-Path field, give a path within the recycle bin, where the removed data record will be stored
temporarily.

From the recycle bin, you can permanently delete data records or restore them to the data container they were
deleted from. For more information about how to recover a deleted data record, see the related section in
Talend MDM Web User Interface User Guide.

Currently, "/" is the default and only option for the Set Part-Path field.
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If needed, select the Fire Delete Event check box so that a delete event will be generated and written into
UpdateReport. Next, in the Source Name field, define a name for the source which generates the delete
event. You can also select the Invoke before deleting process check box to enable the verification of the
delete event by a Before Deleting process.

3. Click OK to validate your changes and confirm the deletion.

The data record will be removed from the list of data records and can be restored from the recycle bin later.

23.3.3. Managing the values of auto increments in the
data container browser

When designing a data model entity in Talend Studio, you can add one or more elements as auto increments, whose
values will be incremented by 1 automatically each time you create a new data record related to the given data
model entity. For more information about how to create a data model, see How to create a data model.

To define an element as an auto increment in the data model editor, firstly change it to be of Simple Type and
then select AUTO_INCREMENT from the custom simple types.

You can review and edit the values of auto increments related to a given data model in the data container browser.

To manage the values of auto increments, do the following:

1. In the MDM Repository tree view, expand the Data Container node.

2. Double-click the data container that holds one or more entities with auto increments.

3. Click the  button on the menu bar.

4. The [Manage AutoIncrement] dialog box opens, showing the current values of auto increments for each
entity.

Click the Value field and enter a new value in the row of the entity for which you want to redefine the starting
value of its auto increment.
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5. If needed, select one specific entity and click the Reset button to reset the starting value of its auto increment
to be 0 or click the Reset All button to reset the starting value of all auto increments to be 0.

6. Click OK to validate your changes.

23.3.4.  Managing data containers
An authorized user can also import/export, copy/paste and delete created data containers from Talend Studio.

It is also possible to import and share MDM complete projects or only a data model or part of the data model from the
community web page, Talend Exchange. For further information, see Projects/objects on Talend Exchange.

23.3.4.1. How to browse a data container

Using Talend Studio, you can easily search and locate data records "attached" to the corresponding business entities
in the MDM Hub.

More than one search option is available to specify the search criteria and to narrow down your search for the data
records you want to view. You can:

• use a time-based filter (from/to dates),

• select a business entity in which to search data records,

• type in the unique key for the business entity you want to search for,

• type in a search keyword.

Prerequisite(s): You have already connected to the MDM server in Talend Studio. A data container exists and
is populated with data records.

To browse a data container:

1. In the MDM Repository tree view, expand the Data Container node.
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2. Double-click the data container you want to browse.

The data container editor opens with a master data container view.

You can set one or several search criteria to narrow your search on the returned data records. Note that, if
you are using a SQL database, you cannot combine a full-text query with other search criteria.

3. Click the From arrow to display a calendar where you can select a start date for the data records created in
the selected data container.

4. Click the To arrow to display a calendar where you can select an end date for the data records created in
the selected data container.

It is possible to click the browse button directly after setting the time range to base your search only on one criterion.
Otherwise, you can use one or more of the other search criteria to narrow down your search on the returned data records.

5. From the Entity list, select a business entity from the list to search data records only in the selected business
entity.

6. In the Keys field, enter the unique key for the entity you want to search.

7. In the Keywords field, enter a search keyword to include only matching values in the returned data records.

8.
Click the  icon.

The lower part of the editor lists all data records that match the search criteria along with their creation dates,
the business entities they are created in and their unique keys.

9. Double-click a given record to open up a dialog box that displays the data record details.

You can also click the Source tab at the top of the dialog box to view the data record in its XML format
or modify the data record.

After updating the data record, if needed, select the Fire a change event (update report) and triggers check
box so that the modified record will be written into the UpdateReport and eligible Triggers will be executed
directly.

After selecting the Fire a change event (update report) and triggers check box, if required, select the
Enable verification by before processes check box to enable the verification of the modified record by the
Before Saving processes. For more information about Process types, see Process types.
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23.3.4.2. How to export data containers

From Talend Studio you can export one or multiple data containers in order to exchange them between:

• two different MDM Servers or Repositories,

• two different Versions (deprecated) from the same/different MDM Servers or Repositories, for example.

The steps to export one or multiple data containers are similar to those for any other data object in the MDM
Repository tree view. For detailed information on how to export data containers, see How to export data models.

23.3.4.3. How to import data containers

From Talend Studio you can import data containers created on other MDM servers, in different Versions
(deprecated) on the same MDM server, or in different MDM Repositories in the current MDM Repository.

The steps to import one or multiple data containers are similar to those for any other data object in the MDM
Repository tree view. For detailed information on how to import data containers, see How to import data models.

23.3.4.4. How to copy/paste a data container

To avoid creating one or multiple data containers from scratch, you can copy an existing one in the MDM
Repository tree view and decide what business entities to copy from the source data container onto the target
data container.
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Prerequisite(s): You have already connected to the MDM server in Talend Studio. At least one data container
exists.

To copy/paste a data container, do the following:

1. In the MDM Repository tree view, expand the Data Container node.

2. Right-click the container you want to duplicate and select Copy from the contextual menu.

3. Right-click the Data Container node and select Paste from the contextual menu.

A dialog box displays prompting you to enter a name for the new container.

4. Enter a name for the new data container and click OK to validate the changes and close the dialog box.

A dialog box displays. This dialog box list all the business entities held in the source data container.

5. Select the business entities you want to copy in the new data container and then click OK.

The new data container that holds the selected business entities is listed under the Data Container node in
the MDM Repository tree view.

23.3.4.5. How to duplicate a data container

To avoid creating one or multiple data containers from scratch, you can duplicate an existing one in the MDM
Repository tree view and decide what business entities to copy from the source data container onto the target
data container.

Prerequisite(s): You have already connected to the MDM server in Talend Studio. At least one data container
exists.

To duplicate a data container, do the following:

1. In the MDM Repository tree view, expand the Data Container node.

2. Right-click the container you want to duplicate and select Duplicate from the contextual menu.

A dialog box displays prompting you to enter a name for the new container.
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3. Enter a name for the new data container and click OK to validate the changes and close the dialog box.

A dialog box displays. This dialog box list all the business entities held in the source data container.

4. Select the business entities you want to copy in the new data container and then click OK.

The new data container that holds the selected business entities is listed under the Data Container node in
the MDM Repository tree view.

You can also duplicate the data object if you drop it onto its parent node in the MDM Repository tree view.

23.3.4.6. How to delete a data container

You can delete a data container you create through a simple right-click on the selected data container.

Prerequisite(s): You have already connected to the MDM server in Talend Studio. At least one data container
exists.

To delete a data container:

1. In the MDM Repository tree view, expand the Data Container node.

2. Right-click the data container you want to delete and select Delete from the contextual menu.

A confirmation dialog box displays prompting you to confirm the deletion operation or to cancel it.
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3. Click OK to close the dialog box and delete the selected data container from the MDM Repository tree view.

23.4. Views
A View is one of the possible ways to query the MDM Hub. When you create Views in Talend Studio, you specify:

• What business entities are viewable/searchable for an authorized business user,

• What elements a business user can view/search in the business entities.

• What elements of the business entities can be returned by the query.

• What content can be returned by the query. The data can be filtered on its content before being delivered by the
View (for example, all companies which have their Head Office in France).

23.4.1. Creating a View

From Talend Studio you can easily create simple views over the same business entity or composite Views over
multiple business entities held in the same data model.

You can also create multiple simple Views over the same business entity to allow users to have different predefined accesses
on the records by defining different search criteria in each View. The # character is used to create multiple views on
the same entity; for example two views on the Agency entity may have the following names: Browse_items_Agency and
Browse_items_Agencynt#UK where the second View will give access only to agencies based in the United Kingdom.

Note also that, for improved readability, in the MDM Repository view, Views are stored in subfolders by type and only the
second part of the name is displayed.

Creating a simple View on a business entity allows a business user inside Talend MDM Web User Interface to
visualize specific elements in this entity according to the defined criteria. For more information on how to view/
search elements in a specific business entity, see the Talend MDM Web User Interface User Guide.

Creating a composite View on several business entities allows a business user inside Talend MDM Web User
Interface to visualize specific elements in multiple entities according to a join clause. A composite View can
provide greater insight on master data than a simple View. For more information, see Talend MDM Web User
Interface User Guide.

It is also possible to attach a Process to the View in order to transform/enrich data, on the fly, by looking up fields in the
source system. For further information, see Running the view result through a Process (registry style lookup).

The sections below explain how to create each of these two types of Views.

23.4.1.1. How to create a simple View

Prerequisite(s): You have already connected to the MDM server from Talend Studio.

To create a simple View, do the following:

1. In the MDM Repository tree view, right-click View and select New from the contextual menu.

The [New View] dialog box displays.
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As the simple View is concerned with only one specific entity, its name must follow a specific pattern that includes
the name of the entity: Browse_items_<name of the business entity>. The dialog box displays with the by-default text
Browse_items. However, you can use the # character to create multiple views on the same entity; for example two
views on the Agency entity may have the following names: Browse_items_Agency and Browse_items_Agencynt#UK
where the second View will give access only to agencies based in the United Kingdom.

Note also that, for improved readability, in the MDM Repository view, Views are stored in subfolders by type and
only the second part of the name is displayed.

2. Enter a name for the new View and then click OK to close the dialog box.

3. Click the three-dot button to open a dialog box where you can select the entity for which you want to create
a View and then click OK to close the dialog box.

An editor for the newly created View opens in the workspace.

You can automate the above steps to create a default View. Select one or more entities in the data model, right-click the
selection and then click Generate Default Browse Items Views. This creates a default View which is listed under the
View node in the MDM Repository tree view. By default, the Viewable Business Elements and Searchable Business
Elements areas in the default View are populated with the top five elements.

You can then proceed as below in order to define the View criteria.
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4. Click the three-dot button next to Description to open a dialog box where you can add multilingual labels
to the new View.
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5. From the list to the left, select a language and enter the corresponding label in the field to the right.

Click the  button to add the description to the Language/Label list.

Repeat the operation to add as many labels as needed and click OK to close the dialog box.

All defined labels display in the Description field.

6. If required, select the Run the view result through a Process check box and then select from the list the
Process you want to attach to the current View. The Process will be used to transform/enrich data, on the
fly, by looking up fields in the source system.For further information, see Running the view result through
a Process (registry style lookup).

7.
In the Viewable Business Elements area, click the  button to add a new XPath line to the table.
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8. In the new XPath line, click the three-dot button to open a dialog box.

By default, only the selected entity of all the entities that constitute the data model will be listed in the dialog
box and its name will display in the Filter field.

You can list multiple entities in the dialog box if you type in the Filter field the text according to which you want to
filter business entities. This is a search-as-you-type filter where entities are instantly filtered as you type your search
string.

9. Select the element to be retrieved by the View and repeat the procedure to add as many elements as needed.

You can also retrieve the foreign key information and display it to the business user in the [Browse Records] page in
Talend MDM Web User Interface. For further information, see How to create a simple View that displays the foreign
key information.

10.
In the Searchable Business Elements area, click the  button to add a new XPath line to the table.

11. In the new XPath line, click the three-dot button to open a dialog box where you can select the element to
be located.

By default, only the selected entity of all the entities that constitute the data model will be listed in the dialog
box and its name will display in the Filter field.

You can list multiple entities in the dialog box if you type in the Filter field the text according to which you want to
filter business entities. This is a search-as-you-type filter where entities are instantly filtered as you type your search
string.

12.
In the Where Conditions area, click the  button to add a new XPath line to the table.

13. In the new XPath line, click the three-dot button to open a dialog box where you can select the element you
want to define conditions on.

You can list multiple entities in the dialog box if you type in the Filter field the text according to which you want to
filter business entities. This is a search-as-you-type filter where entities are instantly filtered as you type your search
string.



Creating a View

Talend Open Studio for MDM User Guide 831

You can define conditions with various operators listed in the Operator column. You can also join elements using
different operators listed in the Predicate column.

14. In the Value field, you can enter a string directly, or select an Entity element.

15. Click the save icon on the toolbar or press Ctrl + S on your keyboard to save your changes.

The newly created View is listed under the View node in the MDM Repository tree view.

Using Talend MDM Web User Interface, an authorized business user can now visualize specific records in this
entity according to the defined criteria. For more information on how to view/search elements in a specific business
entity, see the Talend MDM Web User Interface User Guide.

You can use the  and  icons in the view editor to copy/paste items among Viewable Business Elements,
Searchable Business Elements and Where Conditions tables.

23.4.1.2. How to create a simple View that displays the foreign
key information

The simple views you create on business entities in Talend Studio enables business users using Talend MDM Web
User Interface to visualize specific records/attributes in this entity according to the defined criteria.

Prerequisite(s): You have already connected to the MDM server from Talend Studio.

Consider as an example that your data model holds the Agency and Agent entities. You have added a foreign key
attribute, AgencyFK, in the Agent entity that points to the Agency entity. This attribute will link every agent to an
agency. For further information, see How to add a foreign key: linking entities together.

To create a simple View that displays the foreign key information, do the following:

1. Follow the steps outlined in How to create a simple View to create a simple view on the Agent entity.
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2.
In the Viewable Business Elements table, click the  button to add a new XPath line.

3. In the new XPath line, click the three-dot button to open a dialog box.
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4. Select the foreign key element to be retrieved by the View, AgencyFK in this example.

5. Click the save icon on the toolbar or press Ctrl + S on your keyboard to save your View.

The newly created View is listed under the View node in the MDM Repository tree view.

Using Talend MDM Web User Interface, an authorized business user can now visualize the agent records with all
the elements you defined in the View including the agency to which each agent is attached.

For more information on how to view/search elements in a specific business entity, see Talend MDM Web User
Interface User Guide.

23.4.1.3. How to create a composite View

Prerequisite(s): You have already connected to the MDM server from Talend Studio.

To create a composite View, do the following:

1. In the MDM Repository tree view, right-click View and select New from the contextual menu.

The [New View] dialog box displays.
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As the composite View is not concerned with only one specific entity, its name does not have to follow a specific
pattern as it is the case with the simple View name.

2. Enter a name for the new View and then click OK to close the dialog box, AgentAgency in this example.

An editor for the newly created View opens in the workspace.

3. Click the three-dot button next to Description to open a dialog box where you can add multilingual labels
to the new View.



Creating a View

Talend Open Studio for MDM User Guide 835

4. From the list to the left, select a language and enter the corresponding label in the field to the right.

Click the  button to add the description to the Language/Label list.

Repeat the operation to add as many labels as needed and click OK to close the dialog box.

All defined labels display in the Description field.

5.
In the Viewable Business Elements area, click the  button to add a new XPath line to the table.

6. In the new XPath line, click the three-dot button to open a dialog box.

From the Data Models list, select the data model holding the entities on which you want to create the
composite View.

All entities constituting the model are listed in the dialog box.

You can filter the entities you want to display in the dialog box if you type in the Filter field the text according to
which you want to filter business entities. This is a search-as-you-type filter where entities are instantly filtered as
you type your search string.

7. Select the entities/element to be retrieved by the View being defined.
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8. Consider as an example that your data model has the two entities: Agency and Agent. You want to create a
composite View that joins elements in both entities to show multiple data records for the same agent if he/
she is attached to multiple agencies.

In the Searchable Business Elements area, click the  button to add a new XPath line to the table.

9. In the new XPath line, click the three-dot button to open a dialog box where you can select the entities or
elements to be located.

You can filter the entities you want to display in the dialog box if you type in the Filter field the text according to
which you want to filter business entities. This is a search-as-you-type filter where entities are instantly filtered as
you type your search string.

10.
In the Where Conditions area, click the  button to add a new XPath line to the table.

In the new XPath line, click the three-dot button to open a dialog box where you can select the entities/
elements on which you want to define a join condition.

You can filter the entities you want to display in the dialog box if you type in the Filter field the text according to
which you want to filter business entities. This is a search-as-you-type filter where entities are instantly filtered as
you type your search string.
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You must use the "Join With" operator when creating a composite View in order to specify the join in the WHERE
clause. Usually, you join on elements keys. If there are more than one keys to join on, you must repeat a "Joins With"
clause for each part of the key. For instance, suppose the AgencyFK is a compound key that comprises Id and Date,
you must define two conditions in the "Where Condition" table: "Agent/AgencyFK --> Joins With --> Agency/Id" and
"Agent/AgencyFK --> Joins With --> Agency/Date".

The WHERE clause used in this example will generate multiple data records for the same agent linked with
different agencies.

11. Click the save icon on the toolbar or press Ctrl + S on your keyboard to save your changes.

The newly created View is listed under the View node in the MDM Repository tree view.

Using Talend MDM Web User Interface, an authorized business user can now visualize the records in the two
specified entities according to the defined join clause. For more information, see the Talend MDM Web User
Interface User Guide.

You can attach a Process to the View in order to transform/enrich data, on the fly, by looking up fields in the source system.
For further information, see Running the view result through a Process (registry style lookup).

23.4.2. Running the view result through a Process
(registry style lookup)

Talend Studio enables you to enrich data, on the fly, by looking up fields in the source system through a Process
attached to the View, whether it is a simple or a composite View. Using Processes with Views will help optimizing
system performance.

or example, when an interaction is done on a business entity that is not persisted or not totally persisted in the
MDM Hub, the MDM Hub will be able to resolve specific elements for this entity by referring to the source system.
You can achieve this behavior if you:

• indicate what elements in the business entity or entities are to be transformed or enriched by the Process,

• create the corresponding Process,

• create a View on the viewable/searchable elements in the business entity and attach the Process to this View
that will run the view result.

When a steward or a business user connects to Talend MDM Web User Interface and browse the records/Views
of the business entity/entities, the Process will lookup the defined elements (values) from the source system and
display them in the web user interface without really saving them in the MDM Hub.

23.4.2.1. How to define the elements to be transformed/enriched
by a Process

Consider as an example that you want in your data model to retrieve the agency region, on the fly, from the source
system without really saving the region in the MDM Hub.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. A data model has been
already created.

To define the entity elements to be transformed/enriched by a Process, do the following:

1. In the MDM Repository tree view, expand the Data Model node and double-click the data model in which
you want to define the elements to be handled by the Process.
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In this example, you want to set a lookup field on the Agency entity in order for a corresponding Process to
retrieve the agency region from the source system.

2. In the Data Model Entities panel, right-click the entity from which you want to select the element(s) to be
handled by the Process.

A contextual menu displays.

3. Select Set Lookup Field.

The [Set Lookup Fields] dialog box displays.

4. Click the arrow and select from the list one of the elements pertaining to the selected entity.

5.
Click the  icon in the upper right corner to add the selected element to the Lookup Fields list.

6. Do the same to add as many elements as necessary to the Lookup Fields list.

Only listed elements will be transformed/enriched on the fly by the Process. If this Process modifies anything else in
the XML record, these modifications will be ignored at the entity level because the Process will send only the specified
elements and not all the XML record.

7. Click OK to close the dialog box.

The defined look up field(s) display(s) under the Annotations node corresponding to the entity selected in
the Data Model Entities panel.

23.4.2.2. How to create a Process to enrich data on the fly

The Process used to run a View results can have a number of steps and plug-ins including CallJob. The Process
will map MDM to the source system and then retrieve data from the source system to complete the record. For
further information on Process types, plug-ins and the procedure to create a Process, see Processes.
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When a steward or a business user connects to Talend MDM Web User Interface and browse the records/views
of the business entity/entities, the Process will lookup the defined elements (values) from the source system and
display them in the web user interface without really saving them in the MDM Hub.

Prerequisite(s): You have already connected to the MDM server from Talend Studio.

Follow the steps outlined in How to create a Process from scratch to create a normal Process and call it
LookupLocation, for example.

1. Add a step name in the Step Description field and click the plus button to add it to the Steps Sequence list.

2. Click the step name to display the Step Specifications area. Here you can define the step parameters.

3. Set the Process input variable name to _DEFAULT_.

The default input value is a text, its format is as the following <cluster name>.<concept name>.<ids>,
you can use it to do the cross referencing in your customized Job.

4. From the Plugin name list, select callJob.

This Process invokes a Job, DetermineRegion, to connect to the source system that holds the data you need,
the agency region in this example, and then retrieves this data to complete the Region field in the data record
in Talend MDM Web User Interface.

5. Set the Process output variable to output.

6. In the Parameter area, enter the parameters for the calljob plug-in as the following:
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<configuration>
               <url>http://localhost:8180/DetermineRegion-0.1/services/
DetermineRegion</url>
   <contextParam>
        <name>xmlRecord</name>
        <value>{_DEFAULT_}</value>
   </contextParam>
   <conceptMapping>
        <concept>Agency</concept>
        <fields>{p1:Region}</fields>
   </conceptMapping>

</configuration>

7. Click the save icon on the toolbar or press Ctrl + S on your keyboard to save the Process.

The newly created Process is listed under the Process node in the MDM Repository tree view.

23.4.2.3. How to run the view results through a process

Prerequisite(s): You have already connected to the MDM server from Talend Studio. A Process corresponding
to your needs has already been created.

To run the view results through a Process, do the following:

1. Follow the steps outlined in Creating a View to create a View on the corresponding data model.

2. Select the Run the view results through a process to make the Process list available.
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3. Click the arrow and select from the list the Process you want to attach to the current View, LookupLocation
in this example.

4. Click the save icon on the toolbar or press Ctrl + S on your keyboard to save the View.

Now every time the business user or data steward browses the data records through this view from Talend MDM
Web User Interface, the Region field will display the value retrieved by the Process from the source system without
really saving it in the MDM Hub. For further information on how to browse data records, see Talend MDM Web
User Interface User Guide.

23.4.3.  Managing Views

An authorized user can carry out many management options on simple or composite Views from Talend Studio.

It is also possible to import and share MDM complete projects or only a data model or part of the data model from the
community web page, Talend Exchange. For further information, see Projects/objects on Talend Exchange.

The sections below explain all available management options for simple and composite Views.

23.4.3.1. How to edit a View

You can open a View you have already created to check its settings and/or edit the defined parameters.

Prerequisite(s): You have already connected to the MDM server in Talend Studio. At least one View exists.

To edit a View:

1. In the MDM Repository tree view, expand the View node.

2. Right-click the View you want to edit and select Edit from the contextual menu.

An editor on the selected View opens in the workspace.

3. Modify the view parameters as needed and then click the save icon on the toolbar or press Ctrl + S on your
keyboard to save your changes.

The selected View is modified accordingly.

If you try to update a View that has been modified by somebody else after you have retrieved it from the database, a warning
message displays to warn you that saving your modifications will overwrite the other user's changes.

23.4.3.2. How to test Views

From Talend Studio, you can execute a View to see if it works as expected.

Prerequisite(s): You have already connected to the MDM server. At least one View exists and the View to be
tested has already been deployed to the MDM server.

To test a View, proceed as follows:

1. In the MDM Repository tree view, expand the View node, click the Web Filter folder and then double-click
the View you want to execute to open the corresponding editor.
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2. Click the  icon at the top of the View editor.

A new tab opens with a Characteristics area which shows the details of the View and a Search and results
area which allows you to define the search criteria and check the search results.

3. In the Search and results area, select a container that holds the data of the business entity you want to access.
In this example, select Product.

4. If needed, select one option from the Search on list to narrow down your search for the data records you
want to view. In this example, select ProductFamily/Name.
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5. Enter a value you want to search in the field next to the Search on list. In this example, enter p.

6. Click the Search button.

The data records which match the search criteria will be listed. In this example, all product family records
whose name contains the character "p" are displayed.

You can double-click one item to open the [XML Viewer] dialog box which displays the record in a tree
view and allows you to check the source of the data record.

7. Access Talend MDM Web User Interface and verify that all data records which match the search criteria
are returned.

23.4.3.3. How to import Views

From Talend Studio you can import Views into the current MDM Repository that have been created on other
MDM Repositories or on different Versions (deprecated) of the current MDM Repository.

The steps to import one or multiple Views are similar to those for any other data object in the MDM Repository
tree view. For detailed information on how to import data containers, see How to import data models.

23.4.3.4. How to export Views

From Talend Studio you can export one or multiple Views in order to exchange them between:

• two different MDM Servers or Repositories,

• two different Versions (deprecated) from the same/different MDM Servers or Repositories, for example.

The steps to export one or multiple Views are similar to those for any other data object in the MDM Repository
tree view. For detailed information on how to export data containers, see How to export data models.

23.4.3.5. How to copy/paste a View

To avoid creating one or multiple Views from scratch, you can copy an existing one in the MDM Repository tree
view and modify its parameters to have a new View.

Prerequisite(s): You have already connected to the MDM server in Talend Studio. At least one View exists.

To copy/paste a View, do the following:

1. In the MDM Repository tree view, expand the Views node.
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2. Right-click the View you want to duplicate and select Copy from the contextual menu.

3. Right-click the View node and select Paste from the contextual menu.

A dialog box displays prompting you to enter a name for the new View.

4. Enter a name for the new View and click OK to validate the changes and close the dialog box.

The new View is listed under the View node in the MDM Repository tree view.

23.4.3.6. How to duplicate a View

To avoid creating one or multiple Views from scratch, you can duplicate an existing one in the MDM Repository
tree view and modify its parameters to have a new View.

Prerequisite(s): You have already connected to the MDM server in Talend Studio. At least one View exists.

To duplicate a View, do the following:

1. In the MDM Repositorytree view, expand the Views node.

2. Right-click the View you want to duplicate and select Duplicate from the contextual menu.

A dialog box displays prompting you to enter a name for the new View

3. Enter a name for the new View and click OK to validate the changes and close the dialog box.

The new View is listed under the View node in the MDM Repository tree view.

You can also duplicate the data object if you drop it onto its parent node in the MDM Repository tree view.

23.4.3.7. How to delete a View

You can delete any of the Views you create through a simple right-click on the selected item.
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Prerequisite(s): You have already connected to the MDM server in Talend Studio. At least one View exists.

To delete a View:

1. In the MDM Repository tree view, expand the View node.

2. Right-click the View you want to delete and select Delete from the contextual menu.

A confirmation dialog box displays prompting you to confirm the deletion operation or to cancel it.

3. Click OK to close the dialog box.

The selected View is deleted from the MDM Repository tree view.

23.5. Event management
Event management and real-time integration are an important part of Master Data Management. Talend MDM
provides both functionalities with dedicated MDM objects as follows:

• The Event Manager in Talend Studio "listens" continuously for "events" that happen on the MDM Hub,

• An event happens when some data is modified, added or deleted in the MDM Hub,

• Talend MDM captures the event with an Update Report that gather the event audit log information,

• A Trigger is used to launch a Process when an event corresponds to this Trigger execution conditions,

• A Process, which is an action that usually executes a Talend Job, is launched by the Trigger.

Any event in the MDM Hub generates in Talend Studio an Update Report which gathers the event audit log
information. This information includes the type of action (create, delete, update), the user who performed the
action, source of action (Job, Talend MDM Web User Interface, etc.), modified attributes with old and new values
and finally timestamp of action. The Update Reports are stored in Talend MDM as an XML document like any
other master data but with a pre-defined, static data model.

To access these Update Reports, do the following:

1. In the MDM Repository tree view, expand Data Container - System and then double-click UpdateReport.

A dialog box displays.
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2.
Set parameters to filter the Update Reports you want to display, if required, and then click the  icon to
display a list of the events done on master data in the MDM Hub.

3. Double-click any of these event to display a dialog box. Here you can see a detail audit log information about
the selected event.

4. If required, click Source to display the log information in an XML document.

The following sections give a detailed explanation about the Processes and Triggers involved in the event
management mechanism.

23.5.1. Processes

A Process defines multiple steps to achieve a data validation or human validation process, a transformation process,
an enrichment process, a data integration process, and so on. Each step of a Process can use a plug-in, which is
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a mechanism to add specific capabilities to the process to perform a single task. The list of available plug-ins is
extensible by J2EE developers. The steps defined in each Process and the plug-ins used will differ according to
the task you want to accomplish.

One of the plug-ins available in any Talend MDM platform is the callJob plug-in, which invokes a Talend Job
exposed as a Web Service. For further information on Process types and associated plug-ins, see Process types
and Important plug-ins.

Parameters to set when you define a Process include:

• Process name,

• Process description,

• sequence of steps: the list of all plug-ins included in the Process to be executed, one after the other,

• step specifications: a Process plug-in consumes data in input parameters and produces a result in the output
parameters. You must define variables to hold the result of a step. Then you send the variable to the input of
the next step, and so forth. Eventually, you define a "pipeline" where each step result is chained to the next
step through a variable.

A plug-in may have multiple input variables and parameters, as well as multiple output variables and parameters.

When you design a Process, you combine specific Process plug-ins in a sequence of steps, which are executed
one after the other to perform specific tasks.

For each step, do the following:

1. Choose the appropriate plug-in.

2. Enter or select an input variable and an input parameter.

3. Select the output parameter and select or enter the output variable.

It is possible to disable one or more steps at any time if you select the Disable check box in the Step Specification area
for the selected step.

For a step-by-step procedure on creating a Process, see How to create a Process from scratch.

23.5.1.1. Process types

When creating a new Process from Talend Studio, you can select one of the proposed Process types: Before
Saving/Deleting, Entity/Welcome Action, Smart View, or other.

The table below describes the different Process types:

Process type Description Associated plug-in

Other Any type other than the listed ones. This process is usually executed after
an event occurs on master data in the MDM Hub.

Any in the list of available plug-
ins.

Before Saving A Process that validates master data according to certain conditions
before saving it in the MDM Hub. This Process can be linked with a
Job designed in the Integration perspective to perform the validation
operation automatically.

This Process can alter the MDM record before it is committed in the
database. For instance, a Job may be run that completes the record with
calculations and/or enrichments.

The naming of this Process follows a specific pattern:
beforeSaving_<entity>.

Note also that, for improved readability, in the MDM
Repository view, Processes are stored in subfolders by type and
only the second part of the name is displayed.

Any in the list of available plug-
ins. If this Process is linked with
a Talend Job, it uses the callJob
plug-in. This plug-in executes
a call to the Job created in
the Integration perspective to
evaluate the data to be saved
and returns an error message
if validation of this data is
necessary.

For further information, see
How to set schema for a Before
Saving/Deleting Job.
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Process type Description Associated plug-in

Before Deleting A Process that evaluates master data according to certain conditions
before deleting it from the MDM Hub. This Process can be linked with
a Job designed in the Integration perspective to perform the operation
automatically.

The naming of this Process follows a specific pattern:
beforedeleting_<object name>.

Note also that, for improved readability, in the MDM
Repository view, Processes are stored in subfolders by type and
only the second part of the name is displayed.

Any in the list of available plug-
ins. If this Process is linked with
a Talend Job, it uses the callJob
plug-in. This plug-in executes
a call to the Job created in
the Integration perspective to
evaluate data before deleting it
and forbid the change by an
error message.

For further information, see
How to set schema for a Before
Saving/Deleting Job.

Smart View An XSLT-based Process that is automatically detected by Talend MDM
Web User Interface.

It sets up a more customized graphical presentation for a given data object
(hiding some fields, displaying icons, etc.). The business user may choose
to display or print the object with this read-only personalized view or to
switch to the usual generated view where edits are possible.

The naming of this Process follows a specific pattern:
Smart_view_<entity>_[<ISO2>][<#name>], where the 2
character language ISO code and the name suffix are optional.
<ISO2> allows you to define multilingual smart views, and
the <#name> suffix allows you to have several alternates smart
views of the same entity.

This Process name will automatically fallback to
Smart_view_<entity> if the language is not found, and the
language you use to define the Smart View HTML parameters
in the Smart View editor will be picked as the default language.

Note that, for improved readability, in the MDM Repository
view, Processes are stored in subfolders by type and only the
second part of the name is displayed.

For further information, see How to create a Smart View Process.

Usually XSLT which
transforms an XML document
using XSLT.

But you can choose any number
of steps using any plug-in, as
long as the result at the end is
HTML.

Entity Action A Process that is created in the Studio and automatically listed in the
Browse Records page in Talend MDM Web User Interface. A business
user can then select any of these Processes listed in the Web User Interface
and click the Launch Process button to start the selected Process. For
further information, see Talend MDM Web User Interface User Guide.

This Process is always linked to a specific entity. You can design this
Process to do any tasks you want, for example sending the entity by email.

The naming of this Process follows a specific pattern:
Runnable_<entity>. However, if you want to customize the
Process name, you must specify an Optional Name in the
[Create Process] wizard. This adds a hash sign before the word
you want to add to the Process name. For example, giving the
Optional Name Send to an Entity Action Process on the Agency
entity would give the Process name Runnable_Agency#Send.

Note also that, for improved readability, in the MDM
Repository view Processes are stored in subfolders by type and
only the second part of the name is displayed.

Any in the list of available plug-
ins.

However, a typical associated
plug-in is callJob if the Process
is linked with a Talend Job.

Welcome Action Similar to the Runnable Process but is not linked to a specific entity.

This Process is created in the Studio and automatically listed in the
[Welcome] page in Talend MDM Web User Interface.

You can design this Process to do any task you want, for example adding
a new record/entity.

Any in the list of available plug-
ins.

However, a typical associated
plug-in is callJob if the Process
is linked with a Talend Job.
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Process type Description Associated plug-in

The naming of this Process follows a specific pattern:
Runnable#<name>; for example Runnable#AddNewRecord.

Note also that, for improved readability, in the MDM
Repository view, Processes are stored in subfolders by type and
only the second part of the name is displayed.

For further information, see How to create a Welcome Action Process

23.5.1.2. Important plug-ins

Plug-ins are extra components that add specific capabilities to the Talend MDM. Talend Studio proposes a list of
plug-ins to be combined with a given Process. These plug-ins include callJob, workflowcontexttrigger, groovy,
xslt and crossreferencing (deprecated).

The table below explains some of the plug-ins listed in the Studio and details their parameters.

Plug-in Action Description

callJob Executes a Talend Job on
master data (to modify or
propagate it, for example).

For further information on the
schemas used, see Schemas
used in MDM processes to call
Jobs.

This plug-in executes a Web service call to the server where the Web
service is deployed, usually the MDM server.

Parameters:

url: the webservice port URL.

Name: name of the input variable.

Value: value of the input variable.

If you want to view the related Job, click the Open Job button
to open it in the Integration perspective.

groovy Calls the groovy script and uses
it to process and transform data.

This plug-in implements all the capabilities of the groovy script to process
and transform data when it receives an Update Report. It can read the XML
document, transform data and write in the XML document as well.

crossreferencing
(deprecated)

Transforms XML content using
cross referencing tables.

This plugin takes an input XML and cross-references (e.g. replace the
content of) a designated list of elements or attributes using the content
extracted from items stored in the database. It offers the possibility to:

-perform multiple cross-references on the source XML document in one
pass,

-either ignore a failed cross-reference or throw an error and stop execution
of the Process,

-specify a default value when the cross-referencing fails and errors are
ignored.

This plug-in provides enhanced functionality over the built-in
cross-referencing provided by the XSLT plugin.

Input variables:

-xml: the source xml on which the cross-referencing will be performed.

Output variables:

-text: the result of the processing.

For further information about this plug-in, see Example of the
crossreferencing plug-in and its parameters.

xslt Transforms an XML document
using XSLT.

This plug-in implements xslt transformations on an input XML document.
It supports XSLT 2.0 and is enriched with cross-referencing capabilities:
specific instructions that help to perform on the fly cross-referencing on
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Plug-in Action Description

any master data stored in the MDM Hub. When the output method of the
XSLT is set to xml or to xhtml. Cross-referencing is carried out after the
XSLT is processed on all elements with the following attributes:

<MyElement
     xrefCluster='CLUSTER'
     xrefIn='TEST1, ..., TESTN'
     xrefOut='XPATH_IN_ITEM'
     xrefIgnore='true|false'
     xrefDefault='DEFAULT_VALUE'
>OLD_VALUE</MyElement>

Below is a definition of each of these attributes:

-xrefCluster: the container (cluster) where the items used for cross-
referencing are stored.

-xrefIn: a series of XPaths tests to match this item content with a remote
item.

-xrefOut: the XPath in the remote item, starting with the entity (concept)
name, of the content that will replace the content of this item.

-xrefIgnore: optional, defaults to false. If set to true, the cross
referencing will not fail if no item is found and the xrefDefault value
will be inserted.

-xrefDefault: if xrefIgnore is set to true and the cross-referencing
fails, this value will be used instead.

Input variables:

-xml: the xml on which to apply the XSLT.

-parameters: optional input parameters to the XSLT in the form of:

<Parameters>
   <Parameter>
       <Name>PARAMETER_NAME</Name>
       <Value>PARAMETER_VALUE</Value>
   </Parameter>
</Parameters>

Output variables:

- text: the result of the XSLT.

For an example on this plug-in, see Example of the xslt plug-in.

partialupdate Performs partial updates on an
item.

The partialupdate plugin updates elements of an existing item from the
content of a supplied XML This plugin provides the ability to:

-add sub elements or update existing elements,

-add sub elements to an existing list of sub-elements starting from a
specified position.

Input variables:

-xml-instance: the XML used to find and update an existing item. The
updated item is searched based on the XML content, and the XML must
follow certain specifications:

First, the root element must have the same name as the name of the Entity
of the item.

Second, the XML must contain the value of all the item keys at the same
XPath as those of the item unless item_primary_key is specified.
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Plug-in Action Description

Third, other than the keys, the XML can contain more elements than the
one updated on the item but does not have to validate the item data model.

-item_primary_key: optional if the key values are set on the
xml_instance. The primary key must be supplied as an object of type
application/xtentis.itempk as returned by the project item plugin.

-data_model: (optional) the Data Model used to validate the item after
update. Overwrites the corresponding value supplied in the parameters.

-clear_cache: optional, defaults to false. If set to true, the Data Model
is re-read and parsed from the database for each invocation of the plugin
during the Process execution

Output variables:

-item_primary_key: the primary key of the updated item as an object
of type application/xtentis.itempk.

project (deprecated) Projects content to the Data
Manager.

This plug-in saves an XML document in a data container after validation
against a data model. If no item primary key is passed as a variable in the
pipeline, the default data model and default data container to be used must
be specified in the parameters.

Input variables:

-xml-instance: the XML of the item to project.

-item_primary_key: (optional) the primary key of the projected XML.
When not supplied, the primary key will be inferred from the xml by
parsing the data model (slower).

-data_model: (optional) the Data Model used to validate the item after
update. Overwrites the corresponding value supplied in the parameters.

-clear_cache: optional, defaults to false. If set to true, the data model
is re-read and parsed from the database for each invocation of the plugin
during the Process execution

Output variables:

-item_primary_key: the primary key of the projected item as an object
of type application/xtentis.itempk.

For further information about this plug-in, see Example of the project plug-
in and its parameters.

Example of the xslt plug-in

The following example parameters will loop over all the lines of the input XML and send them to the transformer
as XML fragments:

<Country
    xrefCluster='MYCLUSTER'
    xrefIn='.=Country/Codes/ISO2, ../Customer/Name=[ACME]'
    xrefOut='Country/Name/FR'
><xsl:value-of select='State/CountryCode'/></Country>

The example above does the following:

• The XSLT generates a <Country> element in the target document,

• The content of State/CountryCode of the source document is inserted as the value of the element,
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• The rest of the xslt transformations complete,

• The system queries the Country data in cluster MYCLUSTER where:Codes/ISO2Code is equal to State/
CountryCode (the current value of the Country element), and /Customer/Name in the target document is equal
to hard coded value ACME,

• The matching Country document is returned and the value in Name/FR is extracted,

• The value in Country of the target document is replaced with the extracted value.

Example of the crossreferencing plug-in and its parameters

crossreferencing parameters (deprecated):

The parameters are specified as an XML in the form of a list of CrossRef elements.

<parameters>
    <CrossRef>
           <xrefName>A_UNIQUE_NAME</xrefName>
           <xrefCluster>ITEMS_CLUSTER</xrefCluster>
           <xrefRootElement>ROOT_XPATH</xrefRootElement>
       <xrefIn>
              <mapping>
                      <xrefElement>XML_SOURCE_XPATH</xrefElement>
                      <xrefPath>ITEM_KEY_XPATH</xrefPath>
              </mapping>
       </xrefIn>
       <xrefOut>
              <mapping>
                      <xrefElement>XML_TARGET_XPATH</xrefElement>
                      <xrefPath>ITEM_VALUE_XPATH</xrefPath>
              </mapping>
       </xrefOut>
       <xrefIgnore>FALSE</xrefIgnore>
       <xrefDefault>EMPTY</xrefDefault>
    </CrossRef>
    <CrossRef>
    ...
    </CrossRef>
    ...
</parameters>

Below is a definition of each of these attributes:

• xrefName: an unique name for this CrossRef.

• xrefCluster: the name of the data-container where matching items will be searched.

• xrefRootElement: the XPath to an element in the source XML document to which all other XPaths will be
relative. This is useful to process a list of sub-elements in the source documents: assuming a PurchaseOrder
with multiple LineItems, specifying //LineItem will process the cross-referencing on all LineItems.

• xrefIn/mapping/xrefElement: an XPath relative to xrefRootElement in the source XML document. The
content of this element or attribute will be used to search a matching Item.

• xrefIn/mapping/xrefPath: an XPath to an Item element or attribute, starting with the Item entity name. The
first item where this XPath content matches the content of xrefIn/mapping/xrefElement will be selected.

• xrefOut/mapping/xrefElement: an XPath relative to xrefRootElementin the source XML document. The
content of this element or attribute will be replaced with the content extracted from xrefOut/mapping/
xrefPath.
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• xrefOut/mapping/xrefPath: an XPath to an Item element or attribute, starting with the same Item entity
name as the xrefIn/mapping/xrefPath. The content of this XPath will be used to replace the content of the
xrefOut/mapping/xrefElement XPath.

• xrefIgnore: (optional; defaults to false). If set to true a failed cross-referencing will not stop the Process and
the xrefDefault value will be mapped to the xrefOut/mapping/xrefElement element or attribute.

• xrefDefault: (optional; default to empty). The target value used when a cross-referencing fails and
xrefIgnore is set to true. See xrefIgnore.

Example:

The following example parameters will cross-reference (e.g. replace the content of) the UnitOfMeasure attribute
of the sub-elements Quantity/Value in all elements PurchaseOrderLineItem of the source XML by:

1. first, getting the value of the original UOM attribute of the Quantity/Value element,

2. second, using this value to find a UnitOfMeasure item in the data container Cross Referencing where the
text content of the sub-element cXMLUnit equals the value,

3. and third, extracting the text content of the XBITSunit sub-element of the UnitOfMeasure item.

The Process will stop if the cross-referencing cannot be performed.

<parameters>
    <CrossRef>
            <xrefName>myCrossRefName</xrefName>
            <xrefCluster>CROSSREFERENCING</xrefCluster>
            <xrefRootElement>//PurchaseOrderLineItem</xrefRootElement>
            <xrefIn>
                     <mapping>
                             <xrefElement>Quantity/Value/@OriginalUOM</xrefElement>
                         <xrefPath>UnitOfMeasure/cXMLUnit</xrefPath>
                     </mapping>
            </xrefIn>
            <xrefOut>
                     <mapping>
                          <xrefElement>Quantity/Value/@UOM</xrefElement>
                            <xrefPath>UnitOfMeasure/XBITSUnit</xrefPath>
                     </mapping>
            </xrefOut>
    </CrossRef>
</parameters>

Example of the project plug-in and its parameters

project parameters (deprecated):

The parameters are specified as an XML.

<parameters>
    <defaultDataCluster>DATA_CLUSTER_NAME</defaultDataCluster>
    <defaultDataModel>DATA_MODEL_NAME</defaultDataModel>
    <overwrite>true|false</overwrite>
</parameters>

Below is a definition of each of these attributes:

• defaultDataCluster: optional if input item_primary_key is supplied. It is the data container in which the
item will be stored.
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• defaultDataModel: optional if input data model is supplied. It is the data model used to validate the item.

• overwrite: optional defaults to true. If set to false, an existing item will not be overwritten by this xml.

Example:

The following example parameters will project a supplied XML to the myDataCluster data container validating
against the myDataModel data model. An existing item will be overwritten:

<parameters>
   <defaultDataCluster>myDataCluster</defaultDataCluster>
   <defaultDataModel>myDataModel</defaultDataModel>
   <overwrite>true</overwrite>
</parameters>

23.5.1.3. Schemas used in MDM processes to call Jobs

When a Job is called from an MDM process, it receives an XML document based on a specific schema. In return,
the Job sends back a document which must also conform to a particular schema.

How to set the schema for a Job called through a Trigger

This is the typical case when a Process is called by a Trigger. The Process uses a callJob plug-in to invoke a
Talend Job created in the Integration perspective of Talend Studio.

Input Schema A document is passed on to the Job. The schema is:

<item>
         ... record ...
</item>

Assuming a Customer record, the complete result is:

<item>
        <Customer>
                <Firstname>Janet</Firstname>
                <Lastname>Richards</Lastname>
        </Customer>
</item>

Output schema If the Job returns nothing, MDM will generate a document with the Job return status in callJob
output variable:

<results>
        <item>
                <attr>0=ok or 1=failed</attr>
        </item>
</results>

If the Job returns a table though a tBufferOutput component, MDM will define the following document in the
callJob output variable:

<results>

     <item>
             <attr>col1</attr>
             <attr>col2</attr>
             etc.
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     </item>

</results>

This result may be mapped back into an Entity by adding the following fragment in callJob configuration:

<configuration>
(...)
   <conceptMapping>
         <concept>Customer</concept>
         <fields>
           {
           p0:Firstname,
           p1:Lastname,
           }
        </fields>
   </conceptMapping>
</configuration>

Then callJobs output variable will receive:

<results>
        <Customer>
                <Firstname>col1</Firstname>
                <Lastname>col2</Lastname>
        </Customer>
</results>

How to set schema for a Before Saving/Deleting Job

The Before Saving/Before Deleting processes are called directly by naming convention. They do not go through
the usual Trigger > Process mechanism. Jobs called through a Before Saving or Before Deleting Process receive
a different document than when they are called through a Trigger. In addition, they are expected to return a status
report or an error message which the Web Interface can use to proceed with / cancel the action.

The process must always return a variable called output_report.

Input

The input document comprises the update report as well as the record which is being saved or deleted:

<exchange>
      <report>
      ... update report ...
      </report>
      <item>
      ... record ...
      </item>
</exchange>

You can always find the exact schema description of an update report in the MDM Repository tree view in Data Model
> System > UpdateReport.

In the Job, you may put conditions similar to triggers. For instance, you may use exchange/report/Update/
OperationType to implement different conditions on CREATE and UPDATE.

Output

The Job is required to return a document that conforms to:

<report><message type="info">message</message></report>
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Or to:

<report><message type="error">message</message></report>

When you want to create a Before Saving Process that both checks validation rules and completes the record on the fly, you
must define a two-step Process, with one step returning output_item and the other step returning output_report.

The working principles for the Before Saving and Before Deleting Processes can be summarized as described
in the following three cases.

Upon completion of the Before Saving or Before Deleting processes, the MDM server looks for a variable called
output_report in the Process pipeline.

First case:

• If <report><message type="info">message</message></report>: the validation process of the data
record has been carried out successfully and a message will display. The data record will be successfully saved
with the Before Saving Process, or successfully deleted with the Before Deleting Process.

• If <report><message type="error">message</message></report>: the validation process of the data
record fails and a message displays. The data record will not be saved with the Before Saving Process, and it
will not be deleted with the Before Deleting Process.

Second case:

The MDM server has not found the output_report variable. The validation process of the data record has failed
and an error message will be shown to confirm this. The data record will not be saved with the Before Saving
Process, and it will not be deleted with the Before Deleting Process.

Third case:

The Process throws an exception (typically one of the steps in the Process leads to a technical error: wrong
configuration, XSLT syntax error, Job not found or could not be called, and so on.). A technical error message
will display and the data record will not be saved with the Before Saving Process, and it will not be deleted with
the Before Deleting Process.

23.5.1.4. How to set up a callJob Process chain using the Create
Process wizard

The [Create Process] wizard takes you through the generation of the complete callJob Process chain for each of
the following types of Process: Before Saving or Before Deleting, Entity Action or Welcome Action, and Other.
For a description of each type of Process, see Process types.

The steps to follow vary depending on the type of Process being generated.

Setting up a callJob Process chain for a Before Process

To set up the callJob Process chain for a Before Saving Process or a Before Deleting Process using the [Create
Process] wizard, do the following:

1. In the MDM Repository tree view, expand the Event Management node, right-click the Process node, and
then click New.

The [Create Process] wizard opens.
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2. Select which type of Process you want to create, and then click Next.

The next screen of the [Create Process] wizard opens.
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3. Select whether you want to create a Before Saving Process or a Before Deleting Process, and then click
the [...] button next to the Input Name field.

The [Select one Entity] dialog box opens.
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4. Select the specific Entity for which you want to generate the Process, and then click Add to return to the
[Create Process] wizard.

5. Click Next.

A dialog box opens in which you can input a multi-lingual message to accompany your Process.

6. Define the error or informational message you want to display, as follows:

1. Select the Message Type, error or info.

2. Click the [...] button next to the Message field to open a dialog box in which you write the message and,
if appropriate, a localized version in one or more additional languages.
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3. Click OK to close the [Set multi-lingual message] dialog box and return to the [Create Process] wizard.

7. Click Next.

8. Select or deselect the Generate the template job check box to specify whether you want to generate a
template job for the process, and then click Finish.

The Process and, if appropriate, the template Job open.

Setting up a callJob Process chain for an Entity Action or Welcome Action
Process

To set up the callJob Process chain for an Entity Action Process or a Welcome Action Process using the [Create
Process] wizard, do the following:

1. In the MDM Repository tree view, expand the Event Management node, right-click the Process node, and
then click New.

The [Create Process] wizard opens.

2. Select which type of Process you want to create, and then click Next.

The next screen of the [Create Process] wizard opens.
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3. Select whether you want to create an Entity Action Process or a Welcome Action Process.

An Entity Action Process is linked to a specific Entity (which you define in the next step of the wizard). A
Welcome Action Process appears as a standalone link in the Welcome page of the Talend MDM Web User
Interface.

4. Click the [...] button next to the Description field.

The [Set multi-lingual message] dialog box opens.

5. Enter the text for the English-language label to accompany your Process, and then click the [+] button.
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You can also define localized versions of the label for other languages if required.

6. Click OK to return to the [Create Process] wizard.

7. Click the [...] button next to the Input Name field.

The [Select one Entity] dialog box opens.

8. Select the Entity for which you want to generate the Process, and then click Add to return to the [Create
Process] wizard.

If you are creating a Welcome Action Process, skip the Entity selection step and manually enter a name for your Process
in the Optional Name field instead.

9. Click Next.

The next screen of the [Create Process] wizard opens.
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10. Select the Enable redirection check box if you want the Process to redirect the Web browser to a URL, and
specify the URL in the URL field.

11. Click Next.

12. Select or deselect the Generate the template job check box to specify whether you want to generate a
template job for the process, and then click Finish.

The Process and, if appropriate, the template Job open.

Setting up a callJob Process chain for an Other Process

To set up the callJob Process chain for an Other Process using the [Create Process] wizard, do the following:

1. In the MDM Repository tree view, expand the Event Management node, right-click the Process node, and
then click New.

The [Create Process] wizard opens.
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2. Select which type of Process you want to create, and then click Next.

The next screen of the [Create Process] wizard opens.
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3. Enter a name for your Process in the Input Name field, and then click Next.

4. Select or deselect the Generate the template job check box to specify whether you want to generate a
template job for the process, and then click Finish.

The Process and, if appropriate, the template Job open.

23.5.1.5. How to create a Process from scratch

When you design a Process, you combine specific Process plug-ins into a sequence of steps. These steps are then
executed one after the other to perform specific tasks.

Whenever a data record is created/updated/deleted, the MDM Server generates a document and lists it under the
UpdateReport node in the System data container in the MDM Repository tree view. This document describes
the event in answering a who, what and when questions and in giving the record primary key and the values before
and after in case of an update. This UpdateReport document does contain everything about the event that just
happened, however it does not contain the complete XML record that was created/updated/deleted. This document
is then sent to the Event Manager. Whenever the Event Manager receives a document, it tries to evaluate "route"
every Trigger conditions against this document. For further information about Triggers, see Triggers.

So the sequence of events that occur whenever a Create/Update/Delete (CRUD) is performed in Talend MDM
is as follows:

• the Event Manager evaluates every defined Trigger to see if one or more Triggers have valid conditions,

• the services defined in the Trigger are performed,
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• in case a callJob service has been defined in the Trigger, the Trigger uses the callJob plug-in to run a Talend Job

In the example below, a data model called Product has been created in Talend Studio. This data model has two
business entities: Product and ProductFamily. Several attributes have been created in the Product entity including
Price and Family. You want to create a Process to automatically trigger a validation Job whenever a price of an
item that belongs to a specific family has been changed through Talend MDM Web User Interface.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. You have the appropriate
user authorization to create Processes.

To create a Process to automatically trigger a Talend Job:

1. In the MDM Repository tree view, expand Event Management and then right-click Process and select New
from the contextual menu.

The [Create Process] dialog box displays.

2. Select the option corresponding to the Process type you want to create and then enter a name for the new
Process.

In this example, you want to create an Other Process. For more information on Process types, see Process
types.

3. Click OK to close the dialog box.

An empty editor for the newly created Process opens in the workspace.

4. If required, click the three-dot button next to the Description field to open a dialog box where you can set
multilingual descriptions of your Process.
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5. In the Step Description field, enter a name for the first step you want to define in the created Process and

then click the  icon to add the step name in the rectangle below the field.

6. Repeat to add the two other steps included in this Process.

The Process for this example must include one basic step, Invoke the job through the callJob plug-in, and two
obligatory additional steps as follows:

First step: to retrieve the complete XML record through the XSLT plug-in.

This step is obligatory in this example since you need the whole record in order to check what family the item for
which the price has been changed belongs to and you cannot find such information in the Update Report.

Second step: to decode XML in order to remove the escape function you used in the XSLT document and thus
send a real XML document to the Job.

Final step: to send the XML document to a Talend Job.

Usually, you can create a Process with only the callJob plug-in if the complete XML record is not needed, depending on the
type of the task you want to accomplish. For example, if you want to validate the price change of an item in general without
mapping it to a specific family, you can create this Process with only one step: Invoke the job.

The procedures below describe in detail how to define each of the listed steps.

How to retrieve the complete XML record

1. Click the first step to display the Step Specifications area where you can define the step parameters.
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You can disable the selected step in the open Process editor at any time if you select the Disable check box in the
Step Specification area.

2. From the Plugin name list, select xslt.

A description for the selected plug-in displays in the box above the Plugin name field.

The  button displays a dialog box that describes the plug-in and details its parameters.

3.
As the xslt plug-in is our first step, leave the input variable empty, select the xml input, and click the 
button to add them to the table.

The MDM server starts the pipeline with a default variable called _DEFAULT_ .

Here you want to map variables to the input parameter of the plug-in, and conversely map output parameter
of a plug-in to another variable.
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4. Select the output parameter text and define a new output variable, record_xml in this example and then click

the  button to add them to the table.

For each step, you can select one of the by-default variables or one of the variables defined for the preceding plug-
in the Process you define.

5. In the Parameters area, complete the XSLT definition as follows:

<xsl:stylesheet xmlns:xsl="http://www.w3.org/1999/XSL/Transform"
xmlns:mdm="java:com.amalto.core.plugin.base.xslt.MdmExtension" version="1.0">
<xsl:output method="xml" indent="yes" omit-xml-declaration="yes" />
<xsl:template match="/" priority="1">
<exchange>
<report> 
<xsl:copy-of select="Update"/> 
</report>
<item>
<xsl:copy-of select='mdm:getItemProjection(Update/RevisionID,Update/
DataCluster,Update/Concept,Update/Key)'/>
</item>
<exchange>
</xsl:template>
</xsl:stylesheet>

The text you enter in the text editor is indented by default upon saving. This may cause problems in certain cases such
as the HTML formatting when creating a Smart View process. If required, clear the Auto-indent check box to disable
the text indentation upon saving the process.

In this first step, the Process pipeline starts with a _DEFAULT_ variable, which contains the Update Report. The
content of _DEFAULT_ is sent to this first XSLT step through its text input parameter.The XSLT step retrieves
the complete XML record through the getItemProjection function in order to escape every XML sign to avoid any
character encoding conflicts in XSLT. The result of the step is sent from the output parameter to the item_xml
variable. So now item_xml is ready to be sent to the next step of the Process pipeline.

How to decode XML

In this step, you want to use a decoding mechanism to remove the escape function from the XML document before
sending it to the Job.

1. Click the second step to display the Step Specifications area where you can define the step parameters.

You can disable the selected step in the open Process editor at any time if you select the Disable check box in the
Step Specification area.

2. From the Plugin name list, select codec.

A description for the selected plug-in displays in the box above the Plugin name field.

The  button displays a dialog box that describes the plug-in and details its parameters.

3. Map the item_xml variable defined in the previous step to this step law_text input parameter and click the

 button to add them to the table.

4.
Map this step output parameter to a new variable called decode_xml, for example then click the  button
to add them to the table.

For each step, you can select one of the by-default variables or one of the variables defined for the preceding plug-
in the Process you define.
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5. In the Parameters area, complete the definition as follows:

<parameters>
<method>DECODE</method>
<algorithm>XMLESCAPE</algorithm>
</parameters>

The text you enter in the text editor is indented by default upon saving. This may cause problems in certain cases such
as the HTML formatting when creating a Smart View process. If required, clear the Auto-indent check box to disable
the text indentation upon saving the process.

So far, the first step in the Process produces the record_xml variable with the complete XML record. This step
sends the record_xml to the codec plug-in law_text input parameter. The codec plug-in unescapes the XML and
posts the result in decode_xml through its output variable. So now there is a decode_xml document ready to be
sent to the last step: call the Job.

How to send the XML document to the Job

1. Click the third step to display the Step Specifications area where you can define the step parameters.

You can disable the selected step in the open Process editor at any time if you select the Disable check box in the
Step Specification area.
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2. From the Plugin name list, select callJob.

A description for the selected plug-in displays in the box above the Plugin name field.

The  button displays a dialog box that describes the plug-in and details its parameters.

3.
Map the decode_xml variable defined in the previous step to this step text input parameter and click the 
button to add them to the table.

4.
Map this step output parameter to a new variable called output, for example then click the  button to
add them to the table.

For each step, you can select one of the by-default variables or one of the variables defined for the preceding plug-
in the Process you define.

5. In the Parameters area, click the three-dot button next to the URL field to open a dialog box. Here you can
set the actual URL to the Job web service by selecting the Job you want to invoke.

6. In the Parameters area, set the actual name of the context variable that will receive the XML record.

7. If required, click the Source tab in the lower left corner of the Process editor to switch to the text editor. Here
you can enter the parameters directly in XML.

The text you enter in the text editor is indented by default upon saving. This may cause problems in certain cases such
as the HTML formatting when creating a Smart View process. If required, clear the  Auto-indent  check box to disable
the text indentation upon saving the process.

The Job will thus need to parse the context variable using a tXMLExtractXMLField component. You can
send as many context variables as necessary, including literal values.

8. Click the save icon on the toolbar or press Ctrl + S on your keyboard to save your changes.

The newly created Process is listed under the Process node in the MDM Repository tree view.

Now that the Process has been created, you can call it using a Trigger. Once called, it will transform the master
data records according to the tasks defined in the Process.

For more information on how to call a specific Process in a Trigger, see How to select the service to Trigger and
set the service parameters. For more information on Triggers, see Triggers.

If you have the following error message when trying to call a Process, please verify the possible causes listed below: Error
message:

ERROR [TISCallTransformerPluginSession]
(EJB-Timer-1271251638944[target=jboss.j2ee:jndiName=amalto/remote/core/
transformerv2ctrl,service=EJB]smile
Could not execute the tisCall transformer plugin javax.xml.ws.WebServiceException:
Could not send Message

Possible causes:
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-the URL of the Job to call is not correct or the Job is not deployed,

-the context variable does not have the correct name (it has to be the same in the Process and in the Job),

-there is an error in the Job at runtime.  Try to deactivate all components in your Job and use only a tFixedFlowInput
and a tLogRow components to display the context variable contents. If no error happens, then there is probably an error
in your Job.

23.5.1.6. How to create a Welcome Action Process

Like an Entity Action Process, a Welcome Action Process is a process designed in the Studio and can be manually
launched by a business user from Talend MDM Web User Interface. Unlike the Entity Action Process, the Welcome
Action Process is not linked to a specific business entity.

You can design this Process to do any task you want on master data, for example adding a new record/entity in
the MDM Hub, launching a Job to do some check or transformation on master data, etc. Both Welcome Action
and Entity Action Processes can launch a Job to return a specific result in a new tab in the web interface.

The naming of the Welcome Action Process follows a specific pattern: Runnable#[name]; for example
Runnable#AddNewRecord or Runnable#LaunchJob.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. You have the appropriate
user authorization to create Processes. You have already created a Job that will provide the URL for the
"output_variable" and deployed it on the MDM server.

This example guides you through the steps of creating a Welcome Action Process that returns a result in Talend
MDM Web User Interface. It calls a Job that provides the URL of a PDF file you want to display in the web
interface. You can use the Job to display any type of content, for example Word documents or PDFs, images,
web sites, etc.

Start with creating the Job in the Integration perspective of your Studio. A simple example of such a Job could be:

1. Configure the tJava component with the Java commands you want to execute.

This example will generate the URL for a PDF.
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The output_url is the output variable that is used to return the result in the web interface. You must always define this
same variable as the output variable in the Process editor, as explained further below.

2. Configure the tBufferOutput component to buffer the URL defined in tJava and provide it to the output
variable you will use when you define the Welcome Action Process. Drop the column from the tJava input
schema to the tBufferOutput schema.

3. Click OK to validate your changes and close the dialog box.

For further information on Talend Jobs and components, see the Talend Open Studio Components Reference
Guide.

4. Save your Job and then deploy it to the MDM server. For further information on Job deployment, see
Deploying Jobs automatically on the MDM server.

To create the Welcome Action Process that will launch the above Job to display a PDF in a new tab in the MDM
web browser, do the following:

1. In the MDM Repository tree view, expand Event Management and then right-click Process and select New
from the contextual menu.

The [New Process] dialog box displays.

2. Select the Create an Entity/ Welcome Action Process option, and then click Next.
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3. Select Create a Welcome Action and then, in the Optional Name field, enter LaunchJob.

This creates a Process with the name Runnable#LaunchJob.

4. Click Next twice to move through the following screens of the wizard, and then click Finish to close the
dialog box.

An empty editor for the newly created Process opens in the workspace.

5. If required, click the three-dot button next to the Description field to open a dialog box where you can set
multilingual descriptions of your Process.

This description will be listed as the standalone process name in the [Welcome] page in Talend MDM Web
User Interface. For further information, see Talend MDM Web User Interface User Guide.

6. In the Step Description field, enter a name for the step you want to define in the created Process and then

click the  icon to add the step name to the list that follows.

7. If required, do the same to add a second step to do some other task.

The Welcome Action Process you are going to create here has one step that triggers a Talend Job using the callJob
plug-in. This plug-in consumes data in input parameters and produces a result in the output parameters. The result
in this example is to display the content of a PDF in a new tab in the web interface. So the Process calls a Job that
by turn provides the URL of the file in an output_url variable.

You need now to define the input and output parameters and variables for the listed step(s), only one in this
example.

1. Select the step to display the Step Specification view in the editor. Here you can define the step input and
output parameters and variables.
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2. From the Plugin name list, select callJob.

The  icon displays a description of the plug-in and details its parameters.

3.
As the callJob plug-in is the first step, leave the input variable empty, select the text input, and click the 
button to add them to the table.

The MDM server starts the pipeline with a default variable called _DEFAULT_ .

Here you want to map variables to the input parameter of the plug-in, and conversely map output parameter
of a plug-in to another variable.

4.
Select the output parameter result and define the output variable, output_url, and then click the  button
to add them to the table.

5. In the Parameters area, click the three-dot button to display a list of all Talend Jobs that have been deployed
on the MDM server.

6. Select the Job you want to attach to the Process, ProduceURL in this example.

If you have more than one step in your Process, you must define variables to hold the result of the first step. Then you
send the variable to the input of the second step. Eventually, you define a "pipeline" where each step result is chained
to the next step through a variable. For each step, you can select one of the by-default variables or one of the variables
defined for the preceding plug-in the Process you define.

You can disable the selected step in the editor at any time if you select the Disable check box.
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7. Save your modifications.

The Welcome Action Process is listed under the Process node in the MDM Repository tree view.

This same process is accessible from Talend MDM Web User Interface. An authorized business user can launch
this Process and display the result from the [Welcome] page in the Web User Interface. For further information,
see Talend MDM Web User Interface User Guide.

23.5.1.7. How to create a Smart View Process

Principles

A Smart View is a customized, business-oriented view of a data record in the MDM Hub.

A Smart View basically renders an HTML presentation of the details of a data record held in a specific entity.
Whenever a business user tries to browse a data record through Talend MDM Web User Interface, Talend MDM
checks for a Smart View for such entity. If it finds the Smart View, it uses this view to render the HTML
presentation of the record detail instead of displaying the "conventional" generated form. The business user can
then switch back and forth between the Smart View presentation and the generated form.

A Smart View is not a view but an XSLT-based process that must have an XSLT step which transforms the XML
document using XSLT. The pipeline for this XSLT step must have an output variable called html. However, a
Smart View can have steps other than the XSLT one that can perform different tasks on master data, for further
information, see Processes.

A Smart View has a naming convention: Smart_view_<Entity>[_<ISO2>][<#name>]. The two characters
country ISO code is optional and it allows you to define multilingual smart views. The <#name> suffix is also
optional and allows you to define several smart views for the same entity.

At runtime, when a user tries to open a record in an entity through Talend MDM Web User Interface, say the
Product entity for example, here is what happens:

1. Talend MDM first looks for all Processes that begins with Smart_view_Product,

2. If it finds one with the _<ISO2> suffix (e.g. Smart_view_Product_ENU in the U.S., Smart_view_Product_FR
in France etc.) it uses it,

3. It then sends the XML record into the _DEFAULT_ variable and executes the Process,

4. When the Process completes, it looks for an output variable called html,

5. It finally sends the content of the html variable back to the browser.

How to create a "default" Smart View of a data record

A Smart View is an alternative to the "conventional" generated view used to display the data record detail in
Talend MDM Web User Interface. A Smart View is a customized view that uses an XSLT step to render the HTML
presentation from the incoming XML record.

You can either create the HTML elements directly in the parameters of the XSLT step in the Process editor, or
create a web template outside Talend Studio and then paste the HTML into the parameters of the XSLT step in
the Process editor.
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Prerequisite(s): You have already connected to the MDM server from Talend Studio. You have the appropriate
user authorization to create Processes.

To create a Smart View of a data record, do the following:

1. In the MDM Repository tree view, expand Event Management and then right-click Process and select New
from the contextual menu.

The [Create Process] dialog box displays.

2. Select the Create a Smart View option, and then click Next.

3. The second screen of the wizard is where you define the Process name, which is made up from the name of
the entity on which you want to run the Process, and an optional suffix.

Click the [...] button to open the [Select one entity] dialog box, choose the appropriate Data Model from
the drop-down list, select the entity on which you want to run the Process, and then click Add to close the
dialog box.

4. If you want, you can also add an optional suffix in the Optional Name field which will give a specific name
to your Smart View in addition to the entity name. This can be useful if, for instance, you create multiple
Smart Views on the same entity.

The Process name will follow the same format as these examples: Smart_view_Product or
Smart_view_Product#mysmartviewprocess.

In this example, we assume that you have a Product data model that has a Product business entity. Many
attributes have been defined for this entity including: Name, Description, Features (Sizes and Colors),
Availability and Price.

5. Click Finish to close the dialog box.

An editor for the newly created Process opens in the workspace with a Stylesheet step already listed in the
Step Sequence area.
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6. If required, click the [...] button next to the Description field to open a dialog box where you can set
multilingual descriptions of your Process.

This description will be listed as the Smart View name in the Smart View list in Talend MDM Web User
Interface. For further information, see Talend MDM Web User Interface User Guide.

When you create a new Smart View Process, an XSLT step, with the input and output variables, is automatically
added. Basic HTML elements are also automatically added in the Parameters area.

You can always add new steps in the Process if you enter the step name in the Step Description field and then click

the  icon. For further information, see How to create a Process from scratch.

7. Select the Stylesheet step in order to display the Step Specifications and the Parameters areas of the selected
XSLT step.

8. In the Parameters area, you can see the code used by the stylesheet. Click the Open in Editor button to use
the specific XSLT editor to edit this code.

Note that you can also make simple changes directly in the Parameters area.

The text you enter in the Parameters area will be indented by default upon saving. This may cause problems in HTML
formatting when creating the Smart View Process. Clear the Auto-indent check box to disable the text indentation
upon saving the process.

9. Enter the following code for the Product entity in the XSLT editor, and then click Save back to process
editor and close to save your changes and exit the editor.
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<xsl:stylesheet xmlns:xsl="http://www.w3.org/1999/XSL/Transform"
version="1.0">  
  <xsl:output method="html" indent="yes" omit-xml-declaration="yes"/>
  <xsl:template match="/"> 
   <html> 
     <head> 
       <title>Product</title> 
     </head>  
     <body> 
       <h1>This is the default ENGLISH Smart View for: 
         <xsl:value-of select="./text()"/> 
       </h1>  
       <tr> 
         <td> 
            <xsl:value-of select="Product/Name"/> 
         </td> 
       </tr>  
       <table border="1"> 
       <tr> 
         <td> 
          <xsl:value-of select="Product/Description"/> 
         </td> 
       </tr>  
       <tr>
         <td> 
            <xsl:value-of select="Product/Features"/> 
         </td> 
       </tr>  
       <tr> 
         <td> 
            <xsl:value-of select="Product/Availability"/> 
         </td> 
       </tr>  
       <tr> 
         <td> 
            <xsl:value-of select="Product/Price"/> 
       </td> 
       </tr> 
     </table> 
   </body> 
  </html>
 </xsl:template>
</xsl:stylesheet>

This way, whenever a business user accesses Talend MDM Web User Interface and tries to browse records
in the Product entity, he/she will get this Smart View by default:
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From this view in Talend MDM Web User Interface, the business user can have access to any Runnable processes
created on the selected entity. He/she can run any of the listed process to initiate the tasks listed in the Process.

The business user can switch to the "conventional" generated form by clicking Generated View on the menu
bar:

The business user can always switch back and forth between the Smart View and the generated view through
clicking the Personalized View and Generated View tabs respectively in the Browse Record view in Talend
MDM Web User Interface.
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You can always disable the Smart View process if you select the Disable check box in the Process editor.

For further information on how to customize the Smart View parameters if you have Cascading Style Sheets (CSS)
and JavaScript resources, see HTML resources and Foreign Keys and cross referencing.

How to create a Smart View Process through a template

A Smart View uses an XSLT step to render the HTML presentation from the incoming XML record. The easiest
thing to do is to create an HTML template with hard-coded values outside Talend Studio:

<tr>
<td>Product Name</td><td>PROD NAME</td>
<!-- etc -->
</tr>

Then copy/paste this template into the body of the XSLT stylesheet in the Process editor, and replace the hard-
coded value by <xsl:value-of> statements:

<xsl:stylesheet xmlns:xsl="http://www.w3.org/1999/XSL/Transform"
version="1.0">  
    <xsl:output method="html" indent="yes"/>  
    <xsl:template match="/" priority="1"> 
        <html> 
            <head> 
                <title>Product</title> 
            </head>  
            <body> 
<tr>
<td>Product Name</td><td><xsl:value-of select="Product/Name"/></td>
<!-- etc -->
</tr>
            </body> 
        </html> 
   </xsl:template> 
</xsl:stylesheet>

Use, for instance, http://www.phpform.org/ to create a web template of your form. A web template consists of one
or several html files in addition to the resources (JavaScript, CSS, images, etc.). The resources must be accessible
from within MDM, so unzip the web template in a new "smartview" folder within jboss-4.2.2.GA/server/default/
deploy/jboss-web.deployer/ROOT.war.

1. Unzip the web template in a new smartview folder within jboss-4.2.2.GA/server/default/deploy/jboss-
web.deployer/ROOT.war.

http://www.phpform.org/
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Your form should now be accessible through: http://localhost:8180/smartview/Product/

form.html.

2. Open the form in a text editor and check the html elements.

XSLT is XML, and XML is not as lenient as html. You will find start tags with no end tags (meta, img, link,
etc.). Make sure all html elements are written with start and end tags.

3. Fix the URL to the JS, CSS and images. Change all the src attributes to point to: /smartview/Product/
<resource> instead of just <resource>. For instance:

Change:

<script type="text/javascript" src="view.js"></script>

to: <script type="text/javascript" src="/smartview/Product/view.js"></script>.

4. Create a Smart View Process in Talend Studio as outlined in How to create a "default" Smart View of a data
record and call it Smart_view_Product.

5. Change <xsl:template match="/"> to xsl:template match="/Product">, assuming the entity is Product.

6. Copy the html code, without <!DOCTYPE>, from the html tag and paste it within the

<xsl:template
match="/Product">
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element. Overwrite anything that was already within the <xsl:template> element:

7. Set the field values with the actual values extracted from the Product record using the <xsl:value-of>
statement. To ask XSLT to output an attribute, use the <xsl:attribute> statement.

As an example, here is the html code before the change:

<label class="description" for="element_2">Price
</label>
<div>
    <input id="element_2" name="element_2" class="element text   medium"
type="text" maxlength="255" value=""/>
</div>

And after the change:

<label class="description" for="element_2">Price
</label>
<div>
    <input id="element_2" name="element_2" class="element text medium"
type="text" maxlength="255">
<xsl:attribute name="value"><xsl:value-of select="Price"/></xsl:attribute>
    </input>
</div>

This tells XSLT to issue a "value" attribute within the <input> tag and to fetch the value of this attribute from
the Price element of the Product record.

The Product attribute used in this example has a foreign key to ProductFamily. You may want to add a step before the xslt
step in the Smart View Process and use a crossreferencing plugin (deprecated) to resolve the FK before it reaches the html
rendering. Below is the crossreferencing configuration:

<parameters> 
   <CrossRef> 
      <xrefName>resolvefk</xrefName>  
      <xrefCluster>Product</xrefCluster>  
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      <xrefRootElement>/Product</xrefRootElement>  
      <xrefIn> 
         <mapping> 
             <xrefElement>Family</xrefElement>  
             <xrefPath>ProductFamily/Id</xrefPath> 
         </mapping> 
      </xrefIn>  
      <xrefOut> 
         <mapping> 
             <xrefElement>Family</xrefElement>  
             <xrefPath>ProductFamily/Name</xrefPath> 
         </mapping> 
      </xrefOut> 
   </CrossRef> 
</parameters>

For further information on the crossreferencing plugin, see Important plug-ins and Example of the
crossreferencing plug-in and its parameters.

HTML resources

If you have Cascading Style Sheets (CSS) and JavaScript resources, they need to be URL-addressable. You can
do that through copying them in JBoss Web.

1. Create a directory in <MDM Server home>\jboss-4.2.2.GA\server\default\deploy\jboss-web.deployer
\ROOT.war; Product for instance.

2. Drop your CSS and JS files in the directory.

3. You can now define your resources in the <head> section of the XSLT parameters in the Process editor as
follows:

<xsl:stylesheet xmlns:xsl="http://www.w3.org/1999/XSL/Transform"
version="1.0">  
    <xsl:output method="html" indent="yes"/>  
    <xsl:template match="/" priority="1"> 
        <html> 
<head>
<title>Product</title>
<link rel="stylesheet" type="text/css" href="/product/greatlookandfeel.css"
media="all">
<script type="text/javascript" src="/product/javascriptsuff.js"></script>
</head>
<!-- rest omitted -->

Foreign Keys and cross referencing

Talend MDM sends the XML record, without resolving the FKs. It is up to the Smart View to lookup/resolve them.

As the Process is a multi-step pipeline, you can have one or several steps before the final XSLT step. So you will
need to insert a step to resolve your FKs and/or cross referencing. You can use a Talend Job deployed as a ZIP
or you can use a <parameters>

<CrossRef>

<xrefName>Country</xrefName>

<xrefCluster>crossreferencing</xrefCluster>
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<xrefRootElement>/Product</xrefRootElement>

<xrefIn>

<mapping>

<xrefElement>CountryCode</xrefElement>

<xrefPath>Countries/ISO2</xrefPath>

</mapping>

</xrefIn>

<xrefOut>

<mapping>

<xrefElement>CountryName</xrefElement>

<xrefPath>Countries/Name</xrefPath>

</mapping>

</xrefOut>

</CrossRef>

</parameters> step.

First example: if the data model is Product with a FK to ProductFamily, use the following parameters to resolve
the product family, which is the raw family code (e.g. "[1234]"), to the actual family name:

<parameters> 
   <CrossRef> 
       <xrefName>FamilyFK</xrefName>  
       <xrefCluster>Product</xrefCluster>  
       <xrefRootElement>/Product</xrefRootElement>  
       <xrefIn> 
            <mapping> 
                <xrefElement>Family</xrefElement>  
                <xrefPath>ProductFamily/Id</xrefPath> 
            </mapping> 
       </xrefIn>  
       <xrefOut> 
            <mapping> 
                <xrefElement>Family</xrefElement>
             <xrefPath>ProductFamily/Name</xrefPath> 
        </mapping> 
      </xrefOut> 
   </CrossRef> 
</parameters>

Second example: if there is a Countries cross reference table with key = ISO2 and value = Name and you want
to resolve Product/CountryCode into Product/CountryName, use the following parameters:

<parameters> 
   <CrossRef> 
       <xrefName>Country</xrefName>  
       <xrefCluster>crossreferencing</xrefCluster>  
       <xrefRootElement>/Product</xrefRootElement>  
       <xrefIn> 
          <mapping> 
              <xrefElement>CountryCode</xrefElement>  
              <xrefPath>Countries/ISO2</xrefPath> 
          </mapping> 
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       </xrefIn>  
       <xrefOut> 
          <mapping> 
              <xrefElement>CountryName</xrefElement>  
              <xrefPath>Countries/Name</xrefPath> 
          </mapping> 
       </xrefOut> 
    </CrossRef> 
</parameters>

For further information on the crossreferencing plugin, see Important plug-ins and Example of the
crossreferencing plug-in and its parameters.

23.5.1.8. Managing Processes

An authorized user can also execute, import/export, copy/paste and delete the listed Processes from Talend Studio.

It is also possible to import and share MDM complete projects or only a data model or part of the data model from the
community web page, Talend Exchange. For further information, see Projects/objects on Talend Exchange.

How to test a Process in the Studio

After creating your Process in Talend Studio, this Process is usually called by Talend MDM web service. However,
it is possible to run the Process from within the Studio itself.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one Process exists.

To execute a process in the Studio:

1. In the MDM Repository tree view, expand the Event Management and Process nodes and then double-
click the Process you want to execute in order to open the corresponding editor.

2.
Double-click the Process you want to test and then click the  icon in the upper right corner of the process
editor.

A dialog box opens.
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3. From the Input Variables list, select _DEFAULT_ and select text/xml from the Content Type list.

4. Click the Pick a record from a container button to select the desired record from a container. For more
information, see How to select a record from a container when testing a Process.

5. Click OK to run the Process.

A progress information bar is shown and then a result dialog box opens. If the results are HTML, for example
if you are testing a Smart View Process, you have the option of clicking the Display In Browser button to
view the results in your default Web browser.

This result will show that your Process works correctly. What you must do now is to define a Trigger in order to
call the process from that Trigger. For further information, see Creating a Trigger.

How to select a record from a container when testing a Process

To select a record from a container when testing a Process instead of adding the record manually, do the following:

1. Click the Pick a record from a container button, and the [Select record] dialog box appears.

All the elements are grayed out at the beginning, so you cannot select data from the list or enter data in the
fields.
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2. Select the server you want to use from the Server list. The Container list becomes available.

3. Select the desired container from the Container list. Both the Record Search and Record Content areas
become available.
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4.
Click the  icon next to the Entity list to display a list of records.

5. Click the desired record and its details are displayed in the Record Content area.
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6. Click OK to close the dialog box.

How to export Processes

From Talend Studio, you can export one or multiple Processes in order to exchange them between:

• two different MDM Servers or Repositories,

• two different Versions (deprecated) from the same/different MDM Servers or Repositories, for example.

The steps to export one or multiple Processes are similar to those for any other data object in the MDM Repository
tree view. For detailed information on how to export Processes, see How to export data models.

How to import Processes

From Talend Studio, you can import Processes created on other MDM servers, in different Versions on the same
MDM server (deprecated), or in different MDM Repositories into the current MDM Repository.

The steps to import one or multiple Processes are similar to those for any other data object in the MDM Repository
tree view. For detailed information on how to import Processes, see How to import data models.
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How to edit a Process

You can open a Process you have already created to check its settings and/or edit the defined parameters.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one Process exists.

To edit a Process:

1. In the MDM Repository tree view, expand the Processes node.

2. Right-click the Process you want to edit and select Edit from the contextual menu.

The editor opens on the selected Process in the workspace.

3. Modify the Process parameters as needed and then click the save icon on the toolbar or press Ctrl + S on
your keyboard to save your changes.

The selected Process is modified accordingly.

If you try to update a Process that has been modified by somebody else after you have retrieved it from the database, a
warning message displays to warn you that saving your modifications will overwrite the other user's changes.

How to copy/paste a Process

To avoid creating one or multiple Processes from scratch, you can copy an existing one in the MDM Repository
tree view and modify its parameters to have a new Process.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one Process exists.

To copy/paste a Process, do the following:

1. In the MDM Repository tree view, expand the Processes node.

2. Right-click the Process you want to duplicate and select Copy from the contextual menu.

3. Right-click the Processes node and select Paste from the contextual menu.

A dialog box displays prompting you to enter a name for the new Process.

4. Enter a name for the new Process and click OK to validate the changes and close the dialog box.

The new Process is listed under the Processes node in the MDM Repository tree view.

How to duplicate a Process

To avoid creating one or multiple Processes from scratch, you can duplicate an existing one in the MDM
Repository tree view and modify its parameters to have a new Process.
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Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one Process exists.

To duplicate a Process, do the following:

1. In the MDM Repository tree view, expand the Processes node.

2. Right-click the Process you want to duplicate and select Duplicate from the contextual menu.

A dialog box displays prompting you to enter a name for the new Process.

3. Enter a name for the new Process and click OK to validate the changes and close the dialog box.

The new Process is listed under the Processes node in the MDM Repository tree view.

You can also duplicate the data object if you drop it onto its parent node in the MDM Repository tree view.

How to delete a Process

You can delete any of the Processes you create through a simple right-click on the selected item.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one Process exists.

To delete a Process:

• In the MDM Repository tree view, expand the Processes node.

• Right-click the Process you want to delete and select Delete from the contextual menu.

A confirmation dialog box displays prompting you to confirm the deletion operation or to cancel it.

• Click OK to close the dialog box.

The selected Process is deleted from the MDM Repository tree view.

23.5.2. Triggers
Triggers are used to link the MDM Hub and the Data Models you define in the Studio. You can use Triggers to
call specific Processes under certain conditions.
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The Triggers you define in Talend Studio enable different services to be undertaken on specific data records.

Then, whenever a business user creates or modifies a data record from Talend MDM Web User Interface, for
example, a Trigger kicks in and the relevant event-based Process is undertaken by the Studio.

23.5.2.1. Creating a Trigger

The section below explains how to create a Trigger from scratch, however, Talend Studio enables you as well to automatically
generate Triggers based on the Jobs listed under the Job Designs node in the MDM Repository tree view. You can then do
any modifications in the generated Trigger, if required. For further information, see Generating a job-based Trigger.

Triggers are rules for transforming data. You can easily define Triggers on specific business entities/elements
from Talend Studio.

Parameters to set when defining Triggers include:

• selecting the business entity you want to Trigger the Process on,

• setting conditions on its content,

• deciding the execution mode,

• selecting the service to Trigger,

• setting the service parameters.

Prerequisite(s): You have already connected to the MDM server from Talend Studio.

For this example, a data model called Product has been created in Talend Studio. This data model has two business
entities: Product and ProductFamily. Several attributes have been created in the Product entity including Price
and Family. For further information about how to create a data model, see Setting up a data model.

A Process has been created and named Call_Job. One service has been defined in this Process to launch a validation
Job whenever a price of an item that belongs to a specific family has been changed through Talend MDM Web
User Interface. For further information about how to create such a Process, see How to create a Process to enrich
data on the fly.

What is left to be done now is to create a Trigger and configure it to launch the Call a Job from MDM Process
that will by turn launch the Talend price validation Job.

The sub-sections below explain in detail the procedures necessary to complete the creation of such a Trigger.

How to define the business entities on which to trigger a specific Process

To create a Trigger, you must first define the business entities in a selected data model on which you want to
trigger a specific Process. You also need to define the execution mode. To do this:

1. In the MDM Repository tree view, expand Event Management and then right-click Triggers and select
New from the contextual menu.

The [New Trigger] dialog box displays.
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2. Enter a name for the new Trigger and then click OK to close the dialog box.

An editor for the newly created Trigger opens in the workspace.

No spaces are allowed in the Trigger name. The OK button in the dialog box will be unavailable as long as there is
a space in the instance name.

3. In the Description field, enter a description to identify the Trigger being created.

In this example, the Trigger will launch a Process that will by turn launch the Job ValidatePriceChange_0.1.

4. Click the three-dot button next to the Entity field to open a dialog box where you can select the business
entity you want to trigger the Process on, Product in this example.

5. In the open dialog box, click the Data Models arrow and select the data model that holds the business entity
you want to run the Trigger on.

6. Select the business entity in the list and click Add to close the dialog box.

The selected business entity name displays in the Entity field.

7. Select the check box next to the execution mode you want to use:
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Select to...

Execute Synchronously immediately executes the triggered Process. In most cases, this implies that an open connection from
a source system will not be released until the data record has been pushed to the destination system
and the connection released by the destination system.

Execution Order: enter an integer value (equal to or greater than zero) in this field to specify the
order in which this Trigger will be executed if it is among multiple Triggers which are eligible for a
given event. The lower the value, the ealier the Trigger will be executed.

Bear in mind the following:

• If no value is specified for one trigger, its execution order will be defaulted to zero.

• If the same value is specified for two or more triggers eligible for a given event, the execution order
of those triggers will be random.

Deactivate To put the defined Trigger on hold.

How to select the service to Trigger and set the service parameters

After defining the business entity on which you want to trigger a specific Process, you need to select a service to
run on the defined business entity and set the service parameters.

To select a service to trigger and set the parameters, do the following:

1. In the Service area, click the Service JNDI Name arrow and select from the list the service you want to kick
off by the Trigger, callprocess in this example.

The services you can find in the list are pre configured MDM services. Click the  button to open a dialog box that
gives information about what the service does and its parameters.

2. In the Service Parameters area, define the parameters of the service you select in the list.

When you select the callprocess service, you just need to click the name of the Process you want to trigger,
Call_Job in this example.

The callprocess service is one of the most important available services on the list. When you select this service,
all Processes you already created in Talend Studio are listed in the Service Parameters area and you can call any
of them to transform and cross-reference master data. For more information on Processes, see Processes.

The parameters you need to define in the Service Parameters area differ according to the selected service in
the service list. Talend Studio simplifies this task for you by creating the underlying XML code for the proper
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execution of the trigger. When you select the callJob service, for example, you can access a list of all deployed
Jobs directly from the Trigger editor.

When you select the workflow service, for example, you can access a list of all deployed workflows directly from
the Trigger editor and this simplifies the process of creating a Trigger.

For certain services, you can switch between a graphical editor and a text editor upon clicking the Sheet and Source tabs
respectively. You can define the service parameters in either editors and any modifications you do in one of the two editors
will be reflected in the other.

How to set conditions for the Trigger

After selecting a pre-configured service to run on the selected business entity and defining the service parameters,
you must set conditions on the content of the selected business entity.
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To configure the conditions for this Trigger, do the following:

1.
In the Trigger xPath Expressions area, click the  button to add a new XPath line to the table where
you can set the first condition.

2. Click in the new line, and then click the three-dot button to open a dialog box where you can select the entity
and/or element on which you want to define conditions, Update/OperationType in this example.

3. Click in the Operator column and select an operator from the list.

4. In the Value column, enter a value for each of the selected business entities/elements, the value is usually the
name of the entity or element. Enter the UPDATE value in this example (case sensitive).

5. In the Condition Id column, enter a unique identifier for the condition you want to set on the selected business
entity/element, C1 in this example.

This first condition means that the Trigger will be executed only on the records in the Update entity when
there is an update operation. You may want to activate this Trigger only if the update operation is done on
the Price attribute. So, follow the same steps to define this second condition on the Item/path attribute using
the Price value and C2 condition.

6. In the Conditions area, enter the query you want to undertake on the data record using the condition IDs you
set earlier, C1 and C2 in this example.
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The Trigger created in the above procedure means that you want the Trigger to be executed on a record in
the Update entity only when the Price attribute has been changed.

When the conditions match the content of the data record, the selected service is triggered on the content of the data
records that match the set conditions.

7. Click the save icon on the toolbar or press Ctrl + S on your keyboard to save your changes.

This newly created trigger is listed under the Trigger node in the MDM Repository tree view.

23.5.2.2. Managing Triggers

An authorized user can also import/export, copy/paste and delete created Triggers from Talend Studio.

It is also possible to import and share MDM complete projects or only a data model or part of the data model from the
community web page, Talend Exchange. For further information, see Projects/objects on Talend Exchange.

How to export Triggers

From Talend Studio you can export one or multiple Triggers in order to exchange them between:

• two different MDM Servers or Repositories,

• two different Versions (deprecated) from the same/different MDM Servers or Repositories, for example.

The steps to export one or multiple Triggers are similar to those for any other data object in the MDM Repository
tree view. For detailed information on how to export data containers, see How to export data models.

How to import Triggers

From Talend Studio, you can import Triggers into the current MDM Repository that have been created in other
MDM Repositories or in different Versions (deprecated) of the current MDM Repository.

The steps to import one or multiple Triggers are similar to those for any other data object in the MDM Repository
tree view. For detailed information on how to import data containers, see How to import data models.

How to edit a Trigger

You can open a Trigger you have already created to check its settings and/or edit the defined parameters.

Prerequisite(s): You have already connected to the MDM server in Talend Studio. At least one Trigger exists.

To edit a Trigger:

1. In the MDM Repository tree view, expand the Trigger node.

2. Right-click the Trigger you want to edit and select Edit from the contextual menu.
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An editor opens on the selected Trigger in the workspace.

3. Modify the Trigger parameters as needed and then click the save icon on the toolbar or press Ctrl + S on
your keyboard to save your changes.

The selected Trigger is modified accordingly.

If you try to update a Trigger that has been modified by somebody else after you have retrieved it from the database, a
warning message displays to warn you that saving your modifications will overwrite the other user's changes.

How to copy/paste a Trigger

To avoid creating one or multiple Triggers from scratch, you can copy an existing one in the MDM Repository
tree view and modify its parameters to have a new Trigger.

Prerequisite(s): You have already connected to the MDM server in Talend Studio. At least one Trigger exists.

To copy/paste a Trigger, do the following:

1. In the MDM Repository tree view, expand the Trigger node.

2. Right-click the Trigger you want to copy and select Copy from the contextual menu.

3. Right-click the Trigger node and select Paste from the contextual menu.

A dialog box displays prompting you to enter a name for the new Trigger.

4. Enter a name for the new Trigger and click OK to validate the changes and close the dialog box.

The new Trigger is listed under the Trigger node in the MDM Repository tree view.

How to duplicate a Trigger

To avoid creating one or multiple Triggers from scratch, you can duplicate an existing one in the MDM Repository
tree view and modify its parameters to have a new Trigger.

Prerequisite(s): You have already connected to the MDM server in Talend Studio. At least one Trigger exists.

To duplicate a Trigger, do the following:

1. In the MDM Repository tree view, expand the Trigger node.

2. Right-click the Trigger you want to duplicate and select Duplicate from the contextual menu.
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A dialog box displays prompting you to enter a name for the new Trigger.

3. Enter a name for the new Trigger and click OK to validate the changes and close the dialog box.

The new Trigger is listed under the Trigger node in the MDM Repository tree view.

You can also duplicate the data object if you drop it onto its parent node in the MDM Repository tree view.

How to delete a Trigger

You can delete any of the Triggers you create through a simple right-click on the selected item.

Prerequisite(s): You have already connected to the MDM server in Talend Studio. At least one Trigger exists.

To delete a Trigger:

1. In the MDM Repository tree view, expand the Trigger node.

2. Right-click the Trigger you want to delete and select Delete from the contextual menu.

A confirmation dialog box displays prompting you to confirm the deletion operation or to cancel it.

3. Click OK to close the dialog box.

The selected Trigger is deleted from the MDM Repository tree view.

23.6. Job Designs
All data integration Jobs created in the Integration perspective of Talend Studio are shared with the MDM
perspective, they are automatically listed under the Job Designs node in the MDM Repository tree view. For
more information on the different tools integrated in the Studio, see A comprehensive set of tools.

Talend Studio enables you to deploy these data integration Jobs on the MDM server in .war or .zip files. Several
possibilities are available for this Job deployment:
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• through a manual import/export operation. For further information, see Deploying Jobs manually on the MDM
server.

• through automatic deployment from the Integration perspective. For further information, see How to deploy
Jobs from the Integration perspective.

• through automatic deployment from the MDM perspective. For further information, see How to deploy Jobs
from the MDM perspective.

The Job Designs node in the MDM Repository tree view groups all data integration Jobs under the Source Jobs
folder and all data integration Jobs that have been deployed on the MDM server under the Deployed Jobs folder.

You can also run a Job directly from the MDM perspective through a right-click on the Job in the Source Jobs
folder.

23.6.1. Deploying Jobs manually on the MDM server

An authorized user can export/import an archive for a data integration Job from the Integration perspective into
the MDM perspective. A job-based Process or a job-based Trigger can then be automatically generated from the
imported archive. For more information, see Generating a job-based Process and Generating a job-based Trigger.

Once the job-based Process is generated, it can be attached to a Trigger which will allow, when kicked off, the
data integration operation to be carried out on master data.

For more information on creating and managing Triggers, see Triggers.

23.6.1.1. How to export a Job

From the Integration perspective in Talend Studio, you can export one or more Jobs in order to import them into
the MDM perspective.

The export Job feature allows you to deploy and execute the Job on the MDM server. Exporting a Job adds to an
archive all the files required to execute the Job, including the .bat and .sh files along with the possible context-
parameter files or relative files.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one data integration
Job is created in the Integration perspective.

To export one or more data integration Jobs:

1. In the Integration perspective, expand the Job Designs node in the Repository tree view and browse to the
Job you want to export.

2. Right-click the Job and select Build Job from the contextual menu.

The [Build Job] dialog box displays.
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You can show/hide a tree view of all created Jobs directly from the [Build Job] dialog box by clicking the  and

the  buttons respectively. The Jobs you selected earlier in the Integration perspective display with selected check
boxes. This flexibility allows you to modify the selection of items to be exported directly from the dialog box without
having to close it and go back to the Integration perspective in Talend Studio.

3. In the To archive file field, browse to where you want to export the archive file.

4. In the Job Version area, select the version number of the Job you want to export if you have created more
than one version.

5. From the Select the build type list, select a type for the exported file.

6. Click Finish to validate your changes, complete the export operation and close the dialog box.

A file of the defined type holding the job information is created in the defined place.
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23.6.1.2. How to import a Job archive

Talend Studio enables you to import Jobs created in the Integration perspective into the MDM perspective. Once
imported, you can automatically generate Processes based on these Jobs. For more information on how to generate
a job-related action, see Generating a job-based Process.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. You have exported one or
more Jobs in .war files from the Integration perspective.

To import one or more Jobs into the MDM perspective, do the following:

1. In the MDM Repository tree view, right-click the Job Designs node and select Import Items from the
contextual menu.

The [Import Repository Items] dialog box displays.

2. In the dialog box, select the file including the exported Job.

3. Click Finish to import the Job and close the dialog box.

The imported Job displays under the Job Designs node in the MDM Repository tree view.

23.6.2. Deploying Jobs automatically on the MDM
server

Talend Studio provides additional deployment capabilities that enables an authorized user to deploy a Job from
the Integration or the MDM perspectives onto the MDM server directly without the need of the import/export
operation.

A job-based Process or a job-based Trigger can then be automatically generated from the deployed Job. For more
information, see Generating a job-based Process and Generating a job-based Trigger.

Once the job-based Process is generated, it can be attached to a Trigger which will allow, when kicked off, the
data integration operation to be carried out on master data.

For more information on creating and managing Triggers, see Triggers.

23.6.2.1. How to deploy Jobs from the Integration perspective

You can deploy a Job from the Integration perspective onto the MDM server directly without the need of the
import/export operation. The Jobs will be deployed on the MDM server to which you connect from within the
MDM Studio. For further information, see Launching Talend Studio and connecting to the MDM server.

As the Job Designs node shows up directly within the MDM Repository tree view, you can also deploy Jobs on the MDM
server from the MDM perspective. For further information, see How to deploy Jobs from the MDM perspective.

Prerequisite(s): You have already connected to an MDM server from Talend Studio. The server on which you
want to deploy the Job is up and running.

To deploy a Job on an MDM server, do the following:

1. From the Integration perspective and in the Repository tree view, expand the Job Designs node and then
right-click the Job you want to deploy.
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If you want to deploy multiple Jobs at the same time, press and hold down the Ctrl key while you click each of the
Jobs you want to deploy.

2. From the contextual menu, select Deploy to Talend MDM.

The [Deploy to Talend MDM] dialog box displays.

3. From the Talend MDM Server list, select the MDM server on which you want to deploy the Job.
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4. From the Export type list, select the export type, and then click Finish.

A confirmation message displays.

5. Click OK to close the message and the dialog box.

23.6.2.2. How to deploy Jobs from the MDM perspective

As data integration Jobs are shared between the Integration and the MDM perspectives, you can deploy any of
these Jobs on the MDM server directly from the MDM perspective.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one data integration
Job has been created in the Integration perspective.

To deploy a Job on a specific MDM server, do the following:

1. From the MDM perspective and in the MDM Repository tree view, expand the Job Designs node and then
right-click the Job you want to deploy.

If you want to deploy multiple Jobs at the same time, press and hold down the Ctrl key while you click each of the
Jobs you want to deploy.

2. From the contextual menu, select Deploy To....

The [Deploy to Talend MDM] dialog box displays.

3. If appropriate, select the server where you want to deploy the objects in the [Select server location definition]
window.

4. In the [Deploy to Talend MDM] window, specify the Settings for the deployment:

• Export type: Choose between Distributed (War) or Hosted (Zip).

Deploy the Job as a Zip file if you want it to be preloaded and run directly in the MDM Server, which
reduces latency. Deploy the Job as a War file if you want to embed it in a web service, for instance as a
way of deploying the Jobs across different servers for the purposes of load balancing.

• Leave the Context scripts check box selected.

5. Click Finish to deploy your objects.
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You can also undeploy a deployed Job from the MDM server from the MDM perspective. For further information,
see How to undeploy Jobs from the MDM perspective.

23.6.3. How to undeploy Jobs from the MDM
perspective

After Jobs are deployed, you are allowed to undeploy them so as to remove their information directly from the
MDM Server.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one data integration
Job has been created in the Integration perspective and deployed on the MDM server.

To undeploy a Job from the MDM perspective, do the following:

1. From the Integration perspective and in the MDM Repository tree view, expand the Job Designs node and
then right-click the deployed Job that you want to undeploy.

2. From the contextual menu, select Undeploy From....
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3. In the [Select a server location definition] dialog box that appears, select the server from which you want
to remove the Job information and click OK.

4. Finally, a dialog box shows that the Job is undeployed successfully. Click OK to finish the undeployment.

In the MDM Repository tree view, the server information will disappear from the Job icon automatically.

For more information about how to deploy Jobs to the MDM Server, see Deploying Jobs automatically on the
MDM server.

23.6.4.  Running Jobs

You can run a Job in Talend Studio either from the Integration perspective or directly from the MDM perspective.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one data integration
Job has been created in the Integration perspective and deployed on the MDM server.

To run a Job from the Integration perspective, do the following:
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1. From the Integration perspective and in the Repository tree view, expand the Job Designs node and then
right-click the Job you want to run.

2. From the contextual menu, select Run job.

The selected Job is executed and the execution results are shown in the Run console.

To run a Job from the MDM perspective, do the following:

1. From the MDM perspective and in the MDM Repository tree view, expand the Job Designs node and then
right-click the Job you want to run.

2. From the contextual menu, select Run job.

The selected Job is executed and the execution results are shown in the Run console.
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23.6.5. Generating a job-based Process

Talend Studio enables you to automatically generate Processes based on the deployed Jobs listed under the Job
Designs node in the MDM Repository tree view.

Once the job-based Process is generated, you can attach it to a Trigger which will initiate, when kicked off, the
data integration process defined in the Job.

For more information on creating and managing Processes, see Processes.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one data integration
Job is created in the Integration perspective and deployed on the MDM server.

To generate a Job-based Process:

1. In the MDM Repository tree view, expand the Job Designs node.

2. Right-click the Job on which you want to generate a Process and then select Generate Talend Job Caller
Process.

A dialog box displays.

The option selected by default is to send a complete "exchange" document to the MDM server. This document will
have the Update Report in addition to the item itself. However, if you want your Process to be compatible with older
MDM versions (backward compatibility), you must select the Only send an "item" document option.

3. Click OK to validate your schema choice and close the dialog box.

The generated Process holding the name of the generated Job displays under Event Management - Process
in the MDM Repository tree view.

4. If required, double-click the generated job-based Process to open an editor in the workspace that lists the
Process parameters.
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In the Parameters area, you can always switch between two views: Sheet and Source. The first enables you to add/modify
parameters using fields and rows in a table, while the second display the parameters in its XML format where you can add/
modify the parameters directly in the XML text.

The generated job-based process includes one basic step to call the Job and two additional steps as the following:

First step: to retrieve the complete XML record through the XSLT plug-in.

Second step: to decode XML in order to remove the escape function you used in the XSLT document and thus
send a real XML document to the Job.

Final step: to send the XML document to a Talend Job.

Usually, a Process can have only the step to call the Job, the calljob plug-in, if the complete XML record is not needed in
the task you want to accomplish. For further information, see How to create a Process to enrich data on the fly.

From this editor, you can modify any of the Process parameters, if required.
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23.6.6. Generating a job-based Trigger

Talend Studio enables you to automatically generate Triggers based on the Jobs listed under the Job Designs node
in the MDM Repository tree view.

Once the Job-based Trigger is generated, it will initiate, when kicked off, the data integration Process defined
in the Job.

For more information on creating and managing Triggers, see Triggers.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one Job is created
in the Integration perspective.

To generate a Job-based Trigger:

1. In the MDM Repository tree view, expand the Job Designs node.

2. Right-click the Job on which you want to generate a Trigger and then select Generate Talend Job Caller
Trigger.

The generated Trigger holding the name of the generated Job displays under Event Management - Trigger
in the MDM Repository tree view.

3. If required, double-click the generated job-based Trigger to open an editor in the workspace that lists the
Trigger parameters.

From this editor, you can modify any of the Trigger parameters, if required.
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Chapter 24. Advanced subjects
This chapter provides the information you need to carry out some advanced MDM procedures including using
XQuery instructions on master data and importing into your current Studio MDM projects/objects created by
Talend community and uploaded on Talend Exchange.
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24.1. Stored Procedures
The stored procedure feature in Talend Studio allows authorized users to create and store SQL queries or XQuery
instructions in order to query master data in the MDM Hub.

A stored procedure can be executed directly from Talend Studio or attached to a specific report in the Web User
Interface. For more information, see Talend MDM Web User Interface User Guide.

24.1.1.  Creating a stored procedure

Prerequisite(s): You have already connected to the MDM server from Talend Studio. You have the appropriate
user authorization to create a stored procedure.

To create a stored procedure, do the following:

1. In the MDM Repository tree view, right-click Stored Procedure and select New from the contextual menu.

The [New Stored Procedure] dialog box displays.

2. Enter a name for the new stored procedure and then click OK to close the dialog box.

3. In the MDM Repository tree view, expand the Stored Procedure node and click the new stored procedure
you created to open it in the workspace.
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4. In the Description field, enter a description for the stored procedure you want to create.

5. In the Procedure area, enter the syntax to address the data records contained in a specific entity.

The stored procedure must have a syntax that can be natively understood by the underlying storage of the data
stored in the MDM Hub. When an XML database is used, a XQuery query must be provided. When an RDBMS is
used to store MDM data, the query must use SQL and each result of the stored procedure has the following syntax:
<result><col0>val1</col1>...<colN>valn</colN></result> (where colN is the nth column in the SELECT clause).

6. Select the Refresh the cache after execution check box if you want to refresh the cache after the execution
of the stored procedure.

This is necessary as a stored procedure may perform an insert/update/replace action that is executed directly
at the database level. Because of the cache, the change may not be reflected.

7. Click the save icon on the toolbar or press Ctrl + S on your keyboard to save the procedure.

8. In the Execute Procedure section of the stored procedure editor, select the data container holding the data
records on which you want to execute the query, and then click Execute Procedure to run the procedure
you created.

In this example, it returns the Price and Description for records with a Price of greater than 10.

24.1.2.  Managing stored procedures

An authorized user can also import/export, copy/paste, duplicate and delete stored procedures from Talend Studio.
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24.1.2.1. How to export stored procedures

From Talend Studio you can export one or more stored procedures in order to exchange them between:

• two different MDM Servers or Repositories,

• two different Versions (deprecated) from the same/different MDM Servers or Repositories, for example.

The steps to export one or multiple stored procedures are similar to those for any other data object in the MDM
Repository tree view. For detailed information on how to export stored procedures, see How to export data models.

24.1.2.2. How to import stored procedures

From Talend Studio, you can import stored procedures created on other MDM servers, in different Versions
(deprecated) on the same MDM server, or in different MDM Repositories into the current MDM Repository.

The steps to import one or multiple stored procedures are similar to those for any other data object in the MDM
Repository tree view. For detailed information on how to import stored procedures, see How to import data
models.

24.1.2.3. How to edit a stored procedure

You can open a stored procedure you have already created to check its settings and/or edit the defined parameters.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one stored procedure
exists.

To edit a stored procedure, do the following:

1. In the MDM Repository tree view, expand the Stored Procedure node.

2. Double-click the stored procedure you want to edit and select Edit from the contextual menu.

An editor opens on the selected stored procedure in the workspace.

3. Modify the stored procedure settings as required and then click the save icon on the toolbar or press Ctrl +
S on your keyboard to save your changes.

The selected stored procedure is modified accordingly.

24.1.2.4. How to copy/paste a stored procedure

To avoid creating one or multiple stored procedures from scratch, you can copy an existing one in the MDM
Repository tree view and modify its settings to have a new procedure.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one stored procedure
exists.

To copy/paste a stored procedure, do the following:

1. In the MDM Repository tree view, expand the Stored Procedure node.

2. Right-click the procedure you want to duplicate and select Copy from the contextual menu.
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3. Right-click the Stored Procedure node and select Paste from the contextual menu.

A dialog box displays prompting you to enter a name for the new stored procedure.

4. Enter a name for the new stored procedure and click OK to validate the changes and close the dialog box.

The new stored procedure is listed under the Stored Procedure node in the MDM Repository tree view.

24.1.2.5. How to duplicate a stored procedure

To avoid creating one or multiple stored procedures from scratch, you can duplicate an existing one in the MDM
Repository tree view and modify its settings to have a new procedure.

Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one stored procedure
exists.

To duplicate a stored procedure, do the following:

1. In the MDM Repository tree view, expand the Stored Procedure node.

2. Right-click the procedure you want to duplicate and select Duplicate from the contextual menu.

A dialog box displays prompting you to enter a name for the new stored procedure.

3. Enter a name for the new stored procedure and click OK to validate the changes and close the dialog box.

The new stored procedure is listed under the Stored Procedure node in the MDM Repository tree view.

You can also duplicate the stored procedure if you drop it onto its parent node in the MDM Repository tree view.

24.1.2.6. How to delete a stored procedure

You can delete any of the stored procedures you create through a simple right-click on the selected item.
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Prerequisite(s): You have already connected to the MDM server from Talend Studio. At least one stored procedure
exists.

To delete a stored procedure, do the following:

1. In the MDM Repository tree view, expand the Stored Procedure node.

2. Right-click the procedure you want to delete and select Delete from the contextual menu.

A confirmation dialog box displays prompting you to confirm the deletion operation or to cancel it.

3. Click OK to close the dialog box.

The selected stored procedure is deleted from the MDM Repository tree view.

24.2. Projects/objects on Talend Exchange
Talend Studio enables you to import MDM projects/objects created by Talend community and uploaded on Talend
Exchange into your current Studio.

24.2.1.  Importing data projects from Talend Exchange

From Talend Studio you can share Talend community MDM projects by importing them from Talend Exchange
into your local MDM repository.

To import one or multiple MDM projects from Talend Exchange into your local MDM repository, do the
following:

1. In the MDM Repository tree view, right-click any of the data objects in the view and then select Import
Items from the contextual menu.

The [Import Repository items] dialog box displays.
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2. Select the Select archive file option and then click Import from Talend Exchange.

A dialog box displays and lists all the community MDM projects uploaded on Talend Exchange.

3. Select from the list the MDM project you want to import into your current Studio and then click OK.

All MDM data objects of the selected project are shown in the [Import Repository items] dialog box and
selected by default.

4. Click Finish to validate the import operation and close the dialog box.

All data objects in the selected MDM project are exported and listed under the corresponding nodes in the
MDM Repository tree view of your Studio.
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24.2.2.  Importing the xsd schema for a specific data
model from Talend Exchange

From Talend Studio you can share Talend community MDM data object (data model) or part of the data object
(simple or complex types that can be reused in a data model) through importing it from Talend Exchange into
your local MDM repository.

To import a data object or part of the data object from Talend Exchange into your local MDM repository, do
the following:

1. In the MDM Repository tree view, expand Data Model and then double-click any of the data models in
the list.

The data model editor displays.

2.
Click  to display the [Import xsd schema module] dialog box.
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3. Click Import xsd schema from exchange server.

The [Import from Talend Exchange modules] dialog box displays listing all data models uploaded on
Talend Exchange.

4. Select from the list the data model(s) you want to import into your current MDM Repository and then click
OK.

The imported xsd schema module(s) are listed in the [Import from Talend Exchange modules] dialog box.

If required, double-click the URL to open the selected data model page in Talend Exchange and view more
information about the data model.

If you want to delete any of the data models from the list, select the data model and click Delete xsd modules.

5. Click OK to validate the import operation and close the dialog box.
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Appendix A. GUI
This appendix describes the Graphical User Interface (GUI) of Talend Studio.
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A.1. Main window of Talend Studio
The main window of Talend Studio is the interface from which you manage different types of data integration,
master data management, and profiling processes.

The Talend Studio multi-panel window contains:

• a menu bar

• a toolbar

• a tree view area

• a workspace

• a Palette

• various configuration views organized using a tab system, for any of the elements in the data integration Job
designed in the workspace

• the Outline view and Code Viewer

• a detailed view

• a tab panel (specific to the Column Analysis editors)

• a cheat sheet view

The figure below shows an example of a Talend Studio main window, open on the Integration perspective, and
its panels and views.

Since Talend Studio operates a multi-perspective approach, certain interface elements may not be visible at all
times.

The various elements that make up the interface are described in the following sections.
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All the panels, tabs, and views described in this documentation are specific to Talend Studio. Some views listed in the [Show
View] dialog box are Eclipse-specific and are not described in this documentation. For information on these views, consult
the Eclipse online documentation at http://www.eclipse.org/documentation/.

A.2. Main window of the data explorer
The main window of the data explorer is the interface from which you manage your database.

The data explorer main window is divided into:

• menu bar,

• toolbar,

• Connections view,

• SQL History view

• SQL editor view,

• Database Detail view,

• Database Structure view.

The figure below illustrates an example of the data explorer main window and its components.

The following sections give detailed information about each of the above components.

http://www.eclipse.org/documentation/


Menu bar and Toolbar

930 Talend Open Studio for MDM User Guide

A.3. Menu bar and Toolbar
At the top of the Talend Studio main window, various menus and a quick access toolbar gather commonly-used
Talend features along with some Eclipse-specific functions.

A.3.1. Talend Studio menu bar
The Talend Studio menus include:

• some standard functions, such as Save, Print, Exit, which are used at the application level.

• some native Eclipse features which are be used mainly at the design workspace level, as well as specific Talend
Studio functions.

The following table below describes the menus and menu items available on the menu bar of Talend Studio.

The menus available on the menu bar may differ slightly according to the context in which you are working.

Menu Menu item Description

File Close Closes the current open view in the workspace.

Close All Closes all open views in the workspace.

Save Saves any changes done in the current open view.

Save as Saves any changes done without changing the current open view.

For more information, see Saving a Business Model

Save All Saves any changes done in all open views.

Print Unavailable option.

Switch project Closes the current session and launches another one to enable you to open a different
project in the Studio.

Edit project
properties

Opens a dialog box where you can customize the settings of the current project.

For more information, see Customizing project settings

Switch Workspace Connects to a different workspace.

For more information, see How to connect to a different workspace directory.

Import Opens a wizard that helps you to import different types of resources (files, items,
preferences, XML catalogs, and so on) from different sources.

Export Opens a wizard that helps you to export different types of resources (files, items,
preferences, breakpoints, XML catalogs, and so on) to different destinations.

Exit Closes the Studio main window.

Edit Undo Undoes the last action done in the workspace.

Redo Redoes the last action done in the workspace.

Cut Cuts selected object in the workspace.

Copy Copies the selected object in the workspace.

Paste Pastes the previously copied object in the workspace.

Delete Deletes the selected object in the workspace.

Select All Selects all components present in the workspace.

View Zoom In Obtains a larger image of the open Job.

Zoom Out Obtains a smaller image of the open Job.

Grid Displays a grid in the workspace. All items in the open Job are snapped to it.

Snap to Geometry Enables the Snap to Geometry feature.

Window Perspective Enables you to open any of the different perspectives shown in the list.
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Menu Menu item Description

Show View... Opens the [Show View] dialog box which enables you to display different views on
the Studio.

Maximize Active
View or Editor...

Maximizes the current perspective.

Preferences Opens the [Preferences] dialog box which enables you to set your preferences.

For more information about preferences, see Setting Talend Studio preferences

Help Welcome Opens a welcome page which has links to Talend documentation and other practical
sites.

Help Contents Opens the Eclipse help system documentation.

About Talend
Studio

Displays:

-the software version you are using

-detailed information on your software configuration that may be useful if there is a
problem

-detailed information about plug-in(s)

-detailed information about Talend Studio features.

Export logs Opens the [Export Logs] wizard that helps you to export all logs generated in the
Studio and system configuration information to an archive file.

A.3.2. Talend Studio toolbar

The toolbar contains icons that provide you with quick access to some of the commonly-used operations you can
perform from the Talend Studio main window.

The icons on the toolbar may differ slightly depending on the context in which you are working.

The following table describes the toolbar icons and their functions.

Name Icon Description

Save Saves modifications.

Save as Saves modifications under a new name.

Export items Exports repository items to an archive file, for deploying outside Talend Studio. If instead
you intend to import the exported element to a newer version of Talend Studio or another
computer, make sure the source files are included in the archive.

Import items Imports repository items from an archive file into your current Talend Studio. For more
information regarding the import/export items feature, see How to import items.

Find a specific job Displays the relevant dialog box that enables you to open any Job listed in the Repository
tree view.

Run job Executes the Job currently shown on the design space. For more information about job
execution, see Handling Job execution.

Import Demos Imports the Demo project including numerous samples of ready-to-use Jobs. This Demo
project can help you understand the functionalities of different Talend components.

For more information, see How to import the demo project.

Create Launches the relevant creation wizard. Through this menu, you can create any repository
item including Business models, Job Designs, contexts, routines and metadata entries.

Project settings Launches the [Project Settings] dialog box. From this dialog box, you can add a
description to the current Project and customize the Palette display. For more information,
see Customizing project settings.
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Name Icon Description

Detect and update all
jobs

Searches for all updates available for your Jobs.

Export Talend
projects

Launches the [Export Talend projects] wizard. For more information about project
export, see How to export a project.

A.4. Tree view
The following sections describe the tree view for the Integration, Mediation, Profiling, and MDM perspectives.

A.4.1. Repository tree view

The Repository tree view gathers all the technical items that can be used either to describe business models or
to design Jobs. It gives access to any item including Business Models, JobDesigns, as well as reusable routines
or documentation.

The Repository centralizes and stores all necessary elements for any Job design and business modeling contained
in a project.

The figure below illustrates the elements stored in the Repository.

The Refresh button  allows you to update the tree view with the last changes made.

The Activate filter button  allows you to open the filter settings view so as to configure the display of
the Repository view.

The Repository tree view stores all your data (Business, Jobs) and metadata (Routines, DB/File connections, any
meaningful Documentation and so on).

The table below describes the nodes in the Repository tree view.

Node Description

Business Models Under the Business Models folder, are grouped all business models of the project. Double-click
the name of the model to open it on the design workspace. For more information, see Designing a
Business Model.

Job Designs The Job Designs folder shows the tree view of the designed Jobs for the current project. Double-click
the name of the Job to open it on the design workspace. For more information, see Designing a Job.

Contexts The Contexts folder groups files holding the contextual variables that you want to reuse in various
Jobs, such as filepaths or DB connection details. For more information, see Using contexts and
variables.
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Node Description

Code The Code folder is a library that groups the routines available for this project and other pieces of code
that could be reused in the project. Click the relevant tree entry to expand the appropriate code piece.

For more information, see Designing a Job.

SQL Templates The SQL Templates folder groups all system SQL templates and gives the possibility to create user-
defined SQL templates. For more information, see Using SQL templates.

Metadata The Metadata folder bundles files holding redundant information you want to reuse in various Jobs,
such as schemas and property data. For more information, see Designing a Job.

Documentation The Documentation folder gathers all types of documents, of any format. This could be, for
example, specification documents or a description of technical format of a file. Double-click to
open the document in the relevant application. For more information, see How to generate HTML
documentation.

Recycle bin The Recycle bin groups all elements deleted from any folder in the Repository tree view.

The deleted elements are still present on your file system, in the recycle bin, until you
right-click the recycle bin icon and select Empty Recycle bin.

Expand the recycle bin to view any folders, subfolders or elements held within. You can
action an element directly from the recycle bin, restore it or delete it forever by clicking
right and selecting the desired action from the list.

A.4.2.  DQ Repository tree view
The DQ Repository tree view of the studio shows folders for data profiling analyses, patterns and metadata.

When expanding the Data profiling folder in the tree view, you display the created analyses (either executed or
not executed yet).

When expanding the Libraries folder in the tree view list, you display the list of the pre-defined patterns and SQL
patterns. Imported patterns and patterns created by you will also show under the Patterns folder.

Under Libraries as well, you have all created SQL business rules and all imported patterns from Talend
Exchange.

When expanding the Metadata folder in the tree view list, you display the list of all created DB connections.

The figure below shows an example of an expanded DQ Repository tree view.

You can use the local toolbar icons to manage the display of the DQ Repository tree view.
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A.4.3.  MDM Repository tree view

The MDM Repository tree view area shows nodes for manageable MDM objects including Data Models, Data
Containers, Processes, Views, and Triggers.

If you right-click any of these nodes or any instance under the node, you display a contextual menu with multiple
options.

The table below lists some of the available management options for MDM objects and instances.

Option Description

Export Items Exports one or multiple Data Containers from Talend Studio to a specified folder.

Import Items Imports one or multiple Data Containers from a specified folder to the current Talend Studio.

New Creates a new MDM object.

Create Category Creates a new folder.

Edit properties Edits the selected item.

Remove from Repository Moves the selected item to the Recycle bin.

Copy Copies the selected object(s).

Paste Pastes the selected object(s).

Duplicate Duplicates the selected object(s).

The figure below shows an MDM Repository tree view.

A.5. Workspace
The following sections describe the workspace for the Integration, Integration,  MDM, and Profiling
perspectives.
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A.5.1. Design workspace

In the Talend Studio's design workspace, both Business Models and Job Designs can be laid out.

For more information, see Opening or creating a Business Model and Creating a Job.

For both Business Models and Job Designs: active designs display in a easily accessible tab system above this
workspace.

For Job Designs only. Under this workspace, you can access several other tabs:

• the Designer tab. It opens by default when creating a Job. It displays the Job in a graphical mode.

• the Code tab. It enables you to visualize the code and highlights the possible language errors.

Warnings are indicated in yellow whereas errors are indicated in red.

A Palette is docked at the top of the design workspace to help you draw the model corresponding to your workflow
needs.

A.5.2. Profiling workspace

This area contains:

• nothing if no data quality item is open,

• the parameter values of the open item (an analysis, a database connection and so on).

When you open a data quality item in the DQ Repository tree view, a corresponding editor opens in the profiling
workspace.

You can use the local toolbar icons to manage the display of the workspace.

A.5.3.  MDM workspace

This area contains:
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• nothing if no MDM object is open,

• parameter values or information about the open MDM object.

When you double-click an MDM object in the MDM Repository tree view area, the relevant page opens in the
Talend Studio workspace. You can then browse items in the open MDM object or set parameters for the open
MDM object depending on its type.

For detailed information about actions you can perform on different MDM objects open in the workspace, see
Setting data governance rules, and Advanced subjects.

A.6. Palette
From the Palette, depending on whether you are designing a Job or modeling a Business Model, you can drop
technical components or shapes, branches and notes to the design workspace for Job design or business modeling.

Related topics:

• Designing a Business Model.

• Designing a Job.

• How to change the Palette layout and settings.

A.7. Configuration tabs
The configuration tabs are located in the lower half of the design workspace. Each tab opens a view that displays
the properties of the selected element in the design workspace. These properties can be edited to change or set the
parameters related to a particular component or to the Job as a whole.
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The Component, Run Jobs, Problems and Error Log views gather all information relative to the graphical
elements selected in the design workspace or the actual execution of the open Job.

The Modules and Scheduler tabs are located in the same tab system as the Component, Logs and Run Job tabs.
Both views are independent from the active or inactive Jobs open on the design workspace.

You can show more tabs in this tab system and directly open the corresponding view if you select Window > Show view
and then, in the open dialog box, expand any node and select the element you want to display.

The sections below describe the view of each of the configuration tabs.

View Description

Component This view details the parameters specific to each component of the Palette. To create a Job that will function,
you are required to fill out the necessary fields of this Component view for each component forming your Job.

For more information about the Component view, see How to define component properties.

Run Job This view obviously shows the current job execution. It becomes a log console at the end of an execution.

For details about job execution, see Handling Job execution.

Error Log This view is mainly used for Job execution errors. It shows the history of warnings or errors occurring during
job executions.

The log tab has also an informative function for a Java component operating progress, for example.

Error Log tab is hidden by default. As for any other view, go to Window > Show views, then expand General
node and select Error Log to display it on the tab system.

Modules This view shows if a module is necessary and required for the use of a referenced component. Checking the
Modules view helps to verify what modules you have or should have to run smoothly your Jobs.

For more information, see the Talend Installation and Upgrade Guide.

Scheduler This view enables you to schedule a task that will launch periodically the Job you select via the crontab program.

For more information, see How to launch a Job periodically (feature deprecated).

The Job view displays various information related to the open Job on the design workspace. This view has
the following tabs:

Main tab

This tab displays basic information about the Job opened on the design workspace, for example its name, author,
version number, etc. The information is read-only. To edit it you have to close your Job, right-click its label on
the Repository tree view and click Edit properties on the drop-down list.

Extra tab

This tab displays extra parameters including multi thread and implicit context loading features. For more
information, see How to use the features in the Extra tab

Stats/Log tab

This tab allows you to enable/disable the statistics and logs for the whole Job.

You can already enable these features for every single component of your Job by simply using and setting the
relevant components: tFlowMeterCatcher, tStatCatcher, tLogCatcher.

For more information about these components, see Talend Open Studio Components Reference Guide.

In addition, you can now set these features for the whole active Job (for all components of your Job) in one go,
without using the Catcher components mentioned above. This way, all components get tracked and logged in
the File or Database table according to your setting.

You can also save the current setting to Project Settings by clicking the  button.

For more details about the Stats & Logs automation, see How to automate the use of statistics & logs.

Job view

Version tab

This tab displays the different versions of the Job opened on the design workspace and their creation and
modification dates.
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View Description

Problems This view displays the messages linked to the icons docked at a components in case of problem, for example
when part of its setting is missing. Three types of icons/messages exist: Error, Warning and Infos.

For more information, see Warnings and error icons on components.

Job Hierarchy This view displays a tree folder showing the child Job(s) of the parent Job selected. To show this view, right-
click the parent Job in the Repository tree view and select Open Job Hierarchy on the drop-down list.

You can also show this view in the Window > Show view... combination where you can select Talend > Job
Hierarchy.

You can see Job Hierarchy only if you create a parent Job and one or more child Job(s) via the tRunJob
component. For more information about tRunJob, see Talend Open Studio Components Reference Guide.

Properties When inserting a shape in the design workspace, the Properties view offers a range of formatting tools to help
you customizing your business model and improve its readability.

A.8. Outline and code summary panel
This panel is located below the Repository tree view. It displays detailed information about the open Job or
Business Model in the design workspace.

The Information panel is composed of two tabs, Outline and Code Viewer, which provide information regarding
the displayed diagram (either Job or Business Model) and also the generated code.

For more information, see How to display the code or the outline of your Job.

A.9. Shortcuts and aliases
Below is a table gathering all keyboard shortcuts currently in use:

Shortcut Operation Context

F2 Shows Component settings view. Global application

F4 Shows Run Job view. Global application

F6 Runs current Job or shows Run Job view if no Job is open. Global application

Ctrl + F2 Shows Module view. Global application

Ctrl + F3 Shows Problems view. Global application

Ctrl + H Shows the Designer view of the current Job. Global application

Ctrl + G Shows the Code view of the current Job. Global application

Ctrl + R Restores the initial Repository view. From Repository view

Ctrl + Shift + F3 Synchronizes components javajet components. Global application

Ctrl + Shift + J Opens a Job. Global application (In Windows)

F7 Switches to Debug mode. From Run Job view

F5 Refreshes the Repository view. From Repository view

F8 Kills current Job. From Run Job view

F5 Refreshes Modules install status. From Modules view

Ctrl+L Execute SQL queries. Talend commands (in Windows)

Ctrl+Space bar Access global and user-defined variables. It can be error
messages or line number for example, depending on the
component selected.

From any component field in Job or
Component views
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A.10.  Detailed View
This view is located below the DQ Repository tree view of the studio. It displays detailed information about the
selected element in the tree view area.

The figure below shows an example of the detailed view of the selected DB connection.

You can use the local toolbar icons to manage the display of Detail View.

A.11. Tab panel of the analysis editors
This management tab panel is located at the bottom of the analysis editors. It contains a pair of tabs:

• Analysis Settings,

• Analysis Results.

The Analysis Settings tab lists the settings for the current analysis in the currenty editor.

The figure below is an example of the parameters of a column analysis.
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The Analysis Results tab lists:

• a summary of the executed analysis in the Analysis Summary view in which it specifies the connection, the
database and the table names for the current analysis,

• the results of the executed analysis, graphics and tables, in the Analysis Results view.

The figure below is an example of a column analysis results.
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In the Analysis Results view, you can:

• click the arrow located next to a column name to display the types of analyses done on that column,

• select a type of analysis to display the corresponding generated graphics and tables.

A.12.  Selecting a task from the studio
You have several ways to select a task from Talend Studio main window. You can, for example, use:

• a menu - submenu combination, or

• a toolbar icon, or

• a right-click list, or

• shortcut keys.

Example 1: To show a view in Talend Studio main window, either:

• use the Window > Show View... menu - submenu combination, or,

• use the Alt+Shift+Q, Q shortcut key.

Example 2: To execute a job, a route or an analysis, do one of the followings :

• use the run icon on the toolbar, or

• right-click the job, route or analysis you want to execute and select the run option from the contextual menu, or

• use the F6 shortcut key.
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A.13.  Connections view
The Connections view shows all the connection profiles that you have set up.

The figure below shows an example of the Connections view.

You can use the local toolbar icons to manage the display of the Connections view.

A.14.  SQL History view
This view shows below the Connections view area. Every statement that was successfully executed is logged in
the SQL History view.

The view shows the statement, the date and time when the statement was last executed, which connection was
used and how many times the statement has been executed. The SQL statements can be filtered, sorted, removed
and opened in or appended to the [SQL Editor].

The figure below shows an example of the SQL History view.

You can use the local toolbar icons to manage the display of SQL History View.

A.15.  SQL editor view
This area contains nothing if no [SQL Editor] is open. The [SQL Editor] provides the following features:
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• Executing queries using the CTRL-ENTER combination,

• Basic syntax coloring

• Basic Content Assist

• Overriding result limit

• Word wrapping (if enabled in preferences)

• Session/Catalog/Schema switching

• Loading/Saving SQL scripts

• Commit/Rollback buttons (if session is not in auto-commit mode)

• Display of query execution time of last run query

The figure below shows an example of the [SQL Editor] view.

The lower part of the [SQL Editor] view, the Messages area, detailed information about your data exploring
actions. When you execute a query in the SQL query editor, the Messages area displays the query results.

You can save all the queries you execute in the data explorer under Libraries > Source Files in the DQ Repository tree
view in the studio.

The figure below shows an example of the Messages area.

A.16. Database Structure view
Using the Database Structure view, you can explore multiple databases simultaneously.
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When you select a node in the Database Structure view, the corresponding detail is shown in the Database Detail
view. For more information, see Database Detail view. If the detailed view is not active, double-clicking the node
will bring the detail view to the front.

A.17. Database Detail view
Database Detail view shows detailed information for whatever node you double-click in the Database Structure
view. What is displayed will depend on the database type that you are using.

When you select a database node in the Database Structure view, the Database Detail view will show you the
connection information as shown in the figure below.

When you select a specific table in the database connection in the Database Structure view, the Database Detail
view shows you detail information about the selected table including Exported Keys and Imported Keys.
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The Imported Keys column shows how the table references other tables based on primary and foreign key
declarations.

The Exported Keys column shows how other tables reference the selected table based on primary and foreign
key declarations.
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Appendix B. System routines
This appendix gives you an overview of the most commonly used routines, along with use cases. In the Repository,
routines are grouped according to their type. Each type is detailed in a different section depending on whether it
relates to data integration, data quality or MDM tasks.

For more information on how to define routines, to access to system routines or to manage system or user routines,
see Managing routines.

Before starting any data integration processes, you need to be familiar with Talend Studio Graphical User Interface
(GUI). For more information, see GUI.
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B.1. Data integration and data services
system routines
This section describes how to access the data integration and data services system routines, and provides
descriptions and use cases of some of the most commonly-used routines.

B.1.1. Numeric Routines
Numeric routines allow you to return whole or decimal numbers in order to use them as settings in one or more
Job components. To add numeric IDs, for instance.

To access these routines, double click on the Numeric category, in the system folder. The Numeric category
contains several routines, notably sequence, random and decimal (convertImpliedDecimalFormat):

Routine Description Syntax

sequence Returns an incremental numeric ID. Numeric.sequence("Parameter name", start

value, increment value)

resetSequence Creates a sequence if it doesn't exist and
attributes a new start value.

Numeric.resetSequence (Sequence Identifier,

start value)

removeSequence Removes a sequence. Numeric.RemoveSequence (Sequence Identifier)

random Returns a random whole number between
the maximum and minimum values.

Numeric.random(minimum start value, maximum

end value)

convertImplied
DecimalFormat

Returns a decimal with the help of an
implicit decimal model.

Numeric.convertImpliedDecimalFormat

("Target Format", value to be converted)

The three routines sequence, resetSequence, and removeSequence are closely related.

• The sequence routine is used to create a sequence identifier, named s1 by default, in the Job. This sequence
identifier is global in the Job.

• The resetSequence routine can be used to initialize the value of the sequence identifier created by sequence
routine.

• The removeSequence routine is used to remove the sequence identifier from the global variable list in the Job.

B.1.1.1. How to create a Sequence

The sequence routine allows you to create automatically incremented IDs, using a tJava component:

The routine generates and increments the ID automatically:

B.1.1.2. How to convert an Implied Decimal

It is easy to use the convertImpliedDecimalFormat routine, along with a tJava component, for example:
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The routine automatically converts the value entered as a parameter according to the format of the implied decimal
provided:

B.1.2. Relational Routines

Relational routines allow you to check affirmations based on booleans.

To access these routines, double click on the Relational class under the system folder. The Relational class
contains several routines, notably:

Routine Description Syntax

ISNULL Checks if the variable provided is a null value. Relational.ISNULL(variable to be checked)

To check a Relational Routine, you can use the ISNULL routine, along with a tJava component, for example:

In this example, the test result is displayed in the Run view:

B.1.3. StringHandling Routines

The StringHandling routines allow you to carry out various kinds of operations and tests on alphanumeric
expressions, based on Java methods.

To access these routines, doubleclick on StringHandling under the system folder. The StringHandling class
includes the following routines:

Routine Description Syntax

ALPHA checks whether the expression is arranged in
alphabetical order. Returns the true or false
boolean accordingly.

StringHandling.ALPHA("string to be checked")

IS_ALPHA checks whether the expression contains
alphabetical characters only, or otherwise. Returns
the true or false boolean accordingly.

StringHandling.IS_ALPHA("string to be

checked")

CHANGE replaces an element of a string with a defined
replacement element and returns the new string.

StringHandling.CHANGE("string to be checked",

"string to be replaced","replacement string")

COUNT Returns the number of times a substring occurs
within a string.

StringHandling.COUNT("string to be checked",

"substring to be counted")

DOWNCASE converts all uppercase letters in an expression into
lowercase and returns the new string.

StringHandling.DOWNCASE("string to be

converted")

UPCASE converts all lowercase letters in an expression into
uppercase and returns the new string.

StringHandling.UPCASE("string to be

converted")
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Routine Description Syntax

DQUOTE encloses an expression in double quotation marks. StringHandling.DQUOTE("string to be enclosed

in double quotation marks")

INDEX returns the position of the first character in a
specified substring, within a whole string. If the
substring specified does not exist in the whole
string, the value - 1 is returned.

StringHandling.INDEX("string to be checked",

"substring specified")

LEFT specifies a substring which corresponds to the first
n characters in a string.

StringHandling.LEFT("string to be checked",

number of characters)

RIGHT specifies a substring which corresponds to the last
n characters in a string.

StringHandling.RIGHT("chaîne à vérifier",

number of characters)

LEN calculates the length of a string. StringHandling.LEN("string to check")

SPACE generates a string consisting of a specified number
of blank spaces.

StringHandling.SPACE(number of blank spaces

to be generated)

SQUOTE encloses an expression in single quotation marks. StringHandling.SQUOTE("string to be enclosed

in single quotation marks")

STR generates a particular character a the number of
times specified.

StringHandling.STR('character to be

generated', number of times)

TRIM deletes the spaces and tabs before the first non-
blank character in a string and after the last non-
blank character, then returns the new string.

StringHandling.TRIM("string to be checked")

BTRIM deletes all the spaces and tabs after the last non-
blank character in a string and returns the new
string.

StringHandling.BTRIM("string to be checked")

FTRIM deletes all the spaces and tabs preceding the first
non-blank character in a string.

StringHandling.FTRIM("string to be checked")

B.1.3.1. How to store a string in alphabetical order

It is easy to use the ALPHA routine along with a tJava component, to check whether a string is in alphabetical
order:

The check returns a boolean value.

B.1.3.2. How to check whether a string is alphabetical

It is easy to use the IS_ALPHA routine along with a tJava component, to check whether the string is alphabetical:

The check returns a boolean value.
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B.1.3.3. How to replace an element in a string

It is easy use the CHANGE routine along with a tJava component, to replace one element in a string with another:

The routine replaces the old element with the new element specified.

B.1.3.4. How to check the position of a specific character or
substring, within a string

The INDEX routine is easy to use along with a tJava component, to check whether a string contains a specified
character or substring:

The routine returns a whole number which indicates the position of the first character specified, or indeed the first
character of the substring specified. Otherwise, - 1 is returned if no occurrences are found.

B.1.3.5. How to calculate the length of a string

The LEN routine is easy to use, along with a tJava component, to check the length of a string:

The check returns a whole number which indicates the length of the chain, including spaces and blank characters.

B.1.3.6. How to delete blank characters

The FTRIM routine is easy to use, along with a tJava component, to delete blank characters from the start of
a chain:

The routine returns the string with the blank characters removed from the beginning.
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B.1.4. TalendDataGenerator Routines

The TalendDataGenerator routines are functions which allow you to generate sets of test data. They are based
on fictitious lists of first names, second names, addresses, towns and States provided by Talend. These routines
are generally used when developing Jobs, using a tRowGenerator, for example, to avoid using production or
company data.

To access the routines, double click on TalendDataGenerator under the system folder:

Routine Description Syntax

getFirstName returns a first name taken randomly from a
fictitious list.

TalendDataGenerator.getFirstName()

getLastName returns a random surname from a fictitious
list.

TalendDataGenerator.getLastName()

getUsStreet returns an address taken randomly from a
list of common American street names.

TalendDataGenerator.getUsStreet()

getUsCity returns the name of a town taken randomly
from a list of American towns.

TalendDataGenerator.getUsCity()

getUsState returns the name of a State taken randomly
from a list of American States.

TalendDataGenerator.getUsState()

getUsStateId returns an ID randomly taken from a list of
IDs attributed to American States.

TalendDataGenerator.getUsStateId()

No entry parameter is required as Talend provides the list of fictitious data.

You can customize the fictitious data by modifying the TalendGeneratorRoutines. For further information on
how to customize routines, see Customizing the system routines.

B.1.4.1. How to generate fictitious data

It is easy to use the different functions to generate data randomly. Using a tJava component, you can, for example,
create a list of fictitious client data using functions such as getFirstName, getLastName, getUSCity:

The set of data taken randomly from the list of fictitious data is displayed in the Run view:
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B.1.5. TalendDate Routines

The TalendDate routines allow you to carry out different kinds of operations and checks concerning the format
of Date expressions.

To access these routines, double click on TalendDate under the system folder:

Routine Description Syntax

addDate adds n days, n months, n hours, n minutes or n
seconds to a Java date and returns the new date.

The Date format is: "yyyy", "MM", "dd", "HH",
"mm", "ss" or "SSS".

TalendDate.addDate("String date initiale",

"format Date - eg.: yyyy/MM/dd", whole

n,"format of the part of the date to which n

is to be added - eg.:yyyy").

compareDate compares all or part of two dates according to
the format specified. Returns 0 if the dates are
identical, -1 if the first date is earlier and 1 if the
second date is earlier.

TalendDate.compareDate(Date date1, Date

date2, "format to be compared - eg.: yyyy-

MM-dd")

diffDate returns the difference between two dates in
terms of days, months or years according to the
comparison parameter specified.

TalendDate.diffDate(Date1(), Date2(),

"format of the part of the date to be compared

- eg.:yyyy")

diffDateFloor returns the difference between two dates by
floor in terms of years, months, days, hours,
minutes, seconds or milliseconds according to the
comparison parameter specified.

TalendDate.diffDateFloor(Date1(), Date2(),

"format of the part of the date to be compared

- eg.:MM")

formatDate returns a date string which corresponds to the
format specified.

TalendDate.formatDate("date format - eg.:

yyyy-MM-dd HH:mm:ss", Date() to be formatted

formatDateLocale changes a date into a date/hour string according to
the format used in the target country.

TalendDate.formatDateLocale ("format

target", java.util.Date date, "language or

country code")

getCurrentDate returns the current date. No entry parameter is
required.

TalendDate.getCurrentDate()

getDate returns the current date and hour in the format
specified (optional). This string can contain fixed
character strings or variables linked to the date. By
default, the string is returned in the format, DD/
MM/CCYY.

TalendDate.getDate("Format of the string -

ex: CCYY-MM-DD")

getFirstDayOfMonth changes the date of an event to the first day of the
current month and returns the new date.

TalendDate.getFirstDayMonth(Date)

getLastDayOfMonth changes the date of an event to the last day of the
current month and returns the new date.

TalendDate.getLastDayMonth(Date)

getPartOfDate returns part of a date according to the format
specified. This string can contain fixed character
strings or variables linked to the date.

TalendDate.getPartOfDate("String indicating

the part of the date to be retrieved, "String

in the format of the date to be parsed")

getRandomDate returns a random date, in the ISO format. TalendDate.getRandomDate("format date of the

character string", String minDate, String

maxDate)
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Routine Description Syntax

isDate checks whether the date string corresponds to the
format specified. Returns the boolean value true or
false according to the outcome.

TalendDate.isDate(Date() to be checked,

"format of the date to be checked - eg.: yyyy-

MM-dd HH:mm:ss")

parseDate changes a string into a Date. Returns a date in the
standard format.

TalendDate.parseDate("format date of the

string to be parsed", "string in the format

of the date to be parsed")

parseDateLocale parses a .string according to a specified format and
extracts the date. Returns the date according to the
local format specified.

TalendDate.parseDateLocale("date format of

the string to be parsed", "String in the

format of the date to be parsed", "code

corresponding to the country or language")

setDate modifies part of a date according to the part and
value of the date specified and the format specified.

TalendDate.setDate(Date, whole n, "format of

the part of the date to be modified -

eg.:yyyy")

B.1.5.1. How to format a Date

The formatDate routine is easy to use, along with a tJava component:

The current date is initialized according to the pattern specified by the new date() Java function and is displayed
in the Run view:

B.1.5.2. How to check a Date

It is easy to use the isDate routine, along with a tJava component to check if a date expression is in the format
specified:

A boolean is returned in the Run view:

B.1.5.3. How to compare Dates

It is easy to use the compareDate routine, along with a tJava component to compare two dates, for example to
check if the current date is identical to, earlier than or later than a specific date, according to the format specified.

In this example the current date is initialized by the Java function new date()and the value -1 is displayed in the
Run view to indicate that the current date is earlier than the second date.
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B.1.5.4. How to configure a Date

It is easy to use the setDate routine, along with a tJava component to change the year of the current date, for
example:

The current date, followed by the new date are displayed in the Run view:

B.1.5.5. How to parse a Date

It is easy to use the parseDate routine, along with a tJava component to change a date string from one format
into another Date format, for example:

The string is changed and returned in the Date format:

B.1.5.6. How to retrieve part of a Date

It is easy to use the getPartOfDate routine, along with a tJava component to retrieve part of a date, for example:

In this example, the day of month (DAY_OF_MONTH), the month (MONTH), the year (YEAR), the day number
of the year (DAY_OF_YEAR) and the day number of the week (DAY_OF_WEEK) are returned in the Run view.
All the returned data are numeric data types.
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In the Run view, the date string referring to the months (MONTH) starts with 0 and ends with 11: 0 corresponds to January,
11 corresponds to December.

B.1.5.7. How to format the Current Date

It is easy to use the getDate routine, along with a tJava component, to retrieve and format the current date
according to a specified format, for example:

The current date is returned in the specified format (optional):

B.1.6. TalendString Routines

The TalendString routines allow you to carry out various operations on alphanumerical expressions.

To access these routines, double click on TalendString under the system folder. The TalendString class contains
the following routines:

Routine Description Syntax

replaceSpecialCharForXML returns a string from which the
special characters (eg.:: <, >, &...)
have been replaced by equivalent
XML characters.

TalendString.replaceSpecialCharForXML ("string

containing the special characters - eg.: Thelma

& Louise")

checkCDATAForXML identifies characters starting with
<![CDATA[ and ending with
]]> as pertaining to XML and
returns them without modification.
Transforms the strings not
identified as XML in a form
which is compatible with XML
and returns them.

TalendString.checkCDATAForXML("string to be

parsed")

talendTrim parses the entry string and removes
the filler characters from the start
and end of the string according to
the alignment value specified: -1
for the filler characters at the end
of the string, 1 for those at the

TalendString.talendTrim("string to be parsed",

"filler character to be removed", character

position)
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Routine Description Syntax

start of the string and 0 for both.
Returns the trimmed string.

removeAccents removes accents from a string
and returns the string without the
accents.

TalendString.removeAccents("String")

getAsciiRandomString generates a random string with a
specific number of characters.

TalendString.getAsciiRandomString (whole number

indicating the length of the string)

B.1.6.1. How to format an XML string

It is easy to run the replaceSpecialCharForXML routine along with a tJava component, to format a string for
XML:

In this example, the "&" character is replaced in order to make the string XML compatible:

B.1.6.2. How to trim a string

It is easy to use the talendTrim routine, along with a tJava component to remove the string padding characters
from the start and end of the string:

The star characters are removed from the start, then the end of the string and then finally from both ends:

B.1.6.3. How to remove accents from a string

It is easy to use the removeAccents routine, along with a tJava component, to replace the accented characters,
for example:

The accented characters are replaced with non-accented characters:
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B.2. Data quality system routines
This section describes how to access the data quality system routines, and provides descriptions and use cases of
some of the most commonly-used routines.

B.2.1.  Accessing data quality system routines

To access the TDQ system routines:

• In the Integration perspective of the studio, click on Code > Routines > system. The routines or functions
are classed according to their usage

You can customize system routines, create/edit user routines and libraries and call a routine from a Job.

B.2.2. Data quality system routines

Several types of TDQ system routines exists in Talend Studio. The sections below describe these routines.

B.2.2.1.  DataQuality routines

DataQuality routines are portions of code that parse and clean your data. You can then use them in the settings
of Data Quality components in a Talend Job.

To access these routines:

• In the Repository tree view of your Studio, expand Code > Routines > system and then double-click
DataQuality.

The table below gives a description of these routines:

Routine Description Syntax

getTitle Returns the extracted title based on a list
of provided titles.

DataQuality.getTitle

getNameWithoutTitle Returns the string without the title. DataQuality.getNameWithoutTitle

getNameWithoutSuffix Returns the string without the suffix. DataQuality.getNameWithoutSuffix

getLastName Returns only LastName value from the
string.

DataQuality.getLastName

getCleansedLastName Returns the string without the title and
suffix.

DataQuality.getCleansedLastName

isValidName Returns true/false if the string is a
valid/unvalid formed name respectively:
[Initial] Firstname [Initial] Lastname.

DataQuality.isValidName
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B.2.2.2.  DqStringHandling routines

DqStringHandling routines are portions of code that perform certain quality tasks on arrays of characters. You
can then use them in the settings of Data Quality components in a Talend Job.

To access these routines:

• In the Repository tree view of your Studio, expand Code > Routines > system and then double-click
DqStringHandling.

The table below gives a description of these routines:

Routine Description Syntax

containsOnlyInitials Returns true if the given string contains
only initials such as "A", "A.", "A.I." or
"A.I.D.S".

DqStringHandling.containsOnlyInitials

makeSafe Returns an empty string when the given
string is null.

DqStringHandling.makeSafe

safeTrim Returns the trimmed string or the empty
string when the string is null.

DqStringHandling.safeTrim

safeConcat (String str1,
String str2, char
separator)

Returns the concatenation of the trimmed
strings. The separator character is used
when none of the given strings is empty or
null.

DqStringHandling.safeConcat

safeConcat (char
separator, String...
strings)

Returns the concatenation of the trimmed
strings. The separator character is used
when none of the given strings is empty or
null.

DqStringHandling.safeConcat

validAscii Validates the ascii format or not. DqStringHandling.validAscii

Use case: handling strings using DqStringHandling routines

In this use case, a three-component Job uses several DqStringHandling routines concurrently to handle several
given strings.

In this Job, the three components are:

• tFixedFlowInput: this component provides the strings to be handled by the DqStringHandling routines you
select.

• tMap: this component transforms the given strings using the DqStringHandling routines you select.

• tLogRow: this component displays the execution result of this Job.

To replicate this use case, proceed as follows:

Dropping and linking the components together

1. Drop tFixedFlowInput, tMap and tLogRow from the Palette to the design workspace.
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2. Right-click tFixedFlowInput to open its contextual menu, select the Row > Main link then click tMap to
connect these two components.

3. Do the same to connect tMap to tLogRow using the Row > *New Output* (Main) link and name this link
in the dialog box that pops up when you click tLogRow to create this link. In this use case, name it out.

Configuring the first component

1. Double-click tFixedFlowInput to open its Component view.

2. Click the [...] button next to Edit schema to open the schema editor.

3. Click the [+] button four times to add four rows.
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4. Rename these four rows as, for example, Entity_string, str1, str2 and str3 and make sure that their type
isString.

If a type is not String, click it and select String from the drop-down list that appears accordingly.

5. Click OK to validate these changes and thus close this schema editor.

6. In the Mode area of the Component view, select Use Inline Content (delimited file) to display the Content
field.

7. In the Content field, type in four strings corresponding to the number of rows you have defined in the
component schema and separate them using the field separator that is displayed in the Field Separator field.
By default, the field separator is ; and you can customize it if need be; the strings entered in this use case
are  U.S.A. (a space is typed in front of the U letter which will be trimmed by the routine to be used), Global,
Business, Services.

Thus the strings all together entered here read: U.S.A.;Global;Business;Services.

Configuring the tMap component

1. Double-click tMap to open the Map editor.

2. On the right side of the lower part of the editor, click the [+] button to add 8 rows and rename them
with: Entity_string, contains_only_initials, safe_trim, contains_only_initials_after_trim, str1, str2, str3,
safe_concat.
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These rows correspond to the original input data or the data to be handled by the DqStringHandling routines.

3. In this table, click, in the Type column, the contains_only_initials and the contains_only_initials_after_trim
rows respectively and select Boolean from the drop-down list for each of them.

On the upper part of this editor, these new rows have been added to the output table on the right side
automatically.

4. From the row1 input table on the left side to the Expression column of the output table on the right side,
drop the Entity_string, the str1, the str2 and the str3 rows respectively on the corresponding rows on the
output side.

5. In the Expression column, select the contains_only_initials row.

6. Press Ctrl+space to open the auto-completion list.

7. From this list, select DqStringHandling.containOnlyInitials.

8. Continue to enter the row of data to be handled by this selected routine between the parentheses to replace
the default one. In this use case, this row is row1.Entity_string.

Thus the entered expression reads as the following:
Handling.containsOnlyInitials(row1.Entity_string).

9. Do the same to complete the rest of the rows in the Expression column using the corresponding
DqStringHandling routines to each row. Then these row expressions read as follows:

• DqStringHandling.safeTrim(row1.Entity_string) for the safe_trim row;

• DqStringHandling.containsOnlyInitials;

(DqStringHandling.safeTrim(row1.Entity_string) ) for the contains_only_initials_after_trim
row;

• DqStringHandling.safeConcat(' ', row1.Entity_string , row1.str1, row1.str2 ,

row1.str3) for the safe_concat row.

As is presented in this use case, different DqStringHandling routines can be combined in one expression to produce
an advanced result.

10. Click OK to validate these changes and accept the propagation prompted by the dialog box that pops up.

Finalizing and executing the Job

1. Double-click tLogRow to open its Component view.



Data quality system routines

Talend Open Studio for MDM User Guide 963

2. Select Vertical (each row is a key/value list).

3. Press F6 to run this Job.

The execution result is displayed in the console of the Run view.

From the result, you can see that the contains_only_initials row outputs false because there is a space in front of
U.S.A. while the contains_only_initials_after_trim presents true because this space is trimmed; the safe_trim row
presents U.S.A. with the space trimmed and the safe_concat row outputs U.S.A. Global Business Services.

B.2.2.3.  DQTechnical routines

DQTechnical routines are portions of code that perform advanced String manipulation. You can then use them
in the settings of Data Quality components in a Talend Job.

To access these routines:

• In the Repository tree view of your Studio, expand Code > Routines > DQTechnical and then double-click
DqStringHandling.
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The table below gives a description of these routines:

Routine Description Syntax

extractTitle Returns the extracted title based on a list
of provided titles.

DQTechnical.extractTitle

removeTitle Returns the string without the title. DQTechnical.removeTitle

extractLastName Returns the string without the last name. DQTechnical.extractLastName

removeNameSuffix Returns the string without the suffix. DQTechnical.removeNameSuffix

isNameStringValid Returns true or false if the string is a valid
formed name: [Initial] Firstname [Initial]
Lastname.

DQTechnical.isNameStringValid

validAscii Validates the ascii format or not. DQTechnical.extractTitle

B.3. MDM system routines
This section describes how to access the MDM system routines, and provides descriptions and use cases of some
of the most commonly-used routines.

B.3.1.  Accessing/managing MDM system routines

To access the MDM system routines, click Code > Routines > system in the Integration perspective of Talend
Studio.

You can customize system routines, create/edit user routines and libraries and call a routine from a Job. For more
detailed information, see Managing routines.

B.3.2.  MDM Routines

The table below lists some useful MDM routines including those for mangling Foreign Keys. In MDM, you usually
need to mangle foreign keys to accommodate to compound keys.

To access these routines, double-click MDM in the system folder in the Integration perspective. The MDM
category contains several routines including getFK and createFK:

Routine Description Syntax

getFK Returns one of the FK components by
position in a mangled FK.

MDM.getFK (FKs,0)

createFK Returns the FK string by a single key
(String singleKey).

MDM.createFK("0")

createFK Returns the Fk string by a key list
(String[] keys).

MDM.createFK ({"0","1"})

getRepeatingElement Gets repeating element in xmlString
according to the xpath & position.

MDM.getRepeatingElement

hasRepeatingElement Checks repeating elements in xmlString
according to xpath & text;

MDM.hasRepeatingElement
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Routine Description Syntax

listRepeatingElement Lists repeating elements in xmlString
according to xpath & delimiter.

MDM.listRepeatingElement

addRepeatingElement Adds repeating elements in xmlString
according to xpath & text.

MDM.addRepeatingElement

createReturnMessage Generates an <error code="X">msg</
error> fragment.

MDM.createReturnMessage {example}

genErrMsg("test message",0)

setLanguageVariant Adds or updates an ISO variant to the
multilingual text value.

MDM.setLanguageVariant

For example:

setLanguageVariant("EN","abc","[EN:ab]

[FR:ab_fr]"),

which will update the EN variant to be "abc". The output
message will be [EN:abc][FR:ab_fr].

setLanguageVariant Adds or updates an ISO variant to the
multilingual text value with the default
ISO and the sort option for the output
message.

If the sort option is set to "true", the
message will be output in alphabetical
order.

MDM.setLanguageVariant

For example:

setLanguageVariant("FR","ab_fr","ab","EN",

true), which will add the FR variant "ab_fr". The output
message will be [EN:ab][FR:ab_fr].

getLanguageVariant Gets an ISO value from a multilingual
text value with the default ISO fallback.

If the ISO value requested is not found,
the default ISO value will be returned.

MDM.getLanguageVariant

For example:

getLanguageVariant("DE","EN","[EN:ab]

[FR:ab_fr]"), which will return the default EN value
"ab" because the DE value requested is not found.

getLanguageVariant Gets an ISO value from a multilingual
text value.

If the ISO value requested is not found,
the null value will be returned.

MDM.getLanguageVariant

For example:

getLanguageVariant("FR","[EN:ab]

[FR:ab_fr]"), which will return the requested FR value
"ab_fr".

getNodeList Gets a nodelist from an xPath. MDM.getNodeList

parse Parses the XML. MDM.parse

nodeToString Generates an XML string from a node
with or without the XML declaration.

MDM.nodeToString

For more information about the examples of the setLanguageVariant and getLanguageVariant routines, see
How to handle ISO variants or get an ISO value from a multilingual text.

B.3.2.1.  How to return one component of a mangled foreign key

The getFK routine allows you to return one component of a mangled foreign key using tMap, for example:
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You must use the getFK MDM routine in the lookup table in the Map Editor. Using the getFK routine in the
editor, you can add/remove/update the foreign key components. In the above capture, the routine helps you to
return the name component in the mangled foreign key.

You must do the same in a reversed case and use the createFK routine to return the foreign key string by a single
key.

B.3.2.2. How to handle ISO variants or get an ISO value from a
multilingual text

The setLanguageVariant routine allows you to add, update or remove ISO variants in a multilingual text value,
while the getLanguageVariant routine allows you to get the value of an ISO variant from a multilingual text value.

To better illustrate how to use the setLanguageVariant and getLanguageVariant routines, this section describes
some routine examples with different parameter settings. Note that the examples are not exhaustive.

For more information about those routines, see  MDM Routines.

The following table lists the examples which set different parameters for the routines and explains what the result
will be.

Example Description

setLanguageVariant("FR","Bonjour","Hello") The setLanguageVariant routine may contain three parameters. In
this case, the first parameter indicates an ISO variant, and the second
parameter indicates its value. The last parameter shows the original
multilingual text or the value of the default ISO variant. Note that the
default ISO variant is "EN".

If the ISO variant does not appear in the original multilingual text, the
ISO variant and its value will be added to the text. Otherwise, the old
value of the ISO variant will be updated with the new one, without
modifying the other ISO variants.

After this routine example is called, the output message will be
[EN:Hello][FR:Bonjour].
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Example Description

setLanguageVariant("EN","Hello

world!","[EN:Hello][FR:Bonjour]")

Because the ISO variant EN already appears in the original multilingual
text, its old value "Hello" will be updated with the new value "Hello
world!".

After this routine example is called, the output message will be
[EN:Hello world!][FR:Bonjour].

setLanguageVariant("EN","","[EN:Hello]

[FR:Bonjour]")

If you leave second parameter empty, the ISO variant will be removed.

After this routine example is called, the output message will be
[FR:Bonjour].

setLanguageVariant("FR","Bonjour","Hello","EN",

true)

The setLanguageVariant routine may contain five parameters. In
this case, the first parameter indicates an ISO variant, and the second
parameter indicates its value. The third parameter indicates the original
multilingual text or the value of the default ISO variant. The fourth
parameter is the default ISO variant. The last parameter indicates
whether the message will be sorted and output in alphabetical order.

If the ISO variant does not appear in the original multilingual text, the
ISO variant and its value will be added to the text. Otherwise, the old
value of the ISO variant will be updated with the new one, without
modifying the other ISO variants.

After this routine example is called, the output message will be
[EN:Hello][FR:Bonjour].

setLanguageVariant("FR", "Ceci est mon premier

produit","[EN:This is my first product]

[FR:Bonjour]","EN", false)

Because the ISO variant "FR" already appears in the multilingual text,
the old value "Bonjour" will be replaced with the new value "Ceci
est mon premier produit". Besides, the sort option is set to
false, so the message will not be sorted.

After this routine example is called, the output message will be
[EN:This is my first product][FR:Ceci est mon premier

produit].

setLanguageVariant("DE","Hallo","[EN:Hello]

[FR:Bonjour]","EN",true)

Because the ISO variant "DE" does not appear in the multilingual text,
the variant and its value will be added. Besides, the sort option is set to
true, so the message will be sorted and output in alphabetical order.

After this routine example is called, the output message will be
[DE:Hallo][EN:Hello][FR:Bonjour].

getLanguageVariant("EN","[EN:Hello world!]

[FR:Bonjour]")

The getLanguageVariant routine may contain two parameters. In this
case, the first parameter indicates the ISO variant whose value will be
fetched. The second parameter shows the multilingual text.

If the specified ISO variant does not appear in the multilingual text,
the null value will be returned.

The return value for this routine example is Hello world!.

getLanguageVariant("DE","[EN:Hello]

[FR:Bonjour]")

Because the ISO variant "DE" does not appear in the multilingual text,
the return value for this routine example is null.

getLanguageVariant("DE","EN","[EN:Hello]

[FR:Bonjour]")

The getLanguageVariant routine may contain three parameters. In
this case, the first parameter indicates the ISO variant whose value will
be fetched. The second parameter indicates the default ISO variant.
The last parameter shows the multilingual text.

If the specified ISO variant does not appear in the multilingual text,
the value of the default ISO variant will be returned.

The return value for this routine example is Hello.
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Appendix C. SQL template writing rules
This chapter describes the rules applied for the creation of SQL templates. It aims to help users of SQL templates
in Talend Studio to understand and develop the SQL templates for more customized usage.

These rules provide details that you have to respect when writing the template statement, a comment line or the
different relevant syntaxes.

These rules helps to use the SQL code in specific use cases, such as to access the various parameters defined in
components.
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C.1. SQL statements
An SQL statement can be any valid SQL statement that the related JDBC is able to execute. The SQL template
code is a group of SQL statements. The basic rules to write an SQL statement in the SQL template editor are:

• An SQL statement must end with ;.

• An SQL statement can span lines. In this case, no line should be ended with ; except the last one.

C.2. Comment lines
A comment line starts with # or --. Any line that starts with # or -- will be ignored in code generating.

There is no exception to the lines in the middle part of a SQL statement or within the <%... %> syntax.

C.3. The <%...%> syntax
This syntax can span lines. The following list points out what you can do with this syntax and what you should
pay attention to.

• You can define new variables, use Java logical code like if, for and while, and also get parameter values.

For example, if you want to get the FILE_Name parameter, use the code as follows:

<%
String filename = __FILE_NAME__;
%>

• This syntax cannot be used within an SQL statement. In other words, it should be used between two separated
SQL statements.

For example, the syntax in the following code is valid.

#sql sentence
DROP TABLE temp_0;
<%
#loop
for(int i=1; i<10; i++){
%>
#sql sentence
DROP TABLE temp_<%=i %>;
<%
}
%>
#sql sentence
DROP TABLE temp_10;

In this example, the syntax is used between two separated SQL templates: DROP TABLE temp_0; and DROP TABLE
temp_<%=i%>;.

The SQL statements are intended to remove several tables beginning from temp_0. The code between <% and
%> generate a sequence of number in loop to identify tables to be removed and close the loop after the number
generation.

• Within this syntax, the <%=...%> or </.../> syntax should not be used.
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<%=...%> and </.../> are also syntax intended for the SQL templates. The below sections describe related
information.

Parameters that the SQL templates can access with this syntax are simple. They are often used for connection purpose and
can be easily defined in components, such as TABLE_NAME, DB_VERSION, SCHEMA_TYPE, etc.

C.4. The <%=...%> syntax
This syntax cannot span lines and is used for SQL statement. The following list points out what you can do with
this syntax and what you should pay attention to.

• This syntax can be used to generate any variable value, and also the value of any existing parameter.

• No space char is allowed after <%=.

• Inside this syntax, the <%…%> or </…/> syntax should not be used.

The statement written in the below example is a valid one.

#sql sentence
DROP TABLE temp_<%=__TABLE_NAME__ %>;

The code is used to remove the table defined through an associated component.

For more information about what components are associated with the SQL templates, see Designing a Job.

For more information on the <%...%> syntax, see the previous section.

For more information on the </.../> syntax, see the following section.

Parameters that the SQL templates can access with this syntax are simple. They are often used for connection purpose and
can be easily defined in components, such as TABLE_NAME, DB_VERSION, SCHEMA_TYPE, etc.

C.5. The </.../> syntax
This syntax cannot span lines. The following list points out what you can do with this syntax and what you should
pay attention to.

• It can be used to generate the value of any existing parameter. The generated value should not be enclosed by
quotation marks.

• No space char is allowed after </ or before />.

• Inside this syntax, the <%…%> or <%=…%> syntax should not be used.

The statement written in the below example is a valid one.

#sql sentence
DROP TABLE temp_</TABLE_NAME/>;

The statement identifies the TABLE_NAME parameter and then removes the corresponding table.

For more information on the <%…%> and <%=…%> syntaxes, see the previous sections.

The following sections present more specific code used to access more complicated parameters.
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Parameters that the SQL templates can access with this syntax are simple. They are often used for connection purpose and
can be easily defined in components, such as TABLE_NAME, DB_VERSION, SCHEMA_TYPE, etc.

C.6. Code to access the component schema
elements
Component schema elements are presented on a schema column name list (delimited by a dot "."). These elements
are created and defined in components by users.

The below code composes an example to access some elements included in a component schema. In the following
example, the ELT_METADATA_SHEMA variable name is used to get the component schema.

<%
String query = "select ";
SCHEMA(__ELT_METADATA_SHEMA__);
for (int i=0; i < __ELT_METADATA_SHEMA__.length ; i++) {
query += (__ELT_METADATA_SHEMA__[i].name + ",");
}
query += " from " + __TABLE_NAME__;
%>
<%=query %>;

In this example, and according to what you want to do, the __ELT_METADATA_SHEMA__[i].name

code can be replaced by __ELT_METADATA_SHEMA__[i].dbType, __ELT_METADATA_SHEMA__ [i].isKey,
__ELT_METADATA_SHEMA__[i].length or __ELT_METADATA_SHEMA__[i].nullable to access the other fields
of the schema column.

The extract statement is SCHEMA(__ELT_METADATA_SHEMA__);. In this statement, ELT_METADATA_SHEMA is the
variable name representing the schema parameter to be extracted. The variable name used in the code is just an
example. You can change it to another variable name to represent the schema parameter you already defined.

Make sure that the name you give to the schema parameter does not conflict with any name of other parameters.

For more information on component schema, see Basic Settings tab.

C.7. Code to access the component matrix
properties
The component matrix properties are created and changed by users according to various data transformation
purposes. These properties are defined by tabular parameters, for example, the operation parameters or groupby
parameters that users can define through the tSQLTemplateAggregate component.

To access these tabular parameters that are naturally more flexible and complicated, two approaches are available:

• The </.../> approach:

</.../> is one of the syntax used by the SQL templates. This approach often needs hard coding for every
parameter to be extracted.

For example, a new parameter is created by user and is given the name NEW_PROPERTY. If you want to access
it by using </NEW_PROPERTY/>, the below code is needed.

else if (paramName.equals("NEW_PROPERTY")) {
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List<Map<String, String>> newPropertyTableValue = (List<Map<String, String>>)

ElementParameterParser.getObjectValue(node, "__NEW_PROPERTY__");

for (int ii = 0; ii <newPropertyTableValue.size(); ii++) {

Map<String, String> newPropertyMap =newPropertyTableValue.get(ii);

realValue += ...;//append generated codes

……

}

}

• The EXTRACT(__GROUPBY__); approach:

The below code shows the second way to access the tabular parameter (GROUPBY).

<%

String query = "insert into " + __TABLE_NAME__ + "(id, name, date_birth) select sum(id), name, date_birth from cust_teradata
group by";

EXTRACT(__GROUPBY__);

for (int i=0; i < __GROUPBY_LENGTH__ ; i++) {

query += (__GROUPBY_INPUT_COLUMN__[i] + " ");

}

%>

<%=query %>;

When coding the statements, respect the rules as follows:

• The extract statement must use EXTRACT(__GROUPBY__);. Upcase should be used and no space char is allowed.
This statement should be used between <% and %>.

• Use __GROUPBY_LENGTH__, in which the parameter name is followed by _LENGTH, to get the line number of the
tabular GROUPBY parameters you define in the Groupby area on a Component view. It can be used between
<% and %> or <%= and %>.

• Use code like __GROUPBY_INPUT_COLUMN__[i] to extract the parameter values. This can be used between
<% and %> or between <%= and %>.

• In order to access the parameter correctly, do not use the identical name prefix for several parameters.
For example in the component, avoid to define two parameters with the names PARAMETER_NAME and
PARAMETER_NAME_2, as the same prefix in the names causes erroneous code generation.
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Appendix D.  Regular expressions on SQL
Server
This appendix describes in detail how to create a regular expression function on SQL Server databases.
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D.1.  Main concept
The regular expression function is not built into all different databases environments. This is why you need, when
using some databases, to create a User-Defined Function (UDF) to extend the functionality of the database server.

For example, the following databases natively support regular expressions: MySQL, PostgreSQL, Oracle 10g,
Ingres, etc., while Microsoft SQL server does not.

After you create the regular expression function, you should use the studio to declare that function in a specific
database before being able to use regular expressions on analyzed columns.

For more information on how to declare a regular expression function in the studio, see How to define a query
template for a specific database and How to declare a User-Defined Function in a specific database.

D.2.  How to create a regular expression
function on SQL Server
Prerequisite(s):You should have Visual Studio 2005 or 2008. The Visual Studio main window is open.

To create a regular expression function in SQL Server, follow the steps outlined in the sections below.

D.2.1.  How to create a project in Visual Studio

You must start by creating an SQL server database project. To do that:

1. On the menu bar, select File > New > Project to open the [New Project] window.

2. In the Project types tree view, expand Visual C# and select Database.



How to deploy the regular expression function to the SQL server

Talend Open Studio for MDM User Guide 977

3. In the Templates area to the right, select SQL Server Project and then enter a name in the Name field for
the project you want to create, UDF function in this example.

4. Click OK to validate your changes and close the window.

The [Add Database Reference] dialog box is displayed.

5. From the Available References list, select the database in which you want to create the project and then
click OK to close the dialog box.

If the database you want to create the project in is not listed, you can add it to the Available Reference list through
the Add New Reference tab.

The project is created and listed in the Data Explorer panel to the right of the Visual Studio main window.

D.2.2. How to deploy the regular expression function
to the SQL server

You need now to add the new regular expression function to the created project, and then deploy the function to
the SQl server. To do that:

1. In the project list in the Solution Explorer panel, expand the node of the project you created and right-click
the Test Scripts node.

2. From the contextual menu, select Add > New Item....
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The [Add New Item] dialog box is displayed.

3. From the Templates list, select Class and then in the Name field, enter a name to the user-defined function
you want to add to the project, RegExMatch in this example.

The added function is listed under the created project node in the Solution Explorer panel to the right.

4. Click Add to validate your changes and close the dialog box.
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5. In the code space to the left, enter the instructions corresponding to the regular expression function you
already added to the created project.

Below is the code for the regular expression function we use in this example.

Using System;
Using Microsoft.SqlServer.Server;
Using System.Text.RegularExpressions;
Public partial class RegExBase
{
     [SqlFunction(IsDeterministic = true, IsPrecise = true)]
     Public static int RegExMatch( string matchString , string pattern)
     {
            Regex r1 = new Regex(pattern.TrimEnd(null));
            if (r1.Match(matchString.TrimEnd(null)).Success == true) 
            {
                 return 1 ;
            }
            else
            {
                 return 0 ;
            }
Using
     }
};

6. Press Ctrl+S to save your changes and then on the menu bar, click Build and in the contextual menu select
the corresponding item to build the project you created, Build UDF function in this example.

The lower pane of the window displays a message to confirm that the "build" operation was successful or not.
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7. On the menu bar, click Build and in the contextual menu select the corresponding item to deploy the project
you created, Deploy UDF function in this example.

The lower pane of the window displays a message to confirm that the "deploy" operation was successful,
or not.

If required:

1. launch SQL Server and check if the created function exists in the function list,

2. check if the function works well, for more information, see How to test the created function via the
SQL Server editor.

D.2.3. How to set up the studio

Before being able to use regular expressions on analyzed columns in a database, you must first declare the created
regular expression function, RegExMatch in this example, in the specified database via the studio. To do that:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Expand System Indicators > Pattern Matching.

3. Double-click Regular Expression Matching, or right-click it and select Open from the contextual menu.

The corresponding view displays the indicator metadata and its definition.
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You need now to add to the list of databases the database for which you want to define a query template. This
query template will compute the regular expression matching.

4. Click the [+] button at the bottom of the Indicator Definition view to add a field for the new template.

5. In the new field, click the arrow and select the database for which you want to define the template, Microsoft
SQL Server.

6. Copy the indicator definition of any of the other databases.

7. Click the Edit... button next to the new field.

The [Edit expression] dialog box is displayed.
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8. Paste the indicator definition (template) in the Expression box and then modify the text after WHEN in order
to adapt the template to the selected database.

9. Click OK to proceed to the next step. The new template is displayed in the field.

10. Click the save icon on top of the editor to save your changes.

For more detailed information on how to declare a regular expression function in the studio, see How to define a
query template for a specific database and How to declare a User-Defined Function in a specific database.

D.3. How to test the created function via the
SQL Server editor
• To test the created function via the SQL server editor, copy the below code and execute it:

create table Contacts (
FirstName nvarchar(30),
 LastName nvarchar(30),
EmailAddress nvarchar(30) CHECK
 (dbo.RegExMatch('[a-zA-Z0-9_\-]+@([a-zA-Z0-9_\-]+\.)
 +(com|org|edu|nz)',
EmailAddress)=1),
USPhoneNo nvarchar(30) CHECK
 (dbo.RegExMatch('\([1-9][0-9][0-9]\) [0-9][0-9][0-9]
\-[0-9][0-9][0-9][0-9]',
UsPhoneNo)=1))

INSERT INTO [talend].[dbo].[Contacts]
                        ([FirstName]
                       , [LastName]
                       , [EmailAddress]
                       , [USPhoneNo])
       VALUES
                     ('Hallam'
                    , 'Amine'
                    , 'mhallam@talend.com'
                    , '0129-2090-1092')
                    , ( 'encoremoi'
                     , ‘nimportequoi'
                     , 'amine@zichji.org'
                     , '(122) 190-9090')
GO
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• To search for the expression that match, use the following code:

SELECT [FirstName]
     , [LastName]
     , [EmailAddress]
     , [USPhoneNo]
  FROM [talend].[dbo].[Contacts]
  where [talend].[dbo].RegExMatch([EmailAddress],
'[a-zA-Z0-9_\-]+@([a-zA-Z0-9_\-]+\.)+(com|org|edu|nz|au)')
= 1 

• To search for the expression that do not match, use the following code:

SELECT [FirstName]
     , [LastName]
     , [EmailAddress]
     , [USPhoneNo]
  FROM [talend].[dbo].[Contacts]
  where [talend].[dbo].RegExMatch([EmailAddress],
'[a-zA-Z0-9_\-]+@([a-zA-Z0-9_\-]+\.)+(com|org|edu|nz|au)')
= 0 
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Appendix E. Theory into practice: Job
examples
This chapter aims at users of Talend Studio who seek real-life use cases to help them take full control over the
product. This chapter comes as a complement of Talend Open Studio Components Reference Guide.

This chapter provides some basic Job examples..



tMap Job example

986 Talend Open Studio for MDM User Guide

E.1. tMap Job example
To illustrate the way Talend Studio operates, find below a real-life example scenario. In this scenario, we will
load a MySQL table with a file, that gets transformed on the fly. Then in a further step, we will select the data
to be loaded using a dynamic filter.

Before actually starting the Job, let's inspect the input data and the expected output data.

E.1.1. Input data
Our input file, the data of which will be loaded into the database table, lists clients from all over the State of
California.

The file structure usually called Schema in Talend Studio includes the following columns:

• First name

• Last name

• Address

• City

E.1.2. Output data
We want to load into the database, California clients living in a couple of Counties only: Orange and Los Angeles
counties.

The table structure is slightly different, therefore the data expected to be loaded into the DB table should have
the following structure:

• Key (key, Type: Integer)

• Name (Type: String, max. length: 40)

• Address (Type: String, max.length: 40)

• County (Type: String, max. length:40)

In order to load this table, we will need to use the following mapping process:

The Key column is fed with an auto-incremented integer.

The Name column is filled out with a concatenation of first and last names.

The Address column data comes from the equivalent Address column of the input file, but supports a upper-case
transformation before the loading.

The County column is fed with the name of the County where the city is located using a reference file which will
help filtering Orange and Los Angeles counties' cities.

E.1.3. Reference data
As only Orange and Los Angeles counties data should be loaded into the database, we need to map cities of
California with their respective county, in order to filter only Orange and Los Angeles ones.
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To do so, we will use a reference file, listing cities that are located in Orange and Los Angeles counties such as:

City County

Agoura Hills Los Angeles

Alhambra Los Angeles

Aliso Viejo Orange

Anaheim Orange

Arcadia Los Angeles

The reference file in this Job is named LosAngelesandOrangeCounties.txt.

E.1.4. Translating the scenario into a Job

In order to implement this scenario, let's break down the Job into four steps:

1. Creation of the Job, configuration of the input file parameters, and reading of the input file,

2. Mapping of data and transformations,

3. Definition of the reference file parameters, relevant mapping using the tMap component, and selection of inner
join mode,

4. Redirection of the output into a MySQL table.

E.1.4.1. Step 1: Job creation, input definition, file reading

Launch Talend Studio, and create a local project or import the demo project if you are launching Talend Studio
for the first time. For more information, see Launching Talend Studio and Working with projects.

The main window of Talend Studio is divided into several areas:

• On the left-hand side: the Repository tree view that holds Jobs, Business Models, Metadata, shared Code,
Documentation and so on.

• In the center: the Editor (main Design area)

• At the bottom: Component and Job tabs

• On the right-hand side: the Palette of business or technical components depending on the software tool you
are using within Talend Studio.

To the left of the Studio, the Repository tree view that gives an access to:

• The Business Modeler: For more information, see Modeling a Business Model.

• The Job Designer: For details about this part, see Getting started with a basic Job.

• The Metadata Manager: For details about this part, see Managing Metadata.

• Contexts and routines: For details, see Using contexts and variables and Managing routines.

To create the Job, right-click Job Designs in the Repository tree view and select Create Job.

In the dialog box displaying then, only the first field (Name) is required. Type in California1 and click Finish.
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An empty Job then opens on the main window and the Palette of technical components (by default, to the right of
the Studio) comes up showing a dozen of component families such as: Databases, Files, Internet, Data Quality
and so on, hundreds of components are already available.

To read the file California_Clients, let's use the tFileInputDelimited component. This component can be found
in the File/Input group of the Palette. Click this component then click to the left of the design workspace to place
it on the design area.

Let's define now the reading properties for this component: File path, column delimiter, encoding... To do so, let's
use the Metadata Manager. This tool offers numerous wizards that will help us to configure parameters and allow
us to store these properties for a one-click re-use in all future Jobs we may need.

As our input file is a delimited flat file, let's select File Delimited on the right-click list of the Metadata folder in
the Repository tree view. Then select Create file delimited. A wizard dedicated to delimited file thus displays:

• At Step 1, only the Name field is required: simply type in California_clients and go to the next Step.

• At Step 2, select the input file (California_Clients.csv) via the Browse... button. Immediately an extract of the
file shows on the Preview, at the bottom of the screen so that you can check its content. Click Next.

• At Step 3, we will define the file parameters: file encoding, line and column delimiters... As our input file is
pretty standard, most default values are fine. The first line of our file is a header containing column names.
To retrieve automatically these names, click Set heading row as column names then click Refresh Preview.
And click Next to the last step.

• At Step 4, each column of the file is to be set. The wizard includes algorithms which guess types and length of
the column based on the file first data rows. The suggested data description (called schema in Talend Studio)
can be modified at any time. In this particular scenario, they can be used as is.

There you go, the California_clients metadata is complete!

We can now use it in our input component. Select the tFileInputDelimited you had dropped on the design
workspace earlier, and select the Component view at the bottom of the window.

Select the vertical tab Basic settings. In this tab, you'll find all technical properties required to let the component
work. Rather than setting each one of these properties, let's use the Metadata entry we just defined.

Select Repository as Property type in the list. A new field shows: Repository, click "..." button and select the
relevant Metadata entry on the list: California_clients. You can notice now that all parameters get automatically
filled out.
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At this stage, we will terminate our flow by simply sending the data read from this input file onto the standard
output (StdOut).

To do so, add a tLogRow component (from the Logs & Errors group).

To link both components, right-click the input component and select Row/Main. Then click the output component:
tLogRow.

This Job is now ready to be executed. To run it, select the Run tab on the bottom panel.

Enable the statistics by selecting the Statistics check box in the Advanced Settings vertical tab of the Run view,
then run the Job by clicking Run in the Basic Run tab.

The content of the input file display thus onto the console.

E.1.4.2. Step 2: Mapping and transformations

We will now enrich our Job to include on-the-fly transformations. To implement these transformation, we need
to add a tMap component to our Job. This component is multiple and can handle:

• multiple inputs and outputs

• search for reference (simple, cartesian product, first, last match...)

• join (inner, outer)

• transformations

• rejections
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• and more...

Remove the link that binds together the job's two components via a right-click the link, then Delete option. Then
place the tMap of the Processing component group in between before linking the input component to the tMap
as we did it previously.

Eventually to link the tMap to the standard output, right-click the tMap component, select Row/*New Output*
(Main) and click the tLogRow component. Type in out1 in the dialog box to implement the link. Logically, a
message box shows up (for the back-propagation of schemas), ignore it by clicking on No.

Now, double-click the tMap to access its interface.

To the left, you can see the schema (description) of your input file (row1). To the right, your output is for the
time being still empty (out1).

Drop the Firstname and Lastname columns to the right, onto the Name column as shown on the screen below.
Then drop the other columns Address and City to their respective line.

Then carry out the following transformations on each column:

• Change the Expression of the Name column to row1.Firstname + " " + row1.LastName. Concatenate the
Firstname column with the Lastname column following strictly this syntax (in Java), in order for the columns
to display together in one column.

• Change the Expression of the Address column to row1.Address.toUpperCase() which will thus change the
address case to upper case.

Then remove the Lastname column from the out1 table and increase the length of the remaining columns. To do
so, go to the Schema Editor located at the bottom of the tMap editor and proceed as follows:

1. Select the column to be removed from the schema, and click the cross icon.

2. Select the column of which you need increase the length size.

3. Type in the length size you intend in the length column. In this example, change the length of every remaining
column to 40.

As the first name and the last name of a client is concatenated, it is necessary to increase the length of the name column
in order to match the full name size.
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No transformation is made onto the City column. Click OK to validate the changes and close the Map editor
interface.

If you run your Job at this stage (via the Run view as we did it before), you'll notice the changes that you defined
are implemented.

For example, the addresses are displayed in upper case and the first names and last names are gathered together
in the same column.

E.1.4.3. Step 3: Reference file definition, re-mapping, inner join
mode selection

Define the Metadata corresponding to the LosAngelesandOrangeCounties.txt file just the way we did it previously
for California_clients file, using the wizard.

At Step1 of the wizard, name this metadata entry: LA_Orange_cities.

Then drop this newly created metadata to the top of the design area to create automatically a reading component
pointing to this metadata.

Then link this component to the tMap component.
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Double-click again on the tMap component to open its interface. Note that the reference input table (row2)
corresponding to the LA and Orange county file, shows to the left of the window, right under your main input
(row1).

Now let's define the join between the main flow and the reference flow. In this use case, the join is pretty basic
to define as the City column is present in both files and the data match perfectly. But even though this was not
the case, we could have carried out operations directly at this level to establish a link among the data (padding,
case change...)

To implement the join, drop the City column from your first input table onto the City column of your reference
table. A violet link then displays, to materialize this join.

Now, we are able to use the County column from the reference table in the output table (out1).
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Eventually, click the OK button to validate your changes, and run the new Job.

The following output should display on the console.

As you can notice, the last column is only filled out for Los Angeles and Orange counties' cities. For all other lines,
this column is empty. The reason for this is that by default, the tMap implements a left outer join mode. If you
want to filter your data to only display lines for which a match is found by the tMap, then open again the tMap,
click the tMap settings button and select the Inner Join in the Join Model list on the reference table (row2).

E.1.4.4. Step 4: Output to a MySQL table

Our Job works perfectly! To finalize it, let's direct the output flow to a MySQL table.

To do so, let's first create the Metadata describing the connection to the MySQL database. Double-click Metadata/
MySQL/DemoMySQL in the referential (on the condition that you imported the Demo project properly). This
opens the Metadata wizard.

On Step2 of the wizard, type in the relevant connection parameters. Check the validity of this connection by
clicking on the Check button. Eventually, validate your changes, by clicking on Finish.

Drop this metadata to the right of the design workspace, while maintaining the Ctrl key down, in order to create
automatically a tMysqlOutput component.

Remove the tLogRow component from your Job.

Reconnect the out1 output flow from the tMap to the new component tMysqlOutput (Right-click/Row/out1):
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On the Basic Settings tab of this component:

1. Type in LA_Orange_Clients in the Table field, in order to name your target table which will get created
on the fly.

2. Select the Drop table if exists and create option or on the Action on table field.

3. Click Edit Schema and click the Reset DB type button (DB button on the tool bar) in order to fill out
automatically the DB type if need be.

Run again the Job. The target table should be automatically created and filled with data in less a second!

In this scenario, we did use only four different components out of hundreds of components available in the Palette
and grouped according to different categories (databases, Web service, FTP and so on)!

And more components, this time created by the community, are also available on the community site
(talendforge.org).

For more information regarding the components, see Talend Open Studio Components Reference Guide.

E.2. Using the output stream feature
The following use case aims to show how to use the output stream feature in a number of components in order
to greatly improve the output performance.

In this scenario, a pre-defined csv file containing customer information is loaded in a database table. Then the
loaded data is selected using a tMap, and output to a local file and to the console using the output stream feature.

E.2.1. Input data

The input file, the data of which will be loaded into the database table, contains customer information of various
aspects.

The file structure usually called Schema in Talend Studio includes the following columns:

• id (Type: Integer)
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• CustomerName (Type: String)

• CustomerAge (Type: Integer)

• CustomerAddress (Type: String)

• CustomerCity (Type: String)

• RegisterTime (Type: Date)

E.2.2. Output data

The tMap component is used to select id, CustomerName and CustomerAge columns from the input data. Then
the selected data is output using the output stream feature.

Thus the expected output data should have the following structure:

• id (Type: Integer)

• CustomerName (Type: String)

• CustomerAge (Type: Integer)

All the three columns above come from the respective columns in the input data.

E.2.3.  Translating the scenario into a Job

In order to implement this scenario, break down the Job into four steps:

1. Create the Job, define the schema for the input data, and read the input file according to the defined schema.

2. Set the command to enable the output stream feature.

3. Map the data using the tMap component.

4. Output the selected data stream.

A complete Job looks as what it displays in the following image. For the detailed instruction for designing the
Job, read the following sections.
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E.2.3.1. Step 1: Reading input data from a local file

We will use the tFileInputDelimited component to read the file customers.csv for the input data. This component
can be found in the File/Input group of the Palette.

1. Drop a tFileInputDelimited component onto the design workspace, and double-click the to open the Basic
settings view to set its properties.

2. Click the three-dot button next to the File name/Stream field to browse to the path of the input data file.
You can also type in the path of the input data file manually.

3. Click Edit schema to open a dialog box to configure the file structure of the input file.

4. Click the plus button to add six columns and set the Type and columns names to what we listed in the
following:

5. Click OK to close the dialog box.

E.2.3.2. Step2: Setting the command to enable the output stream
feature

Now we will make use of tJava to set the command for creating an output file and a directory that contains the
output file.

To do so:

1. Drop a tJava component onto the design workspace, and double-click it to open the Basic settings view to
set its properties.
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2. Fill in the Code area with the following command:

new java.io.File("C:/myFolder").mkdirs(); 
globalMap.put("out_file",new java.io.FileOutputStream("C:/myFolder/
customerselection.txt",false));

The command we typed in this step will create a new directory C:/myFolder for saving the output file
customerselection.txt which is defined followingly. You can customize the command in accordance with actual
practice.

3. Connect tJava to tFileInputDelimited using a Trigger > On Subjob Ok connection. This will trigger tJava
when subjob that starts with tFileInputDelimited succeeds in running.

E.2.3.3. Step3: Mapping the data using the tMap component

1. Drop a tMap component onto the design workspace, and double-click it to open the Basic settings view to
set its properties.

2. Click the three-dot button next to Map Editor to open a dialog box to set the mapping.

3. Click the plus button on the left to add six columns for the schema of the incoming data, these columns should
be the same as the following:
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4. Click the plus button on the right to add a schema of the outgoing data flow.

5. Select New output and Click OK to save the output schema. For the time being, the output schema is still
empty.

6. Click the plus button beneath the out1 table to add three columns for the output data.

7. Drop the id, CustomerName and CustomerAge columns onto their respective line on the right.
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8. Click OK to save the settings.

E.2.3.4. Step4: Outputing the selected data stream

1. Drop a tFileOutputDelimited component onto the design workspace, and double-click it to open the Basic
settings view to set its component properties.

2. Select the Use Output Stream check box to enable the Output Stream field and fill the Output Stream
field with the following command:

(java.io.OutputStream)globalMap.get("out_file")

You can customize the command in the Output Stream field by pressing CTRL+SPACE to select built-in command
from the list or type in the command into the field manually in accordance with actual practice. In this scenario, the
command we use in the Output Stream field will call the java.io.OutputStream class to output the filtered data
stream to a local file which is defined in the Code area of tJava in this scenario.

3. Connect tFileInputDelimited to tMap using a Row > Main connection and connect tMap to
tFileOutputDelimited using a Row > out1 connection which is defined in the Map Editor of tMap.

4. Click Sync columns to retrieve the schema defined in the preceding component.
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To output the selected data to the console:

1. Drop a tLogRow component onto the design workspace, and double-click it to open its Basic settings view.

2. Select the Table radio button in the Mode area.

3. Connect tFileOutputDelimited to tLogRow using a Row > Main connection.

4. Click Sync columns to retrieve the schema defined in the preceding component.

This Job is now ready to be executed.

5. Press CTRL+S to save your Job and press F6 to execute it.

The content of the selected data is displayed on the console.
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The selected data is also output to the specified local file customerselection.txt.

For an example of Job using this feature, see Scenario: Utilizing Output Stream in saving filtered data to a local
file of tFileOutputDelimited in Talend Open Studio Components Reference Guide.

For the principle of the Use Output Stream feature, see How to use the Use Output Stream feature.
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Appendix F. Theory into practice: Profiling
data
This chapter aims at users of Talend Data Quality who seek a real-life use case to help them take full control
over data quality products.

It describes how to use the Profiling perspective in Talend Studio to profile data.
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F.1. Profiling customer data
Incorporating appropriate data quality tools in your business processes is vital at the beginning of any project and
through the project plan in order to see what type of data quality you have and decide how and what data to resolve.

Suppose, for example, that you want to start a campaign for your sails and marketing groups, or you need to
contact customers for billing and payment and your main source to contact appropriate people is email and postal
addresses. Having consistent and correct address data is vital in such campaign to be able to reach all people.

This section provides an example of profiling US customer email and postal addresses.

F.1.1. Identifying data anomalies

The first step in this example is to profile the customer contact information in a MySQL database. The profiling
results provides you with statistics about the values within each column.

F.1.1.1. How to profile address columns

You will use the studio to analyze few customer columns including email and postal. Using out-of-box indicators
and patterns on these columns, you can show in the analysis results the matching and non-matching address data,
the number of most frequent records for each distinct pattern and the row, duplicate and blank counts in each
column.

Defining the column analysis

1. In the Profiling perspective of the studio, create connection to the Mysql database that hold the customer data.

2. In the DQ Repository tree view, expand Metadata > DB connections.

3. Browse to the columns you want to analyze and right-click them.
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4. Select Column Analysis > Analysis.

5. In the open dialog box, set a name for the analysis and click Finish.

The analysis editor opens listing the selected columns.
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Setting system indicators

1. Click Select indicators for each column to open the [Indicator Selection] dialog box.
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2. Set the indicator parameters for the columns and then click OK.

You want to see the row, blank and duplicate counts in all columns to see how consistent the data is. Also
you want to use the Pattern Frequency Table indicator on the email and postal columns in order to compute
the number of most frequent records for each distinct pattern or value.

3.
Click the option icon  next to the Blank Count indicator and set 0 in the Upper threshold field.

Defining thresholds on indicators is very helpful as it will write in red the count of the null values in the
analysis results.
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Setting patterns

You would want now to match the content of the email column against a standard email format and the postal
column against a standard US zip code format. This will define the content, structure and quality of emails and
zip codes and give a percentage of the data that match the standard formats and the data that does not match.

1.
Click the  icon next to email.
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2. In the [Pattern Selector] dialog box, expand Regex and browse to Email Address in the internet folder,
and then click OK.

3.
Click the option icon  next to the Email Address indicator and set 98.0 in the Lower threshold (%) field.

If the number of the records that match the pattern is fewer than 98%, it will be written in red in the analysis
results.

4. Do the same to add to the postal column the US Zipcode Validation pattern from the address folder.

Executing the analysis and displaying the profiling results

1. Save the column analysis in the analysis editor and then press F6 to execute it.

A group of graphics is displayed in the Graphics panel to the right of the analysis editor showing the results
of the column analysis including those for pattern matching.

2. Click the Analysis Results tab at the bottom of the analysis editor to access a more detail result view.

These results show the generated graphics for the analyzed columns accompanied with tables that detail the
statistic and pattern matching results.

The results for the email column look as the following:
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The pattern matching results show that about 10% of the email records do not match the standard email
pattern. The simple statistic results show that about 8% of the email records are blank and that about 5%
are duplicates. And the pattern frequency results give the number of most frequent records for each distinct
pattern. This shows that the data is not consistent and you need to correct and cleans the email data before
starting your campaign.

The results for the postal column look as the following:
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The result sets for the postal column give the count of the records that match and those that do not match
a standard US zip code format. The results sets also give the blank and duplicate counts and the number of
most frequent records for each distinct pattern. These results show that the data is not very consistent.

Then some percentage of the customers can not be contacted by either email or US mail service. These results
show clearly that your data is not very consistent and that it needs to be corrected.

F.1.1.2. How to view analyzed data

After running the column analysis using the SQL engine and from the Analysis Results view of the analysis
editor, you can right-click any of the rows/bars in the result tables/charts and access a view of the actual analyzed
data. This could be very helpful to see invalid rows for example and start analyzing what needs to be done to
clean such data.

To view and export the analyzed data, do the following:

1. At the bottom of the analysis editor, click the Analysis Results tab to open a detailed view of the analysis
results.
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2. Right-click a data row in the statistic results of the email column and select View invalid rows for example.

The Data Explorer perspective opens listing the invalid rows in the email column.
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Appendix G. Theory into practice: Building a
simple MDM project
This appendix takes you through the main steps involved in building a simple MDM project.
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G.1. Preparing your project in the Studio
This short scenario walks you through the main steps involved in setting up a simple MDM project. In this example,
you recreate some of the content included in the MDM Demo Project.

First, in Talend Studio, you define the data model and data container, and you then set up a view that you can use
to interact with the data they contain using Talend MDM Web User Interface.

More complex actions such as the creation of processes and triggers are beyond the scope of this scenario.

Before you begin this scenario, make sure you have a valid connection to an MDM Server and have created an
empty project.

G.1.1. Setting up a data model and creating some
business entities

The first step at the beginning of any MDM project involves setting up a data model and creating business entities
in this data model.

G.1.1.1. Create a data model

To create a data model, do the following:

1. In the MDM Repository tree view, right-click Data Model and select New from the contextual menu.

2. Name your data model Product, and then click OK.

In the Studio workspace, an editor opens where you can define some of the details of your new data model.

G.1.1.2. Create business entities in the data model

Once you have created your data model, you need to populate it with some business entities.
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To create a business entity in your data model, do the following:

1. In the editor, right-click anywhere in the Data Model Entities panel, and then click New Entity.

2. In the [New Entity] dialog bog that opens, enter a name for your new entity in the Name field: Product.

3. Select the Complex Type option.

You use the Simple type option if you want to define a single element type such as a phone number or an
email address, and the Complex type option if you want to define a more complete structure, such as an
address or, in this case, the different attributes that describe a product.

4. Leave the other options unchanged and click OK to add your new entity to the editor.
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5. In the Properties panel, in the Access Rights tab, select System_Web role in the drop-down list in the Write
Access area, and then click the [+] to grant write access on the entity for users with this role. Do the same
for the System_Admin role.

If you cannot see these roles in the drop-down list, right-click the Role node in the MDM Repository tree view, and
then click Import Server Objects from MDM Server.

G.1.1.3. Define attributes

The next step in this scenario involves defining different attributes for the Product entity you have just created:
its name, description and price.

To define attributes for the Product business entity, do the following:

1. Expand the Product business entity and anonymous type, right-click subelement and then click Edit Element
in the contextual menu.

2. Change the name to Id, set the minimum and maximum occurrences to 1, and then click OK to close the
dialog box.

3. Right-click Id, click Add Element (after) in the contextual menu, and then add each of the following elements
with the characteristics shown in the table below.

Element type Element name Minimum occurence Maximum occurence

String Name 1 1

Decimal Price 1 1



Defining a data container

Talend Open Studio for MDM User Guide 1017

4. Save your changes and then, in the MDM Repository tree view, expand the Data Model node, right-click
the Product data model, and then select one of the deployment options to deploy your changes to the MDM
Server.

G.1.2. Defining a data container

Once you have set up the basics of your data model, you need to define a data container in the MDM Hub where
your master data is to be persisted.

To create a data container, do the following:

1. In the MDM Repository tree view, right-click Data Container, and then click New.

The [New Data Container] dialog box displays.

2. Name your new data container Product, and then click OK.

3. Save your changes and then, in the MDM Repository tree view, expand the Data Container node, right-
click the Product data container, and then select one of the deployment options to deploy your changes to
the MDM Server.

G.1.3. Creating Views

Before business users are able to extract and query master data in Talend MDM Web User Interface, you need to
create one or more Views in Talend Studio. These Views specify which data records within an entity a business
user is allowed to search and view, and may also set conditions that filter which content can be delivered as the
result of a search.

To create a View, do the following:

1. In the MDM Repository tree view, right-click View and select New from the contextual menu.

2. In the [New View] dialog box that opens, select Web filter view.
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3. Click the [...] button to specify the entity on which you want to create a view.

4. In the dialog box that opens, select the Product data model in the drop-down box, click Product to set the
appropriate XPath, and then click Add to close the dialog box.

5. The name of your View is set automatically as Browse_items_Product. Click OK.

Your View now exists in the MDM Repository tree view, but it has not yet been fully defined. You still need to
specify exactly which elements can be viewed and searched.

To define the details of your View, do the following:

1. In the Browse_items_Product View which opens in the workspace, click the[...] button next to Description
to define a description for your View in one or more languages (for example, Product since it is a View on
all the products), and then click OK to close the dialog box when you have done so.

2.

Under Viewable Business Elements, click the Add multiple button  to add multiple elements at the
same time.

3. In the dialog box that opens, expand Product and anonymous type, and then press Ctrl and hold it down
while you select each of the elements you want to make viewable: Id, Name, Price. Click Add to add each
of these elements.
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4.

Under Searchable Business Elements, click the Add multiple button  to add multiple elements at
the same time.

5. In the dialog box that opens, expand Product and anonymous type, and then press Ctrl and hold it down
while you select each of the elements you want to make searchable: Id, Name, Price. Click Add to add each
of these elements.

6. Save your changes and then, in the MDM Repository tree view, expand the View node, right-click the
Product View, and then select one of the deployment options to deploy your changes to the MDM Server.

You have now created the overall structure for your simple MDM project.

G.2. Working with the data in the Web User
Interface
Once you have prepared your simple project in Talend Studio, you can start to interact with the data in Talend
MDM Web User Interface, as your business users would do in a real-life project.

G.2.1. Opening MDM Web User Interface

To open Talend MDM Web User Interface, do the following:

1. In a web browser, enter the URL for your MDM Server, for instance http://localhost:8180/talendmdm/
secure.

2. On the authentication page, enter the default administrator user name and passowrd, administrator/
administrator, and then click the Login button.

The Welcome Page opens.
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G.2.2. Creating a new data record

In this scenario, you are going to create a single new data record in the Product business entity that corresponds
to the criteria you defined earlier in the studio.

To create a new data record, do the following:

1. In the Menu panel, click Data Browser to open the Data Browser.

2. Select the Product entity from the Select an entity drop-down list.

3. For the moment, there are no data records to display.

Click the Create button to create a new empty record.
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4. In the new data record that opens, you can see some fields corresponding to the attributes you defined in the
studio. Enter any values you like for the Id and Name fields, and any numerical value you like for the Price
field, and then click Save and close to create your data record.

You have now created a data record that validates against all the criteria you defined in the studio.
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